
Tekla Structural Designer
1

Product Guides

May 2021

©2021 Trimble Solutions Corporation



Contents

1 Installation and licensing workflow..........................................27
1.1 Tekla Structural Designer license types....................................................... 27
1.2 If you manage your own installation of Tekla Structural Designer..........28
1.3 If someone manages Tekla Structural Designer for you............................ 29
1.4 Tekla Structural Designer 2021 hardware recommendations...................30

System requirements for effective operation....................................................................30
Test environments.................................................................................................................30

1.5 Create your Trimble Identity......................................................................... 31
Creating a Trimble Identity on your first license purchase.............................................. 31
Creating a Trimble Identity to join an existing organization............................................ 31

1.6 Install and license Tekla Structural Designer.............................................. 33
Licensing & installation information specific to Tekla Structural Designer 2021.......... 34
Further help and update information.................................................................................37

Tekla User Assistance...................................................................................................... 37
Tekla Discussion Forum...................................................................................................37
Helpdesk............................................................................................................................38
Software Update Service................................................................................................. 38
Previous versions............................................................................................................. 38

How can I centrally deploy Tekla software?....................................................................... 38
I want to centrally deploy Tekla Structural Designer what do I need to do to be able

to do this?.......................................................................................................................................... 38
Where is the information found?................................................................................... 39
How do I unpack the install to extract the Distributed Deployment details?........... 39

1.7 Tekla Structural Designer service packs...................................................... 39
Install a Tekla Structural Designer service pack.................................................................39

1.8 Upgrade Tekla Structural Designer to a new version.................................40

2 Get familiar with Tekla Structural Designer............................ 43
2.1 Philosophy........................................................................................................43
2.2 Tekla Structural Designer way of working...................................................44
2.3 Start Tekla Structural Designer.....................................................................45

Choose the country for your settings................................................................................. 45
Check or change your settings.............................................................................................45
Modify project details............................................................................................................46

Modify project details and view revision history..........................................................46
Record revisions............................................................................................................... 46
Apply revision ID as an attribute for each modified element.....................................47

 Use templates in new projects ...........................................................................................47
Create a new template.................................................................................................... 47
Create a new project based on a template................................................................... 48

2.4 Work with projects..........................................................................................49
Start a new project................................................................................................................ 49

2



Open a project....................................................................................................................... 50
Check or change model settings in your project............................................................... 50

2.5 Work with autosave and backups.................................................................51
The difference between autosave and backup..................................................................51
Enable autosave.....................................................................................................................52
Enable backups...................................................................................................................... 52
Automatically restore an autosave or backup following a Program error..................... 52
Manually restore a backup................................................................................................... 54

2.6 Get familiar with the user interface ............................................................ 54
Interface components...........................................................................................................55

1. File menu.......................................................................................................................55
2. Quick access toolbar.................................................................................................... 56
3. Ribbon........................................................................................................................... 57
4. Scene views................................................................................................................... 58
5. Structure tree................................................................................................................58
6. Project Workspace....................................................................................................... 59
7. Properties window....................................................................................................... 61
8. Show Process button................................................................................................... 62
9. Process Window........................................................................................................... 62
10. Select Entity tooltip.................................................................................................... 63
11. Context menu............................................................................................................. 63
12. Properties dialog........................................................................................................ 64
13. Ghost Unselected and Ghosted toggle buttons..................................................... 64
14. 2D/3D toggle button.................................................................................................. 65
15. Global XYZ axes.......................................................................................................... 66
16. Building directions..................................................................................................... 66
17. Cutting planes.............................................................................................................66
18. Loading List.................................................................................................................67
19. Status bar.................................................................................................................... 67
20. View regime buttons..................................................................................................68
21. ViewCube.................................................................................................................... 68
22. Scene Content............................................................................................................ 69
23. Tekla Online side pane.............................................................................................. 69
24. Trimble Connect side pane....................................................................................... 70
25. Sign in.......................................................................................................................... 70

 How to use the project workspace..................................................................................... 70
View and modify model properties in the Project Workspace................................... 71
Manage groups in the Project Workspace.................................................................... 77
View load status in the Project Workspace................................................................... 80
View and modify wind properties in the Project Workspace......................................81
View model status in the Project Workspace................................................................82
Manage and design connections in the Project Workspace....................................... 83

How to manage scene views, view regimes and scene content...................................... 85
Open, close and save scene views................................................................................. 86
Create and modify scene view tab groups....................................................................89
Change the view regime.................................................................................................. 89
Manage scene content information...............................................................................90
Scene content entity categories..................................................................................... 91

How to hide, re-display and move windows...................................................................... 99
Auto-hide a window......................................................................................................... 99
Close a window.................................................................................................................99
Re-display a closed window............................................................................................ 99
Move a window.................................................................................................................99
Dock a window as a tabbed page in another window.................................................99
Open a tabbed page in another window.......................................................................99

3



Dock a window using the docking control.................................................................. 100
Keyboard shortcuts............................................................................................................. 100

 General keyboard shortcuts ....................................................................................... 100
 Keyboard shortcuts in 2D and 3D Views.................................................................... 101
 Keyboard shortcuts in Properties windows...............................................................102
 Keyboard shortcuts in tree structures........................................................................104
 Keyboard shortcuts to the Quick Access Toolbar..................................................... 104
 Keyboard shortcuts to ribbon commands................................................................. 105

2.7 NOTE: Steps to take if the Help Viewer appears to be inactive...............107

3 BIM integration ......................................................................... 108
3.1 Import model data ....................................................................................... 109

Import a project from a Structural BIM Import file......................................................... 109
Import a project from a TEL file......................................................................................... 110

Restrictions..................................................................................................................... 110
Instructions..................................................................................................................... 116

Import data from a 3D DXF file..........................................................................................116
Restrictions..................................................................................................................... 116
Instructions..................................................................................................................... 117

3.2 Working collaboratively with Trimble Connect.........................................118
Launch Trimble Connect Project Explorer........................................................................118
Link or unlink a project....................................................................................................... 119
Create folders, rename folders, rename files.................................................................. 120
Upload an IFC file of a model............................................................................................. 121
Upload a multi-member drawing...................................................................................... 121
Upload a single member drawing..................................................................................... 122
Upload a model report....................................................................................................... 122
Upload a member report................................................................................................... 123
Link a drawing or report to an existing IFC...................................................................... 124
Check linking progress in the Process Window............................................................... 124
Open Trimble Connect to a model view for an IFC......................................................... 125
Open Trimble Connect........................................................................................................125

3.3 Export to Trimble applications ................................................................... 125
Export a model to Tekla Structures...................................................................................126
Export to Tekla Connection Designer............................................................................... 127

To export a single connection...................................................................................... 127
To export multiple connections....................................................................................127
To return connection data from Tekla Connection Designer................................... 127

Export to Tekla Portal Frame Designer.............................................................................128
Export to Tekla Portal Frame Designer workflow...................................................... 128
How loading, restraints and supports are handled in the export............................128
To export a single frame............................................................................................... 131
To export multiple frames............................................................................................ 131
To return revised sections from Tekla Portal Frame Designer.................................132

Export to Tekla Tedds......................................................................................................... 132
 Understanding each of the export options................................................................132
To export all timber and precast members................................................................ 133
To export a single member...........................................................................................134
To export multiple members........................................................................................134
To export a group...........................................................................................................134
To export a substructure...............................................................................................135

3.4 Export to and import from other applications.......................................... 135
Export a model to Autodesk Revit..................................................................................... 135

4



Export a model to IFC..........................................................................................................136
Export to and import from Westok Cellbeam..................................................................137

Export to Cellbeam.........................................................................................................137
Import from Cellbeam................................................................................................... 137

Export to and import from FBEAM....................................................................................138
Overview..........................................................................................................................138
Limitations.......................................................................................................................140
Export to FBEAM.............................................................................................................142
Import from FBEAM....................................................................................................... 142
Review the imported beams.........................................................................................143

Export a model to ADAPT................................................................................................... 143
Limitations.......................................................................................................................143
Instructions..................................................................................................................... 147

Export a model to STAAD................................................................................................... 147
Export a model to Autodesk Robot Structural Analysis..................................................148
Export a model to the cloud...............................................................................................149
Export to One Click LCA...................................................................................................... 149

Overview..........................................................................................................................150
Show report.................................................................................................................... 152
Show online results........................................................................................................152

Export to IDEA StatiCa Connection Design.......................................................................153
Limitations.......................................................................................................................153
Instructions for the export to IDEA StatiCa.................................................................153
Review of IDEA connections designed in Tekla Structural Designer........................154
.......................................................................................................................................... 154

4 Create models............................................................................ 155
4.1 Get to know Tekla Structural Designer basic working methods.............155

Zoom, pan, rotate and walk through the model............................................................. 156
Zoom in and out, or zoom extents...............................................................................156
Pan the view....................................................................................................................156
Rotate the view manually..............................................................................................156
Adjust the view with the ViewCube..............................................................................156
Walk through the model in a 3D view..........................................................................158
Display a 2D view in 3D................................................................................................. 158

Select entities....................................................................................................................... 158
Select single entities.......................................................................................................158
Select multiple entities using area selection...............................................................159
Select using Find.............................................................................................................161
Select from the Project Workspace..............................................................................162
Select nodes....................................................................................................................163
Modify the selection.......................................................................................................164
Use Ghost Unselected to focus on the selection........................................................165
Select a section in the Select Section dialog box........................................................167

Edit entity properties.......................................................................................................... 168
Edit properties using the Properties window............................................................. 168
Edit properties using the Properties dialog box.........................................................168
Edit properties of multiple entities.............................................................................. 169

Re-position entities by moving nodes or edges...............................................................169
Modify one end of a grid or construction line............................................................ 169
Move a grid or construction line.................................................................................. 170
Modify one end of a member.......................................................................................171
Modify slab items and panels by moving a node.......................................................171
Modify slab items by moving an edge......................................................................... 172
Modify walls by moving a node.................................................................................... 172

5



Tips for basic tasks.............................................................................................................. 173
Use the tooltip for input in a command...................................................................... 173
Undo a command...........................................................................................................174
Cancel a command or go back to the previous prompt............................................174

4.2 Create the model...........................................................................................174
Create and manage construction levels........................................................................... 175

Open the Construction Levels dialog ..........................................................................175
Insert a single construction level..................................................................................175
Insert multiple construction levels...............................................................................176
 Make a level an identical copy of another level.........................................................177
Make a level an independent copy of another level..................................................177
Modify the properties of a construction level............................................................ 177
Delete construction levels.............................................................................................177

 Create and manage architectural grids and grid lines ..................................................178
Create grid lines............................................................................................................. 179
Number and renumber grids....................................................................................... 184
Change the name of a grid line or grid arc................................................................. 185
 Apply an architectural grid to a specific level............................................................ 185
Change the name or color of an architectural grid....................................................185
Import grids from a DXF file or a shadow of the DXF file..........................................186
Extend, move, or rotate grid lines and arcs................................................................ 187

Create and manage construction lines.............................................................................188
Create a single construction line.................................................................................. 188
Create parallel construction lines................................................................................ 189
Create perpendicular construction lines.....................................................................190
Create a rectangular construction line system...........................................................191
Create a radial construction line system.....................................................................192
Create construction arcs............................................................................................... 193
Extend, move, or rotate construction lines and arcs.................................................193

Create frames and slopes...................................................................................................194
Create a frame................................................................................................................195
Create a slope.................................................................................................................195

Create dimensions.............................................................................................................. 196
Create a single dimension.............................................................................................196

Create beams, columns and braces..................................................................................197
Create columns.............................................................................................................. 197
Create beams..................................................................................................................210
Create braces..................................................................................................................227
Member global offsets...................................................................................................231

Create walls, cores and bearing walls............................................................................... 234
Create concrete walls.................................................................................................... 235
Create concrete cores....................................................................................................245
Create bearing walls...................................................................................................... 248
Create shear only walls................................................................................................. 252
Create general walls.......................................................................................................254

Create slabs and decks....................................................................................................... 258
Overview of the slab model.......................................................................................... 259
Create slab items............................................................................................................263
Create slab or mat openings.........................................................................................265
Add overhangs to existing slab or mat edges............................................................ 267
 Apply curved edges to existing slab items................................................................. 269
Create column drops..................................................................................................... 270
Specify the material for general slab types.................................................................270
Split and join slabs and mats........................................................................................ 273
Modify slab/panel span direction.................................................................................274

6



Create trusses and joists.................................................................................................... 274
Create trusses.................................................................................................................275
Create steel joists........................................................................................................... 277

Create portal frames........................................................................................................... 279
Create a single or multi-span portal frame.................................................................279
Modify the properties of an existing portal frame.....................................................280
Add copy or mirror spans in an existing portal frame.............................................. 280
Portal frame haunch geometry.................................................................................... 281

Create cold-rolled sections.................................................................................................281
Create cold-rolled sections........................................................................................... 282
Modify the position of a cold-rolled section............................................................... 282

Create wall and roof panels............................................................................................... 282
Create wall panels.......................................................................................................... 283
Create wall panels with parapets................................................................................. 283
Modify the properties of a wall panel..........................................................................284
Create roof panels..........................................................................................................284
Modify the properties of roof panels...........................................................................285

Ancillaries............................................................................................................................. 285
What are ancillaries used for?...................................................................................... 285
Ancillary load default values......................................................................................... 288
Ancillary loadcases.........................................................................................................289
Ancillary load decomposition....................................................................................... 291
Create line ancillary loads............................................................................................. 293
Create area ancillary loads............................................................................................294
Create an ancillary loads report................................................................................... 295

Equipment............................................................................................................................ 295
Overview..........................................................................................................................296
Equipment loadcases.....................................................................................................300
Equipment load decomposition................................................................................... 301
Create equipment and equipment loads.................................................................... 304
Create additional equipment loads in other loadcases............................................ 305
Create an equipment loads report.............................................................................. 306

Inactive members................................................................................................................ 306
Which members can be made inactive?......................................................................307
To make a member inactive......................................................................................... 307
Inactive member load decomposition.........................................................................307
Typical usage cases for inactive members..................................................................309

Create supports................................................................................................................... 314
Create a single support................................................................................................. 314
Create a rotated support using 3 grid points............................................................. 315
Create spring supports..................................................................................................315
Create nominally pinned or nominally fixed supports..............................................315
Modify support properties............................................................................................316
Partial fixity of column bases........................................................................................316

Create analysis elements....................................................................................................317
Create analysis elements.............................................................................................. 317
Create analysis element springs.................................................................................. 318
Modify the position of analysis elements................................................................... 318
Element types................................................................................................................. 318

4.3 Edit the model............................................................................................... 321
Copy and rotate objects......................................................................................................321
Move and rotate objects.....................................................................................................322
Mirror objects to new locations.........................................................................................322
Copy loads............................................................................................................................ 326

Copy all member loads from one span to another....................................................326

7



Only copy one member load to another span........................................................... 327
Copy panel area, level, and slab loads.........................................................................327
Copy panel point, line, and patch loads...................................................................... 328
Copy structure loads......................................................................................................329
Copy loads to another loadcase...................................................................................329

Delete entities...................................................................................................................... 329
Join and split members....................................................................................................... 330

Join members..................................................................................................................330
Split members.................................................................................................................331

Automatically join all concrete beams.............................................................................. 331
Reverse member axes and panel faces............................................................................ 332

Reverse the local axis of a beam.................................................................................. 332
Reverse the outward face of a wind panel..................................................................332

Manage cutting planes........................................................................................................333
Activate or deactivate a cutting plane......................................................................... 333
Move a cutting plane to hide a part of the model......................................................333
Re-display a hidden part of the model........................................................................ 334

Move the model or the DXF shadow.................................................................................334
Move the model............................................................................................................. 334
Move the DXF shadow................................................................................................... 335

Rationalize the model......................................................................................................... 335
Delete unused sloped planes, frames, grids, and construction lines......................335
Update grid and construction line length................................................................... 335

Create infill members..........................................................................................................336
Define the infill properties and pattern.......................................................................336
Place the pattern in a single bay.................................................................................. 336
Place the pattern in multiple bays............................................................................... 337

Merge planes........................................................................................................................337
Create and manage free points......................................................................................... 337

Create a free point......................................................................................................... 338
Adding, moving or deleting free points from the Edit tab........................................ 338
.......................................................................................................................................... 338

4.4 Validate the model........................................................................................338
Run model validation.......................................................................................................... 338
Adjust the conditions considered in model validation................................................... 338
Measure distances and angles...........................................................................................339

Measure distances......................................................................................................... 339
Measure angles.............................................................................................................. 339

5 Apply loading..............................................................................340
5.1 Manage loadcases, groups, combinations, envelopes and patterns...... 340

 Manage loadcases.............................................................................................................. 340
Create loadcases............................................................................................................ 341
 Activate reductions in live or imposed loadcases..................................................... 341
Renumber all loadcases................................................................................................ 342

 Manage load groups.......................................................................................................... 342
 Overview of load groups.............................................................................................. 342
Create load groups.........................................................................................................343
Inclusive and exclusive load groups example............................................................ 344

Manage load combinations................................................................................................344
Load combination classes............................................................................................. 345
Generate load combinations automatically................................................................346
Create load combinations manually............................................................................346
Create modal mass combinations............................................................................... 347

8



Import loadcases and combinations from a spreadsheet........................................347
Renumber all load combinations................................................................................. 352

Manage envelopes.............................................................................................................. 353
Create envelopes............................................................................................................353

Manage load patterns.........................................................................................................353
Overview of load patterns.............................................................................................354
Apply patterning to live loadcases............................................................................... 356
Apply patterning to load combinations.......................................................................356
Update load patterns.....................................................................................................357

 Loading dialog.....................................................................................................................357
1. Loadcases....................................................................................................................358
2. Load Groups............................................................................................................... 359
3. Combinations............................................................................................................. 360
6. Envelopes.................................................................................................................... 363

5.2 Apply panel, member, and structure loads............................................... 364
Apply panel loads................................................................................................................ 364

Create point loads..........................................................................................................365
Create line loads.............................................................................................................365
Create patch loads......................................................................................................... 366
Create polygonal loads.................................................................................................. 367
Create perimeter loads..................................................................................................367
Create variable patch loads.......................................................................................... 368
Create area loads........................................................................................................... 369
Create variable area loads............................................................................................ 369
Create slab loads............................................................................................................369
Create level loads........................................................................................................... 369

 Apply member loads.......................................................................................................... 370
Create full-length UDLs................................................................................................. 370
Create partial-length UDLs or VDLs............................................................................. 370
Create trapezoidal loads............................................................................................... 371
Create point loads and moment loads........................................................................371
Create full-length torsional UDLs................................................................................. 371
Create partial-length torsional UDLs and VDLS..........................................................372

Apply structure loads ......................................................................................................... 372
Diaphragm loads and diaphragm load tables............................................................ 373
Create nodal loads......................................................................................................... 382
Create temperature loads.............................................................................................382
Create settlement loads................................................................................................ 382

Modify panel, member, and structure loads....................................................................383
Delete panel, member, and structure loads.................................................................... 383
Decompose panel loads..................................................................................................... 383

Decompose panel loads for an individual construction level...................................383
Decompose panel loads to all required levels........................................................... 384
View decomposed loads graphically............................................................................384
View applied and decomposed member loads in a table.........................................385
Overview of one-way and two-way load decomposition.......................................... 385

5.3 Apply wind, snow, and seismic loads..........................................................387
 Apply wind loads using the wind wizard..........................................................................388

Create a wind model and wind loads.......................................................................... 388
Modify wind zones and wind zone loads.................................................................... 390
Create and manage wind loadcases............................................................................ 392

Apply wind loads manually.................................................................................................393
Create loadcases for manual wind loads.................................................................... 393
Create simple wind loads.............................................................................................. 393
Modify simple wind load vertical properties.............................................................. 394

9



Modify the simple wind load width..............................................................................394
Apply open structure wind loads.......................................................................................394

 Apply open structure wind load to selected entities................................................ 394
Run the wind wizard...................................................................................................... 395
Define wind loadcases...................................................................................................395

 Apply snow loads using the snow wizard........................................................................396
Overview of snow loading using the snow wizard..................................................... 396
 Roof panel types ...........................................................................................................397
Run the snow load wizard.............................................................................................398
Snow loadcases (ASCE7)................................................................................................ 398
Snow loadcases (Eurocode).......................................................................................... 401
Apply drift loads to loadcases on completion of the snow wizard.......................... 403
Update snow loads........................................................................................................ 405
Delete the snow model................................................................................................. 406

 Apply snow loading manually........................................................................................... 406
Apply seismic loads............................................................................................................. 406

Create seismic loads in the Seismic Wizard................................................................ 406
Display the horizontal design spectrum......................................................................407
Delete seismic loads...................................................................................................... 407
 Seismic wizard in detail................................................................................................ 407

6 Analyze models.......................................................................... 450
6.1 Get started with analysis............................................................................. 450

 Analysis types in Tekla Structural Designer.....................................................................450
 1st order linear.............................................................................................................. 451
 1st order non-linear...................................................................................................... 451
 1st order modal.............................................................................................................451
 2nd order linear.............................................................................................................451
 2nd order non-linear.................................................................................................... 452
 2nd order buckling........................................................................................................452
FE chasedown................................................................................................................. 453
Grillage chasedown........................................................................................................453
 Analyze All (Static)......................................................................................................... 453
 3D only (Static)...............................................................................................................453
 1st order RSA seismic................................................................................................... 454
 2nd order RSA seismic..................................................................................................454
 Analysis limitations and assumptions........................................................................ 454

Adjust and apply analysis settings.....................................................................................460
Adjust analysis settings in the current project........................................................... 460
Adjust analysis settings in future projects.................................................................. 460

What is a solver model........................................................................................................461
FE meshing, sub models and diaphragms....................................................................... 463

 Manage FE meshed slabs.............................................................................................464
 Manage FE meshed walls ............................................................................................ 480
 Diaphragm action in roof panels and slabs............................................................... 482
 Manage sub models......................................................................................................488

6.2 Run analyses ................................................................................................. 491
Run a 1st order linear or non-linear analysis...................................................................491

Run 1st order linear analysis........................................................................................ 491
Run a 1st order non-linear analysis............................................................................. 492

Run a 1st order modal analysis......................................................................................... 492
Run a 2nd order linear or non-linear analysis................................................................. 493

Run a 2nd order linear analysis....................................................................................493
Run a 2nd order non-linear analysis............................................................................493

10



Run a 2nd order buckling analysis.................................................................................... 493
Run a seismic analysis.........................................................................................................494

Run a 1st order RSA seismic analysis...........................................................................494
Run a 2nd order RSA seismic analysis......................................................................... 494

Run FE chasedown or grillage chasedown analysis........................................................ 495
Run Analyze All (Static)........................................................................................................496
Run 3D only (Static)............................................................................................................. 496
Check sum of reactions against load input...................................................................... 497
 Check stability and overall displacement........................................................................ 498

Review the stability checks and overall displacement in the Status tree ...............498
6.3 Display analysis results................................................................................ 498

The Results View.................................................................................................................. 498
Set the analysis type and loading for viewing analysis results.................................500
Display reactions............................................................................................................ 500
Display 1D results...........................................................................................................502
Display 1D deflections................................................................................................... 502
Animate 1D and 2D deflections....................................................................................502
Display sway drift and story shear...............................................................................503
Display notional forces and seismic equivalent lateral forces................................. 504
Display 2D results...........................................................................................................504
Display 2D deflections................................................................................................... 510
Display AsReq contours.................................................................................................510
Display wall lines............................................................................................................ 511
Display core lines........................................................................................................... 511
Manage and display result strips................................................................................. 512
Manage, display and design result lines..................................................................... 515
Display mode shapes.....................................................................................................518
 RSA seismic results .......................................................................................................518
Customize the display of 2D contours.........................................................................523
Change result diagram scale settings..........................................................................523
Display 2D view in isometric projection...................................................................... 524
 Sign conventions and coordinate systems.................................................................524

The Load Analysis View.......................................................................................................542
Open a Load Analysis View........................................................................................... 542
Load Analysis View properties for columns................................................................543
Load Analysis View properties for beams................................................................... 546
RSA Seismic Results in a Load Analysis View.............................................................. 550

6.4 Solver models................................................................................................ 551
 Solver model types............................................................................................................. 552

 Working Solver Model...................................................................................................552
 Solver Model used for 1st Order Linear and 2nd Order Linear.............................. 552
 Solver Model used for 1st Order Non Linear and 2nd Order Non Linear..............554
 Solver Model used for 1st Order Modal..................................................................... 554
 Solver Model used for 2nd Order Buckling................................................................555
 Solver Model used for Grillage Chasedown...............................................................555
 Solver Model used for FE Chasedown........................................................................ 557
 Solver Model used for Load Decomposition............................................................. 559
 Refresh Solver Model....................................................................................................559

Open a solver view.............................................................................................................. 559
Open a solver view as a new view................................................................................560
Change the existing view to a solver view...................................................................560

View the solver model used for a particular analysis..................................................... 560
View solver model object properties................................................................................ 561

Solver node properties.................................................................................................. 561
Solver element properties.............................................................................................561

11



 Solver element (1D) types............................................................................................ 562
Solver element 2D properties.......................................................................................564

 How concrete beams and columns are represented in solver models.......................565
 Rigid offsets....................................................................................................................565
 Rigid zones..................................................................................................................... 566
 Rigid offsets examples..................................................................................................567
 Rigid zones examples................................................................................................... 571

How meshed walls are represented in solver models....................................................577
How mid-pier walls are represented in solver models...................................................582
How shear only walls are represented in solver models................................................584

 Background....................................................................................................................584
 Solver model in Tekla Structural Designer.................................................................587

How bearing walls are represented in solver models.................................................... 588
 View tabular solver model data and results....................................................................591

View tabulated solver node and element data...........................................................591
View tabular results for support reactions................................................................. 592
View tabular results for nodal deflections.................................................................. 592
View tabular results for solver element end forces................................................... 593
View tabular results for wall lines................................................................................ 594
View tabular results for result lines............................................................................. 594
View tabular results for core lines................................................................................595
View tabular results for mode shapes.........................................................................595
View the summed mass for modal mass combinations........................................... 596
View the dynamic masses for modal mass combinations........................................ 596
View active masses by node......................................................................................... 596
View total masses by node............................................................................................596
View modal frequencies and modal masses.............................................................. 597
View buckling factors..................................................................................................... 597

7 Design models............................................................................ 598
7.1 Design steel members and cast-in-place concrete beams,

columns and walls.........................................................................................599
Apply and modify design settings..................................................................................... 599

Modify design settings in the current project.............................................................600
Modify design settings defaults for future projects...................................................600

 Autodesign versus check design.......................................................................................600
Combined analysis and member design.......................................................................... 601

Overview..........................................................................................................................601
Run Design Steel (Gravity).............................................................................................602
Run Design Steel (Static)................................................................................................602
Run Design Steel (RSA)...................................................................................................602
Run Design Concrete (Gravity)......................................................................................603
Run Design Concrete (Static).........................................................................................603
Run Design Concrete (RSA)........................................................................................... 603
Run Design All (Gravity)................................................................................................. 603
Run Design All (Static).................................................................................................... 604
Run Design All (RSA).......................................................................................................604
Select whether to design steel, concrete, or all..........................................................604
 Select between static and gravity design................................................................... 605

Check selected members and walls.................................................................................. 606
Check an individual member, wall, or core.................................................................606
Check selected members and walls.............................................................................607
Check all members in a level, slope, or frame............................................................607
Check all members.........................................................................................................608

12



Check all walls.................................................................................................................608
Check all members and walls....................................................................................... 608
Check all members of a particular section or type.................................................... 608
Check all members in a group......................................................................................609
Check all members and walls in a sub structure........................................................609

Design selected members and walls.................................................................................609
Design an individual member, wall, or core............................................................... 609
Design selected members and walls........................................................................... 610
Interactively design a concrete member.....................................................................611
Design all members in a level, slope, or frame.......................................................... 611
Design all members....................................................................................................... 611
Design all walls............................................................................................................... 612
Design all members and walls......................................................................................612
Design all members of a particular section or type...................................................612
Design all members in a group.................................................................................... 613
Design all members and walls in a sub structure...................................................... 613

Apply user defined utilization ratios................................................................................. 613
Overview of user defined U/R.......................................................................................614
Apply user defined U/R for autodesign only...............................................................614
Apply user defined U/R for autodesign and check.................................................... 615
.......................................................................................................................................... 615

Validate the model for design issues................................................................................ 615
Run design validation.................................................................................................... 616
Adjust the conditions considered in design validation..............................................616

7.2 Design slabs and run punching shear checks............................................616
Create and modify patches................................................................................................ 617

Overview of patches and patch types..........................................................................617
Create column patches..................................................................................................617
Create beam patches.....................................................................................................618
Create wall patches........................................................................................................619
Create panel patches..................................................................................................... 620
 Modify patch properties...............................................................................................622
Resize patches................................................................................................................ 622

Design and check slabs.......................................................................................................622
Check an individual slab item....................................................................................... 623
Check all slab items........................................................................................................623
Check all slab items on a single floor...........................................................................623
Check all slab items in a sub structure........................................................................ 624
Design an individual slab item......................................................................................624
Design all slab items...................................................................................................... 625
Design all slab items on a single floor......................................................................... 625
Design all slab items in a sub structure.......................................................................625

Design and check patches.................................................................................................. 626
Check an individual patch............................................................................................. 626
Check all patches in the model.....................................................................................626
Check all patches on a single floor...............................................................................626
Design an individual patch............................................................................................627
Design or check all patches in the model....................................................................627
Design all patches on a single floor............................................................................. 627

Create punching shear checks...........................................................................................627
Punching check locations.............................................................................................. 627
Punching check axis orientation...................................................................................628
Create punching check items....................................................................................... 628
Specify stud rail reinforcement.................................................................................... 629
Modify the properties of existing punching check items.......................................... 629

13



Design and check punching shear.....................................................................................629
Overview of the Design Punching Shear command.................................................. 629
Check punching shear for an individual punching check item.................................630
Check all punching check items....................................................................................631
Check all punching shear check items on a floor.......................................................631
Design all punching check items.................................................................................. 631
Design all punching shear check items on a floor..................................................... 631
Design an individual punching check item..................................................................631

7.3 Design timber and precast members using Tekla Tedds......................... 632
7.4 Create and run floor vibration checks........................................................632

Create and modify floor vibration checks........................................................................ 632
Create floor vibration check items...............................................................................633
Create floor vibration checks that consider two or three adjoining spans.............634
Modify the properties of existing floor vibration check items..................................634

Run floor vibration checks..................................................................................................635
Check vibration for all floor vibration check items.................................................... 635
Check floor vibration for an individual floor vibration check item.......................... 635

7.5 Create and check steel connections .......................................................... 635
Check simple connection resistance................................................................................. 635

Overview..........................................................................................................................636
Specify 'active' connection resistances (Eurocodes).................................................. 636
Specify 'active' connection resistances (US)................................................................638
Run resistance checks................................................................................................... 640
The connection optimization process......................................................................... 641
Display connection resistance checks in a review data table................................... 643
Create and display a connection resistance report................................................... 644
Related video.................................................................................................................. 645

Create and check column base plates.............................................................................. 645
Create column base plates........................................................................................... 645
Check column base plates............................................................................................ 645

Create and size SidePlate connections............................................................................. 646
SidePlate connections theory....................................................................................... 646
Create SidePlate connections....................................................................................... 653
Beam properties - SidePlate......................................................................................... 654

Create and design other connections...............................................................................655
Overview..........................................................................................................................655
Update connections.......................................................................................................657
Design connections........................................................................................................657
 Steel connection formation rules ...............................................................................658
Recommended workflows for specific connection types..........................................659
Limitations when using Tekla Connection Designer with Tekla Structural Designer

..........................................................................................................................................................660
 Export connections to another application for design ................................................. 661

7.6 Drift, sway, seismic drift, wind drift, and overall displacements........... 662
 Drift check............................................................................................................................662

Run the check................................................................................................................. 663
Review the check status and details............................................................................ 663
Review the check graphically........................................................................................ 665
Switching off inappropriate checks and merging stack lengths...............................666
Printing calculations.......................................................................................................667

 Sway check.......................................................................................................................... 667
Run the check................................................................................................................. 667
Review the check status and details............................................................................ 667
Review the check graphically........................................................................................ 669

14



Switching off inappropriate checks and merging stack lengths...............................670
Printing calculations.......................................................................................................671

 Seismic drift check..............................................................................................................671
Configure the check and set the limit..........................................................................671
Run the check................................................................................................................. 671
Review the check status and details............................................................................ 672
Review the check graphically........................................................................................ 673
Switching off inappropriate checks and merging stack lengths...............................674
Printing calculations.......................................................................................................675

 Wind drift check.................................................................................................................. 675
Configure the check and set the limit..........................................................................675
Run the check................................................................................................................. 676
Review the check status and details............................................................................ 676
Review the check graphically........................................................................................ 678
Switching off inappropriate checks and merging stack lengths...............................679
Printing calculations.......................................................................................................679

 Overall wind drift check..................................................................................................... 679
Configure the check and set the limit..........................................................................680
Run the check................................................................................................................. 680
Review the check status and details............................................................................ 681

 Overall displacement ........................................................................................................ 681
 Common tasks for sway and drift checks........................................................................681

Automatically merge short stacks................................................................................682
Set the wind drift limit................................................................................................... 682
Choose resultant or directional wind drift checks..................................................... 683
Consider wind cases only for the wind drift check.................................................... 683
Switch off sway checks for selected columns/walls...................................................683
Switch off drift checks for selected columns/walls.................................................... 684
Switch off seismic drift checks for selected columns/walls...................................... 684
Switch off wind drift checks for selected columns/walls...........................................684
Switch off tabular results for an entire level ..............................................................685
Override the wind drift limit for selected columns/walls..........................................685
Adjust column stack or wall panel check lengths.......................................................685
 Considerations for non-linear models with Tension Only bracing ........................ 686
 Perform checks..............................................................................................................686
Review tabular results in a Data Table........................................................................ 686
Review results graphically in a Show / Alter State view ............................................687
Create a report............................................................................................................... 687

8 Create and design foundations................................................688
8.1 Create isolated foundations........................................................................ 688

 Create pad bases and strip bases.................................................................................... 688
Create pad base columns..............................................................................................688
Create strip base walls...................................................................................................689

Create a pile type catalogue...............................................................................................690
Create pile caps................................................................................................................... 690

Create pile cap under a specific column..................................................................... 690
Create multiple pile caps...............................................................................................691
Create a user-defined pile arrangement.....................................................................691

8.2 Design isolated foundations........................................................................ 692
Design or check all pad bases and strip bases................................................................ 692
Design or check all pile caps.............................................................................................. 692
Check an individual isolated foundation.......................................................................... 692
Design an individual isolated foundation.........................................................................693

15



8.3 Create mat foundations .............................................................................. 693
Create mats.......................................................................................................................... 694

Create a minimum area or rectangular mat...............................................................694
Create a strip mat...........................................................................................................695
Create an area mat........................................................................................................ 695
Create a mat within bays...............................................................................................695

Place piles and pile arrays in mats.................................................................................... 696
Specify if a piled mat is ground bearing...................................................................... 696
Place an individual pile in a mat...................................................................................696
Place a pile array in a mat............................................................................................. 696
Specify the pile direction of an inclined pile............................................................... 697

8.4 Design mat foundations............................................................................... 698
Design or check all mats in the model..............................................................................698
Check all mats in a single floor.......................................................................................... 698
Design all mats in a single floor.........................................................................................698
Check an individual mat..................................................................................................... 698
Design an individual mat.................................................................................................... 698

9 Review models........................................................................... 700
9.1 Review designs.............................................................................................. 700

Set the design type to review.............................................................................................701
Review member design...................................................................................................... 701

Review member design status..................................................................................... 701
Review member design ratios...................................................................................... 702
Review member depth ratios....................................................................................... 702

Review foundation and pile design................................................................................... 702
Review foundation or pile status..................................................................................702
Review foundation or pile ratios.................................................................................. 703

Review slab and mat design...............................................................................................703
Review slab and mat design status..............................................................................703
Review slab and mat design ratios...............................................................................704
Filter slab and mat design information....................................................................... 704

Design review filters............................................................................................................705
Working with the Status filter....................................................................................... 705
Working with the Utilization ratio filter....................................................................... 709
Working with the Entity type filter................................................................................713

9.2 Review model properties (show/alter state)............................................. 716
Modify autodesign settings................................................................................................ 717
Review and modify diaphragm settings........................................................................... 718

Review the diaphragm settings.................................................................................... 718
Modify the diaphragm settings of slab items or roofs.............................................. 718
Include or remove solver nodes from the diaphragm.............................................. 719

Modify end fixity.................................................................................................................. 719
Modify BIM status................................................................................................................720
Copy or modify slab and foundation reinforcement...................................................... 720

Copy reinforcement....................................................................................................... 721
Modify reinforcement....................................................................................................721

Copy section sizes................................................................................................................722
Copy material grades.......................................................................................................... 722
Copy properties................................................................................................................... 723
Review and modify member filters................................................................................... 723
Review sub structures.........................................................................................................724
Review concrete beam flanges.......................................................................................... 724
Review and modify column splice positions.................................................................... 725

16



Review and apply property sets.........................................................................................725
Copy or modify user-defined attributes........................................................................... 725
Show/alter state...................................................................................................................725

Modify active / inactive settings................................................................................... 727
Modify assumed cracked settings................................................................................728
Modify slenderness settings......................................................................................... 731
Review and set camber................................................................................................. 732
Apply cantilever ends.....................................................................................................734
Review carbon factors................................................................................................... 734
Review and copy deflection limits................................................................................735
Review and modify drift checks....................................................................................736
Apply fire proofing......................................................................................................... 737
Modify gravity only settings.......................................................................................... 739
Review and set imposed load reduction..................................................................... 739
Review and set live load reduction.............................................................................. 741
Override effective width................................................................................................ 743
Modify punching shear check position........................................................................743
Copy quick connector layout........................................................................................ 744
Review and modify restraints....................................................................................... 745
Apply rotational stiffness to a beam end.................................................................... 752
Review and modify seismic drift...................................................................................752
Review and modify SFRS settings.................................................................................753
Copy shear connectors..................................................................................................754
Modify SidePlates...........................................................................................................754
Review and copy size constraints.................................................................................755
Modify stud auto layout................................................................................................ 755
Review and modify sway checks.................................................................................. 756
Copy transverse reinforcement....................................................................................757
Review and modify user defined U/R.......................................................................... 757
Review utilization and embodied carbon....................................................................759
Copy web openings........................................................................................................760
Copy westok openings...................................................................................................760
Review and modify wind drift checks.......................................................................... 761
Modify wind loading...................................................................................................... 762

9.3 Review tabular data......................................................................................762
Review design summary tabular results...........................................................................763
Review inter-story shear tabular results...........................................................................764

Create inter-story shear tabular results...................................................................... 764
Review sway check tabular results.................................................................................... 765

Review sway check tabular results from the Project Workspace Status Tree ....... 765
Review sway check tabular results from a Review View ...........................................766
Locate check in a 3D view............................................................................................. 767

Review story shear tabular results.................................................................................... 768
 Inter-story shear and cumulative story shear........................................................... 769

Review drift check tabular results..................................................................................... 770
Review drift check tabular results from the Project Workspace Status Tree ........ 771
Review drift check tabular results from a Review View ............................................771
Locate check in a 3D view............................................................................................. 772

Review seismic drift check tabular results....................................................................... 774
Review seismic drift check tabular results from the Project Workspace Status Tree

..........................................................................................................................................................774
Review seismic drift check tabular results from a Review View............................... 775
Locate check in a 3D view............................................................................................. 776

Review wind drift check tabular results............................................................................777
Review wind drift check tabular results from the Project Workspace Status Tree 778

17



Review wind drift check tabular results from a Review View .................................. 779
Locate check in a 3D view............................................................................................. 780

Review material list tabular results................................................................................... 782
Create material list tabular results...............................................................................782
Locate material list rows in a 3D view......................................................................... 785
Export material list to Excel.......................................................................................... 786
Material lists for steel.................................................................................................... 786
Material lists for concrete............................................................................................. 792
Material lists for timber................................................................................................. 803
Material lists for cold formed....................................................................................... 805
Material lists for general materials.............................................................................. 806

Review embodied carbon detail........................................................................................ 808
Create embodied carbon detail tabular results......................................................... 808
Locate tabular data in a 3D view.................................................................................. 809

Review embodied carbon overview.................................................................................. 809
Create embodied carbon overview tabular results................................................... 809
Locate tabular data in a 3D view.................................................................................. 810

Review floored area tabular results.................................................................................. 810
Filter tabular data................................................................................................................ 811

Create and apply filters................................................................................................. 811
Edit filters........................................................................................................................ 811

Export tabular results to Excel........................................................................................... 811

10 Calculate slab deflections ........................................................812
10.1 Get started with slab deflection analysis ..................................................812
10.2 Work with event sequences.........................................................................813

 Add an event to the end of the event sequence............................................................ 813
 Insert an event within the event sequence..................................................................... 813
 Re-order events in the event sequence...........................................................................813
 Remove an event from the event sequence................................................................... 814
 Edit event parameters........................................................................................................814
 Edit event loadcases...........................................................................................................814
 Create a custom event sequence..................................................................................... 815
 Apply a custom event sequence to a submodel.............................................................815

10.3 Work with check lines...................................................................................815
 Create the deflection checks to be applied to check lines............................................ 816
 Create a check line............................................................................................................. 816
 Delete a check line..............................................................................................................816

10.4 Run a slab deflection analysis..................................................................... 817
 Run a slab deflection analysis for the current sub model.............................................817
 Run a slab deflection analysis for all sub models...........................................................817
 Run a slab deflection analysis for selected sub models................................................ 818

10.5 Slab deflection results and reports.............................................................818
 Display slab deflection analysis results........................................................................... 818

 Display deflection contours......................................................................................... 818
 Display extent of cracking............................................................................................ 819
 Display relative stiffness...............................................................................................819
 Display effective reinforcement.................................................................................. 820

 Display check line results...................................................................................................820
 Display deflections along all check lines.................................................................... 820
 Display detailed deflections and average slopes along an individual check Line. 820
 Display check line status and utilization.....................................................................821

 Display slab deflection status and utilization..................................................................821

18



 Display slab deflection status...................................................................................... 821
 Display slab deflection utilization................................................................................822

 Slab deflection optimization .............................................................................................823
View slab deflection reports...............................................................................................823

 View an individual check line report........................................................................... 824
 View all/multiple check line reports............................................................................824
 View an effective modulus report............................................................................... 824

11 Create reports and drawings................................................... 825
11.1 Create and modify reports...........................................................................825

Report terminology............................................................................................................. 825
Model reports................................................................................................................. 825
Member reports............................................................................................................. 826
Active model report....................................................................................................... 827
Active member report................................................................................................... 827
Active and inactive chapters......................................................................................... 827
Report filters................................................................................................................... 827
Available styles............................................................................................................... 828

 Create reports.....................................................................................................................828
Configure and display model reports..........................................................................828
Configure and display member reports...................................................................... 829
Select the member report style....................................................................................830
Modify the report structure.......................................................................................... 831

Filter reports.........................................................................................................................832
Create filters................................................................................................................... 832
Apply filters..................................................................................................................... 833

 Format reports ...................................................................................................................834
Adjust and apply report settings.................................................................................. 834
Adjust report headers and footers.............................................................................. 834

 Navigate reports ................................................................................................................ 836
Navigation using the Report Index...............................................................................837
Navigation buttons in the Report toolbar .................................................................. 837

Export reports......................................................................................................................838
Export a report to PDF...................................................................................................838
Export a report to Microsoft Word...............................................................................838
Export a report to Excel.................................................................................................838
Export a report to Tekla Tedds..................................................................................... 838

Print reports......................................................................................................................... 838
Example reports.................................................................................................................. 839

Beam End Forces report................................................................................................839
Bracing Forces report.................................................................................................... 841
Building Analysis & Drift Checks report.......................................................................841
Building Design report...................................................................................................842
Building Loading report.................................................................................................842
Connection Resistance report...................................................................................... 842
Embodied Carbon report.............................................................................................. 843
Foundation Reactions report........................................................................................843
Industrial Structure Loading report............................................................................. 844
Material Listing report................................................................................................... 844
Member Design report.................................................................................................. 846
Open Structure Wind Load report............................................................................... 847
Seismic Design report....................................................................................................847
Solver Model Data report..............................................................................................847

11.2 Create drawings............................................................................................ 848

19



 Drawing categories.............................................................................................................848
Adjust and apply drawing settings.................................................................................... 851

Adjust drawing settings in the current project........................................................... 851
Adjust drawing settings in future projects.................................................................. 851
Create drawing scales....................................................................................................851
Create, modify, or delete layer configurations........................................................... 852
Create, modify, or delete layer styles.......................................................................... 853

 Create planar drawings......................................................................................................855
Create general arrangement drawings....................................................................... 855
Create beam end force drawings.................................................................................856
Create column splice load drawings............................................................................857
Create foundation reaction drawings..........................................................................858
 Create loading plan drawings...................................................................................... 859

Create member detail drawings........................................................................................ 859
Create concrete beam detail drawing......................................................................... 860
Create concrete column detail drawing...................................................................... 860
Create concrete wall detail drawing............................................................................ 861
Create non-concrete beam detail drawing................................................................. 862
Create non-concrete column detail drawing.............................................................. 862
Create base plate detail drawing..................................................................................863

Create slab and mat drawings........................................................................................... 863
Create slab or mat layout drawings.............................................................................864
Create punching shear check detail drawings............................................................864

 Create foundation drawings............................................................................................. 865
Create isolated foundation detail drawings................................................................865
Create foundation layout drawings............................................................................. 866

Create concrete member schedule drawings..................................................................866
Create concrete beam schedule drawings..................................................................867
Create concrete column schedule drawings...............................................................868
Create concrete wall schedule drawings.....................................................................868

 Manage drawings in batches............................................................................................ 869
Create or generate drawings in batches..................................................................... 870
Specify the drawing layout............................................................................................871
Specify the loading for load-dependent drawings..................................................... 871
Reset reinforcement marks in concrete detail drawings.......................................... 872
View drawings.................................................................................................................872
Review drawings.............................................................................................................873
View the revision history of drawings..........................................................................873

Manage schedule drawings in batches.............................................................................874
Create new schedule drawings.................................................................................... 874
Specify the schedule drawing layout........................................................................... 874
View schedule drawings................................................................................................ 875
Reset reinforcement marks in schedule drawings.....................................................875
Review schedule drawings............................................................................................ 875
View the revision history of schedule drawings......................................................... 876

12 Manage models..........................................................................877
12.1 Apply and manage model settings..............................................................877

Define and modify head codes and design codes.......................................................... 878
Change design codes in an existing project................................................................878
Define default design codes for new projects............................................................ 879

Define and modify units..................................................................................................... 879
Change units and unit precision in an existing project............................................. 880
Define the default units and unit precision for new projects...................................880

Manage object references..................................................................................................881

20



Basics of object reference formats.............................................................................. 882
Modify reference formats and texts in an existing project.......................................884
Modify the reference format syntax of an object type..............................................884
Change the text used for the materials and characteristics in the reference format

..........................................................................................................................................................885
Renumber members......................................................................................................885
Renumber slabs..............................................................................................................885
Adjust the default references to be applied to new projects................................... 886

12.2 Manage settings sets.................................................................................... 886
Add a new settings set........................................................................................................ 886
Import a settings set for a different region......................................................................887
Edit the content of a settings set....................................................................................... 887
Change the active settings set........................................................................................... 888
Delete a settings set............................................................................................................ 888
Load settings from the active settings set to the current project................................. 888
Save settings from the current project to the active settings set..................................889
Copy a settings set from one computer to another........................................................889

12.3 Manage materials ........................................................................................ 890
Add, modify and delete user-defined sections................................................................ 891

Add a user-defined custom or compound section to the material database........ 891
Modify a user-defined custom or compound section in the material database....891
Delete a user-defined custom or compound section from the database...............892

Manage design section orders...........................................................................................892
View the list of sections in a design section order..................................................... 892
Specify that a section in the list should not be considered for design....................893
Sort the listed sections by a different property..........................................................893
Specify that a section is non-preferred....................................................................... 893
Reset a design section order back to the original default.........................................894
Create a new Design section order..............................................................................894

Add simple connection resistances to the database...................................................... 895
Pre-defined connection types and resistances.......................................................... 895
Add user-defined connection types.............................................................................896
Edit user-defined connection types............................................................................. 898
Add user-defined connection resistances...................................................................898
Related video.................................................................................................................. 902

Add material properties from the model to a material database.................................902
Add materials for a head code...........................................................................................902

Add a material grade for a head code.........................................................................903
Add a reinforcement class for a head code................................................................ 903
Add new reinforcement sizes....................................................................................... 904
Specify the bar size range to be applied in auto design............................................904
Change default design sections for a different head code....................................... 905
Change default design section orders for a head code............................................ 905
Create new section orders for a head code................................................................906

Upgrade material databases..............................................................................................906
 Timber property assumptions.......................................................................................... 907
Add and manage embodied carbon factors.................................................................... 908

Set up a global set of factors........................................................................................ 908
Set up and edit the local set of factors........................................................................ 908
Add factor........................................................................................................................909
Edit factor........................................................................................................................ 910
Remove factor................................................................................................................ 911
Reorder the list of factors............................................................................................. 911
Set a factor as active or inactive................................................................................... 911
Export factors to a spreadsheet................................................................................... 911

21



12.4 Manage properties and property sets ....................................................... 912
Save properties to and recall properties from property sets........................................ 912

Save properties from the Properties window to a new property set...................... 912
Save the properties of an existing entity to a named property set......................... 913
Recall a previously saved property set to the Properties Window.......................... 913

Apply property sets to existing entities............................................................................ 913
Apply a property set to an individual entity in a Structural View............................. 913
Apply a property set to multiple members in a Structural View.............................. 914
Apply a property set in a Review View.........................................................................914

Review where property sets have been applied..............................................................914
Transfer property sets between models.......................................................................... 915

Export property sets...................................................................................................... 915
Import property sets......................................................................................................915

Delete property sets............................................................................................................916
12.5 Create and manage user-defined attributes ............................................ 916

Create attribute definitions................................................................................................ 917
Create attribute definitions in the current model......................................................917
Create attribute definitions for new models.............................................................. 918

Attach UDA values to members and panels.....................................................................918
Attach a UDA value using the Properties Window..................................................... 918
Attach an existing UDA value in the Review View...................................................... 919
Graphically review the attached UDA values..............................................................919
Open a file that has been attached as a UDA.............................................................920

Apply attribute filters to material lists and reports.........................................................920
Apply an attribute filter to material list review data.................................................. 920
Apply an attribute filter to a report..............................................................................920

12.6 Manage sub structures.................................................................................921
Sub structure characteristics............................................................................................. 921
Create a sub structure........................................................................................................ 921
Edit a sub structure............................................................................................................. 922
Delete a sub structure........................................................................................................ 923
Rename a sub structure..................................................................................................... 923
Review sub structures.........................................................................................................924
Create a sub structure group.............................................................................................924
Open a 3D view of a sub structure....................................................................................924
Use Ghosted to see the view in the context of the whole model..................................925

12.7 Working with large models ......................................................................... 927

13 Tekla Structural Designer reference ...................................... 930
13.1 Properties.......................................................................................................930

Structure Properties............................................................................................................931
Level Properties................................................................................................................... 933
Frame Properties.................................................................................................................935
Slope Properties.................................................................................................................. 936
 Sub Model Properties ....................................................................................................... 937
 Beam properties................................................................................................................. 938

 Beam releases .............................................................................................................. 949
Fire proofing................................................................................................................... 950

 Brace properties................................................................................................................. 951
 Column properties............................................................................................................. 956

Design parameters (Eurocode only)............................................................................ 964
 Column releases ...........................................................................................................965

 Concrete meshed and mid-pier wall properties.............................................................965

22



 Concrete core properties...................................................................................................973
 General wall properties..................................................................................................... 974
Member characteristic, construction and fabrication properties................................. 978
 Slab item properties...........................................................................................................982
 Foundation mat properties............................................................................................... 988
 Slab/Mat overhang properties.......................................................................................... 993
Pad base strip base and pile cap properties....................................................................993
 Line ancillary properties.................................................................................................. 1001
 Area ancillary properties................................................................................................. 1004
 Equipment properties......................................................................................................1006
 Bearing wall properties....................................................................................................1008
 Shear only wall properties...............................................................................................1011
 Wall Panel Properties ......................................................................................................1013

 Parapet wall panel load decomposition ..................................................................1014
 Roof Panel Properties ..................................................................................................... 1015
 Support properties ..........................................................................................................1017
 Analysis Element properties........................................................................................... 1020
 Base plate properties.......................................................................................................1022
 Patch properties............................................................................................................... 1024
 Punching check properties..............................................................................................1027
 Result strip properties..................................................................................................... 1031

13.2 Settings.........................................................................................................1032
Model Settings................................................................................................................... 1032

Design code settings....................................................................................................1033
Unit settings..................................................................................................................1035
Object reference settings............................................................................................1035
Loading settings........................................................................................................... 1037
Grouping model settings.............................................................................................1038
Material list settings.....................................................................................................1039
Beam lines settings......................................................................................................1039
 Analysis Model settings.............................................................................................. 1040
 Validation settings.......................................................................................................1042
 Live/imposed load reduction settings...................................................................... 1043
 Global Imperfections settings....................................................................................1044
 User-defined attribute settings ................................................................................ 1045
 Graphics view settings................................................................................................1047
Structural BIM settings................................................................................................ 1048

Analysis Settings................................................................................................................ 1050
1st order non-linear settings...................................................................................... 1050
2nd order non-linear settings.....................................................................................1051
1st order modal settings............................................................................................. 1052
2nd order buckling settings........................................................................................ 1055
1st order seismic settings........................................................................................... 1056
Iterative cracked section analysis settings................................................................1060
Modification factors.....................................................................................................1061
Meshing settings.......................................................................................................... 1062
Composite steel beams settings................................................................................ 1062

Design Settings.................................................................................................................. 1064
Design Settings - General and Analysis..................................................................... 1065
Design Settings - Steel > General (Eurocode only)................................................... 1067
Design Settings - Steel > Composite Beams............................................................. 1068
Design Settings - Steel > Steel Joists.......................................................................... 1069
Design Settings - Concrete > Cast-in-place............................................................... 1070
Design Settings - Concrete > Precast.........................................................................1094
Design Settings - Design Forces................................................................................. 1097

23



Design Settings - Design Groups and Autodesign................................................... 1113
Design Settings - Design Warnings............................................................................ 1115
Design Settings - Sway & Drift Checks....................................................................... 1119
Design Settings - Fire check........................................................................................ 1121
Design Settings - Timber............................................................................................. 1121

Slab deflection settings.....................................................................................................1122
Drawing settings................................................................................................................1126

Export preferences...................................................................................................... 1126
Layer configurations.................................................................................................... 1127
Layer styles................................................................................................................... 1128
Planar drawing options............................................................................................... 1129
Member detail options................................................................................................ 1138
Member schedule options.......................................................................................... 1146
Slab and mat layout options.......................................................................................1147
Slab and mat punching check detail options............................................................1153
Foundation layout options..........................................................................................1153
Isolated Foundation detail options............................................................................ 1158

Settings set settings.......................................................................................................... 1160
 General settings................................................................................................................1161
Results Viewer settings..................................................................................................... 1163
Structure default settings.................................................................................................1164
Section default settings.................................................................................................... 1164
Section order default settings..........................................................................................1164
Solver settings....................................................................................................................1165
Scene settings.................................................................................................................... 1165
Report settings...................................................................................................................1168
Embodied carbon settings............................................................................................... 1171
 Performance settings.......................................................................................................1172

13.3 Dialogs.......................................................................................................... 1172
 Analysis Settings dialog................................................................................................... 1173
 Connection Resistance dialog......................................................................................... 1174

1. Title Bar..................................................................................................................... 1175
2. Filters......................................................................................................................... 1175
3. Connection Types.................................................................................................... 1176
4. Info box..................................................................................................................... 1176
5. Resistances............................................................................................................... 1176
6. OK and Cancel.......................................................................................................... 1177

 Construction Levels dialog.............................................................................................. 1177
 Design Settings dialog......................................................................................................1179
 Drawing Settings dialog................................................................................................... 1180
 Edit Reinforcement dialog............................................................................................... 1180

1. Use reinforcement...................................................................................................1181
2. Preview graphic........................................................................................................1181
3. Auto-design...............................................................................................................1184
4. Select reinforcement parameters..........................................................................1184
5. Studs parameters.................................................................................................... 1185
6. Buttons......................................................................................................................1185

 Embodied Carbon Factors dialog................................................................................... 1186
1. Category filter...........................................................................................................1187
2. Entity filter.................................................................................................................1187
3. Active flag .................................................................................................................1188
4. Filtered list of embodied carbon factors ..............................................................1188
5. Embodied carbon factor item................................................................................ 1188
6. Number of entities the factor currently applies to.............................................. 1189
7. Defined factors applied to possible entities message.........................................1189

24



8. Add factor................................................................................................................. 1189
9. Edit factor..................................................................................................................1191
10. Remove factor........................................................................................................ 1193
11. Export...................................................................................................................... 1193
12. Load and Save........................................................................................................ 1193
13. View options........................................................................................................... 1194
14. OK and Cancel........................................................................................................ 1194

 Load Event Sequences dialog......................................................................................... 1194
1. Event sequences and submodels pane.................................................................1195
2a. Event sequence parameters table (Eurocode)................................................... 1198
2b. Event sequence parameters table (ACI)..............................................................1200
3. Update custom event sequences...........................................................................1200
4. Buttons......................................................................................................................1201

Materials dialog................................................................................................................. 1201
Sections settings...........................................................................................................1202
Material settings...........................................................................................................1202
Reinforcement settings............................................................................................... 1203
Decking settings........................................................................................................... 1204
Shear Connectors settings.......................................................................................... 1205
Bolts (Rods in US) settings.......................................................................................... 1205
Welds settings...............................................................................................................1206
Model settings.............................................................................................................. 1207

Model Settings dialog........................................................................................................1207
Sections dialog...................................................................................................................1208
Settings dialog....................................................................................................................1209
 Slab Deflection Check Catalogue....................................................................................1211
 Snow wizard (Eurocode).................................................................................................. 1211
 Snow wizard (ASCE7)........................................................................................................1220
 Sub Models dialog............................................................................................................ 1223
 Slab Deflection Settings dialog....................................................................................... 1225

25



26



1 Installation and licensing
workflow

To use Tekla Structural Designer, you need to have a license. The installation
steps you need to take are different depending on the type of license you
have: for server licensing, you need to install additional tools, which are not
necessary when using online licenses.

Click to expand the section relevant to you and follow the links in the text for
detailed instructions.

1.1 Tekla Structural Designer license types
Tekla Structural Designer cannot be used without a valid license. There are
two types of license: online and server*

• An online license is connected to your Trimble Identity. The license is
delivered directly to the Tekla Online Admin tool, where your company's
Tekla Online account administrators can assign the online licenses to
individual users. When Tekla Structural Designer starts, you log in to
Trimble's cloud to reserve your license.

• If you have a server license, you need to install a license server on your
computer or on a separate server in your internal network. Tekla Structural
Designer connects to your local license server to check your license.

*Local and local USB legacy licenses are still supported, but are no longer
available as new purchases.
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1.2 If you manage your own installation of Tekla
Structural Designer

NOTE To ensure a good experience using our software, make sure your computer
meets the Tekla Structural Designer 2021 hardware recommendations
(page 29).

If your organization has no main user who manages Tekla Structural Designer
for you, your installation proceeds like this:

1. Make sure you have your Trimble Identity set up:

a. If you have received an email invitation from Trimble to create a
Trimble Identity, follow the instructions in the email to create your
account to ensure you have the correct access rights.

If you wish to use a different email address for this account, create
the account using your invitation first and then change the email
address.

b. If you have not received an invitation, you can create a new Trimble
Identity to download the software. Click here to create a new Trimble
Identity.

To have access to your online licenses, you must be added to an
organization group in Tekla Online by your organization's account
administrator.

2. If you have a new account, Log in at https://account.tekla.com/, fill in all
the required profile information, and click Save.

3. Download the installation package for Tekla Structural Designer from
Tekla Downloads. At the site, click Download for a guided experience that
ensures you have all necessary files.
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4. If you have an online license, install the software:

• Run the Tekla Structural Designer installer and make sure the
installation finishes successfully.

See Install and license Tekla Structural Designer (page 33) if you need
more detailed instructions.

• After you have completed the Tekla Structural Designer installation,
you can now start Tekla Structural Designer

5. If you have a server license, install the software:

• At the Server - Install the license server software on the server and
activate your licenses.

See also: How can I centrally deploy Tekla software? (page 38)

• At the Client PCs - Run the Tekla Structural Designer installer and make
sure the installation finishes successfully.

See also: Install and license Tekla Structural Designer (page 33) if you
need more detailed instructions.

6. Start learning how to use Tekla Structural Designer:

• For a brief overview, see Get familiar with Tekla Structural Designer
(page 43).

1.3 If someone manages Tekla Structural Designer for
you
If your organization has a Tekla Structural Designer administrator (IT
administrator or main user), you should follow their instructions for
installation and licensing. You may still need to consider the following points:

• You need an account to access Tekla online services and online licenses. If
your administrator has not invited you to your organization and assigned
online licenses to you, ask to join so that you have access to all Tekla online
services and licenses:

Click here to create a new Trimble Identity

• In most cases, your Tekla Structural Designer administrator will prepare an
installation package for you or install the software for you. Ask your
administrator for further instructions.

Start learning how to use Tekla Structural Designer:

• For a brief overview, see Get familiar with Tekla Structural Designer
(page 43).
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1.4 Tekla Structural Designer 2021 hardware
recommendations

System requirements for effective operation
CPU: Multi core Intel i5 Series or above, Xeon or AMD equivalent

• Highest affordable performance recommended.

Memory: 16GB (32GB or more recommended)

• Memory requirements are highly dependent on model content.

OS: 64-bit Microsoft Windows 8.1 / 10

• Operating systems must be running the latest service packs / updates.

• Graphics: 1600 x 900 resolution (1920 x 1080 or higher recommended)

• 1GB or higher of dedicated RAM.

• Utilizes HOOPS Visualize, a third party graphics engine available from
Tech Soft 3D. To check your adapter’s compatibility visit the HOOPS
developer website for HOOPS 25.x, DirectX and OpenGL requirements.

• Disk space: 1GB or more of free space for installation

• Operational disk space requirements are highly dependent on model
content.

Internet connection: Required for access to Online Services and some
documentation.

License Service:

• Tekla Structural License Service 3.00 including Sentinel RMS 9.5

License Server: The latest version of the Tekla Structural Licence Service, at
time of release, is shipped and installed with the software. If you have chosen
to have a separate licence server, it is always our recommendation that you
also run the latest version of the Tekla Structural License Service on it to
ensure compatibility. Please see System Requirements for specific version
details.

Test environments
The application is tested and supported on the following business versions of
Microsoft Windows with the latest updates applied:

• Windows 10 64-bit

• Windows 8.1 64-bit
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1.5 Create your Trimble Identity
You need a Trimble Identity to download Tekla Structural Designer and to use
your online licenses. The Trimble Identity is connected to a Tekla Online
organization (a user group for your physical organization).

Creating a Trimble Identity on your first license purchase
• If you did not have an existing Trimble Identity, Trimble sends you an email

with an invitation to complete your account creation. Create your account
using the link in this email and make sure you fill in all of the required user
profile information.

• If you are a company's named contact, you are invited to your Tekla Online
organization by Trimble when the organization is created in Tekla Online.

You will receive an email to accept membership in your new Tekla Online
organization. You are then responsible for managing the organization
together with other administrators that you may assign.

Creating a Trimble Identity to join an existing organization
To create a new Trimble Identity account:

1. If you have received an email invitation from Trimble to create a Trimble
Identity, follow the instructions in the email to create your account to
ensure you have the correct access rights. Otherwise, Click here to create
a new Trimble Identity.

2. Complete the Create new account form and click the Create new
account button.

If you have several different email addresses, use your company email
address
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3. Look for a verification email in your inbox and click the link provided to
verify you account. You must verify your account to access your Trimble
Identity.

NOTE If you do not receive this email in your inbox, check your Spam/
Junk email folder.

4. Log in with your new account, fill in all the required profile information,
and click Save.

5. Join your Tekla Online organization in one of the following ways:

a. Switch to the Organization page on your user profile page, select an
organization that you would like to join, and click Send request. If
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there are no organizations listed, it means your email address does
not match with any existing organization's email address.

b. Ask your company's Trimble Identity administrator to invite you, and
accept the invitation when it arrives via email or on your user profile
pages at https://account.tekla.com/.

Your Trimble Identity is now active, and you can install and license
Tekla Structures.

NOTE Membership in an organization can also affect your access to
your organization's cloud-stored data, such as Tekla Model
Sharing models. Make sure you do not switch between
organizations unnecessarily. When available, use your
company email address with your Trimble Identity.

1.6 Install and license Tekla Structural Designer
When you install Tekla Structural Designer, you will be asked to select your
license method from a range of options. These are fully explained in the "Tekla
Engineering Software - Installation and Licensing Guide 2021" which can be
viewed during the installation process by clicking the button shown below.
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To install Tekla Structural Designer:

1. Download the installation file from Tekla Downloads to your computer.

2. Double-click the installation file to run the installation.

3. Follow the steps in the installation wizard to complete the installation.

Licensing & installation information specific to Tekla
Structural Designer 2021
• Licensing:

• Perpetual Licenses - for perpetual licenses using Sentinel RMS (both
local and server), Tekla Structural Designer 2021 will require the
activation of a new 2021 version license. You should already have
received your 2021 Product Activation Key (PAK) as these are usually
distributed prior to the software release. Please contact your local
Service Department now if you do not have your PAK. To minimize any
down time, we recommend you activate your PAK BEFORE installing this
release.

• License Server Version - if you are using Sentinel RMS Server
Licenses, the Tekla Structural License Service on your license server
must be updated to the new version 3.2.x or later (incorporating
Sentinel RMS 9.7) to be compatible with this release. The installation
for this can be obtained from Tekla Downloads. Sentinel RMS server
licensing will not function correctly if this update is not performed!

• For more information about this please see the TUA Article Tekla
Structural Design Releases for 2021 & Sentinel RMS Server
Licensing - the License Server must be updated and the
associated FAQ Article.

• Subscription Licenses - if you have Subscription Licenses they will
use the new Tekla Online License Method and the 2021 license(s)
should already have been added to your Tekla Online Organization.
Select the “Tekla Online” license method option when installing the
program as shown in the picture below (only select the “Automatic”
license method if you have both subscription licenses and Sentinel RMS
server licenses as described in this TUA Article).
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• In order to use a Tekla Online license you will need: a verified
Trimble Identity & Tekla OnlineAccount; to be a member of your
company's Tekla Online Organization; have an Online License
assigned to you by your Organization’s Administrator; to Sign In to
your Tekla Online account when you run the program.

• For more guidance on using Tekla Online Licensing see the
following videos; Using Tekla subscription licenses and Managing
Tekla subscription licenses.

• Installation - no previous installation of Structural Designer is required. To
aid with transition, this release will install alongside existing versions and
does not overwrite them.

• Integration

• Tekla Structures - if you wish to integrate with Tekla Structures you
should install both this release and Tekla Structures 2021 for
optimum performance.

• Note that there have been significant improvements to
integration - especially for rebar - in the 2021 releases. For more
information about this please see the Tekla Structures Help Topic
Tekla Structural Designer Import and Export.

• Tekla Portal Frame and Connection Designer 21 - if you wish to
integrate this release with Tekla Portal Frame Designer and/or Tekla
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Connection Designer (or if you use these stand-alone) you should
install the new Tekla Portal Frame Designer 21 and/or Tekla
Connection Designer 21 available from the Tekla Download Service
(note that these too will also need a new license).

• Note that Tekla Portal Frame Designer release 21 features a
significant enhancement for the Eurocode to improve the
classification of haunches for the case when they may be Class 4
slender as detailed in this release note. For full details please see
the Tekla Portal Frame Designer 21 release notes.

• Tekla Tedds - for integrated design using Tekla Tedds you should
install the 2021 release for Tekla Tedds.

• Previous Versions and file compatibility - files from all previous
versions can be opened in this release however, note that, once saved,
they cannot then be opened in a previous release. If you wish to retain
this option we therefore recommend using the File > Save As… option to
save a copy of the file in the previous release and retain the original.

• Databases - Some Databases are updated in this release. For an
existing installation of a previous release, your local Databases will
automatically be updated (it is no longer necessary to do this manually
via Home > Materials). This process works as follows:

• Providing all databases can be updated automatically without user
intervention, when this release is first run then the updates are
applied and a message is displayed stating "updating to latest
database versions" as shown below. On successful completion the
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message closes and the program will open.

Further help and update information

Tekla User Assistance
The Tekla User Assistance services are 24/7 online support channels for fast
self-service, where you can find all the product guides, additional knowledge-
base articles and instructional videos.

Tekla Discussion Forum
The Tekla Discussion Forum is the place to meet other users and discuss
topics related to Tekla products. You can ask questions, contribute to the
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community by sharing your knowledge or get answers from support
personnel.

Helpdesk
The Tekla Helpdesks support your daily operations so that our systems
function as expected and any problems are solved as quickly as possible.

Software Update Service
The Software Update Service allows you to get the latest improvements to
Tekla Structural Designer as soon as they are available. Providing you have an
active internet connection you will be notified by Tekla whenever a new
update is available.

The Software Update Service is enabled via Settings> General> Update Service
on the Home ribbon.

You can also check for updates at any time via Check for Updates on the Home
ribbon.

Previous versions
You can find details of requirements, enhancements and fixes for all previous
releases in Tekla User Assistance (TUA) and Tekla Downloads via the links
below:

• Tekla User Assistance Main version release notes

• Tekla User Assistance Service Pack release notes

• Tekla Downloads

How can I centrally deploy Tekla software?

I want to centrally deploy Tekla Structural Designer what do I need to
do to be able to do this?
Tekla installations are designed to support distributed deployment scenarios
using Windows Group Policy or proprietary Software Management Systems
(SMS). The SMS software will vary depending upon your chosen deployment
process and therefore we are unable to offer detailed technical assistance on
how to implement this. What we can provide is a list of requirements /
components and how to install them to allow you to package up a centralized
install in your chosen deployment process.
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Where is the information found?
Every release of the software has different dependencies so the best way for
us to distribute this information is to ship it in the installation download.
Because the vast majority of users will never need to know this we do not
provide links to the information via the installation wizard - you have to
unpack the download to find the information.

How do I unpack the install to extract the Distributed Deployment
details?
1. Run the downloaded installation package

• Allow the unpacking process to complete and the Installation wizard to
launch

2. Cancel the Installation wizard

3. Open a Windows explorer and navigate to

• C:\Program Files (x86)\Common Files\Tekla\Structural\Install Cache

4. In here there should be a sub folder related to the product and release
you are trying to install, e.g. "tekla_structural_designer_YYYY_MMYYYY"

5. Open this subfolder and open

• Distributed Deployment.htm

1.7 Tekla Structural Designer service packs
Service packs update the existing installed Tekla Structural Designer version
software. You do not need to separately install previous service packs in order
to install the most current service pack. For example, you can install service
pack 2 without installing service pack 1.

• Service packs can include new features, and improvements and fixes to
existing features. We recommend that all users install the latest service
pack.

You can find the service packs in Tekla Downloads.

Install a Tekla Structural Designer service pack
You can install a service pack to update a version or a previous service pack.
Service packs can contain new features, and improvements and fixes to
existing features
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If you have the related Tekla Structural Designer version or a previous service
pack installed on your computer, you do not need to remove it before
installing a new service pack.

To install the service pack

1. Download the service pack software installation file from Tekla
Downloads to your computer.

2. Double-click the installation file to run the installation.

3. Follow the steps in the installation wizard to complete the installation.

1.8 Upgrade Tekla Structural Designer to a new version
If you already have Tekla Structural Designer installed and are upgrading to a
new major version please note that you can have multiple Tekla Structural
Designer versions on your computer. When you install a new version you are
not required to immediately uninstall the previous version.

Service packs are cumulative updates to major versions - these replace the
previous service pack installation for the same Tekla Structural Designer
version. So you should only have the latest service pack installed per version.

To upgrade your version, simply proceed to Install and license Tekla Structural
Designer (page 33) as if you were a new user.
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The Update Service

Using the Update Service is the easiest way to keep your Tekla Structural
Designer installation up to date.
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You can check for updates at any time by selecting the "Check for Updates"
button on the Home tab of the Ribbon.

You can then install them directly from the list of updates in the Software
manager.
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2 Get familiar with Tekla
Structural Designer

Tekla Structural Designer is an integrated model-based 3D tool for analysis
and design (of both concrete and steel members) in multi-material structures.

Features include interactive modeling, automated structural analysis and
design, drawing, and report creation.

Multiple design codes are supported:

• ACI/AISC

• Eurocodes

• British Standards

• Indian Standards

• Australian Standards

2.1 Philosophy
The aim is to allow you to rapidly build your model, apply loads, and design
the model for an appropriate set of design forces.

On a day to day basis, you do not need to be involved with the underlying
analysis models to achieve this. Instead, you can focus on the design results.

To make this possible, Tekla Structural Designer automatically creates and
analyzes multiple solver models, each one being based on a different but
widely accepted approach.

By designing for the forces from all the solver models, you can be confident
that each scenario has been catered for.
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2.2 Tekla Structural Designer way of working
Tekla Structural Designer differs slightly from traditional modeling, analysis
and design process.

Traditional modeling, analysis and design process

The traditional modeling, analysis and design process can be summarized in
the following phases:

1. Provide a way to input or describe the model.

2. Analyze the model.

3. Design the model.

4. Produce calculations.

5. Produce drawings.

Process in Tekla Structural Designer

In Tekla Structural Designer, the analysis and design phases are merged into a
single process. As a result, the workflow is as follows:

1. Input the geometry and loads

A key requirement these days is BIM integration, or the ability to be able
to transfer data from one application to another. Tekla Structural
Designer has tools to automatically import model data from Neutral Files
and from 3D DXF to facilitate BIM integration.

Of course, you can also build the model directly.

Once the physical model has been created, the next step is loading it.
Tekla Structural Designer allows you to apply a wide range of loads in a
flexible system of loadcases. The system contains, among other things, a
wind load generator available to automatically create wind loadcases. You
can also generate load combinations automatically.

You should also consider pattern loading. You can create patterned beam
loads automatically, and create patterned slab loads manually for design
of slabs.

2. Analyze and design the model

Tekla Structural Designer automatically performs the analyses required to
enable member design to proceed. This means that analysis and design
are combined into a single automated process. The only exception to this
rule is slab design.

3. Produce reports

You can create a wide range of calculations. You can also tailor the
calculations extensively to meet your requirements.

4. Produce drawings

You can produce beam and column detail drawings, and member
schedules.
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2.3 Start Tekla Structural Designer
When you start Tekla Structural Designer for the first time, you are asked to
choose a country or region. Based on your selection various region specific
settings such as design codes, units and default section sizes are configured.
These settings, which can be changed to meet your company requirements,
are applied when you start each new project.

Choose the country for your settings
1. Start Tekla Structural Designer by selecting it from the Windows Start

menu or by double-clicking the desktop icon. 

A dialog box where you choose your settings appears.

2. Select a country that fits the region where your project is done.

3. Click OK The Tekla Structural Designer interface appears, with settings
configured for the selected country.

Check or change your settings
You can check or change the settings that get applied to new projects at any
time.

1. On the Home ribbon, click  Settings The Settings dialog opens,
displaying the settings that have been configured for the selected settings
set.
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2. Change the settings as needed. 

NOTE Any changes that you make only apply to new projects, existing
projects are unaffected. For more information about changing
settings, see: Manage settings sets (page 886).

Modify project details
The Project Wiki allows you to modify project details, view revision history,
and record revisions.

Modify project details and view revision history
You set the initial project details as you create a new project. If you want to
change the project details later, or view other project parameters, see the
following instructions.

1. On the Home tab, click Project Wiki. 

The Project Wiki dialog box opens.

In the Project Wiki dialog box, you can:

• Manage the parameters that are included in the output reports on the
Project Summary page.

• Track revision history on the Revisions page.

• View the time at which each revision was started and last saved on the
Sessions page.

• View the changes associated with each revision on the Changes page.

• View statistics related to the model size on the Metrics page and its
sub-pages.

2. On the Project Summary page, modify the project details according to
your needs.

3. Click OK.

Record revisions
1. Save the project before recording revisions.

2. In the file menu, click Start Revision. 

The Start Revision dialog box opens.

3. Type the revision ID and add additional notes related to the revision
according to your needs.
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4. In order to keep a record of the changes made in the revision, select the
Track Changes option.

5. Click OK.

6. Continue to develop the model and save the model under a new name.

7. Repeat steps 2–5 as required.

Apply revision ID as an attribute for each modified element

1. On the Home tab, click Project Wiki.

2. Click Changes.

3. Select an appropriate UDA from the Revision Attribute droplist.

4. Either:.

a. Click Apply automatically in order for the revision ID to be
automatically recorded against the selected UDA on each change, or

b. Click Apply to manually record the revision ID against the selected
UDA for the currently elements listed in the dialog.

5. Click OK.

Use templates in new projects
If you are creating projects that share a common start point, you can use
templates to avoid having to repeat inputting information.

In order to use a template, you must first create one.

A template can contain as much or as little information on the model as you
consider applicable to serve as the start point for subsequent models.

For example, you can create a template that only contains a simple grid and
the height of the first floor construction level.

See also

Create a new template (page 47)

Create a new project based on a template (page 48)

Create a new template
You can create a new template to simplify creating new models that have the
same starting point. For more information, see the instructions below.

1. Start a new project (page 49)

2. Create the model data that you want to include in the template.
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3. On the Home tab, click Save As. 

The Save As dialog opens.

4. Change Save as type to Tekla Structural Designer template file
(*.tsmdt).

5. Name the template and ensure that it is saved in the right location.

6. Click Save.

See also

Create a new project based on a template (page 48)

Create a new project based on a template
You can use an existing template as the base of your project. For more
information, see the following paragraphs.

NOTE Before creating a new project, ensure that an appropriate settings set
is active.

For more information, see Use settings sets.

1. On the Home tab, click . 

A list of any templates in the current folder is displayed, as well as an
Open Template option which enables you to browse in other folders for
a template.

2. In the list, select the required template, or open a template from another
folder. 

The template opens.

To continue, the template should now be saved as a project.

3. On the Home tab, click Save As 

The Save As dialog opens.

4. Change the Save as type to Tekla Structural Designer project files
(*.tsmd;*.cscbd).

5. Name the file and ensure that it is saved in the right location.

6. Click Save.

7. Add the necessary building objects and loads in order to complete the
project.
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See also

Create a new template (page 47)

2.4 Work with projects

Start a new project

1. On the Home toolbar, click  New 

NOTE Once familiar with the program, some users might prefer to set
up a template (page 47) to use as the basis for new projects -
particularly when there is a lot of commonality between projects.

Your new project opens and you will see:

• Two scene views (page 57): Structure 3D and St. Base (Base) 2D

• A tabbed (page 59)

• A (page 60)

2. Click the  Structure tab under the Project Workspace 

A Structure tree is displayed in the Project Workspace.

3. In the Structure tree, click Structure 

The Properties window displays the Structure properties.

4. In the Structure tree, click Levels 
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The Properties window changes to display Levels properties - at this
point there is only only level in the model.

NOTE The units in which the levels are displayed, (along with other
settings), have been copied into the model from the settings set
that was active when the project was started. These are known as
'model settings'. Model settings apply to the current project only
and can be edited to suit the model as required.

What to do next:

• Check or change model settings in your project (see below).

• Try setting out some grid lines (page 179) in the St. Base (Base) 2D view.

• Next, double-click Levels in the Structure tree to create some levels
(page 175).

• With grids in place and levels established, you can then open views of the
other levels (page 86).

• You are now ready to begin creating the model (page 174).

Open a project
You can have one project open at a time. If you open a project and already
have one open, Tekla Structural Designer prompts you to save the first project.

NOTE You can quickly open a recently used project, simply be selecting it
from the 'Recent documents' list that is displayed on the File menu.

1. On the Home toolbar, click Open

2. Browse to the required folder, then select a project in the list.

3. To open the selected project, click Open or double-click the project. 

Your project opens and you will see:

• The scene views (page 57) and (page 60) as they were displayed the
last time the project was saved.

• The (page 59) as it was displayed the last time the project was saved.

Check or change model settings in your project
You can check or change the model settings in the current project at any time.

1. On the Home ribbon, click Model Settings 

The Model Settings dialog opens, displaying the model settings that have
been copied in to your project from the active settings set.
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2. Change the model settings as needed. 

NOTE Any changes that you make only apply to the current project, new
projects are unaffected. For more information about changing
model settings, see: Apply and manage model settings (page 877).

2.5 Work with autosave and backups
Backups ensure that whatever happens there can be previous versions of the
model that can be reverted to.

An added benefit of backups is that they provide a limited (per user setting)
history of the model.

Following a program error, an autosave provides a single shot at reverting
back to a working model.

The difference between autosave and backup
By having both features the user can be confident that they always has a file
with the most recent changes and a backup if that fails.

Autosave Backup
The auto save file is a single
temporary file constantly overwritten
after a specified interval.

Multiple backup files are created
which are only overwritten when a
specified maximum number is
reached. Each backup is only created
if, after the specified interval, there
have been changes since the last
backup.

Provides a single shot at reverting
back to a working model following an
error.

Can be opened as and when required.

Once the model becomes corrupt the
autosave file won’t help.

Backups can be used to restore
versions of the model prior to
corruption.

The autosave file is a core save of the
model.

Similar to autosave, backups are also
a core save of the model.

Typically saved at shorter intervals
than backup.

Typically saved at longer intervals
than autosave.
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Enable autosave
1. On the Home toolbar, click Settings

2. Under Autosave, click General > Autorecover

3. Check the Enabled box and set the Interval as required.

4. Click OK.

Enable backups
1. On the Home toolbar, click Settings

2. Click General > Autorecover

3. Under Backups, check the Enabled box and set the Interval as required.

4. Accept the default location, or browse to another location if required. 

Both local and network locations are allowed.

5. Click OK. 

NOTE Backup files are saved with read-only permission.

NOTE If required you can adjust the limit on the number of backups.
Once the limit is reached the older backups start to be
automatically deleted.

Automatically restore an autosave or backup following a
Program error
To minimize the potential for lost work and possible model data corruption, a
'Program error' dialog can be displayed when an error is detected. As shown
below, when an error is detected you are presented with a number of action
options which cater for the potential situations of the model.
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We strongly recommend that you do not click Cancel, as you would then be
working with a potentially corrupted file. Instead we advise that you always
choose one of the action options and then OK.

• Where an autosave file exists, the top option will be available and is
typically the recommended choice, (although depending on the intervals
you have set, if both an autosave and a backup exist, it is possible the
backup could be the most recent version of the model, in which case the
second option should be used).

• If a previously saved version of the file exists, the third option will be
available (whether or not autosave or backup files exist) listing the last
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previous save of the model. This is the recommended choice if no autosave
or backup file exists.

• If there is a preferred previous file version the engineer wishes to revert to,
this can be selected via the option “Open another model”.

• If the model has only just been started, then none of the above scenarios
apply and so the remaining option “Start model again” is the recommended
choice.

• There is a final option to save the possibly corrupted model for submission
to your local Support Team for investigation. We would be most grateful if
engineers could use this option to help us with continuing to improve the
program. When submitting such a file, please try and include as much
information as possible about the steps undertaken in the program just
prior to the error.

Manually restore a backup
Provided you have the backup facility enabled you will have previous versions
of the project available to revert to if required. Backups work by periodically
saving the model after a specified interval. Each backup is saved to a new
name up to the point when the user definable maximum number of backups
is reached, after which the older backups are overwritten.

1. On the File menu, click Model Backups The available backups for this
Model ID are listed.

NOTE The list is for information only, backups cannot be restored
directly by selecting them from the list.

2. Click on the Backup path: to open the folder containing these backups.

3. Double-click on the required backup file to open it in another session of
Tekla Structural Designer (you may need to exit from the previous session
at this point if you only have a single license.) The backup model opens,
but note that this is read-only.

4. Click Save As from the File menu to save the backup to a new name.

2.6 Get familiar with the user interface
Before creating a new project, we recommend you take a moment to
familiarize yourself with the user interface as explained in the following topics:

• Interface components (page 55)

• How to use the project workspace (page 70)

• How to manage scene views, view modes and scene content (page 85)
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• How to hide, re-display and move windows (page 98)

• Keyboard shortcuts (page 100)

Interface components
The main components of the Tekla Structural Designer user interface are
labeled in the image below:

1. File menu
The File menu contains those commands that you can use to perform file-
related operations.

Button Description

New

Creates a new blank project from scratch.

Open

Opens an existing project.

Save

Saves the currently open project.
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Button Description

Save As

Saves the currently open project with a new name, or
as a template.

Save Model Only

Saves smaller model-only files without the analysis
results. The model-only files can easily be shared
amongst the project team.

Close

Closes the currently open project.

Print

Prints the currently open project.

Start Revision

Records changes to this revision of the project.

Send As Email

Creates a new email with the project attached.

Contact Support

Automatically uploads your model file and sends
this, together with your issue description and key
information (needed by Support to assist you) about
your installation and system, to your Local Support
Team as defined in your Tekla Online Profile.

Exit

Prompts you to save any open project, and then
closes Tekla Structural Designer.

2. Quick access toolbar

The Quick Access toolbar displays commonly used commands, listed below:

•
New

•
Open
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•
Save

•
Undo

•
Redo

•

•

•
Delete

3. Ribbon
The ribbon consists of a number of toolbars, placed on various tabs. Each
toolbar contains related commands organized into logical groups.

1. Toolbar tab

2. Command

3. Group
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4. Scene views
2D views, 3D views and solver views, of the model, sub models, frames,
construction levels and individual members can be displayed in tabbed
windows.

For more information, see: How to manage scene views, view regimes and
scene content (page 85)

5. Structure tree
The Structure tree refers to the hierarchy of information displayed on the
Structure tab in the Project Workspace . Similar 'trees' are displayed for the
other tabs also.
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6. Project Workspace
The Project Workspace is a central location of organizing the entire model
into a hierarchical structure.
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It provides access to a range of functions and is a key tool in creating and
controlling your model.

For more information, see: How to use the project workspace (page 70)
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7. Properties window
The Properties window facilitates the input, review and editing of model
properties.

The Properties window is used to:

• input data when a command is run from a toolbar.

• review or edit existing properties when individual or multiple items are
selected in the active scene view.

• review or edit properties when a branch of the Properties window is
selected.

The properties displayed vary according to the selection. You can edit all of the
properties, unless they are greyed out.

A key feature of the Properties window is that it enables the editing of
multiple items at the same time. Existing properties of selected items are only
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displayed when if are identical for all selected items. If the properties differ,
the property field is left empty.

By default, the Properties window is docked at the bottom left of the main
window, but you can reposition it if required.

8. Show Process button
Click to display the Process Window, described below.

9. Process Window
Initially, the Process Window is minimized. It can be displayed by clicking the
Show Process button, located at the left end of the Status bar.

When you analyze or design the model, each step of the process is logged and
displayed in the window.

When the window is minimized in the Status bar, any detected warning and
errors are flagged. See the flags below:

•

•

Such warnings and errors should always be fully investigated, as they may
have an adverse affect the design.
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10. Select Entity tooltip
The program is automatically in ‘select mode’ when no other commands are
being performed. In this mode you can hover the cursor over an entity and its
name will be displayed in the Select Entity tooltip.

When the correct entity is displayed, click the entity to select it. If several
entities are displayed, you can select one by using the Tab key or Up/Down
arrow keys.

11. Context menu
You can right-click anywhere within a 2D or 3D view to display a menu that is
context-sensitive to the item that is currently highlighted.
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12. Properties dialog
You can use the Properties dialog box for viewing and editing parameters
associated with an individual model object.

The Properties dialog box is displayed by right-clicking an object in the
graphical display and selecting the Edit option from the context menu that
appears.

13. Ghost Unselected and Ghosted toggle buttons

• Ghost Unselected button is displayed in all 2D and 3D Views. It is used to
toggle the display of selected and unselected objects, making it easier to
focus on a particular subset of objects within the model.

See: Use Ghost Unselected to focus on the selection (page 165)

• Ghosted button is displayed in Sub Structure and Sub-model Views. It is
also displayed in Level, Frame, and Slope Views when they have been
toggled into 3D (via the 2D/3D toggle button). It is used to toggle the
display of a ghosted view allowing you to see the current view in the
context of the whole structure.

See: Use Ghosted to see the view in the context of the whole model
(page 924)
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Related video

Ghosted Structure view

14. 2D/3D toggle button

2D/3D button is displayed in 2D Scene Views only. It is used to toggle the view
between 2D and a 3D isometric projection.

Example of a level view in 2D:

The same level view when toggled to 3D:
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15. Global XYZ axes
The global XYZ axis system within which all other systems exist.

16. Building directions
The principle axes of the building can be rotated about global Z if required.

The building direction axes can be switched on/off (and their labelling
contriolled) in Structure Properties (page 931).

17. Cutting planes
The Cutting Planes symbol is displayed in the bottom right corner of the
scene view when any of the cutting planes are currently active.
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18. Loading List
The Loading list is permanently docked at the bottom edge of the main
window.

The Loading list has two main functions:

• Selecting a specific load case to add loads into

• Selecting a specific load case, combination, or envelope to view the results
for.

When viewing results, first click the Loadcase, Combination, or Envelope
button according to your needs. The, choose the specific loadcase,
combination, or envelope name in the list.

19. Status bar
The Status bar is permanently docked at the bottom edge of the main
window. The Status bar performs a number of different functions.

The Status bar provides feedback by indicating:

1. The analysis and design validity

2. The units system

3. The design code

4. The coordinates of the cursor relative to the global origin in 2D views

5. The view regime buttons that allow you to switch the view regime applied
to the active scene view, see View Regime buttons below.

6. Coordinate display that allows you to set the display method for
coordinate tooltips:

• ABS (Absolute)

• REL (Relative)

• POL (Polar)

7. 2D/3D toggle button

• 2D: the content of the 2D view is displayed in plan.

Get familiar with Tekla Structural Designer 67 Get familiar with the user interface



• 3D: the content of the 2D view is displayed in isometric.

20. View regime buttons
The view regime buttons allow you to switch the view regime applied to the
active scene view:

•  Structural View shows the geometry and loading of the structure.

• Solver View shows the analysis model.

• Results View shows the analysis results.

• Wind View shows the wind model.

• Review View graphically examines the model properties or status.

•  Slab Deflections View shows the slab delection analysis results.

21. ViewCube
In 3D views, you can click a vertex, edge, or face of the ViewCube to rotate the
model to a preset view.

For more information, see: Zoom, pan, rotate and walk through scene views
(page 156)
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22. Scene Content
The Scene Content sidebar on the right side of the screen is used to control
the displayed content in the 2D and 3D Scene Views.

The sidebar contains:

1. Entity categories (with check boxes)

Some categories have arrow symbols to their side, indicating sub
categories. Click the arrow symbol in order to see the sub categories.

The check box controls whether the entity category and its associated
information is displayed. You can check the entities that you want to
display and clear the ones that you do not.

2. Entity information controls

Entity information controls list the information in each category that will
be displayed. When clicked, they expand to lists that allow you to select
the information you want to display in the model view.

For more information, see: Manage scene content information (page 90)

23. Tekla Online side pane
The Tekla Online side pane is used to access Tekla Online services provided for
users of Tekla Structural Designer, for example Tekla User Assistance and
Tekla Discussion Forum.
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24. Trimble Connect side pane
The Trimble Connect side pane is used to access the the Trimble Connect
project collaboration tool.

For more information, see: Working collaboratively with Trimble Connect
(page 117)

25. Sign in
Signing in to your Trimble Identity gives you access to a greater number of
online resourses.

You can sign in to one service and then browse to another online service
without a need to log in again. Find the services landing page here: http://
www.tekla.com/services

How to use the project workspace
The Project Workspace is the central control area for your model.

Its tabs are used to access a range of functions:
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Tab Content

Structure Structure (page 71) tree: for opening scene views, viewing
and modifying model properties, controlling grids and sub
models.

Groups Groups (page 77) tree: for organizing members into design
and detailing groups and for displaying UDAs.

Loading Loading (page 80) tree: for viewing load status.
Wind Model Wind Model (page 81) tree: for viewing and modifying wind

model properties
Status Status (page 82) tree: for highlighting validation issues and

other aspects of the model status, i.e.

• Model Geometry

• Wind Model

• Meshing

• Decomposition

• Solver

• BIM

• Drift, Sway, Wind Drift, Seismic Drift and Displacements
Connections Connections (page 83) tree: for viewing and designing steel

connections
Report Index Report Index (page 836): contains bookmarks that can be

used to move around the report when a report view is
displayed.

View and modify model properties in the Project Workspace
The Structure tree organizes the model geometry in a hierarchical way. It also
allows you to view and modify model properties.
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When you open a new model, the Structure tree contains two sub-branches:
Levels and Sub Models. As the model geometry develops new branches are
added, as shown above.

When a branch or sub-branch is selected, the common properties of the
selected branch are viewed in the Properties window. You can then modify
the common properties in the Properties window.

View and modify structure properties

Structure properties, or building parameters, control the principal direction
and default meshing properties of the building.

1. In the Structure tree, click Structure. 

The structure properties are viewed in the Properties window.

2. Modify the structure properties according to your needs.

View and modify construction level properties

• In the Structure tree, do one of the following:

To Do this
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View and modify the properties common to all
construction levels

1. Click Levels.

The construction level properties common
to all levels are viewed in the Properties
window.

2. Modify the properties according to your
needs.

View and modify the parameters of a single
construction level

1. Click the + sign next to Levels.

All construction levels in the model are
viewed.

2. Click the desired construction level.

The level properties are viewed in the
Properties window.

3. Modify the level parameters according to
your needs.

View and modify frame properties

The Frames branch is added in the Structure tree when you create the
first frame in the model.

1. In the Structure tree, click the + sign next to Frames. 

All frames in your model are viewed.

2. Click the desired frame. 

The frame properties are viewed in the Properties window.

3. Modify the frame properties according to your needs.

View and modify the slope properties

The Slopes branch is added in the Structure tree when you create the
first frame in the model.

1. In the Structure tree, click the + sign next to Slopes. 

All slopes in your model are viewed.

2. Click the desired slope. 

The slope properties are viewed in the Properties window.

3. Modify the slope properties according to your needs.

View and modify grid properties

• In the Structure tree, do one of the following:

Get familiar with Tekla Structural Designer 73 Get familiar with the user interface



To Do this
Modify the color, name, or visibility of a grid

1. Click the + sign next to Architectural
Grids.

All architectural grids in your model are
viewed.

2. Click the desired grid.

The grid properties are viewed in the
Properties window.

3. Modify the color, name and visibility of the
grid according to your needs.

Renumber all grids

1. Right-click Architectural Grids.

2. In the context menu, click Renumber.

View and modify sub model properties

1. In the Structure tree, click the + sign next to Sub Models. 

The sub models in your model are viewed.

2. Click the desired sub model. 

The sub model properties are viewed in the Properties window.

3. Modify the properties according to your needs. 

TIP To open the Sub Models dialog dialog, double-click Sub
Models.

View and modify sub structure properties

See: Manage sub structures (page 921)

View and modify member properties

Tekla Structural Designer classifies members by material and type, and further
by fabrication and by shape. Members are classified by material and type,
then further classified by fabrication and then by shape.

• In the Structure tree, do one of the following:

To Do this
View and modify common properties for
members of a particular type and fabrication

1. Click the + sign next to Members.

The existing member types are viewed.
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2. Click the + sign next to a member type.

The existing fabrication types are viewed.

3. Click a fabrication type.

Common properties of all members of the
fabrication type are viewed in the
Properties window.

4. Modify the properties according to your
needs.

View and modify common properties for
members of a particular type, fabrication and
shape 1. Expand the Members branch and its

sub branches by clicking them.

2. Click the + sign next to the desired
fabrication type.

The shapes of the fabrication type are
viewed.

3. Click a shape.

The common properties of all members of
the selected shape are viewed in the
Properties window.

4. Modify the properties according to your
needs.

View and modify the properties of an individual
member

1. Expand the Members branch and its
sub branches by clicking them.

2. Click the + sign next to the shape type.

The member references of the shape are
viewed.

3. Click a member reference.

The properties of the member are viewed in
the Properties window.

4. Modify the properties according to your
needs.

View a member in a new window, select it in
visible views, delete it, or modify it in the
Properties dialog box 1. Expand the Members branch and its

sub branches by clicking them.

2. Right-click a member reference.

3. In the context menu, select the desired
option.

View and modify slab properties

• In the Structure tree, do one of the following:

To Do this
View and modify properties common to all slabs

1. Click Slabs.

The common properties to all slabs are
viewed in the Properties window.
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2. Modify the properties according to your
needs.

View and modify the properties of a parent slab

1. Click the + sign next to Slabs.

The existing parent slabs are viewed.

2. Click the desired parent slab.

The properties of the parent slab are
viewed in the Properties window.

3. Modify the properties according to your
needs.

Modify the properties of a parent slab, or delete it

1. Click the + sign next to Slabs.

The existing parent slabs are viewed.

2. Right-click a parent slab.

3. In the context menu, select if you want to
modify the parent slab in the, or delete it.

View and modify the properties of a slab item

1. Click the + sign next to Slabs.

The existing parent slabs are viewed.

2. Click the + sign next to a parent slab.

All the slab items within the parent slab are
viewed.

3. Click a slab item.

The properties of the slab item are viewed
in the Properties window.

4. Modify the properties according to your
needs.

View and modify wall or roof panel properties

1. In the Structure tree, click the + sign next to Walls or Roofs. 

The currently defined walls and roof panels are viewed.

2. Click the desired wall or roof panel. 

The properties of the selected wall or roof panel are viewed in the
Properties window.

3. Modify the properties according to your needs.

View and modify result strip properties

1. In the Structure tree, click the + sign next to Result Strips. 

All the currently exiting result strips are viewed.
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2. Click the desired result strip. 

The properties of the selected result strip are viewed in the Properties
window.

3. Modify the properties according to your needs.

Manage groups in the Project Workspace
The Groups tree organizes the members in your model into design groups. It
also allows you to manage design groups according to your needs.

If you have defined concrete members, they are also organized into further
groups for detailing purposes. The application of grouping is most useful when
handling concrete structures.

User defined attributes (UDAs) are also listed, allowing you to see which
members have been assigned specific UDAs.

NOTE You can right-click on a group name (or UDA) in order to select all members in
the group, (or with that UDA), simultaneously in the visible views.

Regroup a specific member type

1. In the Groups tree, right-click the member type you want to re-group.

2. In the context menu, select Regroup Members. 

The selected member type is regrouped.

Re-group all member types

WARNING Re-grouping all member types undoes any manual grouping you
may have done.
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• Click the Re-group ALL Model Members button on the top left corner of
the Groups tree.

Add group

1. In the Groups tree, select the appropriate branch within which you want
to manually create a new group.

2. In the context menu, select Add Group. 

A new group empty group is created.

Set as default group

When a new empty group is set as default, if you create a new member it will
be placed in that group in preference to another empty group.

1. In the Groups tree, select an empty group.

2. In the context menu, select Set As Default Group. 

An asterix is placed next to the group name to indicate that it is the
default group for new members.

Split a member group into smaller groups

1. In the Groups tree, right-click the name of the group that you want to
split.

2. In the context menu, select Split Group. 

All members of the group are ungrouped and placed into individual
groups.

Move members from one group to another

1. In the Groups tree, open the group that contains the member(s) to be
moved.

2. Click the first member name to select it, then if you want to add further
members to the selection, hold down Ctrl while clicking on their names.

3. Drag the selection over the group name where you want to move it. 
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Provided that the selection meets the geometric criteria to belong to the
group, a small rectangle will be displayed alongside the cursor.

NOTE You must drag over the group name as shown above, rather than
over the group content for the rectangle to appear.

4. Release the mouse button.

TIP You can also change the group to which members belong by selecting
them and then updating the group name in the Properties window.

Rename a member group

1. In the Groups tree, right-click the group that you want to rename.

2. In the context menu, select Rename Group.

3. Type the new name of the group and press Enter.

Modify the group name defaults for future projects

1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets, and select the settings set that you want to edit.

3. Go to the Grouping page.

4. Review and modify the default group names according to your needs.

5. To save the changes, click OK.

Check a member group

1. In the Groups tree, right-click the member type you want to check.

Get familiar with Tekla Structural Designer 79 Get familiar with the user interface



2. In the context menu, select Check Group. 

The selected member group is checked.

Check a member group using Tekla Tedds

1. In the Groups tree, right-click the member type you want to check.

2. In the context menu, select Check Group. 

The selected member group is checked using Tekla Tedds.

Design a member group

1. In the Groups tree, right-click the member type you want to check.

2. In the context menu, select Design Group. 

The selected member group is designed.

Remove a member group

1. In the Groups tree, right-click the name of the group you want to remove.

2. In the context menu, select Remove Group. 

All members are ungrouped and placed into individual groups.

See also

Create and manage user-defined attributes (page 916)

View load status in the Project Workspace
The Loading tab lists the individual loads that have been applied in each
loadcase. After analysis it sums the applied loads in each combination and
checks these against the sum of reactions.
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See the status options in the following table:

Icon Meaning
Total Reaction is in equilibrium with
the Total Load on Structure.
Total Reaction is not in equilibrium
with the Total Load on Structure.
Total Reaction is unavailable.

1. In the Project Workspace, go to the  Loading tab.

2. Click the desired loadcase. 

The properties of the loadcase are viewed in the Properties window.

View and modify wind properties in the Project Workspace
The Wind Model tree is used after completing the wind modeling process to
display wind direction views, modify wind directions, and modify wind
loadcases.

View a wind direction view

1. In the Wind Model tree, click Wind Directions.

2. Right-click the desired wind direction.

3. In the context menu, select Open View.

Modify wind direction properties

1. In the Wind Model tree, click Wind Directions.
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2. Click the desired wind direction. 

The properties of the wind direction are viewed in the Properties
window.

3. Modify the properties according to your needs.

View and modify wind loadcases

1. In the Wind Model tree, click Wind Loadcases.

2. Click the desired wind loadcase. 

The properties of the wind direction are viewed in the Properties
window.

3. Modify the properties according to your needs.

View model status in the Project Workspace
The Status tree is used to review the validation messages and other model
status indicators.

You can review:

• The validation status for the model

For more information, see: Validate the model (page 338)

• The validation status for the analysis

The analysis model validation is performed automatically when you analyze
the model.

• The decomposition status

The Decomposition branch shows if load decomposition has been
successfully completed.
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• The solver status

The Solver branch lists the analyses that have been performed.

• The BIM validation

If the model has been imported or exported, the BIM branch lists any
warnings and errors that relate to the import or export process.

• The status of drift, sway, wind drift, seismic drift checks and displacements

Each of these are reported automatically when the appropriate analysis
has been performed. For more information, see: Drift, sway, seismic drift,
wind drift, and overall displacements (page 662)

NOTE •  indicates that the analysis or process has been successfully completed.

•  indicates that the analysis or process has resulted in an error.

•  indicates that the analysis or process has resulted in a warning.

Manage and design connections in the Project Workspace
The Connections tree organizes the model’s steel connections in a
hierarchical way, by Type (i.e. Type/Reference), and by Group (i.e. Type/Section
size/Reference).

When opened for the first time, or if the model has been edited in a way that
affects the connection configurations within it, you must run Update
Connections in order to determine the valid connections.

This applies a set of rules (page 658) to create and organize connections into
the following Types:

• Base plate connections

• Beam to Beam Moment Connections
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• Beam to Beam Simple Connections

• Beam to Column Moment Connections

• General Connections

Valid connections are displayed in the scene views and are also listed in the
Connections tree

Update connections

To create connection objects for the first time, or to recreate connections after
changes to the model:

1. Click on the Connections tree in the Project Workspace

2. Right-click the Connections branch.

3. Choose Update Connections from the context menu. 

This applies a set of rules (page 658) to determine all valid steel
connections in the model. The resulting connections are listed in the
Connections Tree and are also shown by bounding boxes in the Scene
Views.

NOTE If the model has been changed so that new connections exist,
these are not created automatically; you are required to update
connections as required.

Edit connection

• In the Connections tree, right click on the appropriate connection
reference and choose Edit... from the context menu. A dialog opens
allowing the connection to be edited.

Select connection in visible views

• In the Connections tree, right click on the appropriate connection
reference and choose Select in visible views from the context menu. The
connection is selected if it exists in the active scene view.

Design connection

• In the Connections tree, right click on the appropriate connection
reference and choose Design connection from the context menu. The
connection is designed using Tekla Connection Designer.

Export connection to Tekla Connection Designer

• In the Connections tree, right click on the appropriate connection
reference and choose Design connection from the context menu. The
connection is designed using Tekla Connection Designer.
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See also

Create and check steel connections (page 635)

How to manage scene views, view regimes and scene
content

Scene views

A scene view displays the model or a part of it in a tabbed window. It might
display: the entire structure, a sub structure, or an individual member in 3D; a
specific level, frame, or plane in 2D. A separate load analysis view is also
available for displaying force and moment diagrams for individual members.

Click the following links to learn how to manage and manipulate scene views:

• Open, close and save scene views (page 86)

• Create and modify scene view tab groups (page 89)

View regimes

For each scene view, you should select a view regime from the Status bar
appropriate to the task being performed:

I
c
o
n

View regime Used for

Structural
View

Creating the structure geometry and applying loads

Solver View Displaying the analysis model
Results View Viewing analysis results
Wind View Viewing the wind model
Review View Examining the design status or reviewing specific model

properties
Slab
Deflections
View

Viewing slab deflection analysis results

Click the following link to learn how to switch between view regimes:

• Change the view regime (page 89)

Scene content

You control the level of information displayed in each scene view by switching
items on/off in the Scene Content dialog.
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Click the following links to find out more about scene content:

• Manage scene content information (page 90)

• Scene Content entity categories (page 91)

Open, close and save scene views
You can display multiple different scene views simultaneously as tabbed
windows within the main window. See the following instructions to open, close
and save scene views.

Open 3D views

1. In the Project Workspace, go to the Structure tab.

2. In the Structure tree, do one of the following:

To Do this
Open a 3D view of the entire structure

• Double-click Structure.

Open a 3D solver view of the entire structure

a. Right-click Structure.

b. In the context menu, select Open solver
view.

Open a 3D view of a sub model

a. Click the + sign next to Sub Models.

The existing sub models are viewed.

b. Double-click a sub model.

Open a 3D solver view of a sub model

a. Click the + sign next to Sub Models.

The existing sub models are viewed.

b. Right-click a sub model.

c. In the context menu, select Open solver
view.

Open a 3D view of a sub structure a. Click the + sign next to Sub Structures.

The existing sub structures are viewed.

b. Double-click a sub structure.

Open a 3D solver view of a sub structure a. Click the + sign next to Sub Structures.

The existing sub structures are viewed.

b. Right-click a sub structures.

c. In the context menu, select Open solver
view.

Open a 3D view of a single member from within
another view

a. Hover the mouse over the desired member
to highlight it.

b. Right-click the member.

c. In the context menu, select Open
[element name] view.
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Open a 3D view of a single member in the
Project Workspace a. Click the + sign next to Members.

b. Expand the required sub branches
similarly.

c. Right-click the required member.

d. In the context menu, select Open view.

Open 2D views

1. In the Project Workspace, go to the Structure tab.

2. In the Structure tree, do one of the following:

To Do this
Open a 2D view of a construction level

a. Click the + sign next to Levels.

The existing construction levels are viewed.

b. Double-click the desired level.

Open a 2D solver view of a construction level

a. Click the + sign next to Levels.

The existing construction levels are viewed.

b. Right-click the desired level.

c. In the context menu, select Open solver
view.

Open a 2D view of a frame

a. Click the + sign next to Frames.

The existing frames are viewed.

b. Double-click the desired frame.

Open a 2D solver view of a frame

a. Click the + sign next to Frames.

The existing frames are viewed.

b. Right-click the desired frame.

c. In the context menu, select Open solver
view.

Open a 2D view of a sloped plane
NOTE Before you can view a 2D view of a

sloped plane, you must create a sloped
plane in your model.

a. Click the + sign next to Slopes.

The existing slopes are viewed.

b. Double-click the desired slope.
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Open a 2D solver view of a sloped plane
NOTE Before you can view a 2D view of a

sloped plane, you must create a sloped
plane in your model.

a. Click the + sign next to Slopes

The existing frames are viewed.

b. Right-click the desired slope.

c. In the context menu, select Open solver
view.

Save, open and delete view configurations
Once a scene view has been adjusted to show a specific area of the model, you
can save the scene view to a view configuration.

NOTE You can use view configurations in two ways:

• Include them as views in model reports.

In this case, the view configurations retain the scene content
settings that were in place when you saved the view configuration.

• Re-open them in a new scene view at a subsequent time.

In this case, the view configurations adopt the scene content
settings that are currently in place in the scene view.

• According to your needs, do one of the following:

To Do this
Save a view configuration 1. Right-click anywhere in the view.

2. In the context menu, select Save View
Configuration...

The View name dialog box opens.

3. Name the view.

4. Click OK.

Open a saved view configuration

1. On the Home tab, click Manage
View Configurations.

2. Select the desired view configuration.

3. Click Open View.

4. Click OK.

Delete a view configuration

1. On the Home tab, click Manage
View Configurations.

2. Select the desired view configuration.

3. Click Delete.

4. Click OK.

Get familiar with Tekla Structural Designer 88 Get familiar with the user interface



Close views

• Click x on the top right corner of the view tab.

Create and modify scene view tab groups
When you have created multiple scene views, only the active view is visible by
default. However, it is often useful to display views side by side or one below
another. You can do this by creating tab groups.

Create a new tab group from an existing view tab

1. Right-click an existing view tab.

2. In the context menu, select New Horizontal Tab Group or New Vertical
Tab Group according to your needs.

Create a new tab group using the docking control

1. Start dragging a view tab. 

A docking control appears in the middle of the view.

2. Do one of the following:

To Do this
Create a new vertical tab group • Drag the view over the left or right button of

the docking control and release the mouse.

Create a new horizontal tab group • Drag the view over the top or bottom button
of the docking control and release the
mouse.

Move a view from one tab group to another

1. Right-click the view tab.

2. In the context menu, select Move to Next Tab Group.

Change the view regime
• In the Status bar at the bottom of the main window, click the desired view

regime button. 

•  Structural View to show the geometry and loading of the
structure.
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• Solver View to show the analysis model.

• Results View to show the analysis results.

• Wind View to show the wind model.

• Review View to graphically examine the model properties or
status.

•  Slab Deflections View to show the slab delection analysis results.

Manage scene content information
Different entity types have different levels of information associated with
them. You can select how much of this information is displayed in each of the
different scene views and view regimes. Scene content selections are saved
independently with each scene view.

For example, in a Solver View regime, it is generally sufficient to represent
beams by their insertion lines. However, in a Structural View regime, you are
likely to also include their geometric outlines. In either of the views, you may
also choose to display their direction arrows and possibly their reference texts
also.

View the Scene Content window

1. Do one of the following:

If Do this
Scene Content is set to Auto Hide The Scene Content tab is docked on the edge of

the main window.

• Click the tab to expand the Scene Content
window.

The Scene Content has been closed • On the Windows tab, click Scene Content.

Select items in the Scene Content window

• In the Scene Content window, do one of the following:

To Do this
View the sub categories of an entity category • Click the arrow sign on the left side of the

category name.

View a category in the model view • Select the check box on the left side of the
category name.
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Hide a category in the model view
NOTE If you hide an entity category, you can no

longer perform some commands that
affect that entity category.

For example, if you hide slab items, you
cannot define slab or area loads on a
floor because there are no slab panels to
select.

• Clear the check box on the left side of the
category name.

Adjust the information viewed in the model view 1. Click the cell on the right side of the
category name.

A list of possible details opens.

2. Select the details you want to view.

3. Click OK.

Reinstate the default Scene Content selections

You can discard your current selections and reinstate the default Scene
Content selections at any time.

See the following instructions.

1. Close the current view.

2. Re-open the view using the Structure tree.

See also

Open, close and save scene views (page 86)

Scene content entity categories
The following paragraphs describe some of the most important entity
categories of Scene Content.

Architectural Grids

Allows you to show or hide architectural grids in 3D views. When selected,
architectural grids are displayed at the lowest level of the model.

Grid & Construction Lines

Allows you to show or hide grid and construction lines at individual levels in
both 2D and 3D views.

You can control the levels at which grids are or are not displayed in the
Properties window for each level. Grids are only displayed in 3D views if the
Show grids in the 3D view option is selected and in 2D views if the Show
grids in plane view option is selected.
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Members

Allow you to manage how each member type is displayed. For each of the
mentioned elements, you can display the following information:

Geometry

Displays the faces of the member by shading them according to the member
type.

The following image displays a concrete beam and column example with the
Geometry and Architectural Grids options selected.

InsertionLine

Displays a solid line between the start and end node of the member.

The following image displays the concrete beam and column example with the
InsertionLine and Architectural Grids options selected.

LoadingLine

Displays a solid line through the center of the member. Any member loads are
applied along the line.

The following image displays the concrete beam and column example zoomed
with the InsertionLine and LoadingLine options selected.
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Normals

Displays the normal directions at each corner of the member.

The following image displays the concrete beam and column example zoomed
with the Geometry and Normals options selected.

Text

Displays the member name.

The following image displays a composite steel beam example with the
Geometry and Text options selected.

Text2D

Displays the member name, section and class in the 2D plane of the member.

The following image displays the composite beam example with the
Geometry and Text2D options selected.

Direction

Displays the direction from end 1 to end 2 of the member.

If the direction is incorrect, go to the Edit tab and click Reverse.

The following image shows the composite steel beam example with the
InsertionLine and Direction options selected.

Get familiar with Tekla Structural Designer 93 Get familiar with the user interface



BoundingBox

Displays the bounding box of sections. Selecting the option may simplify right-
clicking sections of a small cross section.

The following image displays the composite steel beam example with
Geometry and BoundingBox selected.

Decking

Displays the strip of decking that is connected to the member.

The following image displays the composite steel beam example with
Geometry and Decking selected.

Plan

NOTE The Plan entity category is only available in 2D views.

The initial display for 2D views is configured for modeling purposes, so by
default, it does not display all the information that will be output when
drawings are created. However, you can select the Plan entity category to
overlay one of the following planar drawing categories on the 2D view:

• General arrangement

• Beam end forces

• Foundation layout

• Loading plan

• Slab/mat layout
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You can also select the individual drawing layers to be overlaid. The Plan
category can be very useful, as it allows you to display information that would
otherwise not be available whilst modeling.

To use the Plan category, do the following:

1. Open a 2D view.

2. In Scene Content, select Plan.

3. In the list on the right side of the Plan category, you can select the
drawing category.

4. Click the arrow on the left side of the Plan category to view the different
drawing layers that you can optionally display. 

Only the layers that exist in the previously mentioned planar drawing
categories can be displayed. The most important layers are:

Name Description
General Allows you to display grids, construction lines,

and dimensions as they would appear in
drawings.

Members Allows you to display the various different
member types labeled as they would appear in
drawings.

Walls Allows you to display concrete walls labeled as
they would appear in drawings.

Slabs/Mats Allows you to display concrete slabs labeled as
they would appear in drawings.

Other Allows you to display various other items that
can be output to drawings.

NOTE It is not yet possible to overlay beam
end forces or foundation reactions on a
scene view. However, you can display
them in general arrangement drawings.

Tables Allows you to display tables of information that
can be output to drawings.

Connections Allows you to display connection names,
attributes, and reactions as they would appear in
drawings.

Beam End Forces Allows you to display beam end forces as they
would appear in drawings.

By default, the layers that are initially selected match those in the first
layer configuration for the drawing category in Model Settings -->
Drawings --> Layer Configurations.

5. Select or clear the layers according to your needs. 

TIP Layer content can be further controlled in Model Settings -->
Drawings --> Layer Configurations.
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Example

To illustrate how the Plan category would typically be used, consider the
following composite beam example designed to the AISC 360 ASD head code:

In the following floor view, the standard beam labeling for modeling is applied.
The labeling consists of the beam name, section, grade, number of connectors,
and transverse reinforcement.

When you produce drawings, additional design information would probably
also be conveyed. The information can contain, for example, the amount
beam camber required. The camber is included in one of the drawing layers,
so you can include it in the 2D scene view, as long as you know the layer it
belongs to.

To include the camber, do the following:

1. Open a 2D scene view containing the beams.

2. In Scene Content, select Plan.
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Depending on the current scene content selection, there may be a
substantial duplication of axes, members, labeling, and so on.

3. Expand the Plan category and do the following:

a. Clear the Members and Slabs/Mats options.

b. Select options according to the following images:

The scene view should now appear less cluttered, as shown in the
following image.
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4. On the Draw tab, click Settings and adjust the drawing settings as
follows:

a. Go to Options --> Planar Drawings --> General Arrangement.

b. Go to the Beams tab.

c. Ensure that the Camber option is selected.

d. Go to the Slabs/Mats tab.

e. Clear all Panel Labelling options and the Include panel span
direction symbol option.

f. Click OK.

The drawing is updated to match the new drawing options.
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How to hide, re-display and move windows
TheProperties window, the , Scene Content, and each of the Project
Workspace tabs are displayed in windows that can be resized and
repositioned, or docked to an edge of another window.

Auto-hide a window
To increase the area available for graphical display, you can choose to auto-
hide any of the windows.

• In the desired window, click  Auto Hide. 

The window immediately contracts to a tab.

• Click the window tab to expand it. 

You can only expand a window if it is docked against an edge of the main
window.

Close a window

• Click Close at the top right corner of the window.

Re-display a closed window
1. Click the Windows tab.

2. In the View group, click the window name. 

If the window is already displayed, its control is highlighted in the View
group.

Move a window
• Select the title bar of the window, and drag the window to its new location. 

If you place the selected window over an edge of the main window, or over
a divider within the main window, the window docks to that edge or
divider.

Dock a window as a tabbed page in another window
• Select the title bar of the window, and drag the window over the title bar or

the tab group of the other window.

Open a tabbed page in another window
• Select the tabbed page, and drag the page to its new location. 

The tabbed page opens in a new window.
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Dock a window using the docking control
1. Select the title bar of the window, and start dragging the window. 

The window docking control appears in the middle of the main window.

2. Drag the window over the docking control button that indicates the
desired location.

Dock a window to a tabbed page of the current window

1. Select the title bar of the window, and drag the window over the central
button of the docking control.

2. Release the left mouse button.

Keyboard shortcuts
Keyboard shortcuts in Tekla Structural Designer are described in the tables
below.

General keyboard shortcuts
Keys that perform general functions in Tekla Structural Designer are listed
below.

Key Function
F1 Displays the Tekla Structural Designer Help.
Ctrl Holding down Ctrl while selecting entities adds the new

entities to the current selection.
Esc Cancels the current command.
Ctrl F Opens the Find dialog
Ctrl O Open a file
Ctrl N Starts a new file
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Keyboard shortcuts in 2D and 3D Views
The following keys function as described below in the Structural View and
other graphical views.

Key Function
ZA Zooms to the extents of the model.
ZS Zooms to the selected entities.

NOTE Prior to using this shortcut, at least one entity
must be selected in order for the command to
zoom to it.

Z1 Zooms to 1m (3ft) area around the cursor.
Z2 Zooms to 2m (6ft) area around the cursor.
Z3 Zooms to 3m (9ft) area around the cursor.
Up/Down arrow
keys

Allows you to scroll between entities in the Select Entity
tooltip when Tekla Structural Designer has detected
multiple entities.

Ctrl Holding down Ctrl while selecting entities adds the new
entities to the current selection.

F2 Whenever you are prompted to pick a point, the Data
Entry tooltip displays the co-ordinates at the cursor
position.

Pressing F2 enables keyboard input of the exact co-
ordinates required.
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Key Function
F8 Switches between displaying and hiding the ViewCube in

3D views.

Keyboard shortcuts in Properties windows
Keys that perform specific functions in any Properties window are described
below.

Key Function
Up/Down arrow
keys

Move between different properties and navigate within
combo-box drop-down lists.

Tab Tab - Enter or leave (and save) property editing mode.
Space Space - Toggle check-boxes and expand combo-boxes.
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Key Function

Enter Select and save property editing.

When a Review View is active, the following Properties window shortcuts are
also available for [A]ttibute and [M]ode.

Key Function
A Press A to cycle through attributes in the [A]ttibute list.

TIP If this doesn't work it is probably because the focus
is in the Properties window. Click the Review View
to makes it active and try again.
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Key Function
M Press M to cycle through modes in the [M]ode list.

TIP If this doesn't work it is probably because the focus
is in the Properties window. Click the Review View
to makes it active and try again.

Keyboard shortcuts in tree structures
Keys that perform specific functions in any tree structure are described below.

Key Function
Right/Left arrow
keys

Expand and collapse headings.

Keyboard shortcuts to the Quick Access Toolbar

The Quick Access Toolbar is normally displayed as below.

If you press the Alt key letters are superimposed to enable each command to
be accessed directly from the keyboard.
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Command Shortcut

New

Alt N

(or, you can also use Ctrl N)

Open

Alt O

(or, you can also use Ctrl O)

Save

Alt SA

Undo

Alt U

Redo

Alt RD

Alt FI

(or, you can also use Ctrl F)

Alt V

Delete

Alt DE

Keyboard shortcuts to ribbon commands
All commands on the ribbon toolbars can be accessed from the keyboard after
pressing the Alt key.

1. Press Alt then the appropriate letters (summarized in the table below) to
open the required ribbon toolbar.
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2. Press the appropriate letter(s) for the command you want to run.

Example: Press Alt HFN to open the Home toolbar and run the Find
command shown above.

Toolbar Shortcut
File Press Alt AP then the letter(s) shown against the

required command.
Home Press Alt H then the letter(s) shown against the

required command.
BIM Integration Press Alt B then the letter(s) shown against the

required command.
Model Press Alt M then the letter(s) shown against the

required command. .
Edit Press Alt E then the letter(s) shown against the

required command.
Load Press Alt LO then the letter(s) shown against the

required command.
Analyze Press Alt AN then the letter(s) shown against the

required command.
Design Press Alt DE then the letter(s) shown against the

required command.
Slab Deflection Press Alt SL then the letter(s) shown against the

required command.
Foundations Press Alt FO then the letter(s) shown against the

required command.
Report Press Alt RE then the letter(s) shown against the

required command.
Draw Press Alt DR then the letter(s) shown against the

required command.
Windows Press Alt W then the letter(s) shown against the

required command.
Loading Analysis Press Alt LA then the letter(s) shown against the

required command.
Results Press Alt RS then the letter(s) shown against the

required command.
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Toolbar Shortcut
Review Press Alt RV then the letter(s) shown against the

required command.
Review Data Press Alt RV then the letter(s) shown against the

required command.

2.7 NOTE: Steps to take if the Help Viewer appears to be
inactive
Please note that, since Help is displayed within a Tekla Structural Designer
dialog, it will become inactive when another dialog is opened.

Should this occur, the following workarounds are suggested:

• Simply close the other dialog to continue.

• Alternatively you can access Tekla Online Help (TUA) for Structural Designer
directly within any browser.

The Help can also be opened in a browser from any page by clicking the
'arrow' button at the bottom of the page as shown below:
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3 BIM integration

To simplify your work, Tekla Structural Designer allows you to both export
data to different file formats, and import files to Tekla Structural Designer.

Click the following links to find out more:

• Import a project from a Structural BIM Import file (page 109)

• Import a project from a TEL file (page 110)

• Import data from a 3D DXF file (page 116)

• Working collaboratively with Trimble Connect (page 117)

• Export a model to Tekla Structures (page 126)

• Export to Tekla Connection Designer (page 127)

• Export to Tekla Portal Frame Designer (page 128)

• Export to Tekla Tedds (page 132)

• Export a model to Autodesk Revit (page 135)

• Export a model to IFC (page 136)

• Export to and import from Westok Cellbeam (page 137)

• Export to and import from FBEAM (page 138)

• Export a model to ADAPT (page 143)

• Export a model to STAAD (page 147)

• Export a model to Autodesk Robot Structural Analysis (page 148)

• Export a model to the cloud (page 149)

• Export to IDEA StatiCa Connection Design (page 152)

BIM fundamentals (Playlist)
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3.1 Import model data
Tekla Structural Designer allows you to import model data from other
applications.

Click the following links to find out more about importing a model into Tekla
Structural Designer:

• Import a project from a Structural BIM Import file (page 109)

• Import a project from a TEL file (page 110)

• Import data from a 3D DXF file (page 116)

Import a project from a Structural BIM Import file

1. On the BIM Integration toolbar, click Structural BIM Import. 

The BIM Integration wizard opens.

2. Use the […] button to browse and select the appropriate CXL file. 

The remainder of the fields are populated with the settings read directly
from the file.

3. Click Next to continue. 

The Import Options page shows the settings related to the file, it will
indicate if this is a first time import or an update, and allows the user to
choose Metric or Imperial for the units, a design code and the default level
type. The level type can later be adjusted in the construction levels dialog
if required.

4. Click Next to continue. 

The Relocate Import Model page allows for models to be moved to
around the datum position in Tekla Structural Designer from a real world
co-ordinate. The extent of the model can be seen from the information
displayed on the right hand side of the dialog.

5. Click Next to continue. 

The Integration Filter will be displayed. The five options shown here
allow you to verify if grids, levels etc. are to be imported. Please note that
the settings held in the Delete Existing… and four Update… columns
should not be used when performing a First Time Import and are only
used when synchronizing changes into an existing Tekla Structural
Designer model.

6. Click Next to continue. 

Mapping of materials to recognised grades will be shown now. Here you
can view the different materials recognised in the incoming CXL file and
the options to alter materials with a more preferred grade.
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7. Click Next to continue (if available). 

Following on from Material mapping, the dialog for Decking mapping will
be shown (if applicable). Again this allows users to view the decking types
being imported and have the option of overwriting the details if required.

8. Click Finish 

After the file has completed processing, the model will be displayed within
the Structural 3D view and you can then proceed with validation of the
structure before applying any analytical information.

BIM fundamentals (Playlist)

Integration with Tekla Structures (Playlist)

Integration with Autodesk Revit (Playlist)

Revit-TSD Integration

Import a project from a TEL file
Before importing a project from a TEL file, you are advised to be aware of the
restrictions. Then, you can proceed to follow the detailed instructions to
perform the import.

Restrictions
When importing TEL files, note the following points:

Round tripping Does not exist in TEL file imports.

This means that the import data is
used to create new objects in the
model, not to update existing ones.
All existing objects and data are
maintained.

Data that is imported • Project summary (new models
only)

• Project name, engineer, etc.

• Support conditions

• Any associated UCS

• Spring supports, including
linear and non-linear

NOTE In S-Frame, for non-linear
spring the default is
F_max = 0. This does not
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mean that the spring has
zero capacity, but F_max
is simply ignored.

This is not the case in
Tekla Structural Designer.
In Tekla Structural
Designer, F_max =0
means the spring has zero
capacity. Hence for
models with compression-
only springs imported
from S-Frame, all
nonlinear spring supports
with F_max = 0 will need
editing, or analysis will fail.

• 1D elements

• Imported as analysis elements.
However, contiguous elements
are not merged into members
(straight or curved).

• Replicated by additional
relatively stiff 1D elements.

NOTE Automatic supports
are not created, for
example, under
columns.

• Panels - area load only

• Created as roof or wall panels
without openings

• Panels - shell: tri, quad, or mixed

• Created as meshed concrete
walls (vertical planes only) or 2-
way spanning slab items

• Material properties are
mapped manually during the
import.

• Thickness

• Panels - rigid or independent
diaphragm

• Created as 1-way spanning slab
items.
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• Material properties are
mapped manually during the
import.

• Thickness

• Panels - holes

• Created as slab or wall
openings.

NOTE The holes must be
rectangular for walls
and rectangular or
circular for slabs.
Otherwise, Tekla
Structural Designer will
generate a warning.

• Loadcases (linear only)

• Nodal loads

• Settlement loads

• 1D element loads, including
uniform temperature loads

• Area panel loads, not including
uniform temperature loads

• Combinations
Exclusions • Units: the Tekla Structural

Designer model units are not
changed to match the TEL file
units. However, values are
converted to the Tekla Structural
Designer model units.

• There is no special handling for 2D
files. 2D files are imported in the
same plane as they are defined in
S-Frame (the X-Y plane), and
default constraints are not
imported.

• Default constraints are not
imported, and no warning is
generated. Default constraints are
supports applied to all nodes
without exception internally
during analysis. Default
constraints are not displayed in
the S-Frame interface. For models
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marked as 2D, default constraints
restrict displacement to the X-Y
plane and are as follows: Fz, My
and Mz fixed. Default constraints
may be manually applied in 3D
models, and the S-Frame model
can be examined to confirm their
nature. The import does not
replicate default constraints. To
ensure equivalence, default
constraints must be applied
manually to all nodes, either in the
S-Frame model prior to import, or
in Tekla Structural Designer
subsequently.

• The import does not create any
physical members. S-Frame
physical members are treated like
any other 1D element and
imported as a single analysis
element. In particular, Tekla
Structural Designer does not
merge contiguous elements into
members (straight or curved) or
identify columns, beams, and so
on. No warnings are generated.

In addition, for S-Frame physical
models please note the following:

• Intermediate nodes that do not
form the ends of other
elements are not imported. If
such nodes have supports
applied, the model will not be
equivalent and should be
adjusted to ensure
equivalence.

• If physical members have
tapered sections, the sections
should be sub-divided in S-
Frame before importing to
Tekla Structural Designer to
produce an equivalent model.

• Alternatively, the S-Frame
model can be converted to an
analytical model in S-Frame
prior to import, using the S-
Frame command for this.
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• Staged construction data is not
imported, and no warning is
generated. Typically, the entire
model is imported, representing
the last stage in which the model
is complete. Otherwise, turn the
Staged Construction setting in S-
Frame off prior to import. This will
remove all stages but the last one,
and issue a warning to this effect.
The model is then non-staged, and
so should be valid for import.

• Although the following can be
modeled as single objects in Tekla
Structural Designer, no attempt is
made to import them as single
objects from collections of S-
Frame objects:

• Mid-pier walls

• Trusses

• Portal frames

• Inactive elements are imported as
inactive analysis elements of the
beam type.

NOTE Inactive elements are
quite likely to originate
from tension-only cross
bracing in Fastrak Building
Designer models. In this
situation, we recommend
that you click the warning
to identify the relevant
part of the model, delete
both "braces", and create
new braces using the
specific X-brace pair.

• Wall and strip integration lines are
not imported. A warning is issued
to this effect.

• Tapered sections: a 1D element is
imported. However, no tapered
section dimension data is
imported. A warning is issued to
this effect.
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• Prestress data for 1D & 2D
elements is not imported.

• Percentage fixity data for 1D
elements is not imported.

• Non-linear spring data by graph:
1D elements and supports are
imported, but the spring
stiffnesses are set to 0. A warning
is issued to this effect.

• Non-structural alignment and
offsets (cardinal point data) are
ignored, and warnings are issued
if they are non-zero.

• Panels: general diaphragms, mat
foundations, membranes and
plates are excluded, and a warning
is issued.

• Diaphragm panel node exclusions
are ignored.

• 2D elements are excluded, and a
warning is issued.

• Meshing properties for panels are
excluded without warning.

• Shear Walls: only quadrilaterals
can be created.

• Diaphragm constraints are
excluded, and a warning is issued
to this effect. Any diaphragm
constraints must be replicated in
Tekla Structural Designer to
ensure equivalence.

• Slaved nodes are excluded, and a
warning is issued.

• Lumped mass is excluded.

• Groups are excluded.

• Notional load factors: NHF and
EHF are added to combinations,
with the sign indicating positive or
negative for each direction.
However, the actual value is
ignored. The standard notional
load calculation method and
default strength factor are used.
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• Non-zero gravitational factors for
Global X & Y are excluded, and a
warning is issued.

• Thermal gradient loads for 1D and
2D elements are excluded.

• Moving loads are excluded.

• Time history loads are excluded.

• 2D elements are excluded, and a
warning is issued.

• RSA data is excluded.

Instructions
1. On the BIM Integration tab, click 'TEL' File Import. 

The 'TEL' File Import button is not active unless you have a Tekla
Structural Designer document open.

The BIM Integration wizard opens.

2. Click ... to browse the .TEL file, and click Next.

3. If necessary, adjust the location and rotation of the import model, and
click Next.

4. Select an appropriate material type and grade for each material using the
lists.

5. Click Finish.

The model is now imported. Any associated warning messaged can be
reviewed in the BIM sub-branch of the Status tree.

Import data from a 3D DXF file
See the following paragraphs for the restrictions of 3D DXF import, and the
instructions on importing data from a 3D DXF file.

Restrictions
Note the following points when importing 3D DXF files:

• Round tripping does not exist in TEL file imports. This means that the
import data is used to create new objects in the model, not to update
existing ones. All existing objects and data are maintained.

• Analysis elements are created from line segments in the selected layers of
the DXF file as follows:

• All lines in these layers become 1D analysis elements.
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• Arcs and circles in the selected layers are excluded without a warning.

• Blocks are not handled, and no warnings are issued.

• Polylines in the selected layers are excluded without a warning.

• 3D solids in the selected layers are excluded without any warning.

• 2D faces for 3D objects in the selected layers are excluded without a
warning.

• All ends of lines in the selected layers become nodes.

• Nodes are not introduced in the intersections of crossing lines.

• The following elements are not included in the import:

• Reading of any text

• Intelligence on "through members"

• Gridlines and construction lines

• 2D elements

• Supports

• Section properties

• Materials

• Loads

• Combinations

Instructions
1. On the BIM Integration tab, click 3D DXF Import. 

The 3D DXF Import can only be selected in a 3D view.

The Open dialog opens.

2. Browse to the required .dxf file.

3. Click Open. 

The DXF Import Wizard opens.

4. Select the layers and colors that you want to import.

5. If necessary, apply offsets and rotate the model before data is imported.

6. Click OK.

Any line segments found in the selected layers are now imported as analysis
elements.
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3.2 Working collaboratively with Trimble Connect
Trimble Connect is a project collaboration tool allowing project stakeholders
access to reliable, up-to-date project information. It is available as a cloud-
based platform (Trimble Connect Web) and a Windows application (Trimble
Connect for Windows). Projects are synchronised between the Windows app
and the cloud.

NOTE To learn more about Trimble Connect, see:

• https://connect.trimble.com/

• https://trimbleconnect.support.tekla.com/

NOTE You need to have a Trimble Identity before you can start using Trimble
Connect

Trimble Connect Project Explorer is used within Tekla Structural Designer to
control the flow of information between the open model and a Trimble
Connect project.

With Trimble Connect Project Explorer you can:

• link a Tekla Structural Designer model to a Trimble Connect project

• create and rename folders in a Trimble Connect project

• view a file list and rename files in a Trimble Connect project

• upload an IFC of the model to a Trimble Connect project

• upload drawings

• upload reports

NOTE A Tekla Structural Designer model can only be linked to a Trimble Connect
project from the Trimble Connect Project Explorer and not from the web or
Windows apps. The model must be linked before any information can move
between Tekla Structural Designer and Trimble Connect.

Launch Trimble Connect Project Explorer
1. Log in using your Trimble Identity, (if not already signed in).

2. On the BIM Integration tab, click the Trimble Connect droplist.

3. Select Trimble Connect
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Trimble Connect Project Explorer opens, either as a docked window, or
as a tab on the right of the interface.

Available projects are listed with link icons as below.

TIP If the project in which you want to collaborate is not shown, try clicking
the refresh button to synchronise with the cloud. If it still not shown you
would need somebody with the appropriate permissions to create it, or
grant you access, using Trimble Connect Web, or Trimble Connect for
Windows.

TIP If a 'Cannot find linked project' message is displayed, this indicates either
that you do not have permission to view the project; or, that the project
to which the model was previously linked has been deleted - in this
situation you would need to click 'Unlink' before you are able to link the
model with another project.

Link or unlink a project
1. To link to a project:

1. Click  next to the project you want to link to. 

When the model is linked, the project name appears at the top of the
window and the icon changes as shown below.
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Any folders or files in the Trimble Connect project that you have read
access to are also displayed.

2. To unlink from a project:

2. Click  to unlink the project. 

The full list of available projects is displayed once more.

Create folders, rename folders, rename files
When you link to a Trimble Connect project the existing project folder
structure is displayed. You can add to this, if required.

NOTE You can only create but not delete folders in Trimble Connect Project
Explorer. Folders can only be deleted in Trimble Connect Web, or
Trimble Connect for Windows.

You can only rename folders and files to which you have write access.

1. To create a folder:

1. Right click in the Trimble Connect Project Explorer window.

2. Select Create folder and enter the folder name.

2. To create a subfolder:

3. Right click on an existing folder.

4. Click Create folder and enter the folder name.

BIM integration 120 Working collaboratively with Trimble Connect



3. To rename a file or folder:

5. Right click on the file/folder.

6. Select Rename

Upload an IFC file of a model
1. Right-click on the folder where you want to create the IFC.

2. Select Upload New IFC file

3. Follow the steps in the Export to IFC wizard to create the ifc file.

a. Adjust the location and rotation of the model, and click Next

b. Specify the export names of material grades, and click Next

c. Specify the ifc file name

The ifc file will appear in the selected folder, then after an 'assimilation'
process it will be possible for collaborators to view the IFC model in
Trimble Connect.

NOTE If the model is subsequently updated, you can upload a new revision
of the ifc file. To do this, right-click on the ifc file name and select
Upload new version of IFC.

Upload a multi-member drawing
1. Open a view displaying the part of the model that you want to include in

the drawing.

2. On the Draw ribbon, click the drawing type. 

The DXF Export Preferences dialog box opens.

3. Select Upload to Trimble Connect 

NOTE The above option is only available after the model has been
linked to a Trimble Connect project.

A default drawing name for the upload is displayed.

If required, the drawing name and upload folder can be changed by
clicking […] to open the Trimble Connect File Browser.

The Create link between model member and uploaded drawing
option is not applicable to multi-member drawings, so this option cannot
be selected.
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4. Click OK 

The drawing will appear in the selected folder, then after an 'assimilation'
process it will be possible for collaborators to view the drawing in Trimble
Connect.

NOTE The Defaults button on the DXF Export Preferences dialog box can
be used to set a default file location, output target and link creation
option. The options defined here will be true for the whole model.

Upload a single member drawing
1. Highlight the member for which you want to create a drawing.

2. Right click, then from the context menu select Generate Drawing 

The DXF Export Preferences dialog box opens.

3. Select Upload to Trimble Connect 

NOTE The above option is only available after the model has been
linked to a Trimble Connect project.

A default drawing name for the upload is displayed.

If required, the drawing name and upload folder can be changed by
clicking […] to open the Trimble Connect File Browser.

4. To link the model member and drawing, click Create link between
model member and uploaded drawing. 

See the Link a drawing or report to an existing IFC topic below for more
details about this option.

5. Click OK 

The drawing will appear in the selected folder, then after an 'assimilation'
process it will be possible for collaborators to view the drawing in Trimble
Connect.

NOTE The Defaults button on the DXF Export Preferences dialog box can
be used to set a default file location, output target and link creation
option. The options defined here apply for the whole model.

Upload a model report
1. Open the required report in Tekla Structural Designer.

2. On the Report ribbon, click PDF Upload 
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NOTE Both PDF Upload and Upload Settings are only available after
the model has been linked to a Trimble Connect project. (The
latter can be used to set a default file location, output target and
link creation option that applies for the whole model.)

The Upload Report dialog box opens and a pdf name for the report is
displayed.

If required, the pdf name and upload folder can be changed by clicking
[…] to open the Trimble Connect File Browser.

The Create link between model member and uploaded report option
is not applicable to model reports, so this option cannot be selected.

3. Click OK 

The pdf will appear in the selected folder, then after an 'assimilation'
process it will be possible for collaborators to view the report in Trimble
Connect.

Upload a member report
1. Highlight the member for which you want to create a report.

2. Right click, then from the context menu select Report for Member 

The report is displayed in Tekla Structural Designer.

3. On the Report ribbon, click PDF Upload 

NOTE Both PDF Upload and Upload Settings are only available after
the model has been linked to a Trimble Connect project. (The
latter can be used to set a default file location, output target and
link creation option that applies for the whole model.)

The Upload Report dialog box opens and a pdf name for the report is
displayed.

If required, the pdf name and upload folder can be changed by clicking
[…] to open the Trimble Connect File Browser.

4. To link the model member and report, click Create link between model
member and uploaded report. 

See the Link a drawing or report to an existing IFC topic below for more
details about this option.

5. Click OK 

The pdf will appear in the selected folder, then after an 'assimilation'
process it will be possible for collaborators to view the report in Trimble
Connect.
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Link a drawing or report to an existing IFC
When drawings and reports are uploaded they are automatically linked to an
existing IFC file as long as the appropriate option is selected (Create link
between model member and uploaded report / Create link between model member
and uploaded drawing).

It is important to save the Tekla Structural Designer model after exporting the
IFC to Trimble Connect so that the link between the two is stored in the TSD
model.

Linking reports

Linking of reports occurs for member reports only. If there are 3 IFC objects
associated with one member (eg a 3 span beam) there will be a link created on
each of the 3 IFC objects.

Linking drawings

Linking of drawings occurs for member drawings only. If there are 3 IFC
objects associated with one TSD member (eg a 3 span beam) there will be a
link created on each of the 3 IFC objects.

Check linking progress in the Process Window
The progress of the linking is logged in the process window. This will show the
number of successful/unsuccessful links that have been created.

There are a few reasons why linking could be unsuccessful:

1. The member associated with the report/drawing does not exist in IFC
model

2. Connection to the Trimble Connect project is lost

3. IFC model was not successfully uploaded
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Open Trimble Connect to a model view for an IFC
1. In the Trimble Connect Project Explorer window, right-click on the IFC file

to be viewed.

2. Select Open in Trimble Connect Web, or Open in Trimble Connect for
Windows as required. 

Trimble Connect opens the linked project and displays a view of the
selected ifc.

Open Trimble Connect
1. To open Trimble Connect from the ribbon:

1. If not already signed in, click log in (at the top right of the interface).

2. On the BIM Integration tab, click the Trimble Connect droplist.

3. Select select Trimble Connect Web, or Trimble Connect for Windows as
required.

• Trimble Connect Web: This launches the in-browser web app. If the
open model is associated with a Trimble Connect project, the project
itself is opened, otherwise a default Trimble Connect page is opened.

• Trimble Connect for Window: This launches the Windows
application. Again, if the open model is associated with a Trimble
Connect project then that project is opened.

2. To open Trimble Connect from Trimble Connect Project Explorer:

4. Right-click on a folder in the Trimble Connect Project Explorer window.

5. Select Open in Trimble Connect Web, or Open in Trimble Connect for
Windows as required. 

The in-browser web or Windows app is launched and opened at the
selected folder.

3.3 Export to Trimble applications
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Click the following links to find out more about exporting to other Trimble
applications:

• Export a model to Tekla Structures (page 126)

• Export to Tekla Connection Designer (page 127)

• Export to Tekla Portal Frame Designer (page 128)

• Export to Tekla Tedds (page 132)

Export a model to Tekla Structures
To export a model to Tekla Structures, see the following instructions.

1. Create your model in the usual way.

2. Ensure that in Model Settings > Structural BIM > Export (page 1047) the
settings are as you require. 

NOTE For optimum performance of rebar transfer to Tekla Structures
ensure that the following are enabled:

• Separate objects for each stack > Concrete columns

• Separate objects for each span > Concrete beams

• Separate objects for each panel > Shear walls

3. On the BIM Integration tab, click Tekla Structures Export. 

The BIM Integration wizard opens.

4. On the first page, click Next.

5. Adjust the location and rotation of the model, and click Next.

6. Select the items that are included in the model, and click Next.

7. Specify the export names of material grades, and click Next.

8. Specify the file name and location.

9. Select whether the file is exported for the first time, or whether you want
to update an existing model.

10. Click Finish.

11. Start Tekla Structures and open the file to see your project.

NOTE Prior to running the export you can control which levels will be
included by setting Include in export as required in the Level
Properties (page 933). This allows individual levels to be:

• only included if the level is a floor

• always included
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• never included

Integration with Tekla Structures (Playlist)

Export to Tekla Connection Designer
Before exporting connections to Tekla Connection Designer, you are advised
to be aware of the limitations and also the recommended workflows for the
different connection types.

NOTE Only valid base plate, column splice and moment connections listed in the
Project Workspace Connections (page 83) tree can be exported.

To export a single connection

NOTE Export requires a Tekla Connection Designer licence.

1. Right-click the connection in a Scene View.

2. Choose Export (connection name) to Tekla Connection Designer from the
right-click menu. 

The Tekla Connection Designer application opens to allow the selected
connection to be designed.

To export multiple connections

NOTE Export requires a Tekla Connection Designer licence.

1. Select the connections to be exported in a Scene View.

2. On the BIM Integration tab, click TCD Export. 

The Tekla Connection Designer application opens to allow the selected
connections to be designed.

To return connection data from Tekla Connection Designer
Connection data from Tekla Connection Designer can be returned to Tekla
Structural Designer as follows:

1. In Tekla Connection Designer click Connection> Return Connection to
Tekla Structural Designer 
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NOTE In the current release, Moment Connection data from Tekla
Connection Designer is only partially returned. (e.g. Bolt layouts
and endplate dimensions are not returned).

Export to Tekla Portal Frame Designer

Export to Tekla Portal Frame Designer workflow
It is important to follow the correct definition, loading and design sequence
when frames are to be transferred for design to Tekla Portal Frame Designer.

1. Define frames/loading etc inTekla Structural Designer.

2. Run Analyse All (Static).

Analysis is necessary in order for the loading to be included in the export
to Tekla Portal Frame Designer.

3. Export the frame to Tekla Portal Frame Designer to design it and check
member stability.

4. Return revised sections/grades and haunch geometry back to the Tekla
Structural Designer model.

NOTE Only section sizes, haunch dimensions and steel grades are returned to Tekla
Structural Designer. Any other changes to the model data and loading are not
returned.

How loading, restraints and supports are handled in the export

Loadcases and combinations

When you open the Loadcases dialog in Tekla Portal Frame Designer the first
four loadcases are automatically created and named as follows:

• Self Weight

• Frame Dead Load

• Frame Service Load

• Frame Imposed Load

The loading in these loadcases will be taken from Tekla Structural Designer
loadcases (providing the loadcase names have been specified exactly as per
the below table):

Tekla Structural Designer Loadcase Tekla Portal Frame Designer
Loadcase

Self weight - excluding slabs Self weight
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Tekla Structural Designer Loadcase Tekla Portal Frame Designer
Loadcase

Dead Frame Dead Load
Services Frame Service Load
Imposed Frame Imposed Load

Every other Tekla Structural Designer loadcase that applies in-plane loading to
the frame gets exported to Tekla Portal Frame Designer retaining it's original
name.

If a particular Tekla Structural Designer loadcase does not apply any in-plane
load to the frame being exported, the loadcase is not exported and it is also
removed from the Tekla Portal Frame Designer load combinations.

If the Tekla Structural Designer model does not contain loadcases named
"Dead", "Services" or "Imposed"; the "Frame Dead Load", "Frame Service Load"
and "Frame Imposed Load" loadcases are created regardless, (defaulting to
the loading values specified in the Tekla Portal Frame Designer Preferences).
However, since these loadcases are not included in any load combinations
they will have no affect on the design.

If the Tekla Structural Designer model contains loadcases named "Dead",
"Services" or "Imposed" which do not apply any in-plane load to the frame
being exported; then in the same way as any other loadcase that does not
apply any in-plane load, the loadcase is removed from the Tekla Portal Frame
Designer load combinations. (In this situation the "Frame Dead Load", "Frame
Service Load" or "Frame Imposed Load" loadcase is still created regardless
(defaulting to the loading value specified in the Tekla Portal Frame Designer
Preferences), but once again since it does not get included in any load
combinations it will have no affect on the design.

Once loadcases that do not apply in-plane load have been removed from a
load combination, if the resulting combination is empty, or if it only contains
self weight, the combination itself is removed.

Lateral Restraints

The Tekla Structural Designer lateral restraints are exported, strut restraints
are ignored.

NOTE The below mappings assume default rotations of the rafters and
columns. (Changing the rotation by 180 degrees flips the restrained
flange in Tekla Portal Frame Designer.)

Rafter Restraints

These are exported to Tekla Portal Frame Designer restraints as follows

Tekla Structural Designer Lateral Restraint Tekla Portal Frame
Designer RestraintTop Flange Bottom Flange

X X Torsional
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Tekla Structural Designer Lateral Restraint Tekla Portal Frame
Designer RestraintTop Flange Bottom Flange

X - Outer
- X Inner
- - No restraint

Column Restraints

These are exported to Tekla Portal Frame Designer restraints as follows

Tekla Structural Designer Lateral Restraint Tekla Portal Frame
Designer RestraintFace A Face C

X X Torsional
X - Outer
- X Inner
- - No restraint

NOTE The rafter top flange and column face A can be identified graphically,
for details expand the Axis systems topic and then refer to the Object
Orientation section within it.

Supports

The Fy, Fz and Mx Tekla Structural Designer support properties are used to
configure the Tekla Portal Frame Designer base fixities as follows

Tekla Structural
Designer Support

Tekla Portal Frame Designer Base Fixity

Fy Fixed Horiz. Stiffness (ULS, SLS, Stability): Restrained
Fz Fixed Vertic. Stiffness (ULS, SLS, Stability): Restrained
Mx Fixed ULS: Rot. 100%, Cap. 100%

SLS: Restrained
Stability: Restrained

Fy Free-Release Horiz. Stiffness (ULS, SLS, Stability): 0kN/m
Fz Free-Release Vertic. Stiffness (ULS, SLS, Stability): 0kN/m
Mx Free-Release ULS: Rot. Free, Cap. 1%

SLS: Free
Stability: Free

Fy Free-Spring Linear:
XkN/m

Horiz. Stiffness (ULS, SLS, Stability): XkN/m

Fz Free-Spring Linear:
XkN/m

Vertic. Stiffness (ULS, SLS, Stability): XkN/m
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Tekla Structural
Designer Support

Tekla Portal Frame Designer Base Fixity

Mx Free-Spring Linear:
XkNm/rad

ULS: Rot. XkNm/rad, Cap. 1%
SLS: XkNm/rad
Stability: XkNm/rad

Fy Free-Spring Non
Linear:

-ve=XkN/m, +ve YkN/m

Horiz. Stiffness (ULS, SLS, Stability): Max (X, Y) kN/m

Fz Free-Spring Non
Linear:

-ve=XkN/m, +ve YkN/m

Vertic. Stiffness (ULS, SLS, Stability): Max (X, Y)
kN/m

Mx Free-Spring Non
Linear:

-ve=XkNm/rad, +ve
YkNm/rad

ULS: Rot. Max (X, Y) kNm/rad,
Cap. 1%

SLS: Max (X, Y) kNm/rad
Stability: Max (X, Y) kNm/rad

Mx Free-Nominally
Pinned: 10%

ULS: Rot. Free, Cap. 1%
SLS: 20%
Stability: 10%

Mx Free-Nominally
Pinned: X%

ULS: Rot. X%, Cap. 1%
SLS: X%
Stability: X%

Mx Free-Nominally
Fixed: X%

ULS: Rot. X%, Cap. 100%
SLS: X%
Stability: X%

To export a single frame

NOTE Export requires a Tekla Portal Frame Designer licence.

1. Right-click the frame in a Scene View.

2. Choose Export (frame name) to Tekla Portal Frame Designer from the
right-click menu. 

The Tekla Portal Frame Designer application opens to allow the selected
frame to be designed.

To export multiple frames

NOTE Export requires a Tekla Portal Frame Designer licence.
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1. Select the frames to be exported in a Scene View.

2. On the Home tab, click TPFD Export. 

The Tekla Portal Frame Designer application opens to allow the selected
frames to be designed.

To return revised sections from Tekla Portal Frame Designer
If the section sizes have been revised in Tekla Portal Frame Designer they can
be returned to Tekla Structural Designer as follows:

1. In Tekla Portal Frame Designer click Portal Frame> Return sections to
model

Export to Tekla Tedds
Once they have been designed using Tekla Tedds, precast and/or timber
members can then be exported to Tedds in order to output the calculations.

NOTE Export requires a Tekla Tedds licence.

Understanding each of the export options

Command Description
Export to Tekla Tedds > Model Launches Tekla Tedds and:

• Creates a new Tedds Project
containing seperate documents
for each member in the model.

Changes made in the Tedds Project
are not returned to the Tekla
Structural Designer model.

Export to Tekla Tedds > Member This option only appears for a
highlighted member if the option to
design using groups is not active.

Launches Tekla Tedds and:

• Creates a new Tedds Project
containing a single document for
the member.

• The data exported is taken from
the last design run (either Member
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Command Description
or Selection) associated with the
member.

Changes made in the Tedds Project
are not returned to the Tekla
Structural Designer model.

Export to Tekla Tedds > Group This option only appears for a
highlighted member if the option to
design using groups is active.

Launches Tekla Tedds and:

• Creates a new Tedds Project
containing a single document for
the group.

• The data exported is taken from
the last design run (either
Member, Group, or Selection)
associated with the group.

Changes made in the Tedds Project
are not returned to the Tekla
Structural Designer model.

Export to Tekla Tedds > Selection This option only appears if one or
more members are selected.

Launches Tekla Tedds and:

• Creates a new Tedds Project
containing seperate documents
for each member or group in the
selection.

Changes made in the Tedds Project
are not returned to the Tekla
Structural Designer model.

Export to Tekla Tedds >
<Substructure name>

Launches Tekla Tedds and:

• Creates a new Tedds Project
containing seperate documents
for each member in the sub
structure.

Changes made in the Tedds Project
are not returned to the Tekla
Structural Designer model.

To export all timber and precast members
1. In the Project Workspace, click Group tab.
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2. In the tree, right-click Groups.

3. In the context menu, select Export using Tekla Tedds > Model 

Tekla Tedds opens to allow the calculations for the all the exported
members to be output or recalculated.

NOTE If exported calculations are recalculated, the revised results are
not sent back to the Tekla Structural Designer model.

To export a single member
1. Right-click the member in a Scene View.

2. Choose Export to Tekla Tedds > Member from the right-click menu. 

Tekla Tedds opens to allow the calculations for the highlighted member to
be output or recalculated.

NOTE If exported calculations are recalculated, the revised results are
not sent back to the Tekla Structural Designer model.

To export multiple members
1. Select the precast and/or timber members to be exported in a Scene

View.

2. Right-click and choose Export to Tekla Tedds > Selection from the
context menu. 

Tekla Tedds opens to allow the calculations for the selected members to
be output or recalculated.

NOTE If exported calculations are recalculated, the revised results are
not sent back to the Tekla Structural Designer model.

To export a group
1. Right-click any member of the group in a Scene View.

2. Choose Export to Tekla Tedds > Group from the right-click menu. 

Tekla Tedds opens to allow the calculations for the highlighted group to
be output or recalculated.

NOTE If exported calculations are recalculated, the revised results are
not sent back to the Tekla Structural Designer model.
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To export a substructure
1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure you want to
export.

3. In the context menu, select Export using Tekla Tedds > <Sub structure
name> 

Tekla Tedds opens to allow the calculations for the substructure to be
output or recalculated.

NOTE If exported calculations are recalculated, the revised results are
not sent back to the Tekla Structural Designer model.

3.4 Export to and import from other applications
Tekla Structural Designer allows you to import and export data to different file
formats.

Click the following links to find out more about importing to and exporting
from other applications:

• Export a model to Autodesk Revit (page 135)

• Export a model to IFC (page 136)

• Export to and import from Westok Cellbeam (page 137)

• Export to and import from FBEAM (page 138)

• Export a model to ADAPT (page 143)

• Export a model to STAAD (page 147)

• Export a model to Autodesk Robot Structural Analysis (page 148)

• Export a model to the cloud (page 149)

• Export to One Click LCA (page 149)

• Export to IDEA StatiCa Connection Design (page 152)

Export a model to Autodesk Revit
To export a model to Autodesk® Revit®, see the following instructions.

1. Create the model as usual.

2. On the BIM Integration tab, click Autodesk Revit Export. 

The BIM Integration wizard opens.

3. Adjust the location and rotation of the model, and click Next.
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4. Select the items that are included in the model, and click Next.

5. Specify the export names of material grades, and click Next.

6. Specify the file name and location.

7. Select whether the file is exported for the first time, or whether you want
to update an existing model.

8. Click Finish.

NOTE Prior to running the export you can control which levels will be
included by setting Include in export as required in the Level
Properties (page 933). This allows individual levels to be:

• only included if the level is a floor

• always included

• never included

NOTE To open the exported file in Revit, you will need to have installed the
Tekla Structural Designer Integrator for Autodesk Revit. This is
available for download from the following link: https://
download.tekla.com/tekla-structural-designer/for-businesses/all-
downloads?field_package_reference_tid_selective=5713

Integration with Autodesk Revit (Playlist)

Revit-TSD Integration

Export a model to IFC
To export your model to IFC, see the following instructions.

1. Create the model as usual.

2. On the BIM Integration tab, click IFC Export. 

The BIM Integration wizard opens at the Relocate Export Model page.

The Relocate Export Model page allows for models to be moved from
the datum position in Tekla Structural Designer to a real world co-
ordinate.

3. Move and rotate the export model if required, and click Next.

4. On the Integration Filter page, select the items that are included in the
export model, and click Next.

5. On the IFC Export File page, select whether the file is exported for the
first time, or whether you want to update an existing model. Then specify
the file format, name and location.

6. Click Finish.
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NOTE Prior to running the export you can control which levels will be
included by setting Include in export as required in the Level
Properties (page 933). This allows individual levels to be:

• only included if the level is a floor

• always included

• never included

Export to and import from Westok Cellbeam
To export and import beams to and from Westok Cellbeam, see the following
restrictions and instructions.

RESTRICTION Cellbeam import and export are only available for BS and
Eurocode head codes.

Export to Cellbeam
1. On the BIM Integration tab, click Cellbeam Export. 

The Export Westok Beams dialog box opens. Any Westok Cellular beams
in the model are listed in the dialog.

2. Select the beams that you want to transfer to Westok Cellbeam, and click
Next.

3. Select the export format and name the file.

4. Click Next.

5. Ensure that you have selected the design combinations whose results you
want to use in the Westok beam design.

6. Click Next.

7. Select the folder where you want to place the Westok files, and click
Export.

8. Click Finish.

Import from Cellbeam

NOTE In order to import Westok beams into your model, you must have
previously created the beams in your Tekla Structural Designer model,
and have exported them to Westok design. When you do this, each
beam is given a unique identifier. This means that when you import
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the results from the Westok file, Tekla Structural Designer knows to
which beam in your model the imported details apply.

1. On the BIM Integration tab, click Cellbeam Import. 

The Import Westok Beams dialog box opens.

2. Click Add...

3. Select the files that you want to import.

4. If necessary, change the file names.

5. Click Open.

6. Click Import. 

Provided that Tekla Structural Designer recognizes the identifier, the
details in the files are imported to the associated beam in your model.

Export to and import from FBEAM
To export to and import from FBEAM, see the following instructions.

TIP Create substructures for your FABSEC® beams to make it easier to
review and manage the FBEAM workflow.

Overview
FBEAM is software from Fabsec for the design of composite and non-
composite plain and cellular beams.

The workflow for taking FABSEC® beams from a Tekla Structural Designer
model and designing then within FBEAM is as follows:

• Select the FABSEC® beams in your Tekla Structural Designer model and
click FBEAM Export.

This generates an XML file containing all the required properties required
for each member.

• You can then launch FBEAM and open the project you wish to import the
beams into.

• You then click the import button which starts FBEAM's import work flow.
This will allow you to load the previously created XML file and select a
subset or all of the beams in the file to import.

Once the process is complete FBEAM will have created all of the members
and their associated properties.

• You can then design the FABSEC® beams and specify fire protection
coatings.
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• Once complete, click the export button in FBEAM.

This generates another XML file that can be imported back into Tekla
Structural Designer.

• In Tekla Structural Designer, (with the model that was used to export the
beams open), click the FBEAM Import to start the import workflow. This
will then update each of the previously exported FABSEC® beams with the
properties contained within the FBEAM generated XML file.

The above workflow can be summarized as follows:
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Limitations
This following limitations apply to the import/export of FABSEC® beams:

1. Consider the case where multiple combinations are exported and a
loadcase of a particular load type e.g Dead appears in one combination
but not all. In FBEAM the analysis will include all loadcases of the same
type in each combination. This can overestimate the load significantly.

2. When Wind loadcases are exported to the 'Additional Load Set' for a
particular beam, Tekla Structural Designer searches for the Wind loadcase
that has the largest positive end force and exports that value to the
'Additional Load Set' and gives it a 'Type', 'Wind' in FBEAM. Similarly for the
maximum negative value in Tekla Structural Designer to the 'Type', 'Wind
Up' in FBEAM. This loadcase will be used in the design of that beam for all
positive wind combinations and all negative wind combinations
respectively. Whether a wind combination is considered negative is
determined from the start and end values of the distributed (Wind) load
applied to that beam (or point loads). If both are negative then the wind
combination is negative (uplift).

3. The special loadcase in Tekla Structural Designer 'Self weight - excluding
slabs' (i.e. beam self weight) is assumed always to be included in design
combinations. Consequently, the setting in FBEAM, 'Include the beam self
weight' is always switched on.

4. In any combination if any load type e.g. Dead or Imposed appears more
than once with different load factors, only one value of load factor is
exported. This situation is unusual but might occur for imposed loads for
example when different psi factors might apply.

5. Any load types or direction not supported by FBEAM are not passed
through. This includes minor axis loading, axial loading, trapezoidal loads
and torsion.

6. Imposed loads are typically entered into the 'protected' Construction
Stage load combination in Tekla Structural Designer to represent live
loads during construction e.g. due to 'heaping'. These are exported to
FBEAM as Load Type 'CL'. They are given a load factor that will be the
maximum from all imposed loadcases included in the Construction Stage
combination although typically only one is included and with a load factor
of 1.5.

7. Beam self weight loads are typically entered into the 'protected'
Construction Stage load combination in Tekla Structural Designer.
Normally these would be represented by the Load Type ' D' in FBEAM.
However, in order to avoid taking into account all of the dead loads,
including those at composite stage, the Construction Stage load
combination in FBEAM is populated with the beam self weight as a
'cladding' load, 'C'.
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8. The Slab Wet loads exported from Tekla Structural Designer should set
the 'Construction Stage Floor type' in FBEAM to 'CL' - typically this will
ensure that a load factor of 1.5 is used in the design combination for
Construction Stage. For EC this is correct but for BS it should be set to 'D'.
This setting is not accessible to the export from Tekla Structural Designer
and so must be changed manually if BS 5950 design is to be used.

9. For composite beams when the wet weight of the concrete is included in
the Construction Stage combination in Tekla Structural Designer, the
results in FBEAM will only be correct in the following circumstances:

a. Automatic Loading is checked on in the loadcase dialogue when Slab
Dry is selected as the load Type,

b. Automatic Loading is checked on in the loadcase dialogue when Slab
Wet is selected as the load Type,

c. At least on combination includes the Slab Dry loadcase,

d. The Construction Stage combination includes the Slab Wet loadcase.

10. Beams can be rotated in Tekla Structural Designer but in FBEAM are
always assumed to have their web vertical i.e. unrotated. Consequently
any beam rotation is not passed through from Tekla Structural Designer
to FBEAM and any loads in the global axis system that are applied to a
rotated beam are passed through to FBEAM as if they are applied through
the vertical web of the beam.

11. When several beams on the same floor are exported from Tekla Structural
Designer there can be several instance of 'Floor' in FBEAM. Each of these
could be assigned a different size of 'Mesh'. However, only one of these
will be imported into Tekla Structural Designer. It is recommended that
either only one value of mesh is set for these beams or that any required
changes to the slab mesh are made in Tekla Structural Designer and not
FBEAM.

12. In composite design, transverse reinforcement whether in the slab or as
part of the beam data is exported and imported as an area only. In Tekla
Structural Designer the area is derived from the bar size and spacing (or
mesh size). In the case of bars, the export transfers the area and in FBEAM
the default bar size will be shown with the exported area. For import the
area in FBEAM is processed by Tekla Structural Designer to find a bar size
and spacing that has an area greater than (or equal to) the area held in
FBEAM. Furthermore when 'loose bars' are used in the slab (unusual)
these are added to any from the beam data and transferred as one value
to FBEAM. Clearly on import these cannot be separated. This approach
has an impact on round tripping that the user must be aware of and make
appropriate adjustments post import or export.

13. Partial length shear connector layout with empty segments cannot be
created in Tekla Structural Designer. If cases like these are detected when
importing from FBEAM the partial shear connector layout will be extended
for the full length of the beam in Tekla Structural Designer.
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14. Web opening stiffeners applied only to one side of a beam are always set
to the right hand side when importing into FBEAM. When importing from
FBEAM to Tekla Structural Designer, the existing stiffeners in Tekla
Structural Designer keep their side regardless of how they were modeled
in FBEAM.

Export to FBEAM
Before exporting your FABSEC® beams, you should ensure the analysis has
been performed.

1. On the BIM Integration tab, click FBEAM Export. 

The FBEAM Export dialog box opens. Any FABSEC® beams in the model
are listed in the dialog.

2. Select the beams that you want to transfer to FBEAM, and click Next.

3. Select the combinations you want the beams designed for, and click Next.

4. Select the location to save to, name the file, and click Next. 

The export status of the selected beams is displayed.

5. Click Finish.

You can now go in to FBEAM and import the file that you have just created into
an existing or new project, so that the beams can be designed.

Import from FBEAM

NOTE In order to import FABSEC® beams, you must have previously created
them in your Tekla Structural Designer model, and have exported
them to FBEAM. When you do this, each beam is given a unique
identifier. After the beams have been designed in FBEAM you must
then choose the Tekla Structural Designer XML option to export them
to a file. This enables Tekla Structural Designer to know to which
beam in your model the imported details apply.

1. On the BIM Integration tab, click FBEAM Import. 

The FBEAM Import dialog box opens. Any FABSEC® beams in the model
are listed in the dialog.

2. Select the file that you want to import.

3. Click Next 

A list of the FABSEC® beams in the file is displayed from which you can
choose the beams to be imported.
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4. Select the beams that you want to import. 

You can only select beams to import that correspond to existing beams in
the Tekla Structural Designer model.

5. Click Next 

The import status of the selected beams is displayed. If any errors have
occurred, hovering the cursor over the error displays the reason in a
tooltip.

6. Click Finish. 

Provided that Tekla Structural Designer recognizes the beams, the details
in the file are imported to the associated beam properties, (including in
particular the beam UDA properties) in your model.

Review the imported beams
When FABSEC® beams are imported, User Defined Attributes are added to the
beam properties to record import status and fire design details. These can be
reviewed graphically.

To review the FABSEC® beam UDAs graphically:

1. If necessary, change the view regime (page 89) to a Review View.

2. On the Review tab, click UDA.

3. In the Properties window, with [M]ode set as Review, change the
Attribute to Import Status. 

Each FABSEC® beam is color-coded to represent the import status that
applies.

Export a model to ADAPT
Before exporting to ADAPT, read the following limitations. Then, you can
proceed to follow the detailed instructions to perform the export.

Limitations
The scope of the ADAPT Export is constrained by the fact that some
geometries, configurations and properties possible in Tekla Structural
Designer are beyond the scope of ADAPT. This imposes some unavoidable
limitations on the Export at this time, for example:

• Only concrete and steel materials are exported.

• Only horizontal beams and slabs are exported.

• Roof and wall panels are not supported.
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• For concrete walls, the following are not supported (all of which may be in
a Tekla Structural Designer); wall openings, non-rectangular walls, wall
extension, walls with top ends not at a level.

NOTE Both loads as well as reactions are linked to their reference member/
object in Tekla Structural Designer. This means that any loads or
reactions applied to a member that are beyond scope of the export
will not be exported either.

Details of what gets exported and what is beyond scope are as follows:

Units • Units are SI in the export file
Levels • Number of levels Included

• Level height Included
Gridlines • Beyond scope (Adapt import)
Materials • Concrete: Normal weight Included

• Structural Steel Included

• Concrete: Lightweight Beyond
scope (Adapt import)

• Mild Steel (Rebar) Beyond Scope
(Tekla Structural Designer export)

• Timber Beyond Scope (Tekla
Structural Designer export)

• Prestressing Beyond Scope (Tekla
Structural Designer export)

• Other / generic Beyond Scope
(Tekla Structural Designer export)

Load combinations • All active combinations are
included apart from Seismic
Inertia which is beyond scope

Loadcases • All loadcases are included apart
from EHF/NHF which is beyond
scope

Beams • Regular and irregular sections are
Included

• Beam at level Included

• Export by span Included

• Horizontal offsets Included

• Vertical offsets Included

• Tekla Structural Designer Labelling
Included

BIM integration 144 Export to and import from other applications



• Beam not at level Beyond Scope
(Tekla Structural Designer export)

• End trimming at column interface
Beyond Scope (Tekla Structural
Designer export)

• Sloping beams Beyond scope
(Adapt import)

• Axially rotated beams Beyond
scope (Adapt import)

• Reinforcement Beyond scope
(Adapt import)

Columns • Regular and irregular sections are
Included

• Export by stack Included

• Axially rotated columns Included

• Tekla Structural Designer labeling
Included

• Tilted columns Included

• Multi-stack columns Included

• Columns with holes Beyond scope
(Adapt import)

• Reinforcement Beyond scope
(Adapt import)

Walls • Concrete meshed walls Included

• Concrete mid-pier walls Included

• Export by stack Included

• Tekla Structural Designer labeling
Included

• No internal wall members
Included

• Multi-stack walls Included

• Bearing walls Included (exc.
reactions)

• Wall alignments Included

• Slopping walls Beyond scope
(Adapt import)

• Wall openings Beyond scope
(Adapt import)
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• Wall extensions Beyond Scope
(Tekla Structural Designer export)

• Non-rectangular walls Beyond
scope (Adapt import)

• Reinforcement Beyond scope
(Adapt import)

Slabs • Concrete slab on beams Included

• Concrete flat slabs Included

• Export by panel Included

• Tekla Structural Designer labeling
Included

• Vertical offsets Included

• Slab overhangs Included

• Non-concrete slabs Beyond Scope
(Tekla Structural Designer export)

• Slopping slabs Beyond scope
(Adapt import)

• Reinforcement Beyond scope
(Adapt import)

Drop panels • Concrete slab drops Included

• Trimming at slab edges Included

• Reinforcement Beyond scope
(Adapt import)

Openings • Slab rectangular openings
Included

• Slab circular openings Included
Braces • Beyond Scope (Tekla Structural

Designer Export)
Loading • Self weight Included

• User applied Force Included

• User applied Moment Included

• Level Point loads Included

• Horizontal Line loads Included

• Level area loads Included

• Offsets from reference level
Beyond scope (Adapt import)
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• Line and Area Loads applied to
horizontal plane Beyond scope
(Adapt import)

• Vertical line loads applied as point
loads at levels

Releases • Translational releases Beyond
Scope (Tekla Structural Designer
Export)

• Torsional releases Beyond Scope
(Tekla Structural Designer Export)

Stiffness modifiers • Beyond Scope (Tekla Structural
Designer Export)

Instructions

1. On the BIM Integration toolbar, click ADAPT Export. 

This shows a dialog which gives the name of the ADAPT import file which
Tekla Structural Designer will create. You can change the name and
location of the file if necessary.

2. Once the file details are correct click Save to create the ADAPT import file.

3. Launch ADAPT and import the file to see your project.

Export a model to STAAD
To export a model to STAAD, see the following limitations and instructions.

Limitations

The scope of the STAAD Export is constrained by the limitations of the STAAD
Text File (.std) format.

Note that:

• Elastic extensions cannot be defined in STAAD. Therefore, additional 1D
elements are created to preserve model connectivity.

• The exported file will not group elements in any way. 1D elements will not
be grouped as members (or columns, beams, etc). In addition, there will
not be any grouping of faceted elements from a curved member. 2D
elements will not be grouped into panels.

• Section data is exported as analysis properties only. This means that no
attempt is made to reference STAAD library sections.

• Material data is exported as analysis properties only. This means that no
attempt is made to reference STAAD library materials.
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• Objects such as Shear Only Walls have no equivalent native object in
STAAD and some of the internal data such as panel geometry and spring
properties end up lost during conversion.

Instructions

1. Create the model as usual.

2. On the BIM Integration tab, click STAAD Export. 

The Save As dialog opens.

3. If necessary, change the name and location of the file.

4. Click Save.

5. Start STAAD and open the file.

Export a model to Autodesk Robot Structural Analysis
Before you export a Tekla Structural Designer model to Autodesk Robot
Structural Analysis, read the limitations of Robot Export in the following
paragraphs. Once you have read the limitations, you can proceed to the
detailed instructions on how to export models from Tekla Structural Designer
to Autodesk Robot Structural Analysis.

Limitations

The scope of the Robot Export is constrained by the limitations of the Robot
Text File (STR) Format.

Note that:

• The model exported is the one used for 1st order linear static analysis (see
<Linear analysis of structures containing material non-linearity> to remove
non-linearity from the exported model.)

• 1D element springs are totally omitted from the export.

• Elastic extensions cannot be defined in Robot. Therefore, additional 1D
elements are created to preserve model connectivity.

• The exported file will not group elements in any way. 1D elements will not
be grouped as members (or columns, beams, etc). In addition, there will
not be any grouping of faceted elements from a curved member. 2D
elements will not be grouped into panels.

• Section data is exported as analysis properties only. This means that no
attempt is made to reference Robot library sections.

• Material data is exported as analysis properties only. This means that no
attempt is made to reference Robot library materials.

• Loads in projection are converted to equivalent loads in Robot.
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• Robot will not import the material properties for timber from the STR file.
When the file is opened in Robot, you can delete the G value and adjust the
values manually after import.

• It is not possible to define part-length distributed torsional loads in the STR
file. Therefore, they are converted to equivalent full-length distributed
torsional loads.

Instructions

1. Create the model as usual.

2. On the BIM Integration tab, click Robot Export. 

The Save As dialog opens.

3. If necessary, change the name and location of the file.

4. Click Save.

5. Start Robot and open the file.

Export a model to the cloud
To export a Tekla Structural Designer model to the cloud, see the following
instructions.

1. Create the model as usual.

2. On the BIM Integration tab, click Cloud Export. 

The Save As dialog opens.

3. If necessary, change the file name and location.

4. Click Save.

Export to One Click LCA

One Click LCA is third party software for performing a life cycle
assessment of your structure and optimizing its embodied carbon.

From Tekla Structural Designer you can either compile an offline report, which
is a compact summary of materials in the structure that can be edited if
required before being manually imported into One Click LCA, or you can
upload the report data directly to One Click LCA online.

BIM integration 149 Export to and import from other applications



Overview

Scope

Tekla Structural Designer includes material information in tabular data tables,
in general the scope of the exported data matches this. This gives a lot of the
most commonly requested material quantity information, but is not
considered to be exhaustive:

• Data available in Tekla Structural Designer but not exported

• Shear studs on composite beams

• Data NOT available in Tekla Structural Designer (and therefore not
exported)

• Reinforcement in any slab other than cast-in-place reinforced concrete
slabs

• Bearing Walls

• Shear Only Walls

• Transverse shear reinforcement required by composite beams

• surface area of timber members, cold rolled members, general material
members

• DELTABEAM® mass - a zero value is exported to help ensure allowance
is added manually

• analysis elements

• Exported Data not otherwise available in Tekla Structural Designer

• Precast slab screed/topping area

• Composite slab decking type / area

• material in gable and parapet posts

• surface area of defined “roof panels” and “wall panels”

The above summary is not guaranteed to be exhaustive, it is important to
consider “what is missing”? Are all the significant physical items you defined in
Tekla Structural Designer being covered by the export?

Additional information

The following notes may assist with initial use of the export:

• Grouping in One Click LCA

On import there is a phase where it is suggested that lots of the exported
data items can be grouped together on the basis of a shared
“IFCMATERIAL”. The sections below give examples where you may consider
the value of doing this:
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• composite / non-composite beams

the mass of these beam types are exported separately.

you may wish to apply higher carbon factors to composite beams to
allow for shear studs and transverse shear reinforcement.

• steel beams of all different fabrication types

the mass of steel members of different fabrication types are exported
separately.

e.g. rolled, plated, Westok, FABSEC®, DELTABEAM®

you may wish to apply different carbon factors to these different types
of member

• surface areas

the surface areas of slabs and many beams are all exported separately.

if you have no requirement to use any surface area information then it
will be easier to leave these grouped for simpler deletion.

• Slabs

• The data for each slab is exported separately (a slab may contain many
slab-items).

In simple situations this will mean one group of data for each level, but
if multiple slabs are defined in a level you will get separate data for
each.

• Data for different types of slab is also kept separate

e.g. Cast-in-place reinforced slabs, post-tensioned slabs, precast slabs,
composite slabs, various other general material slabs

For reinforced concrete slabs this allows a more detailed understanding
of reinforcement per slab.

• Limitation - as noted above reinforcement data is not available/
exported for other slab types, this will need to be allowed for in one of
two ways:

• Use the surface area information to add an allowance per m2

• Adjust the carbon factor or concrete/topping in the slabs to allow for
reinforcement content

In either case this will mean avoiding grouping of the relevant data
items.

• “roof panels” and “wall panels” surface areas

• Roof and wall surface area data is included in case it assists with the
inclusion of cladding materials.
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Feedback

• Please send us feedback if you feel that:

• Important data is missing

• Included data should be totalled/presented differently - perhaps there
should be options to do things in different ways (possibly at different
stages of design?)

• There should be options to filter out certain data types because you
don’t always want to use them (for example surface area info)

Show report

1. On the BIM Integration tab, click One Click LCA. 

The One Click LCAReport dialog opens.

2. Click Show report The report opens in Excel, (or whatever software is
associated with .xlsx files).

The resulting materials file can then be edited if required before being
manually imported into One Click LCA, or it can be passed on to a third party
and imported into One Click LCA.

Show online results

NOTE Online export requires a One Click LCA license.

1. On the BIM Integration tab, click One Click LCA. 

The One Click LCAReport dialog opens.

2. Enter your One Click LCA user name and password, then click Log in.

3. Click Show online results. The material data from the Tekla Structural
Designer model is uploaded to One Click LCA.

4. Proceed through the One Click LCA wizard:

a. Create/Choose project

b. Consider groupings

c. Review / apply mapping

On completion the amount of embodied carbon in the model is
determined.
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Export to IDEA StatiCa Connection Design
Before exporting connections to IDEA StatiCa, you are advised to be aware of
the limitations. Then, you can proceed to follow the detailed instructions to
perform the export.

NOTE Only valid connections listed in the Project Workspace Connections (page 83)
tree can be exported.

Limitations

NOTE The link is compatible with the latest versions of IDEA StatiCa 9.1 and 10.0; it is
also compatible with IDEA StatiCa 10.1 (build 10.1.113), but may not work with
earlier builds of 10.1.

The following geometrical limitations should be noted.

• Connection checks to BS 5950 are not supported.

• For connections identified as ‘Moment Connections’ using Update
connections in Tekla Structural Designer any out of plane members are not
exported.

• For any connections identified in Tekla Structural Designer the brace
members are not passed through to IDEA.

• For any connection type, haunches are not exported.

• Tekla Structural Designer uses ToS and the wire model is at this level too.
The export to IDEA depicts the ToS so that the 3D graphic looks correct.
However, the wire model typically connects at offsets of half the beam
depth. This introduces additional forces/moments due to eccentricity of
line of action etc. This line of action of the force set can be adjusted in IDEA.

Instructions for the export to IDEA StatiCa

NOTE Export requires an IDEA StatiCa licence.

1. Right-click the connection in a Scene View.

2. Choose Export Connection to IDEA StatiCa from the right-click menu,
selecting the analysis results to use at the same time.

3. Specify the file name and location for this connection. 

The IDEA StatiCa application opens to allow the connection to be
designed, the following data having been transferred:

• Connection geometry

• Section profile & material grade
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• Connection forces for each active solved Tekla Structural Designer
combination.

NOTE The Tekla Structural Designer model remains frozen until you
close the IDEA StatiCa connection.

4. Add bolts, stiffeners etc as required and design the connection.

When you close the connection Tekla Structural Designer becomes active once
more; the connection file is automatically embedded in the model.

Review of IDEA connections designed in Tekla Structural Designer
1. Within Tekla Structural Designer click Review>UDA

2. In the Properties Window set Mode to Review and Attribute to IDEA
StatiCa file 

Joints associated with IDEA StatiCa are shown

3. Use the right-click context menu to open previously exported connections
back to IDEA StatiCa.

Related video

Integration with IDEA StatiCa Connection design

BIM integration 154 Export to and import from other applications



4 Create models

To get started with modeling in Tekla Structural Designer see:

• Get to know Tekla Structural Designer basic working methods (page 155),
for a few first principles

• Create the model (page 174), to learn how to create and modify model
objects

Once you are comfortable creating objects, see:

• Edit the model (page 321), to get familiar with the model editing commands

• Check the model (page 338), for validation and measuring commands

• BIM integration (page 108), to learn how to exchange model data between
applications

See also

Create and design foundations (page 688)

BIM integration (page 108)

4.1 Get to know Tekla Structural Designer basic working
methods
Before creating real models, get to know some basic methods and techniques
that will help you to work efficiently.

We recommend you familiarize yourself with how to:

• work with grids and construction lines (page 188)

• define construction levels (page 175)

• zoom and rotate (page 156) the model

• create (page 174), select (page 158) and edit the properties of (page 168)
entities
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• re-position entities (page 169) by moving nodes or edges

• copy, move and mirror (page 321) part of, or all of the model

Zoom, pan, rotate and walk through the model
You can use the mouse to manually zoom, pan, or rotate the model.
Additionally, you can rotate the model by using the ViewCube, and walk
through your model in 3D views.

Zoom in and out, or zoom extents
• According to your needs, do one of the following:

To Do this
Zoom in or out • Scroll in or out with the middle mouse

button.

Zoom to the center of the visible objects • Right-click anywhere within the view.

• In the context menu, select Zoom Out.

NOTE You can also use the keyboard shorcut
ZA to zoom extents.

Pan the view
• Hold down the middle mouse button and drag the view according to your

needs.

Rotate the view manually
You can use the ViewCube to adjust the view. However, if none of the
standard ViewCube are appropriate, you can also rotate the model manually.

• Hold down the right mouse button and drag the view according to your
needs.

Adjust the view with the ViewCube
1. Move the mouse pointer over the ViewCube.

2. According to your needs, do one of the following:

To Do this
Display one of the eight isometric views • Click the required vertex on the ViewCube.
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TIP If the required vertex is not visible, click
one of the other vertices to spin the
ViewCube until you can see the required
vertex.

Display one of the twelve edge views • Click the required edge on the ViewCube.

TIP If the required edge is not visible, spin the
ViewCube by clicking the vertex that is
adjacent to the required edge.

Display one of the six face views • Click the required face on the ViewCube.

TIP If the required face is not visible, spin the
ViewCube by clicking the vertex adjacent
to the required face.

NOTE When a face view is displayed, the
additional ViewCube controls appear:

• If the required face is not visible in
a face view, roll the ViewCube by
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clicking one of the triangular
controls.

Walk through the model in a 3D view

• On the Home tab, click Walk. 

NOTE In the Walk mode:

• To move forward, backward, left or right, use the arrow keys.

• To move up and down, use the Q and Z keys.

• To rotate the view, hold down the right mouse button and drag
the view.

• To exit Walk mode, press Esc.

Display a 2D view in 3D
1. In a 2D view, click the 2D/3D toggle button, located on the bottom right

corner of the window.

Select entities
Many Tekla Structural Designer commands require you to make selections.
You can make single and area selections from any 2D or 3D view. You can also
make selections from the Project Workspace.

TIP Use (page 64) to display everything not in the selection as ghosted, this makes it
easier to focus on the selection.

TIP If planar objects, such as slabs, roofs and area loads, obscure what you want to
select, you can hide them using the (page 68) window.

Use the different methods listed below to select the entities.

Select single entities
1. In a 2D or 3D view, move the mouse pointer over the desired entity. 

If the entity is the only one at the location, it becomes highlighted and its
name is shown in the Select Entity tooltip.

If several entities are located at the same location, their names are all
listed in the Select Entity tooltip.
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Use the up and down keys to scroll through the list to reach the desired
entity.

2. When the desired entity is highlighted in the Select Entity tooltip, press
Enter to select it.

The selected entity is then displayed in the active selection color, the nodes
for positioning it are exposed, and the entity properties are displayed in
the Properties window.

Select multiple entities using area selection
1. You can select multiple objects using area selection. The dragging

direction affects the selection of objects.

a. To select all entities that are completely within a rectangular area,
hold down the left mouse button and drag the mouse from left to
right.
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b. To select all entities that are at least partly within a rectangular area,
hold down the left mouse button and drag the mouse from right to
left.

c. To select all objects that are at least partly crossed by a straight line,
hold down the shift key, then hold down the left mouse button and
drag the mouse to draw the line.

After selection, one entity type is displayed in the active selection color and
has its properties shown in the Properties window.

Any other entity types in the selection are displayed in the local selection
color.
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NOTE You can change the active and local selection colors by clicking
Home > Settings > Scene > Colors > Selection.

2. To display the properties of another entity type in the selection, choose it
from the droplist at the top of the Properties window.

 

NOTE If there is only a single item in the active selection, all its
properties are shown; if there are multiple items in the active
selection, only common properties are shown.

Select using Find
1. Click Find on either the Home tab, or the Quick Access toolbar. 

The Find dialog opens.

2. In the Find box type any of the following, in whole, or in part:

a. An object 'Type'

b. An object 'Name'

c. An object 'Index'

As you type, any objects that match the criteria are listed in the table
below.
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3. When the object(s) that you require are shown, click to highlight them as
follows:

a. Single click to highlight a single object

b. Ctrl+click to select multiple non-sequential rows

c. Shift+click to select multiple sequential rows Once the object(s) are
highlighted, Select becomes available.

4. Click Select to locate the object in the active view, zoom in, and display its
properties in the Properties window. 

NOTE If the object doesn't exist in the active view a new view containing
the object will become active.

TIP Sometimes when clicking Select the object being located is
obscured from view by other objects. By leaving (page 64) checked
this is avoided, as all objects other than those being found are made
semi-transparent.

NOTE If not using Ghost Unselected, you can change the color used to
highlight the found entity by clicking Home > Settings > Scene >
Colors > Selection and changing the Global - User color.

Select from the Project Workspace

1. Do one of the following:

To Do this
Select individual members from the Structure
tree

a. Expand the Members branch and any
appropriate sub branches until you can
click the required member.

b. Right-click the member name.

c. In the context menu, select Select in
visible views.

The member's properties are viewed in the
Properties window.

Select member groups or individual members
from the Groups tree

a. Expand the appropriate branches until you
can click the required group or member
name.

b. Right-click the member or group name.

c. In the context menu, select Select in
visible views.

The member's or group's properties are viewed
in the Properties window.
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Select nodes
Sometimes you need to select only the nodes of an entity, for example when
moving a beam.

1. In a 2D or 3D view, select the entity. 

The entity is selected and any nodes associated with the entity are
displayed.

2. Move the mouse pointer over the desired node. 

The node becomes highlighted and appears in the Select Entity tooltip.

3. Press Enter. 

You will now be prompted to pick a point to move the node to.

4. Click at a new location to reposition the node. 
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The entity is updated accordingly.

See also: Re-position entities by moving nodes or edges (page 169)

Modify the selection
You can add or remove entities from the current selection.

1. Do one of the following:

To Do this
Add an entity to the current selection a. Hold down the Ctrl key.

b. Click the entity that you want to add to the
selection.

The properties of the newly selected entity
are added to the Properties window.

Remove an entity from the current selection • Click the entity you want to de-select.

The entity's properties are removed from
the Properties window.

Remove multiple entities a. Do one of the following:

• To de-select only the entities that are
encompassed by the box, move the
mouse pointer to the left corner of the
imaginary box that will encompass the
entities.

• To de-select the entities that are
encompassed by the box and that it
crosses, move the mouse pointer to
the right corner of the imaginary box
that will encompass the entities.

b. Hold down the Ctrl key and drag the
mouse pointer to the opposite corner of
the box.

A rectangle on the screen shows the area
that you are selecting.

c. Release the mouse button and the Ctrl
key.

The entities are removed from the
Properties window.

Remove a beam/column/wall and simultaneously
remove its constituent spans/stacks/panels

If a continuous beam and its constituent spans
are selected, they can all be deselected with a
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single mouse-click while holding down the Ctrl
key.

The same method can be applied to a continuous
column and its constituent stacks, or a wall and
its constituent panels.

Remove all entities • Press Esc.

The information displayed in the Properties
window is cleared.

Use Ghost Unselected to focus on the selection

You can toggle Ghost Unselected on and off using the  button in the
bottom corner of the view.

• Ghost Unselected off: selected entities are displayed in the active selection
color, this can make it hard to distinguish between individual entities in the
selection.

• Ghost Unselected on: selected entities are displayed in their nomal colors
(appropriate to the Scene View that is active), unselected objects are semi-
transparent. If nothing is selected, everything is displayed in its normal
color.

• In a Structure View, the selection would be displayed as:
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• In a Review View showing Design Status, the selection would be
displayed as:
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Select a section in the Select Section dialog box
Select Section dialog box allows you to select sections to use them in your
model. You can also add and delete user-defined sections in the database by
using the dialog, if necessary.

To access the Select Section dialog box:

1. On the Model tab, select the member you want to design.

2. In the , click the arrow on the right side of the Section field.

3. Click <New\Edit...>.

The Select Section dialog box opens.

1. Country list

2. Geometry filter

3. Page pane

4. Selected section

5. Section filter

6. Item pane

7. Details pane

1. In the Country list, select the desired country.

2. In the Page pane on the left, select the desired geometry. 
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NOTE If you cannot find the desired shape, ensure that the Geometry
filter does not filter it out.

3. In the Item pane on the right, select the desired section size.

4. Click Select.

Edit entity properties
Any selection of one or more entities can be edited using the Properties
window. Individual model objects can also have their properties edited using
the Properties dialog box.

Edit properties using the Properties window
All entities can have their properties edited using the Properties window

1. Select the entity either in the graphical display or in the Structure tree. 

For more information, see Selection methods (page 158).

2. In the Properties window, modify the properties according to your needs.

Edit properties using the Properties dialog box
Individual model objects can have their properties edited using the
Properties dialog box

1. Hover the mouse pointer over the object that you want to edit.

2. In the Select Entity tooltip, select the object. 

For more information, see Selection methods (page 158).

3. Right-click the object.

4. In the context menu, select Edit. 

The Properties dialog box opens.

5. Modify the properties according to your needs.

6. Click OK.
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Edit properties of multiple entities

NOTE You can view and modify the common properties of multiple entities
in the Properties window.

Note that:

• If the value of a certain item is not identical for all the selected
entities, the cell appears blank in the Properties window.

• If you modify the blank cell, Tekla Structural Designer applies the
new setting to all the selected entities.

• If you have selected multiple entities of different types, the
property information is displayed separately for each type. Use the
list at the top of the Properties window for moving between types.

1. Select the entities in the graphical display. 

For more information, see Selection methods (page 158).

2. If you have selected entities of different types, select the desired type in
the list on top of the Properties window.

3. In the Properties window, modify the properties according to your needs.

4. Repeat steps 2–3 for entities of different types.

Re-position entities by moving nodes or edges
After selecting an entity you can re-position it by moving nodes or edges.

Modify one end of a grid or construction line
Grid and construction lines can only be modified in 2D views.

1. Select the grid or construction line. 
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The nodes at each end and at the mid-point become visible.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click where you want to move the end node. 

Tekla Structural Designer redraws the line, moving the end node to the
selected point.

Move a grid or construction line
Grid and construction lines can only be moved in 2D views.

1. Select the grid or construction line. 

The nodes at each end and at the mid-point become visible.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click where you want to move the end node. 

Tekla Structural Designer redraws the line, moving the end node to the
selected point.
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Modify one end of a member
To move an entire member, see: Move objects (page 322).

To move just one end of a member, proceed as follows:

1. Select the member in a 2D or 3D view. 

The nodes at each end and at the mid-point become visible.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click a grid or construction point where you want to move the end node. 

Tekla Structural Designer redraws the member, moving the end node to
the selected point.

Modify slab items and panels by moving a node
To move entire slab items and panels, see: Move objects (page 322).

To move a slab/panel node, proceed as follows:

1. Select the slab item or panel that you want to modify in a 2D or 3D view. 

The nodes at each vertex and at the mid-point of each edge become
visible.

2. Click a node to select it. 

You can select either corner nodes, or nodes at the mid-points of the
edge.
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3. Move the mouse pointer over an existing construction point or
intersection.

4. Click the point to reposition the node. 

NOTE When you reposition nodes, note that:

• The new node position must be in the same plane as the slab
item or panel.

• When you move a node at the mid-point of an edge, it
becomes a new corner node. Tekla Structural Designer
automatically creates two new mid-point nodes.

• When you move a corner node directly over an adjacent
corner node, Tekla Structural Designer deletes the original
corner node.

Modify slab items by moving an edge
To move entire slab items and panels, see: Move objects (page 322).

To move a slab/panel edge, proceed as follows:

1. Select the slab item that you want to modify in a 2D or 3D view.

2. Click an edge to select it. 

Ensure that you have selected an edge, and not a node.

3. Move the mouse pointer over an existing construction point or
intersection.

4. Click to reposition the edge so that it passes through the selected point. 

NOTE The new edge position must be in the same plane as the slab
item.

Modify walls by moving a node
To move an entire wall, see: Move objects (page 322).

To move a wall node, proceed as follows:
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1. Select the wall that you want to modify in a 2D or 3D view. 

The nodes at each vertex become visible.

2. Click a node to select it. If you want the result of moving the node to be a
rectangular wall, the Rectangular property in Properties window should
be selected, otherwise it should be unselected.

3. Move the mouse pointer over an existing construction point or
intersection.

4. Click the point to reposition the node. 

NOTE The new node position must be in the same plane as the wall.

If the Rectangular property was checked, both the selected node
and one other will be moved as required to form a rectangular
wall.

Tips for basic tasks
Here we provide useful hints and tips that help you use the Tekla Structural
Designer user interface and its basic features more efficiently.

Use the tooltip for input in a command
When you need to specify a distance or pick a point, a tooltip appears,
displaying the current value.

1. Do one the following:

• Move the mouse pointer to the required point and click the point to
use it.

• Press F2 to type an exact number, and press Enter.
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Undo a command

1. In the Quick Access toolbar, click Undo.

Cancel a command or go back to the previous prompt
Yellow command prompts are viewed on the top of the active view to guide
you through each command. To react to command prompts, see the following
instructions.

• Do one of the following:

To Do this
Cancel a command • Press Esc at the first command prompt.

Go back to the previous command prompt • Press Esc at a subsequent command prompt.

TIP Selecting another command also cancels the current command.

Example

The parallel grid line command consists of four steps. Hence, four consecutive
command prompts are displayed.

1.

2.

3.

4.

The grid line is created after the fourth prompt. After that, prompt 2 is
automatically redisplayed.

At this point, you can either continue to create additional lines parallel to the
original, or go back to the first prompt by pressing Esc.

Then, you can either select a new reference line and continue again, or cancel
the command by pressing Esc again.

4.2 Create the model
When you model in Tekla Structural Designer, you create and work with
different types of model object. In most cases, a model object represents a
member type that will exist in the real building or structure, or that will be
closely related to it. You will also work with modeling aids such as grids and
construction lines, that represent information that is only relevant when you
are creating the model.

You can use the following modeling aids:

• Construction levels (page 175)
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• Grids (page 178), construction lines (page 188) and free points

• Frames and slopes

• Dimensions (page 196)

• DXF reference drawings (page 186)

You can create the following physical member/object types:

• Beams, columns and braces (page 196)

• Walls and cores (page 234)

• Slabs and decks (page 258)

• Trusses and steel joists

• Portal frames

• Cold rolled members

The following panels/objects are useful for applying loads to the model:

• Wall panels and roof panels

• Ancillaries (page 285)

• Equipment (page 295)

• Inactive members (page 306)

You can also use the following general members/objects when required:

• Supports (page 314)

• Analysis elements (page 317)

Create and manage construction levels
In the Construction Levels dialog box, you can define and modify the levels
that you need to construct your model. The levels can be floors, roofs, or
intermediate levels required to define specific items.

Open the Construction Levels dialog
• Do one of the following:

• On the Model tab, click Construction Levels.

• In the Structure tree, double-click Levels.

Insert a single construction level
1. In the Construction Levels dialog box, select an existing level.
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2. According to your needs, click either Insert Above or Insert Below.

3. If necessary, change the level type:

• If you are creating a steel structure, set each new level as T.O.S. (top of
steel).

• If you are creating either a concrete or mixed material structure, set
each new level as S.S.L. (structural slab level).

4. If necessary, change the level name.

5. For the new level, do one of the following:

• Specify the height above the base in the Level field.

The inter-story spacing is calculated automatically.

• Specify the inter-story spacing in the Spacing field.

The level is calculated automatically.

NOTE A default height is calculated for the new level based on the
spacings of any existing levels immediately above or below it.
Either accept the height, or adjust it as required.

6. If you want Tekla Structural Designer to treat the level as a floor, select the
Floor option.

Insert multiple construction levels
Multiple levels can be inserted, either above the current top level, or below the
current bottom level.

1. In the Construction Levels dialog box, select an existing level.

2. According to your needs, click New on Top or New at the Bottom

3. For each construction level, type the level spacing and click OK. 

TIP If you have new levels at 12' 6" , 18' 6" , 27' 6" , 36' 6" and 27" above
the current level, you can specify the levels as 12' 6" , 18' 6" , 3*9'.

4. If necessary, change the level names.

5. If necessary, change the level type:

• If you are creating a steel structure, set each new level as T.O.S. (top of
steel).

• If you are creating either a concrete or mixed material structure, set
each new level as S.S.L. (structural slab level).
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Make a level an identical copy of another level
If needed, you can determine a level as an identical copy of another level. In
this case, all changes made to either the source level or the identical level are
automatically applied to both levels. To make a level an identical copy of
another level, see the following instructions.

1. Open the Construction Levels dialog box.

2. At the level you want to be a copy, click the arrow in the Source column.

3. Select the level that you want the current level to be identical to.

4. Click OK.

Make a level an independent copy of another level
If you determine a level as an independent copy of another level, any changes
made to each level only apply to that level. To make a level an independent
copy of another level, see the following instructions.

1. Open the Construction Levels dialog box.

2. At the level you want to be a copy, click the arrow in the Source column.

3. Select the level that you want the current level to be identical to.

4. Click OK.

5. Reopen the Construction Levels dialog box.

6. At the same level, click the arrow in the Source column again.

7. Set the level as -unique-.

8. Click OK.

Modify the properties of a construction level
You can modify some properties of construction levels in the Construction
Levels dialog box dialogs, but other parameters can only be edited in the
Properties window. For more information, see the following instructions.

1. In the Structure tree, click the + sign next to Levels.

2. Click the name of the construction level that you want to modify. 

The properties of the level are viewed in the Properties window.

3. In the Properties window, modify the level properties according to your
needs.

Delete construction levels
To delete construction levels, see the following instructions.
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WARNING Deleting a construction level completely deletes the entire level
and all its associated details, such as beams, members, or slab.
You cannot recover the level once you have deleted it.

1. In the Construction Levels dialog box, select the level that you want to
remove.

2. Click Delete.

3. Click OK. 

NOTE You can also delete construction levels using the Structure tree.
Note that :

a. Click the + sign next to Levels.

b. Right-click the level that you want to remove.

c. In the context menu, select Delete.

Create and manage architectural grids and grid lines

Architectural grids

An architectural grid is a collection of grid lines that lie in a horizontal plane.
Each architectural grid is only displayed in the 3D View and at the lowest level
in the structure. Vertical lines can be projected from each grid intersection of
the architectural grid. The vertical lines extend to the topmost level at which
the architectural grid has been applied.

You can assign a color for each architectural grid, and set to display grid line
names and vertical lines in the architectural grid properties.

NOTE Even when architectural grid properties are checked, they are only
displayed provided that the Architectural Grids --> Text2D and
Architectural Grids --> VerticalLines options are selected in Scene
Content.

Grid lines

Each grid line is associated with an architectural grid, and is only created at a
given level, provided the architectural grid has been applied at that level.

Grid lines that have been created at a given level can optionally be shown or
not shown in both the 2D and 3D views using the level properties.
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NOTE Even when the show/hide options are checked the lines are only
displayed provided that the relevant Grid & Construction Lines
options are also checked in Scene Content.

TIP Even when you have activated the display of grid & construction lines in
Scene Content for a particular 2D or 3D view, you may still find that the
grid lines are not displayed on particular levels.

In this situation, do the following:

1. In the Structure tree, open the Levels branch.

2. Click the level at which you want to view the grids.

The level properties are viewed in the Properties window .

3. In the Properties window:

• To make grids visible in a 2D view, select the Show grids in
plane view option.

• To make grids visible in a 3D view, select the Show grids in the
3D view option.

If the grids are still not visible in the 3D view at certain levels, ensure that
grids are applied at the levels in question. For further information, see
Apply an architectural grid to a specific level (page 185).

Create grid lines
Tekla Structural Designer allows you to create various types of grid lines
according to your needs. For detailed instructions, see the following
paragraphs.

Create a single grid line

NOTE If you want to create a series of grid lines which form a regular or
irregular, rectangular or radial grid line system, the Rectangular
Wizard and Sector Wizard are the fastest options.

1. Ensure that the 2D view containing the construction level on which you
want to create your grid line is active.

2. Go to the Model tab.

3. In the Grid Line list, select Grid Line.

4. In the Properties window, review the default next vertical/horizontal grid
name and edit if required.

5. Select the point where you want the grid line to start. 
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TIP The tooltip views the mouse pointer's exact coordinates. If the
mouse pointer has not snapped to the required point, press F2 to
type the exact coordinates of the required point.

6. Select the point where you want the grid line to end. 

TIP The tooltip views either the absolute, relative, or polar coordinates
of the end point, depending on whether the ABS, REL, or POL
button is selected in the (page 67).

• To switch the display, click one of the other buttons.

NOTE The grid line does not extend to infinity. Do ensure that the grid
line is sufficiently long to meet your needs.

Tekla Structural Designer creates the grid line between the selected
points.

Create parallel grid lines
This option creates a grid line parallel to an existing one, but of a different
length. To use this option, you must have at least one existing grid line in the
current 2D view.

1. Go to the Model tab.

2. In the Grid Line list, select Parallel.

3. In the Properties window, type a name for the grid line.

4. Select the grid line to which your new grid lines will be parallel.

5. Move the mouse pointer to the distance where you want to place the
parallel grid line. 

TIP The tooltip views the distance of the dotted line from the initial grid
line you selected in step 3. Press F2 to type the exact distance.

For more accuracy, you can zoom in.

6. Click to locate the new grid line.

7. Click the points where you want the new grid line to start and end. 

The construction line is now created.

8. Move the mouse pointer and place other grid lines with respect to the line
you selected in step 3, or press Esc to end grid placement. 
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TIP To create parallel grid lines of the same length as the selected

gridline, select the Parallel (quick) command.

When you create quick parallel grid lines, you can press F2 to define
the distance between successive pairs of grid lines, separating the
numbers with commas. If you have a number of bays that are at the
same centers, then you can specify these as a single entry.

For example, you can specify bay centers of 18', 27' , 18' 6" , 18' 6" ,
18' 6" and 27" as 18' , 27' , 3x18' 6" , 27".

Create perpendicular grid lines

To use this option, you must have at least one existing grid line in the current
2D view.

1. Go to the Model tab.

2. In the Grid Line list, select Perpendicular.

3. In the Properties window, type a name for the grid line.

4. Select the grid line to which your new grid line will be perpendicular.

5. Move the new grid line to the desired position and click to locate it. 

TIP The tooltip views the perpendicular distance of the dotted line from
the middle of the grid line you selected. Press F2 to type the exact
distance.

6. Click the points where you want the new grid line to start and end.

7. Move the mouse pointer and place other grid lines with respect to the line
you selected in step 4, or press Esc to end grid placement.

Create a rectangular grid line system

1. Ensure that the 2D view representing the construction level on which you
want to create your rectangular grid line system is active.

2. On the Model tab, in the Grid Line list, select Rectangular
Wizard. 

The Rectangular Grid Wizard opens.

3. Type a name for the grid and select a color for the grid lines.

4. Ensure that each construction level on which you want to create the grid
layout is selected.

5. Click Next.
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6. Define the origin of the grid line system either by clicking it in the 2D view,
or by entering its coordinates in the Rectangular Grid Wizard.

7. Click Next.

8. Select if you want to create grid lines in the X direction only, in the Y
direction only, or in both directions.

9. Select the style that you want to use for the grid lines.

10. Click Next.

11. On the following pages, define the layout of grids for the bays in the X and
Y directions. 

NOTE You can define either a regular or an irregular grid layout:

• For a regular grid, define the number of bays you want to
create and the bay centers.

• For an irregular grid, define the distance between successive
pairs of grid lines, separating the numbers by commas. If you
have a number of bays that are at the same centers, you can
specify them as a single entry (for example, 3x18'6").

You can also specify the reference of the first grid line, and by
how much you want to increment that reference to give the
references of the other lines that you create.

• For alphanumeric grid lines, if you specify that the first grid
line reference is to be D, and specify an increment of 3, your
grid lines will be referenced D, G, J, M, and so on.

12. Click Next.

13. Define the rotation of the grid either by moving the mouse over the 2D
view and clicking, or by typing values into the Rectangular Grid Wizard. 

TIP In the Rectangular Grid Wizard, you can specify the rotation with
respect to either the grid line system's local x or local y direction.
This is helpful if you are creating a grid line system that is not
orthogonal.

14. Click Next.

15. Specify the angle between the axes with respect to either the X or Y axis
system.

16. Click Finish.

Create a radial grid line system

1. Ensure that the 2D view representing the construction level on which you
want to create your radial grid line system is active.
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2. On the Model tab, in the Grid Line list, select Radial Grid
Wizard. 

The Radial Grid Wizard opens.

3. Type a name for the grid and select a color for the grid lines.

4. Ensure that each construction level on which you want to create the grid
layout is selected.

5. Click Next.

6. Define the origin of the grid line system either by clicking it in the 2D view,
or by entering its coordinates in the Radial Grid Wizard.

7. Click Next.

8. Select whether you want to create the radial lines only, the arcs only, or
both of these.

9. Select the style that you want to use for the grid lines.

10. Click Next.

11. Define the layout of the arcs that you will create. 

NOTE You can define either a regular or an irregular grid layout:

• For a regular grid, define the number of bays you want to
create and the bay centers.

• For an irregular grid, define the distance between successive
pairs of grid lines, separating the numbers by commas. If you
have a number of bays that are at the same centers, you can
specify them as a single entry (for example, 3x10'6").

You can also specify the reference of the first grid line, and by
how much you want to increment that reference to give the
references of the other lines that you create.

• For alphanumeric grid lines, if you specify that the first grid
line reference is to be D, and specify an increment of 3, your
grid lines will be referenced D, G, J, M, and so on.

You can also select whether the arc grid lines are represented as
curves, or as a series of straight lines between the points where
the arc intersects the other grid lines created as part of this
process.

12. Click Next.

13. Define the layout of radial grid segments that you want to achieve. 

Again, you can specify the reference of the first grid line, and how you
want to increment the reference to give the references of the other radial
lines that you create.
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14. Click Next.

15. Define the rotation of the grid either graphically by moving the mouse
over the 2D view and clicking, or by typing values into the Rectangular
Grid Wizard 

TIP In the Rectangular Grid Wizard, you can specify the rotation with
respect to either the grid line system's local x or local y direction.

16. Click Finish.

Create a grid arc

1. Go to the Model tab.

2. In the Grid Line list, select Arc.

3. In the Properties window, type a name for the grid line.

4. Select the point which lies at the center of the grid arc which you want to
create. 

The tooltip views the mouse pointer's exact coordinates.

5. Click the points where you want the grid arc to start and end.

6. Move the mouse pointer and place other grid arcs with respect to the line
you selected in step 4, or press Esc to end grid placement.

Number and renumber grids
Each grid that you create is automatically numbered. To set the initial number
or letter for naming grids, or to renumber all grids, see the following
instructions.

Set the initial number or letter used for grids

1. On the Home tab, click Model Settings.

2. Go to References --> General.

3. In the Grid Line Naming section, set the initial values and the naming
style.

4. Click OK.

Renumber all grids

1. In the Structure tree, right-click Architectural Grids.

2. In the context menu, select Renumber. 
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A dialog box is displayed which allows you to renumber the grid line
based on

• the type from direction (default ON) or

• choose grid name type and direction

3. Select the parameters as required, then click OK. 

All grids in the model are renumbered in the chosen sequence.

See also

Change the name of a grid line or grid arc (page 185)

Change the name of a grid line or grid arc
To change the name of a single grid line or grid arc, see the following
instructions.

1. Select the grid line or grid arc that you want to name.

2. In the Properties window, modify the name according to your needs.

See also

Number and renumber grids (page 184)

Change the name or color of an architectural grid (page 185)

Apply an architectural grid to a specific level
To view an existing architectural grid at a specific level of your model, you
must apply the grid to the level. See detailed instructions in the following
paragraphs.

1. In the Structure tree, click Architectural Grids.

2. Right-click the architectural grid name.

3. In the context menu, select Edit...

4. Ensure that the levels where you want the architectural grid to be applied
are selected.

See also

Create and manage architectural grids and grid lines (page 178)

Change the name or color of an architectural grid
To modify the properties of an existing architectural grid, see the following
instructions.
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1. In the Structure tree, click the + sign next to Architectural Grids.

2. Select the architectural grid whose name you want to change.

3. In the Properties window, modify the architectural grid's properties
according to your needs.

See also

Change the name of a grid line or grid arc (page 185)

Import grids from a DXF file or a shadow of the DXF file
If necessary, you can import grids from an existing DXF file to your Tekla
Structural Designer document. In addition, you can use a DXF file as a shadow,
or a base that helps you in creating objects in Tekla Structural Designer.

NOTE The DXF file that you use must be available before you start the
import process, either sent to you, or created by you.

1. Open a 2D view of a construction level, and go to the Model tab

2. In the Grid Line list, select Import DXF. 

An Open dialog opens.

3. Browse to the file that you want to import, select the file, and click Open. 

The DXF Import Wizard opens.

4. On the first page, manage the layers and colors that you want to import.

5. Select if you want to import the architectural grids from the file, or import
the file as a shadow.

• If you import the architectural grids, all elements in the selected layers
of the DXF file are mapped to the Tekla Structural Designer grid lines.
You must therefore ensure that you switch off all the layers in the DXF
file, apart from the layers in which the grids have been defined.

• • If you import the DXF file as a shadow, Tekla Structural Designer
imports the .dxf file but does not create any Tekla Structural Designer
objects. You can use the intersection points and other elements as the
source on which to add the Tekla Structural Designer objects you
require.

6. If necessary, adjust the scale and offsets for the DXF file.

7. Click Next.

8. Select how the grids are created:

• To create separate named grids for each layer, select By layer.
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• To create separate named grids for each color in the DXF file, select By
color.

• To create a single merged grid containing all layers and colors, select
Merged.

9. Ensure that each level to which you want to import the grid layout is
selected.

10. Click Finish.

See also

Create and manage architectural grids and grid lines (page 178)

Change the name of a grid line or grid arc (page 185)

Change the name or color of an existing architectural grid (page 185)

Extend, move, or rotate grid lines and arcs
You can modify grid lines and arcs in different ways according to your needs.
You can stretch, shorten, or rotate grid lines, or move them in a perpendicular
direction. As for grid arcs, you can stretch and shorten them, adjust their
radius, or move them in any direction. For detailed instructions, see the
following paragraphs.

RESTRICTION You can only move grid lines and arcs in 2D views.

Stretch, shorten, or rotate a grid line

1. In a 2D view, select the grid line that you want to modify. 

The end nodes and the center node of the grid line become visible.

2. Click one of the end nodes.

3. Click the location where you want to move the node. 

The node moves to its new position.

Move a grid line to a perpendicular direction

1. In a 2D view, select the grid line that you want to modify. 

The end nodes and the center node of the grid line become visible.

2. Click the center node.

3. Click the location where you want to move the node. 

The grid line moves to its new position.
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Stretch or shorten a grid arc

1. In a 2D view, select the grid arc that you want to modify. 

The end nodes of the arc perimeter and the center node of the arc visible.

2. Click one of the end nodes.

3. Click the location where you want to move the node. 

The arc stretches or shortens accordingly.

Adjust the radius of a grid arc

1. In a 2D view, select the grid arc that you want to modify. 

The end and center nodes of the arc perimeter and the center node of the
arc visible.

2. Click the center node of the arc perimeter.

3. Click the location where you want to move the node. 

The arc radius adjust accordingly.

Move a grid arc

1. In a 2D view, select the grid arc that you want to modify. 

The end nodes of the arc perimeter and the center node of the arc visible.

2. Click the center node of the arc.

3. Click the location where you want to move the node. 

The arc moves to its new location.

Create and manage construction lines
Construction lines serve the same purpose as architectural and construction
lines. The only difference is that they do not display a construction bubble. To
create construction lines, see the following instructions.

Create a single construction line

NOTE If you want to create a series of construction lines which form a
regular or irregular, rectangular or radial construction line system, the
Rectangular Wizard and Sector Wizard are the fastest options.

1. Ensure that the 2D view representing the construction level on which you
want to create your construction line is active.

2. Go to the Model tab.
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3. In the Construction Line list, select Construction Line.

4. Select the point where you want the construction line to start. 

TIP The tooltip views the mouse pointer's exact coordinates. If the
mouse pointer has not snapped to the required point, press F2 to
type the exact coordinates of the required point.

5. Select the point where you want the construction line to end. 

TIP The tooltip views either the absolute, relative, or polar coordinates
of the end point, depending on whether the ABS, REL, or POL
button is selected in the (page 67).

• To switch the display, click one of the other buttons.

NOTE The construction line does not extend to infinity. Do ensure that
the construction line is sufficiently long to meet your needs.

Tekla Structural Designer creates the construction line between the
selected points.

Create parallel construction lines
This option creates a construction line parallel to an existing one, but of a
different length. To use this option, you must have at least one existing
construction line in the current 2D view.

1. Go to the Model tab.

2. In the Construction Line list, select Parallel.

3. Select the construction line to which your new construction lines will be
parallel.

4. Move the mouse pointer to the distance where you want to place the
parallel construction line. 

TIP The tooltip views the distance of the dotted line from the initial
construction line you selected in step 3. Press F2 to type the exact
distance.

For more accuracy, you can zoom in.

5. Click to locate the new construction line.
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6. Click the points where you want the new construction line to start and
end. 

The construction line is now created.

7. Move the mouse pointer and place other construction lines with respect
to the line you selected in step 3, or press Esc to end construction
placement. 

TIP To create parallel construction lines of the same length as the

selected construction line, select the Parallel (quick)
command.

When you create quick parallel construction lines, you can press F2
to define the distance between successive pairs of construction
lines, separating the numbers with commas. If you have a number
of bays that are at the same centers, then you can specify these as a
single entry.

For example, you can specify bay centers of 18', 27' , 18' 6" , 18' 6" ,
18' 6" and 27" as 18' , 27' , 3x18' 6" , 27".

Create perpendicular construction lines
To use this option, you must have at least one existing grid or construction line
in the current 2D view.

1. Go to the Model tab.

2. In the Construction Line list, select Perpendicular.

3. Select the construction line to which your new construction line will be
perpendicular.

4. Move the new construction line to the desired position and click to locate
it. 

TIP The tooltip views the perpendicular distance of the dotted line from
the middle of the construction line you selected. Press F2 to type the
exact distance.

5. Click the points where you want the new construction line to start and
end.

6. Move the mouse pointer and place other construction lines with respect
to the line you selected in step 4, or press Esc to end construction
placement.
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Create a rectangular construction line system
1. Ensure that the 2D view representing the construction level on which you

want to create your rectangular construction line system is active.

2. On the Model tab, in the Construction Line list, select 
Rectangular Wizard. 

The Rectangular Grid Wizard opens.

3. Define the origin of the construction line system either by clicking it in the
2D view, or by entering its coordinates in the Rectangular Grid Wizard.

4. Click Next.

5. Select if you want to create construction lines in the X direction only, in
the Y direction only, or in both directions.

6. Select the style that you want to use for the construction lines.

7. Click Next.

8. On the following pages, define the layout of constructions for the bays in
the X and Y directions. 

NOTE You can define either a regular or an irregular construction
layout:

• For a regular construction, define the number of bays you
want to create and the bay centers.

• For an irregular construction, define the distance between
successive pairs of construction lines, separating the numbers
by commas. If you have a number of bays that are at the same
centers, you can specify them as a single entry (for example,
3x18'6").

9. Click Next.

10. Define the rotation of the construction either by moving the mouse over
the 2D view and clicking, or by typing values into the Rectangular Grid
Wizard. 

TIP In the Rectangular Grid Wizard, you can specify the rotation with
respect to either the construction line system's local x or local y
direction. This is helpful if you are creating a construction line
system that is not orthogonal.

11. Click Next.

12. Specify the angle between the axes with respect to either the X or Y axis
system.

13. Click Finish.

Create models 191 Create the model



Create a radial construction line system
1. Ensure that the 2D view representing the construction level on which you

want to create your radial construction line system is active.

2. On the Model tab, in the Construction Line list, select Radial
Grid Wizard. 

The Radial Grid Wizard opens.

3. Define the origin of the construction line system either by clicking it in the
2D view, or by entering its coordinates in the Radial Grid Wizard.

4. Click Next.

5. Select whether you want to create the radial lines only, the arcs only, or
both of these.

6. Select the style that you want to use for the construction lines.

7. Click Next.

8. Define the layout of the arcs that you will create. 

NOTE You can define either a regular or an irregular construction
layout:

• For a regular construction, define the number of bays you
want to create and the bay centers.

• For an irregular construction, define the distance between
successive pairs of construction lines, separating the numbers
by commas. If you have a number of bays that are at the same
centers, you can specify them as a single entry (for example,
3x10'6").

You can also select whether the arc construction lines are
represented as curves, or as a series of straight lines between the
points where the arc intersects the other construction lines
created as part of this process.

9. Click Next.

10. Define the layout of radial construction segments that you want to
achieve. 

Again, you can specify the reference of the first construction line, and how
you want to increment the reference to give the references of the other
radial lines that you create.

11. Click Next.
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12. Define the rotation of the construction either graphically by moving the
mouse over the 2D view and clicking, or by typing values into the
Rectangular Grid Wizard 

TIP In the Rectangular Grid Wizard, you can specify the rotation with
respect to either the construction line system's local x or local y
direction.

13. Click Finish.

Create construction arcs
1. Go to the Model tab.

2. In the Construction Line list, select Arc.

3. Select the point which lies at the center of the construction arc which you
want to create. 

The tooltip views the mouse pointer's exact coordinates.

4. Click the points where you want the construction arc to start and end.

5. Move the mouse pointer and place other construction arcs with respect to
the line you selected in step 3, or press Esc to end construction
placement.

Extend, move, or rotate construction lines and arcs
You can modify construction lines and arcs in different ways according to your
needs. You can stretch, shorten, or rotate construction lines, or move them in
a perpendicular direction. As for construction arcs, you can stretch and
shorten them, adjust their radius, or move them in any direction. For detailed
instructions, see the following paragraphs.

RESTRICTION You can only move construction lines and arcs in 2D views.

Stretch, shorten, or rotate a construction line

1. In a 2D view, select the construction line that you want to modify. 

The end nodes and the center node of the construction line become
visible.

2. Click one of the end nodes.

3. Click the location where you want to move the node. 

The node moves to its new position.
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Move a construction line to a perpendicular direction

1. In a 2D view, select the construction line that you want to modify. 

The end nodes and the center node of the construction line become
visible.

2. Click the center node.

3. Click the location where you want to move the node. 

The construction line moves to its new position.

Stretch or shorten a construction arc

1. In a 2D view, select the construction arc that you want to modify. 

The end nodes of the arc perimeter and the center node of the arc visible.

2. Click one of the end nodes.

3. Click the location where you want to move the node. 

The arc stretches or shortens accordingly.

Adjust the radius of a construction arc

1. In a 2D view, select the construction arc that you want to modify. 

The end and center nodes of the arc perimeter and the center node of the
arc visible.

2. Click the center node of the arc perimeter.

3. Click the location where you want to move the node. 

The arc radius adjust accordingly.

Move a construction arc

1. In a 2D view, select the construction arc that you want to modify. 

The end nodes of the arc perimeter and the center node of the arc visible.

2. Click the center node of the arc.

3. Click the location where you want to move the node. 

The arc moves to its new location.

Create frames and slopes
Frames and slopes are different 2D views of the model that can help you in
creating your model. To create a frame or a slope, see the following
instructions.
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Create a frame
A frame is a 2D View of the model, created in a vertical plane defined by an
existing grid line. Since only the members that lie within the plane of the frame
are displayed, a frame view can be particularly useful for defining bracing.

1. Obtain a 3D view of your model where you can see the base grid line
associated with the frame that you want to create.

2. On the Model tab, click Frame.

3. Position the mouse pointer over the grid line for the frame that you want
to create.

4. Click to create the frame. 

Tekla Structural Designer creates a frame view for the selected grid line.

TIP To open a frame view:

a. Click the + sign on the left side of Frames in the Structure
tree.

b. Double-click the name of the frame whose view you want to
open.

Create a slope
A slope is a 2D View of the model, created in a sloped plane. You can define a
slope by selecting 3 existing grid points. Since only those members that lie
within the plane of the slope are displayed, this type of view can be particularly
useful for defining inclined roofs and ramps.

NOTE Before creating a slope, note that:

• In order to create a slope, you need to be able to click three
existing (not co-linear) grid points that lie in the plane of the slope.

• Grid points are formed at grid line intersections on construction
levels. Therefore, if the points required to define the slope do not
currently exist, you may need to insert new construction levels and
grid lines to form them.

• A sloped plane must be entirely contained within a single sub
model because the sub model determines the mesh parameters to
be applied.

• In a sloped plane, positive Y is always aligned to the up-slope
direction, so that positive X is always perpendicular to the slope.

1. Obtain a 3D view of your model where you can see three grip points that
define the sloped plane. 
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TIP If you cannot see the grid line intersections on a particular
construction level in the 3D view:

a. In the Structure tree, select the level.

b. In the , select the Show grids in the 3D view option.

If you wish, you can clear the Show grids in the 3D view option
for other levels to simplify the display.

2. On the Model tab, click Sloped Plane.

3. Click the three points which define the sloped plane. 

Tekla Structural Designer creates sloped plane view.

TIP To open a slope view:

a. Click the + sign on the left side of Slopes in the Structure
tree.

b. Double-click the name of the slope whose view you want to
open.

Create dimensions
Dimensions allow you to show distances between the appropriate points in
your structure. The dimension lines are included on any drawings you create.
To create dimensions, see the following instructions.

Create a single dimension

1. On the Model tab, click Dimension.

2. Click the grid point at the start of the dimension.

3. Click the grid point at the end of the dimension. 

Tekla Structural Designer shows a line between the selected points.

4. Move the line to the point where you want the dimension line to lie. 

Choose a point that is easily visible and does not conflict with the rest of
your model's details.

5. Click to create the dimension.
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Create beams, columns and braces
These topics introduce you to the methods of creating beams columns and
braces (in any material).

We recommend you familiarize yourself with how to:

• Create beams (page 210)

• Create columns (page 197)

• Create braces (page 227)

Create columns
This section focuses on the operations required to create columns (in any
material).

• Specify the column type and section size (page 197)

• Create a single column or series of columns (page 200)

• Create inclined columns and cranked columns (page 202)

• Create gable posts or parapet posts (page 202)

• Align a column to a specific angle or an angled... (page 203)

• Modify the position of columns and column stacks (page 204)

The following topics are relevant to steel columns only:

• Setting out steel and cold formed columns (page 204)

• Create plated or compound section steel columns (page 206)

• Specify a column splice (page 207)

• Add a base plate to a steel column (page 207)

• Create web openings (page 223)

Concrete columns specifically have an automatic alignment facility:

• Specify concrete column alignment relative to the grid (page 208)

• Modify the column alignment or specify offsets (page 209)

See also

Column properties (page 956)

Specify the column type and section size
Before you can place a column you must first specify the column type and an
initial section size.

Specify the type of column

• On the Model tab, do one of the following:
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To Do this
Specify a steel column

1. Click the arrow under Steel Column.

2. In the list, select the Steel Column type.

Specify a plated or compound steel column

1. Click the arrow under Steel Column.

2. In the list, select the Plated column type.

Specify a concrete filled steel column

1. Click the arrow under Steel Column.

2. In the list, select the Concrete Filled
column type.

Specify a concrete encased steel column

1. Click the arrow under Steel Column.

2. In the list, select the Concrete Encased
column type.

3. In theProperties window, click Encasing
section.

4. Click the arrow on the right side of
Encasing section.

5. In the list that appears, select <New\Edit...>

6. Enter the size of encasing concrete section.

Specify a cast-in-place, or precast concrete
column

•

1. Click the arrow under Concrete
Column.

2. In the list that appears, select Concrete
Column for cast-in-place, or Precast.

Specify a timber column Click Timber Column.

Specify a cold formed column In the Cold Formed group, click Column.

Specify the size of steel, cold formed and timber columns

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.

3. In the list that appears, select <New\Edit...> 

The (page 166) opens.

4. Select the desired section size, and click Select. 

TIP To define a custom section, click Add...

5. Before proceeding to create the column, adjust the remaining properties
in the Properties window according to your needs.

Create models 198 Create the model



Specify the size of plated or compound steel columns

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.

3. In the list that appears, select <New\Edit...> 

The (page 166) opens.

4. In the (page 166), choose the required compound section type from the
left hand pane.

5. Select the desired section size, and click Select. 

TIP If the desired section is not listed, you can add it as follows:

a. Click Add...

b. Type the sections, plate dimensions, and gaps according to your
needs.

c. To add the section to the list, OK.

The section is automatically added to the materials database.
Therefore, you do not need to redefine it in other models.

d. Select the section in the Select Section dialog box.

6. Before proceeding to create the column, adjust the remaining properties
in the Properties window according to your needs.

Specify the size of cast-in-place, or precast concrete columns

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.

3. In the list that appears, select <New\Edit...> 

The Section dialog box opens.

4. Select the column shape.

5. Define the dimensions of the column. 

NOTE Only click Add if you want to create a hollow column.

Then, to define the void:

a. In the tabular part of the dialog, select the shape and
dimensions of the void.

b. Leave the minor and major offsets as 0.0 to position the void
centrally in the column, or adjust as necessary to create an
offset.
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6. Click OK

7. Before proceeding to create the column, adjust the remaining properties
in the Properties window according to your needs.

Create a single column or series of columns
With Tekla Structural Designer, you can create various kinds of column. You
can model columns in 2D views, frame views, and structure views.

Create columns in a level view

1. Ensure that you have defined the construction levels between which the
column will run and the grid points between which it will lie.

2. Select the column type and size (page 197).

3. In the Properties window , adjust the base level and top level of the
column, and other column properties, if necessary.

4. Do one of the following:

To Do this
Create a single column a. Click the point where you want to place the

column.

b. Press Esc to finish creating columns.

Create a series of columns a. Move the mouse pointer to one corner of
an imaginary box that will encompass the
grid intersection points where you want to
create columns.

b. Hold down the left mouse button.

c. Drag the mouse pointer to the
diametrically opposite corner of the box.

d. Release the mouse button.

Create a single column in a frame or structure view

NOTE In order to define a column in a frame view or a structure view, you
must have already created the construction levels between which the
column will run, and the grid points between which it will lie.

1. Select the column type and size (page 197).

2. Click the start point of the column.

3. Click the end point of the column. 

Tekla Structural Designer creates the column between the selected points.

Create plated or compound section steel columns

1. On the Model tab, click the arrow under Steel Column.
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2. In the list that appears, select Plated.

3. In the Properties window, click the arrow next to the Section property.

4. In the list that appears, select <New\Edit...> 

The Select Section dialog box opens.

5. Select the desired section type and section size. 

TIP If the desired section is not listed, you can add it as follows:

a. Click Add...

b. Type the sections, plate dimensions, and gaps according to your
needs.

c. To add the section to the list, OK.

The section is automatically added to the materials database.
Therefore, you do not need to redefine it in other models.

d. Select the section in the Select Section dialog box.

6. In the Properties window, adjust the remaining properties according to
your needs.

7. To proceed, see Create columns in a 2D view and Create a single
column in a frame view or a structure view. 

TIP In order to apply a plated or compound section an existing steel
column, do the following:

a. In the Properties window, set Fabrication to Plated.

b. Click the arrow next to the Section property.

c. In the list, either select a compound section that has already
been applied in the model, or select <New\Edit...> to add a new
one.

Create concrete filled or encased concrete columns

1. On the Model tab, click the arrow under Steel Column.

2. In the list that appears, select either Concrete Filled or Concrete
Encased. 

The column adopts the properties that are currently displayed in the
Properties window for creating steel columns.

3. In the Properties window, adjust the properties as necessary.
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4. To proceed, see Create columns in a 2D view and Create a single
column in a frame view or a structure view. 

NOTE You can now modify the Section property and specify a different
section size above the space position.

See also

Create gable posts or parapet posts (page 202)

Create inclined columns and cranked columns
Tekla Structural Designer allows you to create inclined and cranked steel and
concrete columns.

Create an inclined column
An inclined column is any column that is not truly vertical. In order to define an
inclined column, you must have defined the construction levels between which
the column will run, and the grid points between which it will lie.

NOTE An inclined column can only be created in a frame view or a structure
view.

1. Select the column type and size. (page 197)

2. In a frame or structure view, Click the start point of the column.

3. Click the end point of the column. 

Tekla Structural Designer creates the column between the selected points.

Create a cranked column

In order to define a cranked column, you must have created the construction
levels between which the column will run and the grid points between which it
will lie.

NOTE An inclined column can only be created in a frame view or a structure
view.

1. Select the column type and size. (page 197)

2. Click the start point of the column.

3. Hold down the Ctrl key and click the next node of the column.

4. Repeat step 3 until you have selected the second to last node of the
column.

5. Release the Ctrl key and click the end point of the column. 

Tekla Structural Designer creates the column.
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Create gable posts or parapet posts
Steel parapet posts are single span members with fixed end connections.
Their specific purpose is to act as a means to transfer load from wind wall
panels into columns: the decomposed load from the panel is applied as a
point load, and the moment at the node connects the parapet post to the
column. To create parapet or gable posts posts in Tekla Structural Designer,
see the following instructions.

NOTE Parapet posts are not designed in Tekla Structural Designer.

1. On the Model tab, click any element type (for example, Steel
Column).

2. In the Properties window, set the Characteristic to Gable post or
Parapet post. 

The properties in the Properties window are updated to a type that is
appropriate for the chosen post.

3. In the Properties window, adjust the properties according to your needs. 

NOTE For gable posts:

• If an axial load release is required at the top, consider carefully
which wind load deflection parameters are required.

4. Click the start point of the post. 

NOTE If you are using a point along a member, do the following:

a. Click the member to see its points.

b. Either click the point that you want to use, or type the
distance to the point from the start of the member.

5. Click the end point of the post. 

Tekla Structural Designer creates the post.

Align a column to a specific angle or an angled grid line
You can align a column to a specific angle or a grid line before creating the
column. Once created an existing column can be realigned by editing the angle
in the Properties window.

1. Do one of the following:

• To create a new column, on the Model tab, select the desired column
type.

• To align an existing column to a specific angle, in the model, click the
desired column.
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2. In the Properties window, click the Rotation property.

3. In the list, select one of the following options: 

• The 0°, 90°, 180°, and -90° options align the column to the global axes.

• The Angle option aligns the column to the exact rotation angle you
specify.

• The Define option aligns the column to the angle of any grid line you
select. (Applies to new columns only).

Related information

Related video

Align columns to grids

Modify the position of columns and column stacks
You may sometimes need to modify the position of columns and column
stacks in your model. To do so, see the following instructions.

Move a column

See: Move objects (page 322).

Modify the position of a single column stack
You can change the position of a column stack in either a frame view or a
structure view.

1. In (page 55), ensure that the Grid & Construction Lines options is
selected.

2. Select the column stack that you want to move.

3. Click one end node for the column stack to be moved. 

Ensure the node is highlighted in the Select Entity tooltip when selecting.

4. Click a grid or construction point where you want to move the selected
end node. 

The entire column is redrawn, with the selected node moved to the new
position.

5. Select the next end node.

6. Click a grid or construction point where you want to move the selected
end node. 

The column is redrawn once more, with the selected node moved to the
new position.

Setting out steel and cold formed columns
With Tekla Structural Designer, you can create various different types of steel
and cold formed columns, including series of columns, inclined and cranked
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columns, gable or parapet posts, and plated, concrete filled or concrete
encased columns. In addition, Tekla Structural Designer allows you to specify a
column splice, align a column to a specific angle, or modify the position of
existing columns.

Steel column alignment

You can create a single steel column over several story heights. These kind of
columns are referred to as column stacks. The columns can start and finish at
any level. Different column sections can be defined in each stack, provided
that a splice is defined at the change point.

Each steel column stack is placed on an insertion line between points, but its
geometry is drawn to reflect the major and minor snap points and any offsets
specified in the column properties.

Major offset:

Minor offset:
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NOTE Steel column alignment snap points and offsets have no effect on the
positioning of 1D solver elements in the solver models. The solver
elements are always inserted along the steel column insertion lines.

This is different to the approach adopted for concrete column solver
elements, in which the alignment snap points and offsets are
structurally significant.

Create plated or compound section steel columns
Along with many other types of steel columns, Tekla Structural Designer allows
you to create plated or compound section steel columns in your models.

Create plated or compound section columns

1. On the Model tab, click the arrow under Steel Column.

2. In the list that appears, select Plated.

3. Click the arrow on the right side of the Section property.

4. In the list that appears, select <New\Edit...>. 

The Select Section dialog box opens.

5. Select the section type and size. 

TIP If the desired section is not listed, you can add it as follows:

a. Click Add...

b. Type the sections, plate dimensions, and gaps according to your
needs.

c. To add the section to the list, OK.

The section is automatically added to the materials database.
Therefore, you do not need to redefine it in other models.

d. Select the section in the Select Section dialog box.

6. In the Properties window, adjust the remaining properties according to
your needs.

7. Click the start point of the column.

8. Click the end point of the column. 

Tekla Structural Designer creates the column.

9. Do one of the following:

• To create more similar column, click the start point of the new column.

• To stop creating columns, press Esc.
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Apply a plated or compound section to an existing steel column

1. In the Properties window, go to Fabrication.

2. Set Fabrication to Plated.

3. Go to Section and do one of the following:

• Select an existing compound section.

• Click <New\Edit...> to select a new section.

See also

Add, modify and delete user-defined sections (page 890)

Specify a column splice
You can add splices at the base of each column stack (except for stack 1) as
required. The splice offset is used to locate each splice at a practical distance
above the floor level.

1. Select the desired columns. 

The properties of the columns are displayed in the Properties window.

2. Expand the properties of the column stack within which you want to
create the splice.

3. Under Release, select the Splice option.

4. If necessary, modify the splice offset. 

NOTE The Section property is now editable, so that you can specify a
different section size above the splice position, if necessary.

See also

Specify the column type and section size (page 197)

Add a base plate to a steel column

While base plates are automatically added to steel columns when they are
created, you might also be required to manually add a base plate to an
existing column in some situations (for example if the old base plate has been
deleted, or a supporting member has been removed, or the column material
has been changed).

To add a base plate:

1. On the Design toolbar, click  Base Plate.

2. In the Properties window:
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a. Leave Autosize selected, or unselect it to manually define the plate
size.

b. Edit the bolt properties as required.

c. Edit the anchor plate properties as required.

d. Edit the weld properties as required.

e. Edit the concrete base properties as required.

3. Click on a steel column, or drag a box around multiple steel columns to
apply. The base plate is applied to all steel columns in the selection that
didn't previously have a base plate attached.

See also

Create a single column or series of columns (page 200)

Specify concrete column alignment relative to the grid
The initial placement of each column relative to the grid depends on whether
the Automatic alignment option is selected in the concrete column
properties.

If Automatic alignment is selected:

Tekla Structural Designer aligns the columns on the perimeter of the grid with
their faces flush to the perimeter, and the internal columns centrally on the
grid.

If Automatic alignment is not selected:

Tekla Structural Designer aligns the columns according to the Major
alignment and Minor alignment options in the concrete column properties.
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• To switch the alignment option, in the Properties window, select or clear
Automatic alignment.

See also

Align a column to a specific angle or an angled grid line (page 203)

Modify concrete column alignment or specify offsets (page 209)

Modify concrete column alignment or specify offsets
Once you have created columns, you can adjust their alignments and specify
their offsets, if necessary. You can adjust the alignment of a single column in
the Properties window or the Properties dialog box, whereas multiple
columns can only be realigned in the Properties window.

The following example illustrates editing the alignment in the Properties
window.

1. Select the columns that you want to offset.

2. Ensure that the column properties are viewed in the Properties window. 
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3. Modify the Major offset and Minor offset values according to your
needs. 

Tekla Structural Designer moves the columns relative to the major and
minor snap levels by the value that you specified.

See also

Specify concrete column alignment relative to the grid (page 208)

Create beams
This section focuses on the operations required to create beams (in any
material).

• Specify the beam type and section size (page 211)
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• Create single-span beams (page 213)

• Create continuous beams (page 214)

• Create curved beams (page 215)

• Modify the position of beams (page 216)

The following topics are relevant to steel beams only:

• Setting out steel and cold formed beams (page 216)

• Create plated or compound section steel beams (page 218)

• Create Westok cellular, Westok plated or FABSEC® beams (page 219)

• DELTABEAM® (page 220)

• Create web openings (page 223)

• Add haunches to steel beams (page 226)

See also

Beam properties (page 938)

Member global offsets (page 231)

Specify the beam type and section size
Before you can place a beam you must first specify the beam type and an
initial section size.

Specify the type of beam

• On the Model tab, do one of the following:

To Do this
Specify a steel beam

1. Click the arrow under Steel Beam.

2. In the list that appears, select the desired
beam type.

Specify a plated, Westok, FABSEC®, or
DELTABEAM®

1. Click the arrow under Steel Beam.

2. In the list, select the required beam type.

Specify a cast-in-place, or precast concrete beam

1. Click the arrow under Concrete
Beam.

2. In the list that appears, select Beam for
cast-in-place, or Precast.

Specify a timber beam Click Timber Beam.

Specify a cold formed beam In the Cold Formed group, click Beam.
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Specify the size of steel, cold formed and timber beams

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.

3. In the list that appears, select <New\Edit...> 

The (page 166) opens.

4. Select the desired section size, and click Select. 

TIP To define a custom section, click Add...

5. Before proceeding to create the beam, adjust the remaining properties in
the Properties window according to your needs.

Specify the size of plated or compound steel beams

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.

3. In the list that appears, select <New\Edit...> 

The (page 166) opens.

4. In the (page 166), choose the required compound section type from the
left hand pane.

5. Select the desired section size, and click Select. 

TIP If the desired section is not listed, you can add it as follows:

a. Click Add...

b. Type the sections, plate dimensions, and gaps according to your
needs.

c. To add the section to the list, OK.

The section is automatically added to the materials database.
Therefore, you do not need to redefine it in other models.

d. Select the section in the Select Section dialog box.

6. Before proceeding to create the beam, adjust the remaining properties in
the Properties window according to your needs.

Specify the size of cast-in-place, or precast concrete beams

1. In the Properties window, click Section.

2. Click the arrow on the right side of Section.
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3. In the list that appears, select <New\Edit...> 

The Section dialog box opens.

4. Select the beam shape.

5. Define the dimensions of the beam.

6. Click OK

7. Before proceeding to create the beam, adjust the remaining properties in
the Properties window according to your needs.

Create single-span beams
Tekla Structural Designer allows you to create concrete, steel, and timber
single-span beams. For detailed instructions, see the following paragraphs.

Create a single-span beam

1. Specify the beam type and section size (page 211)

2. In the Properties window, adjust the beam properties according to your
needs.

3. Click the start point of the beam. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

4. Click the end point of the beam. 

NOTE If Tekla Structural Designer prompts you to pick another point,
and you do not want to create a continuous beam, do one of the
following:

• Click again the end point again.

• Press Enter.

Create a series of single-span beams

RESTRICTION In order to a series of single-span beams using this method,
the floor or construction level must already contain the
columns between which the beams will run. You must also
use a 2D view of the floor or construction level.

1. Select the beam type and size (page 211)

2. In the Properties window, adjust the beam properties according to your
needs.
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3. Move the mouse pointer to one corner of an imaginary box that will
encompass the columns between which you want to create beams.

4. Hold down the left mouse button.

5. Drag the mouse pointer to the diametrically opposite corner of the box. 

Ensure that the box encompasses all of the columns between which you
want to create beams.

6. Release the mouse button. 

Tekla Structural Designer creates the beams between each adjacent pair
of columns within the area you selected.

See also

Create continuous beams (page 214)

Create curved beams (page 215)

Create continuous beams
You can create continuous beams in your model by selecting the Continuous
option before creating the beam. For more information, see the following
instructions.

RESTRICTION You cannot create continuous beams that are curved either
horizontally or vertically.

1. Specify the beam type and section size (page 211) 

You can create steel, concrete, timber, or cold rolled beams.

2. In the Properties window, ensure that the Continuous option is selected.

3. In the Properties window, adjust the remaining properties according to
your needs.

4. Click the start point of the beam. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

5. Click the next node of the beam.

6. Repeat step 5 until you have clicked the second to last node of the beam.

7. Click the end point of the beam. 

Tekla Structural Designer prompts you to pick another point.

8. To create the beam, do one of the following:
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• Click the end point again.

• Press Enter.

Tekla Structural Designer creates the continuous beam.

See also

Create single span beams (page 213)

Create curved beams (page 215)

Create curved beams
Tekla Structural Designer allows you to create curved steel, concrete, and cold
formed beams in your models, if necessary. To model curved beams, see the
following instructions.

1. Select the beam type and size. (page 211)

2. In the Properties window, ensure that Linearity is set to one of the
following:

• Curved major, if you want the beam to curve vertically.

• Curved minor, if you want the beam to curve horizontally.

TIP You can control the direction in which horizontally curved beams
curve.

When you place the beam, you select its start point and its end
point. The curve of the beam always lies on the left side of the line
from the start point to the end point of the beam.

3. Still in the Properties window, specify an appropriate chord height value
to define the curve. 

TIP You can reverse the curve direction of a vertically curved beam by
using a negative chord height value.

NOTE Horizontally curved beams always use the chord height defined in
the property set. Therefore, they do not curve automatically to fit
on any curved grid line that you may have defined.

4. In the Properties window, adjust the remaining properties according to
your needs.

5. Click the start point of the beam. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.
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b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

6. Click the end point of the beam. 

Tekla Structural Designer creates the beam.

NOTE If you are using a 2D view when defining beams that curve
vertically, you cannot see the beam on the graphical display.

Change to a 3D view to see the beams.

See also

Create single span beams (page 213)

Create continuous beams (page 214)

Modify the position of beams
If necessary, you can modify the position of an individual beam in your model
by moving one of its end nodes. You can modify the position of a beam in both
2D and 3D views.

To move an entire beam, see: Move objects (page 322).

1. Select the desired beam.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click the grid or construction point where you want to move the end
node. 

Tekla Structural Designer moves the end node to the selected point.

Setting out steel and cold formed beams
You can define steel beams as single span, or continuous over multiple spans.
Even if you create a continuous beam, you can still define different beam
sections in each span, if necessary.

Each steel beam span is placed on an insertion line between points, but its
geometry is drawn to reflect:

• the major and minor snap points and any offsets specified in the beam
properties

Major snap and offset:
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Minor snap and offset:
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• the level type specified in the Construction Levels dialog box dialog:

• When the type is set to T.O.S. (top of steel), each beam is displayed
according to the alignment snap points and offsets specified.

• When the level type is set to S.S.L. (structural slab level), each beam is
also lowered by the slab thickness specified in the Construction Levels
dialog box.

NOTE Steel beam alignment snap points and offsets and the construction
level type have no effect on the positioning of 1D solver elements in
solver models. This is a different approach to that adopted for
concrete beam solver elements.

Create plated or compound section steel beams
Along with many other types of steel beams, Tekla Structural Designer allows
you to create plated or compound section steel beams in your models.

Create plated or compound section beams

1. On the Model tab, click the arrow under Steel Beam.

2. In the list that appears, select Plated.

3. Click the arrow on the right side of the Section property.

4. In the list that appears, select <New\Edit...>. 

The Select Section dialog box opens.

5. Select the section type and size. 

TIP If the desired section is not listed, you can add it as follows:

a. Click Add...

b. Type the sections, plate dimensions, and gaps according to your
needs.
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c. To add the section to the list, OK.

The section is automatically added to the materials database.
Therefore, you do not need to redefine it in other models.

d. Select the section in the Select Section dialog box.

6. In the Properties window, adjust the remaining properties according to
your needs.

7. Click the start point of the beam.

8. Click the end point of the beam. 

Tekla Structural Designer creates the beam.

9. Do one of the following:

• To create more similar beams, click the start point of the new beam.

• To stop creating beams, press Esc.

Apply a plated or compound section to an existing steel beam

1. In the Properties window, go to Fabrication.

2. Set Fabrication to Plated.

3. Go to Section and do one of the following:

• Select an existing compound section.

• Click <New\Edit...> to select a new section.

See also

Add, modify and delete user-defined sections (page 890)

Create Westok cellular, Westok plated or FABSEC® beams
Tekla Structural Designer also allows you to create Westok Cellular, Westok
Plated or FABSEC® beams, if that is necessary in your model. For more
information, see the following instructions.

1. On the Model tab, click the arrow next to Steel Beam.

2. In the list, select the desired beam type. 

The beam adopts the properties that are currently displayed in the
Properties window.

3. In the Properties window adjust the properties according to your needs.

4. Click the start point of the beam. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.
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b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

5. Click the end point of the beam. 

TIP If Tekla Structural Designer prompts you to pick another point, do
one of the following:

• Click the end point again.

• Press Esc.

Tekla Structural Designer creates the beam.

See also

Create single span beams (page 213)

Create plated or compound section steel beams (page 218)

Create continuous beams (page 214)

Create curved beams (page 215)

DELTABEAM®

DELTABEAM® is a proprietary slim floor system. While DELTABEAM® sections
can be analysed in Tekla Structural Designer they are not designed.

NOTE DELTABEAMS® are manufactured by Peikko in Finland: www.peikko.com.

The Peikko Designer download, (English language version) is available from:

https://www.peikko.com/design-tools/

Workflow in Tekla Structural Designer

• Initial DELTABEAM® section sizes are selected from the database and
applied in the model. Peikko Designer can be used if required to better
determine suitable initial sizes.

• The model is analysed, and a member forces report is created. This report
is then sent to Peiko.

• Peiko provide the detailed design and final analysis properties.

• The Tekla Structural Designer model is updated as required.

• If the properties have been revised, the self weight could be affected and
the model should be reanalysed.

• A further iteration may or may not be required.
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Create DELTABEAMS®

1. On the Model tab, click the arrow next to Steel Beam.

2. In the list, select DELTABEAM® 

The beam will adopt the properties displayed in the Properties window.

3. In the Properties window select the section required. 

NOTE D Series internal beams and DR Series edge beams can be
selected provided the database country is set to Finland, Norway,
Sweden, or Europe. You can add user defined sections to the
database for the same countries if required.

4. Select the construction as either composite, or non-composite, as
required.

5. Adjust the remaining properties according to your needs.

6. Click the start point of the beam. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

7. Click the end point of the beam. 

TIP If Tekla Structural Designer prompts you to pick another point, do
one of the following:

• Click the end point again.

• Press Esc.

Tekla Structural Designer creates the beam.

NOTE If you are placing a DR series edge beam, the flange will be drawn
to the left of the line from start point to end point (easily verified
in a 3D scene view). Once the beam has been placed, if you want
to switch it to the other side simply select Reverse on the Edit tab
and then click on the beam.

See also:

• Create single-span beams (page 213)

• Create continuous beams (page 214)
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Create a member forces report

If you haven't already got a suitable report style configured you will need to
create one as follows:

1. On the Report tab, click Model Report... 

The Report Contents dialog box opens.

2. To add a report, click Add and type a name for the report in the Active
Style field.

3. To add the member forces chapter to the report, expand the Analysis
headung in 'Chapters and Options' and drag the Member Forces chapter
to the Report Structure pane on the right.

4. Review the report structure and modify it (page 831) according to your
needs.

5. To limit the output to selected levels, frames, planes, or sub structures,
apply a model filter (page 832). 

TIP You can further limit the output of Loadcases and Combinations
sub chapters by applying a loading filter (page 832).

6. Click OK.

7. Click Show Report to review the report and check that it is displaying the
required level of data.

Once the report is configured to your needs, it can then be exported to Excel,
PDF, Word, or Tedds.

See also:

• Create general arrangement drawings (page 855)

Add DELTABEAM® properties to the database

Having submitted your member forces report to Peiko, you might be provided
with a new set of analysis properties that are not in the Tekla Structural
Designer database. In this situation you would need to add them as follows:

1. On the Home ribbon, click Materials. 

The Materials dialog box opens.

2. Go to Sections, and click Manage Sections. 

The Sections dialog box opens.

3. In the country list, select the database country.

4. In the Page pane on the left, select the appropriate DELTABEAM Series.

5. Click Add...

6. Enter values for each of the requested variables as supplied by Peiko.
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7. Click OK.

The new section size is now displayed in the Item pane.

Related video

Easy modeling of Peikko Deltabeams

Create web openings in steel members

You can add square, rectangular, and circular web openings to beams and
columns either by specified them manually, or by using a Quick layout
option. FABSEC® beams can also have elongated openings specified.

RESTRICTION 1. Although web openings can be added to steel beams and
columns, they are only considered in the design of:

• Non-composite beams designed to US codes, BS
codes, or Eurocodes

• Composite beams designed to US codes, BS codes, or
Eurocodes

2. Web openings are only valid in check design. If the auto
design flag is switched on the openings will be removed.

Web opening creation methods

You add web openings via the Web openings page of the Properties dialog
box.

The Quick layout method adds web openings to meet the geometric and
proximity recommendations published by the SCI. With this method, Tekla
Structural Designer creates web openings at the maximum depth and spaced
at the minimum centers recommended for the section size.

With the Quick layout option cleared you can also define web openings
manually using one of the following two methods:

• Clicking the Add button adds a new line to the web openings grid and
allows you to define the geometric properties of the opening.

• Clicking the Add... button opens the Web opening dialog box where you
can get more help and guidance when defining the opening.

Both manual methods use  and  signs to indicate faulty data when
defining the opening parameters.

For more assistance, hover the mouse pointer over a  or  sign.
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The Web opening dialog box

In the Web opening dialog box, you can use the following buttons to
automatically define the position of the web opening:

• The Center button positions the opening on the center of the member.

• The Auto button positions the opening to meet the spacing
recommendations by the SCI.

As web openings are defined, they are immediately visible in the diagram in
the Web opening dialog box.

Tekla Structural Designer also performs design checks when you are defining
web openings in the Web opening dialog box. The checked areas are end
posts, web posts, web opening dimensions and tee dimensions.

The  and  signs in the Web opening dialog box help you to decide
whether to make any adjustments to the opening parameters before Tekla
Structural Designer checks the design.

NOTE The design checks carried out at the current stage are geometric
checks only. Compliance with recommended limits is no guarantee
that the opening will pass the subsequent engineering design checks.

Add web openings using the Quick layout option

Using the Quick layout method allows you to create maximum depth
openings spaced at the minimum centers, appropriate to the section size.

1. Click the member to which you want to add web openings.

2. In the Properties window, ensure that the Autodesign option is cleared.

3. Right-click the member, and in the context menu, select Edit [element
name]. 

The Properties dialog box opens.

4. Go to Web openings.

5. Select the Quick layout option.

6. In the Label openings from list, select where you want to start the setting
out from.

7. In the Type column, select the web opening type. 

Data for the first web opening is automatically created as follows:

• IO: the length of the opening (applies to rectangular openings only)

• dO: the depth of the opening

• LCR: the distance from the setting out point to the center of the
opening
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• LC: the distance from the end 1 on the member to the center of the
opening

• dC: the distance from the top of the member to the center of the
opening

• LCR relative to: indicates the setting out point from which LCR is
measured.

• Nr. rel. to: specifies an existing opening number that you want to use
as the setting out point for the new opening.

Nr. rel. to only applies if you selected one of the Opening -> options
in the LCR relative to column.

8. If necessary, in the Stiffening column, select the location of stiffening.

a. Type the details of the stiffeners manually as follows: 

• dS: depth of the stiffener

• tS: thickness of the stiffener

• LS: length of the stiffener

• eS: the distance from the edge of the opening to the center of the
stiffener

9. To create further openings from the selected setting out points, click Add
and select the opening type. 

TIP You can use the Label openings from list to switch to a new setting
out point for the next opening at any point.

10. When you have created the desired openings, click OK.

Add web openings manually

1. Click the member to which you want to add web openings.

2. In the Properties window, ensure that the Autodesign option is cleared.

3. Right-click the member, and in the context menu, select Edit [element
name]. 

The Properties dialog box opens.

4. Go to Web openings.

5. Ensure that the Quick layout option is not selected.

6. In the Label openings from list, select where you want to start the setting
out from.

7. Click Add...

8. In the Type column, select the web opening type.
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9. Specify the following details for the opening: 

• IO: the length of the opening (applies to rectangular openings only)

• dO: the depth of the opening

• LCR: the distance from the setting out point to the center of the
opening

• LC: the distance from the end 1 on the member to the center of the
opening

• dC: the distance from the top of the member to the center of the
opening

TIP Click Center for dC to be automatically calculated to position the
opening centrally in the section depth.

• LCR relative to: indicates the setting out point from which LCR is
measured.

• Nr. rel. to: specifies an existing opening number that you want to use
as the setting out point for the new opening.

Nr. rel. to only applies if you selected one of the Opening -> options
in the LCR relative to column.

10. If necessary, in the Stiffening column, select the location of stiffening.

a. Type the details of the stiffeners manually as follows: 

• dS: depth of the stiffener

• tS: thickness of the stiffener

• LS: length of the stiffener

• eS: the distance from the edge of the opening to the center of the
stiffener

11. To create the opening, click OK.

12. To create further openings, do one of the following:

• To create multiple copies of a selected opening, click Copy...

• To create a single opening of a different size or spacing, click Add...

Add haunches to steel beams

1. Right-click the steel beam to which you want to add a haunch, and in the
context menu, select Edit [element name]. 

The Properties dialog box opens.

2. Go to Haunches.

3. Select the appropriate Create option for the required haunch location.
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4. In the Haunch dialog, define the haunch parameters as required. 

The haunch depth is measured from the beam centerline and length is
measured horizontally from the sharp end of the haunch to the beam
insertion point. In the case of an inclined beam the haunch length and
depth would therefore be measured as shown below.

5. When you have defined the haunch parameters, click OK.

See also

Create single span beams (page 213)

Create braces
Tekla Structural Designer allows you to create single braces, or pairs of braces
(in an X, K, V, or A configuration).

Braces are single span members with pinned end connections that are only
able to resist axial compression and tension. Their purpose is to provide
lateral stability to your structure.

TIP You can specify rigid frames to achieve the same effect as by using
braces. If necessary, you can use both rigid frames and braces within a
single structure.

Element loads cannot be applied directly to a brace itself and moments due to
self weight loading are ignored.

NOTE Although it is possible to model A or V brace configurations using individual
brace members instead of a brace pair, Tekla Structural Designer is then not
able to calculate the notional loads or EHFs (Equivalent Horizontal Forces)
correctly. In this case, elements of the vertical loads that are supported by the
bracing system are lost, and are not included in the notional load or EHF
calculations.
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Setting out braces
Each steel brace is placed on an insertion line between points, with its
geometry being drawn to reflect the major and minor snap points and any
offsets specified in the brace properties.

NOTE The alignment snap points and offsets have no effect on the
positioning of the solver elements created in the solver models, as
these will be created directly between the insertion points.

1. Do one of the following:

To Do this
Create a steel brace a. On the Model tab, click the arrow under

Steel Brace.

b. In the list, select the desired brace type.

Create a cold formed brace

a. On the Model tab, click Cold
Formed.

b. In the list, select Brace.

c. Select the desired brace type.

Create a timber brace a. On the Model tab, click the arrow on the

right side of Timber Brace.

b. In the list, select the desired brace type.

2. In the Properties window, go to the Section property.

3. Click the arrow on the right side of Section.

4. In the list that appears, click <New\Edit...>. 

The Select Section dialog box opens.

5. Select the desired section, and click Select.

6. In the Properties window, adjust the remaining properties according to
your needs.

Specify the brace type and section size
Before creating a brace, you need to specify its type and section size. For more
information, see the following instructions.

1. Do one of the following:

To Do this
Create a steel brace a. On the Model tab, click the arrow under

Steel Brace.

b. In the list, select the desired brace type.
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Create a cold formed brace

a. On the Model tab, click Cold
Formed.

b. In the list, select Brace.

c. Select the desired brace type.

Create a timber brace a. On the Model tab, click the arrow on the

right side of Timber Brace.

b. In the list, select the desired brace type.

2. In the Properties window, go to the Section property.

3. Click the arrow on the right side of Section.

4. In the list that appears, click <New\Edit...>. 

The Select Section dialog box opens.

5. Select the desired section, and click Select.

6. In the Properties window, adjust the remaining properties according to
your needs.

Create a single brace

NOTE A and V Braces should be modeled using special tools. Although you
can model the exact same A or V brace arrangement using individual
brace members, Tekla Structural Designer cannot calculate the
notional loads or EHFs (Equivalent Horizontal Forces) of the braces
correctly. In this case, elements of the vertical loads that are
supported by the bracing system are lost, and are not included in the
notional load or EHF calculations.

1. Select the brace type and size.

2. Click the start point of the brace. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

3. Click the end point of the brace. 

Tekla Structural Designer creates the brace.

Create an X, K, V or A brace

1. Do one of the following:
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To Do this
Create a steel brace • On the Model tab, click the arrow under

Steel Brace.

Create a cold formed brace

a. On the Model tab, click Cold
Formed.

b. In the list, select Brace.

Create a timber brace • On the Model tab, click the arrow on the

right side of Timber Brace.

2. In the list, select the desired brace pattern. 

The braces adopt the properties that are currently displayed in the
Properties window.

3. In the Properties window, adjust the properties according to your needs.

4. Click to identify a bottom corner of the bay that you want to brace.

5. Click to identify the opposite bottom corner of the bay.

6. Click to identify a top corner of the bay.

7. Click to identify the opposite top corner of the bay. 

Tekla Structural Designer creates the brace pattern within the selected
area.

Specify a brace as tension only or compression only
You can move the end nodes of individual steel, concrete, cold formed, or
timber braces in both 2D and 3D views. For more information, see the
following instructions.

Once a brace has been created, you can specify it as Tension only or
Compression only in the Properties window.

NOTE Tension only and Compression only members are non-linear elements
and therefore require non-linear analysis. If linear analysis is
performed, they will be treated as linear elements.

1. Select the brace.

2. In the Properties window select either Compression only, or Tension
only as required.
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Modify the position of a brace
You can move the end nodes of individual steel, concrete, cold formed, or
timber braces in both 2D and 3D views. For more information, see the
following instructions.

To move an entire brace, see: Move objects (page 322).

1. Select the brace.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click a grid or construction point where you want to move the end node. 

Tekla Structural Designer redraws the brace, moving the end node to the
selected point.

See also

Brace properties (page 951)

Member global offsets (page 231)

Member global offsets
In certain situations you may have a requirement to model different global
(X,Y,Z) physical offsets at each end of a member.

In Tekla Structural Designer global offsets can be applied to steel, cold formed,
cold rolled and timber member types, but with the following exceptions:

• columns (all materials),

• concrete beams

• analysis elements

• members with haunches

• curved members

NOTE Global offsets have no affect on the positioning of the 1D solver elements in
the solver models; they have no impact on loading, analysis or design. Global
offsets only affect the graphics and BIM integration.

Global offsets are applied to the member ends before any major/minor local
offsets, the local offsets thus being applied to the whole length of the member
in relation to the new line.

NOTE Global offsets are included in the BIM import/export to/from Tekla Structures
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Global offset combined with major offset example

A horizontal brace member is specified with a Global End 2 offset of -200mm
and a major (local) offset of -500mm, so that its alignment properties are as
follows:

While the offsets do not affect the insertion line (denoting the 1D solver
element in the analysis model), the brace itself is offset in the graphics as
shown below:
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Global offset only example

A diagonal brace member is specified with a Global End 1 offsets of 200mm in
Z and 400mm in Y, the Major and Minor (local) offsets are both 0mm, so that
its alignment properties are as follows:

While the offsets do not affect the insertion line (denoting the 1D solver
element in the analysis model), the brace itself is offset in the graphics as
shown below:
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Global offsets

Create walls, cores and bearing walls
These topics introduce you to the methods of creating walls, cores, and
bearing walls.

We recommend you familiarize yourself with how to:

• Create concrete walls (page 235)

• Create concrete cores (page 245) (from existing concrete walls, columns
and beams)

• Create bearing walls (page 248)

• Create shear only walls (page 252)

• Create general walls (page 254)
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Create concrete walls
This section focuses on the operations required to create concrete walls.

• Overview of the concrete wall model (page 235)

• Create concrete walls (page 237)

• Specify extensions and releases (page 239)

• Create concrete cores (page 245)

• Create and modify wall supports (page 240)

• Create door or window openings (page 241)

Overview of the concrete wall model
Tekla Structural Designer allows you to create both meshed and mid-pier
concrete walls.

Geometric rules for meshed concrete walls

• Meshed walls are defined as quadrilaterals in a single plane that can be
vertical or sloping, (unlike mid-pier concrete walls which must be
rectangular in a vertical plane).

• Openings (page 241) are permitted in meshed walls.

• The alignment and offsets in the wall properties are not structurally
significant as they have no affect on the solver elements that are formed in
the solver model.

• By default, meshed walls use the mesh parameters that are defined in
Structure Properties. However, you can override these for an individual
wall by checking Override model's in the Meshing section of the wall's
properties. You are then able to apply a user-defined mesh to the wall.

• Concrete meshed walls can be included in cores, General meshed walls
cannot.

Sub-division of meshed walls

Each wall object is split into separate panels only at those construction levels
where an element or slab attaches to the wall. At the levels where the wall has
been split, wall beam elements are also inserted.

Geometric rules for mid-pier concrete walls

• Mid-pier walls must be rectangular in a vertical plane.

• Wall openings are ignored.

• The alignment and offsets specified in the wall properties are not
structurally significant as they have no affect on the solver elements that
are formed in the solver model.

• Mid-pier walls can be included in cores.
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Sub-division of mid-pier walls

Each wall object is split into separate panels only at those construction levels
where an element or slab attaches to the wall. At the levels where the wall has
been split, wall beam elements are also inserted.

Continuous concrete walls

Tekla Structural Designer allows you to create walls that are several stories
high and that can start and finish at any level.

Although Tekla Structural Designer only creates one wall in this case, you can
define different thicknesses for each wall panel. The panels are then set back
on one or both faces, depending on the alignment that you have specified.

Creating a continuous wall this way, instead of defining a new wall on each
floor, does not have any significance for analysis or design purposes. However,
it is ultimately important for detailing purposes.

Analysis of concrete walls

The points that you use to place a concrete wall define the exact size and
position of the wall’s analysis model. The alignment and extension properties
of the wall have no effect on the analysis model.

Tekla Structural Designer can adopt either an FE meshed or mid-pier wall
analysis on a wall by wall basis.

Support

Provided that the AutomaticGenerateSupport option is selected, if no slab or
other member exists beneath the wall when it is first created, Tekla Structural
Designer automatically places a support underneath the wall.

Material Type

For walls with the Material type set to concrete (as opposed to general), there
are then two types of Fabrication available:

• Cast-in-place

• Precast

For each fabrication type there are two Concrete types available:

• Normal

• Lightweight

The Grade lists all the available grades in the Materials database under the
current head code for the selected Concrete type.

Releases

You can apply minor axis releases at the top and the bottom of each panel in
order to model pinned connections to incoming slabs and members.
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Door and window openings

You can only define door and window openings in meshed walls. Tekla
Structural Designer does not allow you to create openings in mid-pier walls.
For more information openings, and the alternative ways to model them, see:
Concrete wall openings analysis model (page 242)

Purpose of concrete walls

Both meshed and mid-pier concrete walls introduce structural strength and
stiffness to your model. However, they do not perform the same function as
wall panels. This means that wind loads calculated by the Wind Wizard cannot
be applied to your structure if the model does not contain wall panels.

In order to apply wind loads, you must create additional wall panels in the
same physical locations as the concrete walls.

Create meshed or midpier concrete walls

You can create meshed or mid-pier concrete walls both in 2D views and frame
or structure views. Mid-pier walls are always rectangular; meshed walls can
either be rectangular or quadrilateral.

For detailed information on creating concrete walls, see the following
instructions.

Create rectangular walls in a level view

1. On the Model tab, click the arrow below Concrete Wall.

2. In the list that appears, select the desired wall type.

• Mid-pier Wall

• Meshed Wall

3. Go to the Properties window.

4. Adjust the top and base level for the wall, if necessary.

5. Adjust the remaining properties, such as the wall thickness, if necessary.

6. In the model, click the start point of the wall. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

7. Click the end point of the wall. 

Tekla Structural Designer creates the wall.

Create models 237 Create the model



Create rectangular walls in a frame or structure view

NOTE In order to define a wall in a frame or structure view, you must have
already defined the construction levels between which the wall will
run, and the grid points between which it will lie.

1. On the Model tab, click the arrow below Concrete Wall.

2. In the list that appears, select the desired wall type.

• Mid-pier Wall

• Meshed Wall

3. Go to the Properties window.

4. Ensure the Rectangular property is selected.

5. Adjust the remaining properties, such as the wall thickness, if necessary.

6. Click a point to define a corner of the wall.

7. Click a point to define the opposite corner. Tekla Structural Designer
creates the wall between the selected two points.

Create quadrilateral walls in a frame or structure view

NOTE In order to define a wall in a frame or structure view, you must have
already defined the construction levels between which the wall will
run, and the grid points between which it will lie.

1. On the Model tab, click the arrow below Concrete Wall.

2. In the list that appears, select the Meshed Wall.

3. Go to the Properties window.

4. Ensure the Rectangular property is unselected.

5. Adjust the remaining properties, such as the wall thickness, if necessary.

6. Click the point where the base of the wall should start.

7. Click the point where the base of the wall should end.

8. Click the point where the top of the wall should start.

9. Click the point where the top of the wall should end. Tekla Structural
Designer creates the wall between the selected four points.

See also

Concrete meshed and mid-pier wall properties (page 965)

How meshed walls are represented in solver models (page 577)

How mid-pier walls are represented in solver models (page 582)
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Create door or window openings (page 241)

Specify extensions and releases
Tekla Structural Designer allows you to trim new walls automatically, and trim
or extend existing walls manually. In addition, you can specify minor axis
releases to the top or bottom part of panels. For more information, see the
following instructions.

See also

Create concrete walls (page 237)

Create door and window openings (page 241)

Concrete wall extensions

Specify extensions

• Do one of the following:

To Do this
Automatically trim a new wall back to the face of
existing columns and walls

1. In the Properties window, select the
AutomaticExtension option.

2. Create the wall.

Manually trim or extend existing walls 1. Select the wall that you want to trim or
extend.

2. Go to the Properties window.

3. In the End 1 extension or End 2 extension
field, define the desired extension.

NOTE A positive extension extends the
wall length beyond its insertion
point.

A negative extension trims the wall
back from its insertion point.

Specify releases

1. Select the wall to be released.

2. In the Properties window, go to Releases.

3. In the Minor Top or Minor Bottom list, select the desired release:

• Fixed

• Pinned
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• Continuous (incoming members pinned): only available for FE
meshed walls

TIP To specify a pinned connection to a supported slab, use an FE
meshed wall and select the Continuous (incoming members
pinned) option.

We recommend this option because the Pinned option also
releases the wall panel above from the wall panel below. This
may result in a mechanism during the analysis.

Create and modify wall supports
If needed, you can set Tekla Structural Designer to automatically generate
support for walls. In addition, you can modify the degree of freedom of the
wall support, and remove an unnecessary wall support. For more information,
see the following paragraphs.

Automatic support generation

The AutomaticGenerateSupport option in wall properties controls whether a
support is automatically created at the wall base level.

When the AutomaticGenerateSupport option is selected:

• If there are members or slabs underneath the wall capable of providing
support, no support is generated.

• If there are no members or slabs underneath the wall capable of providing
support, a support is generated.

When the AutomaticGenerateSupport option is cleared:

• If the Generate support option is selected, a support is generated.

• If the Generate support option is not selected, no support is generated.

When a support is required, Tekla Structural Designer forms it as follows:

• Under a meshed wall, Tekla Structural Designer creates a line support.

• Under a mid-pier wall, Tekla Structural Designer creates a point support.

• Under a bearing wall, Tekla Structural Designer creates a series of point
supports.

When a support is required, its degrees of freedom are as specified in wall
properties, under Wall support.

See also

Create concrete walls (page 237)
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Modify wall support fixity

NOTE Supports can only be edited or deleted for both mid-pier and meshed
concrete walls via the wall properties.

1. In the Properties window, expand Wall support.

2. Specify the degrees of freedom according to your needs. 

NOTE The discrete supports at each node are always angled in the
global axis system, and not aligned with the wall major/minor
axes.

That is why you need to set both Mx and My to Free. This way,
you can ensure that angled walls are pinned out of plane. This is
not strictly necessary if the wall is aligned in global X or Y. In this
case, you can set only Mx or My free, as appropriate.

Similarly, set both Mx and My to Fixed in order to ensure that
angled walls are fixed out of plane.

Remove a wall support

NOTE Supports can only be edited or deleted for both mid-pier and meshed
concrete walls via the wall properties.

1. In the Properties window, clear the Generate support option. 

NOTE The Generate support option is only available for editing if the
AutomaticGenerateSupport option is inactive. When
AutomaticGenerateSupport is selected, Generate support is
automatically cleared if members are created underneath a wall
to support it. Similarly, Generate support is automatically
reselected, if the supporting members are deleted.

Create door or window openings
Tekla Structural Designer allows you to create openings for both doors and
windows in existing walls. For detailed instructions, see the following
paragraphs.

RESTRICTION Openings are only active in meshed walls.

1. Open a frame view of the frame that contains the desired meshed wall.

2. On the Model tab, click Wall Opening.

3. Do one of the following:
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• To define the opening relative to the bottom left corner of the wall,
click the outline of an existing wall panel.

• To define the opening relative to the selected node, click a specific
node in the model.

4. Click the first corner of the opening or press F2 to define its exact
position.

5. Drag the mouse pointer to the opposite corner of the opening.

6. Click the opposite corner of the opening or press F2 to define its exact
position. 

Tekla Structural Designer creates the opening.

See also

Create meshed or midpier concrete walls (page 237)

Meshed wall openings analysis model (page 242)

Meshed wall openings analysis model

Limitations of wall openings

1. If you have specified a door or window opening in a wall panel you must
model the wall using FE elements, otherwise a "Walls with openings have
a mid-pier" validation error is displayed and the analysis will not proceed.

2. A "Panel contains openings - these are ignored in design" warning will
always be issued when a wall containing openings is designed. When you
encounter this warning, as well as taking stock of the design implications;
you need also to consider if the analysis model is appropriate, as
potentially it may not reflect your original intention. In certain situations
the Alternative model for wall openings (described below) may prove to
be a better solution.

Analysis model applied to meshed wall panels with openings

If an opening is introduced in a meshed wall, the properties of the "lintel" wall
beam directly above the opening are automatically adjusted in order to
prevent the panel being unrealistically stiff. The adjustments that are applied
are as follows:

• wall beam properties in the lintel use the lintel depth (h2), rather than the
panel depth (h1)
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• wall beam nodes in the lintel are removed from the slab diaphragm

Modeling in this way the lintel becomes less stiff resulting in improved wall
results when subject to gravity and lateral loading.

Alternative model for wall openings

If the presence of an opening would form a beam like strip above or below the
opening, you are advised to create separate wall panels to each side of the
opening and then model the strip between the panels with a connecting beam
('coupling beam').

This method can be demonstrated by considering the below example,
consisting of a two story wall with a large opening at each level.

If the openings were to be created as a window and door the resulting model
would be as shown:
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However, by separating the wall into discrete panels and inserting coupling
beams you obtain an alternative model as below:
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Such an idealisation enables the panels either side of the openings to be
designed for their respective forces and enables the strips between the
openings to be designed as beams.

Of course, this approach will require some additional detailing, but that would
have been the case anyway had the openings been added and subsequently
ignored by the design.

Create concrete cores
Tekla Structural Designer allows you to combine concrete wall panels,
columns, and beams to form cores.

Overview of concrete cores

Concrete wall panels, columns, and beams can be combined to form cores for
which overall analysis results are automatically calculated and available for
review and output.

Such cores might then be used in a number of ways, for example:

• The engineer may wish to see/ output core forces to; better understand the
distribution of lateral forces within the structure; for additional checks they
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wish to undertake; for overall core foundation forces or exclusive core
reactions for cores on foundation mats.

• Cores provide a way of checking lateral forces per object type or SFRS type.
This might be used when assessing buildings for some codes which require
frames in dual systems to resist a minimum amount of seismic load.

• Adding all elements of the lateral system to a single core will give overall
building vertical and lateral load, overturning moments or accumulated
seismic torsion, in any direction.

Any number of walls (meshed and mid-pier), columns, and beams can be
added to a core.

• Constituent objects of a core do not need to be physically attached.

• Once defined the core is listed in the structure tree and can be graphically
selected as a single entity. When selected, its properties are displayed in
the Property Window and Delete, Move, Copy and Mirror operations can be
applied to it.

The directions of each core can be defined as any of; Dir 1/2 - Main Building
Directions; Principal 1/2 - Major and minor local axis; Angle - (w.r.t.) Global
Coordinate System.

The following core properties are automatically calculated/ displayed; Core
section for each level; Core centroid and its coordinates above and below each
level; a Core line with Local coordinate system (LCS) assigned and displayed at
the centroid location; a Core support (for reporting purposes not analysis).

After analysis the following core results are available:

• Core Line Forces - 2D Integrated Results termed “Core Line” results for
cores giving the following overall core forces; Axial Force, Major and Minor
axis Moment and Shear, Torsion.

• In the Results View via 2D Integrated Results > Core Lines, force
diagrams of these results are displayed along the core line w.r.t. its LCS,
with numerical values displayed at the top and bottom of each core
stack and in the Tooltip when the result diagram is cursored over.

• Results are available for all of; All Static Analyses including chase-down;
RSA Seismic both for individual modes and Modal combination;
Imposed/Live load reductions.

• Tabular Results - Core results are also available in Tabular form via
Analyze > Tabular Data and the associated Report option Analysis >
“Core Line Forces”.

NOTE Settings controls in the Member Forces and Wall Line Forces
Report items allow you to optionally exclude columns/walls
assigned to cores.

• Core Reactions - overall Reaction results are calculated for the core and
can be viewed in the Results view via Reactions > Cores and output.
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Create concrete core (assisted mode)

Cores are either created in Assisted or Unassisted mode. In assisted mode
(which is the default), all potential members of a core are automatically
highlighted when the cursor is moved over any of the constituent members,
giving a preview of the core that can be created - a single click then adds all
the highlighted walls to a new core.

1. On the Model tab, click Cores.

1. Assisted Mode

2. In the Properties window, select Assisted.

3. Select an appropriate wall panel or column and all highlighted members
are added to the core. 

The mode switches to Modify to enable you to edit the core if required.

4. If no modifications are required, press Esc to finish. 

NOTE Assisted Mode detects overlapping concrete walls, columns and
coupling beams* that may potentially form a core.

*Beams for which the Construction property is set = “Coupling
Beam”. Note that no additional design checks are performed for
this construction type so currently it serves only to mark beams;
for consideration by the assisted mode core function; for which
additional design checks beyond those currently made in the
program may be required.

Create concrete core (unassisted mode)

1. On the Model tab, click Cores.

2. In the Properties window, unselect Assisted.

3. Select either a wall panel or column as the first member of the core.

4. Select the next wall panel, column, or beam to be part of the core. 

NOTE You can drag the mouse pointer to select multiple members.

5. Continue selecting until all the members of the core have been chosen,
and then press Esc to finish. 

Tekla Structural Designer combines the selected members into a single
core.
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Set the core axis direction
Analysis results are displayed with respect to the axis diection of each core.
This can be aligned to the main building directions, the major and minor local
axis, or to a specified angle.

1. Select the core.

2. In the Properties window, choose the rotation angle as required.

Modify concrete core

1. On the Model tab, click Cores.

2. In the Properties window,

a. Set Mode to Modify

b. Select the Active Core as required.

c. Set Area Selection Mode to Set On to add members to the core, or
Set Off to remove members from the core.

3. Select a member to add or remove from the core.

4. Continue selecting or press Esc to finish. 

Tekla Structural Designer combines the selected members into a single
core.

Dissociate concrete core
Existing cores can be disconnected if required.

1. Hover the mouse pointer over the core.

2. If a different entity is highlighted, press the <down arrow> cursor key until
the required core reference is shown in the Select Entity tooltip.

3. Right click and select Dissociate Core.

Related video

Core modeling

Create bearing walls
Bearing walls provide resistance to vertical compressive loads (but not lateral
loads) and support certain other member types. Unreinforced masonry walls,
for example, can be modeled as bearing walls.

Create models 248 Create the model



You can model bearing walls over several story heights. In these cases, Tekla
Structural Designer creates a single wall with a uniform thickness between the
base and top level.

Tekla Structural Designer determines the location of the wall from the
alignment specified in the bearing wall properties, and the selected insertion
points.

NOTE Bearing walls do not perform the same function as wall panels. In other
words, bearing walls do not allow you to apply loads calculated by the Wind
Wizard to your structure.

Therefore, in order to apply wind loads, you must create additional wall
panels in the same locations as the bearing walls.

Material type

Three Material types are available for bearing walls:

• Concrete

• Timber

• General

Concrete Bearing Walls

There are two Concrete types available:

• Normal

• Lightweight

The Grade lists all the available grades in the Materials database under the
current head code for the selected Concrete type.

Timber Bearing Walls

The Grade lists all the available grades in the Materials database under the
current head code for Timber.

General Bearing Walls

The Grade lists all the available General materials in the Materials database
under the current head code.
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If the grade you want to use is not listed, you can open the Materials dialog
and add the grade to the database (page 902), taking care to first select the
General material type as shown below.
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Geometric rules

• Bearing walls can only be created as rectangular in a vertical plane.

• Wall openings are ignored.

• Bearing walls cannot be included in cores.

Create bearing walls in a level view

NOTE Ensure that you have defined the construction levels between which
the wall will run, and the grid points between which the wall will lie.
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1. On the Model tab, click Bearing Wall. 

The wall will adopt the properties displayed in the Properties window.

2. Go to the Properties window.

3. If necessary, adjust that the base level and top level of the wall.

4. Adjust thickness and other wall properties according to your needs.

5. In the model, click the start point of the wall.

6. Click the end point of the wall. 

Tekla Structural Designer creates the wall between the selected start and
end points.

Create bearing walls in a frame or structure view

NOTE In order to define a wall in a frame or structure view, you must have
already defined the construction levels between which the wall will
run and the grid points between which it will lie.

1. On the Model tab, click Bearing Wall. 

The wall will adopt the properties displayed in the Properties window.

2. In the Properties window, adjust the thickness and other wall properties
according to your needs.

3. In the model, click the first corner of the wall.

4. Click the opposite corner of the wall. 

Tekla Structural Designer creates the wall between the selected points.

See also:

Bearing wall properties (page 1008)

How bearing walls are represented in solver models (page 588)

Create shear only walls
Shear only walls provide resistance to in-plane lateral loads only.

You can model shear only walls over several story heights. In these cases,
Tekla Structural Designer creates a single wall with a uniform thickness
between the base and top level.

Tekla Structural Designer determines the location of the wall from the
alignment specified in the shear only wall properties, and the selected
insertion points.
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NOTE Requirements for these walls are that they must be; within a single bay (i.e. do
not overlap one or more columns); strictly rectangular; vertical and
surrounded by columns and beams (other than at the bottom edge).

NOTE Shear only walls do not perform the same function as wall panels. In other
words, shear only walls do not allow you to apply loads calculated by the
Wind Wizard to your structure.

Therefore, in order to apply wind loads, you must create additional wall
panels in the same locations as the shear only walls.

Material type

The chosen material will only affect the weight of the wall. Whilst Shear only
walls are most suited to masonry, three Material types are available:

• Concrete

• Timber

• General

Geometric rules

• Shear only walls can only be created as rectangular in a vertical plane.

• They must be totally enclosed by members (concrete or steel), except at
the base.

• Wall openings are ignored.

• Shear only walls cannot be included in cores.

Create shear only walls in a level view

NOTE Ensure that you have defined the construction levels between which
the wall will run, and the grid points between which the wall will lie.

1. On the Model tab, click  Shear Only Wall. 

The wall will adopt the properties displayed in the Properties window.

2. Go to the Properties window.

3. If necessary, adjust the base level and top level of the wall.

4. Adjust stiffness, thickness, and other wall properties according to your
needs.

5. In the model, click the start point of the wall.

6. Click the end point of the wall. 

Tekla Structural Designer creates the wall between the selected start and
end points.
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Create shear only walls in a frame or structure view

NOTE In order to define a wall in a frame or structure view, you must have
already defined the construction levels between which the wall will
run and the grid points between which it will lie.

1. On the Model tab, click  Shear Only Wall. 

The wall will adopt the properties displayed in the Properties window.

2. In the Properties window, adjust the stiffness, thickness, and other wall
properties according to your needs.

3. In the model, click the first corner of the wall.

4. Click the opposite corner of the wall. 

Tekla Structural Designer creates the wall between the selected points.

See also:

Shear only wall properties (page 1011)

How shear only walls are represented in solver models (page 584)

Create general walls
You can create meshed general walls in level, frame, or structure views. For
detailed information on creating general walls, see the following instructions.

Material type

The Grade lists all the available General materials in the Materials database
under the current head code.
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NOTE Care should be taken when choosing the grade, as some general
materials in the database may not be appropriate for meshed walls.
Meshed walls resist loads in all directions and isotropic stiffness
properties are assumed.

If the grade you want to use is not listed, you can open the Materials dialog
and add the grade to the database (page 902), taking care to first select the
General material type as shown below.
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Geometric rules

• Meshed walls are defined as quadrilaterals in a single plane that can be
vertical or sloping, (unlike mid-pier concrete walls which must be
rectangular in a vertical plane).

• Openings (page 241) are permitted in meshed walls.

• The alignment and offsets in the wall properties are not structurally
significant as they have no affect on the solver elements that are formed in
the solver model.
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• Concrete meshed walls can be included in cores, General meshed walls
cannot.

Sub-division of meshed walls

Each wall object is split into separate panels only at those construction levels
where an element or slab attaches to the wall. At the levels where the wall has
been split, wall beam elements are also inserted.

Create rectangular walls in a level view

1. On the Model tab, click the arrow below  General Wall.

2. Go to the Properties window.

3. Ensure the Material Type is set to General, then use the Grade property to
select the general material type.

4. Adjust the top and base level for the wall, if necessary.

5. Adjust the remaining properties, such as the wall thickness, if necessary.

6. In the model, click the start point of the wall. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

7. Click the end point of the wall. 

Tekla Structural Designer creates the wall.

Create rectangular walls in a frame or structure view

NOTE In order to define a wall in a frame or structure view, you must have
already defined the construction levels between which the wall will
run, and the grid points between which it will lie.

1. On the Model tab, click the arrow below General Wall.

2. Go to the Properties window.

3. Ensure the Material Type is set to General, then use the Grade property to
select the general material type.

4. Ensure the Rectangular property is selected.

5. Adjust the remaining properties, such as the wall thickness, if necessary.

6. Click a point to define a corner of the wall.
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7. Click a point to define the opposite corner. Tekla Structural Designer
creates the wall between the selected two points.

Create quadrilateral walls in a frame or structure view

NOTE In order to define a wall in a frame or structure view, you must have
already defined the construction levels between which the wall will
run, and the grid points between which it will lie.

1. On the Model tab, click the arrow below General Wall.

2. Go to the Properties window.

3. Ensure the Rectangular property is unselected.

4. Ensure the Material Type is set to General, then use the Grade property to
select the general material type.

5. Adjust the top and base level for the wall, if necessary.

6. Adjust the remaining properties, such as the wall thickness, if necessary.

7. Click the point where the base of the wall should start.

8. Click the point where the base of the wall should end.

9. Click the point where the top of the wall should start.

10. Click the point where the top of the wall should end. Tekla Structural
Designer creates the wall between the selected four points.

See also

General wall properties (page 974)

How meshed walls are represented in solver models (page 577)

Specify extensions and releases (page 239)

Create and modify wall supports (page 240)

Create door or window openings (page 241)

Create slabs and decks
This section focuses on the operations required to create slabs and decks.

• Overview of the slab model (page 259)

• Create slab items (page 263)

• Create slab or mat openings (page 265)

• Add overhangs to existing slab or mat edges (page 267)

• Apply curved edges to existing slab items (page 269)
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• Create column drops (page 270)

• Specify the material for general slab types (page 270)

• Split and join slabs and mats (page 273)

• Modify slab/panel span direction (page 274)

See also

Modify slab items and panels by moving a node (page 171)

Modify slab items by moving an edge (page 172)

Overview of the slab model
Slabs allow you to decompose loads placed on a floor back to the supporting
structure. You can create slabs in either levels or inclined planes. For more
information, see the following paragraphs.

Slabs and slab items

Tekla Structural Designer stores slab data in the form of parent slabs, each
consisting of one or more individual panels, called slab items. Slab items can
be either connected or separated from each other. However, they must be on
the same level.

Every parent slab has a unique name. A slab name used at one level can not
be re-used at a different level.

Every parent slab has general properties of slab type (and associated deck
type) as follows:

• Slab on beams

• Reinforced concrete

• Post tension

• Flat slab

• Reinforced concrete

• Post tension

• Precast

• Precast concrete planks

• Composite slab

• Profiled metal decking

• General

• Steel plate

• Timber

• General
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Every parent slab also has a load decomposition property:

• One-way

• Two-way

Slab items initially inherit their properties from the parent slab. However, once
the slab items have been created, you can modify them to amend certain
properties: you can change the rotation angle, override the slab depth, or
exclude a panel from the diaphragm. Once you have overridden the slab
depth, you can also apply a vertical offset in order to model a slab step.

In the view below, there are 24 slab items grouped together in one slab.

Tekla Structural Designer sets some data on the slab level and is common to
all slab items, while other data is set at the slab item level. In simple overview
terms, the data breakdown is as follows:

Slab data:

• Slab type

• Deck type

• Decomposition

• Thickness

• Vertical offset

• Material properties

• Analysis settings

• General design settings

Slab item data:

• Cover

• Reinforcement information

• Specific design settings
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Therefore, you can create slabs over a wide area. While creating slabs, you do
not have to consider sub-sections of the slab - you can simply create one big
expanse of slab.

When it comes to design, you need to conceptualize the slab as a series of
design panels, or slab items. Each slab item will have its own design settings
and its own design results. You can select different reinforcement in different
panels. You also have to consider pattern loading, where some panels are
loaded, and others not.

When results are later presented in calculations and drawings, you can
specifically reference the design panels.

Comparison of slab types

The different slab types available in Tekla Structural Designer are compared in
the below table.

 Slab on
beams

Flat slab Precast Composite General

Deck Type • Reinforc
ed
concret
e

• Reinforc
ed
concret
e

• Precast
concret
e planks

• Profiled
metal
decking

• steel
plate

• timber

• general
See: Create slab items (page 263)

Decomposi
tion

• 1-way

• 2-way

• 2-way • 1-way • 1-way • 1-way

• 2-way
See: Overview of one-way and two-way load decomposition
(page 385)

Diaphragm
action

• rigid

• semi-
rigid

• none

• rigid

• semi-
rigid

• none

• rigid

• semi-
rigid

• none

• rigid

• semi-
rigid

• none

• rigid

• semi-
rigid

• none
See: Overview of diaphragm action in roof panels and slabs
(page 482)

Load • all panel
load
types

• all panel
load
types

• all panel
load
types

• all panel
load
types

• all panel
load
types

See: Apply panel loads (page 364)
Modificati
on factors
for 2-way
spanning
slabs

• yes • yes • n/a • n/a • yes
See: Analysis Settings>Modification factors (page 1061)
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 Slab on
beams

Flat slab Precast Composite General

Meshed in
3D
analysis
and
grillage
chasedow
n models

• 1-way:
no

• 2-way:
optional

• optional • no • no • 1-way:
no

• 2-way:
optional

See: Define whether slabs are meshed for 3D building analysis
and grillage chasedown analysis (page 464)

Meshed in
FE
Chasedow
n analysis

• 1-way:
no

• 2-way:
yes

• yes • no • no • 1-way:
no

• 2-way:
yes

See: Manage FE meshed slabs (page 464)
Designed
in Tekla
Structural
Designer

• 1-way -
beyond
scope

• 2-way-
yes

• yes • beyond
scope

• beyond
scope

• beyond
scope

See: Design slabs and run punching shear checks (page 616)

Vertical alignment

The vertical alignment of all slabs in a given level is determined by the
construction level type specified in the Construction Levels dialog. The
possible types are:

• T.O.S. (Top Of Steel): the base of each slab item aligns with the level.

• S.S.L. (Structural Slab Level): the top of each slab item aligns with the level.

• T.O.F. (Top Of Foundation): the base of each slab item aligns with the level.

Vertical offsets

A vertical offset can be specified after checking ‘Override slab depth’ in the
slab item properties.

These offsets are not structurally significant in slabs as they have no effect on
the analysis mesh position relative to the top of the slab in the solver model.
However, the mesh properties would reflect any change in the slab thickness.

Slab edges

Slab edges can be either straight or curved.

See: Apply curved edges to existing slab items (page 269)

Create models 262 Create the model



Slab openings

You can create openings of any shape within slabs. These are only considered
when the slab is meshed for load decomposition or analysis.

See: Create slab or mat openings (page 265)

Column drops

Column drop panels are slab items with an increased thickness. In flat slabs, at
points where the slab is supported by columns, you can use column drops to
thicken the slab.

See: Create column drops (page 270)

Panel sub-division

Regardless of how the slabs and slab items are initially created, you can
further divide or re-form them with the Slab Split and Slab Join commands.
There are several reasons why you may choose to use the previously
mentioned commands, related to adding steps, loading patterns, and
designing panels.

For flat slabs in particular, the way that slabs are split for the purposes of
pattern loading is a matter of engineering judgement. The views below view
two options that two different engineers might both justifiably choose for the
same slab perimeter.

See: Split and join slabs and mats (page 273)

Create slab items
Slab items are individual slab panels that form parent slabs. You can create
slab items either by bay, or by points. For more information, see the following
instructions.
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Select the slab type and specify slab properties

1. On the Model tab, click the arrow under  Slabs.

2. In the list that appears, select the desired slab type.

3. In the Properties window, define the slab item parameters for the
selected slab type.

4. Ensure that the Slab and Select bays properties are set according to your
needs.

Specify the parent slab to which the slab item belongs

1. In the Properties window, go to the Slab property.

2. Click the arrow on the right side of Slab.

3. In the list that appears, select whether you want to:

• Create a new slab

• Add to existing slab

NOTE When you select this option, at the point of creating the slab
item, Tekla Structural Designer checks if there is a existing slab
in the plane with same properties.

If Tekla Structural Designer finds an identical slab, the new
slab item will be added to it.

If Tekla Structural Designer finds two identical slabs, the
closest one is used.

If Tekla Structural Designer does not find an identical slab, a
new parent slab is created.

• Manually select the parent slab

NOTE This option is only available in 2D views after one or more slab
items have been placed in that view.

4. When the slab item properties are defined, you can place the item either
by bays or by picking points.

Create slab items by bay

You can only create slab items by bay in 2D Views.

1. In the Properties window, ensure that the Select bays option is selected.

2. Do one of the following:

To Do this
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To add an individual slab item a. Click the outline of a bay bounded by
beams or walls.

To add slab items into all bounded bays • Drag a box that encompasses the bays.

NOTE Dragging the box from left to right
places items in those bays totally
enclosed by the box.

Dragging the box from right to left
places items in all bays that are either
enclosed by the box, or cross it.

Holding down Shift while dragging
creates a line instead of a box. Tekla
Structural Designer places slab items in
all bays that cross the line.

Create slab items by points

You can create slabs in both 2D and 3D Views.

1. In the Properties window, ensure that the Select bays option is cleared.

2. Click the start point of the slab item.

3. Click other points that define the slab item outline.

4. Double-click the final point to create the slab item.

Create slab or mat openings
When you have created slabs or mats, you can create different kinds of
openings to them according to your needs. You can define rectangular,
circular, and irregular openings. For more information on how to create and
delete slab and mat openings, see the following instructions.

Simple openings

You can quickly define simple openings within existing slabs. Simple openings
are rectangular or circular in plan.

The Slab Opening command is located on the list in the Slabs group. The
command is only active in 2D views.

Slab openings can:

• Cross more than one slab item or slab

• Be overlaid or joined to create openings which together have shapes other
than rectangular

• Cut across a stepped edge

• Be applied to level an sloping slabs

Openings cannot:

• Be applied to one-way spanning slabs
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• Reside within or cut a column drop

Irregular Openings

Alternatively, you can create more complex openings by using construction
lines and constructing slab items around an irregular shape.

Create rectangular openings

1. Open a 2D view of the level containing the slab item or mat panel within
which you want to create an opening.

2. Do one of the following:

To Do this
Create slab openings a. On the Model tab, click the arrow on the

top right corner of the Slabs group.

b. In the list that appears, select Slab
Opening.

Create mat openings

• On the Foundations tab, click Mat
Opening.

The opening properties are viewed in the Properties window.

3. In the Properties window, set the Opening Type to Rectangular.

4. If necessary, specify a rotation angle to rotate the opening on plan.

5. Click within the outline of an existing slab item or mat panel to define the
first corner of the opening, or press F2 to define its exact position.

6. Drag the mouse pointer to the opposite corner of the opening.

7. Click the opposite corner of the opening, or press F2 to define its exact
position. 

Tekla Structural Designer creates the opening.

Create circular openings

1. Open a 2D view of the level containing the slab item or mat panel within
which you want to create an opening.

2. Do one of the following:

To Do this
Create slab openings a. On the Model tab, click the arrow on the

top right corner of the Slabs group.

b. In the list that appears, select Slab
Opening.
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Create mat openings

• On the Foundations tab, click Mat
Opening.

The opening properties are viewed in the Properties window.

3. In the Properties window, set the Opening Type to Circular.

4. Click within the outline of an existing slab item or mat panel to define the
center of the opening, or press F2 to define its exact position.

5. Drag the mouse pointer to define the radius of the opening, or press F2 to
define the exact radius. 

Tekla Structural Designer creates the opening.

Delete slab or mat openings

1. In the Structure tree, open the Slab Openings branch.

2. Right-click the name of the slab or mat opening that you want to delete.

3. In the context menu, select Delete. 

Tekla Structural Designer deletes the opening.

Add overhangs to existing slab or mat edges
At times, the edge of a slab or mat may extend beyond a grid line, either to the
edge of the beam which supports the edge of the slab, or around the
perimeter of the building to meet the inside face of the cladding. In order to
take these cases in to account, Tekla Structural Designer allows you to define
overhangs to the edges of a slab. An overhang may extend across many slab
items in one slab and can be curved, or tapered if required.

Any loads that you define over an overhang are included in the total loading
on your building.

You can only create overhangs in 2D views.

Add an overhang along the full length of a supporting beam

NOTE This method can only be used if a beam exists along the entire
slab/mat edge to which the overhang is to be added.

1. Open a 2D view of the level containing the slab/mat for which you want to
create the overhang.

2. Do one of the following:

To Do this
Create an overhang over a supporting beam to a
slab edge

a. On the Model tab, click the arrow in the
top right corner of the Slabs group.
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b. In the list that appears, select Slab
Overhang.

c. In the Properties window, check
LengthOfBeam.

d. If necessary, in the Properties window,
modify the width and other properties of
the overhang.

e. Click on the beam over which the overhang
is to extend.

Create an overhang over a supporting beam to a
mat edge

• On the Foundations tab, the arrow under

Mat Opening.

• In the list that appears, select Mat
Overhang.

• In the Properties window, check
LengthOfBeam.

• If necessary, in the Properties window,
modify the width and other properties of the
overhang.

• Click on the beam over which the overhang
is to extend.

Tekla Structural Designer creates the overhang along the length of the
beam.

Add an overhang to a slab or mat edge between two points

NOTE In order to define a slab overhang between two points, you must have
already defined the slab to which it applies.

1. Open a 2D view of the level containing the slab/mat for which you want to
create an overhang.

2. Do one of the following:

To Do this
Create an overhang to a slab edge a. On the Model tab, click the arrow in the

top right corner of the Slabs group.

b. In the list that appears, select Slab
Overhang.

Create an overhang to a mat edge • On the Foundations tab, the arrow under

Mat Opening.

• In the list that appears, select Mat
Overhang.

The slab or mat overhang properties are viewed in the Properties
window.

3. Ensure the LengthOfBeam property is unchecked.
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4. If necessary, in the Properties window, modify the width and other
properties of the overhang.

5. Click along the edge of an existing slab item or mat panel to define the
start point of the overhang, or press F2 to define its exact position.

6. Click along the same edge to define the end point of the overhang, or
press F2 to define its exact position. 

Tekla Structural Designer creates the overhang between the two points.

Add a curved overhang to a slab or mat edge

While following one of the above procedures to add an overhang along the
length of a supporting beam, or between two points:

1. In the Properties window, uncheck the Edge parallel property.

2. In the Properties window, define the Curvature of the overhang.

3. Continue to create the overhang in the normal way.

Add a tapered overhang to a slab or mat edge

While following one of the above procedures to add an overhang along the
length of a supporting beam, or between two points:

1. In the Properties window, check the Tapered property.

2. Use the Width1 property to define the length of overhang at end 1.

3. Use the Width2 property to define the length of overhang at end 2.

4. Continue to create the overhang in the normal way.

Apply curved edges to existing slab items
You may sometimes need to create slab items that have curved edges instead
of linear ones. For detailed instructions to do so, see the following paragraphs.

1. Select the slab items that you want to modify.

2. According to you needs, do one of the following:

To Do this
Apply the same degree of curvature to all
selected slab edges

a. In the Properties window, go to All edges.

b. Clear the Linear option.

c. Define the required curvature.

A positive value creates an inward curve,
whereas a negative value creates an
outward curve.

Apply curvature to a specific edge a. In the Properties window, go to the
properties of the required edge.

The edges are numbered.

b. Clear the Linear option.
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c. Define the required curvature.

A positive value creates an inward curve,
whereas a negative value creates an
outward curve.

Tekla Structural Designer redraws the slab item with the specified
curvature.

Create column drops
In order to increase punching resistance, you can insert drop panels, or
column drops, within concrete slabs at points where they are supported by
columns. Column drops are slab thickenings that can be positioned above the
slab, below the slab, or both. Column drops are rectangular in plan, and
aligned to the column axes. Column drops are always positioned centrally over
the supporting column.

The extent of the column drop is limited by the extent of the slab boundary.
The cut back drop shape may not be rectangular.

NOTE In order to define a slab drop you must have already defined the
concrete slab to which it applies.

1. On the Model tab, click the arrow on the top right corner of the Slabs
group.

2. In the list that appears, select Column Drop. 

The column drop properties are viewed in the Properties window.

3. If necessary, in the Properties window, modify the properties of the
column drop.

4. Click an existing column connected to a concrete slab panel to create a
single column drop, or drag a box around multiple columns to create a
series of column drops. 

NOTE To insert the column drop correctly, ensure that the type of the
construction level containing the slab is S.S.L., not T.O.S.

Specify the material for general slab types
General slab types can have steel plate, timber, or general deck types. The
material grade properties for each deck type can either be selected from the
material database or they can be user-defined.
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Choosing the grade from the material database

If the Deck type is set to:

• Steel plate - the Grade lists all the available Steel materials in the
Materials database under the current head code.

• Timber - the Grade lists all the available Timber materials in the Materials
database under the current head code.

NOTE When using a timber deck type, the program will initially default to
a material override option rather than displaying a Grade. This is
because the Poisson’s ratio in the timber materials database is
generally invalid for isotropic elastic analysis (of 2D elements), for
which it must be > 0 and < 0.5. You can disable the override to
select a timber grade, but you must then enable it again to enter a
valid Poisson’s ratio (other grade properties such as density and
modulus of elasticity will be retained).

• General - the Grade lists all the available General materials in the
Materials database under the current head code.

If the general material grade you want to use is not listed, you can open the
Materials dialog and add the grade to the database (page 902), taking care to
first select the General material type as shown below.
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Override material properties option

Unlike other slab types, general slab types each have an option to override
material properties. This option is provided primarily to allow the existing
properties of steel or timber deck slabs created in older versions of Tekla
Structural Designer (pre 2020 SP5) to be retained, but it can also be used to
enter the material properties directly if required.

NOTE When creating new timber decks, the program will default to the override
option. This is because the Poisson’s ratio in the timber materials database is
generally invalid for isotropic elastic analysis (of 2D elements), for which it
must be > 0 and < 0.5. You can disable the override to select a timber grade,
but you must then enable it again to enter a valid Poisson’s ratio (other grade
properties such as density and modulus of elasticity will be retained).
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Split and join slabs and mats
Tekla Structural Designer allows you to both sub-divide existing slab items into
smaller items, and merge slab items into larger items.

NOTE The commands for splitting and joining slab items are only accessible in 2D
views.

Split slab and mat items

1. Do one of the following:

To Do this
Split slabs

• On the Model tab, click Slab Split.

Split mats

• On the Foundations tab, click Mat
Split.

2. Hover the mouse pointer over the slab or mat edge, grid point, or other
point where you want to start the split. 

NOTE The points used to define the cut line can be outside the
boundary of the slabs being split. Thus, they do not need to be on
the slab edges.

3. Click the start point of the split.

4. Click the second point of the split on either the same or other item or
panel.

5. Do one of the following:

• To continue the split, click subsequent split points.

• To end the split, click the second point of the split again.

Tekla Structural Designer splits any slab items entirely crossed by the split
along the cut line.

Join slab and mat items

RESTRICTION You can only join slab items that share a common edge.

1. Do one of the following:

To Do this
Split slabs

• On the Model tab, click Slab Join.
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Split mats

• On the Foundations tab, click Mat
Join.

2. Select the first of the slab items (the master item) that you wish to join. 

NOTE The slab items selected later will adopt the properties of the
master item.

3. Select the second slab item. 

Tekla Structural Designer joins the selected slab items to create a new
one.

4. Select additional slab items as required, or press Esc.

Modify slab/panel span direction
The span direction of slab items or wall/roof panels can be edited via the
Properties window. The span direction of individual slab items and wall/roof
panels can also be edited graphically.

NOTE Provided SpanDirection is switched on in Scene Content, the rotation angle/X
direction is represented by a blue arrow.

Modify a single span direction graphically

The span direction can be edited graphically , in both 2D and 3D views.

1. Select the slab/panel item.

2. Select the span direction symbol. A yellow command prompt is displayed
and the Properties window lists the X direction mode options of Align
with edge and Define by 2 points

3. Select the desired mode.

4. Select either a slab edge (of any slab item) or two points, depending on
the selected mode. 

The slab direction is automatically set to the identified angle.

Modify span direction via the Properties window

1. Select the slab/ panel item(s).

2. In the Properties window enter the required rotation angle/X direction.
The slab span direction is updated to the new angle.

Create trusses and joists
These topics introduce you to the methods of creating trusses and joists.
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We recommend you familiarize yourself with how to:

• Create trusses (page 275)

• Create steel joists (page 277)

Create trusses
Trusses are particular arrangements of members that Tekla Structural
Designer calculates automatically for you. Once you have created a truss, you
can copy the truss throughout your model as necessary. In addition, you can
pick a truss in your model, and move it to a desired location.

Create a truss
The Truss Wizard helps you to create trusses in your models. For detailed
instructions on how to use the Truss Wizard to create trusses, see the
following instructions.

1. On the Model tab, click Steel Truss, or Timber Truss according
to your needs. 

The Truss Wizard opens.

2. Select the truss shape.

3. In the model, click the start point of the truss. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

4. In the model, click the end point of the truss.

5. In the Truss Wizard, click Next.

6. Specify the truss alignment parameters.

7. Click Next.

8. Specify the truss details.

9. Click Finish.

Create a space truss
Tekla Structural Designer allows you to create linear and planar space trusses.
You can create space trusses in a 2D or 3D view. For more information, see the
following instructions.

1. On the Model tab, click the arrow next to Steel Truss, or Timber
Truss, according to your needs.
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2. In the list that appears, select Space. 

The Space Truss Wizard opens.

3. Define the truss type, the alignment, and the number or bays.

4. Click Next.

5. In the model, click the truss location points:

• For a linear truss, click the start and end points.

• For a planar truss, click the four corners of the truss.

6. In the Space Truss Wizard, specify the truss width and height. 

If you are creating a planar truss, Tekla Structural Designer calculates the
width automatically.

7. Click Next.

8. Define whether the truss should be straight or curved.

9. Click Finish.

Create a free form truss
You can create a free form truss by placing a series of truss members in the
required shape. For more information, see the following instructions.

RESTRICTION Free form trusses cannot be created in a 3D view, or a 2D level
view.

1. Open the 2D frame view in which you want to create the truss.

2. On the Model tab, click the arrow next to Steel Truss, or Timber
Truss, according to your needs.

3. In the list that appears, select Free Form.

4. Click the start point of the first truss member.

5. Click the end point of the first truss member.

6. Repeat steps 4 and 5 to place each truss member as required.

7. When the truss geometry is complete, press Esc to finish.

Modify the geometry of existing steel and space trusses
After creating a steel, timber, or space truss, you can modify their geometry by
using the Edit command. For more information, see the following instructions.

1. Hover the mouse pointer over the desired truss so that it becomes
highlighted.

2. Right-click the truss.

Create models 276 Create the model



3. In the context menu, select Edit [element name]. 

Depending on the type of the truss, either the Truss Wizard or the Space
Truss Wizard opens.

4. Modify the truss properties according to your needs.

5. To save the changes, click Finish.

Modify the properties of existing trusses
You can modify the section sizes, material grades, section orientations, and
other truss properties in the Properties window. For more information, see
the following instructions.

1. Move the mouse pointer over the desired truss, so that it becomes
highlighted.

2. Click the truss.

3. In the Properties window, modify the truss properties according to your
needs.

Create steel joists
Steel joists, or bar joists, are a specific type of members used in the United
States. They are simply supported secondary members that, in turn, support
slab and roof loads. Steel joists are constrained to standard types specified by
the US Steel Joist Institute, and standardized in terms of span, depth and load
carrying capacity. To create steel joists in your model, see the following
paragraphs.

Specify the section for Standard and Special joist types

1. On the Model tab, click Steel Joist.

2. In the Properties window, specify the Steel joist type

3. Click the arrow on the right side of Steel joist type.

4. In the list that appears, select either Standard or Special as required.

5. Select the Section parameter.

6. Click the arrow on the right side of Section.

7. In the list that appears, select <New\Edit...> The Select Section dialog
box opens.

8. Select the desired joist type and size.

9. Click Select.

10. In the Properties window, adjust the remaining parameters according to
your needs.
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Specify the section for the Girder joist type

1. On the Model tab, click Steel Joist.

2. In the Properties window, select the Steel joist type parameter.

3. Click the arrow on the right side of Steel joist type.

4. In the list that appears, select Girder.

5. Select the Section parameter.

6. Click the arrow on the right side of Section.

7. In the list that appears, select <New\Edit...> The Girder Section dialog
opens.

8. Either:

• Enter the girder properties and then click OK.

• Click Add if you want to add another girder section.

9. In the Properties window, adjust the remaining parameters according to
your needs.

Create a steel joist

1. Select the joist type and size.

2. Click the start point of the joist. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

3. Click the end point of the joist.

NOTE The ends of steel joists can be on different levels.

Move a steel joist

You can modify the joist position in both 2D and 3D views.

1. Select the joist.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.
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3. Click the grid or construction point where you want to move the end
node. 

Tekla Structural Designer moves the end node to the selected point.

Create portal frames
Tekla Structural Designer allows you to create both single-span and multi-span
portal frames. After creating the portal frame, you can modify the properties
of either the entire portal frame, or a portal frame member. For more
information, see the following paragraphs.

Create a single or multi-span portal frame
1. On the Model tab, click Portal Frame.

2. In the Properties window use Span Count to specify the number of
spans.

3. Click the start point of the first span of the portal frame. 

The start point sets the local X and Y coordinate origin for the portal
frame.

4. Click the end point of the last span of the portal frame. 

The start point defines the positive local X axis direction for the portal
frame.

NOTE The end point must lie in the same construction level as the start
point.

The Portal Frame dialog box opens.

5. On the Spans page, select the first span and click Edit...

6. Define the eaves level, select the frame type, and complete the frame
geometry for the span.

7. Click OK.

8. According to your needs, do one or all of the following:

• On the Rafters page, review the rafter section sizes.

• On the Columns page, review the column section sizes.

• On the Haunches page, specify eaves and apex haunches. See:Portal
frame haunch geometry (page 281)

• On the Bases page, specify the base fixity, and adjust the base levels
according to your needs.
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NOTE You can also specify bases as nominally pinned or nominally
fixed if required, as follows:

a. close the Portal Frame dialog box,

b. open the appropriate Support in the Portal Frame
Properties window,

c. set the Rotational stiffness x Type as nominally pinned or
nominally fixed,

d. enter the stiffness %

For more details, see: Partial fixity of column bases (page 316).

• Use the Valleys, Ties, Tie Members, Parapets, and Parapet
Members pages to specify any additional elements.

9. To create the portal frame, click OK.

Modify the properties of an existing portal frame
• According to your needs, do one of the following:

To Do this
Modify the overall frame properties 1. Hover the mouse pointer over the desired

portal frame, so that it becomes
highlighted.

2. Right-click the portal frame.

3. In the context menu, select Edit [element
name].

The Portal Frame dialog box opens.

4. Modify the properties according to your
needs.

5. Click OK.

Modify the properties of an individual portal
frame member

1. Hover the mouse pointer over the desired
portal frame member, so that it becomes
highlighted.

2. In the Select Entity tooltip, scroll until the
desired member is highlighted.

3. In the model, right-click the member.

4. In the context menu, select Edit [element
name].

The Properties dialog box opens.

5. Modify the properties according to your
needs.

6. Click OK.

Add copy or mirror spans in an existing portal frame
1. Open the Portal Frame dialog box (as described in the above topic).
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2. Go to the Spans page of the Portal Frame dialog box.

3. Use the available buttons to introduce additional spans: 

• To introduce a new span at the end of the frame, click Add.

• To insert a new span below the currently highlighted span, click Insert.

• To copy the currently highlighted span to a pre-existing target span,
click Copy...

• To mirror the currently highlighted span to a pre-existing target span,
click Mirror...

4. Click OK.

Portal frame haunch geometry

Eaves haunch dimensions

Apex haunch dimensions

Create cold-rolled sections
Tekla Structural Designer allows you to create multiple characteristic types of
cold-rolled sections. The types are track, stud, and joist (US), or eaves beam,
purlin, and rail (UK), depending on the language that you are using. For more
information, see the following paragraphs.
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RESTRICTION You can model and analyze cold-rolled in Tekla Structural Designer,
but cold-rolled sections are not designed.

Create cold-rolled sections

1. On the Model tab, click any steel member type, for example, Steel
Beam.

2. In the Properties window, set the Characteristic property to the desired
cold-rolled section type. 

The properties in the Properties window are updated to match the
selected cold-rolled section type.

3. In the Properties window, adjust the properties of the cold-rolled section
according to your needs.

4. Click the start point of the member. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

5. Click the end point of the member. 

Tekla Structural Designer creates the member.

Modify the position of a cold-rolled section
You can modify a cold-rolled section in both 2D and 3D views.

To move an entire cold-rolled section, see: Move and rotate objects (page 322).

1. Click the section that you want to modify.

2. Click the end node that you want to move.

3. Click the new position of the selected end node. 

The end node moves to the selected position.

Create wall and roof panels
Wall panels, also referred to as wind walls, allow you to apply loads calculated
by the Simple Wind Loading Generator and Wind Wizard to your structure.
Wall panels do not introduce any structural strength or stiffness to your
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structure. If you wish to introduce walls that resist gravity, or lateral loads, you
must define them as concrete walls.

Roof panels allow loads placed on a sloping plane to be decomposed back to
the supporting structure. Area loads on roofs can act either vertically, or
normal to the roof plane. To create and modify roof panels, see the following
instructions.

Create wall panels

RESTRICTION Note that:

• In order to define a wall panel, you must have already
defined the grid points that define the panel vertices.

• Wall panels must lie in a single plane. Otherwise, Tekla
Structural Designer will fail the panel during validation.

• The wall panel must consist of at least 3 points.

1. On the Model tab, click Wall Panel.

2. Click the start point of the panel.

3. Click the remaining points of the panel.

4. To define the end point of the panel, do one of the following:

• Double-click the end point.

• Click the end point, and click the start point again.

Tekla Structural Designer creates a wall panel between the selected
points.

Create wall panels with parapets

NOTE To ensure the wind analysis accounts for the parapet correctly, a wall
panel with a parapet should be modeled in two parts:

1. Create an ordinary wall panel up to the roof level

2. Create a second wall panel above the roof level and marking the
panel as a parapet

1. Open a frame view in which you want to create the wall.

2. Create the wall panel below the roof level normally.

3. Create the wall panel above the roof level normally. 

NOTE You may need to create a new construction level to define the top
level of the parapet.
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4. Press the Esc key.

5. Hover the mouse pointer over the second wall panel, so that it becomes
highlighted.

6. Click the second wall panel.

7. In the Properties window, select the Is a parapet wall option.

See also: Parapet wall panel load decomposition (page 1014)

Modify the properties of a wall panel
You can modify the properties of a panel wall in both 2D and 3D Views.

1. Hover the mouse pointer over the panel, so that i becomes highlighted.

2. Click the panel to select it. 

TIP If necessary, add further roof panels to the selection by holding
down the Ctrl key and clicking the panels.

3. Go to the Properties window.

4. Modify the properties according to your needs. 

Tekla Structural Designer automatically applies the changes to all the
selected panels.

Create roof panels

RESTRICTION Note that:

• In order to define a roof panel, you must have already
defined the grid points that define its outline.

• Roof panels must lie in a single plane. Otherwise, Tekla
Structural Designer will fail the panel during validation.

1. On the Model tab, click Roof Panel.

2. Click the start point of the panel.

3. Click the remaining points of the panel.

4. To define the end point of the panel, do one of the following:

• Double-click the end point.

• Click the end point, and click the start point again.

Tekla Structural Designer creates a roof panel between the selected
points.
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Modify the properties of roof panels
You can modify the properties of roof panels in both 2D and 3D Views.

1. Hover the mouse pointer over the panel, so that it becomes highlighted.

2. Click the panel to select it. 

TIP If necessary, add further roof panels to the selection by holding
down the Ctrl key and clicking the panels.

3. Go to the Properties window.

4. Modify the properties according to your needs. 

Tekla Structural Designer automatically applies the changes to all the
selected panels.

Ancillaries
Ancillaries enable the quick and efficient application of loading from ancillary
items such as ladders, stairs and pipework etc - that are not part of the main
structural frame.

What are ancillaries used for?
While primarily intended for use in industrial structures, some features
associated with ancillary loads are also beneficial to the AEC market - eg:

• Modeling of stairs in steel, concrete, and timber structures,

• The use of stairs in combination with inactive members.
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Ancillaries can also be used to model loads from:

• Walkways/Catwalks

• Ladders (with/without cages)

• Access Platforms

• Operating Platforms (Storage/Standard)

• Lines of Pipework

• Lines of Cable Tray

In Tekla Structural Designer each of the above types can be created in the
form of either a line, or area ancillary.

Line ancillaries

Line ancillaries can be defined horizontally, vertically or sloped. They are
created by selecting a series of support points in order to create a "run". Each
line has a defined width in a user defined plane (perpendicular to length).
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Area ancillaries

Area ancillaries can be defined horizontally, vertically or sloped. They are
created in the same way as a panel, by selecting the vertices of the area.
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Ancillary load default values
Each Line or Area Ancillary has default Dead Loads and Imposed/Live Loads
which can be preset to be project specific from the sub-pages under Loading
in Model Settings.
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The default values can be overridden when individual ancillaries are created.

NOTE For Pipework Operating & Testing Content Loadcase Types, you can
select whether these are considered as Dead or Imposed (Live) loads
from Model Settings > Loading > General.

Ancillary loadcases
Ancillary loads are created in dedicated loadcases which are automatically
added and removed as the loads are added/deleted. These dedicated
loadcases specifically aid combination building for Industrial design.
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Most types of ancillary load are created in the Ancillary Dead & Ancillary Live
(Imposed) loadcases. The two exceptions are lines of pipework which are
created in the Pipework Empty, Pipework Operating Content & Pipework
Testing Content loadcases, and lines of cable tray which are created in the
Cable Tray Empty & Cable Tray Content loadcases.

NOTE If working to Eurocodes,
the ancillary imposed
case Ψ and ɸ factors
default to Ψ1 = 1.0, Ψ2 =
0.9, Ψ3 = 0.8, ɸ = 1.0.

Some ancillaries may
require different values
in which case a new
imposed loadcase
should be manually
added with the desired
Ψ and ɸ factors. Then
when the ancillary load
is being created the
loads can be put into the
new loadcase instead of
the dedicated loadcase
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by changing the
Imposed Load
Loadcase in the
Properties window
from 'default' to that
required.

Ancillary load decomposition
All decomposed loads from ancillaries are present in the analysis and design.

Once loads are decomposed the ancillaries themselves play no further part in
analysis and design.

Line ancillary decomposition

Line ancillaries are treated as simply supported beams, spanning onto
supporting members/slabs.

Decomposition is in two stages from the line ancillary to its supports then
onwards.

In the below example the line ancillary is supported by a beam at one end and
a slab spanning perpendicular to the ancillary at the other. At the slab end,
stage 2 decomposition occurs to distribute the load on to beams supporting
the slab.
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Area ancillary decomposition

In the same way as a roof panel, an area ancillary has a span direction which
determines the load decomposition onto surrounding supporting members/
slabs.

Decomposition is in two stages from the area ancillary to its supports then
onwards.

In the below example the area ancillary is supported by a slab which spans in
the same direction as the ancillary.

The UDLs generated in the stage 1 decomposition are then decomposed on to
the members supporting the slab in stage 2.
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Create line ancillary loads

1. On the Model tab, click Line Ancillary.

2. In the Properties window,

a. If the load is to only span between two points, uncheck the
Continuous setting, otherwise leave it checked.

b. Enter the load width

c. Select the required Type.

d. Accept the default load values, or define your own.

e. Specify the remaining properties as appropriate to selected Type. 

NOTE 1. For walkways and platforms the presence of a guardrail
and channel height alters dead loading.

2. For lines of pipework/cable trays the height is displayed
and it can be visually reversed by checking the Reversed
property.
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3. Click the start point of the line.

4. Click the remaining points of the line.

5. Double-click to define the end point of the line.

6. Pick a reference point to define the ancillary plane. 

Tekla Structural Designer creates a line ancillary between the selected
points.

Create area ancillary loads

1. On the Model tab, click Area Ancillary.

2. In the Properties window,

a. The rotation angle defines the span direction measured relative to
the first two points clicked to identify the area.

b. Select the required Type.

c. Accept the default load values, or define your own.

d. Specify the remaining properties as appropriate to selected Type. 

NOTE 1. For walkways and platforms the presence of a guardrail
and channel height alters dead loading.

2. For lines of pipework/cable trays the height is displayed
and it can be visually reversed by checking the Reversed
property.
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3. Click the start point of the area.

4. Click the remaining points of the area.

5. To define the end point of the area, do one of the following:

• Double-click the end point.

• Click the end point, and click the start point again.

Tekla Structural Designer creates an area ancillary load between the
selected points.

Create an ancillary loads report
A table of the ancillary loads applied to the model is available in the Industrial
Structure Loading report, which is created as follows:

1. In the list on the left side of the Report toolbar, select Industrial
Structure Loading.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Equipment
Equipment is primarily intended for use in industrial structures, enabling the
quick and efficient application of loading from plant items, tanks & cylinders
etc. - that are not part of the main structural frame.
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Overview
Equipment can be displayed in Tekla Structural Designer in the form of a
sphere, vertical cylinder, horizontal cylinder or cuboid.
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Equipment has an associated Center of Gravity (CoG) which is indicated by the
user co-ordinate system (UCS) as shown above.

Equipment also has a number of support points through which load is
transferred to the structure. At least three support points are required and
there is no limit on the maximum. The area bounded by these support points
is referred to as the 'Loading Area'.

The support points are numbered and become active when the equipment is
selected. Unnumbered nodes at the mid-points of loading area edges also
become active.
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Equipment support points and loading area

Equipment

Loading area

Support points

Unnumbered node

NOTE Unnumbered nodes are provided to facilitate editing of the
Loading Area - they are not support points.

The 3D geometry, UCS and loading area can be switched on or off for each
equipment shape within Scene Content (page 68).

Once placed, equipment is listed in the Project Workspace Structure Tree
(page 58) under the Loading Elements group.

Modeling

Equipment must be defined in the horizontal plane.

Once it has been defined, you can alter the shape of the loading area by
dragging any of its nodes. Dragging a numbered support point moves it,
dragging an unnumbered node (as shown below) introduces a new support
point.
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By default the CoG of the equipment and the CoG of the support points
coincide. You can specify an offset to the equipment CoG to facilitate the
adjustment of equipment loads on the structure.
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Equipment must be placed in such a way that each support point is itself
supported by a structural item or slab item.

No member, ancillary, slab, wall or other equipment may be attached to an
equipment entity.

Equipment loadcases
Equipment loads have three dedicated gravity loadcases which are
automatically added and removed as the loads are added/deleted.

• Equipment Empty

• Equipment Operating Content

• Equipment Testing Content

These dedicated loadcases specifically aid combination building for Industrial
design.

NOTE For Equipment Operating & Testing Content Loadcase Types, you can select
whether these are considered as Dead or Imposed (Live) loads from Model
Settings > Loading > General.
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When equipment is added, initially the loads in the dedicated loadcases
default to zero. When the load is specified it can either be applied at the CoG
of the equipment, or at the equipment support points. This is important when
the CoG is different between the loaded and unloaded conditions.

Once equipment has been defined, additional horizontal or vertical point loads
can be applied to it in other dead and imposed/live loadcases.

The Equipment load command for
doing this is located in the Structure
Loads group on the Load toolbar.

Equipment load decomposition
All decomposed loads from equipment are present in the analysis and design.

Once loads are decomposed the equipment itself plays no further part in
analysis and design.

Equipment decomposition for loads applied at CoG

Decomposition is in two stages: from the equipment to the equipment
support points, then into the structure.

For each equipment, the load distribution distributes the total load
proportionately to the equipment support points based on an iterative
decomposition approach in which the loading area acts as rigid.
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NOTE The distribution of a point load applied to a rigid plate is a very
complex problem to solve, if done by FE then results are determined
by stiffness of the plate. The iterative approach is approximate but
believed to be sufficiently accurate for the purpose. If you do not want
to use this approach, the loads should be applied at supports instead.

In the following example equipment is placed on a one-way slab which spans
in the global X direction. The equipment has 4 support points positioned
symmetrically about the slab center-line. A load of 10kN is applied at the
equipment CoG.

When the model is analyzed the equipment load is decomposed to the
equipment support points, then on to the supporting members as shown
below.
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• Stage 1 - the 10kN load is decomposed to the 4 numbered support points,
due to symmetry these each receive 2.5kN.

• Stage 2 - support point loads are decomposed on to the members
supporting the slab. Again due to symmetry, the resulting member point
loads are each 2.5kN

If the CoG of the equipment is offset along the global X axis so that it now lies
at the edge of the loaded area, when the model is re-analyzed the
decomposed loads are updated as shown below:
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• Stage 1 - because the CoG has been offset, support points 2 and 3 each
receive 5kN whereas support points 1 and 4 remain unloaded.

• Stage 2 - support point loads are decomposed on to the members
supporting the slab, resulting in 2 point loads of 1.25kN on the left, and 2
point loads of 3.75kN on the right.

Equipment decomposition for loads applied at supports

In this case, only the second stage decomposition is required on to the
supporting members.

Create equipment and equipment loads
1. Open a 3D View, or 2D Level View in which to create the equipment. 

NOTE Equipment must be defined in a horizontal plane, and so cannot
be created in a 2D Inclined Plane View.
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2. On the Model tab, click  Equipment.

3. In the Properties window, define the equipment shape and size:

a. Select the required Type.

b. Enter the geometric properties (Length, Breadth, Height, or Diameter)
required to define the size.

c. Leave Base position, z as 0 to place the equipment directly on it's
loaded plane, or enter a non-zero value to raise/lower it.

d. Leave Angle to Global X as 0 , or enter an angle to rotate it.

4. In the Properties window, select whether the empty, operating content,
and testing loads are to be applied at the center of gravity of the
equipment, or through the supports.

5. Define the equipment load values:

• If applied At CoG, enter each value.

• If applied At Supports, click the ellipsis button then enter the
required value at each support.

6. In the 3D or 2D View, click the start point of the loaded area.

7. Click the remaining points of the loaded area.

8. To define the end point of the loaded area, do one of the following:

• Double-click the end point.

• Click the end point, and click the start point again.

NOTE At least three support points are required, no limit on maximum.

Tekla Structural Designer creates the equipment positioned at the center
of gravity of the loaded area.

Create additional equipment loads in other loadcases
Once equipment has been defined you can apply additional loads to it in
loadcases other than the dedicated 'equipment' ones. These loads can be
applied in any global or local direction.

1. In the Loading list, select an appropriate loadcase. 

NOTE This cannot be one of the existing dedicated 'equipment'
loadcases.

2. On the Load toolbar, click  Equipment.

3. In the Properties window, select the load direction.
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4. In the Properties window, select whether the load is to be applied at the
center of gravity of the equipment, or through the supports.

5. Define the load value:

• If applied At CoG, enter the load value and the Offset from mid
height above or below the loaded area at which the load is to be
applied.

• If applied At Supports, click the ellipsis button then enter the
required value at each support.

6. In a 2D or 3D View, pick the equipment to apply the load to.

Create an equipment loads report
A table of the equipment loads applied to the model is available in the
Industrial Structure Loading report, which is created as follows:

1. In the list on the left side of the Report toolbar, select Industrial
Structure Loading.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Inactive members
Single span members can be made inactive for analysis and design while still
being kept in the model for load distribution and for determination of effective
lengths.

This feature is particularly useful for industrial structures, as frequently not all
the secondary beams are included in the analysis and design model, but they
are still required to distribute load in the structure and act as restraints to
supporting members.

An inactive member is totally ignored in the solver model as is any load carried
by it. Therefore, to allow the load to be distributed it is instead decomposed to
nodal forces in a pre-analysis decomposition stage - this happens for all
applied loads on inactive members on the basis of the members being simply
supported.
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Which members can be made inactive?
Only single span beams, braces, analysis elements, purlins and rails have the
potential to be inactive. They each have an Active setting in the properties
which defaults to 'on' but can be unchecked.

NOTE Members cannot be made inactive if:

• they are multi-span, or,

• they support another member (active or inactive)

To make a member inactive
By selecting the Show/Alter State Active (page 727) attribute in a Review View,
inactive members are color coded allowing the active/inactive setting to be
toggled graphically.

Alternatively, you can change the setting manually in the Properties window
as follows:

1. Select the member in a 2D or 3D view.

2. In the Properties window deselect Active.

Inactive member load decomposition
The first stage of load decomposition treats active and inactive members in
exactly the same way.

This is then followed by a second stage of load decomposition for the inactive
members only, as follows:

• End reactions are calculated for the inactive members.

• These are then applied as nodal forces to the supporting members.

After decomposition has taken place analysis can proceed with the inactive
members removed from the solver model.

In the below example, by using the Show/Alter State Active (page 727) attribute
one beam has been made inactive. The view shows decomposed loads - note
that the inactive beam still has slab load decomposed to it in the same way as
the active beams (as a result of the first decomposition stage).
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The effects of the second decomposition stage can be seen by switching to a
Results View showing major moments.
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In the second stage the end reactions of the inactive beam have been applied
as nodal forces to the supporting edge beams in the first bay causing
moments to be generated in them, (without this second stage the two
supporting beams would have otherwise been completely unloaded.)

No moments are generated in the inactive beam itself because after the
decomposition has taken place it does not exist in the solver model.

Typical usage cases for inactive members
There are potentially many uses for inactive members, the following being
some examples.

Industrial Structures

Inactive members can be used in conjunction with ancillaries in order to apply
loads to the structure while not themselves participating in the analysis.

In the below example an area ancillary decomposes load on to two inactive
beams, which is then applied as nodal forces on to the supporting members.
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Purlins and Rails

In large portal sheds, purlins and rails may be included in the model to act as a
means of load distribution; the engineer would not want to see the forces in
them when reviewing forces in the main structural members, or consider the
small axial loads that develop in purlins and rails when gravity loadcases are
analysed.

By setting the purlins and rails to be inactive these goals are achieved.

This is demonstrated in the below example - in the top view the purlins are
rails are active, consequently small forces develop in them in gravity
combinations and the results views are quite clutterred with values that are of
no interest to the engineer.
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In the second view the purlins and rails have been set inactive, providing a
clearer display and showing the values the engineer would expect/assume
from such a combination.

Grouped Design

Design can be speeded up by enabling group design and limiting the number
of active members in a group.

This is demonstrated in the below example of a regular floor, all beams in the
group apart from one have been made inactive which significantly reduces the
design time.
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NOTE When making the non-critical beams inactive to speed up design:

• You are responsible for choosing critical beam(s)

• Primary beams cannot be set to inactive

To support stairs at a slab edge

If an area ancillary stair spans onto a slab edge, in order to decompose the
stair load on to the slab you can add an inactive member along just that part
of the slab edge to which the stair attaches.
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Provided that the slab is meshed for 3D analysis, the inactive member
provides a load path - the load becomes point loads on slab at each end
inactive member (i.e. at the edges of the stair).
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Create supports
Supports allow you to constrain points in your structure vertically and
rotationally. You can use supports to model connections to existing structures,
so that you do not need to incorporate them in your current model. In
addition, you can change the fixity provided at an existing support by
modifying the support properties.

Create a single support

RESTRICTION You can only place supports at existing grid points.

1. On the Model tab, click Support. 

The support will adopt the properties currently displayed in the
Properties window.

2. If necessary, in the Properties window, adjust the support properties.

3. Click the grid point where you want to create the support.
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Create a rotated support using 3 grid points
You can apply a local coordinate system to your supports, allowing the X and Y
axes to be rotated about global the Z axis.

NOTE The z direction of the support cannot be changed.

1. On the Model tab, click Support.

2. Go to the Properties window.

3. Ensure that the 3 Grid Points option is selected.

4. Click the grid point where you want to create the support.

5. To define the support direction along the x axis, click a second grid point.

6. To define the support direction along the y axis, click a third grid point.

Create spring supports
You can create linear and non linear spring supports in a similar fashion.

1. On the Model tab, click Support.

2. Go to the Properties window.

3. Ensure that in the direction where you want the spring to act, the degree
of freedom is set to Free.

4. In the appropriate stiffness properties, do one of the following:

• Select the Spring Linear option, and define a single stiffness value that
acts in both the positive and negative directions.

• Select the Spring Non-linear option, and define two stiffness values,
one to act in the positive direction and another to act in the negative
direction.

5. Click the grid point where you want to create the support.

Create nominally pinned or nominally fixed supports
A support placed under a column is a special case which can be specified as
nominally pinned, or nominally fixed if required.

NOTE A validation error is produced if a nominally pinned or nominally fixed
support is placed at any other location.

1. On the Model tab, click Support.

2. Go to the Properties window.
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3. Ensure that the Mx and/ or My directions about which you require partial
fixity are set to Free.

4. In the appropriate rotational stiffness properties, do one of the following:

• Select the Nominally pinned option, and define the required stiffness
value as a percentage of the column stiffness 4EI/L.

• Select the Nominally fixed option, and leave the stiffness value as
100% of the column stiffness 4EI/L.

5. Click the grid point where you want to create the support.

For more information, see: Partial fixity of column bases (page 316)

Modify support properties
You can modify support properties in both 2D and 3D views.

1. Hover the mouse pointer over the desired support, so that it becomes
highlighted.

2. Click the support. 

TIP You can add further supports to the current selection by holding
down the Ctrl key and clicking the additional supports.

3. Go to the Properties window.

4. Modify the support properties according to your needs. 

Tekla Structural Designer automatically applies any changes to the
selected supports.

Partial fixity of column bases
Two additional types of rotational linear spring are provided to allow partial
fixity to be modelled, these are:

• Nominally pinned

• Nominally fixed

These are specifically provided for supports under columns (of any material),
but will result in a validation error if placed under walls, or if they are used for
any other supports.

The support stiffness is based on the column properties (E*I/L)

• E = Young’s Modulus of the column

• I = relevant bending stiffness (Ixx or Iyy) of the column

• L = distance from the support to the first column point (stack) that is on a
Construction Level checked as a Floor in the Levels dialog, i.e. combined
length of all the stacks until a floor is found.
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NOTE Where no Floor has been defined in the column above the support,
then L is taken as total length of column.

Partial fixity spring stiffness is calculated as follows for each of the two
bending releases Mx and My:

• Nominally pinned (spring stiffness) - x% * 4 * E*I/L (default x% = 10%)

• Nominally fixed (spring stiffness) - x% * 4 * E*I/L (default x% = 100%)

Since the spring stiffness is dependent upon stack height and column stiffness
(E and I), the spring stiffness will change if any changes are made to column
stack height, column E or I values.

In addition, since for steel, Auto Design can change the column size (and hence
I value) the spring stiffness will change with any change in column size.

Create analysis elements
Linear and non-linear elements and springs can be modeled in Tekla
Structural Designer as analysis elements.

See also

Analysis Element properties (page 1020)

Element types (page 318)

Create analysis elements

1. On the Model tab, click Element.

2. In the Properties window, select the Element type (page 318) that you
require.

3. In the Properties window, adjust the material and/or properties of the
element according to your needs.

4. Click the start point of the element. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

5. Click the end point of the element. 

Tekla Structural Designer creates the element.
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Create analysis element springs

1. On the Model tab, click Element. 

The element will adopt the properties currently displayed in the
Properties window.

2. In the Properties window, select the spring Element type (page 318) that
you require.

3. Enter the the material and properties of the element according to your
needs.

4. Click the start point of the element. 

TIP If you are using a point along a member, do the following:

a. Click the member to view its points.

b. Click the point that you want to use, or type the distance from
the start of the member to the desired point.

5. Click the end point of the element. 

Tekla Structural Designer creates the element.

6. Select the newly created element.

7. In the Properties window, enter the spring stiffness properties that you
require.

Modify the position of analysis elements
You can modify the position of an individual analysis element in both 2D and
3D views.

1. Select the element that you want to move.

2. Select the end node that you want to move. 

NOTE Ensure that only the desired end node is highlighted in the Select
Entity tooltip.

3. Click the grid or construction point where you want to move the end
node. 

Tekla Structural Designer moves the end node to the selected point.

Element types
This topic introduces the different element types available when creating
Analysis Elements
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Beam

The Beam element type is defined as a 2 node element with 6 potential
releases; 3 translational (Fx, Fy, Fz) and 3 rotational (Mx, My, Mz); at each end.

Material properties and the following section properties are required:

• Ax

• A parallel to minor

• A parallel to minor

• Ix

• I major

• I minor

Truss

The Truss element type is defined as a 2 node element which has axial (Fx)
fixity at each end. The remaining 5 degrees of freedom; 2 translational (Fy, Fz)
and 3 rotational (Mx, My, Mz); are released at each end.

Material properties and the area of the section are required.

This element type acts in both tension and compression.

Tension only

The Tension only element type is defined as a 2 node element which has axial
(Fx) fixity at each end. The remaining 5 degrees of freedom; 2 translational (Fy,
Fz) and 3 rotational (Mx, My, Mz); are released at each end.

Material properties and the area of the section are required.

This element type acts in tension only.

NOTE Tension only and Compression only members are non-linear elements and
therefore require non-linear analysis. If linear analysis is performed they will
be treated as linear elements

Compression only

The Compression only element type is defined as a 2 node element which
has axial (Fx) fixity at each end. The remaining 5 degrees of freedom; 2
translational (Fy, Fz) and 3 rotational (Mx, My, Mz); are released at each end.

Material properties and the area of the section are required.

This element type acts in compression only.

NOTE Tension only and Compression only members are non-linear elements and
therefore require non-linear analysis. If linear analysis is performed they will
be treated as linear elements
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Linear axial spring

The Linear axial spring element type is defined as a 2 node element which
has axial (Fx) fixity at each end. The remaining 5 degrees of freedom; 2
translational (Fy, Fz) and 3 rotational (Mx, My, Mz); are released at each end.

An axial Spring Stiffness property is required.

This element type acts in both tension and compression.

Linear torsional spring

The Linear torsional spring element type is defined as a 2 node element
which has torsional (Mx) fixity at each end. The remaining 5 degrees of
freedom; 3 translational (Fx, Fy, Fz) and 2 rotational (My, Mz); are released at
each end.

A rotational Spring Stiffness property is required.

Non-linear axial spring

The Non-linear axial spring element type is defined as a 2 node element
which has axial (Fx) fixity at each end. The remaining 5 degrees of freedom; 2
translational (Fy, Fz) and 3 rotational (Mx, My, Mz); are released at each end.

Seperate tension and compression Spring Stiffness properties are required
and also the maximum tension and compression values.

NOTE Non-linear elements require non-linear analysis. If linear analysis is
performed they will be treated as linear elements.

Non-linear torsional spring

The Linear torsional spring element type is defined as a 2 node element
which has torsional (Mx) fixity at each end. The remaining 5 degrees of
freedom; 3 translational (Fx, Fy, Fz) and 2 rotational (My, Mz); are released at
each end.

Seperate tension and compression torsional Spring Stiffness properties are
required and also the maximum torsional tension and compression values.

NOTE Non-linear elements require non-linear analysis. If linear analysis is
performed they will be treated as linear elements.

Link

A basic link element is implemented in Tekla Structural Designer, defined as a
2 node element with 6 springs; 3 translational (Fx, Fy, Fz) and 3 rotational (Mx,
My, Mz); at end 2.

This element type is used internally to effect partial fixity in beams.
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4.3 Edit the model
After creating the model and the necessary members within it, you may need
to make some modifications.

For example you may want to:

• Edit the properties of (page 168) entities

• Re-position entities (page 169) by moving nodes or edges

Additional model editing commands are located on the Edit tab, these allow
you to:

• copy objects (page 321) and loads

• move objects (page 322) or move the model

• mirror objects (page 322)

• delete objects (page 329)

• join and split members

• Automatically join all concrete beams (page 331)

• Reverse member axes and panel faces (page 332)

• use cutting planes to hide a part of your model

• remove any unused unused slopes, frames, construction and grid lines

• merge planes (page 337)

• Rationalize the model (page 335)

• create infill members

• edit or add free points

Copy and rotate objects
To copy, or copy and rotate objects, see the following instructions.

1. Select the objects that you want to copy.

2. On the Edit toolbar, click Copy.

3. If you want to rotate the object when you copy it, in the Properties
window, type the rotation about the Z axis.

4. Click the reference node.

5. Click the point where you want to copy the reference node. 

Tekla Structural Designer moves the selected member to the new
location, and rotates them according to the specified rotation value.

6. Place more copies in your model, or press Esc to finish.
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Move and rotate objects
To move, or move and rotate objects, see the following instructions.

1. Select the objects that you want to move.

2. On the Edit toolbar, click Move.

3. If you want to rotate the object while moving it, in the Properties window,
type the rotation about the Z axis.

4. Click the reference node.

5. Click the point where you want to move the reference node. 

Tekla Structural Designer moves the selected member to the new
location, and rotates them according to the specified rotation value.

Mirror objects to new locations
To copy existing elements by mirroring them, see the following instructions.

1. Select the objects that you want to mirror.

2. On the Edit toolbar, click Mirror.

3. In the Properties window, select the desired Mirror mode:

• Along Y axis mirrors the objects about a global XZ plane defined by a
single reference point.
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• Along X axis mirrors the objects about a global YZ plane defined by a
single reference point.
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• Pick mirror plane mirrors the objects about a plane defined between
two points.
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• Pick destination point mirrors the objects about a plane which
perpendicularly bisects a line defined between two points.
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4. In the model, click the reference points.

5. If you are using the Pick mirror plane or Pick destination point mode,
click the second point to define the mirror plane.

See also

Copy and rotate objects (page 321)

Copy loads
Tekla Structural Designer allows you to quickly apply the same loads to
multiple members by using the Copy Loads command.

Copy all member loads from one span to another
1. On the Edit toolbar, click Copy Loads.

Create models 326 Edit the model



2. Go to the Properties window.

3. Set Mode to Copy Span Loading.

4. Select whether you want to copy loads in the current loadcase or in all
loadcases. 

NOTE If you select the current loadcase, remember to select the
required loadcase in the (page 55).

5. In the model, click the span that contains the member loads that you want
to copy.

6. Click the span that you want to apply the loads to. The source span and
the destination span do not need to be the same length. 

Tekla Structural Designer copies the member loads to the selected span.

7. Do one of the following:

• Click additional spans to continue applying the loads.

• Press Esc to select a different loaded element span to copy loads from.

• Press Esc twice to finish.

Only copy one member load to another span
1. On the Edit toolbar, click Copy Loads.

2. In the Properties window, set Mode to Copy Member/Area Load.

3. In the model, click the member load that you want to copy.

4. Click the span that you want to apply the load to. The source span and the
destination span do not need to be the same length. 

Tekla Structural Designer copies the member load to the selected span.

5. Do one of the following:

• Click additional spans to continue applying the loads.

• Press Esc to select a different load to copy.

• Press Esc twice to finish.

Copy panel area, level, and slab loads
1. On the Edit toolbar, click Copy Loads.

2. In the (page 55), select the desired loadcase.

3. In the Properties window, set Mode to Copy Member/Area Load.

4. Click the area, slab, or level load that you want to copy.
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5. Click the panel that you want to apply the load to. 

Tekla Structural Designer copies the load to the selected panel.

6. Do one of the following:

• Click additional panels to continue applying the loads.

• Press Esc to select a different load to copy.

• Press Esc twice to finish.

Copy panel point, line, and patch loads
1. On the Edit toolbar, click Copy Loads.

2. In the (page 55), select the desired loadcase.

3. In the Properties window, set Mode to Copy Plane Loads.

4. Click the panel point, line, or patch load that you want to copy. 

TIP If necessary, you can click to add other loads to the selection, or
remove them from the selection by clicking them once more.

A red circle indicates the original reference point for the selected loads.

5. To apply the loads, do one of the following:

• Click a panel node to define a new reference point at that node.

The loads are applied at the same offset from the new reference point.

• Click anywhere within a panel boundary at a different level to define a
new reference point directly above or below the original reference
point.

The loads are applied at the same offset from the new reference point.

WARNING If you choose a new reference point that results in the
loads being applied outside the panel area, Tekla
Structural Designer does not apply the loads to the
model. In this situation, a warning appears during
validation.

6. Do one of the following:

• Click to define further reference points to continue applying the
loads. .

• Press Esc to select a different loads to copy.

• Press Esc twice to finish.
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Copy structure loads
1. On the Edit toolbar, click Copy Loads.

2. In the Properties window, set Mode to Copy Member/Area Load.

3. In the model, click the structure load to be copied.

4. Click the position you want to apply the load to. 

Tekla Structural Designer copies the load to the new location.

5. Do one of the following:

• Click additional locations to continue applying the load.

• Press Esc to select a different load to copy.

• Press Esc twice to finish.

Copy loads to another loadcase
1. On the Edit toolbar, click Copy Loads.

2. In the (page 55), select the loadcase from which you want to copy the
loads.

3. Go to the Properties window.

4. Set Mode to Copy Loads to another Loadcase.

5. Select the loadcase that you want to copy the loads to.

6. In the model, click the load that you want to copy. 

TIP If necessary, you can click to add other loads to the selection, or
remove them from the selection by clicking them once more.

7. To copy the loads to the loadcase displayed in the Properties window,
press Enter.

8. Do one of the following:

• Press Esc to select additional loads, and then press Enter to copy
them.

• Press Esc twice to finish.

Delete entities
1. Do one of the following:

To Do this
Delete using the keyboard • Select the entity.

• Press Delete

Delete using the Quick Access toolbar • Select the entity.
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• From the Quick Access toolbar choose
Delete

Delete using the context menu • Right click the entity you want to delete.

• From the context menu choose Delete
Element

Delete from the Edit ribbon • Select the entity.

• From the Edit ribbon choose Delete

Join and split members
You can use the Join command for joining discontinuous members, thus
creating a continuous member. The Split command, on the other hand, allows
you to split continuous members of any material.

See also

Automatically join all concrete beams (page 331)

Join members
You can use the Join command to manually join concrete beams, even when
the Allow automatic join end options are not selected. This is because the
Allow automatic join end only applies to the automatic joining that occurs
during design process or when you run the Beam Lines command.

RESTRICTION You can only join:

• Two similar members if that the angle between the
members is less than 45 degrees in both plan and
elevation.

• Beams that have an end point in common.

If Tekla Structural Designer fails to join two beams, their
end points have probably been defined using different
construction or grid lines.

1. On the Edit toolbar, click  Join.

2. Hover the mouse pointer over the member that you want to join to
another member. 

Both the original member and the member to which it will be joined
become highlighted. The point where they will be joined is indicated by a
red dot.

NOTE If Tekla Structural Designer tries to join the wrong end, move the
mouse pointer towards the other end of the member until Tekla
Structural Designer indicates the correct end.
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3. Click the highlighted members to join them.

4. Click additional members to join them, or press Esc to finish.

Split members

RESTRICTION You can only split members that have previously been joined.

1. On the Edit toolbar, click Split.

2. Hover the mouse pointer over previously joined members that you want
to split. 

The member is highlighted, and Tekla Structural Designer uses a red dot
to indicate the point where the member will split.

3. According to your needs, do one of the following:

• Click the member to split it at the indicated point.

• Move the mouse pointer further along the member to identify other
points where the member could be split.

NOTE If the member being split is a concrete beam, Tekla Structural
Designer splits the member into two separate beams. The first
beam has the Allow automatic join end 2 option cleared,
whereas the second one has the Allow automatic join end 2
option cleared. This prevents Tekla Structural Designer from
automatically making the two beams continuous again when the
model is designed.

Automatically join all concrete beams
Tekla Structural Designer automatically forms concrete beam lines as part of
the combined analysis and design process. However, if you would prefer to
have greater control yourself, you can run the Beam Lines command
manually. This way, you can verify that continuous beam lines are formed as
you intend before proceeding with the design.

When run manually, the Beam Lines command applies to all concrete beam
members in the model, irrespective of whether they are selected or not.

NOTE Discontinuous concrete beam ends can only be joined if the Allow
automatic join end option is selected for the appropriate beam ends
at the join. Then, Tekla Structural Designer only joins the ends if all the
following criteria are met:

• The angle in plan at which the two beams meet is less than the
Limiting join angle in plan specified in Model Settings --> Beam
Lines
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• The angle in elevation at which the two beams meet is less than
the Limiting join angle in elevation specified in Model Settings --
> Beam Lines

• The amount by which the cross sectional areas of the two beams
overlap is greater than the Minimum section overlap percentage
specified in Model Settings --> Beam Lines

In addition, if either of the two beam ends being joined is pinned,
Tekla Structural Designer does not join them unless the Join pinned
beam end option is selected in Model Settings --> Beam Lines.

To join the concrete beams in the model automatically, do the
following:

• On the Edit tab, click Beam Lines.

See also

Join and split members (page 330)

Reverse member axes and panel faces
Sometimes when creating a model, you may end up creating beams or wall
panels that run or face in the wrong direction. This may lead to problems in
the analysis phase. In order to fix these kinds of inconsistencies, you can use
the Reverse command.

Reverse the local axis of a beam
You can easily end up with beams running forwards and backwards if a
consistent approach has not been adopted when selecting start and end
nodes. Beams that run in different directions can result in confusing force
diagrams. By manually reversing the axes of beams, you can make all beams
run left to right and bottom to top in a plan view.

To reverse a beam, do the following:

1. On the Edit toolbar, click Reverse.

2. Click a beam to reverse its direction.

Reverse the outward face of a wind panel
The front of each wall should be facing outwards in order to correctly
determine the wind direction relative to the wall. Ensure that all the outward
faces are displayed in the color assigned to the front of the wind wall.

If a wall is facing in the wrong direction, reverse it by doing the following:
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1. On the Edit toolbar, click Reverse.

2. Click a wind panel to reverse its direction.

Manage cutting planes
Initially, the six cutting planes form a cube around the extents of each model.
By activating a cutting plane, you can move it inwards so that it slices through
the model. Everything on the positive side of the plane is temporarily hidden
from the view, making it easier to work on different areas inside the model.

Activate or deactivate a cutting plane
The active cutting plane faces are shown in a different colour. (By default blue
indicates the positive side of the plane and red the reverse side).

1. On the Edit toolbar, click Cutting Planes. 

Tekla Structural Designer displays the six existing cutting planes.

2. Click a cutting plane to activate it. 

Tekla Structural Designer displays the positive side of the plane in blue,
and the reverse side in red.

TIP To deactivate a cutting plane, click an active plane again.

Move a cutting plane to hide a part of the model
When a cutting plane is active, an arrow projects from its center. You can use
the arrow to reposition the plane.

1. Click the arrow at the center of the cutting plane. 

Tekla Structural Designer views a line that indicates the direction in which
you can move the plane.

2. Click the desired position of the plane, or press F2 to type the exact
distance. 

Tekla Structural Designer redraws the cutting plane at its new position.
The cutting plane slices to the model, and everything to the positive side
of the plane is hidden.
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Re-display a hidden part of the model
• Click the cutting plane to deactivate it. 

Tekla Structural Designer displays any previously hidden parts of the
model.

Move the model or the DXF shadow
If necessary, you can relocate the entire model to a new coordinate in the XY
plane by using the Move Model. You can relocate the DXF shadow of the
model similarly with the Move DXF Shadow command.

Move the model
In order to move the model, you first have to decide which reference point to
use.

You can determine the reference points by drawing an imaginary box aligned
to X and Y around the extents of the model, as shown in the following image:

Bounds Corner equals the lower left hand corner of the imaginary box,
whereas Bounds Centroid equals the centroid of the imaginary box.

1. On the Edit toolbar, click Move Model.

2. Set the reference point to either Bounds Corner or Bounds Centroid.

3. Enter the required target coordinate of the reference point.

4. Click Move.
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Move the DXF shadow
The Move DXF Shadow command is only available if you have previously
imported a DXF shadow (page 116).

1. On the Edit toolbar, click Move DXF Shadow.

2. Select an existing point in the DXF shadow as the reference point.

3. Click the new position of the reference point.

Rationalize the model
In order to remove all unused sloped planes, frames, grids, and construction
lines in your model, you can use the Rationalize command. If necessary, the
Rationalize command also allows you to update all grid and construction lines
to extend only a short length beyond the point where they are required. After
running the command, you can see a summary of the changes in the Process
Window.

Delete unused sloped planes, frames, grids, and construction lines
1. On the Edit toolbar, click Rationalize. 

The Rationalize dialog box opens.

2. Select the unused items that you want to remove.

3. Click OK. 

Tekla Structural Designer deletes the unused items of the selected types,
and their associated items.

Update grid and construction line length
1. On the Edit toolbar, click Rationalize. 

The Rationalize dialog box opens.

2. Select Shrink/Extend Grid & Construction lines.

3. Click OK. 

Tekla Structural Designer updates all grid and construction lines in the
model to extend a fixed length (500 mm / 1'8") beyond the point where
they are required.
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Create infill members
In order to quickly place a pattern of infill members into selected plays in a
level, sloped plane, or frame, you can use the Create Infills command. Note
that only the bays with members attached to all sides can be selected.

RESTRICTION You cannot create infills in 3D views.

Define the infill properties and pattern

1. On the Edit toolbar, click Create Infills.

2. Go to the Properties window.

3. In Define Beams, select one of the following:

• By number allows you to specify the number of equally spaced
members in the pattern.

• By spacing allows you to specify the exact positions of the beams,
separating them by a comma.

• By max spacing allows you to create as many equally spaced beams
in the pattern as possible without exceeding the max spacing.

4. In Direction, select one of the following:

• Perpendicular allows you to have the members drawn perpendicular
to the highlighted edge member.

• Parallel with left allows you to have the members drawn parallel to
the edge member that connects to the end 1 of the highlighted edge
member.

• Parallel with right allows you to have the members drawn parallel to
the edge member that connect to the end 2 of the highlighted edge
member.

5. Define the element parameters according to your needs. 

TIP If you have saved infill properties to a named property set, you can
recall them by selecting the set in the drop list at the top of the
Properties window.

Place the pattern in a single bay
1. Hover the mouse pointer over the required bay, adjacent to the required

edge member.

2. If necessary, change the orientation by moving the cursor to a different
edge member, or by adjusting the general parameters in the Properties
window.
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3. Click the bay to create the pattern.

Place the pattern in multiple bays
1. Hover the mouse pointer over one of the bays, adjacent to the required

edge member.

2. If necessary, change the orientation by moving the cursor to a different
edge member, or by adjusting the general parameters in the Properties
window.

3. Click the bays in which you want to create the pattern.

Merge planes
Where a model contains very close planes, as can often occur in imported
models, for example, the Merge Planes command allows the you to merge two
planes by selecting a destination plane and then a source plane.

1. On the Edit toolbar, click Merge Planes. 

Existing Level, Frame, and Slope planes are displayed in the active view.

NOTE If the view is cluttered by having all the plane types displayed
simultaneously, and you only want to merge Levels, consider
switching off Frames and Slopes in Scene Content.

2. Pick the destination plane.

3. Pick the source plane. 

If the planes can be merged, everything on the source plane will be
moved to the destination plane, and the source plane will be deleted. If
the merge is not possible, a message is given in the Process window and
the model will be unchanged.

Create and manage free points
Free points can be used to connect beams, columns, braces etc. without
having to define an intersection between grid lines or construction lines.

NOTE Once a free point has an item connected to it, if the item is moved a
new point is created and the existing free point remains.
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Create a free point
A frame is a 2D View of the model, created in a vertical plane defined by an
existing grid line. Since only the members that lie within the plane of the frame
are displayed, a frame view can be particularly useful for defining bracing.

1. Make sure that Free Points are visible in Scene Content.

2. Right click in the view and pick Add free point... from the context menu.

3. Enter the point co-ordinates and click OK.

Adding, moving or deleting free points from the Edit tab
1. On the Edit tab, click Free Points... 

A Free Points dialog is displayed.

2. Click Add to add a new point, Delete to remove an existing point, or click
in the table to edit the co-ordinates of existing points.

Related video

Free point defined by XYZ coordinates

4.4 Validate the model
You can validate the model at any time in order to trap errors that will cause
the solver to fail before the model is submitted for analysis. Validation is also
automatically performed during design.

NOTE You can also measure distances and angles (page 339) to check your
modeling.

Run model validation

• On the Model or Load tab, click Validate. 

Tekla Structural Designer performs the validation checks. If your model
contains any issues, warning messages appear.

Adjust the conditions considered in model validation

1. On the Home tab, click Model Settings.
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2. Go to the Validation page.

3. Select the conditions that you want Tekla Structural Designer to consider
during validation checks.

4. Click OK.

Measure distances and angles
To know the exact distances or angles between different points in the model,
you can use the Tekla Structural Designer measuring commands. You can find
the measuring commands on the Model tab, in the Miscellaneous group.

Measure distances
To measure the distance between any two points in the model, see the
following instructions.

1. On the Model tab, click Measure.

2. Click a node to define the start position.

3. Click a second node to define the end position. 

The distance between the nodes is displayed in the current view. To clear
the measurement, press Esc.

Measure angles

RESTRICTION You can only measure angles in 2D Views.

1. On the Model tab, click Measure Angle.

2. Click a node to define the arc center.

3. Click a second node to define the start position.

4. Click a third node to define the end position. 

The clockwise angle between the start and end position is displayed in the
current view. To clear the measurement, press Esc.
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5 Apply loading

The Load tab allows you to:

• Manage loadcases, groups, combinations, envelopes and patterns
(page 340)

• Apply panel, member, and structure loads (page 364)

• Apply wind, snow, and seismic loads (page 387)

5.1 Manage loadcases, groups, combinations, envelopes
and patterns
Loadcases, groups, combinations and envelopes are all managed in the
Loading dialog (page 357). Load patterns are reviewed via Update Patterns
on the Load tab.

• Manage loadcases (page 340)

• Manage load groups (page 342)

• Manage load combinations (page 344)

• Manage load patterns (page 353)

Manage loadcases
Before applying loads to your model, you must first define the loadcases
within which the loads will be contained.

To define loadcases, see:

• Create loadcases (page 341)

• Activate reductions in live or imposed loadcases (page 341)

• Renumber all loadcases (page 342)
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Create loadcases
When you create a new model, Tekla Structural Designer automatically creates
a loadcase whose type is Self weight - excluding slabs. You cannot access the
loadcase because Tekla Structural Designer automatically calculates the loads
within it using the objects in your structure. Tekla Structural Designer also
creates three other loadcases that are initially empty. However, you will almost
certainly need to create other loadcases that contain the loads that your
building must withstand.

1. On the Load tab, click Loadcases. 

The Loading dialog (page 357) opens on the Loadcases page. On this
page, you can see all currently existing loadcases.

2. Click Add.

3. In Loadcase Title, name the loadcase.

4. In Type, select the desired loadcase type.

5. Select whether the loadcase is included when you automatically generate
load combinations.

6. Click OK. 

Tekla Structural Designer adds the new loadcase to the list of loadcases in
the Loading list.

Activate reductions in live or imposed loadcases
When you create a loadcase whose type is Live (US) or Imposed (other head
codes), you can allow Tekla Structural Designer to automatically calculate load
reductions in accordance with the percentages specified on the Load
reductions page in Model Settings. To do so, see the following instructions.

Activate reductions in live and roof live loadcases (US)

1. On the Load tab, click Loadcases. 

The Loading dialog (page 357) opens on the Loadcases page. On this
page, you can see all currently existing loadcases.

2. Select the Live or Roof Live loadcase to which you want to apply the
reductions.

3. Select the Live Load Reductions option.

4. Click OK.
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Activate reductions in imposed loadcases (other head codes)

NOTE You cannot activate reductions in loadcases whose type is set to Roof
Imposed.

1. On the Load tab, click Loadcases. 

The Loading dialog (page 357) opens on the Loadcases page. On this
page, you can see all currently existing loadcases.

2. Select the Imposed loadcase to which you want to apply the reductions.

3. Select the Imposed Load Reductions option.

4. Click OK.

Renumber all loadcases
When you delete loadcases from the Loading dialog (page 357), the remaining
loadcases retain their original loadcase number. If necessary, you can
renumber the remaining loadcases in sequence.

For more information, see the following instructions.

1. On the Loading tab of the Project Workspace, right-click Loadcases.

2. In the context menu, select Renumber.

Manage load groups
Load Groups facilitate the generation of combinations (primarily for design of
industrial structures where many loading scenarios must be considered).

To manage load groups, see:

• Overview of load groups (page 342)

• Create load groups (page 343)

• Inclusive and exclusive load groups example (page 344)

Overview of load groups
Features of load groups

• Load Groups are an aid to building Combinations - both manually and
using the Generator - and their use is entirely optional.

• Once a Combination is built using Load Groups, the link to the Load Group
is lost – the Combination is made up only of Loadcases. Only Loadcases
and Combinations are analysed – Load Groups are not.
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• Each Load Group holds items of a single load type - e.g. “Dead” or
“Live”...etc. - and can contain both multiple loadcases and other Load
Groups

• The fundamental Load Groups setting is the “Class” which is either
“Inclusive” or “Exclusive”

• When “Inclusive” – all loadcases are added at once into a combination

• When “Exclusive” – loadcases are used one at a time in combinations.
Thus for example, where an Exclusive Load Group contains four
loadcases, the Generator will produce four combinations for all
required combinations which include the group’s load Type (e.g.
“Imposed”), each containing only one of the group’s four cases.

The load groups process

To make use of Load Groups you would proceed as follows:

1. Define Loadcases as normal

2. If required, create Load Groups from Loadcases and/or other Load
Groups

3. Create Combinations by combining Loadcases and/or Load Groups

The end result is Loadcases and Combinations (built up of factored loadcases).
These are then run through analysis and design.

Create load groups

1. On the Load tab, click  Load Groups. 

The Loading dialog (page 357) opens on the Load Groups page. On this
page, you can see all currently existing load groups.

2. Click Add.

3. Enter the Load Group Title.

4. In Class, select the desired load group class.

• Inclusive - all loadcases are added at once into a combination

• Exclusive – loadcases are used one at a time in combinations

5. Click the load group name in the left hand panel of the dialog to display
the available loadcases.

6. Select each loadcase in turn to be included and click the right arrow
button to copy it into the load group. 

NOTE A load group can only contain items of one load type.
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7. Click OK. 

Tekla Structural Designer adds the new load group to the list of load
groups.

Inclusive and exclusive load groups example

If you were to manually create a combination to include:

• Loadcase 1

• Load Group 1 ("Inclusive" which contains Loadcases 2 & 3)

• Load Group 2 ("Inclusive" which contains Loadcases 4 & 5)

• Load Group 3 ("Exclusive" which contains Loadcases 6 & 7)

• Load Group 4 ("Exclusive" which contains Loadcases 8 & 9)

When you click OK to close the Loading dialog, the following combinations are
created with the relevant factors according to Load Type

Combination Contains Loadcases
Combination 1 1 + 2 + 3 + 4 + 5 + 6 + 8
Combination 2 1 + 2 + 3 + 4 + 5 + 6 + 9
Combination 3 1 + 2 + 3 + 4 + 5 + 7 + 8
Combination 4 1 + 2 + 3 + 4 + 5 + 7 + 9

See also

Create load groups (page 343)

Manage load combinations
Load combinations allow you to assemble sets of loadcases, applying the
appropriate factors for the strength and service condition. These factors are
specific to the design code that you are using.

To manage load combinations, see:

• Load combination classes (page 344)

• Generate load combinations automatically (page 345)

• Create load combinations manually (page 346)

• Create modal mass combinations (page 347)

• Import loadcases and combinations from a spreadsheet (page 347)

• Renumber all load combinations (page 352)
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Load combination classes
Combinations fall into five different classes, with a number of options available
for each of the classes:

Combination
class

Description Active Strength Service

Construction
Stage

Only required
for design of
composite
beams

Not applicable Not applicable Not applicable

Gravity Consists of
gravity loads
only (self
weight, dead,
slab dry, slab
wet, imposed,
roof imposed,
snow)

On/Off On/Off On/Off

Lateral In addition to
gravity loads,
contains
lateral loads
due to
notional loads
or wind

On/Off On/Off On/Off

Seismic Consists of
gravity and/or
lateral loads
as well as
seismic
loadcases

On/Off On Not applicable

Modal Mass Only required
if you perform
a modal
analysis

On/Off Not applicable Not applicable

• Active: Selecting and clearing the option switches the combination on and
off for analysis and design.

• Strength: If the Strength option is not selected and the combination is
active, the combination is not assessed for design.

• Service: If the Service options is not selected and the combination is
active, the combination is not assessed for deflection.
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Generate load combinations automatically
The easiest way to create load combinations is to generate the combinations
automatically. In order to do so, see the following instructions.

NOTE Construction Stage combinations must be created manually.

1. On the Load tab, click Combination. 

The Loading dialog (page 357) opens on the Combinations page. On this
page, you can see all currently existing load combinations.

2. Click Generate... 

The Combination Generator dialog box opens.

3. On the first page of the dialog, specify the initial parameters according to
your needs. 

Depending on the number of combination types that you selected on the
first page, Tekla Structural Designer creates one or more pages of
combinations.

4. Click Next.

5. Review each page of combinations, and adjust them as necessary.

6. Click Next to move on to the next page.

7. To save the load combination, click Finish. 

Tekla Structural Designer adds the load combination to the list of
combinations available in the Loading list.

TIP To review the factors and options that have been applied to a
combination, click the combination name in the list on the left side
of the Loading dialog box.

Create load combinations manually
If necessary, you can create load combinations manually. In this case, Tekla
Structural Designer uses a default factor for each loadcase when you add it to
the combination.

1. On the Load tab, click Combination. 

The Loading dialog (page 357) opens on the Combinations page. On this
page, you can see all currently existing load combinations.

2. Click Add.

3. In Design Combination Title, name the combination.

4. In Class, select the combination class.
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5. Depending on the combination class that you selected, do some of the
following:

• Select Active in order to include the combination in analysis or design.

• Select Strength in order to assess the combination for design.

• Select Service in order to assess the combination for deflection.

6. In the left side pane of the Loading dialog box, click the combination
name.

7. Select the loadcases that you want to add in the combination, and click >>.

8. Click OK to save the load combination. 

Tekla Structural Designer adds the new load combination to the list of
combinations in the Loading list.

TIP To review the factors and options that have been applied to a
combination, click the combination name on the left side pane of
the Loading dialog box.

Create modal mass combinations

1. On the Load tab, click Combination. 

The Loading dialog (page 357) opens on the Combinations page. On this
page, you can see all currently existing load combinations.

2. Click Add.

3. In Design Combination Title, name the combination.

4. In Class, set the combination class to Modal Mass.

5. In the left side pane of the Loading dialog box, click the combination
name.

6. Select the loadcases that you want to add in the combination, and click >>.

7. On the Applied mass tab, set the directions to be considered, and if
necessary, specify the level below which mass can be ignored.

8. On the Second order effects tab, define the amplifier that you want to
apply to the combination.

9. Click OK to save the load combination. 

Tekla Structural Designer adds the new load combination to the list of
combinations in the Loading list.

Import loadcases and combinations from a spreadsheet
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Loadcases and combinations defined in an Excel Spreadsheet can be imported
via the ‘Import…’ button on the Loading dialog.

The data must be in the form of a matrix of combination factors in which
loadcases form the row headers and combinations the column headers or
vice-versa. Where a matrix value is blank the associated case is omitted from
the combination. The load type can be set by including in the loadcase name
“DL” for dead load, “LL” for Imposed and “Wind” for Wind (without quotes).

The selected spreadsheet’s Worksheets are automatically listed and one is
selected for import.

Flexible controls allow definition of whether Loadcases are listed in a column
and combinations in a row or vice-versa and selection of the case and
combination column/row sources. Identified cases and combinations can be
reviewed prior to import and the case Type can be edited as necessary.

NOTE The following default/ automatically determined loadcases are not supported
by this feature and would need to be manually added to combinations after
import; Self weight - excluding slabs, Slab self weight, Notional Loads (EHF,
NHF and NL).

Example

We want to import the following loadcases and combinations:

Combination Name Loadcase Strength Factor
dead + imposed DL Dead 1.35

LL Imposed 1.5
Dead+Imp+Wind
Accomp

DL Dead 1.35
LL Imposed 1.5
Wind 0.75

Dead+Imp Accomp
+Wind

DL Dead 1.35
LL Imposed 1.05
Wind 1.5

Dead+Wind DL Dead 1.35
Wind 1.5
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1. In an Excel spreadsheet a matrix of loadcases and combinations is set out
like this:

NOTE An empty cell is used to indicate a Loadcase is not to be included
in particular Combination.

2. Starting from either the Loadcases or Combinations dialog in Tekla
Structural Designer, click Import to start the Import loading wizard, the
first page of which is:

3. Click Open ... to navigate to the Excel file and the Sheet within the Excel
file which contains the matrix and then click Next.
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4. In the next page of the dialog you then choose the orientation of your
matrix and confirm the Excel column & row which contain the Loadcase
and Combination names (i.e. the matrix column and row headers). For
this example the correct orientation and name sources are:

5. The next page of the dialog allows you to confirm/amend Loadcase
options (a) Include (in the imported loadcases) - default is Include
checked on, and (b) Type (the Loadcase type from Dead, Slab Dry, Slab
Wet, Live, etc) - default is Dead for those names that can’t be identified
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automatically:

6. The next page of the dialog allows you to confirm/amend the
Combination option Include (in the imported combinations) - default is
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checked on:

7. The final page of the dialog summarizes the number of loadcases and
combinations that will be imported, after which click Finish to complete
the import process.

8. In the Loading dialog review the combinations, amend the combination
classes where required, and if necessary include additional loadcases (e.g.
automatically determined self weight).

Renumber all load combinations
When you delete load combinations from the Loading dialog box, the
remaining load combinations retain their original loadcase number. If
necessary, you can renumber the remaining load combinations in sequence.
For more information, see the following instructions.

1. On the Loading tab of the Project Workspace, right-click 
Combinations.

2. In the context menu, select Renumber.
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Manage envelopes
You can use envelopes to view analysis results for multiple combinations
simultaneously. When you do so, Tekla Structural Designer displays the
maximum positive and negative values along each member from any
combination included in the envelope.

NOTE When using envelopes, note the following:

• If you have defined patterned load combinations, you only need to include
the base case pattern combination in the envelope. This way, Tekla
Structural Designer automatically includes all pattern combinations
derived from the base case in the envelope.

• You can include gravity, lateral, and seismic combinations in the same
envelope.

• You should not include seismic RSA combinations in envelopes, as Tekla
Structural Designer currently cannot display the results.

Create envelopes

1. On the Load tab, click Envelope. 

The Loading dialog (page 357) opens on the Envelopes page. This page
displays all currently existing envelopes.

2. Click Add.

3. Name the envelope.

4. On the left side pane of the Loading dialog box, click the name of the
envelope.

5. Select the load combinations that you want to add in the envelope, and
click >>.

6. Click OK to save the envelope.

Manage load patterns
Having live/imposed loads applied only to a portion of the structure can
produce a more unfavorable loading than the "fully loaded" condition. More
unfavorable loading conditions can be considered in Tekla Structural Designer
by the use of load patterns.

To manage load patterns, see:

• Overview of load patterns (page 354)

• Apply patterning to live loadcases (page 356)
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• Apply patterning to load combinations (page 356)

• Update load patterns (page 356)

Overview of load patterns

NOTE When you apply pattern loading to imposed loads, the factors of the loaded
and unloaded spans are specific to the design code that you are using.

The basic steps of applying pattern loads

1. Set individual imposed loadcases to be patterned (page 356) according to
your needs.

These loadcases are referred to as fully loaded pattern loadcases.

2. Set the gravity combinations that contain imposed loadcases to be
patterned (page 356) according to your needs.

These gravity combinations are referred to as base case pattern
combinations.

After load decomposition, the building analysis automatically sets up the
pattern cases for concrete beams in Dir1 and Dir2 directions as follows:

• 10 pattern cases for each pattern gravity combination

• 5 pattern cases for beams along Dir1 and 5 for beams along Dir2

NOTE By default, patterns are only applied to beam loads, and slab loads
that have been decomposed on to beams. Loads applied to meshed
slabs should be manually patterned using engineering judgement. For
more information, see Update load patterns (page 356).
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Pattern loadcases

A pattern combination containing patterned imposed loadcases results in 11
combinations: the base case combination, and 10 pattern combinations
derived from the base combination.

If you later modify the building geometry, update load patterns (page 356) to
ensure the load patterns reflect the changes.

NOTE Tekla Structural Designer contains a set of 10 pattern combinations
associated with each fully loaded pattern combination. The pattern
combinations are the same for beams and slabs.

The rules of applying load patterns to slabs and beams

Slab load patterning only applies where two-way slabs have been meshed in
the solver model:

• in FE chasedown analysis

• in 3D analysis where two-way slabs are set as meshed

Therefore, the slab load pattern setting has no affect on:

• one-way spanning slabs

• two-way slabs not meshed in 3D analysis, as the slab loads are being
decomposed to beams and walls prior to creation of the solver model

• two-way slab in Grillage chasedown analysis, as the slab loads are being
decomposed to beams and walls prior to creation of the solver model

Therefore, in 3D analysis and Grillage chasedown analysis:
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• When a beam is set to Full Load, it receives the full decomposed load from
adjacent unmeshed two-way slabs, irrespective of whether the slabs
themselves are set to Full Load or Min Load.

• When a beam is set to Min Load, it receives the min decomposed load
from adjacent unmeshed two-way slabs, irrespective of whether the slabs
themselves are set to Full Load or Min Load.

Apply patterning to live loadcases
If necessary, you can apply load patterning to live/imposed loadcases in a
combination. In order to do so, see the following instructions.

1. On the Load tab, click Loadcases. 

The Loading dialog (page 357) opens on the Loadcases page. On this
page, you can see all currently existing loadcases.

2. Click the live/imposed loadcase to which you want to apply patterning.

3. Select the Pattern Load option.

4. Click OK.

Apply patterning to load combinations
You can only apply load combinations to gravity combinations, as lateral and
seismic combinations do not consider pattern loading. For detailed
information on how to apply pattern loading to load combinations, see the
following instructions.

1. On the Load tab, click Combination. 

The Loading dialog (page 357) opens on the Combinations page. On this
page, you can see all currently existing load combinations.

2. On the left side pane of the Loading dialog box, select the name of the
load combination.

3. In Parameters, ensure that the Pattern option is selected.

4. Click OK. 

NOTE If you wish, you can use pattern loading for every gravity
combination in your model. However, doing so may create many
additional combinations.

Apply loading 356 Manage loadcases, groups, combinations,
envelopes and patterns



Update load patterns
Tekla Structural Designer applies patterning to beam loads automatically.
However, if you need to apply patterning to slab loads for slab design or other
purposes, you must update the load patterns manually.

1. On the Load tab, click Update Patterns.

2. In the Properties window, select each pattern and adjust the loading
status of the existing beams and slabs.

3. To switch the loading status of a slab, click the slab in the model.

Loading dialog

Summary

The Loading dialog is used to define loadcases, load groups, combinations
and envelopes.

Location

On the Load tab, click:

• Loadcases - to open the dialog on the Loadcases page.

•  Load Groups to open the dialog on the Load Groups page.

• Combination- to open the dialog on the Combinations page.

•  Envelope- to open the dialog on the Envelopes page.

Content
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1. Loadcases

Loadcases table

Select Loadcases in the left hand pane to show a table of loadcases that have
been defined.

You can click within the table to:

• Rename a Loadcase Title.

• Change the type of a loadcase.

• Choose whether the "Self weight excluding slabs" and Slab self weight"
cases are to be calculated automatically, or defined manually.

• Choose which cases are to be included when generating the load
combinations.

• Apply reductions to live/imposed cases.

• Apply pattern loading to live/imposed cases.

Using the buttons you can:

• Add a new loadcase to the table.

• Copy an existing loadcase.

• Delete an existing loadcase.

• Reorder to move loadcases up or down the table.

• Import... loadcases from a spreadsheet.

Loadcase parameters

Select an individual loadcase in the left hand pane to show parameters
specifically applicable to that loadcase.

Apply loading 358 Manage loadcases, groups, combinations,
envelopes and patterns



Certain values can only be specified by selecting individual loadcases, for
example:

• For dead loadcases: Prior to Brittle Finishes % .

• For live/imposed loadcases: Long Term % .

See also

Manage loadcases (page 340)

2. Load Groups

Load Groups table

Select Load Groups in the left hand pane to show a table of any load groups
that have been defined.

Click within the table to:

• Rename a load group title.

• Set the load group class as Inclusive, or Exclusive.

• Choose whether the load group is to be included in the generator.
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Using the buttons you can:

• Add a new load group in the table.

• Copy an existing load group.

• Delete an existing load group.

• Reorder to move load groups up or down the table.

• Import... load groups from a spreadsheet.

Load group parameters

Select an individual load group in the left hand pane to set up the load group
content.

The load group class is set as Inclusive, or Exclusive.

The loadcases/load groups currently in the load group are shown in the
Included list.

Use the [>>] and [<<] buttons to add or remove loadcases/load groups from
the Available list to the Included list.

See also

Manage load groups (page 342)

3. Combinations

Combinations table

Select Combinations in the left hand pane to show a table of combinations
that have already been defined or generated.
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You can click within the table to:

• Rename a combination title.

• Change the class of a combination.

• Choose the gravity combination to be used for any steel beam camber
calculations.

• Choose which combinations are active for analysis and design.

• Choose which active combinations are to be assessed for strength.

• Choose which active combinations are to be assessed for service.

Using the buttons you can:

• Add a new combination in the table.

• Copy an existing combination.

• Delete an existing combination.

• Reorder to move combinations up or down the table.

• Import... combinations from a spreadsheet.

Combination parameters

Select an individual combination in the left hand pane to show the parameters
specifically applicable to that combination only.
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The tabbed boxes are used to set:

• Parameters: (Active, Pattern, Strength and Service).

• Type: Head code dependent type settings:

• US head code - ACI/LRFD or ASD.

• Eurocode - Formula type (STR, EQU, GEO)

• India - Limit State or Working Stress

• BS & Australia - not applicable

• Second order effects: the amplification factor, its direction, and whether it
is applied to all loads or lateral loads only.

• Timber design: (US and Eurocodes only) the load duration/time effect
factor.

The loadcases currently in the combination and the strength and serviceability
factors that apply are shown in the Included list.

• Use the [>>] and [<<] buttons to add or remove loadcases from the
Available Loadcases list to the Included list.

• In the Strength column specify the strength factors.

• In the Service column specify the service factors.

See also

Manage load combinations (page 344)
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6. Envelopes

Envelopes table

Select Envelopes in the left hand pane to show a table of any envelopes that
have been defined.

Using the buttons you can:

• Add a new envelope in the table.

• Copy an existing highlighted envelope.

• Delete an existing highlighted envelope.

• Reorder to move envelopes up or down the table.

• Import... to import envelopes from a spreadsheet.

Envelope parameters

Select an individual envelope in the left hand pane to set up the envelope
content.
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The combinations currently in the envelope are shown in the Included list.

Use the [>>] and [<<] buttons to add or remove combinations from the
Available Combinations list to the Included list.

5.2 Apply panel, member, and structure loads
• Apply panel loads (page 364)

• Apply member loads (page 370)

• Apply structure loads (page 372)

• Modify panel, member, and structure loads (page 383)

• Delete panel, member, and structure loads (page 383)

• Decompose panel loads (page 383)

Apply panel loads
You can use panel loads to apply loads to slab items, roof panels, and wall
panels. Tekla Structural Designer contains several types of panel loads,
including point loads, line loads, patch loads, polygonal loads, area loads, slab
loads, and level loads. In order to apply the different panel loads to your
model, see the following instructions.
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You can use the different panel loads in the following ways:

Panel load
type

Use Notes

Point load Can be applied anywhere
within an individual or across
multiple slab items, roof
panels, or wall panels.

Can only be applied in 2D
views.Patch load

Polygonal
load
Area load Entirely covers a slab item, a

roof panel, or a wall panel.
Not applicable

Slab load Entirely covers all slap items
in a parent slab.

A parent slab can consist of
slab items that are physically
separate from each other, but
are on the same level.

Level load Entirely covers all parent
slabs in a level.

Create point loads
1. Open a 2D view of the level within which you want to apply the load.

2. In the Loading list, select an appropriate loadcase.

3. On the Load tab, click Point.

4. In the Properties window, adjust the load details according to your needs.

5. In the model, click a reference node from which the load position can be
offset. 

The load position can be the start or end point of any member at the
level.

TIP To be able to select a reference node, go to Scene Content, and
select Points.

6. Click the load position, or press F2 to type the exact position. 

NOTE If you move the slab item or panel by manually selecting & re-
positioning its nodes, the point load does not move with the slab
or panel.

However, if you move any of the grid lines defining the reference
node, the load will move as well.

Create line loads
1. Open a 2D view of the level within which you want to apply the load.

2. In the Loading list, select an appropriate loadcase.
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3. On the Load tab, click Line.

4. In the Properties window, adjust the load details according to your needs.

5. In the model, click a reference node from which the load position can be
offset. 

The load position can be the start or end point of any member at the
level.

TIP To be able to select a reference node, go to Scene Content, and
select Points.

6. Click the start point of the load, or press F2 to type the exact position. 

Note that the start point is an offset (X, Y) from the selected reference
node.

7. Click the end point of the load, or press F2 to type the exact position. 

Note that when you type the position using the keyboard, the end point is
an offset (X, Y) from the load start position.

Create patch loads
1. Open a 2D view of the level within which you want to apply the load.

2. In the Loading list, select an appropriate loadcase.

3. On the Load tab, click Patch.

4. In the Properties window, adjust the load details according to your needs.

5. In the model, click a reference node from which the load position can be
offset. 

The load position can be the start or end point of any member at the
level.

TIP To be able to select a reference node, go to Scene Content, and
select Points.

6. Click to specify a corner position of the load, or press F2 to type the exact
corner position.

7. Click to specify the size of the load, or press F2 to type the size. 

The size is specified as the offset dimensions from the selected corner
position.

8. Click to specify the rotation angle of the load, or press F2 to type the
rotation angle.
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Create polygonal loads
1. Open a 2D view of the level within which you want to apply the load.

2. In the Loading list, select an appropriate loadcase.

3. On the Load tab, click Polygon.

4. In the Properties window, adjust the load details according to your needs.

5. In the model, click a reference node from which the load position can be
offset. 

The load position can be the start or end point of any member at the
level.

TIP To be able to select a reference node, go to Scene Content, and
select Points.

6. Click the start point of the load, or press F2 to type the exact position. 

Note that the start point is an offset (X, Y) from the selected reference
node.

7. Click a corner point of the load, or press F2 to type the exact position.

8. Repeat step 7 according to your needs.

9. When the polygon is complete, do one of the following:

• Press Esc.

• Click the first corner that you defined.

TIP To modify the shape of an existing polygonal load the following:

a. In the model, select the load.

b. Click one vertex of the load.

c. Click the point where you want to move the vertex.

Create perimeter loads
1. Open a 2D or 3D view showing the level at which you want to apply the

load.

2. In the Loading list, select an appropriate loadcase.

3. On the Load tab, click Perimeter.

4. In the Properties window, adjust the load details according to your needs.

TIP If necessary, you can select one or both of the following options:
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• Create as line loads: creates the load as a series of separate line
loads along each external edge.

• Ignore openings: only creates the load around external
perimeters, and not around internal opening perimeters.

5. Click any slab or mat item. 

Tekla Structural Designer creates the load around the external perimeter
of every continuous area of slabs at the selected level.

Create variable patch loads

NOTE Variable patch loads do not have to be quadrilaterals. Instead, they
can be any polygonal shape.

1. Open a 2D or 3D view showing the level at which you want to apply the
load.

2. In the Loading list, select an appropriate loadcase.

3. On the Load tab, click Var. Patch.

4. In the Properties window, specify three load values to describe the
variable loads.

5. Adjust the remaining load details according to your needs.

6. In the model, click a reference node from which the load position can be
offset. 

The load position can be the start or end point of any member at the
level.

TIP To be able to select a reference node, go to Scene Content, and
select Points.

7. Click the start point of the load, or press F2 to type the exact position. 

Note that the start point is an offset (X, Y) from the selected reference
node.

8. Click a corner point of the load, or press F2 to type the exact corner
position.

9. Repeat step 8 according to your needs.

10. When the polygon is complete, do one of the following:

• Press Esc.

• Click the first corner that you defined.

11. Click one of the corners of the polygon to specify the position of Load 1.

12. Click another corner to specify the position of Load 2.
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13. Click a third corner to specify the position of Load 3. 

TIP To modify the shape of an existing patch load the following:

a. In the model, select the load.

b. Click one vertex of the load.

c. Click the point where you want to move the vertex.

Create area loads
1. Open a 2D view of the level within which you want to apply the load.

2. In the Loading list, select an appropriate loadcase.

3. On the Load tab, click Area.

4. In the Properties window, adjust the load details according to your needs.

5. Click the panel to which you want to apply the load.

Create variable area loads
Variable area loads can only be applied to non-horizontal slab items and roof
panels, as well as wall panels and concrete walls. Therefore, they cannot be
applied in a 2D view.

1. Open the 3D view, frame, or sloped plane view in which you want to apply
the load.

2. In the Loading list, select an appropriate loadcase.

3. On the Load tab, click Var. Area.

4. In the Properties window, adjust the load details according to your needs.

5. Click the slab item or panel to which you want to apply the load.

Create slab loads
1. In the Loading list, select an appropriate loadcase.

2. On the Load tab, click Slab.

3. In the Properties window, adjust the load details according to your needs.

4. To apply the load to all the slab items within a parent slab, in the model,
click any slab item within the parent slab.

Create level loads
Click any slab panel in order to apply the load to all slabs within the level.

1. In the Loading list, select an appropriate loadcase.
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2. On the Load tab, click Level.

3. In the Properties window, adjust the load details according to your needs.

4. To apply the load to all slabs within the level, in the model, click any slab
item.

Apply member loads
By using member loads, you can apply loads to one-dimensional members,
such as beams, columns, and braces.

Tekla Structural Designer allows you to create and apply the following types of
member loads:

• Full-length uniformly distributed loads (UDLs)

• Partial-length uniformly distributed loads (UDLs)

• Partial-length variable deck loads (VDLs)

• Trapezoidal loads

• Point loads

• Moment loads

• Full-length torsional uniformly distributed loads (UDLs)

• Partial-length torsional uniformly distributed loads (UDLs)

• Partial-length torsional variable deck loads (VDLs)

Create full-length UDLs
In order to create a full-length uniformly distributed load (UDL) and apply it to
a member, see the following instructions.

1. In the Loading list, select an appropriate loadcase.

2. On the Load tab, click Full UDL.

3. In the Properties window, adjust the load details according to your needs.

4. To apply the load, click anywhere along the member.

Create partial-length UDLs or VDLs
In order to create UDLs (uniformly distributed loads) or VDLs (variable deck
loads) that only apply to a selected part of the member, see the following
instructions.

1. In the Loading list, select an appropriate loadcase.

2. On the Load tab, click UDL or VDL.
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3. In the Properties window, adjust the load details according to your needs.

4. Hover the mouse pointer over the member to which you want to apply
the load.

5. Click the start point of the load along the member, or press F2 to type the
exact position.

6. Click the end point of the load along the member, or press F2 to type the
exact position.

Create trapezoidal loads
In order to apply trapezoidal loads to the members in your model, see the
following instructions.

1. In the Loading list, select an appropriate loadcase.

2. On the Load tab, click Trapezoidal.

3. In the Properties window, adjust the load details according to your needs.

4. Hover the mouse pointer over the member that you want to apply the
load to.

5. Click the load position along the member, or press F2 to type the exact
position. 

The load position defines the point at which the symmetrical trapezoidal
load reaches its maximum intensity.

Create point loads and moment loads
In order to create and apply point loads or moment loads to the members in
your model, see the following instructions.

1. In the Loading list, select an appropriate loadcase.

2. On the Load tab, in the Member Loads group click Point or 
Moment.

3. In the Properties window, adjust the load details according to your needs.

4. Hover the mouse pointer over the member to which you want to apply
the load.

5. Click the load position along the member, or press F2 to type the exact
position.

Create full-length torsional UDLs
In order to apply full-length torsional uniformly distributed loads (UDLs) to the
members in your model, see the following instructions.
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1. In the Loading list, select an appropriate loadcase.

2. On the Load tab, click Torsion Full UDL.

3. In the Properties window, adjust the load details according to your needs.

4. To apply the load, click anywhere along the member.

Create partial-length torsional UDLs and VDLS
In order to create and apply torsional uniformly distributed loads (UDLs) or
variable deck loads (VDLs) that only apply to a selected part of the member,
see the following instructions.

1. In the Loading list, select an appropriate loadcase.

2. On the Load tab, click Torsion UDL or Torsion VDL.

3. In the Properties window, adjust the load details according to your needs.

4. Hover the mouse pointer over the member to which you want to apply
the load.

5. Click the start point of the load along the member, or press F2 to type the
exact position.

6. Click the end point of the load along the member, or press F2 to type the
exact position.

Apply structure loads
The five types of structure loads that you can apply are:

• Diaphragm loads: applied at any point within a rigid or semi-rigid
diaphragm.

• Equipment loads (page 305): applied to equipment, (in loadcases other
than the dedicated 'equipment' ones).

• Nodal loads (page 382): applied at solver node locations.

• Temperature loads (page 382): global rises in temperature applied to
elements or panels.

• Settlement loads (page 382): translations or rotations applied to supports
in the support UCS system.
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Diaphragm loads and diaphragm load tables
Diaphragm loads are Building Direction 1, Building Direction 2, and Mz torsion
loads applied at any point within a rigid or semi-rigid diaphragm.

Typically these might be used for the application of externally determined
level loads (for example from Wind Tunnel testing of large/ unusual
structures).

The Diaphragm load command is available when a 2D plan view is active - it
can be used to apply a load to any diaphragm within the current view.

If you have multiple loads to apply at different levels, the Diaphragm Table of
loads provides a quicker means of doing this - either by typing the loads and
their positions directly into the table, or by pasting the data into the table from
a spreadsheet.

Add a diaphragm load in a 2D view
To apply a load to any diaphragm within the current 2D view:

Related video

Diaphragm loading

1. Open a 2D view of the level containing the diaphragm to which you want
to apply the load.

2. Click the Load tab on the ribbon.

3. In the Loading list, select an appropriate loadcase. 

 Diaphragm on the Load tab should now be active.

4. Click  Diaphragm

5. In the Properties window, adjust the load details according to your needs.

6. Click the load position, or press F2 to type the exact position.

Add a diaphragm load in a 3D view
To apply a load to any diaphragm within the current 3D view:

Related video

Diaphragm loading

1. Open a 3D view containing the diaphragm to which you want to apply the
load.

2. Click the Load tab on the ribbon.

3. In the Loading list, select an appropriate loadcase. 

 Diaphragm on the Load tab should now be active.
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4. Click  Diaphragm

5. In the Properties window, adjust the load details according to your needs.

6. At the level of the diaphragm, click an existing construction point to apply
the load at that position, or hover over an existing member to apply the
load at a distance along the member (press F2 to type the exact position).

Add a diaphragm load in a 3D view by selecting the diaphragm level
In this method, the load can be applied to a diaphragm at any level by
selecting an existing point at any level:

1. Open a 3D view containing the diaphragm to which you want to apply the
load.

2. Click the Load tab on the ribbon.

3. In the Loading list, select an appropriate loadcase. 

 Diaphragm on the Load tab should now be active.

4. Click  Diaphragm

5. In the Properties window, adjust the load details according to your needs.

6. In the Properties window, check Select diaphragm level

7. At any level, click an existing construction point, or hover over an existing
member to specify a distance along the member (press F2 to type the
exact position). A vertical line is displayed with nodes along it at each
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diaphragm position above or below the identified position.

8. Click on a node to apply the load to the diaphragm at that level.
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Add multiple loads using the diaphragm load table

The diaphragm loads table provides a way to quickly apply multiple diaphragm
loads at different levels, either by typing the loads and their positions directly
into the table, or by pasting the data into the table from a spreadsheet.

1. On the Load tab, click Diaphragm Table.

The Diaphragm Loads table opens in a dialog. If any loads had already
been added (via the Diaphragm Load command, or the Diaphragm Loads
table) these would be listed.

2. In order to see all the separate diaphragms at each level to which loads
could be applied, click the Show diaphragms with no loads box.
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Each level containing a diaphragm is listed, (if more than one diaphragm
exists at the same level a separate row is created for each).

3. In the Loading list at the bottom of the dialog, select the loadcase within
which you want to apply the load.
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4. In the table, click on the diaphragm level to which you want to apply the
load, then click Add.
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A row is displayed for entering the load. The initial default for the load
position is simply the middle point in X and Y of the diaphragm
extremities.

5. Enter the load values and the actual X and Y coordinates.

6. Add further rows of loading data as required, either at the same level or
other levels. 

NOTE Multiple loads can be applied to a single diaphragm if required.

7. Click OK when done. 

The loads are displayed on the model iat their defined locations.

NOTE To edit existing loads in the table, simply open it once more. To delete
loads from the table, select the diaphragm in the table and click
Delete.

Paste multiple loads into the diaphragm load table

If you have been provided with the loading data in the form of a spreadsheet
you can simply paste the data directly into the table.
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NOTE The data must includes a Z (Level height) column and you must ensure
that it is in the following order (which is not the same order as in the
diaphragm loads table):

1. Force in direction 1

2. Force in direction 2

3. Torsion moment

4. Position X

5. Position Y

6. Position Z

1. Open the spreadsheet containing the data to be pasted and copy the
contents to the clipboard.

2. In Tekla Structural Designer, on the Load tab, click Diaphragm Table.

The Diaphragm Loads table opens in a dialog.

3. In the Loading list at the bottom of the dialog, select the loadcase within
which you want to apply the load.
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4. Click Paste New.
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Provided the spreadsheet contents were in the expected format, the loads
and their positions are pasted into the table.

NOTE Existing diaphragm loads will be deleted / replaced by the pasted
data.

5. Click OK when done.

Create nodal loads
To create nodal loads at the solver nodes in your model, see the following
instructions.

1. Click the Load tab on the ribbon.

2. In the Loading list, select an appropriate loadcase. 

Nodal on the Load tab should now be active.

3. Click Nodal.

4. In the Properties window, adjust the load details according to your needs.

5. To define the load position, click the desired node.

Create temperature loads
Temperature loads are global rises in temperature that you can apply to
individual elements or panels in the model. For more information on how to
create temperature loads, see the following instructions.

1. Click the Load tab on the ribbon.

2. In the Loading list, select an appropriate loadcase. 

Temperature on the Load tab should now be active.

3. Click Temperature.

4. In the Properties window, adjust the load details according to your needs.

5. Click anywhere along the element to apply the load.

Create settlement loads
Settlement loads are translations or rotations that you can apply to a support.
To create settlement loads, see the following instructions.

1. Click the Load tab on the ribbon.
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2. In the Loading list, select an appropriate loadcase. 

Settlement on the Load tab should now be active.

3. Click Settlement.

4. In the Properties window, adjust the load details according to your needs.

5. In the model, click a supported node to place the load.

Modify panel, member, and structure loads
To modify the properties of existing loads, see the following instructions.

1. In the model, select the load that you want to modify.

2. In the Properties window, adjust the load details according to your needs.

Delete panel, member, and structure loads
If necessary, you can delete existing loads in your model. In order to do so, see
the following instructions.

1. Ensure that the loadcase containing the load is displayed in the Loading
list.

2. On the Quick Access toolbar at the top of the window, click Delete.

3. Click the load that you want to delete.

Decompose panel loads

TIP Although Tekla Structural Designer carries out load decomposition automatically
when you click to analyze the structure, you have the option to decompose loads
manually by using the Decomposition command.

In the context of big or complex models, decomposing manually can potentially
save time, as it allows you to check that panel loads have been decomposed as
you intend before running the analysis.

Decompose panel loads for an individual construction level
1. Open a 2D view of the desired level. (page 86)

2. Click the '2D' toggle button at the bottom right corner of the view to
display it in 3D.
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3. On the Load tab, click Decomposition. 

Tekla Structural Designer generates an FE mesh within the two-way slab
panels, and applies the resulting decomposed loads to the supporting
members.

TIP In case you cannot see the changes in the model at this point,
ensure that you have selected the correct settings in Scene Content
- See View decomposed loads below.

Decompose panel loads to all required levels
1. Open the Structure 3D view.

2. On the Load tab, click Decomposition. 

Tekla Structural Designer generates an FE mesh within the two-way slab
panels, and applies the resulting decomposed loads to the supporting
members.

TIP In case you cannot see the changes in the model at this point,
ensure that you have selected the correct settings in Scene Content
- See View decomposed loads below.

View decomposed loads graphically
1. Open a 3D view of the model, or a 2D view displayed in 3D.

2. In Scene Content, go to Loading.

3. Select the Decomposed option.

4. According to your needs, do one of the following:

To Do this
View the decomposed load values • In the cell on the right side of Decomposed,

select both Geometry and Text.

View the decomposed loads without load values • In the cell on the right side of Decomposed,
only select Geometry.

5. In the Loading list, select the loadcase. 
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NOTE Decomposed loads do not exist for 2-way slab items at levels
where the Mesh 2-way Slabs in 3D Analysis option has been
selected.

At levels where this is not the case, you can view the decomposed
loads. However, you cannot see any shell results from the FE load
decomposition.

View applied and decomposed member loads in a table
1. Open a 3D view of the model, or a 2D view displayed in 3D.

2. Right-click on the member, and from the context menu select Show
Member Loading. Loads that have been applied directly to the member,
and loads that have been decomposed to the member are displayed in a
table. The 'In Proj.' checkbox is used to indicate applied loads applied in
projection as opposed to along the element.

3. To filter the data by Loadcase, Source, Direction, or Type:

a. Click the appropriate column header to filter by (Loadcase...,
Source..., Direction..., or Type...)

b. From the drop list that appears clear the categories that you don’t
want to be displayed.

c. Click the Close button under the drop list.

Overview of one-way and two-way load decomposition
The way in which Tekla Structural Designer decomposes panel loads depends
on how the slabs/panels are modeled and how they are spanning.

Slab/Panel type Decomposition
One-way spanning slab item Tekla Structural Designer 1-way

decomposes panel loads applied to
the slab directly on to those
supporting members/two-way
spanning slab edges before
performing 3D analysis.

The rotation angle of the slab item
determines the decomposition
direction.

NOTE Any openings in 1 way slabs
are ignored and thus have no
impact on load
decomposition.
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Slab/Panel type Decomposition
Roof panel Tekla Structural Designer 1-way

decomposes panel loads directly on
to supporting members/two-way
spanning slab edges before
performing 3D analysis.

The rotation angle of the roof panel
determines the decomposition
direction.

Two-way spanning slab item • At those levels where the Mesh 2-
way Slabs in 3D Analysis option
is selected, load decomposition is
not required.

• At other levels, any loads applied
to two-way slabs are automatically
2-way decomposed back to
supporting members during the
3D pre-analysis stage, immediately
prior to the 3D analysis stage.

NOTE Where openings have been
defined, any portion of a
panel load that lies within the
opening will not be
decomposed.

Roof panel overlapping a one-way
spanning slab item

Tekla Structural Designer 1-way
decomposes panel loads applied to
the slab directly on to supporting
members/two-way spanning slab
edges before performing 3D analysis.

The rotation angle of the slab item
(and not the roof panel) determines
the decomposition direction.

NOTE Any openings in 1 way slabs
are ignored and thus have no
impact on load
decomposition.

Roof panel overlapping a two-way
spanning slab item

• If there are no openings in the
slab, decomposition is as per Two-
way spanning slab item type
described above.

• Where openings exist, any panel
load applied inside the opening is
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Slab/Panel type Decomposition
first one-way decomposed in the
direction defined by the rotation
angle of the roof panel on to the
two-way slab at the edge of the
opening. It is then further
decomposed back to supporting
members as per Two-way
spanning slab item type
described above.

NOTE This does not apply when
the panel load is an area
load that has been
applied to the slab item
(as opposed to the roof
panel), or a level load, or a
slab load. In each of these
instances the load will
automatically be boxed
out around the opening.

5.3 Apply wind, snow, and seismic loads
Wind loads can be applied using the Wind Wizard, or they can be applied
manually - when applied manually they can take the form of panel, member,
or structure loads, or simple wind loads.

Open structure wind loads are determined by running the Wind Wizard, and
applied to members, ancilaries and equipment via their properties

Snow loads can either be applied using the Snow Wizard or they can be
applied manually.

Seismic loads can only be applied using the Seismic Wizard.

• Apply wind loads using the wind wizard (page 387)

• Apply wind loads manually (page 393)

• Apply open structure wind loads (page 394)

• Apply snow loads using the snow wizard (page 396)

• Apply snow loading manually (page 406)

• Apply seismic loads (page 406)
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Apply wind loads using the wind wizard
In Tekla Structural Designer, you can apply wind loads to your structure by
using the Wind Wizard to generate a wind model.

• Create a wind model and wind loads (page 388)

• Modify wind zones and wind zone loads (page 390)

• Create and manage wind loadcases (page 392)

Create a wind model and wind loads
You can use the Wind Wizard to automate the wind modeling process. Where
appropriate, the Wind Wizard uses databases to determine the appropriate
wind details for your structure location, and then calculates the appropriate
wind loading details according to the selected wind loading code.

RESTRICTION The Wind Wizard is not currently available for the Australian
AS:1170.2 wind loading code variant.

Once you have defined the wind directions in which you are interested, Tekla
Structural Designer automatically calculates the appropriate wind zones on
the roofs and walls of your structure. You can set the type of each roof to
achieve the correct zoning, and then tailor the zoning to account for particular
features in more detail, if you so require.

The wind modeling process can automatically define standard wind loadcases
for you based on the usual internal pressure coefficients, or you can define
the loadcase information yourself. In both cases, the appropriate wind
pressures are calculated on each zone. You can then combine the wind
loadcases into design combinations as usual.

NOTE The determination of the wind speeds, the pressures, and the zones is
rigorous. However, do remember that the final wind loads that are adopted
are your responsibility.

Run the Wind Wizard

NOTE You must define at least one wall or roof panel before running the
Wind Wizard.

1. On the Load tab, click Wind Wizard... 

The Wind Wizard opens.

NOTE The Wind Wizard varies slightly according to the head code that
you are using.
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2. Define the necessary information for the wind model. To go to the next
page in the wizard, click Next.

3. Once you have defined all the necessary information, click Finish. 

NOTE After running the Wind Wizard, you can review the roof and wall
zones for each wind direction.

After you have created the wind model with the Wind Wizard,
you can open a wind view to graphically display the wind zones
and loading that apply for a particular wind direction.

Add wind directions

1. On the Load tab, click Wind Wizard... 

The Wind Wizard opens.

2. Click Next until you are on the Results page.

3. Click Add Dir.

4. Specify the properties of the new wind direction.

5. Click Finish. 

NOTE Remember to add new wind loadcases and design combinations
to incorporate the wind loading for the new direction into your
calculations.

Delete wind directions

1. On the Load tab, click Wind Wizard... 

The Wind Wizard opens.

2. Click Next until you are on the Results page.

3. Click the wind direction that you want to delete.

4. Click Del Dir.

5. Click Finish. 

NOTE Remember to update the existing wind loadcases and design
combinations to remove the details for the wind direction you
have deleted from your calculations.
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Delete the entire wind model

To delete the entire wind model and start the wind modeling process from
scratch, do the following:

1. On the Load tab, click Delete Wind. 

Tekla Structural Designer deletes all the previously defined wind
directions and wind loadcases.

Modify wind zones and wind zone loads
In order to view and modify the wind zones and loading that apply to a
particular wind direction, you have to open the appropriate wind view. Then,
you can modify the wind zones and wind zone loads according to your needs.

Open a wind view

NOTE Wind views are only available if you have already created the wind
model with the Wind Wizard.

1. In the Project Workspace, go to the  Wind tab.

2. Right-click the wind direction that you want to view.

3. In the context menu, click Open View. 

Tekla Structural Designer opens the selected wind view, and the Zone
Loads tab, which allows you to review wind zone data graphically.

View wind zones

1. Open a wind view that displays the details of the desired wind direction.

2. On the Zone Loads tab, click Wind Zones. 

The wind view displays the zones that are applied to the structure for the
selected wind direction.

Modify wind zones

1. Open a wind view that displays the details of the desired wind direction.

2. In the Project Workspace, go to the Wind tab.

3. For the wind direction in question, expand the Roof Zones or Wall Zones
branch.

4. In the desired branch, right-click the panel label containing the zone that
you want to edit.
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5. In the context menu, select Edit Zones... 

The Zone Properties dialog box opens.

6. Modify the wind zones according to your needs.

7. Click OK.

View the wind zone loads

NOTE Remember to update the zone loads when you make changes to your
model.

1. Open a wind view that displays the details of the desired wind direction.

2. On the Zone Loads tab, click Zone Loads.

3. In the Loading list, select the desired wind loadcase. 

Tekla Structural Designer displays the loads that are applied to the
structure for this loadcase in this wind direction.

Modify wind zone loads

1. Open a wind view that displays the details of the wind direction whose
zone loads you want to modify.

2. On the Zone Loads tab, click Zone Loads.

3. In the Loading list, select the desired wind loadcase. 

Tekla Structural Designer displays the loads that are applied to the
structure for this loadcase in this wind direction.

4. In the model, click the wind zone that you want to change.

5. In the dialog that opens, clear the Use Default Values option.

6. Modify the values that determine the loads. 

TIP If you want to reduce the net pressure for benecifial loads to zero,
select the Beneficial Load option.

7. To update the zones, OK.

Update wind zone loads

When you change the roofs or walls of your structure, Tekla Structural
Designer does not automatically update the changes to existing wind zoning.
Updating the zoning is manual because you may wish to make more
alterations before you recalculate the zoning.

Once you have completed your changes, incorporating them and recalculating
the zoning details is simple. To reinstate the zoning after making changes, do
the following:
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1. On the Load tab, click Update Zones. 

The wind zoning calculations run in the background. Once the calculations
are complete, Tekla Structural Designer views the new zoning layout for
your structure.

NOTE If you have defined your own zone layout for any roof or wall, the
existing zones will be maintained when you make changes. Make
sure to update these zones appropriately.

Create and manage wind loadcases
Once you have defined the basic wind data for your model, and calculated
wind zoning in the Wind Wizard, you can define the required wind loadcases
manually. For detailed instructions, see the following paragraphs.

Define wind loadcases

1. On the Load tab, click Wind Loadcases. 

The Wind Loadcases dialog box opens.

2. Do one of the following:

• Click Add to add the details of each wind loadcase individually.

• Click Auto to generate standard wind loadcases for the wind directions
that you have defined in the Wind Wizard.

NOTE You cannot use the Auto option once you have created other
wind loadcases.

Add wind loadcases

1. On the Load tab, click Wind Loadcases. 

The Wind Loadcases dialog box opens.

2. Click Add.

3. Define the details of the new loadcase according to your needs.

4. Repeat steps 2 and 3 for each loadcase that you want to create.

5. Click OK to close the Wind Loadcases dialog box. 

NOTE Remember to update or add design combinations, so that they
take the new wind loadcases into account.
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Delete wind loadcases

1. On the Load tab, click Wind Loadcases.

2. Click the wind loadcase that you want to delete.

3. Click Delete.

4. Repeat steps 2 and 3 to delete further loadcases.

5. Click OK to close the Wind Loadcases dialog box. 

NOTE Remember to update your design combinations, so that they take
the deleted wind loadcases into account.

Apply wind loads manually
In case you do not want to construct an entire wind model, you can elect
instead to apply the wind loads manually. These can be applied as panel,
member, or structure loads in the usual way, or as simple wind loads.

Create loadcases for manual wind loads

1. On the Load tab, click Loadcases. 

The Loading dialog box opens.

2. On the Loadcases page, click Add.

3. Name the new loadcase.

4. Set the type to Wind.

5. Click OK.

Create simple wind loads

RESTRICTION You can only create simple wind loads in the Structure 3D
view.

NOTE In order access the Simple Wind Loading dialog box, you must first
create and select the loadcase where you want to add the simple wind
loads.

1. In the Loading list, select a manually created wind loadcase.

2. On the Load tab, click Simple Wind.

3. In the model, click to define the start point of the load width.
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4. Click to define the end point of the load width. 

The Simple Wind Loading dialog box opens. The dialog box allows you to
specify a single area wind load from the lowest level of the building up to
the highest level that contains a rigid diaphragm.

TIP The wind load does not have to begin at the lowest level of the
building.

If you have one or more levels below ground, you can adjust the
value of the lowest level in the Simple Wind Loading dialog box.

5. Specify the required area load.

6. To create a stepped profile up the height of the building, use the Insert
Above, Insert Below, Quick Above... and Quick Below... buttons.

7. Specify the load for each level.

8. When you load is complete, click OK.

Modify simple wind load vertical properties
1. Double-click anywhere in an existing simple wind load. 

The Simple Wind Loading dialog box opens.

2. Modify the load properties according to your needs.

3. Click OK.

Modify the simple wind load width
1. Select the simple wind load that you want to modify.

2. Select one of the two nodes that define the load width.

3. Click where you want to move the selected node. 

Tekla Structural Designer moves the selected node to the new location,
and regenerates the load.

Apply open structure wind loads

Apply open structure wind load to selected entities
Open structure wind loads can only be applied to structural members,
ancillaries, and equipment.

1. Select the members to which the load is to be applied.
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2. In the Properties window, under Wind loading, select Apply open
structure wind load 

Additional properties then become available, allowing the shape factor
and effective area factors used in the wind load calculation to be
customized.

3. Edit these additional properties, if required. 

NOTE The Apply open structure wind load property is already
selected by default for ancillaries and equipment, but can be
deselected if required.

Run the wind wizard

NOTE You must apply an open structure wind load to at least one entity
before running the Wind Wizard.

1. On the Load tab, click Wind Wizard... 

The Wind Wizard opens.

NOTE The Wind Wizard varies slightly according to the head code that
you are using.

2. On the first page of the wizard select the Apply Open Structure Wind
Load option.

3. Step-through the remaining pages of the wizard to define the necessary
information for the wind model.

4. Once you have defined all the necessary information, click Finish. 

NOTE After you have created the wind model with the Wind Wizard,
you can open a wind view to graphically review the open
structure wind loads for each wind direction.

Define wind loadcases

1. On the Load tab, click Wind Loadcases. 

The Wind Loadcases dialog box opens.

2. Do one of the following:

• Click Add to add the details of each wind loadcase individually.
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• Click Auto to generate standard wind loadcases for the wind directions
that you have defined in the Wind Wizard.

NOTE You cannot use the Auto option once you have created other
wind loadcases.

Apply snow loads using the snow wizard
In Tekla Structural Designer, you apply snow loads to your structure by
running the Snow Wizard to input basic snow data and set up the required
snow loadcases. Provided that Roof Panels have been modeled, some of these
loadcases will be populated with Uniform Snow automatically; the remaining
loadcases then have Uniform Snow, Valley Snow and Local Drift Snow applied
manually as required. As an alternative, you can also choose to apply the snow
loads manually.

NOTE The Snow Wizard is not currently available for the Indian, Australian, or
British Standard snow code variants.

• Overview of snow loading using the snow wizard (page 396)

• Roof panel types (page 397)

• Run the snow load wizard (page 398)

• Snow loadcases (ASCE7) (page 398)

• Snow loadcases (Eurocode) (page 401)

• Apply drift loads to loadcases on completion of the snow wizard (page 403)

• Update snow loads (page 405)

• Delete the snow model (page 406)

Apply snow loading manually (page 406)

How do I define snow loading? (Playlist)

Overview of snow loading using the snow wizard
This section provides a brief overview of snow loading in Tekla Structural
Designer.

The intensity of snow load is based upon geographic location, building/roof
geometry, environmental factors and local roof factors.

All snow loading falls into three categories:

• Uniform Snow load (the first fall of snow)

• Drifted uniform snow (the first fall of snow blown into uneven uniform
loading)
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• Drift loading (local build-up of snow load behind steps, objects, parapets)

Prior to running the Snow wizard... you should ensure that roofed areas of
the model are 'clad' with roof panels.

The Snow wizard... can then be run in order to define the basic snow load
factors and in the case of the Eurocode, the snow loadcases and types
relevant to the particular National Annex.

From this information all the required snow loadcases are automatically set up
and the loads in the undrifted (or balanced) snow loadcase are created.

Following the wizard, you then manually define the drift cases. To do this,
select the relevant snow loadcase, and then define the key attributes for the
drift load prior to placing the load in the relevant position on the roof of the
building.

The end result is a series of snow loadcases ready to be combined in the
Combination Generator with other loadcases.

The basic steps are summarized as follow:

1. Apply Roof Panels to the model

2. Run the Snow wizard...

3. Apply snow loads to the drift loadcases set up by the wizard

4. Combine snow loadcases into design combinations

5. Perform the static design

How do I define snow loading? (Playlist)

Roof panel types
For the snow loading calculations, Tekla Structural Designer has to distinguish
between monopitch (monoslope) and pitched roofs. This is determined from
the RoofType property that has been assigned to the roof panel.

The RoofType property is mapped for the determination of snow loading as
follows:

RoofType For snow loading this is considered
as:

Default Monopitch (Monoslope)
Flat Monopitch (Monoslope)
Monopitch (Monoslope) Monopitch (Monoslope)
Hip Gable Pitched
Hip Main Pitched
Mansard Pitched
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Run the snow load wizard
With the Snow Wizard, you can automatically generate snow loadcases in
both ASCE7 and EN 1991-1-3 snow loading codes. Using the wizard, you can
set up basic snow data, snow loadcases, and snow loads within the balanced,
or undrifted, snow loadcases.

NOTE Snow loads in drift snow loadcases are not set up automatically, and
must therefore be manually applied. For more information, see
Manually apply snow loads to snow loadcases.

1. On the Load tab, click Snow Load --> Snow wizard... 

The Snow Wizard opens.

2. On the first page of the Snow Wizard, define the basic data.

3. Click Next.

4. On the second page, specify the loadcases that you want to generate, and
the number of drift directions to be considered.

5. Click Finish. 

If necessary, you can now review the snow loadcases that you created.

See also

Snow wizard (ASCE7) (page 1220)

Snow wizard (Eurocode) (page 1211)

How do I define snow loading? (Playlist)

Snow loadcases (ASCE7)
The snow loadcases that are set up will depend on the head code that is being
worked to. This section will look at the snow loadcases when the headcode is
set to United States.

NOTE All loads and lengths of loads are assumed to act on a horizontal projection of
the roof surface.

Once set up these loadcases are standard loadcases so you can include them
in combinations in the normal manner.

In the Snow wizard... you specify the Snow Loadcases to be set up from the
following list:

• Minimum Snow Load - for low sloped roofs

• Balanced Snow load - uniform snow load and rain on snow load

• Unbalanced Snow Load - the number of cases required being chosen to
reflect the number of wind directions considered
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• Drift Snow Load

• Rain on Snow Surcharge

Minimum snow load

Loads would need to be manually applied to this loadcase on completion of
the Snow wizard... - the only snow load applicable being Uniform Snow.

Balanced snow load

This loadcase is automatically populated on completion of the Snow wizard...
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Unbalanced snow load

Loads would need to be manually applied to these loadcases on completion of
the Snow wizard... - both Uniform Snow and Valley Snow loads may be
applicable, (depending on the model geometry).
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Drift snow loads

Loads would need to be manually applied to these loadcases on completion of
the Snow wizard... - the only snow load applicable being Local Drift Snow.

Rain on Snow Load Surcharge

This loadcase is automatically populated on completion of the Snow wizard...

Snow loadcases (Eurocode)
The snow loadcases that are set up will depend on the head code that is being
worked to. This section will look at the snow loadcases when the headcode is
set to Eurocode.

NOTE All loads and lengths of loads are assumed to act on a horizontal projection of
the roof surface.
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Once set up these loadcases are standard loadcases so you can include them
in combinations in the normal manner.

In the Snow wizard... you choose the Snow Loadcases to be set up from the
following list:

• Snow Load - Case A - 1) Undrifted

• Snow Load - Case A - 2) Drifted *

• Snow Load - Case B1 - 1) Undrifted Snow Load - Case B1 - 2) Drifted *

• Snow Load - Case B1 - 3) Undrifted (Acc)

• Snow Load - Case B1 - 4) Drifted (Acc) *

• Snow Load - Case B2 - 1) Undrifted

• Snow Load - Case B2 - 2) Drifted *

• If any drifts from Annex B are selected

• Snow Load - Case B2 - 3) Drifted (Annex B) (Acc) *

• Snow Load - Case B3 - 1) Undrifted

• Snow Load - Case B3 - 2) Drifted *

• Snow Load - Case B3 - 3) Undrifted (Acc)

• If any drifts from Annex B are selected

• • Snow Load - Case B3 - 4) Drifted (Annex B) (Acc) *

NOTE For cases marked * - the number of cases actually set up will depend on the
number of wind directions that are asked for.

NOTE The Eurocode / National Annex recommends which loadcases to generate.

Undrifted loadcases

Any undrifted loadcases that have been set up in the Snow wizard... are
automatically populated with uniform loading on completion of the wizard
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Drifted loadcases

All drifted loadcases that have been set up in the Snow wizard... would need
to be have their snow loads manually applied on completion of the wizard.

Apply drift loads to loadcases on completion of the snow wizard
The loads in the drifted snow loadcases have to be applied manually as
uniform snow, valley snow, or local drift snow loads. Any snow loads that are
not appropriate for the selected loadcase cannot be selected.

Apply uniform snow loads

1. In the Loading list, select a snow loadcase generated by the wizard
appropriate for uniform snow.

2. On the Load tab, click Snow Load --> Uniform Snow.

3. In the Properties window, adjust the load details according to your needs.

4. To apply the load, click the relevant roof panel. 

NOTE In the unbalanced cases, setting Roof type option to Pitched
allows you to select whether the wind type of the load should be
Windward or Leeward.
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Apply a valley snow load

1. In the Loading list, select a snow loadcase generated by the wizard
appropriate for valley snow.

2. On the Load tab, click Snow Load --> Valley Snow.

3. Select the left roof panel of the valley in which the load is applied. 

Tekla Structural Designer automatically determines the right panel, and
calculates the valley load.

TIP If necessary, you can use apply a user override to the calculated
load. Even if you rerun the Snow Wizard, Tekla Structural Designer
maintains any user overrides that you have applied.

NOTE Graphic displays depict the loading magnitude of a snow load,
and not depth of loading. Remember this when reviewing the
load that has been calculated on structures like the low pitched
valley model shown below:

Although the above image appears to indicate snow load rising
above the ridges, the display actually views the loading
magnitude.

Apply a local drift snow load

1. In the Loading list, select a snow loadcase generated by the wizard
appropriate for local drift snow.

2. On the Load tab, click Snow Load --> Local Drift Snow.

3. Go to the Properties window.

4. Specify the drift type, and then enter the height, and any other
parameters required to define the drift.

5. In the model, select the roof panel edge where the drift is to form, taking
care to click close to the required edge. 
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TIP The edge closest to the cursor is highlighted, if this isn't where you
want the drift to form move the cursor toward the edge required
before clicking to select.

6. Click the start point of the drift on the highlighted edge.

7. Click the end point of the drift on the highlighted edge. 

TIP If necessary, you can use apply a user override to the calculated
load. Even if you rerun the Snow Wizard, Tekla Structural Designer
maintains any user overrides that you have applied.

8. If you have another drift load to apply to the same panel in the same
loadcase, repeat the above steps starting from step 3. 

NOTE If working to the US headcode, when applying the second and
subsequent drift loads to the same roof panel, a Do not apply
balanced load setting is automatically enabled in the load
properties. (This setting was disabled for the first drift load to
ensure the balanced load gets applied.) The second and
subsequent drift loads use the balanced load of the first drift to
determine their drift load and extent. Working in this way, it is not
necessary to override the load value in order to apply the second
and subsequent drift loads.

Override snow loads

You can apply user overrides for snow load values and drift lengths, if
necessary.

1. Select the snow load.

2. In the Properties window, select the Override load value option.

3. Specify the override value. 

Tekla Structural Designer maintains the user overrides, even if you rerun
the Snow Wizard.

Update snow loads
If you have created a snow model using the Snow Wizard, and later decide to
modify the roof geometry, the snow loads need to be recalculated. To do so,
see the following instructions.

• On the Load tab, click Snow Load --> Update Snow Loads.

See also

Delete the snow model (page 406)
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Delete the snow model
Occasionally, you may need to delete the entire snow model, and start the
process from scratch. In order to do so, see the following instructions.

• On the Load tab, click Snow Load --> Delete Snow. 

Tekla Structural Designer resets the basic data that was previously defined
in the Snow Wizard, and deletes the snow loadcases.

Apply snow loading manually
This approach provides an alternative method to apply snow loading to the
structure, without having to run the Snow Wizard

In order to manually apply snow loads, you must first create a loadcase
(page 341) and set its load type to Snow.

You can then manually apply loads (page 364) to this loadcase in the normal
way.

NOTE Snow loadcases created manually in this way can have panel,
member, and structure loads applied but cannot have snow (i.e.
Uniform Snow, Valley Snow and Local Drift Snow) loads applied.

Apply seismic loads
Use the Seismic Wizard to define all the parameters required to set up the
seismic loadcases and combinations.

RESTRICTION The Seismic Wizard is not currently available for the Australian
AS:1170.4 loading code variant.

Create seismic loads in the Seismic Wizard

1. On the Load tab, click Seismic Load --> Seismic Wizard... 

The (page 407) opens.

NOTE The parameters in the Seismic Wizard vary according to the
loading code that you have selected in Model Settings.

2. In the Seismic Wizard, define the necessary parameters for the seismic
loading and loadcases. To go to the next page, click Next.
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3. Once you have defined the parameters, click Finish. 

The Combination Generator dialog box opens.

4. In the Combination Generator dialog box, define the seismic load
combinations.

5. Click Finish.

Display the horizontal design spectrum
After running the Seismic Wizard, you can view the horizontal design
spectrum.

1. On the Load tab, click Seismic Load --> Horizontal Spectrum.

2. If necessary, in the Properties window, you can switch Direction between
Dir 1 and Dir 2.

Delete seismic loads
• On the Load tab, click Seismic Load --> Delete Seismic. 

Tekla Structural Designer deletes all the previously defined seismic loads in
your model.

See also

Seismic wizard in detail (page 407)

Seismic wizard in detail
The Seismic Wizard is run to specify the seismic analysis method (RSA or ELF)
and to set up the seismic loadcases and combinations.

The information that is entered in the seismic wizard will vary according to the
seismic loading code that is being worked to:

• Using the ASCE7 seismic wizard (page 407)

• Using the UBC 1997 seismic wizard (page 415)

• Using the Eurocode EN1998-1:2004 seismic wizard (page 423)

• Using the IS1893 seismic wizard (page 430)

• Code spectra and site specific spectra (page 436)

• Seismic loadcases (page 448)
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Using the ASCE7 seismic wizard
The Seismic Wizard guides you through the process of defining the
information that is required in order to calculate the seismic loading on the
structure.

This section runs through each page of the wizard and discusses the various
options.

Starting the Wizard

To initiate the wizard:

• Click Load > Seismic Wizard...

The Seismic Wizard will start, and you can use its pages to define the
necessary information. The first page displayed is Site Specific Spectra.

Site Specific Spectra page

You can choose the analysis procedure to be used, either:

Property Description
Code
Spectra

Choose this option to use the ASCE Horizontal Design Spectrum
(page 439).

Site Specific
Spectra
(user
defined -
based on
Sd and T)

User defined spectra are appropriate for locations which use
another country's loading and design codes where the code
spectrum is not relevant.

For this option you create a user defined spectrum by specifying
the required curve parameters and slope options.

See: Code spectra and site specific spectra (page 436).
Site Specific
Spectra
(user
defined -
generic
curve)

User defined spectra are appropriate for locations which use
another country's loading and design codes where the code
spectrum is not relevant.

For this option you create a user defined spectrum by specifying
the required curve manually, or by pasting data from a
spreadsheet.

NOTE The spreadsheet data must be in the form of period vs
acceleration values and in ascending order of period
(the input dialog features an automatic Sort command if
the latter is not the case).

See: Code spectra and site specific spectra (page 436).
Next Clicking Next takes you to the Basic information page

described below.

NOTE No vertical spectrum is considered in the current release.
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Basic information page

The Seismic Design Category (SDC) is determined on this page.

NOTE In ASCE7-10 (not ASCE7-05) there is an additional value of Cs calculated for a
building < 5 stories and where T <0.5s. In this instance Ss is taken as 1.5 and
the additional value of Cs should be used to give a final value of Cs. This clause
has not been implemented in Tekla Structural Designer.

Property Description
Structure details
Height to
the highest
level

This field defaults to the structure height (calculated from the
base to the highest point on the structure).

Ignore
seismic in
floor (and
below)

Only floors above this level are considered when the seismic
weight combination is determined.

Number of
stories

This field defaults to the number of ticked floors in the
Construction levels dialog less the ones ignored in field above.

Site Occupancy
Site class This field allows you to set the appropriate soil conditions, A-E -

(A - Hard rock, B - Rock, C - Very dense soil/soft rock, D - Stiff soil,
E - Soft soil. as defined in ASCE7-05 & ASCE-10 Table 20.3-1.

Occupancy/
Risk
Category

This field allows you to set the appropriate occupancy category,
I-IV, as defined in ASCE 7-05 &-10 Table 1-1.

Importance
Factor, Ie

This is automatically derived from the occupancy class.

Override
check box

Checking this box allows you to override the importance factor,
(some countries require different Importance Factors to those
given in the US codes).

Seismic Design Category (SDC)
Seismic
Design
Category
(SDC)

User editable (range A-F)

Alternative
seismic
design
category
determinati
on

Select this check box in order to use the alternative
determination from IBC2009 1613.5.6.1 / IBC2012 1613.5.6.
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Property Description
User
Defined
SDC

Select this check box in order to specify your own SDC Category

Max earthquake spectral response acceleration
Ss – short
period
(0.2s)

This figure can be determined from the maps found in ASCE
7-05 &-10

(units % of g, range 1 – 500)
S1 – 1.0s
period

This figure can be determined from the maps found in ASCE
7-05 &-10

(units % of g, range 1 – 500)
Design spectral response spectral acceleration
SDS – short
period

This is automatically determined from SS and the site class,
according to ASCE 7-05&-10

SD1 – 1s
period

This is automatically determined from S1 and the site class,
according to ASCE 7-05&-10

Next Unless the SDC is type A, clicking Next takes you to the
Structure Irregularities page described below; for SDC type A
only, clicking Next takes you to the Seismic Loading page.

Structure Irregularities page

For SDC types B to F this page is used to indicate any irregularities in plan or
vertically.

Property Description
Structure
Plan
Irregulariti
es

Check the appropriate boxes to define any plan irregularities.

Structure
Vertical
Irregulariti
es

Check the appropriate boxes to define any vertical irregularities.

Analysis
procedure
to be used

Having specified any irregularities, you then choose the analysis
procedure.

• Use Equivalent Lateral Force Procedure
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Property Description
• Use Modal Response Spectrum Analysis

NOTE Based on the irregularities you have defined, one or
both of the above methods may be unavailable.

Any additional information, assumptions or warnings
applicable to the selected a method are displayed for
information.

Next Clicking Next takes you to the Fundamental Period page
described below.

Fundamental Period page

For SDC types B to F this page is used to determine the fundamental period,
TDir 1 and TDir 2.

Property Description
Fundamental Period Definition
Use approx
fundament
al period Ta

This is automatically derived from ASCE7-05&-10 clause 12.8.2.1.

User
defined
fundament
al period T

If RSA was selected on the previous page this option is dimmed.

Use modal
analysis

Modal analysis is run to determine fundamental periods of the
structure in Dir1 and Dir2.

Fundamental Period
Long
period
transition
period, TL

This figure can be determined from figs 22-15, 16, 17, 18, 19 and
20 found in ASCE 7-05 or figs 22-12, 13, 14, 15 and 16 found in
ASCE 7--10.

TS This value is derived (Ts = SD1/SDS)

Fundamental Period Dir 1 and Dir 2
Structure
Type

Select from Steel moment resisting frames, Concrete moment
resisting frames, Eccentrically braced steel frames or All other
structural systems (ref ASCE7-05 / ASCE7-10 Table 12.8-2

Approx
fundament
al period,
Ta

This is automatically derived from ASCE7-05&-10 clause 12.8.2.1.
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Property Description
Fundament
al period,
TDir 1, TDir 2

Depending on your choice of definition this will either be taken
as Ta, or it can be a user defined value, or it will be calculated
from the modal analysis.

Next Clicking Next takes you to the Seismic Force Resisting System
page described below.

Seismic Force Resisting System page

For SDC types B to F this page is used to determine the response modification
coefficient, R, and other factors in the X and Y directions.

Property Description
Seismic force resisting system Dir 1 and Dir 2
System This field allows you to set the appropriate system, (eg. bearing

wall, building frame, moment resisting frame etc.) from
ASCE7-05 &-10 Table 12.2-1.

Type This field allows you to set the appropriate type for the chosen
system from ASCE7-05 &-10 Table 12.2-1.

Coefficients & Factors Dir 1 and Dir 2
Response
modificatio
n
coefficient,
R

This is automatically derived, but you are given the facility to
edit the calculated value.

System
over-
strength
factor

This is automatically derived, but you are given the facility to
edit the calculated value.

Deflection
amplificatio
n factor, Cd

This is automatically derived, but you are given the facility to
edit the calculated value.

Redundanc
y factor, ρ

This is automatically derived from the SDC, (SDC B-C ρ = 1.0,
SDC D-F ρ = 1.3) but you are given the facility to edit the
calculated value.

Next Clicking Next takes you to the Effective Seismic Weight page
described below.

Effective Seismic Weight page

This page is used to determine the Structure Seismic Dead Weight.

You should include those loadcases that you want to contribute to the
Structure Seismic Dead Weight.
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NOTE This “base shear combination” is used to develop the seismic design loading
and is not used in any analysis of the structure.

Clicking Next takes you to the Localization page described below.

Localization page

On this page you can:

• choose whether to perform seismic drift checks, and set the allowable
story drift factor to be used

• define appropriate localization parameters for using the ASCE7 code
outside of the US.

Property Description
Skip seismic drift checks - Check this box if you do not require seismic drift
checks to be performed.
Structure
Type

Select the structure type for determining the allowable story
drift factor.

Risk
Category

Displays the risk category that was selected on an earlier page
of the wizard.

Allowable
Story Drift
Factor

The factor to be used when calculating the allowable story drift
is determined from the above two parameters. Click 'override' if
you want to enter your own value.

Include localization - Check this box in order to display the below 'ELF &
RSA' and 'RSA only' localization settings.
ELF & RSA  
Scale
Factor
between
elastic and
design
spectra
(Dir1 and
Dir2)

This field allows you to override the code value for the scale
factor, (ASCE7 code value = 1/(R/I)).

User
Defined
Static Base
Shear (Dir1
and Dir2)

This field allows you to override the code value for the static
base shear, (ASCE7 code value V = Cs x W and Cs = SDS / (R /Ie)).

%
eccentricity
for
accidental
torsion

This field allows you to override the code eccentricity for
accidental torsion, (ASCE7 code value = 5%).

NOTE The same value is applied to all floors in the structure.
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Property Description
(Dir1 and
Dir2)
Vertical
seismic
load effect
combinatio
n factor

This field allows you to override the combination factor for
vertical seismic loading (usually a small additional factor for the
dead loads in the combination),(ASCE7 factor = 0.2 x SDS x Dead
loads).

RSA only (only available if RSA has been selected)
% Mass
participatio
n for RSA

This field allows you to set your own required % mass
participation, (ASCE7 code value = 90%).

NOTE This overrides the setting in Analysis Options/1st order
seismic when running the Seismic Wizard.

NOTE It is not usually possible to achieve 100% mass
participation in a modal analysis so max value is 99%.

NOTE This setting can benefit some users wanting nearer
100% to be conservative.

Scaling of
forces (% of
Base Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling factors, (ASCE7
code value: 85% x V / Vt).

Scaling of
Deflections
for Drift
Checks (%
of Base
Shear) (Dir1
and Dir2)

This field allows you to set your required scaling factors, (ASCE7
code value: 85% x V / Vt).

NOTE A zero factor means no scaling will be performed on
deflections.

Finish Click Finish to automatically generate the Seismic loadcases
(page 448) and open the ASCE7 Seismic Combination
Generator described below.

ASCE7 Seismic Combination Generator

The Combination Generator sets up seismic combinations from the following
ASCE7-5 and ASCE7-10 "core" combinations that include seismic loads.

ASD - Seismic Combinations

5) 1.0D + 0.714E

6) 1.0D + 0.75L + 0.536E + 0.75S
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8) 0.6D + 0.714E

NOTE In ASCE, in the above 0.714 equates to 0.7 and 0.536 equates to 0.525. Tekla
Structural Designer utilizes the ASCE factors - you can however change them if
required.

LRFD - Seismic Combinations

5) 1.2D + 1.0E + 1.0L + 0.2S

7) 0.9D + 1.0E

(Where E is the seismic component of the loading in the combination.)

Property Description
Initial Parameters page
Delete /
Replace
combinatio
ns

Select whether to:

• Delete all previously generated combinations

• Replace only combinations generated by this run
Scenario If you need to generate combinations for a range of different

scenarios, ensure you type in (or choose from the droplist if
appropriate) a scenario name. This scenario name is then added
as a prefix to all the combinations generated in the this run of
the generator. You can then rerun the generator to create
additional scenarios.

 Clicking Next takes you to the Combinations page described
below.

Combinations page
Generate Select the seismic combinations to be generated with factors as

specified.
Keep
existing
Seismic
Combinatio
ns

If you want to retain previously set up Seismic Combinations
you can select this check box to do so.

NOTE Warning - some factors may no longer be correct for
these combinations after rerunning the Wizard.

Next Click Next to specify the service factors.
Finish Click Finish to generate the Seismic combinations.

Using the UBC 1997 seismic wizard
The Seismic Wizard guides you through the process of defining the
information that is required in order to calculate the seismic loading on the
structure in accordance with the Uniform Building Code.

This section runs through each page of the wizard and discusses the various
options.

Apply loading 415 Apply wind, snow, and seismic loads



Starting the Wizard

To initiate the wizard:

1. Click Home > Model Settings > Design Codes

a. Set the Design Code for Seismic Loading to UBC

b. Click OK

2. Click Load > Seismic Wizard...

The Seismic Wizard will start, and you can use its pages to define the
necessary information. The first page displayed is Site Specific Spectra.

Site Specific Spectra page

You can choose the analysis procedure to be used, either:

Property Description
Code
Spectra

Choose this option to use the UBC Horizontal Design Spectrum.

Site Specific
Spectra

This option is appropriate for locations which use another
country's loading and design codes where the code spectrum is
not relevant.

For this option you create a user defined spectrum by specifying
the required curve parameters and slope options.

See: Code spectra and site specific spectra (page 436).
Next Clicking Next takes you to the Basic information page

described below.

NOTE No vertical spectrum is considered in the current release.

Basic information page

The Seismic Design Category (SDC) is determined on this page.

NOTE In ASCE7-10 (not ASCE7-05) there is an additional value of Cs calculated for a
building < 5 stories and where T <0.5s. In this instance Ss is taken as 1.5 and
the additional value of Cs should be used to give a final value of Cs. This clause
has not been implemented in Tekla Structural Designer.

Property Description
Structure details
Height to
the highest
level

This field defaults to the structure height (calculated from the
base to the highest point on the structure).
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Property Description
Ignore
seismic in
floor (and
below)

Only floors above this level are considered when the seismic
weight combination is determined.

Number of
stories

This field defaults to the number of ticked floors in the
Construction levels dialog less the ones ignored in field above.

Soil Profile Occupancy
S - Soil
Profile Type

This field allows you to set the appropriate soil conditions, A-E -
(A - Hard rock, B - Rock, C - Very dense soil/soft rock, D - Stiff soil,
E - Soft soil. As defined in UBC97 Table 16-J.

Occupancy
Category

This field allows you to set the appropriate occupancy category,
I-IV. As defined in UBC97 Table 16-K.

Importance
Factor, I

This is automatically derived from the occupancy category.

Override
check box

Checking this box allows you to override the importance factor,
(some countries require different Importance Factors to those
given in the US codes).

Seismic Zone
Seismic
Zone

This field allows you to set the appropriate zone, I-4. As defined
in UBC97 Figure 16-2

Z - Seismic
Zone Factor

This is automatically derived for the seismic zone.

Near Source (for Seismic Zone 4 only)
Seismic
Source
Type

This field allows you to set the appropriate source type, A-C.

Distance to
Seismic
Source

The distance to the seismic source.

Next Clicking Next takes you to the Structure Irregularities page
described below.

Structure Irregularities page

For SDC types B to F this page is used to indicate any irregularities in plan or
vertically.

Property Description
Structure
Plan
Irregulariti
es

Check the appropriate boxes to define any plan irregularities.
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Property Description
Structure
Vertical
Irregulariti
es

Check the appropriate boxes to define any vertical irregularities.

Analysis
procedure
to be used

Having specified any irregularities, you then choose the analysis
procedure.

• Use Static Force Procedure

• Use Modal Response Spectrum Analysis

NOTE Based on the irregularities you have defined, one or
both of the above methods may be unavailable.

Any additional information, assumptions or warnings
applicable to the selected a method are displayed for
information.

Next Clicking Next takes you to the Fundamental Period page
described below.

Fundamental Period page

For SDC types B to F this page is used to determine the fundamental period,
TDir 1 and TDir 2.

Property Description
Fundamental Period Definition
Use approx
fundament
al period Ta

This is automatically derived.

If RSA was selected on the previous page this option is dimmed.

User
defined
fundament
al period

If RSA was selected on the previous page this option is dimmed.

Use modal
analysis

Modal analysis is run to determine fundamental periods of the
structure in Dir1 and Dir2.

Fundamental Period Dir 1 and Dir 2
Structure
Type

Select from Steel moment resisting frames, Concrete moment
resisting frames, Eccentrically braced steel frames or All other
structural systems

Approx
fundament
al period,
Ta

This is automatically derived.
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Property Description
Fundament
al period,
TDir 1, TDir 2

Depending on your choice of definition this will either be taken
as Ta, or it can be a user defined value, or it will be calculated
from the modal analysis.

Next Clicking Next takes you to the Seismic Force Resisting System
page described below.

Seismic Force Resisting System page

This page is used to determine the response modification coefficient, R, and
other factors in the directions 1 and 2.

Property Description
Seismic force resisting system Dir 1 and Dir 2
System This field allows you to set the appropriate system, (eg. bearing

wall, building frame, moment resisting frame etc.) from UBC97
Table 16-N.

Type This field allows you to set the appropriate type for the chosen
system from UBC97 Table 16-N.

Coefficients & Factors Dir 1 and Dir 2
Response
modificatio
n
coefficient,
R

This is automatically derived, but you are given the facility to
edit the calculated value.

System
over-
strength
factor

This is automatically derived, but you are given the facility to
edit the calculated value.

Redundanc
y factor
drift, ρdrift

This factor has to be entered manually.

Redundanc
y factor, ρ

This factor has to be entered manually.

Next Clicking Next takes you to the Effective Seismic Weight page
described below.

Effective Seismic Weight page

This page is used to determine the Structure Seismic Dead Weight.

You should include those loadcases that you want to contribute to the
Structure Seismic Dead Weight.
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NOTE This “base shear combination” is used to develop the seismic design loading
and is not used in any analysis of the structure.

Clicking Next takes you to the Localization page described below.

Localization page

On this page you can:

• choose whether to perform seismic drift checks, and set the allowable
story drift factor to be used

• define appropriate localization parameters for using the UBC code outside
of the US

Property Description
Skip seismic drift checks - Check this box if you do not require seismic drift
checks to be performed.
Structure
Type

Select the structure type for determining the allowable story
drift factor.

Allowable
Story Drift
Factor

The factor to be used when calculating the allowable story drift
is varies according to the Structure Type. Click 'override' if you
want to enter your own value.

Include localization - Check this box in order to display the below 'ELF &
RSA' and 'RSA only' localization settings.
SFP & RSA  
Scale
Factor
between
elastic and
design
spectra
(Dir1 and
Dir2)

This field allows you to override the code value for the scale
factor, (UBC code value = 1/R).

User
Defined
Static Base
Shear (Dir1
and Dir2)

This field allows you to override the code value for the static
base shear, (UBC code value V = Cv x I x W / (R x T)).

%
eccentricity
for
accidental
torsion
(Dir1 and
Dir2)

This field allows you to override the code eccentricity for
accidental torsion, (UBC code value = 5%).

NOTE The same value is applied to all floors in the structure.
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Property Description
Vertical
seismic
load effect
combinatio
n factor

This field allows you to override the combination factor for
vertical seismic loading (usually a small additional factor for the
dead loads in the combination), (UBC factor = 0.5 x Ca x I x Dead
loads for strength design and 0.0 for allowable stress design).

RSA only (only available if RSA has been selected)
% Mass
participatio
n for RSA

This field allows you to set your own required % mass
participation, (UBC code value = 90%).

NOTE This overrides the setting in Analysis Options/1st order
seismic when running the Seismic Wizard.

NOTE It is not usually possible to achieve 100% mass
participation in a modal analysis so max value is 99%.

NOTE This setting can benefit some users wanting nearer
100% to be conservative.

Scaling of
forces (% of
Base Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling factors,

UBC code values:

Code ground motion = 90% x V / VDesign

Site specific ground motion = 80% x V / VDesign

Irregular structures = 100% x V / VDesign

Scaling of
Deflections
for Drift
Checks (%
of Base
Shear) (Dir1
and Dir2)

This field allows you to set your required scaling factors,

UBC code values:

Code ground motion = 90% x V / VDesign

Site specific ground motion = 80% x V / VDesign

Irregular structures = 100% x V / VDesign

NOTE A zero factor means no scaling will be performed on
deflections.

Finish Click Finish to automatically generate the Seismic loadcases
(page 448) and open the UBC Seismic Combination Generator
described below.

Apply loading 421 Apply wind, snow, and seismic loads



UBC Seismic Combination Generator

The Combination Generator sets up seismic combinations from the following
UBC 1997 "core" combinations that include seismic loads.

ASD - Seismic Combinations

5) 1.0D + 0.714E

6) 1.0D + 0.75L + 0.536E + 0.75S

8) 0.6D + 0.714E

NOTE In ASCE, in the above 0.714 equates to 0.7 and 0.536 equates to 0.525. Tekla
Structural Designer utilizes the ASCE factors - you can however change them if
required.

LRFD - Seismic Combinations

5) 1.2D + 1.0E + 1.0L + 0.2S

7) 0.9D + 1.0E

(Where E is the seismic component of the loading in the combination.)

Property Description
Initial Parameters page
Delete /
Replace
combinatio
ns

Select whether to:

• Delete all previously generated combinations

• Replace only combinations generated by this run
Scenario If you need to generate combinations for a range of different

scenarios, ensure you type in (or choose from the droplist if
appropriate) a scenario name. This scenario name is then added
as a prefix to all the combinations generated in the this run of
the generator. You can then rerun the generator to create
additional scenarios.

 Clicking Next takes you to the Combinations page described
below.

Combinations page
Generate Select the seismic combinations to be generated with factors as

specified.
Keep
existing
Seismic
Combinatio
ns

If you want to retain previously set up Seismic Combinations
you can select this check box to do so.

NOTE Warning - some factors may no longer be correct for
these combinations after rerunning the Wizard.

Next Click Next to specify the service factors.
Finish Click Finish to generate the Seismic combinations.
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Using the Eurocode EN1998-1:2004 seismic wizard
The Seismic Wizard guides you through the process of defining the
information that is required in order to calculate the seismic loading on the
structure.

This section runs through each page of the wizard and discusses the various
options.

Starting the Wizard

To initiate the wizard:

• Click Load > Seismic Wizard...

The Seismic Wizard will start, and you can use its pages to define the
necessary information. The first page displayed is Site Specific Spectra.

Site Specific Spectra page

You can choose the analysis procedure to be used, either:

Property Description
Code
Spectra

Choose this option to use the EN 1998-1 Horizontal Design
Spectrum (page 441).

Site Specific
Spectra

This option is appropriate for locations which use another
country's loading and design codes where the code spectrum is
not relevant.

For this option you create a user defined spectrum by specifying
the required curve parameters and slope options.

See: Code spectra and site specific spectra (page 436).
Next Clicking Next takes you to the Basic information page

described below.

NOTE No vertical spectrum is considered in the current release.

Basic information page

Property Description
Structure details
Height to
the highest
level

This field defaults to the structure height (calculated from the
base to the highest point on the structure).

Ignore
seismic in
floor (and
below)

Only floors above this level are considered when the seismic
inertia combination is determined.
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Property Description
Number of
storeys

This field defaults to the number of ticked floors in the
Construction levels dialog less the ones ignored in field above.

Ground acceleration
Region Only applies for the Malaysia NA:

• Peninsular Malaysia,

• Sarawak,

• Sabah
Reference
Peak
Ground
Acc, agR

Refer to PD6698:2009

Design
Ground
Acc, ag

agR x γI.

Importance & Ground
Importance
class

For Base Eurocode and UK NA: I- IV as defined in BS EN
1998-1:2004 - Table 4.3.

For Singapore NA: Ordinary or Special
Ground
type

For Base Eurocode and UK NA: A-E

For Malaysia NA: Rock, Stiff Soil, Flexible Soil

For Singapore NA: C, D, S1

(A - Rock, B - Very dense soil/gravel/clay, C - Deposits of dense/
medium dense soil, D - Loose to medium soil, E - Surface
alluvium. Ref BS EN 1998-1:2004 - Table 3.1.)

Importance
Factor, γI

This is automatically derived from the occupancy class.

Spectrum
type

For Base Eurocode and UK NA: Spectrum Type - 1 or 2 BS EN
1998-1:2004 - Cl 3.2.2.2.1(P)

For Malaysia NA: Spectrum Type - 1

For Singapore and Norway NA: (No choice)
Lower
bound
factor, β

This is automatically derived.

Upper limit
of the
period of
the
constant
spectral

This is automatically derived.
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Property Description
acceleratio
n branch,
Tc

Structural
Ductility
Class

Low, Medium or High - for whole building (not directional)

If ag ≤ 0.78 m/s2 or if ag x S ≤ 0.98 m/s2 - Structure suitable for
Low Seismicity (where S is the soil factor)

If not - Structure suitable for Medium or High Seismicity
Site natural
period, TS
(Malaysia
NA only)

This is only required if the ground type is Flexible Soil.

Elastic
response
spectral
displaceme
nt, SDR
(Malaysia
NA only)

This is only required if the ground type is Flexible Soil.

Next Clicking Next takes you to the Structure regularity page
described below.

NOTE The Norway NA for EC1998 has the following differences:-

Soil factors specific to Norway

- φ factor for Imposed load types A, B and C = 1.0 (not 0.8)

- γI importance factors specific to Norway- Spectrum specific to Norway (TB,
TC and TD factors)

- q values for Ductility Class Medium use for both Medium and High

Structure regularity page

For Medium and High structural ductility this page is used to indicate any
irregularities in plan or elevation. (For Low structural ductility only the
irregularities in elevation are displayed.)

Property Description
Structure
Plan
Regularity
- Cl 4.2.3.2

Check the appropriate boxes to define any plan irregularities.

Structure
Elevation

Check the appropriate boxes to define any elevation
irregularities.
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Property Description
Regularity
- Cl 4.2.3.3
Analysis
procedure
to be used

Having specified any irregularities, you then choose the analysis
procedure.

• Use Equivalent Lateral Force Procedure

• Use Modal Response Spectrum Analysi

NOTE Based on the irregularities you have defined, one or
both of the above methods may be unavailable.

Any additional information, assumptions or warnings
applicable to the selected a method are displayed for
information.

Next Clicking Next takes you to the Fundamental Period page
described below.

Fundamental Period page

This page is used to determine the fundamental period, TDir 1 and TDir 2

Property Description
Fundamental Period Definition
Use approx
fundament
al period TA

If RSA was selected on the previous page this option is dimmed.

User
defined
fundament
al period

If RSA was selected on the previous page this option is dimmed.

Use modal
analysis

Modal analysis is run to determine fundamental periods of the
structure in Dir1 and Dir2.

Fundamental Period Dir 1 and Dir 2
Structure
Type

Select from Moment resistant space steel frames, Moment
resistant space concrete frames, Eccentrically braced steel
frames, All other structures (ref BS EN 1998-1 Cl 4.3.3.2.2)

Approx
fundament
al period,
TA

This is automatically derived.

Fundament
al period,
TDir 1, TDir 2

Depending on your choice of definition this will either be taken
as TA, or it can be a user defined value, or it will be calculated
from the modal analysis.
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Property Description
Next Clicking Next takes you to the Behaviour Factor page

described below.

Behaviour Factor page

For Low Ductility Class, q = 1.5, (but the value can be changed by the user) - all
other fields on the page are dimmed and cannot be changed.

For Medium or High Ductility Classes, this page is used to determine the
Behaviour Factor in direction 1 and 2.

Property Description
Ductility
Class

Medium or High.

Structure
Type

Moment resistant space steel frames, Moment resistant space
concrete frames, Eccentrically braced steel frames, All other
structures

Frame Type This options displayed here depend on the structure type
selected above.

αu/ αl This is a user defined multiplication factor - for the structure

User
defined q

For Medium or High Ductility Classes, select this check box in
order to edit the calculated q value.

Behaviour
Factor, q

This is automatically derived, but you are given the facility to
edit the calculated value.

Next Clicking Next takes you to the Seismic Inertia Combination
page described below.

Seismic Inertia Combination page

This page is used to set up the loadcases for the Seismic Inertia Combination.

You should include those loadcases that you want to contribute to the
effective seismic weight of the structure.

NOTE This “Seismic Inertia Combination” is used to develop the seismic design
loading and is classed as a modal mass combination for the modal analysis. It
is not used in any other analysis of the structure.

Clicking Next takes you to the Localization page described below.

Localization page

On this page you can:

• choose whether to perform seismic drift checks, and set the allowable
story drift factor to be used
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• define appropriate localization parameters

Property Description
Skip seismic drift checks - Check this box if you do not require seismic drift
checks to be performed.
Structure
Type

Select the structure type for determining the allowable story
drift factor.

Importance
Class

Displays the risk category that was selected on an earlier page
of the wizard.

Allowable
Story Drift
Factor

The factor to be used when calculating the allowable story drift
is determined from the above two parameters. Click 'override' if
you want to enter your own value.

-
ELF & RSA  
Scale
Factor
between
elastic and
design
spectra
(Dir1 and
Dir2)

This field allows you to override the code value for the scale
factor, (Eurocode value = 1/q ).

Design
Static Base
Shear, V
(Dir1 and
Dir2)

This field allows you to override the code value for the static
base shear, (Eurocode value FB = Sd (Tl) x m x λ).

%
eccentricity
for
accidental
torsion
(Dir1 and
Dir2)

This field allows you to override the code eccentricity for
accidental torsion, (Eurocode value = 5%).

NOTE The same value is applied to all floors in the structure.

Vertical
seismic
load effect
combinatio
n factor

This field allows you to override the combination factor for
vertical seismic loading (usually a small additional factor for the
dead loads in the combination),( (Eurocode - No vertical loads
considered - factor = 0.0).

RSA only (only available if RSA has been selected)
% Mass
participatio
n for RSA

This field allows you to set your own required % mass
participation, (Eurocode value = 90%).
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Property Description

NOTE This overrides the setting in Analysis Options/1st order
seismic when running the Seismic Wizard.

NOTE It is not usually possible to achieve 100% mass
participation in a modal analysis so max value is 99%.

NOTE This setting can benefit some users wanting nearer
100% to be conservative.

Scaling of
forces (% of
Base Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling factors,
(Eurocode - No base shear adjustment).

Scaling of
Deflections
for Drift
Checks (%
of Base
Shear) (Dir1
and Dir2)

This field allows you to set your required scaling factors,
(Eurocode - No adjustment).

NOTE A zero factor means no scaling will be performed on
deflections.

Finish Click Finish to automatically generate the Seismic loadcases
(page 448) and open the EC8 Seismic Combination Generator
described below.

EC8 Seismic Combination Generator

The Combination Generator uses the two “core” combinations from EC8 that
include seismic loads as below:

Equation 6.12a

Gkj + AEd + ψ2,i x Qk,i

Equation 6.12b

Gkj + AEd

Provided the generate option is selected these will then be used, with factors
as specified, to generate an appropriate number of combinations to cover for
direction +/- Dir1 and Dir2 with +/- eccentricities.

Property Description
Initial Parameters page
Delete /
Replace

Select whether to:

• Delete all previously generated combinations
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Property Description
combinatio
ns

• Replace only combinations generated by this run

Scenario If you need to generate combinations for a range of different
scenarios, ensure you type in (or choose from the droplist if
appropriate) a scenario name. This scenario name is then added
as a prefix to all the combinations generated in the this run of
the generator. You can then rerun the generator to create
additional scenarios.

 Clicking Next takes you to the Combinations page described
below.

Combinations page
Generate Select the seismic combinations to be generated with factors as

specified.
Keep
existing
Seismic
Combinatio
ns

If you want to retain previously set up Seismic Combinations
you can select this check box to do so.

NOTE Warning - some factors may no longer be correct for
these combinations after rerunning the Wizard.

Next Click Next to specify the service combinations.
Finish Click Finish to generate the Seismic combinations.

Using the IS1893 seismic wizard
The Seismic Wizard guides you through the process of defining the
information that is required in order to calculate the seismic loading on the
structure in accordance with the Indian IS1893 code.

This section runs through each page of the wizard and discusses the various
options.

Starting the Wizard

To initiate the wizard:

1. Click Home > Model Settings > Design Codes

a. Set the Design Code for Seismic Loading to IS1893 (Part 1) and select
the year required

b. Click OK

2. Click Load > Seismic Wizard...

The Seismic Wizard will start, and you can use its pages to define the
necessary information. The first page displayed is Site Specific Spectra.
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Site Specific Spectra page

You can choose the analysis procedure to be used, either:

Property Description
Code
Spectra

Choose this option to use the IS893 (Part 1) Horizontal Design
Spectrum.

Site Specific
Spectra

This option is appropriate for locations which use another
country's loading and design codes where the code spectrum is
not relevant.

For this option you create a user defined spectrum by specifying
the required curve parameters and slope options.

See: Code spectra and site specific spectra (page 436).
Next Clicking Next takes you to the Basic information page

described below.

NOTE No vertical spectrum is considered in the current release.

Basic information page

The SZone Factor is determined on this page.

Property Description
Structure details
Height to
the highest
level

This field defaults to the structure height (calculated from the
base to the highest point on the structure).

Ignore
seismic in
floor (and
below)

Only floors above this level are considered when the seismic
weight combination is determined.

Number of
storeys

This field defaults to the number of ticked floors in the
Construction levels dialog less the ones ignored in field above.

Zone & Site
Seismic
Zone

This field allows you to set the appropriate zone, II-V.

Site class This field allows you to set the appropriate soil conditions, I-III.
Importance
Factor, I

This is automatically derived from the occupancy class.

Next Clicking Next takes you to the Structure Irregularities page
described below.
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Structure Irregularities page

This page is used to indicate any irregularities in plan or vertically.

Property Description
Structure
Plan
Irregulariti
es

Check the appropriate boxes to define any plan irregularities.

Structure
Vertical
Irregulariti
es

Check the appropriate boxes to define any vertical irregularities.

Analysis
procedure
to be used

Having specified any irregularities, you then choose the analysis
procedure.

• Use Equivalent Lateral Force Procedure

• Use Modal Response Spectrum Analysis

NOTE Based on the irregularities you have defined, one or
both of the above methods may be unavailable.

Any additional information, assumptions or warnings
applicable to the selected a method are displayed for
information.

Next Clicking Next takes you to the Fundamental Period page
described below.

Fundamental Period page

This page is used to determine the fundamental period, TDir 1 and TDir 2.

Property Description
Fundamental Period Definition
Use approx
fundament
al period Ta

This is automatically derived.

If RSA was selected on the previous page this option is dimmed.

User
defined
fundament
al period

If RSA was selected on the previous page this option is dimmed.

Use modal
analysis

Modal analysis is run to determine fundamental periods of the
structure in Dir1 and Dir2.

Fundamental Period Dir 1 and Dir 2
Structure
Type

Select the structural type.
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Property Description
Approx
fundament
al period,
Ta

This is automatically derived.

Fundament
al period,
TDir 1, TDir 2

Depending on your choice of definition this will either be taken
as Ta, or it can be a user defined value, or it will be calculated
from the modal analysis.

Next Clicking Next takes you to the Seismic Force Resisting System
page described below.

Seismic Force Resisting System page

This page is used to determine the response modification coefficient, R, and
other factors in the directions 1 and 2.

Property Description
Seismic force resisting system Dir 1 and Dir 2
Type This field allows you to set the appropriate type.
System This field allows you to set the appropriate system for the

chosen type.
Coefficients & Factors Dir 1 and Dir 2
Response
modificatio
n
coefficient,
R

This is automatically derived, but you are given the facility to
edit the calculated value.

Next Clicking Next takes you to the Effective Seismic Weight page
described below.

Effective Seismic Weight page

This page is used to determine the Structure Seismic Dead Weight.

You should include those loadcases that you want to contribute to the
Structure Seismic Dead Weight.

NOTE This “base shear combination” is used to develop the seismic design loading
and is not used in any analysis of the structure.

Clicking Next takes you to the Localization page described below.
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Localization page

On this page you can:

• choose whether to perform seismic drift checks, and set the allowable
story drift factor to be used

• define appropriate localization parameters

Property Description
Skip seismic drift checks - Check this box if you do not require seismic drift
checks to be performed.
Allowable
Story Drift
Factor

The factor to be used when calculating the allowable story drift.
Click 'override' if you want to enter your own value.

Include localization - Check this box in order to display the below 'ELF &
RSA' and 'RSA only' localization settings.
ELF & RSA  
Scale
Factor
between
elastic and
design
spectra
(Dir1 and
Dir2)

This field allows you to override the code value for the scale
factor.

User
Defined
Static Base
Shear (Dir1
and Dir2)

This field allows you to override the code value for the static
base shear.

%
eccentricity
for
accidental
torsion
(Dir1 and
Dir2)

This field allows you to override the code eccentricity for
accidental torsion).

NOTE The same value is applied to all floors in the structure.

Vertical
seismic
load effect
combinatio
n factor

This field allows you to override the combination factor for
vertical seismic loading (usually a small additional factor for the
dead loads in the combination).

RSA only (only available if RSA has been selected)
% Mass
participatio
n for RSA

This field allows you to set your own required % mass
participation.
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Property Description

NOTE This overrides the setting in Analysis Options/1st order
seismic when running the Seismic Wizard.

NOTE It is not usually possible to achieve 100% mass
participation in a modal analysis so max value is 99%.

NOTE This setting can benefit some users wanting nearer
100% to be conservative.

Scaling of
forces (% of
Base Shear)
(Dir1 and
Dir2)

This field allows you to set your required scaling factors

Scaling of
Deflections
for Drift
Checks (%
of Base
Shear) (Dir1
and Dir2)

This field allows you to set your required scaling factors.

NOTE A zero factor means no scaling will be performed on
deflections.

Finish Click Finish to automatically generate the Seismic loadcases
(page 448) and open the Seismic Combination Generator
described below.

Seismic Combination Generator

The Combination Generator sets up seismic combinations from the "core"
combinations that include seismic loads.

Property Description
Initial Parameters page
Delete /
Replace
combinatio
ns

Select whether to:

• Delete all previously generated combinations

• Replace only combinations generated by this run
Scenario If you need to generate combinations for a range of different

scenarios, ensure you type in (or choose from the droplist if
appropriate) a scenario name. This scenario name is then added
as a prefix to all the combinations generated in the this run of
the generator. You can then rerun the generator to create
additional scenarios.
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Property Description
 Clicking Next takes you to the Combinations page described

below.
Combinations page
Generate Select the seismic combinations to be generated with factors as

specified.
Keep
existing
Seismic
Combinatio
ns

If you want to retain previously set up Seismic Combinations
you can select this check box to do so.

NOTE Warning - some factors may no longer be correct for
these combinations after rerunning the Wizard.

Next Click Next to specify the service factors.
Finish Click Finish to generate the Seismic combinations.

Code spectra and site specific spectra

Code Spectra

Different analysis procedures are provided for determining the elastic design
response spectrum, the first of which is simply to adopt the code spectra.

• Default spectra (page 437)

Site Specific Spectra (user defined)

In addition to the code spectra, Tekla Structural Designer also allows you to
define your own site specific spectra by specifying significant periods and
acceleration. This procedure is applicable to both ELF and RSA analysis.

The curve equations used for the different head codes are as follows:

• ASCE Horizontal Design Spectrum (page 439)

• EN 1998-1 Horizontal Design Spectrum (Europe, UK, Singapore NA)
(page 441)

• EN 1998-1 Horizontal Design Spectrum (Malaysia NA) (page 442)

• IS893 (Part 1) Horizontal Design Spectrum (page 444)

• ASCE7/UBC Horizontal Design Spectrum - Taiwan (page 446)

This procedure can be used for locations which use another country's loading
and design codes where the code spectra are not relevant and so the local site
spectra need to be defined.

Site Specific Spectra (user defined - generic curve)

A third route is to set a site specific generic curve, either manually, or by
pasting data from a spreadsheet. This procedure requires an RSA to be run
(not ELF). This has been added primarily for remote markets using the US
codes It is available for the US Headcode with loading codes:
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• ASCE7-05

• ASCE7-10

• ASCE7-16

It is not available for UBC, EC or IS codes as these codes do not define the
process to be used with a generic spectrum.

User defined RSA curve

Default spectra
The following details the initial values of the parameters for spectra for each of
the seismic head codes:

ASCE - Horizontal Design Spectrum

Limits Equation Segment Ref
0 ≤ T ≤ T0 SDS x (0.4 + 0.6 x T / T0 ) x (1/(R/Ie) Start point/

linear
11.4.5 (1)

T0 ≤ T ≤ Ts SDS x (0.4 + 0.6 x T / T0 ) x (1/(R/Ie) Constant 11.4.5 (2)

Ts ≤ T ≤ TL (SD1/T)/(R/I) Constant/T 11.4.5 (3)

TL ≤ T ≤ 4s (SD1 x TL / T2)/(R/I) Constant/T2 11.4.5 (4)

UBC - Horizontal Design Spectrum

Limits Equation Segment
0 ≤ T ≤ T0 Ca + 1.5 x T / T0 x (2.5 / R-1) Start point/linear

T0 ≤ T ≤ Ts 2.5 x Ca /R Constant

Ts ≤ T Cv / T/R Constant/T

EC - Horizontal Design Spectrum (UK, Singapore and Europe)

Limits Equation Segment Ref
0 ≤ T ≤ TB ag x S x [ 2/3 + T/TB x ( 2.5 / q - 2/3 )] Start point/

linear
3.13

TB ≤ T ≤ TC ag x S x 2.5 / q Constant 3.14

TC ≤ T ≤ TD ag x S x TC/T x 2.5 / q Constant/T 3.15

TD ≤ T ≤ 4s ag x S x 2.5 / q x (TC x TD) / T2 Constant/T2 3.16

EC - Horizontal Design Spectrum (Malaysia)
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For Rock soil sites

Limits Equation Segment
0 ≤ T ≤ TC ((2 x π)2 x γl x SDR(1.25) / (TC x TD)) / q Constant

TC ≤ T ≤ TD ((2 x π)2 x γl x SDR(1.25) / (T x TD)) / q Constant/T

TD ≤ T ≤ 4s ((2 x π)2 / T2 x [λl x SDR(1.25) + γl x mr x (T -
TD))] / q

Constant/T2

For Stiff soil sites

Limits Equation Segment
0 ≤ T ≤ TC ((2 x π)2 x γl x SDR(1.25) x 1.5 / (TC x TD)) / q Constant

TC ≤ T ≤ TD ((2 x π)2 x γl x SDR(1.25) x 1.5 / (T x TD)) / q Constant/T

TD ≤ T ≤ 4s ((2 x π)2 / T2 x [λl x SDR(1.25) x 1.5 + γl x mr x
(T - TD))] / q

Constant/T2

For Flexible soil sites

Limits Equation Segment
0 ≤ T ≤ TC ((2 x π)2 x γl x SDR (1.5TS) x 3.6 / (TC x TD)) / q Constant

TC ≤ T ≤ TD ((2 x π)2 x γl x SDR(1.5TS) x 3.6 / (T x TD)) / q Constant/T

TD ≤ T ≤ 4s ((2 x π)2 / T2 x [λl x SDR(1.5TS) x 3.6 + γl x mr
x (T - TD))] / q

Constant/T2

IS - Horizontal Design Spectrum

For rocky, or hard soil sites

Limits Damping factor Segment
0 ≤ T ≤ 0.10 (1 + 15 T) Start point/linear
0.10 ≤ T ≤
0.40

(2.50) Constant/T

0.40 ≤ T ≤
4.00

(1.00/T) Constant/T2

For medium soil sites

Limits Damping factor Segment
0 ≤ T ≤ 0.10 (1 + 15 T) Start point/linear
0.10 ≤ T ≤
0.55

(2.50) Constant/T
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Limits Damping factor Segment
0.55 ≤ T ≤
4.00

(1.36/T) Constant/T2

For soft soil sites

Limits Damping factor Segment
0 ≤ T ≤ 0.10 (1 + 15 T) Start point/linear
0.10 ≤ T ≤
0.67

(2.50) Constant/T

0.67 ≤ T ≤
4.00

(1.67/T) Constant/T2

ASCE Horizontal Design Spectrum

NOTE ASCE7 has either sloped second segment or horizontal 4th segment - not
both.

Parameters

• SDuser(0) – units g

• SDuser(T0user) – units g

• T0user – units sec

• TSuser – units sec

• TLuser – units sec

• T4user – units sec, default = 4s
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Input limits

• SDuser(0) > 0

• SDuser(T0user) > 0 if T0user > 0

• 0s ≤ T0user < TSuser < TLuser ≤ T4user

Curve Equations

Design Response Spectrum curves for Sa(g) are defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ T0user Sa(g)(T) = SDuser(0) + ((SDuser(T0user) –
SDuser(0)) x T / T0user)

(2) – straight
line

T0user ≤ T ≤ TSuser Sa(g)(T) = SDuser(T0user)

(3) – curve TSuser ≤ T ≤ TLuser Sa(g)(T) = SDuser(T0user) x TSuser/ T

(4) – curve TLuser ≤ T ≤ T4user Sa(g)(T) = SDuser (T0user) x TSuser x TLuser/ T2

(5) – straight
line
continued
from (4)

  

Adjusted Design Response Spectrum curves for Sa(g)/(R/Ie) are defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ T0user SD(T) = [SDuser(0) + ((SDuser(T0user) - SDuser(0))
x T / T0user)] /(R/Ie)

(2) – straight
line

T0user ≤ T ≤ TSuser SD(T) = SDuser(T0user) / (R/Ie)

(3) – curve TSuser ≤ T ≤ TLuser SD(T) = SDuser(T0user) x TSuser / T / (R/Ie)

(4) – curve TLuser ≤ T ≤ T4user SD(T) = SDuser(T0user) x TSuser x TLuser / T2 /
(R/Ie)

(5) – straight
line
continued
from (4)
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NOTE If T0user = 0, then no line (1) exists

If TLuser = T4user then no line (4) exists

EN 1998-1 Horizontal Design Spectrum (Europe, UK, Singapore NA)

Parameters

• Suser(0) – units g

• Suser(TBuser) – units g

• TBuser – units sec

• TCuser – units sec

• TDuser – units sec

• TEuser – units sec, default = 4s

Input limits

• Suser(0) > 0

• Suser(TBuser) > 0

• 0s ≤ TBuser < TCuser < TDuser ≤ TEuser

Curve Equations

Elastic Response Spectrum curves for Se/agare defined by

NOTE same curve for both Dir1 and Dir2
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Line Limits Equation
(1) – straight
line

0 ≤ T ≤ TBuser Se/ag(T) = Suser(0) + ((Suser(TBuser) x η –
Suser(0)) x T / TBuser)

(2) – straight
line

TBuser ≤ T ≤ TCuser Se/ag(T) = Suser(TBuser) x η

(3) – curve TCuser ≤ T ≤ TDuser Se/ag(T) = Suser(TBuser) x η x TCuser/ T

(4) – curve TDuser ≤ T ≤ TEuser Se/ag(T) = Suser (TBuser) x η x TCuser x TDuser/
T2

(5) – straight
line
continued
from (4)

  

Design Spectrum for Elastic Analysis curves for Se/ag are defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ TBuser Sd/ag(T) = [ 2/3 x Suser(0) + ((Suser(TBuser) / q –
2/3 x Suser(0)) x T / TBuser)]

(2) – straight
line

TBuser ≤ T ≤ TCuser Sd/ag(T) = Suser(TBuser) / q

(3) – curve TCuser ≤ T ≤ TDuser Sd/ag(T) = Suser(TBuser) x TCuser/ T / q

(4) – curve TDuser ≤ T ≤ TEuser Sd/ag(T) = Suser (TBuser) x TCuser x TDuser/ T2/ q

(5) – straight
line
continued
from (4)

  

NOTE If TBuser = 0, then no line (1) exists

If TDuser = TEuser then no line (4) exists
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EN 1998-1 Horizontal Design Spectrum (Malaysia NA)

Parameters

• SDRuser(0) – units g

• SDRuser(TBuser) – units g

• TBuser – units sec

• TCuser – units sec

• TDuser – units sec

• TEuser – units sec, default = 4s

Input limits

• SDRuser(0) > 0

• SDRuser(TBuser) > 0

• 0s ≤ TBuser < TCuser < TDuser ≤ TEuser

Curve Equations

Elastic Response Spectrum curves for Se/agare defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ TBuser Se/ag(T) =SDRuser(0) + ((SDRuser(TBuser) -
SDRuser(0)) x T / TBuser)
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Line Limits Equation
(2) – straight
line

TBuser ≤ T ≤ TCuser Se/ag(T) = SDRuser(TBuser)

(3) – curve TCuser ≤ T ≤ TDuser Se/ag(T) = SDRuser(TBuser) x TCuser / T

(4) – curve TDuser ≤ T ≤ TEuser Se/ag(T) = SDRuser(TBuser) x TCuser x TDuser / T2

(5) – straight
line
continued
from (4)

  

Design Spectrum for Elastic Analysis curves for Sd/ag are defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ TBuser Sd/ag(T) = [SDRuser(0) + ((SDRuser(TBuser) -
SDRuser(0)) x T / TBuser)] / q

(2) – straight
line

TBuser ≤ T ≤ TCuser Sd/ag(T) = SDRuser(TBuser) / q

(3) – curve TCuser ≤ T ≤ TDuser Sd/ag(T) = SDRuser(TBuser) x TCuser / T / q

(4) – curve TDuser ≤ T ≤ TEuser Sd/ag(T) = SDRuser(TBuser) x TCuser x TDuser /
T2 / q

(5) – straight
line
continued
from (4)

  

NOTE If TBuser = 0, then no line (1) exists(as in the example above)

If TDuser = TEuser then no line (4) exists

NOTE The above by default does not quite equate to Line (4) in the Malaysian NA
because there is an extra term (2 x π)2 / T2 x γl x mr x (T - TD) that tweaks the
1/T2 curve slightly. In Sarawak, this term is non-existent, in Peninsular
Malaysia it does not exist for Flexible soils. In the Tekla Structural Designer
User defined spectrum it is also non-existent.
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IS893 (Part 1) Horizontal Design Spectrum

NOTE In this example T3user = T4user so there is no line (4)

Parameters

• Damping factoruser

• Sauser/g(0) – units g

• Sauser/g(T1user) – units g

• T1user – units sec

• T2user – units sec

• T3user – units sec, default = 4s

• T4user – units sec, default = 4s

Input limits

• Sauser/g(0) > 0

• Sauser/g(T1user) > 0

• 0s ≤ T1user < T2user < T3user ≤ T4user

Curve Equations

Average Response Spectrum curves for Sa/g are defined by

NOTE same curve for both Dir1 and Dir2
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Line Limits Equation
(1) – straight
line

0 ≤ T ≤ T1user Sa(g)(T) = Damping factoruser x [Sauser/g(0) +
((Sauser/g(T1user) – Sauser/g(0)) x T / T1user)]

(2) – straight
line

T1user ≤ T ≤ T2user Sa(g)(T) = Damping factoruser x Sauser/g
(T1user)

(3) – curve T2user ≤ T ≤ T3user Sa(g)(T) = Damping factoruser x Sauser/g
(T1user) x T2user/ T

(4) – curve T3user ≤ T ≤ T4user Sa(g)(T) = Damping factoruser x Sauser/g
(T1user) x T2user x T3user/ T2

(5) – straight
line
continued
from (4)

  

Design Response Spectrum curves for Ah(g) (=Sa/g/((2xR)/(ZxI))) are defined by

NOTE same curve for both Dir1 and Dir2

Line Limits Equation
(1) – straight
line

0 ≤ T ≤ T1user Ah(g)(T) = Damping factoruser x [Sauser/g(0) +
((Sauser/g(T0) – Sauser/g(0)) x T / T1user)]

But not less than Z/2
(2) – straight
line

T1user ≤ T ≤ T2user Ah(g)(T) = Damping factoruser x Sauser/g
(T1user) / ((2xR)/(ZxI))

(3) – curve T2user ≤ T ≤ T3user Ah(g)(T) = Damping factoruser x Sauser/g
(T1user) x T2user/ T / ((2xR)/(ZxI))

(4) – curve T3user ≤ T ≤ T4user Ah(g)(T) = Damping factoruser x Sauser/g
(T1user) x T2user x T3user/ T2 / ((2xR)/(ZxI))

(5) – straight
line
continued
from (4)

  

NOTE If T1user = 0, then no line (1) exists

If T3user = T4user then no line (4) exists
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ASCE7/UBC Horizontal Design Spectrum - Taiwan

Taiwan code Figure 2

Specifically, the last section of curve (Segment 4) extends horizontally from
2.5T0 with a value of 0.4 x SDS

NOTE The above curve can be obtained by selecting Horizontal 4th Segment on the
Site Specific Spectra page of the Seismic Wizard.

ASCE7/UBC Horizontal Design Spectrum - Thailand

When Sd1 > Sds

Thailand code Figure 1-4-3
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Specifically, the previously flat section of curve (Segment 2) rises from SDS at T
= 0.2 to SD1 At T = 1.0

NOTE The above curve can be obtained by selecting Sloped 2nd Segment on the Site
Specific Spectra page of the Seismic Wizard.

Seismic loadcases

Once the Seismic Wizard has been run the loadcases required to be applied to
the structure can be generated.

Equivalent Lateral Force (ELF) Loadcases

If an Equivalent Lateral Force (ELF) analysis procedure was selected in the
Wizard, the load is applied to the structure at each level as determined for the
relevant direction - loadcases being created as follows:

For structures with no torsion

• Seismic Dir1 - loadcase type Seismic

• Seismic Dir2 - loadcase type Seismic

For all other structures:

• Seismic Dir1 - loadcase type Seismic

• Seismic Dir2 - loadcase type Seismic

• Seismic Torsion - loadcase type Seismic

NOTE + and - factors are applied in the combinations to achieve the possible options
- +Dir, -Dir, +torsion and -torsion.
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Response Spectrum Analysis (RSA) Loadcases

If a response spectrum analysis procedure was selected in the Wizard, the
loadcases are created as follows:

For structures with no torsion

• Seismic Dir1 - loadcase type Seismic RSA

• Seismic Dir2 - loadcase type Seismic RSA

For all other structures:

• Seismic Dir1 - loadcase type Seismic RSA

• Seismic Dir2 - loadcase type Seismic RSA

• Seismic Torsion - loadcase type Seismic RSA

NOTE Enveloping is used in the combinations to achieve the possible options - +Dir,
-Dir, +torsion and -torsion.
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6 Analyze models

With Tekla Structural Designer you can perform an extensive range of
different analyses.

• Get started with analysis (page 450)

• To run a specific analysis for selected loadcases/combinations, or to run all
the analyses necessary for design, see Run analyses (page 491)

• To review the results once the analyses have completed, see Display
analysis results (page 498)

• To review the solver model used for a particular analysis type, see View and
manage solver models (page 551)

6.1 Get started with analysis
This section explains some basic concepts and procedures you need to know
to get started with analysis in Tekla Structural Designer.

Click the links below to find out more:

• Analysis types in

• Adjust and apply analysis settings (page 460)

• What is a solver model (page 460)

• FE meshing, sub models and diaphragms (page 463)

Analysis types in Tekla Structural Designer
The following analysis types can be run in Tekla Structural Designer.
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1st order linear
1st order linear static analysis is suitable for structures where secondary
effects are negligible. Any nonlinear springs or nonlinear elements present are
constrained to act linearly.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: No

• Material: No

Related task: Run 1st order linear analysis (page 491)

1st order non-linear
This is a nonlinear analysis with loading applied in a single step.

It is suitable for structures where secondary effects are negligible and
nonlinear springs/elements are present.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: No

• Material: Yes

Related task: Run a 1st order non-linear analysis (page 492)

1st order modal
This is an unstressed modal analysis which can be used to determine the
structure's natural frequencies.

The structure is assumed to be in an unstressed state and nonlinear elements
are constrained to act linearly.

Nonlinearity Included:

• Geometric: No

• Material: No

Related task: Run a 1st order modal analysis (page 492)

2nd order linear
This is a 2-stage P-Delta analysis which is suitable for structures where
secondary effects are of comparable magnitude to primary effects. Any
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nonlinear springs or nonlinear elements present are constrained to act
linearly.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: No

Related task: Run a 2nd order linear analysis (page 493)

2nd order non-linear
This is a nonlinear analysis with loading applied in a single step.

It is suitable for structures where secondary effects are of comparable
magnitude to primary effects and nonlinear springs/elements are present.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: Yes

Related task: Run a 2nd order non-linear analysis (page 493)

2nd order buckling
This is a linear buckling analysis which can be used to determine a structure's
susceptibility to buckling.

The stressed state of the structure is determined from linear analysis;
therefore nonlinear elements are constrained to act linearly.

Loadcases and Combinations to be considered in the analysis can be pre-
selected.

Nonlinearity Included:

• Geometric: Yes

• Material: No

Related task: Run a 2nd order buckling analysis (page 493)
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FE chasedown
This analysis type cannot be run in isolation, it is only performed when it is
required as part of another process, such as Analyze All (Static), or Design
All.

Separate analyses are performed for a series of 3D sub models each
containing the members between two horizontal planes with fully meshed
floors. The complete series of models is chased down from top to bottom so
loads are carried from the level above to the level below. The results are
always used for slab design and optionally used for beam, column and wall
design.

Grillage chasedown
This analysis type cannot be run in isolation, it is only performed when it is
required as part of another process, such as Analyze All (Static), or Design
All.

Separate analyses are performed for a series of 3D sub models each
containing the members between two horizontal planes, floors only being
meshed at those levels where they have also been meshed in 3D Analysis. The
complete series of models is chased down from top to bottom so loads are
carried from the level above to the level below.

Analyze All (Static)
This is a full series of analyses that would be carried out as part of Design All
(Static) but with no design. All the analyses required to enable a design to be
performed are included:

• 3D analysis

• 1st order linear/non-linear

• 2nd order linear/non-linear (only if this has been specified by the user
in Design > Design Settings > Analysis)

• FE chasedown analysis (if required)

• Grillage chasedown analysis (if required)

Related task: Run Analyze All (Static) (page 496)

3D only (Static)
This is a similar to Analyze All (Static) but excludes chasedowns to save time
during scheme design, (for example while addressing overall stability, sway,
drift, wind drift, etc.)

Analyses performed:

• 3D analysis

• 1st order linear/non-linear
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• 2nd order linear/non-linear (only if this has been specified by the user
in Design > Design Settings > Analysis)

Related task: Run 3D only (Static) (page 496)

1st order RSA seismic
This is a Modal Response Spectrum Analysis used to determine the peak
response of the structure to earthquakes. Any nonlinear springs or nonlinear
elements present are constrained to act linearly. For RSA Seismic
Combinations, the peak responses are enveloped around the static results for
1st Order Linear Analysis

Related task: Run a 1st order RSA seismic analysis (page 494)

2nd order RSA seismic
This is a Modal Response Spectrum Analysis used to determine the peak
response of the structure to earthquakes. Any nonlinear springs or nonlinear
elements present are constrained to act linearly. For RSA Seismic
Combinations, the peak responses are enveloped around the static results for
2nd Order Linear Analysis

Related task: Run a 2nd order RSA seismic analysis (page 494)

Analysis limitations and assumptions
Certain specific limitations and assumptions relating to the various analysis
types are expanded upon below:

Linear analysis of structures containing material nonlinearity

If a structure containing nonlinear springs or nonlinear elements is subjected
to a linear (i.e. 1st or 2nd order linear, 1st order modal, or 2nd order buckling)
analysis, then the nonlinear springs/elements are constrained to act linearly as
described below:

Nonlinear spring supports

In each direction in which a nonlinear spring has been specified, a single value
of stiffness is applied which is taken as the greater of the specified -ve or +ve
stiffness.

Any specified maximum capacities of the spring are ignored.

Tension only, or compression only elements

If either tension only or compression only element types have been specified,
they are constrained to act as truss element types instead.

Nonlinear axial spring, or nonlinear torsional spring elements

If either of these element types have been specified, they are constrained to
act as linear axial spring, or linear torsional spring element types instead.
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A single value of stiffness is applied which is taken as the greater of the
specified -ve or +ve stiffness.

Any specified maximum capacities of these spring elements are ignored.

Tension only X braces

It is essential that the "X Brace" pattern is used to input cross braces as brace
pairs rather than creating them individually. For linear analysis one of the
braces in a brace pair is automatically inactivated, ensuring that the model's
lateral stiffness, and hence lateral drift, is reasonably correct. If braces are
input individually this will not be the case.

To determine which brace in each pair is inactivated the program pushes the
structure simultaneously in the positive direction 1 and positive direction 2.
The brace that goes into tension retains its full stiffness, while the
compression brace becomes inactive.

If the above process fails to determine which of the pair goes into tension and
which is inactivated then a shear is applied to the structure and the braces are
re-assessed.

Analysis of structures containing geometric nonlinearity

It is assumed that where secondary effects are significant (for example the
structure is close to buckling), the engineer will elect to undertake a 2nd order
analysis. If a 1st order analysis is performed any secondary effects will be
ignored.

Analysis of structures containing curved beams

The member analysis for curved members in the plane of the curve is
approximated by joining the values at the nodes, which are correct. For
detailed analysis of curved members it is your responsibility to ensure
sufficient discretization. More refined models can be achieved, if required, by
decreasing the maximum facet error.

Analysis of compound (plated) steel beams and columns

Compound (plated) sections are 2 chords or more connected by battens,
lattice or welded.

• Static calculations for these section types are the same as for solid
sections. The section characteristics are calculated in the basis of the actual
section.

• The torsional constant of a compound section is calculated as a total of
torsional constants of the chords in a compound section.

• Plane section remain plane.

• The material is homogeneous, isotropic and linearly elastic.

• Saint Venant's principle applies.
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Story shears

The story shears that are output are obtained by resolving the loads at column
nodes horizontally into Direction 1 and Direction 2. Any loads associated with
V & A braces are not included because these occur at mid-beam position and
not at column nodes.

Member Deflections

There is a known issue when calculating member deflection profiles in
combinations which can affect the following analysis types:

• 2nd Order Linear

• 1st Order Nonlinear

• 2nd Order Nonlinear

This occurs when the structures behavior is significantly nonlinear because the
deflection profile is currently based on linear superposition of the loadcases
within it. Clearly as structural response becomes more nonlinear the
assumption that deflections can be superposed becomes less valid. This can
cause a deflected profile to be calculated which deviates from the correct
profile. The deviation can become significant if loadcases fail to solve, but the
combination succeeds in solving, as components of the deflected shape are
missing entirely. It is suggested that for the three analysis types listed member
deflections in combinations be used with caution and engineering judgment.

It should be noted that this limitation only affects member deflection profiles
between solver nodes. All other results, including member force profiles and
deflection at the solver nodes are correct.

Torsion load analysis - relative angle of twist

Any section that is subject to torsional moment will rotate through an angle, θ.
If the cross-section is non-circular this will also be accompanied by warping.

To be able to determine stresses on members subject to torsional moments it
is necessary to determine θ (and for "Open" sections its derivatives also).

For single span pinned steel beams only: a torsion load analysis is
performed which enables θ (and its derivatives) to be calculated and made
available in the Load Analysis View.

For open sections: a more accurate approach is used to determine θ and its
derivatives. The 'cases' in DG9, SCI P057 & SCI P385 being used which depend
on the end conditions and loading conditions on the beam.

This more accurate analysis is carried out for the following open sections:

i. I Symmetric

ii. I Asymmetric

iii. I Plated (including Westok Plated)

iv. Channel
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v. Westok cellular beyond scope

For all other sections not mentioned above (including compound
sections): a "Standard" analysis is carried out to determine θ only using the
following equation:

1 / GI T * ∫ T(x)

Where:

I T = torsion constant

G = shear modulus of steel

T(x) = function of torsion moment

• 2nd Order Linear

• 1st Order Nonlinear

• 2nd Order Nonlinear

Modal analysis - active mass

Modal analysis - active mass

In a 1st order modal analysis mass is assigned to nodes of the analysis model.
In simple terms (neglecting rotation terms for the consistent mass matrix) half
of each element mass is assigned to each node it is attached to.

Mass that is assigned to a translational support cannot go anywhere - i.e. it is
not "active".

Summed Active Mass

Reported in the Dynamic Masses table, this is the actual total active mass for
each direction, but expressed in terms of force units rather than mass.

Summed Total Translational Mass

Reported in the Dynamic Masses table, this is the total system mass for each
direction, again expressed in terms of force units rather than mass.

Translation %

Reported in the Summed Mass table, this is the proportion of mass that is
active for each direction. For a building this will usually be close to but not
quite 100% as some mass always goes to the supports.

Translation % = (Summed Active Mass / Summed Total Translational Mass) x
100

Participation Translation %

Reported in the Summed Mass table, this is the sum of Mass Participation
(reported in the Modal frequencies table) for all modes for each direction.
Design codes stipulate this should be >= 90% for seismic analysis usually for
two orthogonal lateral directions.
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Modal analysis - modal mass

After running a 1st order modal analysis, modal masses for each mode are
available in the Modal Frequencies tabular display.

Modal Mass

In Tekla Structural Designer the modal mass, Mi is given by the following
matrix equation:

Where { Ψ}i is the unity-scaled mode shape (often termed mode vector) of the
ith mode (i.e. any single mode) and [M] is the mass matrix. The meaning of the
unity-scaled mode shape is that the (numerically) largest modal displacement
is set to unity and all other displacements are scaled accordingly. The term
{Ψ}i is used to differentiate this mode shape from the mass-normalized shape
{Φ}i which is the mode shape actually reported by Tekla Structural Designer .

This equation comes from modal analysis theory. It may also be termed
"generalized mass".

Another way to state this equation, which is found in some design guides, is a
summation equation for point masses and their associated modal
displacements for a system of discretized mass distribution:

We have from CCIP-016:
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where i is each on N points on the structure, having mass mi at which the
mode shape μj,i is the jth mode is known.

According to this reference - "Conceptually, the modal mass can be thought of
as the mass of an equivalent single degree of freedom system... which
represents the jth mode."

It can be seen how this is equivalent to the matrix equation given above.
Actually Tekla Structural Designer makes use of a shortcut calculation since it
already has mode shapes which are normalized to mass.

The mass-normalized mode shape { Φ}i and the unity-normalized mode shape
{ Ψ}i are related as follows:

From this we can state the following, where Φ2 is the largest modal
displacement from the mass-normalized mode shape (which we already have
from the Tekla Structural Designer modal analysis):

Hence:

Unstable Structures

Flat Slab Structures

If a concrete structure exists with only flat slabs and columns (i.e. no beams
and no shear walls), and the slab is modelled with a diaphragm this is an
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unstable structure, assuming that the concrete columns are pinned at the
foundation level (current default).

To prevent the instability you should mesh the slabs, as the resulting model
does then consider the framing action that results from the interaction of the
slabs and columns.

Adjust and apply analysis settings
To adjust the analysis settings of the current project or set them as default
settings for future projects, see the following instructions.

Adjust analysis settings in the current project
1. On the Analyze toolbar, click Settings 

The Model Settings dialog box opens.

2. Review and modify the analysis settings according to your needs.

3. Do one of the following:

• To apply the changes to the current project, click OK.

• To save the changes to the selected settings set, click Save...

• To revert to the analysis settings specified in the selected settings set,
click Load...

Adjust analysis settings in future projects
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to the Analysis Settings page.

3. In the list at the top of the page, select the settings set that you want to
modify.

4. Review and modify the analysis settings according to your needs.

5. To save the settings as defaults for future projects that use the selected
settings set, click OK.

See also

Analysis Settings (page 1050)
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What is a solver model
When you use Tekla Structural Designer to model, analyze, and design
structures, you will become familiar with the following concepts:

A structural model is a 3D model that includes the physical members/objects
you create using Tekla Structural Designer, and information related to them.
Each member/object in the physical model will exist in the completed
structure.

The structural model also contains information about the loadcases and
combinations that act on the physical members/objects.
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A solver model is a 3D model that is created from the structural model. It is
used for analyzing structural behavior, and for design.
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When you create a solver model, Tekla Structural Designer generates the
following analysis objects and includes them in the solver model:

• Solver nodes

• Support conditions for nodes

• 1D solver elements

• 2D solver elements

FE meshing, sub models and diaphragms
Click the links below to find out more about FE meshing, sub models and
diaphragms.

To Click the link below:
Choose whether to mesh slabs for 3D
analysis; specify slab mesh

Manage FE meshed slabs (page 464)

Specify wall mesh Manage FE meshed walls (page 480)
Manage the sub models used in
chasedown analyses

Manage sub models (page 488)
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To Click the link below:
Activate and manage rigid and/or
semi-rigid diaphragms

Diaphragm action in roof panels and
slabs (page 482)

Manage FE meshed slabs
At the levels where two-way spanning slabs exist, Tekla Structural Designer
applies FE meshing as follows:

• Two-way spanning slabs are always meshed in the FE chasedown analysis
that occurs as part of the static design process.

• Two-way slabs are by default not meshed for 3D building analysis or
grillage chasedown analysis. This ensures the quickest solution time. A 3D
pre-analysis process (in which the slabs are meshed) is used to decompose
loads from the slabs on to supporting members.

• Alternatively, you can choose to mesh two-way slabs for 3D building
analysis and grillage chasedown analysis, either at all, or selected
construction levels. In this case Tekla Structural Designer does not perform
the load decomposition during 3D pre-analysis for the two-way slabs at
those levels.

In all of the above mentioned situations, the slab mesh density is set globally,
but can be overridden at individual levels if required.

Click the links below to find out more:

• Define whether slabs are meshed for 3D building analysis and grillage
chasedown analysis (page 464)

• Adjust global slab mesh properties (page 465)

• Apply different mesh properties at different levels (page 466)

• Review the slab mesh before the analysis (page 466)

• How slab properties and features impact on meshing (page 467)

• Slab meshing controls (page 471)

Define whether slabs are meshed for 3D building analysis and grillage
chasedown analysis

To ensure the quickest solution time, two-way slabs are by default not
meshed for 3D building analysis or grillage chasedown analysis. In this case,
the diaphragm option (none, semi-rigid, or rigid) in the slab properties
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determines their axial rigidity and a 3D pre-analysis process is used to FE
decompose loads from the slabs on to supporting members.

If you prefer, you can instead choose to mesh the slabs, either at all, or
selected construction levels.

NOTE Two-way spanning slabs are always meshed in the FE chasedown
analysis that occurs as part of the static design process.

Use meshed two-way slabs in at all construction levels

1. Go to the Project Workspace.

2. In the Structure tree, select Levels.

3. In the Properties window, select the Mesh 2-way Slabs in 3D Analysis
option.

Use FE decomposed slab loads at all construction levels

1. Go to the Project Workspace.

2. In the Structure tree, select Levels.

3. In the Properties window, clear the Mesh 2-way Slabs in 3D Analysis
option.

Use meshed two-way slabs at selected construction levels

1. In the Structure tree, expand the Levels branch.

2. Click one of the desired construction levels.

3. According to your needs, either select or clear the Mesh 2-way Slabs in
3D Analysis option.

4. Repeat step 3 for all the desired construction levels.

Adjust global slab mesh properties
Initially, the same mesh properties are applied globally to all meshed slabs. In
order to adjust the global slab mesh properties, see the following instructions.

1. Go to the Project Workspace.

2. In the Structure tree, click Structure.

3. Go to the Properties window.

4. Accept or adjust the Slab Mesh Size.
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5. Accept or adjust the Slab Uniformity Factor. At 100% uniformity all slabs
in the mesh will be of approximately equal area.

6. Accept or adjust the Slab Mesh Type:

• QuadDominant: mainly consists of quadrilateral 2D elements, but
may use occasional triangular elements to create a better mesh.

• QuadOnly: only consists of quadrilateral 2D elements.

• Triangular: only consists of triangular 2D elements.

See also

Apply different mesh properties at different levels (page 466)

Apply different mesh properties at different levels
If you need to apply different mesh parameters at a specific level, you can do
so by creating sub models. For more information, see the following
instructions.

1. Create a sub model. (page 489)

2. In the Structure tree, expand the Sub Models branch.

3. Select the sub model that you created.

4. In the Properties window, select the Override model's option.

5. Adjust the mesh size and uniformity factor according to your needs.

Review the slab mesh before the analysis
In order to review the existing slab mesh in your model before running a
particular analysis, see the following instructions.

1. In the Status bar at the bottom of the window, click Solver View. 

The solver view opens.

2. Right-click anywhere in the solver view.

3. In the context menu, go to Solver models.

4. In the list, select the solver model appropriate to the analysis that you
want to run. 

If the slab mesh is applicable to the selected solver model, it is displayed.

NOTE The slab mesh is not displayed in the working solver model. This
is because the working solver model displays the model in its
form before any analysis, and 2D elements are only formed
during the analysis.
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See also

View and manage solver models (page 551)

How slab properties and features impact on meshing

The slab mesh is always created in a single plane, but the resulting mesh is can
be affected by the slab properties and features as described below.

Slab thickness, vertical offsets, column drops and openings

The mesh of shell 2D solver elements is always created in the same plane,
irrespective of whether slabs have different thicknesses, slabs items have
been raised/lowered via vertical offsets, or column drops have been applied.
Shells are not created inside slab openings and any loads placed within
openings are not applied to the model.

Consider the example shown below. This features curved slab boundaries,
circular and rectangular openings, thickened slab panels, lowered slab panels
and a slab overhang. A column drop panel has also been inserted at one of the
locations where the slab is supported by a column.

In the resulting FE solver model, since vertical offsets are not structurally
significant the analysis mesh is formed at the same level relative to the top of
the slab. The mesh properties do however reflect the change to the slab
thicknesses in the different slab areas.
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NOTE Beam solver elements and slab meshes can only be offset vertically from one
another by being defined in different construction levels.

Other slab properties

Rotation Angle

Different slab items in the same slab can have different rotation angles.

This property is used for the following where appropriate:

• Span direction for 1-way load decomposition

• To determine the 2D solver element local axes in the solver model

• Bar direction for Slab on Beam and Flat Slabs.

Include in Diaphragm

This property is only available when the Diaphragm option is Semi-Rigid or
Rigid. Individual slab items in the same slab can be included or excluded as
required.

The effect of excluding a slab item depends on the Diaphragm option as
follows:

• Semi-Rigid - excluded slab items are not meshed with semi-rigid 2D solver
elements

• Rigid - internal nodes not considered in the nodal constraints

NOTE Where 2 items share a boundary and one item is included and one excluded,
then the nodes along the shared boundary are included in the diaphragm.

NOTE When a slab item is excluded from the diaphragm this has no effect on the
mesh of shell 2D solver elements used in some of the solver models for 2-way
spanning slabs.
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Mesh groups

To facilitate meshing, Tekla Structural Designer automatically gathers slab
items and features together into mesh groups, and meshes them as a single
entity. A mesh group contains one or more slab items with identical analysis
attributes. Since slab depth is a key analysis attribute, by definition a slab step,
or a column drop, will produce an additional mesh group.

Example: Mesh groups at a slab step

In the following image, you can see three separate slab items:

1. d = 300 mm

2. d = 100 mm

3. d = 100 mm

Although there are three slab items in the previous image, there are only two
different slab depths. That is why Tekla Structural Designer only creates two
mesh groups, as shown in the following image:

1. mesh group 1

2. mesh group 2
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Discontinuity of force contours at slab steps and column drops

When slab items on either side of a slab step are placed into different mesh
groups, the solver nodes along the boundary are shared by both groups. Each
node on the boundary reports a single value of deflection, but two values of
force, one for each group. That is why there will be a discontinuity of force
contours along the boundary.

See the following examples:

Example: Deflection contours (no discontinuity)

Example: Moment contours, discontinuity along boundary

The force discontinuity is a genuine result. The slab items share the same
curvature at the step and have the same elastic modulus, so the moment must
be directly proportional to the inertia of each slab item.

NOTE Other programs may average the value across the boundary when
generating the contours. However, we prefer the approach of Tekla
Structural Designer because averaging would result in an
unrealistically high design of the thinner slab.
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Mesh group boundary warnings

Meshing may fail or produce undesirable results when there is challenging
mesh group boundary geometry. In this case, Tekla Structural Designer warns
you about the source points source of meshing issues.

Examples of possible warning triggers are:

• short edges

• distance between a hole and an edge

• small area enclosed by a mesh group

Slab meshing controls
Meshing issues tend to be caused when the area being meshed ends up with
really narrow strips of slab, for example when the slab edge ends up just
outside the edge of a column.

On the Meshing page of Analysis options (page 1050) certain meshing
tolerance controls can be adjusted when required to solve these type of issue.

The model shown above has various challenging situations which are
discussed below along with an indication of whether changing the automatic
merging distances in Analysis Options can have an impact:
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1. Column face close to parallel slab edge - (yes)

In this example the slab edge is positioned 50mm outside the column face.
The view above left shows the analysis model you would get when the Column
boundary to slab edge merging distance is < 50mm. The view above right
shows the model you get if the merging distance is set to 50mm or above. The
column corner nodes merge (move to) the slab edge eliminating the narrow
strip.

The simplified analysis model avoids mesh quality warnings and gives almost
identical results in terms of column transfer forces and slab design.

2. Column face close to inclined slab edge - (yes)

In this example the slab edge sits just a few mm outside the column corner.
The view above left shows analysis model where a very poor quality element
runs past the corner, (you would only end up with this model if the Column
boundary to slab edge merging distance were to be set less than the default
5mm. The view above right shows the model you get if the merging distance is
set to the default 5mm or above. One column corner node merges (moves to)
the slab edge eliminating the narrowest part of strip.

The simplified analysis model avoids mesh quality warnings and gives almost
identical results in terms of column transfer forces and slab design.
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3. Column close to multiple non-parallel slab edges - (yes)

This is just another variation on positions 1 and 2. The view above left shows
analysis model you would end up with if the Column boundary to slab edge
merging distance were to be set less than the default 5mm. The view above
right shows the model you get provided the default merging distance (5mm) is
retained - meshing is simplified avoiding mesh quality warnings and gives
almost identical results in terms of column transfer forces and slab design.

4. Opening near slab edge - (yes)

In the following examples merging will make things better, but the reality is
that a slab will never be cast with thin isolated strips at the edge - you cannot
effectively reinforce a 50 to 100mm wide strip of slab. In all these the ideal
solution is that the modelling should reflect the reality of realistic minimum
edge distances.

A hole is defined approximately 20mm from the slab edge. The effect is the
same as at the column cut-out boundary - above on the right shows how with
the Opening to slab edge merge distance set to 50mm the opening corners
move to the slab edge. This creates a better analysis model.
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5. Opening near wall inserted along slab edge - (yes)

This is basically the same as the previous situation except that a wall happens
to be defined along the edge. In such cases the user is often tempted to
extend the opening into the physical width of the wall but does not extend it
right to the wall insertion line.

There are pros and cons to both models. On the left the narrow meshed strip
of slab can give mesh quality warnings and errors. On the right the slab mesh
is better, but the model relies a bit more heavily on the wall beam to transfer
moments. However, the overall minor axis moment transferred to the wall
only drops from 75.7 to 72.5 kNm.
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6. Circular opening near slab edge - (yes)

Above left shows the sort of meshing that will occur when a circular opening is
created near to the slab edge. Above centre shows an example where closest
point on the circle is merged to edge. The meshing looks a bit better but this is
still not a great model because you will get strange local results at the
connecting node. On the right where theOpening to slab edge merge distance
is set to 100mm the edge gets completely broken - this is probably the best
model.

7. Closely spaced openings - (no)

These are all examples where the merging settings have no effect.

In each case the problems can generally be resolved by adjusting the openings
so that they overlap slightly.
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Above - shows meshing when a narrow (unbuildable?) strip of slab is left
between openings.

Below shows the model when the openings are manually adjusted to eliminate
this strip.
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8 and 9. Opening near column - (no)

In both these cases it would again be better to adjust the openings so that
they overlap the column boundaries as suggested below.
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10. Opening near wall with slab on other side - (no, unless certain conditions apply)

In this case the opening is defined with an edge that is approximately 4mm
from the insertion line of the wall. With the Hardpoint to edge distance
tolerance at the default of 5mm this creates a model that is poorly connected
along the edge of the opening. The node highlighted in red is not included in
the slab meshing (because it is just 4mm away from the edge). The 3 slab
nodes highlighted in blue are not directly connected to the wall.

If the hard point distance is reduced to 1mm then the model changes as
shown below, the node marked in red above is now included in the slab mesh
so the adjacent nodes have a better connection to the wall.
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However, the best model would be obtained if the opening edge got exactly
aligned with the wall, this can actually be quite hard to achieve in the manual
positioning of openings. A workaround at present is to force a “slab mesh
boundary” along the line of the wall by making the slab on one side slightly
different to the slab on the other - then the automatic mergings will create a
model as shown below.
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Manage FE meshed walls
By default, concrete walls automatically adopt an FE meshed model when the
structure is analyzed. Meshed walls automatically use the mesh parameters of
the model. However, if necessary, you can override the mesh parameters and
apply a user defined mesh to an individual wall.

NOTE If necessary, you can modify concrete walls so that they use a mid-pier model
instead of an FE meshed model.

Adjust global wall mesh properties
Initially, the same mesh properties are applied globally to all meshed walls. In
order to adjust the global wall mesh properties, see the following instructions.

1. Go to the Project Workspace.

2. In the Structure tree, click Structure.

3. Go to the Properties window.
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4. If necessary, in Wall Mesh Type, change the shape of the wall mesh:

• QuadDominant: mainly consists of quadrilateral 2D elements, but
may use occasional triangular elements to create a better mesh.

• QuadOnly: only consists of quadrilateral 2D elements.

• Triangular: only consists of triangular 2D elements.

5. Adjust the horizontal and vertical sizes of the wall mesh according to your
needs.

See also

Apply different mesh properties to an individual wall (page 481)

Apply different mesh properties to individual walls
If you need to apply different wall mesh properties to specific walls, you can
override the model mesh properties, and modify the properties of the
individual wall. For more information, see the following instructions.

1. In the model, select the walls that you want to modify.

2. Go to the Properties window.

3. If necessary, in Wall Mesh Type, change the shape of the wall mesh:

• QuadDominant

• QuadOnly

• Triangular

4. Adjust the horizontal and vertical sizes of the wall mesh according to your
needs.

Review the wall mesh before the analysis
In order to review the existing slab mesh in your model before running a
particular analysis, see the following instructions.

1. In the Status bar at the bottom of the window, click Solver View. 

The solver view opens.

2. Right-click anywhere in the solver view.

3. In the context menu, go to Solver models.

4. In the list, select the solver model appropriate to the analysis that you
want to run. 

If the wall mesh is applicable to the selected solver model, it is displayed.

NOTE The wall mesh is not displayed in the working solver model. This
is because the working solver model displays the model in its
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form before any analysis, and 2D elements are only formed
during the analysis.

Diaphragm action in roof panels and slabs
Roof panels and slabs both have the potential to act as a diaphragms.

Both rigid and semi-rigid diaphragms can be modelled.

• Overview of diaphragm action in roof panels and slabs (page 482)

• Managing diaphragm action in roof panels and slabs (page 485)

Overview of diaphragm action in roof panels and slabs

Roof panels and slabs will both act as a diaphragms provided they have
Include in diaphragm checked in their properties.

While Include in diaphragm is the only property used to determine
diaphragm action in roof panels, for slab items the diaphragm properties are
also determined by the solver model under consideration and the following
properties:

• Diaphragm option slab item property

• Decomposition slab item property

• Mesh 2-way Slabs in 3D analysis level or slope property

How these and other choices affect the diaphragm model are described in the
topics below.

Include in Diaphragm

Roof panels:

The Include in diaphragm choice works as follows:

• On - a diaphragm is created within the roof panel using a mesh of semi-
rigid 2D solver elements

• Off - no diaphragm is created

Slab items:

For slab items the Include in diaphragm choice is only available when the
Diaphragm option is Semi-Rigid or Rigid. Individual slab items can then be
included or excluded as follows:

• On - a diaphragm is created within the slab item which may take the form
of a shell mesh, a semi-rigid mesh, or nodal constraints

• Off - no diaphragm is created

Analyze models 482 Get started with analysis



NOTE Where 2 slab items share a boundary and one item is included and one
excluded, then the nodes along the shared boundary are included in the
diaphragm.

NOTE When a slab item is excluded from the diaphragm this has no effect on the
mesh of shell 2D solver elements used in some of the solver models for 2-way
spanning slabs.

Diaphragm option

The choice of Diaphragm option is set in the slab item properties. The chosen
option is applied to all slab items in the same slab.

The available options are:

• Rigid

• Semi-rigid

• None

How your choice affects the 2D solver element types used depends on the
method of decomposition selected.

NOTE For roof panels there is no choice of diaphragm option - it is always treated as
semi-rigid.

Decomposition

While roof panels are always one-way spanning, for slab panels you can
choose the Decomposition method in the slab item properties. The chosen
option is applied to all slab items in the same slab.

Two options are available: Two-Way Spanning or One-Way Spanning - although
for certain slab types the value is fixed as follows:

• Composite Slab - One-Way only

• Precast Slab - One-Way only

• Slab on Beams - Two-Way or One-Way

• Flat Slab - Two-Way only

• Steel Deck - One-Way or Two-Way

• Timber Deck - One-Way only

One-way spanning slabs are unmeshed unless the Diaphragm option is set to
Semi-rigid, in which case they will be meshed with semi-rigid 2D solver
elements.

NOTE Semi-rigid 1-way spanning slabs cannot be designed.
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Two-way spanning slabs always adopt a mesh of shell 2D solver elements for
the FE chasedown and FE Load Decomposition solver models. However for the
3D Analysis and Grillage chasedown solver models they are:

• unmeshed - if the Diaphragm option is set to None,

• meshed with semi-rigid 2D solver elements - if the Diaphragm option is set
to Semi-rigid, or,

• meshed with shell 2D solver elements - if the Diaphragm option is set to
Rigid.

NOTE Semi-rigid 2-way spanning slabs can be designed, but only using the results
from the FE Chasedown, not the 3D Analysis or Grillage Chasedown.

Mesh 2-way Slabs in 3D Analysis

Two-way spanning slabs are always meshed with shell 2D solver elements in
FE Chasedown and Load decomposition solver models. When the Mesh 2-way
Slabs in 3D Analysis property (specified in the Level, or Slope properties) is
checked the same meshing parameters are then extended to the Grillage
chasedown and 3D Analysis solver models.

Summary of diaphragm constraint and mesh type configurations

The configurations of mesh and nodal constraints applied to each solver
model resulting from the different permutations of the Decomposition,
Diaphragm option, and Mesh 2-way slabs in 3D analysis properties are
recapped in the table below.

Deco
mpos
ition

Diaphra
gm
Option

Mesh 2-way
slabs in 3D
Analysis

FE Load
Decomposition & FE
Chasedown Models

Grillage
Chasedown & 3D
Analysis Models

1-way None Not Applicable No mesh; no nodal
constraints

No mesh; no nodal
constraints

Semi-
Rigid

Not Applicable Semi-Rigid mesh; no
nodal constraints

Semi-Rigid mesh; no
nodal constraints

Rigid Not Applicable No mesh; Nodal
constraints

No mesh; Nodal
constraints

2-way None Yes Shell Mesh; no nodal
constraints

Shell Mesh; no nodal
constraints

No Shell Mesh; no nodal
constraints

No mesh; no nodal
constraints

Semi-
Rigid

Yes Shell mesh; no nodal
constraints

Semi-Rigid mesh; no
nodal constraints

No Shell Mesh; no nodal
constraints

Semi-Rigid mesh; no
nodal constraints
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Rigid Yes Shell Mesh; Nodal
constraints

Shell Mesh; Nodal
constraints

No Shell Mesh; Nodal
constraints

No Mesh; Nodal
constraints

Managing diaphragm action in roof panels and slabs
Tekla Structural Designer forms diaphragms in every slab item of a parent slab
when Diaphragm option is set to Rigid or Semi-rigid.

When a rigid diaphragm is specified, Tekla Structural Designer automatically
applies nodal constraints to the associated slab nodes.

In turn, when a semi-rigid diaphragm is specified, Tekla Structural Designer
creates a mesh of semi-rigid 2D elements within the slab.

Activate rigid diaphragm option within a slab
By default, Tekla Structural Designer automatically creates rigid diaphragm
within slabs. If necessary, you can review and modify the setting for specific
slabs as follows:

1. Go to the Project Workspace.

2. In the Structure tree, expand the Slabs branch.

3. Select the slab that contains the diaphragm.

4. In the Properties window, set Diaphragm option as required. 

NOTE You can set the Diaphragm option as required in both slab item
properties and parent slab properties. Either way, all slab items
within the parent slab adopt the new setting.

Activate semi-rigid diaphragm option within a slab
You can form semi-rigid diaphragms in both one-way and two-way spanning
slabs. In addition, you can review and modify the diaphragm properties by
selecting the slab within which they are located.

1. Go to the Project Workspace.

2. On the Structure tree, expand the Slabs branch.

3. Select the desired slab.

4. In the Properties window, set Diaphragm option to Semi-rigid.

5. If necessary, to adjust the flexibility of the diaphragm, type a value in the
Divide stiffness by option. 
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TIP You can set the Diaphragm option as required in both slab item
properties and parent slab properties. Either way, all slab items
within the parent slab adopt the new setting.

Activate semi-rigid diaphragm option within a roof panel
You can form semi-rigid diaphragms in roof panels as follows:

1. Go to the Project Workspace.

2. On the Structure tree, expand the  Roofs branch.

3. Select the desired roof panel.

4. In the Properties window, select Include in diaphragm. 

NOTE You cannot form a rigid diaphragm within a roof panel.

Adjust semi-rigid diaphragm flexibility

When the Diaphragm option is Semi-Rigid a Divide stiffness by value can be
set in the slab item properties. The same value is applied to all slab items in
the same slab.

The stiffness determined from the material properties and slab thickness is
divided by this value in order to adjust semi-rigid diaphragm flexibility.

Adjust global semi-rigid mesh properties

When a semi-rigid mesh is created the 2D solver element shape (triangular or
quad), the degree of mesh uniformity, and mesh type adopted are obtained
from the Structure Properties. These parameters can be overridden for
individual sub-models by setting different values in the respective Sub Model
Properties.

1. Go to the Project Workspace.

2. In the Structure tree, click Structure.

3. Go to the Properties window.

4. Accept or adjust the Semi-Rigid Mesh Size.

5. Accept or adjust the Semi-Rigid Uniformity Factor.

6. Accept or adjust the Semi-Rigid Mesh Type:

• QuadDominant: mainly consists of quadrilateral 2D elements, but
may use occasional triangular elements to create a better mesh.

• QuadOnly: only consists of quadrilateral 2D elements.

• Triangular: only consists of triangular 2D elements.
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NOTE Beam elements are not split by semi-rigid 2D element nodes.

Apply different semi-rigid mesh properties at different levels
If you need to apply different semi-rigid mesh parameters at a specific level,
you can do so by creating sub models.

1. Create a sub model. (page 489)

2. In the Structure tree, expand the Sub Models branch.

3. Select the sub model that you created.

4. In the Properties window, select the Override model's option.

5. Adjust the semi-rigid mesh size, uniformity factor and type according to
your needs.

Identify the nodes constrained by rigid diaphragms
In order to see which nodes are constrained by diaphragms, see the following
instructions.

1. In the Status bar at the bottom of the window, click Solver View. 

A solver view opens. The rigid and semi-rigid diaphragms are represented
as different colored shaded planes.

Nodes that are constrained by a rigid diaphragm:

• Must lie within, or be on the edge of, the shaded rigid diaphragm
plane.

• Must be solid rather than hollow, or excluded.

Therefore, the following nodes are not constrained by a rigid diaphragm:

• Solid nodes that lie outside the shaded rigid diaphragm plane.

• Hollow, or excluded, nodes.

Exclude individual nodes from a rigid diaphragm
If necessary, you can exclude specific nodes from a rigid diaphragm. In order
to do so, see the following instructions.

1. In the status bar at the bottom of the window, click Review View. A
review view opens.

2. On the Review tab, click Diaphragm On/Off. 
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The nodes are displayed as follows:

• Included nodes are only constrained if they lie within or on the edge of
a rigid diaphragm. If they lie outside the rigid diaphragm, they are not
constrained by it.

• Excluded nodes are always unconstrained.

3. Click a node to switch whether it is included in the diaphragm or not.

Exclude slab items from a diaphragm
By default, Tekla Structural Designer forms a rigid diaphragm in all the
individual slab items within a slab. However, you can decide to exclude specific
slab items. In order to do so, see the following instructions.

1. In the structure view, select the slab item that you want to exclude.

2. In the Properties window, clear the Include in diaphragm option. 

TIP You can also exclude individual slab items graphically in the Review

View. On the Review tab, click Diaphragm On/Off and then
click the slab item to include/exclude.

Manage sub models
Tekla Structural Designer initially treats each structure as a single sub model.
In practice, this means that the Tekla Structural Designer applies the same
mesh parameters to all meshed slabs. However, if needed, you can create sub-
models in your model by creating horizontal planes between levels. Each
individual sub model controls the slab mesh parameters at the levels within it.

Tekla Structural Designer creates additional sub models automatically for
every level specified as a Floor in the Construction Levels dialog box when
Tekla Structural Designer performs one of the following:

• Grillage chasedown analysis

• FE chasedown analysis

You can also define sub models manually in the Sub Models dialog box.

Tekla Structural Designer uses the he slab mesh parameters specified for a
sub model in any analysis that requires the slabs to be meshed, such as load
decomposition, building analysis with meshed floors, or FE chasedown
analysis.

In both grillage and FE chasedown, Tekla Structural Designer performs the
analyses one sub model at a time. Tekla Structural Designer first analyzes the
topmost sub model, and then applies its support reactions as loads for the
analysis of the sub model below. The sequence continues until Tekla Structural
Designer has analyzed all sub models down to the foundation level.
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For both grillage and FE chasedown analysis, you can modify the default
support conditions applied to the sub-models, if necessary.

Definitions of sub model characteristics

• Sub model: a part of the 3D model between two horizontal sub model
divide planes.

Each sub model contains all members entirely between the two horizontal
planes. For the columns, wall and braces split by a divide plane, the stacks
and brace length above the top plane are included in the sub model, as are
the stacks and brace length below the lower plane.

• Sub model divide planes: horizontal planes that you can add, delete or
move in the 3D structure. Sub model divide planes are notional and
infinite. Tekla Structural Designer only allows the planes to cut through the
structure where they only split the following members:

• Column stacks

• Wall stacks

• Steel braces

• Sub model supports: the artificial supports that Tekla Structural Designer
defines for the column and wall stack ends and braces that pass through
the divide planes

• Structure supports: the supports that the user has defined in the 3D
structure

• Column and wall stacks: the span length of a column or wall.

• Volume of the sub model: the 3D space that exists between any two
adjacent sub model divide planes.

Basic rules of sub models

When all sub models are considered together, they form the complete
structure. Only column stacks, wall stacks, and braces that are split by sub
model divide planes can be in several sub models.

This means that:

• Each member in the 3D model is in at least one sub model.

• A sub model cannot contain a member that is already in another sub
model, unless that member is a column, wall, or brace divided by a sub
model divide plane.

• A sub model must contain at least one beam member, one truss member,
or one slab item.

Create sub models
Sub models allow you to apply different slab mesh parameters within your
structure. To create sub models, see the following instructions.
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1. In the Structure tree, double-click Sub Models. 

The Sub Models dialog box opens.

2. According to your needs, do one of the following:

To Do this
Automatically create sub models • Click Generate.

Manually create sub models • According to your needs, click Insert Above,
or Insert Below.

3. If necessary, modify the height above the base of each level in the Level
field.

4. Click OK.

See also

Sub Models dialog (page 1223)

Sub Model Properties (page 937)

Open a 3D view of a sub model
To display a sub model in its own 3D view, see the following instructions.

1. In the Project Workspace, open the Structure tree.

2. Expand the Sub Models branch.

3. Double-click the sub model. 

Tekla Structural Designer opens a 3D view of the selected sub model.

TIP To open a solver view of the sub model, right-click the sub model,
and select Open solver view.

Delete sub models
If necessary, you can delete existing sub models in the Sub Models dialog box.
For detailed information on deleting sub models, see the following
instructions.

1. In the Structure tree, double-click Sub Models. 

The Sub Models dialog box opens.

2. Select the sub model that you want to delete.

3. Click Delete. 

Tekla Structural Designer deletes the sub model, and the floors are
transferred to the sub model immediately above the deleted one.
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6.2 Run analyses
Various analyses can be run from the Analyze toolbar.

Click the links below to find out how to:

• Run a 1st order linear or non-linear analysis (page 491)

• Run a 1st order vibration analysis (page 492)

• Run a 2nd order linear or non-linear analysis (page 493)

• Run a 2nd order buckling analysis (page 493)

• Run a seismic analysis (page 494)

• Run FE chasedown or grillage chasedown analysis (page 495)

• Run Analyze All (Static) (page 496)

• Run 3D only (Static) (page 496)

Once the analysis has completed, the Project Workspace can be used to verify
the results in a couple of ways:

• Check sum of reactions against load input (page 497)

• Check stability and overall displacement (page 498)

Run a 1st order linear or non-linear analysis
To run either a linear or non-linear 1st order analysis on your model, see the
following instructions.

See also

The Results View (page 498)

View tabular results for support reactions (page 592)

View tabular results for nodal deflections (page 592)

View tabular results for solver element end forces (page 593)

Run 1st order linear analysis
1. On the Analyze tab, click 1st Order Linear. 

The Select loading dialog box opens.

2. In the Select loading dialog box, select the combinations and loadcases
that you want to analyze.

3. Click OK. 
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Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

Run a 1st order non-linear analysis
1. On the Analyze toolbar, click Settings. 

The Analysis Settings dialog box opens.

2. In the dialog box, go to the 1st Order Non-Linear page.

3. If necessary, adjust the convergence criteria and relaxation factors.

4. Click OK.

5. On the Analyze tab, click 1st Order Non-linear. 

The Select loading dialog box opens.

6. In the Select loading dialog box, select the combinations and loadcases
that you want to analyze.

7. Click OK. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

Run a 1st order modal analysis
In order to run a modal analysis on your model, see the following instructions.

NOTE To run a modal analysis, your model must contain an active modal
mass combination.

For more information, see Create modal mass combinations
(page 347).

1. On the Analyze toolbar, click Settings. 

The Analysis Settings dialog box opens.

2. In the dialog box, go to the page (page 1052).

3. If necessary, adjust the analysis options.

4. On the Analyze tab, click 1st Order Modal. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View opens to allow you to
display the mode shapes graphically. Tabular results can also be viewed in
a Solver Model Data View.
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Run a 2nd order linear or non-linear analysis
In order to run either a linear or a non-linera 2nd order analysis on your
model, see the following instructions.

Run a 2nd order linear analysis
1. On the Analyze tab, click 2nd Order Linear. 

The Select loading dialog box opens.

2. In the Select loading dialog box, select the combinations and loadcases
that you want to analyze.

3. Click OK. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

Run a 2nd order non-linear analysis
1. On the Analyze toolbar, click Settings. 

The Analysis Settings dialog box opens.

2. In the dialog box, go to the 2nd Order Non-linear page.

3. If necessary, adjust the convergence criteria and relaxation factors.

4. Click OK.

5. On the Analyze tab, click 2nd Order Non-linear. 

The Select loading dialog box opens.

6. In the Select loading dialog box, select the combinations and loadcases
that you want to analyze.

7. Click OK. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

Run a 2nd order buckling analysis
In order to run a buckling analysis on your model, see the following
instructions.

1. On the Analyze toolbar, click Settings. 

The Analysis Settings dialog box opens.
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2. In the dialog box, go to the 2nd Order Buckling page.

3. If necessary, adjust the buckling options.

4. Click OK.

5. On the Analyze tab, click 2nd Order Buckling. 

The Select loading dialog box opens.

6. In the Select loading dialog box, select the combinations and loadcases
that you want to analyze.

7. Click OK. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

See also

The Results View (page 498)

View buckling factors (page 597)

Run a seismic analysis
In order to run either a 1st or 2nd order seismic analysis on your model, see
the following instructions.

Run a 1st order RSA seismic analysis
1. On the Analyze toolbar, click Settings. 

The Analysis Settings dialog box opens.

2. In the dialog box, go to the 1st Order Seismic page.

3. If necessary, adjust the analysis options.

4. Click OK.

5. On the Analyze tab, click 1st Order RSA Seismic. 

Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

Run a 2nd order RSA seismic analysis
• On the Analyze tab, click 2nd Order RSA Seismic. 
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Tekla Structural Designer analyzes the model.

At the end of the analysis process, the Results View and the Results
toolbar open, and allow you review the analysis results graphically.

See also

RSA seismic results (page 518)

The Results View (page 498)

View tabular results for support reactions (page 592)

View tabular results for nodal deflections (page 592)

View tabular results for solver element end forces (page 593)

Run FE chasedown or grillage chasedown analysis
You can run FE chasedown and grillage chasedown analyses by using the
Analyze All (Static) command. The analyses are also run when they are
required as a part of the combined analysis and design process.

RESTRICTION FE chasedown and grillage chasedown analyses are run for
loadcases only, and not for load combinations.

In a combined analysis and design process, Tekla Structural Designer performs
the previously mentioned analyses as follows:

• If the model contains two-way slabs or the user has selected the
appropriate option in the Design Settings dialog box, Tekla Structural
Designer performs FE chasedown analysis.

TIP To control whether Tekla Structural Designer performs FE chasedown
analysis, do the following:

1. On the Design tab, click Settings.

2. Under concrete beams, columns, or walls, go to General
Parameters.

3. Select whether you want to design the members for FE
chasewdown analysis results.

4. Click OK.

• If the model contains one or more concrete members, Tekla Structural
Designer performs the grillage chasedown analysis.

See also

Analyze all combinations and loadcases (page 496)
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Run Analyze All (Static)
Static designs can only be performed provided suitable analysis results exist -
while these results are created when you run a combined analysis and
member design, in some situations you may prefer to run the analysis
separately and then selectively design parts of the model as required.

Analyze All (Static) facilitates this as it performs all the analyses for static
loadcases and active static load combinations that are required to enable the
selective designs to be carried out.

To run a separate analysis in this way proceed as follows:

1. On the Analyze toolbar, click  Analyze All (Static). 

Tekla Structural Designer performs the following analyses:

• 1st order linear/non-linear

• 2nd order linear/non-linear (only if this has been specified by the user in
Design > Design Settings > Analysis))

• Grillage chasedown (if one or more concrete members exist)

• FE chasedown (if two-way spanning slabs exist)

At the end of the analyses if a 2D or 3D view is active it is switched to a Review
View.

See also

The Results View (page 498)

View tabular results for support reactions (page 592)

View tabular results for nodal deflections (page 592)

View tabular results for solver element end forces (page 593)

Run 3D only (Static)
3D only (Static) analysis can be used to save time during scheme design, for
example while addressing overall stability, sway, drift, wind drift, etc.

To run a 3D only analysis proceed as follows:

1. On the Analyze toolbar, click 3D only (Static).

Tekla Structural Designer performs the following 3D analyses:

• 1st order linear/non-linear
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• 2nd order linear/non-linear (only if this has been specified by the user in
Design > Design Settings > Analysis)

At the end of the analysis if a 2D or 3D view is active it is switched to a Review
View.

See also

The Results View (page 498)

View tabular solver model data and results (page 591)

Review tabular data (page 762)

Check sum of reactions against load input
Once you have performed an analysis in your model, you can use the Loading
tree to quickly check that the total reaction from each analysis equates to the
total load on structure. This way, you can quickly verify that none of the
applied loads is missing.

1. In the Project Workspace, go to the Loading tab.

2. Review the status of each loadcase and combination. 

The status options are the following:

• : total reaction equates to the total load on structure

• : total reaction does not equate to the total load on structure

• : total reaction is not available

Example cross-checks

The General section of the properties for each loadcase provides summations
(in global X, Y & Z) of the different load types applied to the structure, from
these the total applied load is determined. The total reaction from the 3D
Analysis result is also reported in this section. Assuming a 3D analysis, FE
chasedown analysis and grillage chasedown analysis have all been performed:

• The Total User Applied Load should equate to the Total Load on
Structure.

• The Total Load on Structure should equate to the Total Reaction for 3D
analysis reported in the General section.

• The Total Load on Structure should equate to the Total Reaction for FE
chasedown analysis reported in the FE ChaseDown section.

• For each sub-model in the FE ChaseDown section the Load Applied when
added to the Load from above should equate to the Reaction

• The Total Load on Structure should equate to the Total Reaction for
Grillage chasedown analysis reported in the Grillage ChaseDown section.
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• For each sub-model in the Grillage ChaseDown section the Load Applied
when added to the Load from above should equate to the Reaction

Check stability and overall displacement
You can use the Status tree in the Project Workspace to review the stability
checks and overall displacement of the model.

Review the stability checks and overall displacement in the Status tree
1. In the Project Workspace click the Status tab

2. In theStatus tree , expand the Design heading.

3. Expand the required check or overall displacement to review as required. 

NOTE Further details of the checks performed are available by reviewing
the tabular design data.

See also:

Filter tabular data (page 811)

6.3 Display analysis results
Once analysis has been run, you can switch 2D and 3D scene views to the
Results View regime to display graphical analysis results. You can also display
analysis results for individual members and walls in a Load Analysis View

Click the links below to find out more:

• The Results View (page 498)

• The Load Analysis View (page 542)

Tabular results are also available, either by creating reports, or by viewing the
tabular solver model data.

See also

View tabular solver model data (page 591)

The Results View

To change to a Results View click  in the Status bar at the bottom of the
main window.
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After setting the analysis type and loading (page 500), most of the results can
then be displayed simply by selecting from the appropriate toolbar group:

Reactions

• Display reactions (page 500)

1D Results

• Display 1D results (page 502)

• Display 1D deflections (page 502)

• Animate 1D and 2D deflections (page 502)

Sway Drift...

• Display sway drift and story shear (page 503)

Notional Loads

• Display notional forces and seismic equivalent lateral forces (page 504)

2D Results

• Display 2D results (page 504)

• Display 2D deflections (page 510)

• Animate 1D and 2D deflections (page 502)

• Display AsReq contours (page 510)

2D Integrated Results

• Display wall lines (page 511)

• Display core lines (page 511)

• Manage, display and design result lines (page 515)

• Manage and display result strips (page 512)

• NOTE Result lines and result strips must be created before they can be
displayed.

Mode Shapes

• Display mode shapes (page 518)

RSA Results

• RSA seismic results (page 518)

If required, adjustments can be applied to the diagrams as follows:

• To change contour intervals and colors, see Customize the display of 2D
contours (page 522)

• To adjust the amplitude of the diagrams, see Change result diagram scale
settings (page 523)
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• In 2D views, it is sometimes necessary to switch to an isometric projection,
see Display 2D view in isometric projection (page 524)

Set the analysis type and loading for viewing analysis results
When Tekla Structural Designer has performed several analysis types, the
results of each analysis are held separately. Therefore, there is no need to re-
perform a particular analysis to recall its results.

1. On the Results toolbar, in the Result Type group, select the required
analysis method. 

NOTE If you select: 1st order modal, 2nd order buckling, 1st order RSA
seismic or 2nd order RSA seismic analyses, you should also
choose the Mode to be displayed.

2. In the Result Type group, if required, click Reduce Axial Force if you
want to take into account reductions when viewing axial forces in a
loadcase or combination in which reductions have been applied.

3. In the Result Type group, click Strength Factors, or Service Factors, as
required, to control which factors are used when displaying results for
combinations.

4. In the Loading list, click either the Select Loadcase, Select

Combination, or Select Envelope button.

5. In the Loading list, select the desired loadcase, combination, or envelope.

You can now proceed to select the diagram to be displayed.

See also

The Results View (page 498)

Display reactions

Support reactions

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the Reactions group, select the reactions to be displayed:
1D Reactions at supports under 1D elements (e.g.

column support reactions),

2D Reactions at supported nodes of 2D elements
(individual meshed wall supports and mat
foundation supports),
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Distributed wall reactions (Fz) - available for self-
supported meshed, mid-pier, bearing and shear-
only wall panels with horizontal bottom levels.

When active the nodal support reactions
exclusive to the wall are hidden.

Summary of assumptions,

• Wall panel has enough height to ensure that
all loading that contributes to the reaction is
far enough from the support such that the
principle of St. Venant is considered valid,

• Material is perfectly homogeneous and
isotropic,

• Elastic limit is nowhere exceeded and 'E' is
same in tension and compression.

Integrated reactions at core supports.

When active support reactions exclusively from
1D and 2D core members are hidden.

4. For Distributed wall reactions the droplist beneath should be set to
Total, for other support reactions you can select the desired reaction
from the droplist.
Fx support local x axis reaction (corresponds to

Fminor in the Foundation Reactions Report),

Fy support local y axis reaction ((corresponds to
Fmajor in the Foundation Reactions Report),

Fz support local z axis reaction (corresponds to
Fvert in the Foundation Reactions Report),

Mx support local x axis moment (corresponds to
Mmajor in the Foundation Reactions Report).

My support local y axis moment (corresponds to
Mminor in the Foundation Reactions Report)

Mz support local z axis moment (corresponds to
Mtor in the Foundation Reactions Report)

Fxyz support local reactions in Fx and Fy and Fz

Mxyz support local reactions in Mx and My and Mz

Total all support local reactions (Fx, Fy, Fz, Mx, My and
Mz.

5. From the Text group select Reaction to display values on the diagram.

Beam end reactions

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the Reactions group, select Beam Ends, then from the droplist
beneath select the desired reaction.

4. From the Text group select Reaction to display values on the diagram.
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Display 1D results

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the 1D Results group, select Results, then from the droplist
underneath it, select the desired result.

4. From the Text group select Forces to display values on the diagram.

See also

Change result diagram scale settings (page 523)

Display 2D view in isometric projection (page 524)

Display 1D deflections

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the 1D Results group, select Deflections, then from the droplist
underneath it, select the desired deflection type.

4. From the Text group select Deflection to display values on the diagram.

See also

Change result diagram scale settings (page 523)

Animate 1D and 2D deflections (page 502)

Animate 1D and 2D deflections
Once the required deflections are displayed, they can be animated as follows:

1. Right click in the view and from the context menu select Animate. 

The animation commences.

2. If required you can change the number of frames per second, the cycle
duration and the amplitude by adjusting the sliders and clicking Apply in
the Animation dialog.

3. To end the animation, simply close the Animation dialog. 

NOTE Animations are available for static displacements and those for
modal and buckling analysis.
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Display sway drift and story shear
Once you have selected the analysis type, and the loadcase, combination, or
envelope, you can simply view the results by selecting the desired reaction on
the Results tab. The commands in the 1D Results group and the Deflections
group display the results for 1D elements, such as beams, columns, and
trusses, and walls modelled using the mid-pier option. Conversely, the
commands in the 2D Results group and the 2D Deflections group display the
results for 2D elements, such as FE slabs and FE walls. For more information,
see the following instructions.

Sway

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the Sway Drift and Story Shear group, select Drift, then from the
droplist beneath select Sway Dir 1 or Dir 2 as required.

4. From the Text group select Deflection to display values on the diagram.

Relative sway

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the Sway Drift and Story Shear group, select Drift, then from the
droplist beneath select Relative Sway Dir 1 or Dir 2 as required.

4. From the Text group select Deflection to display values on the diagram.

Wind drift

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the Sway Drift and Story Shear group, select Drift, then from the
droplist beneath select Wind Drift Dir 1 or Dir 2 as required.

4. From the Text group select Deflection to display values on the diagram.

Shear

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the Sway Drift and Story Shear group, select Drift, then from the
droplist beneath select Dir 1 Shear or Dir 2 Shear as required.
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See also

Change result diagram scale settings (page 523)

Display notional forces and seismic equivalent lateral forces
To view the notional forces or seismic equivalent lateral forces that apply to a
particular load combination or loadcase, see the following instructions.

View the magnitude of EHF in a combination

RESTRICTION The command is only applicable to the Eurocode head code.

1. In the Loading list, select the required combination.

2. On the Results tab, click EHF.

View notional loads in a combination

RESTRICTION The command is only applicable to the ACI/AISC head code.

1. In the Loading list, select the required combination.

2. On the Results tab, click NF.

View the magnitude of NHF in a combination

RESTRICTION The command is only applicable to the BS, IS and Australian
head codes.

1. In the Loading list, select the required combination.

2. On the Results tab, click NHF.

View the magnitude of equivalent lateral forces in a seismic loadcase or
combination

1. In the Loading list, select the required seismic loadcase or combination.

2. On the Results tab, click Seismic.

Display 2D results

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the 2D Results group, select Results, then from the droplist beneath
select the result required.
Mdx top Wood Armer bending along panel x axis, top

surface

Analyze models 504 Display analysis results



Mdx bottom Wood Armer bending along panel x axis, bottom
surface

Mdy top Wood Armer bending along panel y axis, top
surface

Mdy bottom Wood Armer bending along panel y axis, bottom
surface

Bearing pressure Bearing pressure

Fx Axial force in panel x axis

Fy Axial force in panel y axis

Fxy Complimentary in-plane shear

Fxz Shear in panel z axis in the panel xz plane

Fyz Shear in panel z axis in the panel yz plane

Mx Bending along panel x axis

My Bending along panel y axis

Mxy Plate torsional moment

σx top In-plane axial stress in the x direction, top
surface

σy top In-plane axial stress in the y direction, top
surface

τxy top In-plane shear stress, top surface

σx bottom In-plane axial stress in the x direction, bottom
surface

σy bottom In-plane axial stress in the y direction, bottom
surface

τxy bottom In-plane shear stress, bottom surface

σx max tension Maximum tension stress in the x direction for
both surfaces

= max (σxtop, σxbottom, 0) ≥ 0

σy max tension Maximum tension stress in the y direction for
both surfaces

= max (σytop, σybottom, 0) ≥ 0

σx max compression Maximum compression stress in the x direction
for both surfaces

= min (σxtop, σxbottom, 0) ≤ 0

σy max compression Maximum compression stress in the y direction
for both surfaces

= min (σytop, σybottom, 0) ≤ 0

σx in-plane In-plane center stress in the x direction

σy in-plane In-plane center stress in the y direction

σx in-plane tension In-plane center tension stress in the x direction

= max (σxin-plane, 0) ≥ 0

σy in-plane tension In-plane center tension stress in the y direction

= max (σyin-plane, 0) ≥ 0

σx in-plane compression In-plane center compression stress in the x
direction

= min (σxin-plane, 0) ≤ 0
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σy in-plane compression In-plane center compression stress in the y
direction

= min (σyin-plane, 0) ≤ 0

NOTE Tooltips are available for the contour plots, by hovering over nodes.
These display all the relevant results at the node for the selected
loading.

See also

Stresses in 2D elements (page 506)

Stresses in 2D elements

Which stresses can be displayed?

You can view the stresses on the outer faces of 2D elements for both slabs
and walls by selecting the required result from droplist beneath Results in the
2D Results group.

The first 6 values are calculated directly from the forces and moments:

1. σx top - in-plane axial stress in the x direction, top surface

2. σy top - in-plane axial stress in the y direction, top surface

3. τxy top - in-plane shear stress in xy direction, top surface

4. σx bottom - in-plane axial stress in the x direction, bottom surface

5. σy bottom - in-plane axial stress in the y direction, bottom surface

6. τxy bottom - in-plane shear stress in xy direction, bottom surface

NOTE The above 6 values are available for loadcases & combinations, but not
envelopes

The next 4 values are determined from the first 6 values:

1. σx max tension - maximum tension stress in the x direction for both
surfaces

2. σy max tension - maximum tension stress in the y direction for both
surfaces

3. σx max compression - maximum compression stress in the x direction for
both surfaces

4. σy max compression - maximum compression stress in the y direction for
both surfaces

NOTE The above 4 values are available for loadcases, combination &
envelopes.
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The center stress values are calculated directly from the forces and moments:

1. σx in-plane - in-plane axial stress in the x direction, center

2. σy in-plane - in-plane axial stress in the y direction, center

The last 4 values are determined from the above 2 values:

1. σx in-plane tension - maximum tension stress in the x direction center

2. σy in-plane tension - maximum tension stress in the y direction center

3. σx in-plane compression - maximum compression stress in the x direction
center

4. σy in-plane compression - maximum compression stress in the y direction
center

How might these results be used?

Users performing the design of structures with concrete core walls are
interested to know which panels within the walls are cracked. Which panels
are cracked can be determined by comparing the maximum tensile stress in
each panel to the concrete tensile strength.

Tekla Structural Designer calculates stress values from the gross section
properties (ignoring the reinforcement). To determine cracked panels, you can
see the maximum tension (and compression) stress in each direction for each
panel, across loadcases, combinations and envelopes.

Calculation of in-plane axial and shear stress

For loadcases and combinations, by using the 2D element thickness, stresses
(based on the gross section properties) can be calculated from the forces at
the nodes:

σxtop = Fx / t + 6Mx / t2

σytop = Fy / t + 6My / t2

τxytop = Fxy / t + 6Mxy / t2

σxbottom = Fx / t - 6Mx / t2

σybottom = Fy / t - 6My / t2

τxybottom = Fxy / t - 6Mxy / t2

σxin-plane = Fx / t

σyin-plane = Fy / t

NOTE • Tension stresses are positive
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• Compression stresses are negative

The process for enveloping the above values is the same as that used for other
envelopes. For each of the items, a pair of values is found, these are the
minimum & maximum values across all loadcases and combinations.

Calculation of maximum tension and compression stress for loadcases and combinations

For loadcases and combinations, the maximum tension and compression
values are determined for a specific direction by finding the maximum or
minimum of the top and bottom stresses in that direction:

σx max tension = Max ( σxtop, σxbottom, 0.0 )

σy max tension = Max ( σytop, σybottom, 0.0 )

σx max compression = Min ( σxtop, σxbottom, 0.0 )

σy max compression = Min ( σytop, σybottom, 0.0 )

σx in-plane tension = Max ( σxin-plane, 0.0 )

σy in-plane tension = Max ( σyin-plane, 0.0 )

σx in-plane compression = Min ( σxin-plane, 0.0 )

σy in-plane compression = Min ( σyin-plane, 0.0 )

For envelopes, the maximum tension and compression values are determined
by applying the above equations to the enveloped values. Envelopes yield two
values for each of the 4 entries in the dropdown.

Calculation of maximum tension and compression stress for envelopes

For envelopes, the maximum tension and compression values are determined
by applying the above equations for loadcases and combinations to the
enveloped values.

Envelopes yield two values for each of the 4 entries in the droplist.

For tension stresses (x or y - only x shown for brevity) the values are returned
are:

σx max tension = m1 / m2 , where:

m1 = Min ( σxtop max across all cases & combs , σxbottom max across all cases & combs ,
0.0 )

m2 = Max ( σxtop max across all cases & combs , σxbottom max across all cases & combs ,
0.0 )

For compression stresses (x or y - only x shown for brevity) the values
returned are:

σx max compression = m1 / m2 , where:

m1 = Min ( σxtop min across all cases & combs , σxbottom min across all cases & combs, 0.0 )
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m2 = Max ( xtop min across all cases & combs , σxbottom min across all cases & combs , 0.0 )

In summary the values visible in the tooltip are:

σx max tension  = Min (σxtopmax across all

cases & combs, σxbottommax

across all cases & combs, 0.0) /

Max (σxtopmax across all

cases & combs, σxbottommax

across all cases & combs, 0.0)

   
σy max tension  = Min (σytopmax across all

cases & combs, σybottommax

across all cases & combs,
0.0 ) /

Max (σytopmax across all

cases & combs, σybottommax

across all cases & combs, 0.0)

   
σx max compression  = Min (σxtopmin across all

cases & combs, σxbottommin

across all cases & combs, 0.0) /

Max (σxtopmin across all

cases & combs, σxbottommin

across all cases & combs, 0.0)

   
σy max compression  = Min (σytopmin across all

cases & combs, σybottommin

across all cases & combs,
0.0 ) /

Max (σytopmin across all

cases & combs, σybottommin

across all cases & combs, 0.0)

Key points when using stress values

1. In Walls X direction is horizontal in plane of wall and Y is vertical

2. “Top”/”Bottom” is dependent on shell local axis system, but if you are only
concerned about max values you don’t need to worry about this - use the
“max” options which consider both faces.

3. For engineers wanting to consider tensile stresses in walls the “σy in-plane
tension” option will be of greatest interest.
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• This is based purely on the membrane tension stress (i.e. ignoring out
of plane bending effects).

• This can be viewed for enveloped results

• It is very easy to see walls/panels in which no tension stress is
developing.

• In a full 3D view it may be difficult to assess whether a particular
cracking stress level is exceeded. Viewing results in 2D views or sub
structures may be helpful here.

• It should be clear that this is based on the concrete section only -
reinforcement content is not considered.

See also

Display 2D results (page 504)

Display 2D deflections

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the 2D Results group, select Deflections, then from the droplist
beneath select the desired deflection type.

4. From the Text group select Deflection to display values on the diagram.

See also

Customize the display of 2D contours (page 522)

Change result diagram scale settings (page 523)

Animate 1D and 2D deflections (page 502)

Display AsReq contours
AsReq contours can either be displayed as values, or as a pass/fail threshold.
Displaying as a pass/fail threshold helps to visualize minimum patch sizes
when optimizing panel and patch reinforcement as it highlights the specific
areas in which the existing reinforcement is not sufficient.

1. Go to the Results toolbar.

2. Set the analysis type and loading for viewing analysis results (page 500). 

NOTE Typically the analysis method will be FE chase-down

3. In the 2D Results group , select As Req.

4. From the first droplist, select the desired direction and slab face.
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5. From the second droplist, select Value, or Pass/Fail as required.

See also

Customize the display of 2D contours (page 522)

Change result diagram scale settings (page 523)

Display wall lines
Tekla Structural Designer automatically creates a wall line at the centroid of
every meshed shear wall to facilitate the display of wall forces.

1. In the Status bar, click Results View. 

The Results toolbar opens.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the 2D Integrated Results group, select Wall Lines, then from the
droplist in the same group, select the desired result.

4. From the Text group select Forces to display values on the diagram. 

Tekla Structural Designer displays the selected result on the wall line.

TIP If you are working in a 2D view and you can't see any results, try
displaying the view in isometric projection (page 524).

Display core lines
Tekla Structural Designer automatically creates a core line at the centroid of
each concrete core to facilitate the display of core forces.

1. In the Status bar, click Results View. 

The Results toolbar opens.

2. Set the analysis type and loading for viewing analysis results (page 500).

3. In the 2D Integrated Results group, select Core Lines, then from the
droplist in the same group, select the desired result.

4. From the Text group select Forces to display values on the diagram. 

Tekla Structural Designer displays the selected result on the core line.

NOTE All forces in the results are rotated to be in the axis system of the
core line.
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TIP If you are working in a 2D view and you can't see any results, try
displaying the view in isometric projection (page 524).

See also

Create concrete cores (page 245)

Manage and display result strips
You can place user-defined result strips across 2D element meshes. For these
strips, Tekla Structural Designer determines the force and moment results
from the shell/plate/membrane nodal analysis results. These results can then
be used for design purposes, typically for slab design.

Engineering judgement is required when positioning the strips to ensure
suitable design forces are obtained.

By default, strips have parallel edges, but tapering strips can also be defined
as shown in the following image:

Create result strips

1. Open a 2D view of the FE mesh where you want to place the strip.

2. In the Status bar, click Results View. 

The Results toolbar opens.

3. In the 2D Integrated Results group, click Result Strip.

4. In the Properties window, adjust the result strip properties according to
your needs.

5. Click the start point of the strip.

6. Click the end point of the strip. 

TIP Neither the start or the end point have to match nodes in the mesh.

Tekla Structural Designer creates a strip between the selected points.

7. Do one of the following:
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• Continue placing further strips.

• Press Esc to exit the command.

View the results for result strips

Once you have created a result strip in the model, you can obtain results for it
without re-running the analysis. In order to view the results, do the following:

1. Open a 3D view containing the strips whose results you want to view.

2. Go to the Results toolbar.

3. In the first list of the Result Type group, select the desired result type.

4. In the Loading list, select the loadcase or combination that you want to
display.

5. In the 2D Integrated Results group, click the effect that you want to view.

Tekla Structural Designer displays the selected effect on the strip, and its
maximum positive and negative values, calculated according to the result
type specified in the strip properties.

NOTE Tekla Structural Designer contains the following three ways to
calculate the results:

Me
th
od
na
me

Details

No
rm
al

• The results on the center of the result
strip are calculated at each station*.

• Tekla Structural Designer considers
the shell elements local to each
station, and calculates a weighted
average force based on the distance
of the element nodes from the
station.

The process is repeated for all
stations along the center line of the
strip to give the results.

Ma
xi
mu
m

• The results on the transverse line
across the strip are calculated for
each station* along the strip.

• Tekla Structural Designer considers
the shell elements local to each point,
and calculates a weighted average
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Me
th
od
na
me

Details

force based on the distance of the
element nodes from the point. The
maximum result across the strip from
all points is taken as the result for the
station on the strip center line.

The process is repeated for all
stations along the center line of the
strip to give the results.

• The values calculated at points are
always weighted averages of results at
adjacent nodes. Therefore, they are
always less than the peak nodal
values.

• Maximum values include nodes within
the strip.

Av
era
ge

• Average over strip width.

• The results are obtained in the same
way as for the maximum option, but
in this case, they are averaged to give
the results for each station*.

The process is repeated for all
stations along the center line of the
strip to give the results.

•

* Along the strip center line, there is a user-defined number of
stations. At each station, there is a transverse line with a user
defined number of points along it. Final results are always given
by station, and obtaining them may or may not use points.

All forces in the results are rotated to be in the axis system of the
result strip.

Delete result strips

TIP To delete a strip, ensure that Result Strips are switched on in Scene
Content.

1. Open a view containing the strip that you want to delete.
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2. In the Quick Access toolbar, click Delete.

3. In the model, click the strip that you want to delete. 

Tekla Structural Designer deletes the selected strip.

See also

Change result diagram scale settings (page 523)

Display 2D view in isometric projection (page 524)

Manage, display and design result lines
You can place user-defined result lines across 2D element meshes. For these
lines, Tekla Structural Designer determines the force and moment results from
the shell/plate/membrane nodal analysis results. These results can then be
used to assess design solutions, typically for the design of wall panels with
openings.

Engineering judgement is required when positioning the lines to ensure
suitable design forces are obtained.

Create result lines

1. Open a 2D view containing the wall or slab within which you want to place
the strip.

2. In the Status bar, click Results View. The Results toolbar opens.

3. In the 2D Integrated Results group, click  Result Line.

4. Click the start point of the line.

5. Click the end point of the line. 

TIP Neither the start or the end point have to match nodes in the mesh.

Tekla Structural Designer creates a result line between the selected
points.

6. Do one of the following:

• Continue placing further result lines.

• Press Esc to exit the command.

View the analysis results for result lines

NOTE An analysis must be performed after adding or editing result lines in
order to obtain up to date results.
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To view the results, do the following:

1. Open a view containing the result lines whose results you want to view.

2. In the Status bar, click Results View. 

The Results toolbar opens.

3. Set the analysis type and loading for viewing analysis results (page 500).

4. In the 2D Integrated Results group, click Result Lines, then from the
droplist in the same group, select the desired result.

5. From the droplist in the 2D Integrated Results group, select the effect
that you want to view.

6. From the Text group select Forces to display values on the diagram. 

Tekla Structural Designer displays the selected result on the result line.

NOTE All forces in the results are rotated to be in the axis system of the
result line.

TIP If you are working in a 2D view and you can't see any results, try
displaying the view in isometric projection (page 524).

See also:

View tabular results for result lines (page 594)

Interactively design result lines

1. Open a view containing the result line to be designed.

2. Hover the mouse pointer over the result line that you want to design. 

The Select Entity tooltip appears.

3. In the Select Entity tooltip, navigate to the result line (RL) name by using
the arrow keys.
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4. Right-click the result line.

5. In the context menu, select Interactive Design... (as a column section, or
as a wall section as required). 

The selected (column or wall) interactive design dialog is displayed with
the Additional Design Cases page populated with the result line results.

6. Modify the reinforcement parameters as required to achieve a
satisfactory design, and click the Check button to examine the detailed
design results.

7. Click OK to save the designed reinforcement to the result line. 

NOTE For help on using the interactive dialogs, see and .

Features of result line design

• The interactive design dialog features full interactive manual selection of
both lateral and vertical reinforcement, interaction diagrams and auto-
design and check options, just as for a regular wall/ column section
interactive design.

• The wall length/ column depth considered is the Result Line length.

• Result lines are not constrained to cross sections in the horizontal plane -
vertical sections can be used above/between openings to investigate forces
and reinforcement requirements in “coupling beams”.

• The section design always considers the main bars (running
perpendicular to the cross section) as being on the inner layer, from a
design perspective this will tend to be conservative but the engineer
should give this some consideration when working with non-horizontal
sections.

• The design does not consider the existing reinforcement specified in
wall properties - only that which is defined in the Interactive design
dialog.

• Currently this feature is not linked with Reports and so it is envisaged
output will be via screenshots of the interactive design and check
results dialogs.

• The same result line can be used to interactively design as a column, and
as a wall. Both designs are saved to the result line independently.

Delete result lines

TIP To delete a result line, ensure that Result Lines are switched on in Scene
Content.

1. Open a view containing the result line that you want to delete.

2. In the Quick Access toolbar, click Delete.
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3. In the model, click the result line that you want to delete. 

Tekla Structural Designer deletes the selected result line.

Related video

Interactive design using Result lines

Display mode shapes
When Tekla Structural Designer has performed several analysis types, the
results of each analysis are held separately. Therefore, there is no need to re-
perform a particular analysis to recall its results.

1. Open a suitable 2D or 3D View and change the view regime (page 89) to a
Results View.

2. On the Results tab, in the Result Type group, select the required analysis
type.

3. In the Loading list, select the required loadcase or combination. 

NOTE For RSA seismic analysis, only select load cases, as mode shapes
are not applicable for combinations, and therefore cannot be
viewed.

4. In the second list of the Result Type group, select the desired mode.

5. Select the diagram that you want to display.

See also

The Results View (page 498)

RSA seismic results
For information on how RSA seismic results are displayed for different
loadcases and combinations, see the following paragraphs.

Result Type

When the result type is 1st or 2nd order RSA seismic, the results that can be
displayed depend on the type of the currently selected loadcase or
combination.

Mode Shapes

Mode shapes can be displayed for:

• RSA Seismic loadcases:

• Combined (CQC) or combined (SRSS), depending on your choice in
Analysis Settings
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• All modes that are relevant for the selected loadcase

• Effective seismic weight combination:

• List of all modes returned by the modal analysis

Mode shapes are not displayed for:

• RSA torsion loadcases

• Static loadcases included in the RSA seismic combination

• RSA seismic combinations

   

See also

• Display mode shapes (page 518)

1D Element Results

1D element results (and Load Analysis View results) are displayed as follows:

Loadcase or combination Display method
RSA seismic loadcases Combined (CQC) or combined (SRSS),

depending on your choice in Analysis
Settings:

Absolute values are determined at
various points along each member
and displayed on both the positive
and negative side of the diagram.
Therefore, the diagrams are always
symmetrical about the base line.

All relevant modes:

A standard enveloped diagram is
displayed.

RSA torsion loadcases Displayed as per 1st order linear
analysis.

Static loadcases included in the RSA
seismic combination

Displayed as per 1st order linear
analysis.

Effective seismic weight combination Not available
RSA seismic combinations An envelope is drawn displaying the

seismic results above and below the
static result:

• Baseline goes through the static
values

• Top line = static value + seismic
value
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Loadcase or combination Display method
• Bottom line = static value - seismic

value

   

See also

• Display 1D results (page 502)

Story Shear

Story shears are displayed as follows:

Loadcase or combination Display method
RSA seismic loadcases Combined (CQC) or combined (SRSS),

depending on your choice in Analysis
Settings:

Absolute values are determined at
each position of interest and the
result is displayed as both positive
and negative.

All relevant modes:

A standard diagram with a single
value at each point of interest is
displayed.

RSA torsion loadcases Displayed as per 1st order linear
analysis.
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Loadcase or combination Display method
Static loadcases included in the RSA
seismic combination

Displayed as per 1st order linear
analysis.

Effective seismic weight combination Not available
RSA seismic combinations The diagram displays two values at

each point of interest:

• Static value + seismic value

• Static value - seismic value

   

See also

• Display sway drift and story shear (page 503)

Support Reactions

Support reactions are displayed as follows:

Loadcase or combination Display method
RSA seismic loadcases Combined (CQC) or combined (SRSS),

depending on your choice in Analysis
Settings:

Absolute values are determined at
each support and the result is
displayed as both positive and
negative.

All relevant modes:

A standard diagram is displayed.
RSA torsion loadcases A standard diagram is displayed.
Static loadcases included in the RSA
seismic combination

A standard diagram is displayed.

Effective seismic weight combinations Not available
RSA seismic combinations The diagram displays two values at

each support:

• Static value + seismic value

• Static value - seismic value

   

See also

• Display reactions (page 500)

Concrete Wall Results

Concrete wall results are displayed as follows:
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Loadcase or combination Display method
RSA seismic loadcases Combined (CQC) or combined (SRSS),

depending on your choice in Analysis
Settings:

Absolute values are determined at
points along the wall line and
displayed on both the positive and
negative side of the diagram.
Therefore, the diagrams are always
symmetrical about the wall line.

All relevant modes:

A standard diagram is displayed.
RSA torsion loadcases A standard diagram is displayed.
Static loadcases included in the RSA
seismic combination

A standard diagram is displayed.

Effective seismic weight combinations Not available
RSA seismic combinations An envelope is drawn displaying the

seismic results above and below the
static result:

• Baseline goes through the static
values

• Top line = static value + seismic
value

• Bottom line = static value - seismic
value
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Customize the display of 2D contours
By default, all contour diagrams consist of 10 evenly sized contours, each
accounting for 10% of the total range. If necessary, you can increase or
decrease the number of contours, and also change the size and the color of
individual contours.

1. On the Home tab, click Settings. 

The Settings dialog box opens.

NOTE If you intend to make the changes to the contours in the current
model, ensure that you are making changes to the active settings
set.

2. Go to Scene --> Contours .

3. According to your needs, do one or more of the following:

To Do this
Add new contours • Click Split.

Delete existing contours • Click Delete.

Modify the size of contours • In the Size [%] column, type new values in
the appropriate cells.

Change the color of contours a. In the Color column, click the color that
you want to change.

b. Select a new color.

c. Click OK.

Revert to the default contour settings • Click Reset.

4. Click OK.

See also

The Results View (page 498)

Change result diagram scale settings
• Move the sliders in the Scale Settings group according to adjust the

diagram amplitude according to your needs. 
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The below example shows the effect on an axial force diagram when the
1D Results slider is increased from minimum to maximum.

See also

The Results View (page 498)

Display 2D view in isometric projection
Because the diagrams are plotted on each element in the planes in which they
act when you are working in a 2D view, you will need switch on an isometric
display to see the out of plane forces.

If the 2D view is currently displayed in plan, the 2D/3D toggle button at the
bottom right corner of the screen is labeled 3D.

• To change the current view, click the 2D/3D toggle button.

See also

The Results View (page 498)

Sign conventions and coordinate systems
Tekla Structural Designer adopts the standard convention that lower case x, y,
and z represent local coordinate systems, whereas upper case X, Y, and Z
represent the global coordinate system. For more information on analysis
result sign conventions, see the following paragraphs.

Axis systems

The following table presents the axis systems that can be used in Tekla
Structural Designer:
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Axis system name Description
Global coordinate system The global XYZ axis system within

which all other systems exist.
Building directions 1 and 2 The principle axes of the building,

where dir 1 is rotated at an angle to
global X in the horizontal plane.

User coordinate system A local coordinate system defined by
the system or the user.

1D member local coordinate system The local coordinate system that is
applicable to all 1D members, such as
beams, columns, and braces.

Mid-pier wall coordinate system The local coordinate system that is
applicable to walls modeled using the
mid-pier option.

2D member local coordinate system The local coordinate system that is
applicable to all 2D members, walls,
and slabs.

Result line coordinate system The local coordinate system that is
applicable to result lines.

Result strip coordinate system The local coordinate system that is
applicable to result strips.

Foundation reaction coordinate
system

The local coordinate system that is
applicable to foundations.

General information

All global (XYZ) and local (xyz) axis systems follow the right-hand rule, where:

• x axis is the pointing index finger.

• y axis is the crooked middle finger.

• z axis is the extended thumb.

In the directions of positive rotation:

• About x: the y axis moves toward the z axis.

• About y: the z axis moves toward the x axis.

• About z: the x axis moves toward the y axis.

Object orientation

Tekla Structural Designer considers the orientation of the object when
displaying the analysis results. Therefore, to apply the sign convention
correctly, you need to know which is the end 1 and which is the end 2 of
beams or walls, and which is the face A of columns.

If you select the Direction option for an element in Scene Content, Tekla
Structural Designer displays an arrow on all beams, walls and columns. This
arrow points from the start to the end of beams and walls, and from the
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bottom to the top of columns along the face A. Looking down from the top of
a column, Face B, C, and D then follow in the clockwise direction.

Diagram conventions

All arrows should point in the direction of the force or moment, as the
following image illustrates:

If the arrows are reversed, they become negative forces and moments, as the
following image illustrates:

Global coordinate system

The following image illustrates the global axis system and applied load
directions.

The resulting deflection directions appears as follows.
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Building directions 1 and 2

Global axes (positive Z vertically up) and angle between X and direction 1 is θ,
where θ is positive in right-hand rule about Z.

The following image illustrates the building directions and applied load
directions.

The resulting deflection directions appear as follows.

User coordinate system

A user coordinate system can be at any angle to the global coordinate system.

The following image illustrates the axis system of a user coordinate system
axis and applied load directions.
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The resulting deflection directions appear as follows.

NOTE Every support is given a user coordinate system. Automatically
created supports under certain objects default to the following
method:

• Support under a single column or wall rotates the foundation
forces to align with the y/z-axes of the column or wall

• Support under a mat foundation - uses the global coordinate
system.

All other supports default to the global coordinate system.

1D member local coordinate system (general case)

Local axis system and applied load directions:

• The local x axis along member starts from end 1 and ends in end 2

• When γ = 0:

• The local z axis lies in the plane created by the local x axis and the
global Z axis.

• The global Z component of the local z axis is always negative.

• The local y axis follows the right-hand rule.

γ = positive clockwise rotation of y and z axes about the x axis looking
towards positive x.
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Applied force directions:

• z = Major (Fz and My):

• y = Minor (Fy and My):
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• x = Axial:

Result axis system and directions

In the major axis:

• Moment major = bending about the y axis

• Shear major = shear along the z axis

In the minor axis:

• Moment minor = bending about the z axis

• Shear minor = shear along the y axis
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In the axial direction:

Resulting member end forces and directions

Member end forces are the forces applied to the rest of the structure by the
member. Based on loading applied above, the forces would be applied as
follows:

1D member local coordinate system (vertical members)

Local axis system and applied load directions

Local x aligns with global Z (vertical):

• When γ = 0:

• The local y axis aligns with global X.

• The local z axis according to the right-hand rule.

γ = positive clockwise rotation of y and z about the x axis towards positive
x.
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Applied force directions as displayed in the previous image:

• z = Major

• y = Minor

• x = Axial

Result axis system and directions

In the major axis:

• Moment major = bending about the y axis

• Shear major = shear along the z axis

In the minor axis:

• Moment minor = bending about the z axis
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• Shear minor = shear along the y axis

In the axial direction:

Mid-pier wall coordinate system

Wall axis system and applied load directions

As the following image illustrates, centered on the centroid of the cut section:

• the x axis lies along the stem mid-pier element (positive lowest to highest)

• the z axis lies along the plane of the wall (positive end 2 to end 1)

• the y axis follows the right-hand rule and is normal to the wall.
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The results from a mid-pier model are in the same axis system as the result
line in a meshed wall.

Result axis system and direction

In the major axis:

• Moment major = bending about the y axis:
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• Shear major = shear along the z axis:

In the minor axis:

• Moment minor = bending about the z axis:
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• Shear minor = shear along the y axis:

In axial and torsion, force is in the x axis and torsion about the x axis:

2D member local coordinate system

Horizontal panel local axis system and applied load directions

Horizontal panel local axes are the following:

• The local z axis is normal to the plane of the panel

• When θ = 0:

• The local x axis plane is in the plane of the panel, aligned with the global
X axis and positive in the positive global X direction.
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• The local y axis is in the plane of the panel and follows the right-hand
rule.

θ = positive clockwise rotation of the x and y axis about the z axis looking
towards positive z.

Vertical and sloped panel local axis system and applied load directions

Vertical and sloped panel local axes are the following:

• The local z axis is normal to the plane of the panel.

• When θ = 0:

• The local x axis plane is in the plane of the panel and in a horizontal
plane.

• The local y axis is in the plane of the panel and follows the line of
greatest slope of the plane (positive in the direction of positive global).

θ = positive clockwise rotation of x and y a bout z looking towards positive
x.

Sloped panel (axes at θ):

Vertical panel (axes when q = 0):

Analyze models 537 Display analysis results



2D member forces sign convention

The sign convention for 2D member forces is not the same as that of 1D
elements. The following diagram illustrates the forces and the panel and 2D
element axis system (for results):
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• The arrows in the diagram show positive force directions.

• The double-arrow convention is used for moments: the moment is
around the double-arrow, positive being clockwise when looking in the
arrow direction.

• The forces act on a member face cut anywhere in the FE mesh,
perpendicular to the force direction.

Thus, for example, Mx acts on the X face that is perpendicular to the X axis
and is moment resulting from spanning in the X direction, Fxz is the out-of-
plane shear force acting on the X face, and so on.

• The wood armer design moments (denoted by the d suffix) act in the same
manner as the unprocessed moments without the d suffix. Thus, Mdx acts
in the same manner as Mx, and so on.

• The design moments are further classified into top and bottom
components for the slab design process.

• The positive Z axis direction (up) follows the right-hand rule and, therefore,
is not the same as that for the 2D member local coordinate system. This is
because the 2D member local coordinate system for the applied load
directions displays the positive applied load direction convention that, for Z
only, is opposite to the convention of the global and 2D element axes.

• A positive moment creates tension in the top surface of the shell.
Therefore, the moment over a supporting column is positive, whereas the
span moment is negative.

• The conventions for wall results are exactly the same as conventions for
columns, so they can be interpreted in the same way.

• The compression of axial loads (Fx and Fy) is negative.

• Out-of-plane shear (Fxz and Fyz) is positive when shear is such that
moment is increasing in the positive X or Y direction.

Result line coordinate system

Centered on the centroid of the cut section:

• The z axis lies along the result line (positive end 2 to end 1).

• The y axis normal to plane of mesh (generally positive in the positive Z
direction, in special cases positive x towards positive Z).

• The x axis follows the right-hand rule and lies in the mesh, so x is
perpendicular to the cut line.
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NOTE The results from a result line are exactly like those for a mid-pier
model when the cut is horizontal and the cut direction matches the
direction required.

Result Axis System

• In the major axis: bending about the y axis and shear along the z axis

• In the minor axis: bending about the z axis and shear along the y axis

• Axial and torsion: force in x and bending about the x axis

General case:

Special case:

Result strip coordinate system

Centered at each station along the strip center line, whether there is a single
or several continuous strips:
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• The z axis is normal to plane of mesh (generally positive in the negative Z
direction, in special cases positive x towards positive Z).

• The x axis lies along the result strip (positive end 1 to end 2)

• The y axis lies along the transverse line to the result strips and follows the
right-hand rule, so the y axis is perpendicular to the strip line.

Result axis system

• Deflection in the z direction

• Out of plane moment about the y axis

• Shear in the z direction

General case:

Special case:
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Foundation reaction coordinate system

As the following image illustrates, the foundation reaction coordinate system
is aligned with the coordinate system for the support node, whether that is the
global coordinate system or a user coordinate system.

Reactions are the forces applied to the structure by the foundation. They
appear as follows.

The Load Analysis View
Analysis results for individual members and walls can be displayed in a Load
Analysis View.

Open a Load Analysis View
1. Right-click the member whose loading and analysis results you want to

view.

2. In the context menu, select Open Load Analysis View. 

Tekla Structural Designer opens the load analysis view and the Loading
Analysis tab.

3. In the Loading list, select the loadcase or combination whose results you
want to view.

4. Select the analysis type using the list in the Result Type group.

5. If you are viewing the results for a load combination, in the Result Type
group, select whether you want to view the results based on strength or
service factors.
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6. In the Direction group, select the axis type (Axial, Major, or Minor). 

Tekla Structural Designer displays the results according to the selected
options. If necessary, you can control the results in the Properties
window.

Load Analysis View properties for columns
Result Type: Axial

Property Description
Distance The results can be reported at any

position along the column, either by
typing the distance directly into the
Properties window, or, on the
diagram, by dragging this slider

 to the position required.

NOTE For concrete columns only: If
rigid zones have been
applied, only the non-rigid
length of the column is
displayed in the loading
analysis view.

Stack Specifies the stack for which results
are displayed.

Axial force above The axial force in the column
immediately above the cross section
at the distance specified.

Axial force below The axial force in the column
immediately below the cross section
at the distance specified.

Axial force reduced above The axial force in the column
immediately above the cross section
at the distance specified, taking into
account imposed load reductions.

Axial force reduced below The axial force in the column
immediately below the cross section
at the distance specified, taking into
account imposed load reductions.

Torsion moment above The torsion in the column
immediately above the cross section
at the distance specified.
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Property Description
Torsion moment below The torsion in the column

immediately below the cross section
at the distance specified.

Show axial force If cleared, the axial force diagram is
removed from the view.

Show axial force reduced If cleared, the axial force diagram is
removed from the view.

Show torsion moment If cleared, the torsion diagram is
removed from the view.

Show dimensions If cleared, the dimensions are
removed from the view.

Show extremes If cleared, the max and min values are
removed from the view.

Result Type: Major, Minor

Property Description
Distance The results can be reported at any

position along the column, either by
typing the distance directly into the
Properties window, or, on the
diagram, by dragging this slider

 to the position required.

NOTE For concrete columns only: If
rigid zones have been
applied, only the non-rigid
length of the column is
displayed in the loading
analysis view.

Stack Specifies the stack for which results
are displayed.

Shear above The major or minor shear force
immediately above the cross section
at the distance specified.

Shear below The major or minor shear force
immediately below the cross section
at the distance specified.
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Property Description
Moment above The major or minor moment

immediately above the cross section
at the distance specified.

The Moments diagram is solid and
shaded.

Moment below The major or minor moment
immediately below the cross section
at the distance specified.

Ecc. Moment above The major or minor moment due to
eccentricity immediately above the
cross section at the distance
specified.

The eccentricity moments diagram is
dashed and unshaded.

Ecc. Moment below The major or minor moment due to
eccentricity immediately below the
cross section at the distance
specified.

Relative deflection The relative deflection in the major or
minor direction at the distance
specified.

Applied load above The applied distributed load in the
major or minor direction immediately
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Property Description
above the cross section at the
distance specified.

Applied load below The applied distributed load in the
major or minor direction immediately
below the cross section at the
distance specified.

Applied force The applied point load in the major or
minor direction at the distance
specified.

Applied moment The applied moment in the major or
minor direction at the distance
specified.

Show loading If cleared, the loading diagram is
removed from the view.

Show shear If cleared, the shear diagram is
removed from the view.

Show moment If cleared, the moment diagram is
removed from the view.

Show relative deflection If cleared, the relative deflections
diagram is removed from the view.

Show dimensions If cleared, the dimensions are
removed from the view.

Show extremes If cleared, the max and min values are
removed from the view.

Load Analysis View properties for beams
Result Type: Axial

Property Description
Distance The results can be reported at any

position along the beam, either by
typing the distance directly into the
Properties window, or, on the
diagram, by dragging this slider
shown below to the position required.

NOTE For concrete beams only: If
rigid zones have been
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Property Description

applied, only the non-rigid
length of the beam is
displayed in the loading
analysis view.

Span Specifies the span for which results
are displayed.

Axial force left The axial force in the beam
immediately to the left of the cross
section at the distance specified.

Axial force right The axial force in the beam
immediately to the right of the cross
section at the distance specified.

Torsion moment left The torsion in the beam immediately
to the left of the cross section at the
distance specified.

Torsion moment right The torsion in the beam immediately
to the right of the cross section at the
distance specified.

Relative angle of twist The relative angle of twist (due to
torsion) in the beam cross section, at
the distance specified.

Angle of twist derivative A droplist allowing the selection of the
derivative of angle of twist:

• First

• Second

• Third

(This property is displayed for “Open”
sections only).

Angle of twist derivative left The relative angle of twist (due to
torsion) in the beam cross section,
immediately to the left of the distance
specified.

(This property is displayed for “Open”
sections only).

Angle of twist derivative right The relative angle of twist (due to
torsion) in the beam cross section,
immediately to the right of the
distance specified.

(This property is displayed for “Open”
sections only).
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Property Description
Show axial force If cleared, the axial force diagram is

removed from the view.

(This property is only displayed if the
Axial direction is selected.)

Show torsion moment If cleared, the torsion diagram is
removed from the view.

(This property is only displayed if the
Axial direction is selected.)

Show relative angle of twist If cleared, the relative angle of twist
diagram is removed from the view.

Show angle of twist derivative If cleared, the angle of twist derivative
diagram is removed from the view.

(This property is displayed for “Open”
sections only).

Show dimensions If cleared, the dimensions are
removed from the view.

Show extremes If cleared, the max and min values are
removed from the view.

Result Type: Major, Minor, (plus Major Principal and Minor Principal for
angle sections)

Property Description
Distance The results can be reported at any

position along the beam, either by
typing the distance directly into the
Properties window, or, on the
diagram, by dragging this slider
shown below to the position required.

NOTE For concrete beams only: If
rigid zones have been
applied, only the non-rigid
length of the beam is
displayed in the loading
analysis view.

Span Specifies the span for which results
are displayed.
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Property Description
Shear left The major or minor shear force

immediately to the left of the cross
section at the distance specified.

Shear right The major or minor shear force
immediately to the right of the cross
section at the distance specified.

Moment left The major or minor moment
immediately to the left of the cross
section at the distance specified.

Moment right The major or minor moment
immediately to the right of the cross
section at the distance specified.

Relative deflection The relative deflection in the major or
minor direction at the distance
specified.

Applied load left The applied distributed load in the
major or minor direction immediately
to the left of the cross section at the
distance specified.

Applied load right The applied distributed load in the
major or minor direction immediately
to the right of the cross section at the
distance specified.

Applied force The applied point load in the major or
minor direction at the distance
specified.

Applied moment The applied moment in the major or
minor direction at the distance
specified.

Show loading If cleared, the loading diagram is
removed from the view.

Show shear If cleared, the shear diagram is
removed from the view.

Show moment If cleared, the moment diagram is
removed from the view.

Show relative deflection If cleared, the relative deflection
diagram is removed from the view.

Show dimensions If cleared, the dimensions are
removed from the view.

Show extremes If cleared, the max and min values are
removed from the view.
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RSA Seismic Results in a Load Analysis View
Loading Analysis Views for 1st or 2nd Order RSA Seismic result types use the
same rules as those applied to multi-member Results Views for the same
result types, i.e. as follows:

RSA Seismic Loadcases

• Combined (CQC) or Combined (SRSS) - depending on your choice in
Analysis Options

• Absolute values are determined at various points along each member
and then plotted on both the positive and negative side of the diagram,
(so that the diagrams are always symmetrical about the base line).

• All relevant modes - a standard enveloped diagram is displayed

• RSA Torsion Loadcases - displayed as per 1st order linear analysis

• Static Loadcases included in the RSA Seismic Combination - displayed as
per 1st order linear analysis

• Effective Seismic Weight Combination - not available

RSA Seismic Combinations

A droplist is provided to allow you to view:

• Design Profile - derived from the Static+Seismic result, the Design Profile is
always plotted on the same side of the base line as the Static Only result

• Static Only - displayed as per 1st order linear analysis

• Seismic Only - absolute values are determined at various points along each
member and then plotted on both the positive and negative side of the
diagram

• Static+Seismic - an envelope is drawn showing the seismic results above
and below the static result.

• Base line is through the static values

• Top line is static value + seismic value

• Bottom line is static value - seismic value
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6.4 Solver models
You can display the solver model used for each analysis type in 2D or 3D by
opening an appropriate solver view.

If you have performed more than one analysis type, then (providing the
geometry and loading have not changed between runs), each solver model is
retained.

NOTE Changes to mesh size or uniformity do not constitute a change in the
geometry. Hence, if different meshes have been applied for each analysis
type, the different solver models are retained.

To Click the link below:
Learn about the different solver
model types and what is displayed
within them

Solver model types (page 552)

Open a solver view to display a solver
model

Open a solver view (page 559)

Change the solver model type
displayed in a solver view

View the solver model used for a
particular analysis (page 560)

View properties of solver model
objects

View solver model object properties
(page 561)

Learn about rigid offsets and rigid
zones used in concrete beams and
columns

How concrete beams and columns
are represented in solver models
(page 565)
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To Click the link below:
Learn about the analytical model
used for meshed walls

How meshed walls are represented in
solver models (page 577)

Learn about the analytical model
used for mid-pier concrete walls

How mid-pier walls are represented
in solver models (page 582)

Learn about the analytical model
used for shear only walls

How shear only walls are represented
in solver models (page 584)

Learn about the analytical model
used for bearing walls

How bearing walls are represented in
solver models (page 588)

View tabular solver model data and
solver model results

View tabular solver model data
(page 591)

Solver model types
You can review the different solver models by opening a Solver View and then
choosing the solver model type required from the right-click menu.

Working Solver Model
The Working Solver Model shows the model in its form prior to any analysis.

Although 1D elements, solver nodes, and diaphragms are displayed, 2D
elements are not (even when you have chosen to mesh slabs/walls). This is
because 2D elements are only formed at the point of analysis.

Solver Model used for 1st Order Linear and 2nd Order Linear
The solver model used for 1st order and 2nd order linear analysis potentially
features a mix of 1D analysis elements, FE meshes and diaphragms as follows:

• beams and columns are modelled as 1D analysis elements

• walls are either mid-pier analysis elements, or FE meshes

• slabs (optionally) form rigid, or semi rigid, diaphragms in floors

• 1-way slabs have their loads decomposed on to supporting members at a
preliminary stage of the analysis.

• 2-way slabs are (typically) not meshed, in which case they will also have
their loads decomposed on to supporting members at a preliminary stage
of the analysis.

• 2-way slabs (optionally) can be meshed, this is only recommended for
special cases, typically where slabs participate in the lateral load stability
system, e.g. transfer slabs

• supports are user defined
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Any FE meshes in the solver model are formed using the mesh parameters in
place for the most recent run of the chosen analysis (i.e. 1st order linear or
2nd order linear).

If the analysis has yet to be run, the current mesh parameters are applied.

Running any other analysis type after changes to either geometry or loading
will prevent you from displaying results for this model.

NOTE Results are still displayed for the "old" solver model until the working solver
model is updated to reflect the changes (by running an analysis). Changes to
mesh size or uniformity do not cause the working solver model to be
updated: consequently if you run an analysis with certain mesh parameters,
then a second analysis type with different mesh parameters, both sets of
results can be displayed.

2-way slabs meshed
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Optionally you can choose to mesh all 2-way slabs - making a fully meshed
model (both walls and floors) possible.

This is generally not recommended as it will inevitably increase the model size,
(and potentially the time to solve for large models), although it might be
considered that a fully meshed model behaves more "correctly" where slabs
are considered to be part of the lateral load resisting system of the structure.

It is more likely that you will choose to mesh specific floor levels only (e.g.
transfer levels), keeping other levels unmeshed.

Solver Model used for 1st Order Non Linear and 2nd Order Non Linear
These solver models are basically the same as those used for 1st order
analysis with the exception that they will also feature non linear elements.

Any FE meshes in these solver models are formed using the mesh parameters
in place for the most recent run of the chosen analysis (i.e. 1st order non-
linear or 2nd order non-linear).

If the analysis has yet to be run, the current mesh parameters are applied.

Running any other analysis types after changes to either geometry or loading
will prevent you from displaying results for these models.

NOTE Results are still displayed for the "old" solver model until the working solver
model is updated to reflect the changes (by running an analysis). Changes to
mesh size or uniformity do not cause the working solver model to be
updated: consequently if you run an analysis with certain mesh parameters,
then a second analysis type with different mesh parameters, both sets of
results can be displayed.

Solver Model used for 1st Order Modal
Any FE meshes in this 3D solver model are formed using the mesh parameters
in place for the most recent run of 1st order modal analysis.

If the analysis has yet to be run, the current mesh parameters are applied.

Running any other analysis type after changes to either geometry or loading
will prevent you from displaying results for this model.

NOTE Results are still displayed for the "old" solver model until the working solver
model is updated to reflect the changes (by running an analysis). Changes to
mesh size or uniformity do not cause the working solver model to be
updated: consequently if you run an analysis with certain mesh parameters,
then a second analysis type with different mesh parameters, both sets of
results can be displayed.
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Solver Model used for 2nd Order Buckling
Any FE meshes in this 3D solver model are formed using the mesh parameters
in place for the most recent run of 2nd order buckling analysis.

If the analysis has yet to be run, the current mesh parameters are applied.

Running any other analysis type after changes to either geometry or loading
will prevent you from displaying results for this model.

NOTE Results are still displayed for the "old" solver model until the working solver
model is updated to reflect the changes (by running an analysis). Changes to
mesh size or uniformity do not cause the working solver model to be
updated: consequently if you run an analysis with certain mesh parameters,
then a second analysis type with different mesh parameters, both sets of
results can be displayed.

Solver Model used for Grillage Chasedown
In grillage chasedown a 3D sub model is formed for each floor including those
columns and walls that connected to the floor.

The sub models are analysed sequentially for gravity loads, starting at the top
level and working down. Support reactions from each level are transferred to
the level below.
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Two-way slabs are only meshed in grillage sub-models at those levels where
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they have been set as meshed for 3D Analysis. For all other slabs load
decomposition is carried out prior to the analysis.

Solver Model used for FE Chasedown
FE chasedown is similar to grillage chasedown, with 3D sub models being
formed at each level; the one difference being that in the FE chasedown the
two-way slabs are always meshed.

The sub models are analysed sequentially for gravity loads, starting at the top
level and working down. Support reactions from each level are transferred to
the level below.
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Solver Model used for Load Decomposition
At each level, (provided you have not checked the Mesh 2-way Slabs in 3D
Analysis option), a solver model is created solely for the purpose of
decomposing slab and panel loads back on to the supporting members. As
these load decomposition models are only used during the pre-analysis stage,
by default they are not retained.

However, if you want to examine the load decomposition model used at a
given level this is possible by editing the level properties prior to analysis and
selecting keep solver model.

The sub models are analysed sequentially for gravity loads, starting at the top
level and working down. Support reactions from each level are transferred to
the level below.

Refresh Solver Model
The solver model currently displayed is updated to reflect changes that have
occurred in the working solver model since the last analysis. The 2D element
mesh is also updated to reflect the current mesh parameters. Previous
analysis results are also erased for this solver model

Open a solver view
You can either open a new view that displays the solver model, or change
another 2D or 3D view to a solver view. In order to open a solver view, see the
following instructions.
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Open a solver view as a new view
1. To duplicate the existing 2D or 3D view, right-click the tab.

2. In the context menu, select Duplicate view. 

A duplicate of the current view opens.

3. To change the view type of the duplicate, do one of the following:

• Right-click the duplicate tab, and in the context menu, select 
Solver view.

• In the Status bar at the bottom of the window, click Solver View.

Change the existing view to a solver view
1. Open an appropriate 2D or 3D view.

2. To change the view type of the view, do one of the following:

• Right-click the view tab and in the context menu, select Solver
view.

• In the Status bar at the bottom of the window, click Solver View.

See also

View the solver model used for a particular analysis (page 560)

View solver model object properties (page 561)

View the solver model used for a particular analysis
In case you need to view the solver model that Tekla Structural Designer uses
for a particular analysis type, see the following instructions.

1. Open a solver view. (page 559)

2. Right-click anywhere in the solver view.

3. In the context menu, select Solver models.

4. In the submenu, select the desired solver model. 

Tekla Structural Designer opens the selected solver model.

See also

View solver model object properties (page 561)
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View solver model object properties

After opening a solver view (page 559), you can select solver nodes, solver
elements, and supports in order to see their properties in the Properties
window.

• Solver node properties (page 561)

• Solver element properties (page 561)

• Solver element (1D) types (page 562)

• Solver element 2D properties (page 564)

• Support properties (page 1017)

Solver node properties
When in a Solver View, solver node properties are displayed in the Properties
Window as shown below. Only certain of these can be edited; properties that
are dimmed are derived and cannot be changed directly.

Property Description
General
Fx, Fy, Fz The translational degrees of freedom

at the node.
Fx, Fy, Fz The rotational degrees of freedom at

the node.
Coordinate The node location.
P-Delta This property cannot be edited.
Exclude from Diaphragm Check to remove the node from the

diaphragm.
Diaphragm # Specifies the diaphragm number to

which the node is connected.

Solver element properties
When in a Solver View, solver element properties are displayed in the
Properties Window as shown below. Only certain of these can be edited;
properties that are dimmed are derived and cannot be changed directly.

Property Description
General
Active When this is set to False the solver

element is inactive in the analysis.
Only certain member types (braces,
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Property Description
analysis elements) can be made
inactive.

Type The type of the solver element
Fabrication The fabrication type of the solver

element.
Construction The construction type of the solver

element.
Material The solver element material.
Gamma angle Defines the element orientation

about its local x axis.

When gamma = 0, the local z lies in
the plane created by the local x axis
and the global z axis.

Length The solver element length.
Start Releases
Fx, Fy, Fz These define the translational end

releases at end 1.
Mx, My, Mz These define the rotational end

releases at end 1.
End Releases
Fx, Fy, Fz These define the translational end

releases at end 2.
Mx, My, Mz These define the rotational end

releases at end 2.

Solver element (1D) types
Eight different 1D solver element Types are available in Tekla Structural
Designer as follows:

Beam

An element in any material, with user defined area and inertia properties, and
user-definable end releases - used in all solver models for:

• Columns (any material)

• Beams (any material)

• Truss top, bottom and side members (any material)

• Mid-pier concrete wall: wall-beam, and wall-column elements

• Bearing wall: wall-beam elements

• Analysis Elements (any material) with element type: Beam
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Truss

An element in any material, with user-defined cross sectional area, and pinned
ends (releases not being editable) - used in all solver models for:

• Braces (any material) that have not been set as tension or compression
only

• Truss internal members (any material) that have not been set as tension or
compression only

• Bearing wall: wall-column elements

• Analysis Element (any material) with element type: Truss

Truss 1D solver elements are also used in linear solver models only for:

• Braces (any material) that have been set as tension or compression only

• Truss internal members (any material) that have been set as tension or
compression only

Tension only

A pin ended member in any material, with user-defined cross sectional area,
that can only transfer tension. This is a non-linear element which requires
non-linear analysis - hence used in non-linear solver models only for:.

• Braces (any material) that have been set as tension only

• Truss internal members (any material) that have been set as tension only

• Analysis Element (any material) with element type: Tension only

Compression only

A pin ended member in any material, with user-defined cross sectional area,
that can only transfer compression. This is a non-linear element which
requires non-linear analysis -hence used in non-linear solver models only
for:

• Braces (any material) that have been set as compression only

• Truss internal members (any material) that have been set as compression
only

• Analysis Element (any material) with element type: Compression only

Linear axial spring

An element that deflects linearly when an axial force is applied, in accordance
with a user-defined axial spring stiffness. These are specified as:

• Analysis Element (any material) with element type: Linear axial spring
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Linear torsional spring

An element that rotates linearly when a torsion force is applied, in accordance
with a user-defined rotational spring stiffness. These are specified as:

• Analysis Element (any material) with element type: Linear torsional spring

Non-linear axial spring

An element that deflects non-linearly when an axial force is applied, in
accordance with a user-defined axial spring stiffness. These are used in non-
linear solver models only for:

• Analysis Element (any material) with element type: Non-linear axial spring

Non-linear torsional spring

An element that rotates non-linearly when a torsion force is applied, in
accordance with a user-defined rotational spring stiffness. These are used in
non-linear solver models only for:

• Analysis Element (any material) with element type: Non-linear torsional
spring

Solver element 2D properties
When in a Solver View, solver element 2D properties are displayed in the
Properties Window as shown below. None of these properties can be directly
edited in the Solver View.

Property Description
Panel
Type The 2D element type will be Shell or

Semi-rigid depending on the Slab
Type, Decomposition and Diaphragm
Options that have been set.

Thickness The 2D element thickness is derived
from a different property depending
on the slab type:

• Composite Slab; Precast Slab; Slab
on Beams; Flat Slab - Overall Depth

• Steel Deck; Timber Deck - Thickness
Orientation The 2D element orientation in the

solver model follows the rotation
angle defined for the slab item to
which it belongs.
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Property Description
DivideStiffnessBy This property applies to semi-rigid

elements only.

It adjusts the stiffness determined
from the material properties in order
to control semi-rigid diaphragm
flexibility.

CrackedOption yes/no
Nodes
Node 1, Node 2, Node 3 The node numbers associated with

this element.

How concrete beams and columns are represented in
solver models
Solver elements for most members are created directly between the member
insertion points - they do not take into account major and minor snap points,
or any offsets that might have been specified in the member properties. The
exception to this rule is that solver elements for concrete columns and
concrete beams do take into account snap points and offsets - Rigid offsets
are then automatically introduced where necessary to connect the solver
elements.

NOTE The rules applied to insertion of solver elements for concrete columns are
different to those that are applied to concrete beams. For concrete structures
this enables you to simplify the grid layout but then employ offsets to position
the members exactly.

Design codes also allow engineers to assume parts of concrete beams and
columns are rigid, leading to more efficient designs. Tekla Structural Designer
uses Rigid zones to cater for this where columns and beams are connected
and where beams are connected to other beams. Columns can have rigid
zones when they are the supporting or supported member, but beams will
only have rigid zones when they are the supported member.

Rigid offsets
For concrete beams and columns rigid offsets are automatically applied to the
start and end of solver elements as required to ensure that the solver model is
properly connected.

This will be necessary whenever the 1D solver elements are not co-linear. A
typical example of this occurs when concrete edge beams are aligned to be
flush with the face of the supporting columns, as shown below:
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TIP To see rigid offsets: open a Solver View, and then in Scene Content ensure that
1D Elements> RigidOffsets is selected.

Click the below link to view a couple of examples illustrating the use of rigid
offsets in concrete columns and beams:

• Rigid offsets examples (page 567)

Rigid zones
Unless you have chosen not to apply them, rigid zones are created at concrete
column/beam connections. The proportion of the zone which is modeled as
rigid (the thick black line shown below) is specified as a percentage, the
remaining portion of the rigid zone (the red line inside the rigid zone) remains
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elastic. The proportion of the rigid zone that is rigid is specified in Model
Settings and can vary between 0 - 100%

As shown above, the elastic portion of the rigid zone is aligned with the central
span solver element.

In most situations in order to get an efficient design you would want rigid
zones to be applied. You can however choose not to consider them by
checking the Rigid zones not applied option that is provided in Model
Settings, this will deactivate them throughout the model. You can also
selectively deactivate rigid zones at specific column/beam connections by
unchecking the Apply rigid zones option that is provided in the column
properties under the Design control heading.

• For example, you might choose not to apply them if you encounter
problems with short members and rigid zones which cannot be overcome
by modifying the physical model.

• When rigid zones are not applied, the position of releases in analysis model
is affected, and member start and end points for design are also adjusted.

There is a significant difference between Rigid Zones Not Applied and Rigid
Zones Applied with 0% rigidity. The total elastic length of a member is the
same in the two models, but the position of releases and start/end of design
members will be different.

Rigid zones should not be confused with rigid offsets which are used to ensure
that the analysis model is properly connected, i.e. it is possible to have rigid
offsets in the model even if rigid zones are turned off.

Click the below link to view a couple of examples illustrating the use of rigid
zones in fixed and pin ended beams:

• Rigid zones examples (page 571)

Rigid offsets examples
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Rigid offsets example 1 - concrete column

Consider the two stack concrete column shown below - this has been inserted
with its alignment properties set to bottom left so that the outer column faces
remain flush despite a smaller section being introduced in stack 2.

Since solver elements for concrete columns always take into account any snap
points or offsets, they will always be located at the centroid of each stack -
thus they do not necessarily coincide with the insertion line used to position
the column originally. In this example the centroid position shifts from one
stack to the next which causes a “rigid offset” to be created automatically to
connect the solver elements. Similar rigid offsets would also be created as
required to connect incoming beams into the column centroids.
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TIP To see solver elements, solver nodes and rigid offsets: open a Solver View, and
then in Scene Content select 1D Elements> Geometry & RigidOffset and
Solver Nodes> Geometry.

As a consequence of this method of modeling, you are freer to simplify the
grid layout in order to create the structure more effectively, and then employ
column offsets to position each column exactly, knowing that during analysis
the program automatically assumes the column is located at its centroid as
shown in the plan view.
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Rigid offsets example 2 - concrete beam

Consider the two span concrete beam shown below - this has been inserted
with both major and minor axis offsets applied to span 2 only.

NOTE For concrete beams:

• The minor snap points and offsets are structurally significant and have an
effect on the positioning of the 1D solver elements.

• The major snap points and offsets are not structurally significant.

In the minor direction beam solver elements are always located at the center
of each beam section - as beam widths or minor offsets may vary, this may
result in the introduction of lateral rigid offsets to make the connection
between spans.

In the major direction beam solver elements are always created at the same
level as the insertion line used to position the beam.

Consequently, for this particular example a lateral rigid offset is required to
make the connection between the two spans.
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TIP To see solver elements, solver nodes and rigid offsets: open a Solver View, and
then in Scene Content select 1D Elements> Geometry & RigidOffset and
Solver Nodes> Geometry.

Rigid zones examples
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Rigid zones example 1 - fixed ended beam

Consider the following 2 span beam supported on columns and loaded with a
udl:

Rigid Zones Not Applied

The analysis model is simply constructed from the solver elements with rigid
offsets applied as necessary to connect the beam solver elements to the
column solver elements.
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The resulting beam bending moment diagram is as follows:

Rigid Zones Applied (default 50%)

Rigid Zones are activated via Model Settings, and this is also where the
percentage of rigidity of the zones can be specified. Initially for this example it
will be left at the default of 50%.

The revised solver model is as shown below, note the rigid zones that have
been formed where the columns and beams connect:
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The beam bending moment diagram for the revised model is as shown below.

NOTE The above diagram was generated from a Results View to illustrate that a
“gap” is formed in the diagram where there are rigid zones. It should be noted
that when the same result is displayed in a Load Analysis View the gap is
removed, leaving only the non-rigid length of the member displayed.

We might expect the extra stiffness introduced at the supports to increase the
hogging moments and reduce the sagging moments, however because the
element end forces are now reported at the rigid zone boundaries (rather than
the ends of the solver elements) - in this example the main effect is that the
hogging moment over the central column support is substantially reduced.
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Rigid Zones Applied (100%)

To investigate the effect of the percentage rigidity an additional run is made
with the percentage rigidity increased to 100%. The bending moment diagram
that results is shown below:

As expected the extra stiffness introduced at the supports increases the
hogging moments and reduce the sagging moments in comparison to the run
at 50%.

Rigid Zones Applied (0%)

If the percentage rigidity is reduced to 0% the bending moment is as shown
below:

If this result is compared to the run in which rigid zones were not applied, it is
clear that although the sagging moments are identical, the hogging moments
that are reported are not the same. This is because, although the total elastic
length of a member is the same in the two models, the position of the start
and end of design members is different (being taken at the rigid zone
boundaries when applied).
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Rigid zones example 2 - pin ended beam

When rigid zones are applied to a pin ended member, the end release is
shifted from the end of the solver element to the rigid zone boundary.

To illustrate this effect the model illustrated in Rigid zones example 1 is
modified to have pinned connections introduced at the two remote ends of
the beam.

Rigid Zones Not Applied

The analysis model is constructed from the solver elements with rigid offsets
applied to connect the beam and column solver elements. Releases are
formed at the two remote ends of the beam solver elements.

The beam bending moment diagram is as follows:

Rigid Zones Applied (0%)
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For comparison, rigid zones are then introduced, (with 0% rigidity in order to
keep the total elastic length of the beams the same in both models).

Because the releases are moved to the rigid zone boundaries, this has the
effect of reducing the moments in the beams.

How meshed walls are represented in solver models
Meshed walls have isotropic stiffness properties and resist loads in all
directions.

Wall beam elements

Wall beam elements are inserted into walls primarily to collect slab mesh
nodes and line elements. For meshed walls, they are generated along the top
of the wall and also at intermediate levels where an object (e.g. slab, beam,
truss) is physically connected. A wall beam element is also generated along the
bottom edge of the wall if Generate Support is not selected.

Sloping wall beam elements can be generated by sloping top or bottom edges
or connected sloping slabs.

Where horizontal wall beam elements are required, they are generated across
the entire width of the wall at that level.

Wall beam elements can also be created where certain properties, (e.g.
thickness), differ across panel boundaries.

2D solver elements

For meshed walls the type of 2D solver element used will depend on whether
the wall mesh type is set to Quad only, Tri only, or, Quad dominant.

Modification Factors

Different modification factors applied to meshed walls in the analysis
depending on the Material type that has been applied.

Meshed concrete wall example

Consider the following two stack wall supporting a slab; the wall has different
thickness panels aligned to produce a flush surface on one face.
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1D and 2D solver elements for each wall panel are always located along the
insertion line used to position the wall originally, irrespective of any alignment
offsets that have been specified.

Quad only

In this two stack example, when the Wall Mesh Type is set to Quad only, solver
elements are formed as shown below:
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NOTE To see solver elements, solver nodes and 2D elements: open a Solver View,
and then in Scene Content check 1D Elements> Geometry, 2D Elements>
Geometry and Solver Nodes> Geometry.

Tri only

In this two stack example, when the Wall Mesh Type is set to Tri only, solver
elements are formed as shown below:
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Quad dominant

In this two stack example, when the Wall Mesh Type is set to Quad dominant,
solver elements are formed as shown below:
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Wall openings

When wall openings are introduced, the mesh will adjust to form around the
openings.
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See also: Meshed wall openings analysis model (page 242)

How mid-pier walls are represented in solver models
Wall beam and wall column elements

Wall beam elements are inserted into walls primarily to collect slab mesh
nodes and line elements. For mid-pier walls, they are generated along the top
and bottom edges of the wall and also at intermediate levels where an object
(e.g. slab, beam, truss) is physically connected.

NOTE Only horizontal wall beam elements can be generated in mid-pier walls -
sloping wall beam elements cannot be generated - this will be indicated by an
error in validation.

Each mid-pier wall object also has a single vertical wall column element in the
middle of the wall, from the top to the bottom level.

Modification Factors

The modification factors applied to concrete walls in the analysis depend on
whether they have been specified as meshed or mid-pier.
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Mid-pier wall example

Consider the following two stack mid-pier wall supporting a slab; the wall has
different thickness panels aligned to produce a flush surface on one face.

The wall beam and wall column elements are always located along the
insertion line used to position the wall originally, irrespective of any alignment
offsets that have been specified, so for this example, the elements are formed
as shown below:
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NOTE To see wall beam elements, wall column elements and solver nodes: open a
Solver View, and then in Scene Content select 1 D Elements> Geometry and
Solver Nodes> Geometry.

How shear only walls are represented in solver models
Shear only walls resist in-plane shear only and have no out of plane stiffness
or load bearing resistance.

Background
The ‘shear only wall’ is configured to allow, as the name implies, shear forces
only to be resisted. These arise from frame action in the lateral load resisting
system when subject to lateral loads. The behaviour is typical of unreinforced
masonry walls built into a steel or concrete frame. Under lateral loading the
top of the column adjacent to the wall panel bears on a relatively short length
of wall, creates compression in some width of masonry in the diagonal and
exits the wall panel at the toe of the opposite corner.

A masonry wall panel resists this force couple at each corner primarily as a
shear panel. The failure mechanism either follows a stepped pattern through
the joints or by shear bond along the bed joints. The compression strut
manifests as a failure in diagonal tension across the bed joints in a stepped
fashion. Failure can also occur by local crushing in the top left or bottom right
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of the wall (or vice versa). These failure modes are depicted in the figure
below.

The third failure mode mentioned, crushing in the corners, is very difficult to
model and is believed to have a minor influence on overall behaviour. It is
thought to be self compensating to some extent because when the masonry
begins to crush more length of wall is brought into play.

The diagonal cracking and sliding in the bed joint are the primary effects of the
wall acting as a shear panel. This is the only behaviour that ‘shear only walls’
are able to model.

The compression strut that is also inferred by the diagonal cracking generates
push-pull forces in the frame and complementary axial forces in the beams.
These are incorporated in the Tekla Structural Designer implementation by the
use of special ‘Link Elements’.

The oft used and simplest model of a single brace or pair of braces from
corner to corner of the wall panel can adequately represent the lateral
stiffness of the infilled frame but introduces unwanted axial forces (from
gravity loads), particularly in columns. The Tekla Structural Designer
implementation is a significant improvement on this simplest model and
requires only the determination of the spring stiffness associated with the
shear behaviour.

Crisafulli (2007)1 provides a formula for the stiffness, ks, of the shear spring as,

ks  = γs x Ams x Em/dm x cos2θ

Where,   
Ams  = total area of equivalent

strut based on a width of
strut of the order of ¼ to
⅓ of the diagonal length
of the panel
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Em  = Elastic modulus of the
masonry

dm  = diagonal length of the
wall panel

θ  = the angle of the ‘strut’
with the horizontal

The factor γs is the proportion of total stiffness that is assigned to the spring
whilst the remainder is provided in the Crisafulli model by a pair of ‘masonry
struts’. In Tekla Structural Designer γs is 1.0 i.e. all of the stiffness is provided
by the spring whilst the force effects of the ‘masonry struts’ are replicated by
the special ‘Link Element’.

Other formulations for the spring stiffness are likely to exist in the literature.

In Tekla Structural Designer, the spring is a either a linear or non-linear
uniaxial spring, the former being used when all diaphragms are ‘Rigid’.

One of the consequences of the configuration of ‘shear only walls’ adopted in
Tekla Structural Designer is that no loads can be applied out of plane and no
members can be connected into the main body of the wall panel. Similarly, the
wall panel must be completely surrounded by column and beam members to
ensure transfer of lateral loads. For this type of shear wall the head detail is
assumed to be such that there is no load transfer from the beam above to the
head of the wall.
1 Crisafulli F. J. and Athol J. C., Proposed macro-model for the analysis of infilled
frame structures, Bulletin of the New Zealand Society for Earthquake Engineering,
Vol. 40 No. 2 June 2007.
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Solver model in Tekla Structural Designer
Shear only wall panels are modelled using two axial springs between 'panel
nodes' connected to 'corner nodes' by link elements. How these are
configured differs for interstory panels and the base panel.

NOTE The axial spring and link elements are only shown in the Solver View
used for analysis. The above illustrations are not to scale, the actual u
and v dimensions being 10mm (25/64 in.) and 20mm (50/64in.)

Interstory panels

For each interstory panel, two springs, each with a pair of nodes are created
and connected to the ‘corner’ nodes where the panel connects to the beam-
column node. The connection is made using four special ‘Link Elements’. The
orientation of the axial spring means there is stiffness only in the plane of the
wall, specifically only in the horizontal direction. The Link Elements coordinate
systems and their degrees of freedom are configured such that the panel
operates in-plane and is stable out-of-plane whilst not generating any
untoward moments and forces.

Base panel

Where a base panel exists, a single fixed base is created. Two springs are
created at the same level, and connected to the ‘corner’ nodes where the
panel connects to the beam-column node using two Link Elements. The
orientation of the axial springs means there is stiffness only in the plane of the
wall, specifically only in the horizontal direction. The Link Element coordinate
system and their degrees of freedom are configured such that the panel
operates in-plane and is stable out-of-plane whilst not generating any
untoward moments and forces. Only horizontal reaction is produced at the
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support and this must be distributed manually along the wall footing if
required.

Walls supported on meshed slabs and foundation mats are treated as base
panels with the springs and consequent forces applied to a ‘seeded’ node in
the mesh.

Self weight

The self weight of each panel is automatically calculated by Tekla Structural
Designer and applied to the supporting beam. For a base panel this applied
directly to the wall support. For meshed slabs and foundation mats the wall is
treated as a base panel and the self weight is applied to a ‘seeded’ node in the
mesh.

How bearing walls are represented in solver models
Bearing walls have no in-plane or out-of-plane stiffness and resist vertical load
only.

For bearing walls the alignment (Front, Middle, or Back) specified in the wall
properties is not structurally significant as it has no effect on the positioning of
the solver elements in the solver model.

Consider the two stack bearing wall shown below.
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The solver model for this wall is formed using a series of vertical "wall column"
and horizontal "wall beam" solver elements. The beams have pinned ends and
are placed at the top of the wall spanning between the columns. The next
panel above is pinned to the one below and similarly the lower end of a
column is pinned to a supporting beam. At the lowest level the column is
'fixed' to a pinned support.

Members supported by the wall either (fortuitously) bear directly on one of the
wall columns or on one of the wall beams at the head of the wall. All wall
columns and wall beams in an individual bearing wall are given properties
automatically by Tekla Structural Designer, based on the width of the bearing
wall with which they are associated.

If the bearing wall did not continue to the lowest level, but was instead
supported by a transfer beam, then at the lowest level the wall columns would
have pinned ends and no supports would be introduced.
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For bearing walls that are defined between other vertical column members
e.g. steel columns, the wall columns at the edge of the panel are omitted and
the associated wall beam is connected to the steel column (for example) and
the adjacent wall column - as below.

Wall columns at the edge of the panel are also omitted when it is defined
between concrete walls.

Irrespective of whether the wall spans between other vertical column
members or not - any load applied to the wall beam at the edge of the panel is
shared between the end column and the first internal column. This can result
in some load being `lost' directly into the supports.
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Load transfer in the bearing wall model is not the same as it would be in for
example, a masonry wall. A point load applied at the top of a masonry wall
would result in a distributed load on any beam supporting the masonry wall,
whereas in a bearing wall the supporting beam would be subjected to a pair of
point loads, (or possibly even a single point load if the applied load coincides
exactly with a wall column location).

Self weight of the bearing wall is concentrated in the wall beams so seismic
weight is concentrated at the top of the wall and not split between the floor
above and below.

View tabular solver model data and results
Solver model data views can be used to view tabulated node and element data
and specific results for the different solver models.

The full list of tabular data view types is shown below.

NOTE Some of the view types are only available for specific solver model
types.

• View solver model object properties (page 561)

• View tabular results for support reactions (page 592)

• View tabular results for nodal deflections (page 592)

• View tabular results for solver element end forces (page 593)

• View tabular results for wall lines (page 594)

• View tabular results for result lines (page 594)

• View tabular results for core lines (page 595)

• View the summed mass for modal mass combinations (page 595)

• View the dynamic masses for modal mass combinations (page 596)

• View active masses by node (page 596)

• View modal frequencies and modal masses (page 597)

• View buckling factors (page 597)

View tabulated solver node and element data
To view node coordinate and degrees of freedom, or solver element
properties in tables, see the following instructions.

View tabulated node coordinates and degrees of freedom

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.
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2. In the upper list of the Result Type group, select the solver model result
type required.

3. In the View Type list, select Nodes. 

Tekla Structural Designer displays the node coordinates and degrees of
freedom in a table.

View tabulated solver element properties

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the solver model type
required.

3. In the View Type list, select Elements. Tekla Structural Designer
displays solver element properties in a table.

View tabular results for support reactions
In order to view the results for support reactions, or nodal forces, in tables,
see the following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired solver model
type. 

NOTE You can view support reactions for all solver model types except
for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Nodal Forces.

4. In the Loading list at the bottom of the window, select the desired
loadcase, combination, or envelope.

View tabular results for nodal deflections
To view the deflections of the nodes in your model as tables, see the following
instructions.
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1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired solver model
type. 

NOTE You can view nodal deflections for all solver model types except
for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Nodal Deflections.

4. In the Loading list at the bottom of the window, select the desired
loadcase, combination, or envelope.

View tabular results for solver element end forces
To view the raw results for element end forces in tables, see the following
instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired solver model
type. 

NOTE You can view solver element end forces for all solver model types
except for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Element End Forces.

4. In the Loading list at the bottom of the window, select the desired
loadcase, combination, or envelope. 

Tekla Structural Designer displays the raw analysis results of element end
forces. This means that no axial load reductions have been applied.

NOTE The asterisk next to certain element numbers signifies that the
results are actually output at the end of a rigid arm that you have
modeled, rather than at the node itself.
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View tabular results for wall lines
To view the results of the wall lines in your model as tables, see the following
instructions. The result tables include information on such aspects as the
location, position, axial force, and torsion of the wall lines.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired solver model
type. 

NOTE You can view wall line forces for all solver model types except for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Wall Lines.

4. In the Loading list at the bottom of the window, select the desired
loadcase, combination, or envelope. Tekla Structural Designer displays the
wall line results in a table.

View tabular results for result lines
To view the results of the result lines in your model as tables, see the following
instructions. The result tables include information on such aspects as the
location, position, axial force, and torsion of the result lines.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired analysis
type. 

NOTE You can view 2D result lines forces for all analysis types except
for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select 2D Result Lines.

4. In the Loading list at the bottom of the window, select the desired
loadcase, combination, or envelope. Tekla Structural Designer displays the
wall line results in a table.
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View tabular results for core lines
To view the results of the core lines in your model as tables, see the following
instructions.

The result tables include information on such aspects as the location, position,
axial force, and torsion of the wall lines.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the desired analysis
type. 

NOTE You can view core line forces for all analysis types except for:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Core Lines.

4. In the Loading list at the bottom of the window, select the desired
loadcase, combination, or envelope. Tekla Structural Designer displays the
wall line results in a table.

View tabular results for mode shapes
To view the mode shapes analyzed in a 1st order modal or 2nd order buckling
analysis, see the following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select the solver model type. 

NOTE You can only view mode shapes for the following solver model
types:

• 1st order modal analysis

• 2nd order buckling analysis

3. In the View Type list, select Mode Shape.

4. In the Loading list at the bottom of the window, select the desired
loadcase, combination, or envelope.

5. In the lower list of the Result Type group, select the mode.
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View the summed mass for modal mass combinations
In order to view the summed total mass of the modal mass combinations in
your model, see the following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select 1st Order Modal.

3. In the View Type list, select Summed Mass. 

Tekla Structural Designer displays the total mass of the modal mass
combinations in a table.

View the dynamic masses for modal mass combinations
To view the total dynamic masses for modal mass combinations, see the
following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select 1st Order Modal.

3. In the View Type list, select Dynamic Masses. Tekla Structural Designer
displays the total dynamic masses for the modal mass combinations in a
table.

View active masses by node
To view the dynamic active masses of the nodes in your model, see the
following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select 1st Order Modal.

3. In the View Type list, select Active Masses by Node. 

Tekla Structural Designer displays the dynamic active masses of the nodes
in your model.

View total masses by node
To view a table of the total masses of the nodes in your model, see the
following instructions.
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1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select 1st Order Modal.

3. In the View Type list, select Total Masses by Node. 

Tekla Structural Designer displays the dynamic total masses of each node
in your model in a table.

View modal frequencies and modal masses
In order to view the modal frequencies and modal masses of a particular load
combination, see the following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of the Result Type group, select 1st Order Modal.

3. In the View Type list, select Modal Frequencies.

4. In the Loading list, select the desired load combination. 

Tekla Structural Designer displays the modal frequencies and modal
masses of the selected load combination in a table.

View buckling factors
To view the buckling factors analyzed in the 2nd order buckling analysis in a
table, see the following instructions.

1. On the Analyze toolbar, click Model & Results. 

A Solver Model Data view opens in a new tab, and the Result Type and
View Type groups appear in the ribbon.

2. In the upper list of Result Type group, select 2nd Order Buckling.

3. In the View Type list, select Buckling Factors.

4. In the Loading list, select the desired loadcase or combination.
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7 Design models

From the Design toolbar you can batch design all the members and walls in
your model and (separately) batch design all the slabs. From the same toolbar
you can also check the response of floors to dynamic excitation.

As an alternative to batch design you might choose to selectively design parts
of the model as required.

To get to know about combined analysis and member design and selective
member design, see:

• Design steel members and cast-in-place concrete beams, columns and
walls (page 599)

To design slabs, see

• Design slabs and run punching shear checks (page 616)

If working to either the Eurocode or US headcode, you may also want to
introduce more/less conservatism to the design process by specifying user
defined utilation ratios:

• Apply user defined utilization ratios (page 613)

To check the response of floors to dynamic excitation, see:

• Create and run floor vibration checks (page 632)

As part of the design process, drift/sway, seismic drift, and wind drift checks
are automatically performed as required. To find out more about these
checks, see:

• Drift, sway, seismic drift, wind drift, and overall displacements (page 662)

NOTE Foundation design topics are covered separately, see Create and design
foundations (page 688)

Certain member types can be designed using Tekla Tedds, see:

• Design timber and precast members using Tekla Tedds (page 632)
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7.1 Design steel members and cast-in-place concrete
beams, columns and walls
Before commencing the design you should take a moment to ensure design
options and autodesign settings are set as required. If working to either the
Eurocode , US, or India headcode, you may also want to introduce more/less
conservatism to the design process by specifying user defined utilation ratios.

• Apply and modify design options (page 599)

• Autodesign versus check design (page 600)

• Apply user defined utilization ratios (page 613)

Having set the properties and options as required you can then proceed to
rapidly assess all steel members and/or concrete members/walls in your
model:

• Combined analysis and member design

Alternatively, you may find it more efficient to run an analysis in the first
instance and then:

• Check selected members and walls (page 606)

• Design selected members and walls (page 609)

NOTE Additional considerations may be necessary when designing members and
walls for seismic analysis, see in the Seismic analysis and design handbook.

See also

Design timber and precast members using Tekla Tedds (page 632)

Apply and modify design settings
The design options in Tekla Structural Designer allow you to adjust the way in
which your model is designed.

The different Design Settings (page 1064) sub pages enable you to, for
example:

• set which analysis type is run for the design, (on the Analysis sub page)

• set reinforcement and other parameters for concrete design, (on the
Concrete sub page)

• set the levels at which forces can be ignored, (on the Design Forces sub
page)

• set which members to design using groups, (on the Design Groups sub
page)
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• control how Autodesign settings will be reset after the design, (on the Auto
design sub page)

Modify design settings in the current project

1. On the Design tab, click Settings.

2. Modify the Design Settings (page 1064) according to your needs.

3. After making the changes, do one of the following:

• To apply the changes to the current project, click OK.

• To save the changes as defaults for future projects, click Save...

TIP To revert to the default design settings of the active settings set,
click Load...

Modify design settings defaults for future projects
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Go to the Design Settings (page 1064) page.

4. Select the settings set that you want to modify.

5. Modify the settings according to your needs.

6. To save the changes to the settings set, click OK.

See also

Design Settings (page 1064)

Autodesign versus check design
Before you begin the design process you should select a suitable design mode
for each member in your model. The available design mode options are check
design mode and autodesign mode.

Each member in your model is set to one of two design modes:

• Check design mode:

You assign the desired section size (for steel members), or section size and
reinforcement (for concrete members). Then, Tekla Structural Designer
determines if the section or reinforcement is sufficient
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• Autodesign mode:

For steel members, you select the desired section type. Tekla Structural
Designer then determines a suitable size for the selected section type.

For concrete members, you assign the desired section size.Tekla Structural
Designer then automatically determines a suitable reinforcement
configuration.

TIP To quickly review and update the mode applied to all members in the model,
open a review view and use the Auto/Check Design command to switch
between the two modes.

NOTE The Autodesign setting is only considered when you choose to design multiple
members, as explained below:

• If you choose to run a combined analysis and design (Design Steel,
Design Concrete, Design All); or choose a selective design of multiple
members (Design model, Design plane, Design Selection etc.) - members
will either be designed or checked according to their individual 'auto-
design' setting.

• If you choose a check (Check model, Check plane, Check Selection, Check
Member etc.) - each member will be checked irrespective of its 'auto-
design' setting.

• If you design an individual member (Design Member, Design Wall etc.) -
the member will be designed irrespective of its 'auto-design' setting.

See also

Select whether to design steel, concrete, or all (page 604)

Select between static and gravity design (page 605)

Combined analysis and member design
Run a combined analysis and design in order to rapidly check, or design; every
concrete, steel, or, concrete and steel menber in the model for active gravity,
static, or RSA load combinations.

Overview
Located on the Design toolbar, three groups of commands can be used for
combined analysis and design as follows:

• Design steel - to design all steel beams and columns in your model.

• Design concrete - to design all concrete beams, columns and walls.

• Design all - to design all steel beams and columns, and concrete beams,
columns and walls.
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By selecting a Gravity, Static, or RSA option, you can control which classes of
combination are considered in the analysis and design process.

At the end of the chosen process the Review tab and the review view open so
that you can inspect the results

NOTE As design validation is performed automatically as part combined analysis
and design, there is no requirement to run design validation manually
beforehand.

NOTE In combined analysis and design each member is either designed or checked
according to its individual 'auto-design' setting.

NOTE Additional considerations may be necessary when designing members and
walls for seismic analysis, see in the Seismic analysis and design handbook.

Run Design Steel (Gravity)

• On the Design tab, click Design Steel (Gravity). 

Tekla Structural Designer analyzes gravity combinations only, and then
designs all steel beams and columns in the model.

Run Design Steel (Static)

• On the Design tab, click Design Steel (Static). 

Tekla Structural Designer analyzes all static combinations and then designs
all steel beams and columns in the model.

Run Design Steel (RSA)

NOTE RSA load combinations must be set up in advance of RSA Design by
running the Seismic Wizard (page 407) (choosing the option to use
Modal Response Spectrum Analysis).

NOTE Additional considerations may be necessary when designing members
and walls for seismic analysis, see in the Seismic analysis and design
handbook.

• On the Design tab, click Design Steel (RSA). 

Tekla Structural Designer analyzes all Seismic RSA combinations and then
designs all steel beams and columns in the model.
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Run Design Concrete (Gravity)

• On the Design tab, click  Design Concrete (Gravity). 

Tekla Structural Designer analyzes gravity combinations only, and then
designs all concrete beams, columns and walls in the model.

Run Design Concrete (Static)

• On the Design tab, Click Design Concrete (Static). 

Tekla Structural Designer analyzes all static combinations and then designs
all concrete beams, columns and walls in the model.

Run Design Concrete (RSA)

NOTE RSA load combinations must be set up in advance of RSA Design by
running the Seismic Wizard (page 407) (choosing the option to use
Modal Response Spectrum Analysis).

NOTE Additional considerations may be necessary when designing members
and walls for seismic analysis, see in the Seismic analysis and design
handbook.

• On the Design tab, Click Design Concrete (RSA). 

Tekla Structural Designer analyzes all Seismic RSA combinations and then
designs all concrete beams, columns, and walls in the model.

Run Design All (Gravity)

• On the Design tab, click  Design All (Gravity). 

Tekla Structural Designer analyzes gravity combinations only, and then
designs all steel and concrete beams and columns and all concrete walls in
the model.
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Run Design All (Static)

• On the Design tab, click  Design All (Static). 

Tekla Structural Designer analyzes all static combinations and then designs
all steel and concrete beams and columns and all concrete walls in the
model.

Run Design All (RSA)

NOTE RSA load combinations must be set up in advance of RSA Design by
running the Seismic Wizard (page 407) (choosing the option to use
Modal Response Spectrum Analysis).

NOTE Additional considerations may be necessary when designing members
and walls for seismic analysis, see in the Seismic analysis and design
handbook.

• On the Design tab, Click Design All (RSA). 

Tekla Structural Designer analyzes all Seismic RSA combinations and then
designs all steel and concrete beams and columns and all concrete walls in
the model.

Select whether to design steel, concrete, or all
The appropriate design command depends on the materials you have used in
the model. For more information on selecting the appropriate command, see
the following paragraphs.

In simple terms:

• If your model consists of steel members only, you can run the design by
using the Design Steel commands.

• If your model consists of concrete members only, you can run the design
by using the Design Concrete commands.

• If your model consists of a mix of both concrete and steel members, you
can run the design by using the Design All commands.

TIP For structures that are mostly steel but have a few concrete members: instead
of running Design All, you could run Design Steel (in order to focus on the steel
design) before switching to Design Concrete for the remaining members.

In this way during the steel design phase you are not running grillage and FE
chasedown analyses when they are not required .

For more details on how each command affects the analysis process, see the
following:
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Design steel

• Performs a 3D analysis.

• Does not perform grillage chasedown or FE chasedown analysis.

• Designs or checks all steel elements and shear walls.

• Does not design or check concrete beams or columns.

Design concrete

• Performs a 3D analysis and a grillage chasedown analysis.

• May also be required to perform an FE chasedown analysis.

• Designs or checks all concrete beams, columns and shear walls.

• Does not design or check steel elements.

Design all

• Performs a 3D analysis and a grillage chasedown analysis.

• May also be required to perform an FE chasedown analysis.

• Designs or checks all concrete beams, columns and shear walls.

• Designs or checks all steel elements.

See also

Select between static and gravity design (page 605)

Select between static and gravity design
If you are not sure whether you should use the Design (Static) or Design
(Gravity) commands when designing the model, see the following paragraphs
for more details on each option.

Design (Gravity)

Although your final design should consider all combinations, designing for
gravity combinations can be a useful way to rapidly pre-size the members in
the model that are not subjected to lateral loads.

Designing members for gravity combinations is more common for steel
structures than concrete structures.

The gravity design commands involve the use of first order analysis on a
limited set of design combinations as follows:

• Design Steel (Gravity): rapid gravity sizing of the majority of steel
members

• Design Concrete (Gravity): design of concrete members for gravity
combinations only
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• Design All (Gravity): design of all steel and concrete members for gravity
combinations only

Because you may not have created lateral systems at this stage, the column
nodes that are not in a rigid floor diaphragm are, by default, fixed horizontally.
To change the default setting, go to Home --> Settings --> Design Settings -->
General.

Design (Static)

Once initial member sizes have been adequately sized, you should make a
sway sensitivity assessment (ACI/AISC), as this can affect the choice of analysis
type (ACI/AISC) used in the final static design.

The final static design is invoked by selecting the suitable Design (Static)
command:

• Design Steel (Static): full design of all steel members

• Design Concrete (Static): full design of all concrete members

• Design All (Static): full design of all steel and concrete members

For each command above, Tekla Structural Designer performs a 3D analysis
for all active combinations to establish a set of design forces. The 3D analysis
can be either first or second order, depending on the settings specified on the
Analysis page of the Design Settings dialog box.

If the model contains concrete members, Tekla Structural Designer also
performs a Grillage chasedown and potentially FE chasedown analysis to
establish additional sets of design forces.

All members are checked or designed for the appropriate design
requirements. Gravity members are only checked for gravity combinations,
while lateral members are checked for all combinations. Only active
combinations are checked.

See also

Select whether to design steel, concrete, or all (page 604)

Check selected members and walls
There are various ways to check specific members only, using the results of
the analyses that have already been performed.

Using a selective approach can be a more efficient way to work with large
models.

Check an individual member, wall, or core
• Do one of the following:
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To Do this
Check a member/wall from a 2D or 3D view 1. Hover the mouse pointer over the member.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right click and select Check Member >
Static/RSA, or Check Wall > Static/RSA as
required.

Check a member from the Structure Tree 1. In the Members branch locate the member
reference.

2. Right click and select Check Member >
Static/RSA as required.

Check a wall from the Structure Tree 1. In the Walls branch locate the wall
reference.

2. Right click and select Check Wall >
Static/RSA as required.

Check all members in a core from the Structure
Tree

1. In the Cores branch locate the core
reference.

2. Right click and select Check member >
Static/RSA as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check selected members and walls
1. In the active view, select the members to check.

2. Right-click, then in the context menu, select Check Selection > Static/RSA
as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all members in a level, slope, or frame
• In the Project Workspace, click Structure tab.

• In the Structure tree, do one of the following:

To Do this
Check all members in a construction level Right click the required Level and select Check

plane > Static/RSA as required.

Check all members and walls in a frame Right click the required Frame and select Check
plane > Static/RSA as required.

Check all members in a slope Right click the required Slope and select Check
plane > Static/RSA as required.
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NOTE These commands use the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all members
1. In the Project Workspace, click Structure tab.

2. Right-click the Members tree.

3. In the context menu, select Check members > Static/RSA as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all walls
1. In the Project Workspace, click Structure tab.

2. Right-click the Walls tree.

3. In the context menu, select Check walls > Static/RSA as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all members and walls
1. In the Project Workspace, click Structure tab.

2. Right click on the Structure branch.

3. In the context menu, select Check model > Static/RSA as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Check all members of a particular section or type
1. In the Project Workspace, click Structure tab.

2. In the Members tree, right-click the section type or size you want to
check.

3. In the context menu, select Check members > Static/RSA as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').
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Check all members in a group
1. In the Project Workspace, click Groups tab.

2. In the Design tree, right-click the member group you want to check.

3. In the context menu, select Check Group > Static/RSA as required.

NOTE • Check Groups uses the existing analysis results, (even if the
analysis status is 'Out of Date').

It is not available unless the Design Groups option is checked for
the member type in Design Settings.

Check all members and walls in a sub structure
1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure you want to
check.

3. In the context menu, select Check sub structure > Static/RSA as
required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

Design selected members and walls
There are various ways to design specific members only, using the results of
the analyses that have already been performed.

Using a selective design approach can be a more efficient way to work with
large models.

NOTE In all of the selective design methods, each member in the selection
will be individually checked or designed according to its individual
autodesign setting, (while also taking account of any member design
groups that are active). The exception being that if there is only a
single member in the selection it will always be designed irrespective
of its autodesign setting.

Design an individual member, wall, or core
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Design Member designs an individual member (taking into account any
member design groups that are active).

Design Wall designs an individual wall.

Both these commands ignore the auto-design setting of the member/wall. (i.e.
a design is always performed even if the autodesign property is off.)

• Do one of the following:

To Do this
Design a member/wall from a 2D or 3D view 1. Hover the mouse pointer over the member/

wall.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right click and select Design Member >
Static/RSA, or Design Wall > Static/RSA as
required.

Design a member from the Structure Tree 1. In the Members branch locate the member
reference.

2. Right click and select Design Member >
Static/RSA as required.

Design a wall from the Structure Tree 1. In the Walls branch locate the wall
reference.

2. Right click and select Design Wall >
Static/RSA as required.

Design all members in a core from the Structure
Tree

1. In the Cores branch locate the core
reference.

2. Right click and select Design member >
Static/RSA as required.

NOTE The Design Member and Design Wallcommands both use the
existing analysis results, (even if the analysis status is 'Out of Date').

Design selected members and walls
Design Selection performs a check or design of each entity in the current
selection, according to each entity's autodesign setting, (taking into account
any member design groups that are active).

1. In the active view, drag a box to make your selection.

2. Right-click, then in the context menu, select Design Selection >
Static/RSA as required. 

The selected members/walls are designed/checked.

If any members in the selection are in a design group, other members in
the same group are updated and checked as required.

NOTE The Design Selection command uses the existing analysis results,
(even if the analysis status is 'Out of Date').
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Interactively design a concrete member
Interactive design is only available for concrete beams columns and walls. A
dialog opens showing the existing design of the highlighted member for the
currently supplied reinforcement. From here you can interactively modify the
reinforcement and instantly see the result.

1. In the active view, hover the mouse pointer over the concrete member
you want to interactively design.

2. Right click and select Interactive Design > Static/RSA as required. 

The interactive dialog opens from where the member can be designed.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also:

Design all members in a level, slope, or frame
Design plane performs a check or design of each entity in the plane,
according to each entity's autodesign setting, (taking into account any member
design groups that are active).

1. In the Project Workspace, click Structure tab.

2. In the Structure tree, do one of the following:

To Do this
Design all members in a construction level Right click the required Level and select Design

plane > Static/RSA as required.

Design all members and walls in a frame Right click the required Frame and select Design
plane > Static/RSA as required.

Design all members in a slope Right click the required Slope and select Design
plane > Static/RSA as required.

NOTE • The Design plane command uses the existing analysis results,
(even if the analysis status is 'Out of Date').

• It requires at least one member in the selection to be in auto-
design mode.

• If any grouped members are designed and the grouped member
design option is on, all members of the group are considered in
the design even if they are not in the selected level, slope, or
frame.

Design all members
Design members performs performs a check or design of every member
according to each member's autodesign setting, (taking into account any
member design groups that are active).

Design models 611 Design steel members and cast-in-place concrete
beams, columns and walls



1. In the Project Workspace, click Structure tab.

2. Right-click the Members tree.

3. In the context menu, select Design members > Static/RSA as required.

NOTE • Design members uses the existing analysis results, (even if the
analysis status is 'Out of Date').

• It is not available until at least one member is in auto-design mode.

Design all walls
Design walls performs performs a check or design of every wall according to
each wall's autodesign setting.

1. In the Project Workspace, click Structure tab.

2. Right-click the Walls tree.

3. In the context menu, select Design walls > Static/RSA as required.

NOTE • Design walls uses the existing analysis results, (even if the analysis
status is 'Out of Date').

• It is not available until at least one wall to be in auto-design mode.

Design all members and walls
Design model performs performs a check or design of every member/wall in
the model according to the individual member/wall autodesign settings,
(taking into account any member design groups that are active).

1. In the Project Workspace, click Structure tab.

2. Right click the Structure branch.

3. In the context menu, select Design model > Static/RSA as required.

NOTE • Design model uses the existing analysis results, (even if the
analysis status is 'Out of Date').

• It is not available until at least one member is in auto-design mode.

Design all members of a particular section or type
Design members performs performs a check or design the selected members
according to each member's autodesign setting, (taking into account any
member design groups that are active).

1. In the Project Workspace, click Structure tab.

2. In the Members tree, right-click the section type or size you want to
design.
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3. In the context menu, select Design members > Static/RSA as required.

NOTE • Design members uses the existing analysis results, (even if the
analysis status is 'Out of Date').

• It is not available until at least one member is in auto-design mode.

Design all members in a group
Design Group performs performs a check or design of the selected member
group according to the autodesign settings in the group.

1. In the Project Workspace, click Groups tab.

2. In the Design tree, right-click the member group you want to design.

3. In the context menu, select Design Group > Static/RSA as required.

NOTE • Design Group uses the existing analysis results, (even if the
analysis status is 'Out of Date').

• It is not available unless the Design Groups option is checked for
the member type in Design Settings.

Design all members and walls in a sub structure
Design sub structure performs performs a check or design of all members/
walls in the selected sub structure according to their individual autodesign
settings, (taking into account any member design groups that are active).

1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure you want to
design.

3. In the context menu, select Design sub structure > Static/RSA as
required.

NOTE • Design sub structure uses the existing analysis results, (even if
the analysis status is 'Out of Date').

• It is not available until at least one member in the sub structure is
in auto-design mode.

Apply user defined utilization ratios
By default designs and checks are performed against a utilization ratio (U/R) of
1.0.
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To facilitate design optimization Tekla Structural Designer allows you to specify
user defined U/Rs on an individual member basis (currently for Eurocode, US,
and India head codes only).

NOTE Utilization ratio = actual performance value / maximum allowable
performance value.

Overview of user defined U/R
When applied to the autodesign process user defined U/Rs introduce a
measure of:

• Conservatism - if the value is less than 1.0

• Non conservatism - if the value is greater than 1.0

By not applying user defined U/Rs to the check process, you are still able to
work to the original U/R of 1.0 when working in check mode.

User defined U/Rs can be applied to the following objects:

• Members; steel and concrete columns and beams, composite beams, steel
joists and braces. This includes separate settings for each span/stack/panel
of continuous beams/columns/walls.

• Steel Trusses - includes; Truss member top/bottom, Truss member side/
internal.

• Portal frames (Individual members within Frames are treated as steel
columns and steel beams as appropriate).

• Concrete Walls and Slabs including panels, patches, and punching shear
checks.

• Foundations; Pad Bases (Spread Footings), Strip Bases, Pile Caps, Mat and
Piled Mat Foundation slabs and Piles.

Apply user defined U/R for autodesign only
Applying a value of utilization ratio < 1.0 for autodesign only introduces a
measure of conservatism into the autodesign process but doesn't fail the
member until the ratio default value of 1.0 is exceeded.

1. Select the required element or elements. 

The properties of the selected elements are displayed in the Properties
window

2. Expand Utilization ratio and select Apply (to autodesign), but do not
select Apply to check

3. Enter the Ratio limit as required. 
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NOTE For continuous beams/columns/walls you can apply separate
ratio limits for the individual spans/stacks/panels if required.

When an Autodesign is performed, the design will be incremented to achieve
a utilization ratio less than the ratio limit. When a Check is performed, the
check will pass provided the utilization ratio is less than 1.0.

Apply user defined U/R for autodesign and check
Applying a value of utilization ratio < 1.0 for autodesign and check introduces a
measure of conservatism into the autodesign process and fails the member
when the ratio value that was set is exceeded.

1. Select the required element or elements. 

The properties of the selected elements are displayed in the Properties
window

2. Expand Utilization ratio and select bothApply (to autodesign) and
Apply to check

3. Enter the Ratio limit as required. 

NOTE For continuous beams/columns/walls you can apply separate
ratio limits for the individual spans/stacks/panels if required.

When an Autodesign is performed, the design will be incremented to achieve
a utilization ratio less than the ratio limit. When a Check is performed, the
check will pass provided the utilization ratio is less than the ratio limit.

See also

Review and modify user defined utilization ratios (page 757)

Related video

User defined utilization ratio

Validate the model for design issues
If required, you can manually validate the model for design issues before the
model is submitted for design in order to trap errors that will cause the design
to fail.
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Run design validation

NOTE As design validation is performed automatically as part of all the
combined analysis and design processes, there is no requirement to
run design validation manually beforehand in those cases. You might
however elect to run the validation manually when performing
selective member and wall checking or design.

NOTE Design validation cannot be performed if model validation is
outdated.

• On the Design tab, click Validate. 

Tekla Structural Designer performs the design validation checks. If your
model contains any design validation issues, warning messages appear in
the Status tab of the Project Workspace.

Adjust the conditions considered in design validation

1. On the Home tab, click Model Settings.

2. Go to the Validation page.

3. Select the conditions that you want Tekla Structural Designer to consider
during validation checks.

4. Click OK.

7.2 Design slabs and run punching shear checks
Slab design in Tekla Structural Designer requires a certain amount of user
interaction, (which is why slabs are not considered when any of the combined
analysis and design commands are run).

Slab design can therefore be considered in isolation, the process being able to
be broken down into the following discreet steps:

1. Create slab patches over columns, beams, walls, or panels

2. Design slabs (the slab areas that lie outside the patches)

3. Design patches (the slab areas inside the patches)

4. Create punching shear checks as required

5. Design punching shear (page 629) for the whole model or individually

See also

Apply user defined utilization ratios (page 613)
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Create and modify patches
You can apply rectangular patches of reinforcement to individual slab items to
act in addition to the background reinforcement. After selecting the patch
type, you can place patches in the model by clicking or boxing around
elements in 2D or 3D views.

Overview of patches and patch types
Patches are used during the design of concrete slabs as a way of managing the
physical and design data. Each patch defines a rectangular area of slab within
which FE analysis results are collected, enabling Tekla Structural Designer to
perform the design process. Design moments are calculated along result
strips, embedded within each patch. Depending on the patch type, a patch can
contain up to 6 result strips, catering for up to 3 strips of reinforcement in
each of two perpendicular directions.

Tekla Structural Designer contains the following patch types:

• Column patch: can be placed at column stack heads

• Beam patch: can be placed along beams

• Wall patch: can be placed along walls

• Panel patch: can be placed at a specified position within the panel
boundary

• not restricted to a centralized position or to existing within one panel

• can be positioned under loads

Patches can be either on the top or the bottom of the slab and may or may not
have reinforcement defined in them. If you have not defined any
reinforcement, Tekla Structural Designer uses the background reinforcement.
If you have defined reinforcement, then for the top/bottom, x/y direction, you
can optionally use the sum of the background + patch reinforcement option, if
the patches are reasonably aligned.

NOTE Any patches may overlap on the plan view. However, during design,
the eventual overlap is ignored.

Create column patches
1. On the Design toolbar, click the arrow on the left side of the Patch list.

2. In the list, select Patch Column.

3. In the Properties window, adjust the patch properties according to your
needs.

a. To specify the patch size, type values in the Lx and Ly fields.

b. To specify the layer of the patch, select the desired option in Surface.
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c. To have the reinforcement automatically designed, select the
Autodesign option.

NOTE Only select the Consider patch surface moments only option if
you do not want Tekla Structural Designer to consider the
opposite surface.

One example where you would need the option is when the check
of slab reinforcement in the opposite surface fails, but another
patch exists in the same location at that face. When the second
patch is designed, additional reinforcement is provided at the
surface, so the surface check is not required for the original
patch.

4. According to your needs, do one of the following:

To Do this
Place a patch over a specific column • Click a column node within the slab.

Tekla Structural Designer creates a patch to
the selected column.

Place multiple patches a. Move the mouse pointer to one corner of
an imaginary box that will encompass the
columns to which you want to create
patches.

b. Hold down the left mouse button.

c. Drag the mouse pointer to the opposite
corner of the box.

d. Release the mouse button.

Tekla Structural Designer creates patches
to all columns entirely within the box.

Create beam patches
1. On the Design toolbar, click the arrow on the left side of the Patch list.

2. In the list, select Patch Beam.

3. In the Properties window, define the required patch width (perpendicular
to the beam span) and the center slab width. 

Tekla Structural Designer recalculates the two end strips accordingly. The
strips cannot be modified.

NOTE Only select the Consider patch surface moments only option if
you do not want Tekla Structural Designer to consider the
opposite surface.

One example where you would need the option is when the check
of slab reinforcement in the opposite surface fails, but another
patch exists in the same location at that face. When the second
patch is designed, additional reinforcement is provided at the
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surface, so the surface check is not required for the original
patch.

4. According to your needs, do one of the following:

To Do this
Place a patch over a specific beam span • Click the required beam span.

Tekla Structural Designer creates a patch
centered on and orientated to the beam
center line.

Place multiple patches a. Move the mouse pointer to one corner of
an imaginary box that will encompass the
beams to which you want to create
patches.

b. Hold down the left mouse button.

c. Drag the mouse pointer to the opposite
corner of the box.

d. Release the mouse button.

Tekla Structural Designer creates patches
to all beams entirely within the box.

Create wall patches
1. On the Design toolbar, click the arrow on the left side of the Patch list.

2. In the list, select Patch Wall.

3. In the Properties window, adjust the patch properties according to your
needs.

a. To specify the layer of the patch, select the desired option in Surface.

b. To have the reinforcement automatically designed, select the
Autodesign option.

c. Define the required patch width perpendicular to the wall.

NOTE Only select the Consider patch surface moments only option if
you do not want Tekla Structural Designer to consider the
opposite surface.

One example where you would need the option is when the check
of slab reinforcement in the opposite surface fails, but another
patch exists in the same location at that face. When the second
patch is designed, additional reinforcement is provided at the
surface, so the surface check is not required for the original
patch.

4. According to your needs, do one of the following:

To Do this
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Create a patch along a specific wall a. In the Properties window, set Create
Mode to Single Patch Along Wall.

b. Click the required wall.

Tekla Structural Designer creates a patch,
centered on and orientated to the wall
center line.

Place an internal patch and two end patches
along a specific wall

a. In the Properties window, set Create
Mode to Internal With End Patches.

b. Click the required wall.

Tekla Structural Designer creates an
internal patch and two end patches,
centered and orientated to the wall center
line.

Place an end patch at one end of a specific wall: a. In the Properties window, set Create
Mode to End Patch at Wall End.

b. Click near the required end of the wall.

Tekla Structural Designer creates a patch
at the end of the wall that is closest to the
point that you clicked.

Place an internal patch part way along a specific
wall

a. In the Properties window, set Create
Mode to Internal Patch.

b. Click to define the start point of the patch
along the required wall.

c. Click to define the end point of the patch
along the required wall.

Tekla Structural Designer creates a patch
between the selected points.

Create patches along multiple walls a. In the Properties window, set Create
Mode to Single Patch Along Wall or
Internal With End Patches.

b. Move the mouse pointer to one corner of
an imaginary box that will encompass the
walls to which you want to create patches.

c. Hold down the left mouse button.

d. Drag the mouse pointer to the opposite
corner of the box.

e. Release the mouse button.

Tekla Structural Designer creates patches
to all walls entirely within the box.

Create panel patches
1. On the Design toolbar, click the arrow on the left side of the Patch list.

2. In the list, select Patch Panel.

3. In the Properties window, adjust the patch properties according to your
needs.

a. To specify the patch size, type values in the Lx and Ly fields.

b. To specify the layer of the patch, select the desired option in Surface.
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c. To have the reinforcement automatically designed, select the
Autodesign option.

NOTE Only select the Consider patch surface moments only option if
you do not want Tekla Structural Designer to consider the
opposite surface.

One example where you would need the option is when the check
of slab reinforcement in the opposite surface fails, but another
patch exists in the same location at that face. When the second
patch is designed, additional reinforcement is provided at the
surface, so the surface check is not required for the original
patch.

4. According to your needs, do one of the following:

To Do this
Place the patch at the centroid of a specific panel a. In the Properties window, ensure that the

Create Patch at Centroid option is
selected.

b. Click anywhere within the required panel.

Tekla Structural Designer creates a patch
at the panel centroid.

Place the patch elsewhere within a specific panel a. In the Properties window, ensure that the
Create Patch at Centroid option is
cleared.

b. Still in the Properties window, do one of
the following:

• To define the patch by its corners,
select the Define corner points
option.

• To define the patch by its center, clear
the Define corner points option.

c. In the panel, click the points that define the
patch.

Tekla Structural Designer creates a patch
at the selected position.

Create multiple centroid patches a. In the Properties window, ensure that the
Create Patch at Centroid option is
selected.

b. Move the mouse pointer to one corner of
an imaginary box that will encompass the
panels to which you want to create
patches.

c. Hold down the left mouse button.

d. Drag the mouse pointer to the opposite
corner of the box.

e. Release the mouse button.

Tekla Structural Designer creates patches
to the centroids of all panels entirely within
the box.
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Modify patch properties
1. Hover the mouse pointer over the patch that you want to modify. 

The Select Entity tooltip appears.

2. In the Select Entity tooltip, use the arrow keys to navigate to the patch
name and press Enter.

3. In the Properties window, modify the patch properties according to your
needs.

a. To specify the patch size, type values in the Lx and Ly fields.

b. To specify the layer of the patch, select the desired option in Surface.

c. To have the reinforcement automatically designed, select the
Autodesign option.

d. To specify the directions of the reinforcement that you want to
design, select the appropriate option in Consider Strips.

e. To specify the type and direction of the reinforcement that you want
to design, select the appropriate option in Reinforcement.

f. To specify the required width for each strip, type a value in the Width
field.

g. To specify whether each strip should be designed for the average or
maximum design force, select the appropriate option in Design
Force.

Resize patches
1. Hover the mouse pointer over the patch that you want to resize. 

The Select Entity tooltip appears.

2. In the Select Entity tooltip, use the arrow keys to navigate to the patch
name and press Enter.

3. Hover the mouse pointer over the patch edge or corner that you want to
adjust. 

The Select Entity tooltip appears.

4. In the Select Entity tooltip, use the arrow keys to navigate to the edge or
corner node and press Enter.

5. Hold down the left mouse button and drag to move the edge or corner.

Design and check slabs
After creating any necessary patches, you can determine the top and bottom
reinforcement requirements in all the slab item areas that lie outside of the
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patch areas. Because patch areas are excluded from slab item design, you
should create patches before designing slab items.

NOTE Slabs can only be designed/checked after slab design moments have been
established from a suitable analysis. If valid analysis results do not yet exist
you would need to create them (by, for example, clicking Analyze All (Static)
from the Analyze toolbar).

Check an individual slab item
• Do one of the following:

To Do this
Check an individual slab from a 2D or 3D view 1. Hover the mouse pointer over the slab.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right-click, and from the context menu that
appears, select Check Panel.

Check an individual slab from the Structure Tree 1. In the Project Workspace, click Structure
tab.

2. In the Slabs branch, locate the slab
reference.

3. Right click and select Check Panel.

NOTE Check Panel uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also:

•

Check all slab items
1. In the Project Workspace, click Structure tab.

2. Right click on the Structure branch.

3. In the context menu, select Check model slabs as required.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also:

•

Check all slab items on a single floor
• Do one of the following:
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To Do this
Check all slabs in a floor from a 2D view 1. Open a 2D view of the floor that you plan to

design.

2. Right-click anywhere in the view.

3. In the context menu that appears, select
Check Slabs.

Tekla Structural Designer checks the
reinforcement of all slab items on the floor.

Check all slabs in a floor from the Structure Tree 1. In the Project Workspace, click Structure
tab.

2. In the Levels branch, right click the required
Level and select Check plane slabs.

NOTE This command uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also:

•

Check all slab items in a sub structure
1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure containing the
slabs you want to check.

3. In the context menu, select Check sub structure slabs. 

Tekla Structural Designer checks the reinforcement of all slab items on
the floor.

See also:

•

Design an individual slab item
• Do one of the following:

To Do this
Design an individual slab from a 2D or 3D view 1. Hover the mouse pointer over the slab.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right-click, and from the context menu that
appears, select Design Member.

Design an individual slab from the Structure Tree 1. In the Project Workspace, click Structure
tab.

2. In the Slabs branch, locate the slab
reference.

3. Right click and select Design panel.
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NOTE Design panel uses the existing analysis results, (even if the analysis
status is 'Out of Date').

See also:

•

Design all slab items

• On the Design tab, click Design Slabs. 

Tekla Structural Designer designs or checks all slab items in the model
according to their autodesign settings.

See also:

•

Design all slab items on a single floor
• Do one of the following:

To Do this
Design all slabs in a floor from 2D view 1. Open a 2D view of the floor that you plan to

design.

2. Right-click anywhere in the view.

3. In the context menu that appears, select
Design Slabs.

Design all slabs in a floor from the Structure Tree 1. In the Project Workspace, click Structure
tab.

2. In the Levels branch, right click the required
Level and select Design plane slabs.

See also:

•

Design all slab items in a sub structure
1. In the Project Workspace, click Structure tab.

2. In the Sub Structures tree, right-click the sub structure containing the
slabs you want to design.

3. In the context menu, select Design sub structure slabs. 

Tekla Structural Designer designs all slab items in the sub structure,
possibly selecting new reinforcement for them.

See also:
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•

Design and check patches
When that the slab item designs resulting from the slab or mat design process
are satisfactory, you can then proceed to design patches. You should design
slab items before designing patches, as the additional patch reinforcement
requirement takes account of the existing level of reinforcement provided by
the slab items.

NOTE For each strip within each patch, Tekla Structural Designer determines the
area of the required steel (A s,reqd) and the area of the provided steel (A s,prov).
The A s,prov calculation always considers the patch reinforcement, but if
necessary and allowed, you can also include additional background
reinforcement in the calculation.

Check an individual patch
1. Hover the mouse pointer over the patch that you want to check.

2. Right-click the patch.

3. In the context menu that appears, select Check Slab Patch. 

Tekla Structural Designer displays the results of the check in a new dialog.

Check all patches in the model
• The same command can be accessed in two ways:

• In a 3D Structural View, right click on the background and choose Check
Patches from the context menu.

• In the Project Workspace Structure tree, right-click on the Structure
branch and choose from the context menu.

Tekla Structural Designer checks the reinforcement of all patches in the
model.

Check all patches on a single floor
1. Open a 2D view of the floor that you plan to design.

2. Right-click anywhere in the view.

3. In the context menu that appears, select Check Patches. 

Tekla Structural Designer checks the reinforcement of all patches on the
floor.
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Design an individual patch
1. Hover the mouse pointer over the patch that you want to design.

2. Right-click the patch.

3. In the context menu that appears, select Design Slab Patch. Tekla
Structural Designer displays the results of the design in a new dialog.

The results of the design are displayed in a new dialog.

Design or check all patches in the model
• The same command can be accessed in three ways:

• On the Design tab, click  Design Patches

• In a 3D Structural View, right click on the background and choose
Design Patches from the context menu.

• In the Project Workspace Structure tree, right-click on the Structure
branch and choose from the context menu.

Tekla Structural Designer designs or checks all patches in the model
according to their autodesign settings.

Design all patches on a single floor
1. Open a 2D view of the floor that you want to design.

2. Right-click anywhere in the view.

3. In the context menu that appears, select Design Patches. 

Tekla Structural Designer designs all patches on the floor, possibly
selecting new reinforcement for them.

Create punching shear checks
You can apply punching shear checks to flat slabs and foundation mats by
using the Add Check command on the Design tab.

Punching check locations
You can apply punching shear checks as follows:

In flat slabs:

• Concrete columns supporting a flat slab with and without drops

• Concrete columns supported by a flat slab

• Concrete columns through a flat slab with or without drops
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• Concrete walls supporting a flat slab

• Concrete walls supported by a flat slab

• Concrete walls through a flat slab

• Steel columns supported by a flat slab

• Point loads at either face of a flat slab

In foundation mats:

• Concrete columns supported by a foundation mat

• Concrete walls supported by a foundation mat

• Steel columns supported by a foundation mat

• Point loads on a foundation mat

• individual piles supporting a foundation mat

Punching check axis orientation
• When you apply a punching shear check to a column, the check Y and Z

axes are automatically orientated to align with the column major and
minor axes. The two axis systems are locked together, so if the column is
rotated, the punching check axes also rotate.

• When you apply a punching shear check to a point load, you must
manually define the punching shear check Z axis orientation. You can do
this in the Properties window by specifying the point load orientation in
relation to the global Y axis.

NOTE Point load properties (including point load orientation, point load
breadth, and point load depth) are not applicable when you apply
a check to a column.

Create punching check items

NOTE Punching check items can generally be created in 2D and 3D
Structural or Review Views, apart from checks around walls which can
only be created in Structural Views, but not currently in Review Views.

Punching check items are the objects to which the punching shear information
and calculations are attached. To create punching check items, do the
following:

1. On the Design tab, click Add Check.

2. Go to the Properties window-

3. Ensure that the location for the slab tension reinforcement is correct.
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4. Adjust the remaining properties according to your needs. 

NOTE The point load properties are only relevant if you are adding the
check to a point load position.

5. To create the check, do one of the following:

• Hover the mouse pointer over the desired column node, wall node, or
point load. When the Pick Punching Check Location tooltip appears,
click to add the punching shear at the selected node.

• Hold down the left mouse button and drag a box to add punching
check items to all potential check locations within the box.

Specify stud rail reinforcement

RESTRICTION Stud rail reinforcement is only available for Eurocode and ACI
head codes.

You can specify an orthogonal or circular arrangement of stud
rails, and then check or design it as required.

1. Create a punching check item as instructed above.

2. Go to the Properties window.

3. Select the Use reinforcement option.

4. Select whether you want to autodesign the reinforcement.

5. Adjust the remaining reinforcement properties according to your needs.

Modify the properties of existing punching check items
1. Right-click the punching check item.

2. In the context menu, select Edit Reinforcement.

Design and check punching shear

Overview of the Design Punching Shear command
The Design Punching Shear command calculates an applied load on the slab,
accounting for the difference in column/wall axial load and bending. In
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addition, the command checks the slab shear stresses, accounting for the
reinforcement present (background and column/general patches).

Provided that you are using the Eurocode or ACI head code, you can also
design the punching reinforcement as an orthogonal or circular arrangement
of stud rails at the following locations:

In flat slabs:

• Concrete columns supporting a flat slab without drops

• Concrete columns supported by a flat slab

• Concrete columns through a flat slab without drops

• Point loads at either face of a flat slab

In foundation mats:

• Concrete columns supported by a foundation mat

• Point loads on a foundation mat

Column head drops and the presence of openings within a certain distance of
the punching shear boundary are taken into account in the punching shear
calculations.

Where punching checks are closely spaced and the perimeters overlap the
checks are beyond scope.

NOTE • Since the checks are dependent on using the correct levels of slab
reinforcement (typically provided by patch reinforcement), do not check
punching before designing the patches.

• View punching checks applied to walls with caution. Their applicability to
long walls is particularly questionable, as the check does not consider the
potential for stress concentrations at the ends of the wall.

Check punching shear for an individual punching check item
• Do one of the following:

To Do this
Check an individual punching check item from a
2D or 3D view

1. Hover the mouse pointer over the punching
check.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right-click, and from the context menu that
appears, select Check Punching Shear.

Check an individual punching check item from the
Structure Tree

1. In the Project Workspace, click Structure
tab.

2. In the Slabs> Punching Checks branch,
locate the check reference.

3. Right click and select Check Punching
Shear.
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Check all punching check items
1. In the Project Workspace, click Structure tab

2. Right click the Structure branch and select Check Punching Shear

Check all punching shear check items on a floor
1. In the Project Workspace, click Structure tab.

2. In the Levels branch, right click the required Level and select Check
Punching Shear.

Design all punching check items
• Do one of the following:

To Do this
Design all punching check items from the ribbon

1. On the Design tab, click Design
Punching Shear.

Design all punching check items from the
Structure Tree

1. In the Project Workspace, click Structure
tab.

2. Right click the Structure branch and select
Design Punching Shear.

Tekla Structural Designer performs punching shear checks for all punching
check items in the model based on their individual auto-design setting. If
the punching check item does not connect to a flat slab, punching shear is
flagged as beyond scope.

Design all punching shear check items on a floor
1. In the Project Workspace, click Structure tab.

2. In the Levels branch, right click the required Level and select Design
Punching Shear.

Design an individual punching check item
• Do one of the following:

To Do this
Design an individual punching check item from a
2D or 3D view

1. Hover the mouse pointer over the punching
check.

2. If a different entity is highlighted, press the
<down arrow> cursor key until the correct
reference is shown in the Select Entity
tooltip.

3. Right-click, and from the context menu that
appears, select Design Punching Shear.
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Design an individual punching check item from
the Structure Tree

1. In the Project Workspace, click Structure
tab.

2. In the Slabs> Punching Checks branch,
locate the check reference.

3. Right click and select Design Punching
Shear.

Tekla Structural Designer displays the results of the design in a new dialog
box.

7.3 Design timber and precast members using Tekla
Tedds
Timber and precast members that have been modelled and analysed in Tekla
Structural Designer can then be designed in Tekla Tedds if a licence is
available.

For further information, see:

•

•

7.4 Create and run floor vibration checks
To establish the response of the floor to dynamic excitation you can apply a
floor vibration checks. These are applied over a user-defined rectangular or
polygon shaped slab area by using the Add Check command in the Floor
Vibration group. In order to create the check, you need to identify a primary
beam, secondary beam and critical slab item. In addition, you must specify
associated data in order to perform the floor vibration calculation.

See also

Create and modify floor vibration checks (page 632)

Run floor vibration checks (page 635)

Create and modify floor vibration checks
To establish the response of the floor to dynamic excitation you can apply a
floor vibration checks. These are applied over a user-defined rectangular or
polygon shaped slab area by using the Add Check command in the Floor
Vibration group. In order to create the check, you need to identify a primary
beam, secondary beam and critical slab item. In addition, you must specify
associated data in order to perform the floor vibration calculation.
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Vibration of Floors to SCI P354 Handbook; Vibration of Floors to DG11
Handbook; Vibration of Floors to SCI P354 Example

Create floor vibration check items
Floor vibration check items are the objects to which the floor vibration check
information and calculations are attached.

NOTE Floor vibration check items can only be created in 2D Views.

1. On the Design tab, click Add Check.

2. Go to the Properties window.

3. In FloorPlateDefinition, select whether you want to create a rectangular
or polygonal slab.

a. If you selected the Rectangular option, adjust the local x angle to
define the angle at which the rectangle will be drawn, if necessary.

4. To create a check area, in the model, do one of the following depending
on the slab shape:

• Rectangular: Click once to define the first corner of the rectangle, and
again to define the opposite corner.

• Polygon: Click to define the corners of the polygon. In order to close
the shape, click the first point again.

5. Click to define the primary beam. 

The primary beam properties appear in the Properties window.

6. Click to define the secondary beam. 

The secondary beam properties appear in the Properties window.

7. Click to define the critical slab item. 

NOTE If the critical slab item is a composite slab, Tekla Structural
Designer automatically defines the slab item properties. In other
cases, you need to input the properties yourself.

The critical slab item properties appear in the Properties window.

8. In the Properties window, review and adjust the check item properties.

9. Click anywhere in the model to create the check item. 

Tekla Structural Designer highlights the primary beam, secondary beam
and critical slab item of the current check item.

10. Create new checks, or press Esc to finish creating floor vibration check
items.
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Create floor vibration checks that consider two or three adjoining
spans
Creating two-span or three-span floor vibration checks is almost identical to
that required for single spans. When creating the check item, do the following:

• In the Properties window, set the Adjoining Spans property of a primary
and/or secondary beam to Two span or Three span.

NOTE If the Two span option is selected, note the following:

• When you hover the mouse pointer to select the beam, only
beams of two or more spans are available.

• When a beam is highlighted, note that the beam directly under the
mouse pointer will become the critical beam, and the second
highlighted beam will become the adjoining beam.

• The second highlighted beam (the adjoining beam) will be the
beam closest to the mouse pointer position. That's why, in order to
highlight the adjoining beam at a particular end of the critical
beam, you can move the mouse pointer toward that end of the
critical beam.

NOTE If the Three span option is selected, note the following:

• When you hover the mouse pointer to select the beam, only
beams of three or more spans are available to be highlighted,

• When a beam is highlighted, note that the beam directly under the
mouse pointer will become the critical beam, and the second
highlighted beam will become the adjoining beam.

• The second highlighted beam (the adjoining beam) will be the
beam closest to the mouse pointer position. That's why, in order to
highlight the adjoining beam at a particular end of the critical
beam, you can move the mouse pointer toward that end of the
critical beam.

Modify the properties of existing floor vibration check items
1. In Scene Content, ensure that Floor Vibration Checks have been turned

on.

2. Hover the mouse pointer over the slab area where the floor vibration
check item lies. 

The Select Entity tooltip appears.

3. Navigate to the floor vibration check item name by using the arrow keys,
and click Enter. 

The floor vibration check properties appear in the Properties window.
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4. In the Properties window, adjust the check item properties according to
your needs.

Run floor vibration checks

Check vibration for all floor vibration check items
• On the Design tab, click Check Floor Vibration. 

Tekla Structural Designer performs floor vibration checks for all floor
vibration check items in the model.

Check floor vibration for an individual floor vibration check item
1. Hover the mouse pointer over the floor vibration check item that you

want to check. 

The Select Entity tooltip appears.

2. If necessary, navigate to the floor vibration check item name by using the
arrow keys.

3. Right-click the check item.

4. In the context menu, select Check Floor Vibration. Tekla Structural
Designer displays the results of the design in a new dialog box.

7.5 Create and check steel connections
• Check simple connection resistance (page 635)

• Create and check column base plates (page 645)

• Create and size SidePlate connections (page 645)

• Create and design other connections (page 655)

• Export connections to another application for design (page 661)

Check simple connection resistance
Tekla Structural Designer provides a quick and simple way of checking the
shear capacity of simple beam connections, and the axial capacity of brace
connections.
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Overview
Tekla Structural Designer has a Connection Resistance database for simple
beams and braces. For simple beams the database contains pre-defined types
with pre-defined resistances (page 895) to Eurocode and US head codes.

You can add user-defined connection types (page 898) and user-defined
resistances (page 898) to the database for any head code, for steel and cold
formed materials. Once defined, these can then be used across all projects.

Each resistance value in the database has an 'active' flag which must be 'on'
for the resistance to be considered. (Simple beams and braces in the model
that have no active resistances are not checked.)

Having configured the active resisistances in the database as required, the
checks are then performed in the model as follows:

• For each simple beam the active shear resistances for each available
connection type are read from the database.

• These resistances are compared to the maximum shear force at the
connection (determined from a 3D analysis)

• The connection configuration is optimized accordingly for each connection
type.

• A similar process is then followed for each brace, by comparing the active
axial resistances to the maximum applied axial force.

Results can be displayed in a review data table, or output via a connection
resistance report.

Specify 'active' connection resistances (Eurocodes)
Since only active resistances are considered in the check, you can deactivate
resistances for those connection configurations you do not want to be
considered.

The active status of resistances can be set on or off directly (by ticking or
unticking a checkbox in the Active column) but a quicker way of changing the
active status is with the Activate/Deactivate dialog.

1. In the Connection Resistance dialog (page 1174), click Activate/
Deactivate...

2. Set the filters in the dialog, then set either Activate or Deactivate, as
required.

3. Click Apply if you want to change further Active settings, or click Apply &
Close to finish.

Example: From the pre-defined connection types you want only Fin Plates to
be active, only for S355 Universal Beams, and only those Fin Plates with 1 line
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of bolts. There are a number of ways to achieve this using Activate/
Deactivate but one way would be as follows:

1. Click Activate/Deactivate...

2. Deactivate everything - select ‘All’ in each of the Activate/Deactivate filters,
select ‘Deactivate matching resistance values’, then Apply

3. To activate only Fin Plates for S355 Universal Beams with 1 line of bolts

a. select Fin Plate in the Connection Type filter,

b. select S355 in the Grade filter,

c. select 1 in the # Bolt Lines filter,

d. select Universal Beams in the Section List filter,

e. select ‘All’ in the other filters (# Notches, # Bolt Rows),

f. select ‘Activate matching resistance values’,

g. click Apply & Close
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Following step 3, you will find ticks in the Active column only for Fin Plates with
S355 Universal Beams with 1 line of bolts, but note these changes are not saved
to the database, and do not become active in Reports or in Tabular Data, until
clicking OK in the main dialog.

Specify 'active' connection resistances (US)
Since only active resistances are considered in the check, you can deactivate
resistances for those connection configurations you do not want to be
considered.

The active status of resistances can be set on or off directly (by ticking or
unticking a checkbox in the Active column) but a quicker way of changing the
active status is with the Activate/Deactivate dialog.

1. In the Connection Resistance dialog (page 1174), click Activate/
Deactivate...

2. Set the filters in the dialog, then set either Activate or Deactivate, as
required.

3. Click Apply if you want to change further Active settings, or click Apply &
Close to finish.

Example: From the pre-defined connection types you want only Single Plates
to be active, for W & M beams of ‘Any’ Fy, only for 3/4 in bolts, but for all
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defined thicknesses of plate. There are a number of ways to achieve this using
Activate/Deactivate but one way would be as follows:

1. Click Activate/Deactivate...

2. Deactivate everything - select ‘All’ in each of the Activate/Deactivate filters,
select ‘Deactivate matching resistance values’, then Apply

3. To activate only Single Plates for W & M Beams of ‘Any’ Fy, with 3/4 in
diameter bolts and all plate thickness

a. select Single Plate in the Connection Type filter,

b. select Any in the Fy filter, select 3/4 in in the Bolt Diameter filter,

c. select W & M in the Section List filter,

d. select ‘All’ in the other filters (Coping, # Bolt Lines, # Bolt Rows,
Thickness),

e. select ‘Activate matching resistance values’,

f. click Apply & Close
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Following step 3, you will find ticks in the Active column only for Single Plates,
with Any Fy selected, and W & M Beams with 3/4 in diameter bolts, but note
these changes are not saved to the database, and do not become active in Reports
or in Tabular Data, until clicking OK in the main dialog.

Run resistance checks
Provided you have an appropriate set of 'active' resistances, the checks are
performed automatically, using the current analysis results - you can proceed
directly to a review of the check results.

• If necessary, analyse the model to generate an up-to-date set of analysis
results,

• Review the check results, see: Display connection resistance checks in a
review data table below.
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The connection optimization process
Tekla Structural Designer carries out an optimization process to find the first
passing Active resistance based on the name of the Connection Type and the
number of Bolt Lines and Bolt Rows assigned to that name.

For Eurocodes, separate check results are reported for each 'active'
connection type and each notch variation.

For US codes, separate check results are reported for each 'active' connection
type and each coping variation.

Example: to Eurocode, a Fin Plate for an S355 UB 457x152x52 with 1 and then
2 lines of bolts has pre-defined resistances as shown below. All resistances are
indicated as Active.
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If an S355 UB 457x152x52 in a model is found to have an applied major shear
force of 250 kN then the connection resistance check will report that a Fin
Plate with 1 bolt line and 4 bolt rows (resistance 263 kN) is adequate.

If the applied major shear force is 300 kN then the connection resistance
check will report that a Fin Plate with 1 bolt line and 5 bolt rows (resistance
352 kN) is adequate.
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If the applied major shear force is 355 kN then the connection resistance
check will report that a Fin Plate with 2 bolt lines and 5 bolt rows (resistance
450 kN) is adequate.

For each of the applied major shear forces given above only the first passing
resistance is reported, by looping through the Active bolt rows for 1 bolt line
followed, where necessary, by looping through the Active bolt rows for 2 bolt
lines.

If Tekla Structural Designer gets to the end of these loops and still doesn’t find
a passing resistance then it reports the last resistance found and a fail status
e.g. if the applied major shear force is 455 kN then the connection resistance
check will report that a Fin Plate with 2 bolt lines and 5 bolt rows (resistance
450 kN) fails.

Now suppose that the UB 457x152x52 with 1 bolt line and 5 bolt rows
(resistance 352 kN) is not Active. The first shear check above (applied force 250
kN) would be unchanged but the second check (applied force 300 kN) would
now report that a Fin Plate with 2 bolt lines and 4 bolt rows (resistance 349 kN)
is adequate. This illustrates the interplay of the resistance Active status with
the optimization process.

Display connection resistance checks in a review data table
To create a tabular connection resistance summary:

1. If necessary, change the view regime (page 89) to a Review View.

2. On the Review ribbon tab, click Tabular Data. 

A Review Data tab opens on the ribbon and a Review Data View is
displayed.

3. On the Review Data ribbon tab, in the list in the View Type group, select
Connection Resistance.

4. In the Material Type group, select the material (either Steel, or Cold
Formed).

The available selections in the Characteristic group (and the other
groups) are reduced to those appropriate to the selected material.

5. In the Characteristic group, select the required characteristic (either
Beams, or Braces).
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6. In the Construction group, select Composite, Non-composite, or both.

7. In the Fabrication group, select the required fabrication types.

A resistance check is provided for the filtered selection for every section where
a resistance has been specified in the database.

NOTE A resistance check is not provided for beams that do not have simple
connections.

NOTE If there is uplift in any load combination then the maximum uplift
shear force will be displayed, with a warning that connection
resistance is not checked for uplift condition.

NOTE Each time you re-analyse the building, if you have the Connection
Resistance data table open you must close and then re-open it to
update the results.

Create and display a connection resistance report

1. On the Report tab, use the droplist to select the existing Connection
Resistance report.

2. Click Model Report...

3. Review the report structure and adjust as required.
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4. Click OK to save the report.

5. Click Show Report

Related video
Predefined connection resistance database for Eurocode and AISC

Create and check column base plates
Base plates can only be created under steel columns. How these can be
checked depends on the head code being worked to.

Create column base plates
Tekla Structural Designer automatically adds a base plate on creation of a new
steel column if a support is required.

NOTE If an existing steel column is missing a base plate you can add one by
clicking the (Add) Base Plate button (page 207) on the Design ribbon
and then select the column.

Check column base plates
How base plates are checked depends on the head code being worked to.

• AISC and Eurocode

Base plates can be checked directly in Tekla Structural Designer, but cannot
be designed in Tekla Connection Designer. For details, see: in the Steel
Design Handbook

• British Standards

Base plates cannot be checked directly in Tekla Structural Designer, but
can be designed in Tekla Connection Designer. For details, see: Create and
design other connections (page 655)

• Australian & Indian Standards

Base plates cannot be checked in Tekla Structural Designer, or designed in
Tekla Connection Designer.
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Create and size SidePlate connections
SidePlates are a US proprietary connection system that can be applied in Tekla
Structural Designer but are considered separately to other connection types.

Click the following links to find out more:

• For background to their usage in Tekla Structural Designer, see

SidePlate connections theory (page 646)

• For modeling instructions, see

Create SidePlate connections (page 653)

SidePlate connections theory

Overview of SidePlate connections

SidePlate® is a type of moment connection for connecting I or HSS section
beams to I, HSS, built up box or built up WF (cruciform) section columns.

SidePlates are welded to the column section in the fabrication shop. Plates or
angles are similarly welded to beam ends.

The column and beam units are transferred to site where the columns are
erected and the beams are lifted into place and either bolted or welded to the
columns. SidePlate connections are used on buildings of 1 to 30 stories tall.

Within the structure, the beam end is held in position by SidePlates. The net
result is moment connection with a very stiff section of column and a stiffened
beam end.

SidePlate connection types can be:

• Non-Seismic moment connections

• A beam/column moment connection anywhere in the structure

• Seismic moment connections

• A seismic beam/column moment connection within any of the following
seismic force resisting systems Ordinary Moment Frame (OMF),
Intermediate Moment Frame (IMF) or Special Moment Frame (SMF).

SidePlate connections work for all WF and HSS sections in the AISC steel book,
and for all UB and UKB sections. However it is worth noting the SidePlate
datafile may NOT have a full set of values for all 'clear spans' or all %Mps for all
these sections; if this is the case then no SidePlate connection can be applied
at the joint.

Tekla Structural Designer can perform an initial sizing for the SidePlate
connection, but the final detailed design of the SidePlate connection has to be
undertaken in SidePlate® software.
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Permitted SidePlate connections in Tekla Structural Designer

RESTRICTION In Tekla Structural Designer, sideplate connections are
currently only permitted for US Customary sections and not
for metric sections.

Column

Side Plate Permitted Connections

 

Tekla
Structu

ral
Designe
r Status

Non-Seismic
Moment

Connections

Seismic Moment
Connections

Beam Beam
I HSS I HSS

WF Flange yes yes yes yes Modele
d

Analyze
d

Designe
d

Web yes yes Warning Warning

HSS Flange yes yes yes yes Modele
d

Analyze
d

Designe
d

Web yes yes yes yes

Plated
box

Flange yes yes yes yes Modele
d

Analyze
d

Not
Designe
d

Web yes yes yes yes

WF +
2xWT

Flange yes yes yes yes Not
Modele
d

Not
Analyze
d

Not
Designe
d

Web yes yes yes yes

Design models 647 Create and check steel connections



Column

Side Plate Permitted Connections

 

Tekla
Structu

ral
Designe
r Status

Non-Seismic
Moment

Connections

Seismic Moment
Connections

Beam Beam
I HSS I HSS

WF +
1xWT

Flange yes yes yes yes Not
Modele
d

Not
Analyze
d

Not
Designe
d

Web yes yes Warning Warning

SidePlate workflow in Tekla Structural Designer

A brief description of the SidePlate workflow in Tekla Structural Designer is
given here with more detail available in the subsequent topics.

• Modeling: You define SidePlate connections by changing properties of the
relevant beam or beams.

NOTE The Update Connections process used for defining other
connection types is not applicable for SidePlate.

Connection objects are not created for any point on a steel column
where any of the beams attached at that point have a SidePlate
connection.

• Visualisation: Each connection is initially shown in the graphics as a simple
box. After sizing has been performed it is shown as a pair of plates.

• Validation: Some preliminary checks are carried out in Model validation
(page 338), (additional checks are done subsequently in Initial sizing and
Analysis model adjustment). Any problems do not stop the analysis and
design process but mean the relevant beam and or column will not benefit
from the enhanced properties.

• Initial sizing: The initial SidePlate dimensions are determined during the
Design Steel (Static & RSA) and Design All (Static & RSA) processes, using
data provided by SidePlate and incorporated into Tekla Structural
Designer.

NOTE After the initial sizing process, any changes to loading, (individual
loads, loadcases and combinations), will not trigger change control
for the SidePlates, i.e. they will keep those initial sizes. You can
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reset the status using Review mode (page 754) if you decide that
the sizing process needs to be run again.

• Analysis model adjustment: Where valid SidePlate dimensions exist, the
analysis model passed to the solver is adjusted to reflect the increased
stiffness of the SidePlate connections. This is done during stand-alone
analysis as well as Design.

• Steel member design: If SidePlate connections exist, they are taken into
account in the member design for steel beams and columns. The changes
affect both static and seismic design.

• Review: The SidePlate connection status can be seen easily in a Review
view (page 754), and tooltips give more information.

• Reports: A “SidePlate Connection Report” can be generated.

• Final design: SidePlate developers can use the Tekla Structural Designer
API in order to fully design a SidePlate connection defined and initially
sized in Tekla Structural Designer

NOTE Design of SidePlate connections is beyond scope for both Tekla
Connection Designer and export to the IDEA StatiCa Connection
Design program.

SidePlate 'joint' and 'connection' terminology

NOTE • A SidePlate joint exists at a column node and consists of 1 to 4 valid
connections.

• Every suitable beam framing into the column node can create a SidePlate
connection.

A SidePlate connection exists at End 1 and / or End 2 of a steel beam where
Apply SidePlate Connection is true. It will still exist even if other data makes
it invalid. The connection position is the reference point at the relevant end of
the beam.

All connections sharing the same position on a column are considered as a
single SidePlate Joint. No attempt is made to merge separate SidePlate joints
even where the relevant levels are close.

Various checks are performed on each connection and each joint, and the
analysis model is only be adjusted if they all pass. In particular, if the depths of
two SidePlate joints overlap then a warning is generated and the analysis
model is not be adjusted.
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SidePlate validation

SidePlate validation is performed during model validation.

If warnings are issued, this will typically result in the Connection Status being
set to "Not Applied" in the Properties window.

NOTE Until the “Not Applied” Connection Status is resolved, the connection will not
be considered for the initial sizing process.

Initial sizing of the SidePlates

The initial SidePlate dimensions are determined during the Design Steel (Static
& RSA) and Design All (Static & RSA) processes.

The initial sizing process is only performed where the Sizing Status is “Not
Performed” and the Connection Status is not “Not Applied”.

For each connection that is considered, a number of checks are performed in
order to verify that SidePlate can be applied. If any of the checks fail, the
Connection Status is set to "Not Applied".

NOTE After the initial sizing process, any changes to loading, (individual
loads, load cases and combinations), will not trigger change control for
the SidePlates, i.e. they will keep those initial sizes. You can reset the
status using Review mode if you decide that the sizing process needs
to be run again.

Analysis model adjustment

Analysis model adjustment is only performed for valid SidePlate connections
that have successfully completed the initial sizing process, i.e. where the Sizing
Status is not “Not Performed”.

Both the geometry and the properties of the Solver model are dependent
upon the size of the SidePlate connection.
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For the beam

• B2 – a new 1d element on the beam, with stiffened beam properties.

• B1 – a rigid offset on the end of B2

• B3 – normal bare beam properties

For the Column

• C1 – a rigid offset at the top of the column 1d element

• C2 – normal column properties

Design/Analysis processes and recommended workflows

Tekla Structural Designer can automatically size members throughout a
structure – we call this Autodesign. The process is complex and involves
sophisticated initial sizing, multiple analysis runs with repeated design cycles.
The interweaving of initial sizing for SidePlate connections into the Autodesign
routines is a highly complex process and for the first implementation remains
beyond scope. Instead you have to manually reduce section sizes to take
advantage of the SidePlate advantages.

Any beams and columns not affected by SidePlate connections can be
AutoDesigned as normal during this process.

The following examples show the results for 2 different workflows where each
step is carried out in the exact order specified and assuming that there are no
model issues.
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Recommended Workflow

• Full model created including loadcases and combinations - AutoDesign left
checked for all columns, beams etc.

• Check “Apply SidePlate Connection” for selected beams - also set Utilization
Ratio to 1.25 for those beams.

• Set Utilization Ratio to 1.1 for selected columns

• Run 1st order linear analysis

• Validation will generate SidePlate AutoDesign warnings where relevant

• SidePlate Initial Sizing will not be performed because not Static Design

• Adjust Solver Model will not be performed because no Connections will
have Sizing Status not “Not Performed”.

• Run Gravity Design Steel

• Validation will generate SidePlate AutoDesign warnings where relevant

• SidePlate Initial Sizing will not be performed because not Static Design

• Adjust Solver Model will not be performed because no connections will
have Sizing Status not “Not Performed”.

• Reset Utilization Ratio to 1.0 for relevant beams and columns

• Run Static Design Steel

• No SidePlate related validation warnings

• SidePlate Initial Sizing is performed for all connections

• Adjust Solver Model will be performed for subsequent analysis

• Manually adjust section sizes to achieve further size savings with SidePlate
connections

• SidePlate Connection Status will be reset where necessary

• Run Static Design Steel

• No SidePlate related validation warnings

• SidePlate Initial Sizing is performed only where section sizes have been
changed

• Adjust Solver Model will be performed

At the end of this workflow, any subsequent stand-alone analysis will also use
the adjusted solver model.

Other Workflow

• Full model created including loadcases and combinations - AutoDesign left
checked for all columns, beams etc.

• Check “Apply SidePlate Connection” for selected beams.
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• Run Static Design Steel

• Validation will generate SidePlate AutoDesign warnings where relevant

• SidePlate Initial Sizing will not be performed because Connection Status
will be set to Warning

• Adjust Solver Model will not be performed because no Connections will
have Sizing Status not “Not Performed”.

• Run Static Design Steel

• No SidePlate related validation warnings

• SidePlate Initial Sizing is performed for all Connections

• Adjust Solver Model will be performed for subsequent analysis

Effects of SidePlate on steel member design

Any beams and columns not affected by SidePlate connections can be
AutoDesigned as normal.

Beams and columns affected by SidePlate connections cannot be
AutoDesigned.

Where SidePlate connections exist, changes are required for both static and
seismic member design.

For static design

• Beam and column buckling lengths are affected.

• Beam and column design checks are adjusted so that they are applied
outside the physical length of any SidePlate connection

For seismic design

• OMF frames - no change

• IMF frames – various changes

• SMF frames – various changes

Create SidePlate connections
To add SidePlate connections:

1. Select the steel beam(s) to which you want to apply SidePlate connections.

2. In the Properties window, expand the SidePlate heading and select Apply
SidePlate connection at one, or both ends as required.

3. In the Properties window, select the SidePlate Connection type that is
appropriate to the SFRS type that has been specified, or, if not in a seismic
frame, set the type as SidePlate MF (moment frame). 

Each connection is initially shown in the graphics as a simple box. After
sizing has been performed it will be shown as a pair of plates.
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See also

Beam properties - SidePlate (page 654)

Modify SidePlates (page 754)

Beam properties - SidePlate

For steel beams the Properties window has a SidePlate group within which an 
Apply SidePlate Connection check box can be selected for End 1 and End 2 of
the beam.

When selected the following properties are displayed:

• Seismic Provision - depending on the head code, one of:

• Non-Seismic (ACI/AISC only)

• Seismic OMF

• Seismic IMF (ACI/AISC only)

• Seismic SMF

• Field Connection, (user option if Connection Type is Seismic SMF, otherwise
fixed to Bolted)

• Bolted (default)

• Welded

• Datafile look up criteria (readonly)

• Use %Mp (if Connection Type is Non-Seismic)

• Use clear span (otherwise)

• Connection Status - one of

• Unknown (default)

• Pass

• Warning

• Not Applied

• Failure Reason - one of

• Unknown (default)

• Datafile Look Up Failed

• Geometric Compatibility

• Beam Element too short for Rigid Offset

• Column Element too short for Rigid Offset

• Sizing Status - one of

• Not Performed (default)
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• Initial

• Final

• SidePlate size and other data set during the Initial Sizing Process, (Invisible
if Sizing Status is Not Performed)

• DimA – the outstand distance required for the SidePlate connection

• DimB – the depth required for the SidePlate connection

• Tsp – the thickness of the SidePlates

• DimH – the length of the SidePlates

• %Mp- if calculated during initial sizing

• Clear span - if calculated during initial sizing

NOTE These properties are for the start and end of the whole beam. Where
a steel beam is multi-span it is not possible to apply SidePlate
connections to the internal points.

Create and design other connections

NOTE These topics relate to the design of connections using either Tekla Connection
Designer, or IDEA StatiCa; they do not cover checking of simple connection
resistance (page 635), or checking of AISC/Eurocode base plates, which are
separate topics.

Overview
Before connections can be designed in Tekla Structural Designer valid
connection objects have to be created in the model. This is achieved by
running Update connections from the Project Workspace. This applies a set
of rules (page 658) to create and organize connections into the following
types:

• Base plate connections - BS head code only

NOTE Base plates to AISC or Eurocode head codes are handled
differently, see:

• Beam to beam moment connections

• Beam to beam simple connections

• Beam to column moment connections

• Beam to column simple connections

• Column splice connections
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• General connections

Valid connections are then displayed in the scene views and are also listed in
the Connections tree.

Provided a license of Tekla Connection Designer is available, some of these
can then be designed or exported to Tekla Connection Designer. If you have a
license of IDEA StatiCa you can also export some types to that software for
design.

Type Connection Design Options
Base plate connections • Design Connection (BS head code

only)

• Export to Tekla Connection
Designer (BS head code only)

Beam to beam moment connections • Design Connection (Eurocode and
BS head codes only)

• Export to Tekla Connection
Designer (Eurocode and BS head
codes only)

• Export to IDEA StatiCa
Beam to beam simple connections • Export to IDEA StatiCa
Beam to column moment
connections

• Design Connection (Eurocode and
BS head codes only)

• Export to Tekla Connection
Designer (Eurocode and BS head
codes only)

• Export to IDEA StatiCa
Beam to column simple connections • Export to IDEA StatiCa
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Type Connection Design Options
Column splices • Design Connection (Eurocode and

BS head codes only)

• Export to Tekla Connection
Designer (Eurocode and BS head
codes only)

• Export to IDEA StatiCa
General Connections • Export to IDEA StatiCa

See also

• Recommended workflows for specific connection types (page 658)

• Limitations when using Tekla Connection Designer with Tekla Structural
Designer (page 660)

Update connections
To create connection objects for the first time, or to recreate connections after
changes to the model:

1. Click on the Connections tree in the Project Workspace

2. Right-click the Connections branch.

3. Choose Update Connections from the context menu. 

This applies a set of rules (page 658) to determine all valid steel
connections in the model. The resulting connections are listed in the
Connections Tree and are also shown by bounding boxes in the Scene
Views.

NOTE If the model has been changed so that new connections exist,
these are not created automatically; you are required to update
connections as required.

Design connections
Design using Tekla Connection Designer is initiated in one of two ways:

1. From the Project Workspace:

• Expand the appropriate branch in the Connections tree

• Right click on the required connection reference and choose Design
connection from the context menu.

2. From a scene view:

• Right click on the connection object and choose Design connection
from the context menu.
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See also

Recommended workflows for specific connection types (page 658)

Limitations when using Tekla Connection Designer with Tekla Structural
Designer (page 660)

Export connections to another application for design (page 661)

Steel connection formation rules
The following rules relate to connection formation in Tekla Structural
Designer.

1. beam to column connection

a. beam connections to the column base are ignored

b. column must be a symmetric section

c. more then 1 beam attached to the same column face prevents any
connection

d. a continuous beam connected to the column flanges prevents any
connection

e. a beam with a fully fixed or moment end condition connected to the
column web prevents any connection

2. beam to beam - for a particular construction point (node)

a. any column at the node prevents the connection

b. only two beam ends can be connected, a 3rd beam at the same node
prevents any connection.

c. connections cannot be formed at beam internal nodes

d. the beams being connected must be symmetric and of the same
section size

e. connected beam ends cannot be free or pinned

f. top flange haunches prevent the connection

g. beam ends being connected must have no end plates specified, or
both have the same end plate

h. beam ends being connected must have no bottom haunch specified,
or both have the same bottom haunch

3. any non-steel member at the node prevents any connection

4. braces are ignored in the procedure

Design models 658 Create and check steel connections



Recommended workflows for specific connection types

NOTE Connection design requires a Tekla Connection Designer licence.

Portal frame connections

Although it is possible to design portal frame connections in Tekla Structural
Designer - i.e. Base Plate, Eaves, and Apex moment connections; it should be
noted that the design forces used for connection design within Tekla
Structural Designer are those from its own elastic analysis and may not be
appropriate.

A more correct approach would be to derive the connection forces from a
Tekla Portal Frame Designer plastic analysis. To do this you would need to
export the portal frame to Tekla Portal Frame Designer and then design both
the frame and its connections within Tekla Portal Frame Designer.

Note that it in addition to the connection forces (usually) being fundamentally
different between Tekla Portal Frame Designer and Tekla Structural Designer
there are other potential differences also:

• for eaves connections - in Tekla Portal Frame Designer the connection
design forces are taken at the column face (rather than the rafter/column
intersection),

• for column bases - in Tekla Portal Frame Designer they can be pinned at
ULS but % fixity can be taken for SLS, while Tekla Structural Designer will
always give an analysis moment for % fixity regardless of ULS/SLS and this
moment would be designed for.

NOTE Connection design via Tekla Portal Frame Designer requires both a Tekla
Portal Frame Designer and a Tekla Connection Designer licence.

Base plate connections (not in portal frames)

Base plate connections can be edited directly in Tekla Structural Designer.

Provided they are in elastically analyzed frames they can be also be designed
using the design forces obtained from Tekla Structural Designer.

NOTE The analysis results used for the connection design follow the selection (1st
order or 2nd order) made on the Analysis page of the Tekla Structural
Designer Design Options.

Base plate connections can be exported to Tekla Connection Designer if you
require, in which case if you edit the connection geometry while in Tekla
Connection Designer you should use the “Return Connection to Tekla
Structural Designer” command (under the “Connection” menu) to return the
edited connection data back to Tekla Structural Designer.

Design models 659 Create and check steel connections



Other connections (not in portal frames)

The recommended workflow for connection types other than Base Plate
Connections is:

• Select the connection(s) to be designed and export to Tekla Connection
Designer always.

• Design in Tekla Connection Designer and print the reports.

• While the “Return Connection to Tekla Structural Designer” command can
be used, this does not currently return all connection data to Tekla
Structural Designer (principally the data derived from the connected
elements). Hence, if changes are made in Tekla Structural Designer and the
analysis and/ or design processes run and the connection exported again
for checking, the engineer should review the connection data and may
need to re-enter some of the settings previously made.

NOTE While the “Return Connection to Tekla Structural Designer” command can be
used In Tekla Connection Designer, this does not currently return all
connection data to Tekla Structural Designer (principally the data derived
from the connected elements). Hence, if changes are made in Tekla Structural
Designer and the analysis and/or design processes are re-run; if the
connection is exported again for checking, the engineer would need to review
the connection data as it may be necessary to re-enter some of the settings
previously made.

See also

Limitations when using Tekla Connection Designer with Tekla Structural
Designer (page 660)

Limitations when using Tekla Connection Designer with Tekla
Structural Designer

General

• The analysis results used for the connection design follow the selection (1st
order or 2nd order) made on the Analysis page of the Tekla Structural
Designer Design Options.

• It is always necessary to export all connection types to Tekla Connection
Designer for reporting purposes.

Base plate connections

• Base Plate Connections only deal with major axis shear - only one value for
shear is available in the Combinations grid in Tekla Connection Designer.
(This is a limitation in the Green Book also.)
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Moment connections

• While the “Return Connection to TSD” command can be used, this does not
currently return all connection data to Tekla Structural Designer (principally
the data derived from the connected elements). Hence, if changes are
made in Tekla Structural Designer and the analysis and/ or design
processes run and the connection exported again for checking, the
engineer should review the connection data and may need to re-enter
some of the settings previously made.

• For Beam to Column moment connections, column forces are exported
and displayed on the "Column" tab of the Combinations page.

• When designed to Eurocodes, there is a reduction factor for column
web in compression to allow for coincident forces in the column itself
i.e. moment and axial force. This is called kwc and in most cases is 1.0
i.e. no reduction. But where the stress due to the column forces is high
(> 0.7 fy) then kwc is < 1.0. See Clause 6.2.6.2 (2).

• These forces are NOT populated by the TCD integration link and must
be entered manually by the engineer.

Simple connections

• It is not currently possible to transfer Simple Connections from Tekla
Structural Designer to Tekla Connection Designer.

Hollow section connections

• It is not currently possible to transfer Simple Connections from Tekla
Structural Designer to Tekla Connection Designer.

Column splice connections

• Splice connections with significant ‘real’ moments (other than eccentricity
moments) cannot currently be transferred from Tekla Structural Designer
to Tekla Connection Designer.

NOTE Significent 'real' moments being greater than the Ignore forces below
(page 1097) limit in Design Settings.

Export connections to another application for design
Click the following links to find out more about exporting specific connections
into another application for design:

• Recommended workflow for TCD connection types (page 658)

• Export to Tekla Connection Designer (page 127)

• Export to Tekla Portal Frame Designer (page 128)
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• Export to IDEA StatiCa Connection Design (page 152)

7.6 Drift, sway, seismic drift, wind drift, and overall
displacements
As part of the static design process the model is automatically checked on a
level by level basis for drift (page 662) (ACI/AISC), or sway (page 667) (other
head codes). Also any seismic load combinations are checked for seismic drift
(page 671) and wind load combinations checked for wind drift (page 675)/
overall wind drift (page 679).

Click the links below to find out more:

• Drift check (page 662)

• Sway check (page 667)

• Seismic drift check (page 671)

• Wind drift check (page 675)

• Overall wind drift check (page 679)

• Overall displacement (page 681)

Drift check
By default, this check is applied to all columns (of all materials) and all walls at
every level in the model.

NOTE The drift check is only relevant to models that use the ACI/AISC head code.

Results are presented in terms of levels, with detailed results for individual
column/wall stacks/panels also being available.

For levels set as floors a Check for drift option is displayed in Level Properties
(page 933). By unselecting this option, individual levels can be excluded from
the check reporting.

In this check the story drift in each direction (i.e. the difference between top
and bottom deflection of the stack) is calculated, and from this the stability
coefficient is determined as follows:

Stability coefficient = Δ2/Δ1

Where

Δ2= second order drift

Δ1= first order drift
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A Warning status is displayed against any stack in which the ratio exceeds 1.71
and a Beyond Scope status is applied if it exceeds 2.85 (as this indicates the
structure lacks stiffness in whole or in part).

NOTE Stability coefficients can only be calculated accurately by performing a second
order analysis, however indicative values can still be displayed when only a
first order analysis has been performed. These are determined from the
column's elastic critical load factor, λ:

(Δ2/Δ1) = 1/(1- 1/λ)

Approximate second order drift:

Δ2= Δ1/(1- 1/λ)

A workflow for running the check is outlined below:

Run the check
Load combinations are automatically checked on a level by level basis for drift
by running a static analysis or design.

Review the check status and details
Once the check has been run, an overall status is reported in the Design
branch of the Status Tree (page 82), the overall status being the worst status
from each of the individual levels.

Right clicking on the status opens a context menu.

From this menu you can display the drift check summary in a Review Data
Table (page 770).
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By unselecting the Summary Only option in the ribbon, the table can also
display detailed results on a stack by stack basis if required.

The checks can be investigated in more detail by clicking the Details button at
the end of any row.

This displays the stability coefficients in both directions (RatioDir1,RatioDir2).
These are calculated as follows:
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Stability coefficient = Δ2/Δ1

Where

Δ2= second order drift

Δ1= first order drift

A Warning status is displayed against any stack in which the ratio exceeds 1.71
and a Beyond Scope status is applied if it exceeds 2.85 (as this indicates the
structure lacks stiffness in whole or in part).

Stability coefficients can only be calculated accurately by performing a second
order analysis, however indicative values can still be displayed when only a
first order analysis has been performed. These are determined from the
column's elastic critical load factor, λ:

(Δ2/Δ1) = 1/(1- 1/λ)

Approximate second order drift:

Δ2= Δ1/(1- 1/λ)

Review the check graphically
From the right click menu in the Status Tree you are also provided with an
option to graphically review the checks in a Show/Alter State View (page 736).
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The color coded legend makes it easy to see individual failing members. By
hovering the cursor over a member, its drift results are displayed in the
tooltip.

From the same Show/Alter State view, by changing the Mode in the Properties
window, you also have the option to switch off checks for specific stacks
(page 736) if you require.

Switching off inappropriate checks and merging stack lengths
After reviewing you might choose to switch off checks for selected columns
and walls, or individual stacks/panels within selected columns and walls: this
can be done directly via the (page 684), or graphically in a Show/Alter State
view (as described in the previous section).

You might also choose to take advantage of the option to merge short stacks
automatically (page 681) where they are less than a specified limit. Stacks
check lengths can also be manually adjusted (page 685) by merging them
together if required.

An option is also provided which allows you to switch off checks for specific
levels (page 685) if you decide they are inappropriate, (for example if the
story height is very short). The checks at that level are still performed, but they
are excluded from the tabular review data display.
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Printing calculations
The drift check results table is available either by creating a Building Analysis &
Drift Checks report (page 841), or by including the Analysis>Drift chapter in a
custom report.

Sway check
By default, this check is applied to all columns (of all materials) and all walls at
every level in the model.

NOTE The sway check is not relevant to models that use the ACI/AISC head code.

Results are presented in terms of levels, with detailed results for individual
column/wall stacks/panels also being available.

For levels set as floors a Check for drift option is displayed in Level Properties
(page 933). By unselecting this option, individual levels can be excluded from
the check reporting.

In this check the story sway in each direction (i.e. the difference between top
and bottom deflection of the stack) is calculated and from this the elastic
critical load factor is determined.

A workflow for running the check is outlined below:

Run the check
Load combinations are automatically checked on a level by level basis for sway
by running a static analysis or design.

Review the check status and details
Once the check has been run, an overall status is reported in the Design
branch of the Status Tree (page 82), the overall status being the worst status
from each of the individual levels.

Right clicking on the status opens a context menu.
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From this menu you can display the sway check summary in a Review Data
Table (page 765).

By unselecting the Summary Only option in the ribbon, the table can also
display detailed results on a stack by stack basis if required.

The individual checks can be investigated in more detail by clicking the Details
button at the end of any row.
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Review the check graphically
From the right click menu in the Status Tree you are also provided with an
option to graphically review the checks in a Show/Alter State View (page 756).
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The color coded legend makes it easy to see any individual failing members.
By hovering the cursor over a member, its sway results are displayed in the
tooltip.

From the same Show/Alter State view, by changing the Mode in the Properties
window, you also have the option to switch off checks for specific stacks
(page 756) if you require.

If required, sway values can also be displayed graphically (page 503) in a
Results View.

Switching off inappropriate checks and merging stack lengths
After reviewing you might choose to switch off checks for selected columns
and walls, or individual stacks/panels within selected columns and walls: this
can be done directly via the (page 683), or graphically in a Show/Alter State
view (as described in the previous section).

You might also choose to take advantage of the option to merge short stacks
automatically (page 681) where they are less than a specified limit. Stacks
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check lengths can also be be manually adjusted (page 685) by merging them
together if required.

An option is also provided which allows you to switch off checks for specific
levels (page 685) if you decide they are inappropriate, (for example if the
story height is very short). The checks at that level are still performed, but they
are excluded from the tabular review data display.

Printing calculations
The sway check results table is available either by creating a Building Analysis
& Drift Checks report (page 841), or by including the Analysis>Sway chapter in
a custom report.

Seismic drift check
By default this check is applied to all columns (of all materials), and all walls at
every level in the model.

Results are presented in terms of levels, with detailed results for individual
column/wall stacks/panels also being available.

For levels set as floors a Check for drift option is displayed in Level Properties
(page 933). By unselecting this option, individual levels can be excluded from
the check reporting.

In this check the seismic stability coefficient θ in each direction is checked
against the limit θmax and then the stack design story drift Δdes is determined
in each direction and checked against the allowable story drift Δa

A workflow for running the check is outlined below:

Configure the check and set the limit
The check is configured on the Localization page of the Seismic Wizard.

An option is provided to override the allowable story drift factor and a second
option allows for the seismic drift check to be skipped entirely if required.

Run the check
Seismic load combinations are automatically checked on a level by level basis
for drift by running an appropriate analysis or design.
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Review the check status and details
Once the check has been run, an overall status is reported in the Design
branch of the Status Tree (page 82), the overall status being the worst status
from each of the individual levels.

Right clicking on the status opens a context menu.

From this menu you can display the seismic drift check summary in a Review
Data Table (page 774), an ASCE example of this table is shown below.

By unselecting the Summary Only option in the ribbon, the table can also
display detailed results on a stack by stack basis if required.
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The individual checks can be investigated in more detail by clicking the Details
button at the end of any row.

Review the check graphically
From the right click menu in the Status Tree you are also provided with an
option to graphically review the checks in a Show/Alter State View (page 752).
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The color coded legend makes it easy to see individual failing members. By
hovering the cursor over a member, its seismic drift results are displayed in
the tooltip.

From the same Show/Alter State view, by changing the Mode in the Properties
window, you also have the option to switch off checks for specific stacks
(page 753) if you require.

Switching off inappropriate checks and merging stack lengths
After reviewing you might choose to switch off checks for selected columns
and walls, or individual stacks/panels within selected columns and walls: this
can be done directly via the (page 684), or graphically in a Show/Alter State
view (as described in the previous section).

You might also choose to take advantage of the option to merge short stacks
automatically (page 681) where they are less than a specified limit. Stacks
check lengths can also be be manually adjusted (page 685) by merging them
together if required.

An option is also provided which allows you to switch off checks for specific
levels (page 685) if you decide they are inappropriate, (for example if the
story height is very short). The checks at that level are still performed, but they
are excluded from the tabular review data display.
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Printing calculations
The seismic drift check results table is available either by creating a Seismic
Design report (page 847), or by including the Analysis>Seismic Drift chapter in
a custom report.

Wind drift check
By default this check is applied to all columns (of all materials), and all walls at
every level in the model.

Results are presented in terms of levels, with detailed results for individual
column/wall stacks/panels also being available.

For levels set as floors a Check for drift option is displayed in Level Properties
(page 933). By unselecting this option, individual levels can be excluded from
the check reporting.

In this check the lateral drift resulting from the analysis is determined for each
wind load combination using the combination SLS (Service Level) factors -
(which can be < 1.0). This is then compared against a user-defined limit.

A workflow for running the check is outlined below:

Configure the check and set the limit
The check is configured from Design Settings.

On the Drift Checks page (if working to the ACI/AISC head code) or Sway &
Drift Checks page (if working to any other head code) you can enter the limit
required.

NOTE By default the limit is set as 1/300 of the story height, in line with Eurocode 3
recommendations.

Individual limits can also be applied as overrides to selected stacks (page 685)
if required.

By default the check is performed in the resultant wind drift direction only, but
by unselecting Check for Resultant Wind Drift it can be performed in each of
Building Directions 1 & 2 if required.

By default the check only considers the effects of the wind loadcase(s) in wind
combinations, but by unselecting Check wind cases only it will consider the
effects of all loadcases in wind combinations (which would include drift
induced by gravity loads).
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Run the check
Wind load combinations are automatically checked on a level by level basis for
wind drift during the structure static design, and also when any 3D analysis is
run in isolation. If a sub-set of combinations are considered for analysis then
only those combinations are considered in the wind drift checks, (allowing
engineers working on larger structures to investigate and optimize the lateral
load resisting systems more rapidly).

Review the check status and details
Once the check has been run, an overall status is reported in the Design
branch of the Status Tree (page 82), the overall status being the worst status
from each of the individual levels.

Right clicking on the status opens a context menu.

From this menu you can display the wind drift check summary in a Review
Data Table (page 778), an example of this table for a Eurocode model is
shown below.
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By unselecting the above Summary Only option in the ribbon, the table can
also display detailed results on a stack by stack basis if required.

The individual checks can be investigated in more detail by clicking the Details
button at the end of any row.
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Review the check graphically
From the right click menu in the Status Tree you are also provided with an
option to graphically review the checks in a Show/Alter State View (page 760).
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This color coded legend makes it easy to see individual failing members. By
hovering the cursor over a member, its wind drift results are displayed in the
tooltip.

From the same Show/Alter State view, by changing the Mode in the Properties
window, you also have options to switch off checks (page 761), or set a
different drift limit (page 761) for specific stacks if you require.

Switching off inappropriate checks and merging stack lengths
After reviewing you might choose to switch off checks for selected columns
and walls, or individual stacks/panels within selected columns and walls: this
can be done directly via the (page 684), or graphically in a Show/Alter State
view (as described in the previous section).

You might also choose to take advantage of the option to merge short stacks
automatically (page 681) where they are less than a specified limit. Stacks
check lengths can also be be manually adjusted (page 685) by merging them
together if required.

An option is also provided which allows you to switch off checks for specific
levels (page 685) if you decide they are inappropriate, (for example if the
story height is very short). The checks at that level are still performed, but they
are excluded from the tabular review data display.

Printing calculations
The wind drift check results table is available either by creating a Building
Analysis & Drift Checks report (page 841), or by including the Analysis>Wind
Drift chapter in a custom report.

NOTE The Wind Drift chapter has a Settings option that can be used to dramatically
reduce the number of report pages. By default all columns and walls are
output, but you can specify instead the most critical 'XX' columns and walls,
(where 'XX' is a number of your choice).

The same Settings option also allows you to choose between reporting only
the critical stack/all stacks, and reporting only the critical combination/all
combinations.

Overall wind drift check
When activated, by default this check considers all columns (of all materials),
and all walls at every level in the model.

In this check the overall wind drift ratio, (H / Δmax) is compared against a user
defined limit.

For levels set as floors a Check for drift option is displayed in Level Properties
(page 933). This is used in the above calculation as follows:
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H  = Distance between the
highest and lowest levels
with Check for drift
selected.

Δmax  = Maximum lateral
deflection at the highest
level with Check for
drift selected.

By default the Δmax is calculated in the resultant wind drift direction only:

Δmax = Δmax,Resultant

By unselecting in Design Settings (page 682) it is calculated as follows:

Δmax = max [Δmax, Dir1, Δmax, Dir2]

A workflow for running the check is outlined below:

Configure the check and set the limit
The check is activated from Design Settings.

On the Drift Checks page (if working to the ACI/AISC head code) or Sway &
Drift Checks page (if working to any other head code), select Check for
Overall Wind Drift and then enter the limit required.

NOTE By default the check is activated for new models with the limit set as 500.

By default the check is performed in the resultant wind drift direction only, but
by unselecting Check for Resultant Wind Drift it can be performed in each of
Building Directions 1 & 2 if required.

By default the check only considers the effects of the wind loadcase(s) in wind
combinations, but by unselecting Check wind cases only it will consider the
effects of all loadcases in wind combinations (which would include drift
induced by gravity loads).

Run the check
Provided the check has been activated, wind load combinations are
automatically checked for overall wind drift during the structure static design,
and also when any 3D analysis is run in isolation. If a sub-set of combinations
are considered for analysis then only those combinations are checked,
(allowing engineers working on larger structures to investigate and optimize
the lateral load resisting systems more rapidly).

In performing the checks, the maximum lateral deflection (Δmax) associated
with the highest level of active check for drift is determined for each
combination using the combination SLS (Service Level) factors - (which can be
< 1.0). The ratio of H / Δmax is then compared against a user-defined limit.
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Review the check status and details
Once the check has been run, an Overall Wind Drift status is reported in the
Design branch of the Status Tree (page 82). Beneath the status the node with
maximum wind drift deflection value and its associated combination are listed.

Right clicking on the value opens a context menu, from which you can choose
Highlight Node to see where the maximum occurs in a solver view.

You can also choose Details... to open a dialog which shows the results of the
check.

Overall displacement
By expanding the Design branch of the Status Tree (page 82), you are able to
review the maximum positive and negative overall displacement results from
the 3D Analysis for both Strength and Service combinations.

Displacements can also be viewed graphically in the Results View by using the
buttons on the Deflections group.

Common tasks for sway and drift checks
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Automatically merge short stacks
Columns are divided into stacks and walls are divided into panels at floor
levels where members or slabs connect to the column/wall. For the purposes
of sway/drift, wind drift and seismic drift checks only, you can override the
default stack/panel divisions by merging a stack/panel with a lower stack/
panel. The length of the combined stack/panel is then used in the checks.

A setting is provided in Design Settings to automatically do this when stacks
are less than a given length.

• With the setting off, the check considers all stacks of all columns/walls
apart from those that have been manually excluded.

• With the setting on, any stacks that are less than the limit specified are
merged with the stack below, and the check is performed on the merged
stack length. The check is not performed on single stack columns/walls that
are less than this limit .

To turn the setting on:

1. On the Design ribbon, click Settings.

2. On the left hand side of the Design Settings dialog, click:

• Drift Checks (if working to the ACI/AISC head code)

• Sway & Drift Checks (if working to any other head code)

3. Select Merge short stacks.

4. Enter the minimum stack length, (below which the stack will be merged
with the next adjacent stack).

5. Click OK

Set the wind drift limit

1. On the Design ribbon, click Settings.

2. On the left hand side of the Design Settings dialog, click:

• Drift Checks (if working to the ACI/AISC head code)

• Sway & Drift Checks (if working to any other head code)

3. Enter the Wind Drift Limit required.

4. Click OK

The limit is applied to all columns and walls, but can be overridden if required
for specific members via in the member properties.
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Choose resultant or directional wind drift checks

1. On the Design ribbon, click Settings.

2. On the left hand side of the Design Settings dialog, click:

• Drift Checks (if working to the ACI/AISC head code)

• Sway & Drift Checks (if working to any other head code)

3. Select or unselect Check for Resultant Wind Drift.

• Selected - the wind drift limit is checked against the resultant wind drift

• Unselected - two checks are performed, one each for Building
Directions 1 & 2.

4. Click OK

Consider wind cases only for the wind drift check
A Check wind cases only design setting (default on) is provided which applies
to the check as follows:

• With the setting on, the Wind Drift check only considers the effects of the
wind loadcase(s) in wind combinations.

• With the setting off, the check considers the effects of all loadcases in wind
combinations (which would include drift induced by gravity loads).

1. On the Design ribbon, click Settings.

2. On the left hand side of the Design Settings dialog, click:

• Drift Checks (if working to the ACI/AISC head code)

• Sway & Drift Checks (if working to any other head code)

3. Select or unselect Check wind cases only as required.

4. Click OK

Switch off sway checks for selected columns/walls
Selected column stacks or wall panels can be excluded from the sway check as
follows:

1. Select the desired column(s) or wall(s). 

The column or wall properties are displayed in the Properties window.

2. Expand the appropriate Sway & Drift Checks heading:

• under All stacks, All Panels - to exclude the entire column/wall

• under the required Stack or Panel - to exclude a specific stack/panel

3. Unselect Sway/Seismic drift checks
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Switch off drift checks for selected columns/walls
Selected column stacks or wall panels can be excluded from the drift check as
follows:

1. Select the desired column(s) or wall(s). 

The column or wall properties are displayed in the Properties window.

2. Expand the appropriate Drift Checks heading:

• under All stacks, All Panels - to exclude the entire column/wall

• under the required Stack or Panel - to exclude a specific stack/panel

3. Unselect Drift/Seismic drift checks and consider for seismic torsion

Switch off seismic drift checks for selected columns/walls
Selected column stacks or wall panels can be excluded from the seismic drift
check as follows:

1. Select the desired column(s) or wall(s). 

The column or wall properties are displayed in the Properties window.

2. Expand the appropriate Sway & Drift Checks* heading:

• under All stacks, All Panels - to exclude the entire column/wall

• under the required Stack or Panel - to exclude a specific stack/panel

3. Unselect:

• Drift/Seismic drift checks and consider for seismic torsion (if
working to the ACI/AISC head code)

• Sway/Seismic drift checks (if working to any other head code)

NOTE *If working to the ACI/AISC head code this heading is shortened
to Drift Checks

Switch off wind drift checks for selected columns/walls
Selected column stacks or wall panels can be excluded from the wind drift
check as follows:

1. Select the desired column(s) or wall(s). 

The column or wall properties are displayed in the Properties window.

2. Expand the appropriate Sway & Drift Checks* heading:

• under All stacks, All Panels - to exclude the entire column/wall

• under the required Stack or Panel - to exclude a specific stack/panel
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3. Unselect Wind drift check 

NOTE *If working to the ACI/AISC head code this heading is shortened
to Drift Checks

Switch off tabular results for an entire level
The sway/drift, seismic drift and wind drift check results for all column stacks
and wall panels at a specific level can be excluded from the tabular review
data as follows:

1. Go to the Project Workspace.

2. In the Structure tree, expand Levels then select the level at which
you want the tabular results to be switched off.

3. In the Properties window, unselect the Check for drift option.

Override the wind drift limit for selected columns/walls
The wind drift limit specified in Design Settings can be overridden for selected
column stacks or wall panels as follows;

1. Select the desired column(s) or wall(s). 

The column or wall properties are displayed in the Properties window.

2. Expand the appropriate Sway & Drift Checks* heading:

• under All stacks, All Panels - to override the entire column/wall

• under the required Stack or Panel - to override a specific stack/panel

3. Select Override Wind Drift Limit

4. Enter the required Wind drift ratio limit. 

NOTE *If working to the ACI/AISC head code this heading is shortened
to Drift Checks

Adjust column stack or wall panel check lengths
Columns are divided into stacks and walls are divided into panels at floor
levels where members or slabs connect to the column/wall. For the purposes
of sway/drift, wind drift and seismic drift checks only you can override the
default stack/panel divisions by merging a stack/panel with a lower stack/
panel. The length of the combined stack/panel is then used in the checks.

To do this manually proceed as follows:
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1. Select the desired column(s) or wall(s). 

The column or wall properties are displayed in the Properties window.

2. Under the required Stack or Panel group, unselect the following setting:

• Drift Checks > Merge with stack below (if working to the ACI/AISC
head code)

• Sway & Drift Checks > Merge with stack below (if working to any
other head code)

Considerations for non-linear models with Tension Only bracing
For non-linear models with Tension Only bracing it is essential that the 'X
Brace' pattern is used to input the braces as brace pairs rather than creating
them individually. For linear analysis one of the braces in a brace pair is
automatically inactivated, ensuring that the model's lateral stiffness, and
hence lateral drift, is reasonably correct. If braces are input individually this
will not be the case.

Perform checks
The checks are performed either by running Analyze All (Static) from the
Analyze ribbon, or by running any of the Design (Static) commands from the
Design ribbon.

Review tabular results in a Data Table
Tabular results can either be reported in summary, or in detail.

• Summary - the column/wall with most critical result from all combinations
is reported for each direction at each level

• Detailed - the critical result in each direction at each level is reported for all
columns/walls

The results can also be filtered by material type, characteristic and fabrication
as required.

To access the tabular results from the Project Workspace Status Tree proceed
as follows:

1. Expand the Design branch of the Project Workspace Status Tree.

2. Right-click on the required check.

3. Select Review Data Table

Design models 686 Drift, sway, seismic drift, wind drift, and overall
displacements



For further information, see:

• Review drift check tabular results (page 770)

• Review sway check tabular results (page 765)

• Review seismic drift check tabular results (page 773)

• Review wind drift check tabular results (page 777)

Review results graphically in a Show / Alter State view
To access the graphical results from the Project Workspace Status Tree
proceed as follows:

1. Expand the Design branch of the Project Workspace Status Tree.

2. Right-click on the required check.

3. Select Show / Alter View

For further information, see:

• Review and modify sway checks (page 756)

• Review and modify drift checks (page 736)

• Review and modify seismic drift (page 752)

• Review and modify wind drift checks (page 760)

Create a report
Each of the results tables can be included in printed output by adding the
Drift, Sway, Seismic Drift and Wind Drift chapters from the Analysis branch
into your model report.
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8 Create and design foundations

You can create and design both isolated and mat foundations using the
Foundations toolbar.

8.1 Create isolated foundations
Tekla Structural Designer allows you to create pad base, strip base and pile
cap isolated foundations. Before you can create a pile cap the Pile Catalogue
must contain at least one pile type.

Click the links below to find out more:

• Create pad bases and strip bases (page 688)

• Create a pile type catalogue (page 690)

• Create pile caps (page 690)

See also

Design isolated foundations (page 692)

Create pad bases and strip bases
You can create both pad base columns and strip base walls in your model. Pad
bases and strip bases are both isolated foundations. The difference is that pad
bases support a column, while strip bases support a wall.

Create pad base columns
A pad base is an isolated foundation that supports a single column. To place
pad bases in your model, see the following instructions.

Create a pad base under a specific column

1. On the Foundations tab, click  Pad Base Column.
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2. In the Properties window, adjust the pad base properties according to
your needs.

3. Click anywhere in the wall under which you want to place the pad base. 

Tekla Structural Designer places a pad base under the selected column.

Create multiple pad base columns

1. On the Foundations tab, click  Pad Base Column.

2. In the Properties window, adjust the pad base properties according to
your needs.

3. Move the mouse pointer to a corner of an imaginary box that will
encompass the columns under which you want to place pad bases.

4. Hold down the left mouse button.

5. Drag the mouse pointer to the opposite corner of the box.

6. Release the mouse button. 

Tekla Structural Designer places pad bases under all columns within the
box.

Create strip base walls
A strip base is an isolated foundation that supports a single wall. To place strip
bases in your model, see the following instructions.

Create a strip base under a specific wall

1. On the Foundations tab, click  Strip Base Wall.

2. In the Properties window, adjust the strip base properties according to
your needs.

3. Click anywhere in the wall under which you want to place the strip base. 

Tekla Structural Designer places a strip base under the selected wall.

Create multiple strip bases

1. On the Foundations tab, click  Strip Base Wall.

2. In the Properties window, adjust the strip base properties according to
your needs.

3. Move the mouse pointer to a corner of an imaginary box that will
encompass the walls under which you want to place strip bases.

4. Hold down the left mouse button.
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5. Drag the mouse pointer to the opposite corner of the box.

6. Release the mouse button. 

Tekla Structural Designer places strip bases under all walls within the box.

Create a pile type catalogue
In order to use pile foundations in your model, you must create a catalogue of
pile types. To do so, see the following instructions.

1. On the Foundations tab, click  Catalogue. 

The Pile Catalogue opens.

2. To create a new pile type, click Add... 

The Edit Pile Type dialog box opens.

3. On the different pages of the Edit Pile Type dialog box, define the
properties of the new pile type.

4. Click OK. 

Tekla Structural Designer creates the pile type.

5. Repeat steps 2–4 as necessary. 

TIP In the Pile Catalogue, you can also modify or delete the existing pile
types:

• To modify a pile type, select the pile type and click Edit...

• To delete a pile type, select the pile and click Delete.

Create pile caps
A pile cap is an isolated piled foundation that supports a single column.

NOTE Before you can create pile caps, the Pile Catalogue must contain at least one
pile type.

To create pile types, see Create a pile type catalogue (page 690).

Create pile cap under a specific column

1. On the Foundations tab, click  Pile Cap Column.

2. In the Properties window, adjust the pile cap properties according to your
needs.
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3. Click anywhere in the column under which you want to place the pile cap. 

Tekla Structural Designer places a pile cap under the selected column.

Create multiple pile caps

1. On the Foundations tab, click  Pile Cap Column.

2. In the Properties window, adjust the pile cap properties according to your
needs.

3. Move the mouse pointer to a corner of an imaginary box that will
encompass the columns under which you want to place pile caps.

4. Hold down the left mouse button.

5. Drag the mouse pointer to the opposite corner of the box.

6. Release the mouse button. 

Tekla Structural Designer places pile caps under all columns within the
box.

Create a user-defined pile arrangement
If necessary, you can modify the pile arrangement in a pile cap and create
user-defined pile arrangements. Creating user-defined pile arrangements can
be particularly useful when you want to check a pile cap where the pile
positions on site do not exactly match the originally specified arrangement.

Do the following:

1. In the model, select the pile cap that you want to modify.

2. In the Properties window, go to Pile arrangement.

3. Click the ... button next to Pile arrangement. 

The Pile Arrangement dialog box opens.

4. In the Pile Arrangement dialog box, select the User Defined
Arrangement option. 

NOTE If the Auto-design piles option is selected in the Properties
window, Tekla Structural Designer asks you whether you want to
turn off the option. Click Yes.

5. Specify the pile arrangement properties according to your needs:

a. Select the pile type.

b. Define the pile length and width.

c. If necessary, define the eccentricity of the pile cap centroid from the
centroid of the column it supports in X and Y directions.
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TIP To add more piles into the arrangement, click Add.

6. If necessary, in the table below the properties, adjust the position of piles
by defining the eccentricity of the pile centroid from the pile cap centroid.

7. Click OK. 

Tekla Structural Designer creates the pale arrangement that you defined.

8.2 Design isolated foundations
You can design isolated foundations (pad bases, strip bases, and pile caps)
either in a batch or individually.

NOTE Before bases or pile caps can be designed, you have to run an analysis
to establish the design forces. You can run either the Analyze All
(Static) command or one of the combined analysis and design
commands (such as Design All).

Design or check all pad bases and strip bases

1. On the Foundations tab, click  Design Pad Bases. 

Tekla Structural Designer designs or checks all pad bases and strip bases
in the model according to their individual auto-design settings. In the
process, Tekla Structural Designer considers all active static and RSA
combinations .

Design or check all pile caps

1. On the Foundations tab, click  Design Pile Caps. 

Tekla Structural Designer designs or checks all pile caps in the model
according to their individual auto-design settings. In the process, Tekla
Structural Designer considers all active static and RSA combinations .

Check an individual isolated foundation
1. Hover the mouse pointer over the foundation that you want to check. 

The Select Entity tooltip appears.
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2. In the Select Entity tooltip, navigate to the foundation name by using the
arrow keys.

3. Right-click the foundation.

4. In the context menu, select  Check Member. Tekla Structural Designer
displays the results of the check in a new dialog box.

Design an individual isolated foundation
1. Hover the mouse pointer over the foundation that you want to design. 

The Select Entity tooltip appears.

2. In the Select Entity tooltip, navigate to the foundation name by using the
arrow keys.

3. Right-click the foundation.

4. In the context menu, select Design Member. Tekla Structural Designer
displays the results of the design in a new dialog box.

See also

Apply user defined utilization ratios (page 613)

8.3 Create mat foundations
Mat foundations support multiple columns and walls. Mats can be ground
bearing, supported on piles, or both. Tekla Structural Designer contains he
following commands for creating mat foundations:

• Minimum Area: creates an overhanging polygonal mat to minimize the
required area

• Rectangular: creates an overhanging rectangular mat either at a specified
angle to the global axes or at the smallest rectangular area aligned to the
global axes

• Strip: creates a constant width mat along a series of points that do not
have to be on the same line

• Area: creates an overhanging polygonal mat when you identify points
around its outline

• Bays: creates a mat with no overhang when you click within a closed grid
area

• Pile: creates individual piles underneath existing mats

• Pile Array: creates an array of piles underneath existing mats

Create and design foundations 693 Create mat foundations



Click the links below to find out more:

• Create mats (page 694)

• Place piles and pile arrays in mats (page 695)

See also

Create slab or mat openings (page 265)

Add overhangs to existing slab or mat edges (page 267)

Create column drops (page 270)

Split and join slabs and mats (page 273)

Design isolated foundations (page 692)

Create mats
In Tekla Structural Designer, you can create various types of mat foundations,
including minimum area mats, rectangular mats, strip mats, area mats, and
mats with bays. For detailed information on creating mats, see the following
instructions.

Create a minimum area or rectangular mat

1. On the Foundations tab, click either  Minimum Area or 
Rectangular.

2. In the Properties window, adjust the mat properties according to your
needs.

3. Do one of the following:

To Do this
Create a mat in a 3D view a. Click anywhere on the first column or wall

to be supported.

b. Click to define the other necessary
columns and walls.

c. To create the mat, click the last column or
wall again or press Enter.

Create a mat in a 2D view a. Do one of the following:

1. To select multiple walls, hold down
the left mouse button and drag a
box from right to left to encompass
the walls under which you want to
create the mat.

2. To select multiple columns, hold
down the left mouse button and
drag a box from left to right to
encompass the columns under
which you want to create the mat.
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3. To add individual columns and walls,
click each member individually.

b. To create the mat, click one of the
previously selected members or press
Enter.

Create a strip mat
1. Open a 2D view at the base level where you want to place the strip mat.

2. On the Foundations tab, click  Strip.

3. In the Properties window, adjust the strip width and other mat properties
according to your needs.

4. In the model, click the start point of the strip.

5. Click to define the other necessary points.

6. To create the strip, click the last point again or press Enter.

Create an area mat
Either click once again on the last point, or press <Enter> to create the mat.

1. On the Foundations tab, click  Area.

2. In the Properties window, adjust the mat properties according to your
needs.

3. In the model, click a construction point at a corner of the area.

4. Click to define the remaining corner points.

5. To create the mat, click the last point again or press Enter.

Create a mat within bays
1. On the Foundations tab, click Bays.

2. In the Properties window, adjust the mat properties according to your
needs.

3. To select a bay, do one of the following:

• Click within an enclosed area defined by grid lines.

• Hold down the left mouse button and drag a box around the required
area.
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Place piles and pile arrays in mats
A piled mat can either be supported on piles alone, or by a combination of
ground springs and piles. Piles can either be placed individually at specific
locations within the mat, or an array of equally spaced piles can be created. To
place piles in mats and define their inclination, see the following instructions.

Specify if a piled mat is ground bearing
1. Click the desired mat.

2. In the Properties window, go to Soil Parameters.

3. Do one of the following:

To Description
Create a mat supported on piles alone • Clear the Use Ground Bearing Springs

option.

Create a mat supported by a combination of
ground spring and piles

• Ensure that the Use Ground Bearing
Springs option is selected.

Place an individual pile in a mat

1. On the Foundations tab, click  Pile.

2. Click the mat in which you want to place the pile.

3. Click the pile position in the selected mat. 

Tekla Structural Designer places the pile in the selected position.

Place a pile array in a mat

1. On the Foundations tab, click  Pile Array.

2. In the Properties window, adjust the pile type, spacing, and pile direction
according to your needs. 

TIP To preview the array, hover the mouse pointer over a mat.

3. Click an individual mat, or hold down the left mouse button and drag a
box around multiple mats.

4. If necessary, add further mats to the selection by clicking or boxing them.

5. To create the mat, click the last mat you selected again. 

Tekla Structural Designer places the piles in the mat.

6. Repeat steps 2–4 to place more piles or press Esc to finish placing piles.
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Specify the pile direction of an inclined pile

1. On the Foundations tab, click  Pile.

2. In the Properties window, do one of the following:

To Do this
Specify the direction as a vector a. Adjust the X and Y components of the

vector.

TIP If you do not want the pile to slope
in the global X or Y direction, leave
the appropriate value as 0.

b. Type a negative value in the Z component
field.

For example:

To create an inclined pile of 45 degrees in
positive X, define the components as follows: X =
1.0, Y = 0.0, Z = -1.0.

To create an inclined pile of 45 degrees in
negative Y, define the components as follows: X
= 0.0, Y = 0.5, Z = -1.0

Specify the direction as an angular measurement
NOTE You can only specify the direction as an

angular measurement before the pile is
first positioned.

a. Select the Direction by Angles option.

b. Define the inclination of the pile from the
vertical.

c. Define the azimuth (the horizontal angle
measured clocwise about the positive
global Z direction.

d. If necessary, define the rotation about the
longitudinal axis of the pile.

NOTE Since the pile is only checked for
axial capacity, the rotation angle
has no effect on the pile checks.
However, you can define the
rotation to vary how Tekla
Structural Designer displays the
moment and shear force values
of the pile.

For example:

To create an inclined pile of 45 degrees in
positive X, define the angles as follows:
inclination = 45 degrees, azimuth = 90
degrees

To create an inclined pile of 30 degrees in
negative Y, define the angles as follows:
inclination = 30 degrees, azimuth =
0.0 degrees
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8.4 Design mat foundations

Design or check all mats in the model

1. On the Foundations tab, click  Design Mats. 

Tekla Structural Designer designs or checks all mats in the model
according to their auto design settings.

Check all mats in a single floor
1. Open a 2D view of the floor that you want to design.

2. Right-click anywhere in the scene view.

3. In the context menu, select  Check Slabs. 

Tekla Structural Designer checks all slab items (including mat foundations)
in the floor regardless of their autodesign settings.

Design all mats in a single floor
1. Open a 2D view of the floor that you want to design.

2. Right-click anywhere in the scene view.

3. In the context menu, select Design Slabs. Tekla Structural Designer
designs all slab items (including mat foundations) in the floor regardless
of their autodesign settings.

Check an individual mat
1. Hover the mouse pointer over the mat that you want to check.

2. Right-click the mat.

3. In the context menu that appears, select  Check Panel. 

Tekla Structural Designer displays the results of the check in a new dialog
box.

Design an individual mat

1. Hover the mouse pointer over the mat that you want to design.
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2. Right-click the mat.

3. In the context menu that appears, select Design Member. 

Tekla Structural Designer displays the results of the design in a new dialog
box.

See also

Apply user defined utilization ratios (page 613)
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9 Review models

By selecting the Review view regime, you are able to graphically display the
design status of members, slabs, foundations and connections. In the same
view you can interrogate or modify a variety of model parameters and
properties.

In addition, by clicking  Tabular Data from the toolbar, you can open a
Review Data view, from where you can display tables of Sway/Drift Results,
Design Summaries and Material Lists.

TIP The Review view opens automatically at the end of the structure design process,

but you can access it at any time by clicking the  icon in the Status bar

9.1 Review designs
By graphically reviewing the design status and ratios you are able to quickly
assess the design efficiency.

Click the links below to find out more:

• Set the design type to review (page 700)

• Review member design (page 701)

• Review foundation and pile design (page 702)

• Review slab and mat design (page 703)

• Design review filters (page 705)
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Set the design type to review
You can set a specific design type to focus on when reviewing the member,
foundation, or slab designs.

The available design type options are Static, RSA, and Combined (i.e. Static and
RSA together).

To set the design type, do the following:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, in the Type list, select the desired design type.

• Static

• RSA

• Combined

See also

Review member design (page 701)

Review foundation and pile design (page 702)

Review slab and mat design (page 703)

Design review filters (page 705)

Review member design

Review member design status
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, in the Design group, click Status. 

Color codes display the design status of each member.

Tekla Structural Designer uses the following classifications:

Status Description
Pass The member has passed all design

checks.
Fail The member has failed one or more

design checks.
Warning Although the member has passed the

design checks, one or more warnings
have been issued. Review the
warnings before deciding if you need
to take further action.
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Status Description
Error The member currently cannot be

designed because an error has
occurred.

Beyond Scope The member cannot be designed
because its design is beyond the
scope of Tekla Structural Designer.

Unknown The member has not been designed.

Review member design ratios
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, in the Design group, click Ratio. 

Color codes display the design ratio of each member. N/A is assigned to
members that have no ratio or whose ration is smaller than the lowest
band. N/A also indicates members that either are beyond scope or have
yet to be designed.

Review member depth ratios
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, in the Design group, click Depth Ratio. 

All steel and concrete beams are color coded to indicate their span to
depth utilization ratios.

See also

Design review filters (page 705)

Review design summary tabular results (page 763)

Review foundation and pile design

Review foundation or pile status
1. Open a view and change the view regime (page 89) to Review View.

2. Go to the Review ribbon.

3. Either in the Foundations group or the Piles group, click Status. 

Color codes display the design status of each foundation or pile.

Tekla Structural Designer uses the following classifications:
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Status Description
Pass The foundation or pile has passed all

design checks.
Fail The foundation or pile has failed one

or more design checks.
Warning Although the foundation or pile has

passed the design checks, one or
more warnings have been issued.
Review the warnings before deciding
if you need to take further action.

Error The foundation or pile currently
cannot be designed because an error
has occurred.

Beyond Scope The foundation or pile cannot be
designed because its design is
beyond the scope of Tekla Structural
Designer.

Unknown The foundation or pile has not been
designed.

Review foundation or pile ratios
1. Open a view and change the view regime (page 89) to Review View.

2. Go to the Review ribbon.

3. Either in the Foundations group or the Piles group, click Ratio. 

Color codes display the design ratio of each foundation or pile. N/A is
assigned to members that have no ratio or whose ration is smaller than
the lowest band. N/A also indicates foundations and piles that are either
beyond scope or have yet to be designed.

See also

Design review filters (page 705)

Review design summary tabular results (page 763)

Review slab and mat design

Review slab and mat design status
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, in the Slab/Mat Design group, click Status. 
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Color codes display the design status of each slab and mat.

Tekla Structural Designer uses the following classifications:

Status Description
Pass The slab item has passed all design

checks.
Fail The slab item has failed one or more

design checks.
Warning Although the slab item has passed

the design checks, one or more
warnings have been issued. Review
the warnings before deciding if you
need to take further action.

Error The slab item currently cannot be
designed because an error has
occurred.

Beyond Scope The slab item cannot be designed
because its design is beyond the
scope of Tekla Structural Designer.

Unknown The slab item has not been designed.

Review slab and mat design ratios
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, in the Slab/Mat Design group, click Ratio. 

Color codes display the design ratio of each slab item. N/A is assigned to
members that have no ratio or whose ration is smaller than the lowest
band. N/A also indicates slab items that are either beyond scope or have
yet to be designed.

Filter slab and mat design information
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, click the list in the Slab/Mat Design group.

3. In the list that appears, select one of the following filtering options
according to your needs: 

Filter Description
Overall The governing Top X, Top Y, Bottom X,

Bottom Y, or span depth result is
displayed.

Reinforcement The governing Top X, Top Y, Bottom X,
or Bottom Y result is displayed.
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Filter Description
Top X The result is only displayed for top

reinforcement in the X direction.
Top Y The result is only displayed for top

reinforcement in the Y direction.
Bottom X The result is only displayed for

bottom reinforcement in the X
direction.

Bottom Y The result is only displayed for
bottom reinforcement in the Y
direction.

Span Depth The span to depth result is displayed.
Bearing Pressure The bearing pressure result is

displayed.

See also

Design review filters (page 705)

Review design summary tabular results (page 763)

Design review filters
Design review filters help the user to focus on specific results.

The filters are displayed in the Properties window when Status or Ratio are
selected from any group on the Review ribbon.

The following filter types are available and can be used individually or in
combination:

• Status filter

• Utilization ratio filter

• Entity type filter

TIP These filters can be particularly useful when working with large models.

Working with the Status filter
The Status filter is always active in the Properties window when Status is
selected from the Review ribbon.
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All entities are assigned a design status from the below list:

• Pass - The entity has passed all design checks.

• Warning - Although the entity has passed the design checks, one or more
warnings have been issued. Review the warnings before deciding if you
need to take further action.

• Fail - The entity has failed one or more design checks.

• Error - The entity currently cannot be designed because an error has
occurred.

• Beyond Scope - The entity cannot be designed because its design is
beyond the scope of Tekla Structural Designer.

• Unknown - The entity has not been designed.

In the above model the legend indicates that two members are failing and
another has a warning but their locations are not immediately apparent.
Deselecting a status in the Properties window causes entities of that status to
be hidden in the Review View, so in this instance deselecting the Pass status
helps to focus on where the problems are occurring.
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By also selecting Ghost excluded the filtered results can be displayed in
relation to the rest of the model.

Review models 707 Review designs



If required, you can also apply the Status filter when investigating ratios. This
is achieved as follows:

1. From the Review ribbon select Ratio

2. Select Manual filters in the Properties window.

The Status filter group is displayed.

3. Select Active and choose the statuses by which to filter the display of
ratios.

The result is that ratios are then only displayed for those members in the
chosen Status filter categories.
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Working with the Utilization ratio filter
All entities that have been designed are assigned a utilization ratio. The
Utilization ratio filter allows you to display only those entities within a given
utilization range.

This filter is always active in the Properties window when Ratio is selected
from the Review ribbon.
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Initially entities with any ratio are displayed, but by selecting upper and/or
lower limits, entities outside the defined range are hidden in the Review View.
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By selecting Ghost excluded the filtered results can be displayed in relation to
the rest of the model.

Review models 711 Review designs



If required, you can also apply the Utilization ratio filter when investigating
statuses. This is achieved as follows:

1. From the Review ribbon select Status

2. Select Manual filters in the Properties window.

The Utilization ratio filter group is displayed.

3. Select Active and set the upper and/or lower limits by which to filter the
display.

The result is that statuses are then only displayed for those members
within the specified utilization ratio limits.
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Working with the Entity type filter
Unless they have been unselected in Scene Content, all relevant entity types
are initially displayed when either Status or Ratio are selected from the
Review ribbon.

You can use the Entity type filter to focus on specific types only, it is made
active as follows:

1. Select Manual filters in the Properties window

The Entity type filter group is displayed.

2. Select Active

A list of designable entity types is displayed in the Properties window.

Deselecting an entity type from the list causes entities of that type to either be
hidden in the Review View, or displayed as ghosted if Ghost excluded is
selected.

NOTE Clicking 'All' toggles between all entity types being selected, or
unselected.

Example:
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The below view shows slab status at a particular level. Initially, the Entity type
filter is not active and as a result the slab, slab patch, and punching check
statuses are all displayed making interpretation difficult. Note that a Fail is
reported, but it is not immediately apparent where it is.

By activating the Entity type filter you can investigate the status for specific
entity types. The below view is filtered for patches only, which are all passing.

Review models 714 Review designs



The below view is filtered for punching checks only and clearly reveals where
the Fail occurs.
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9.2 Review model properties (show/alter state)
The Show/Alter State group of commands on the Review toolbar allow you
to graphically review and modify various model properties. For each of the
commands, entities are color coded in accordance with a legend, and the
entity color changes to reflect any changes as they are made.

Many of the commands can only be accessed by selecting an appropriate
attribute in the Properties window after first clicking Show/Alter State
(page 725) on the toolbar, while some of the commands can only be accessed
directly from the toolbar.

The Show/Alter State commands accessed directly from the toolbar are as
follows:

• Embodied Carbon - which is used to:

• graphically review and override the carbon factors (page 734) applied
to the model,

• and focus in on high carbon usage and inefficiency (page 758)

• Auto/Check Design (page 717) - to graphically review or modify
autodesign settings of a member or slab

• Diaphragm On/Off - to graphically review or modify diaphragm settings
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• Fixed/Pinned (page 719) - to graphically review or modify member end
fixities

• BIM Status (page 720) - to graphically assess the BIM Status, and also to
exclude members and panels from the import/export process

• Slab / Foundation Reinforcement - to graphically review and edit or
rationalize panel, patch or foundation reinforcement

• Section/Material Grade (page 722) - to graphically copy section sizes, or,
(by changing the Attribute), material grades (page 722)

• Copy Properties (page 723) - to copy a specified element parameter (such
as web openings, shear connectors, or transverse reinforcement) from a
source member to valid target members.

• Report Filter (page 723) - to graphically review and modify report filters

• Sub Structures (page 724) - to graphically review and modify sub
structures

• Concrete Beam Flanges (page 724) - to graphically set whether flange are
considered

• Column Splices (page 725) - to graphically review and modify splice
positions within steel columns.

• Property Sets - to graphically review or apply property sets to members,
slab items and roof panels.

• UDA - to graphically review and modify the values of user defined
attributes that have been attached to the model.

• Show/Alter State (page 725) - to review and modify various model
properties

Modify autodesign settings
You can graphically modify autodesign settings of members and slabs from a
Review View.

To modify the autodesign settings of a member or slab, do the following:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, either:

a. Click Auto/Check Design, or,

b. Click Show/Alter State and choose Autodesign from the Attribute
list.

Members and slabs are color coded according to their auto design setting.

3. In the Properties window, select the appropriate mode.

4. Do one of the following:
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• Click an individual entity to modify its auto design setting.

• Hold down the left mouse button and drag a box from left to right to
modify the auto design setting of all members within the box.

• Hold down the left mouse button and drag a box from right to left to
modify the auto design setting of all members within the box or cut by
the box.

Review and modify diaphragm settings
The Diaphragm On/Off command on the Review tab allows you to select
whether the slab items, roof panels, and nodes in the model are included

Review the diaphragm settings
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, either:

a. Click Diaphragm On/Off, or

b. Click Show/Alter State and choose Diaphragm from the Attribute
list.

Slab items, roofs and nodes are color coded according to their Include in
diaphragm setting.

Modify the diaphragm settings of slab items or roofs
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, either:

a. Click Diaphragm On/Off, or

b. Click Show/Alter State and choose Diaphragm from the Attribute
list.

Slab items, roofs and nodes are color coded according to their Include in
diaphragm setting.

3. In the Properties window, set Entity type to Slab Item or Roof.

4. Do one of the following:

• Click an individual slab item or roof panel to switch between including
and excluding the element from the diaphragm.

• Hold down the left mouse button and drag a box from left to right to
switch between including and excluding slab items and roof panels
within the box from the diaphragm.

Review models 718 Review model properties (show/alter state)



• Hold down the left mouse button and drag a box from right to left to
switch between including and excluding slab items and roof panels
within the box or cut by the box from the diaphragm.

Include or remove solver nodes from the diaphragm
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, either:

a. Click Diaphragm On/Off, or

b. Click Show/Alter State and choose Diaphragm from the Attribute
list.

Slab items, roofs and nodes are color coded according to their Include in
diaphragm setting.

3. In the Properties window, set Entity type to Solver Node.

4. Do one of the following:

• Click an individual slab item or roof panel to switch between including
and excluding the element from the diaphragm.

• Hold down the left mouse button and drag a box to switch between
including and excluding the nodes within the box in diaphragm.

Modify end fixity
The Fixed/Pinned command allows you to graphically review and modify the
end fixity of all members in the model.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Fixed/Pinned.

3. Go to the Properties window.

4. In the Attribute list, ensure that Fixed/Pinned is selected.

5. With the Mode set as Toggle, do one of the following:

• Click an individual member to switch its end fixity between the valid
end fixity types.

• Hold down the left mouse button and drag a box from left to right to
alter the fixity settings of all members within the box.

• Hold down the left mouse button and drag a box from right to left to
alter the fixity settings of all members within the box or cut by the box.
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6. Alternatively, with the Mode set as Set On, select the FixityType required
and then click an individual member, or drag a box, as above to apply the
chosen fixity. 

NOTE If the end fixity of a member is labeled Cantilever, or N/A, the
end fixity at end 1 of the element is different from the fixity at end
2. You can only edit a mixed end fixity by right-clicking on the
member and editing its properties in the Properties dialog
(page 63).

Modify BIM status
The BIM Status command allows you to graphically modify the BIM status and
to exclude members and panels from the BIM import or export process.

To include or exclude members and panels from the BIM process, do the
following:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click BIM Status.

3. Do one of the following:

• Click an individual member or panel once to exclude it or twice to re-
include it.

• Hold down the left mouse button and drag a box from left to right to
modify the exclude setting of all members within the box.

• Hold down the left mouse button and drag a box from right to left to
modify the exclude setting of all members within the box or cut by the
box.

Copy or modify slab and foundation reinforcement
You can graphically review and modify the bar/mesh size and spacing applied
in each layer and direction for slab items, mats, patches and isolated
foundations. Tekla Structural Designer also allows you to copy reinforcement
from one slab item, mat, patch or isolated foundation to another.

TIP If you open two Review Views side by side, you can then use the first one to
modify the reinforcement while displaying the design status in the second one.
This way, each change you make to the reinforcement immediately updates the
design status.
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Copy reinforcement
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, either:

a. Click Auto/Check Design, or,

b. Click Show/Alter State and choose Autodesign from the Attribute
list.

Members and slabs are color coded according to their auto design setting.

3. Ensure that auto design is set off for the slab items and patches that you
want to modify.

4. On the Review tab, click Slab / Foundation Reinforcement.

5. Go to the Properties window.

6. Set Entity type to either Slab Item, Slab Patch or Isolated Foundation,
depending on the reinforcement that you want to copy.

7. In Reinforcement Direction, select the direction that you want to modify.

8. In Surface, select the slab layer that you want to modify.

9. Click the slab item or patch whose reinforcement you want to copy.

10. Click the slab items or patches to which you want to copy the
reinforcement. 

The slab reinforcement is copied to the selected slab items or patches.

TIP To ensure that the updated reinforcement is sufficient, in the
Slab/Mat Design group, click Status.

Modify reinforcement
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, either:

a. Click Auto/Check Design, or,

b. Click Show/Alter State and choose Autodesign from the Attribute
list.

Members and slabs are color coded according to their auto design setting.

3. Ensure that auto design is set off for the slab items and patches that you
want to modify.

4. On the Review tab, click Slab / Foundation Reinforcement.

5. Go to the Properties window.

6. Set Entity type to either Slab Item, Slab Patch or Isolated Foundation,
depending on the reinforcement that you want to modify.
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7. In Reinforcement Direction, select the direction that you want to modify.

8. In Surface, select the slab layer that you want to modify.

9. If you want to modify bars, in Bar Parameters, select the properties that
you want to modify.

10. In Apply, select the bar properties that you want to apply to the slab.

11. Click the slab item or patch whose reinforcement you want to update. 

TIP To ensure that the updated reinforcement is sufficient, in the
Slab/Mat Design group, click Status.

Copy section sizes
If necessary, you can graphically copy the section size applied to a member to
other members in the model. For more information, see the following
paragraphs.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Section.

5. Set Mode to Copy.

6. In Material type, select the desired material type. 

NOTE You can use a characteristic filter to reduce the elements
displayed in the model.

7. In the model, click the element from which you want to copy a section
size.

8. Click the elements to which you want to copy the section size. 

The section size is copied to the selected elements.

Copy material grades
If necessary, you can graphically review the material grade applied to the
members in your model. Tekla Structural Designer also allows you to copy the
grade of one member to another member with the same material type . For
more information, see the following paragraphs.

RESTRICTION You can only copy material grades to and from steel, cold
formed, cold rolled, concrete, or timber members.
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1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Material Grade.

5. In Material Type, select the desired material type. 

TIP If necessary, use a characteristic filter to reduce the elements
displayed in the Review View.

6. Set Mode to Copy.

7. Click the element whose grade you want to copy.

8. Click the elements to which you want to copy the grade. 

The material grade is copied to the selected elements.

Copy properties
The Copy Properties command allows you to graphically copy a specified
element parameter (such as web openings, shear connectors, or transverse
reinforcement) from a source member to other valid target members. To copy
properties from one member to another, see the following instructions.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Copy Properties.

3. Go to the Properties window.

4. In the Attribute list, select the parameter that you want to copy.

5. In the model, click the member from which you want to copy the
parameter.

6. Do one of the following:

• Click an individual member to which you want to copy the parameter.

• Hold down the left mouse button and drag a box around multiple
members to which you want to copy the parameter.

Tekla Structural Designer copies the parameter to the selected members.

Review and modify member filters
The Report Filter command allows you to graphically review and modify
report filters that you have defined for the members in your model. The
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Report Filter command remains unavailable until you have defined a member
filter.

TIP To define a report filter, do the following:

1. Go to the Report tab.

2. In the Filters group, click Members.

3. Define the member filter according to your needs.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Report Filter.

3. Do one of the following:

• Click an individual member to switch between including and excluding
the member from the selected member filter.

• Hold down the left mouse button and drag a box from left to right to
switch between including and excluding the members within the box
from the selected member filter.

• Hold down the left mouse button and drag a box from right to left to
switch between including and excluding the members within the box
or cut by the box from the selected member filter.

Review sub structures
The Sub Structures command allows you to graphically create, review and
modify sub structures for modeling purposes. The command can be especially
useful in large models, as individual sub structures can then be differentiated
by color and worked on in separate views.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Sub Structures. 

The elements in the model are color coded based on whether they belong
to sub structures.

See also

Manage sub structures (page 921)

Review concrete beam flanges
The Concrete Beam Flanges command allows you to graphically review the
flanges of concrete beams. See detailed instructions on how to review conrete
beam flanges in the following paragraphs.
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1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Concrete Beam Flanges. 

Each concrete beam is color coded to indicate if its flanges are considered
and flange widths determined.

Use of beam flanges

Review and modify column splice positions
The Column Splices command allows you to graphically review and modify
splice positions within steel columns. For detailed instructions on how to
review and modify splice positions, see the following paragraphs.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Column Splices. 

All potential splice locations are color coded to indicate if they are on or
off.

3. Do one of the following:

• Click a potential splice location to alter its setting between on or off.

• In a 2D view, hold down the left mouse button and drag a box to alter
the setting of multiple splices simultaneously.

Review and apply property sets
The command provides a means to graphically review or apply property sets
to entities.

• Review where property sets have been applied (page 914)

• Apply property sets to existing entities (page 913)

Copy or modify user-defined attributes
If necessary, you can graphically review and modify the values of attributes
that have been attached to the model.

Show/alter state
The Show/Alter State commands allow you to efficiently review and modify
various model properties. For each of the commands, entities are color coded
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in accordance with a legend, and the entity color changes to reflect any
changes as they are made.

In the Properties window, you can use filters for most Show/Alter State
commands. The filters allow you to control both the visibility of entities by
their current setting and their adjustability by their type and characteristic.
Inactive but visible entities are shaded a light transparent grey whose opacity
you can also control, if necessary.

To access the Show/Alter State commands, do the following:

1. Open a Review view.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. Choose the command required from the Attribute list:

Option Description
(page 727) set single span members to be active/inactive

(page 723) copy all properties between members

(page 728) set concrete members as either cracked or
uncracked

(page 717) review or modify autodesign settings

(page 720) modify BIM status, or exclude members/panels
from BIM import/export

(page 731) modify slenderness settings in each direction for
concrete columns and walls

(page 732) review and apply camber

(page 734) mark beam and column ends as cantilevers

(page 734) allows you to graphically review and override the
carbon factors applied to the model

(page 735) review and copy specified deflection limits
between steel beams

(page 718) select the slab items, roof panels, and nodes to
be included in diaphragms

review check status, or specify members to be
checked

(page 737) review and apply fire proofing

(page 719) review and modify member end fixity

(page 739) review and modify the gravity only setting of
beams and columns

(page 739) review and set imposed load reductions

(page 741) review and set live load reductions (US
headcode)

(page 722) review and copy the material grade between
members

(page 743) set the composite beams to which an effective
width override applies

(page 743) modify assumed punching shear check positions

(page 744) copy the connector layout from one beam to
others

review and modify lateral restraint settings of
steel beams, columns, trusses and portal frames
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(page 752) review and modify rotational stiffness settings of
beam ends

(page 722) review and copy section sizes between members

(page 752) review check status, or specify members to be
checked

review or modify SFRS type and direction

(page 754) copy shear connector properties between
composite beams

(page 754) review the status and locations where SidePlate
connections have been applied to steel beams

review and copy specified size constraints for
steel beams, columns, and braces

(page 755) modify the stud auto layout setting of composite
beams

review check status, or specify members to be
checked

(page 756) modify the transverse reinforcement of
composite beams

(page 725) review and modify user defined attributes
applied to members

review and modify user defined utilization ratios

(page 758) allows you to graphically focus in on high carbon
usage and inefficiency.

(page 760) copy web opening properties between members

(page 760) copy westok opening properties between
members

review check status, specify members to be
checked and set the limit

(page 761) set the members/ancillaries/equipment to which
open structure wind loading applies

TIP You can use Ctrl + A as a shortcut to quickly scroll the Attribute list.

Modify active / inactive settings
Initially all members are active. If a member is set inactive it does not
participate in the analysis but any load applied to (or decomposed) to it is still
accounted for.

Only single span beams, braces, analysis elements, purlins and rails have the
potential to be inactive. They each therefore have an Active setting in the
properties which defaults to 'on', but can be unchecked. In the Review View
these members are color coded allowing the same setting to be toggled
graphically.

NOTE Members cannot be inactive if:

• They are multi-span

• They support another member (active or inactive)

To modify the active setting of a member graphically do the following:
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1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State .

3. Go to the Properties window.

4. In the Attribute list select Active. 

Members are color coded according to their active setting.

5. In the Properties window, select the appropriate mode.

6. Do one of the following:

• Click an individual entity to modify its active setting.

• Hold down the left mouse button and drag a box from left to right to
modify the active setting of all members within the box.

• Hold down the left mouse button and drag a box from right to left to
modify the active setting of all members within the box or cut by the
box.

Modify assumed cracked settings
You can graphically review and modify the assumed cracked setting of the
concrete beams, columns and walls in a Review View using Show/Alter State -
Assume cracked.

Review assumed cracked settings

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Assume cracked.

5. Set the [M]ode to Review

6. Set the Entity type 

The member color coding indicates the cracked, partially cracked or
uncracked status.

NOTE By hovering the cursor over an individual member or panel a
tooltip is displayed. This reports the cracked status, and also the
EImajor, EIminor values. For partially cracked members/panels the
percentage is also given.

Set as fully cracked or uncracked

1. Open a view and change the view regime (page 89) to Review View.
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2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Assume cracked.

5. Set the [M]ode to Set On

6. Set Assume cracked to one of the following:

• Yes - click or box around concrete member(s) to set to cracked.

• No- click or box around concrete member(s) to set to uncracked.

The member color coding updates to reflect the cracked or uncracked
status.

7. Select Entire member to apply the new setting to all spans/stacks, or
leave it unselected to update individual spans/stacks only.

8. Click or box around those concrete member(s) you want to set. 

The member color coding updates to reflect the new cracked or
uncracked status.

Set as partially cracked

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Assume cracked.

5. Set the [M]ode to Set On

6. Set Assume cracked to Partially

7. Select Set Percentage

8. Enter the Percentage required.

9. Select Entire member to apply the new percentage to all spans/stacks, or
leave it unselected to update individual spans/stacks only.

10. Click or box around those concrete member(s) you want to apply the
percentage to. 

The member color coding updates to reflect the partially cracked status.

Toggle assumed cracked settings

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Assume cracked.

5. Set the [M]ode to Toggle
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6. Click or box around those concrete member(s) you want to toggle. 

The assumed cracked status of the members toggles between cracked,
partially cracked, and uncracked.

Review Wall Stress

To review/update the cracked status of all wall panels to be compatible with
the stress levels for the loadcases/ combinations that have been analyzed,
proceed as follows:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Assume cracked.

5. Set the [M]ode to Review Wall Stress.

6. Check the yellow command prompt to confirm which analysis type is
being used for the review, (this will be the type currently specified in
Design Settings>Analysis).

7. Set the Result type to control which factors to use in combinations for
the review.

• Strength factors, or

• Service factors

8. Set the Stress type to be considered.

• Max tension - Y, or

• In-plane tension - Y

9. Set the Stress threshold above which walls should crack. The existing
cracked/uncracked status of each panel is displayed, along with an
indiation of whether the stress threshold has been exceeded.

10. To make panel status compatible with the stress threshold for one or
more panels:

a. click an individual panel, or

b. box around multiple panels, or

c. to make all panels compatible, click  then click the Auto update
button 

Panel status is made compatible, i.e.

• If uncracked and the stress threshold has been exceeded, the status is
changed to cracked.
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• If partially cracked and the stress threshold has been exceeded, the
status is changed to cracked.

• If cracked and the stress threshold has not been exceeded, the status
is changed to uncracked.

Review Wall Stress - limitations and assumptions

NOTE The following limitations and assumptions apply to Review Wall Stress

1. Only meshed wall panels are considered, mid-pier walls are excluded.

2. The analysis type specified in Design Settings>Analysis determines
which set of analysis results are used for the review.

3. For the above analysis type, the loadcases and combinations considered
are those from the last performed building analysis of that type.

• This gives you the flexibility to review the stresses for a subset of
loadcases/combinations if required.

• By running Analyse All you can ensure all active gravity, lateral and
seismic (not seismic RSA) combinations have been considered.

• Stresses are available for seismic but not for seismic RSA
combinations - these are beyond scope. (Review Wall Stress is
more particularly aimed at determining the cracked status of
panels under wind loading).

4. Chasedown results are not considered.

5. Axial load reductions are always taken into account.

6. The maximum stress value from all nodes for all analysed cases/
combinations is reported in a tooltip for each panel. This value is used to
determine if the stress threshold has been exceeded.

• The reinforcement content in the panel is not considered in
determining the stress value.

7. The loading droplist in the status bar does not filter the status for
individual cases/combinations.

Modify slenderness settings
The Braced/Bracing command provides a means to graphically review and
modify the slenderness settings in each direction for concrete columns and
walls.

To modify slenderness settings, do the following:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Braced/Bracing.
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5. Select the direction under consideration. 

Members are color coded according to their slenderness setting in the
selected direction.

6. Do one of the following:

• Click an individual column or wall to modify its slenderness setting
between braced and bracing.

• Hold down the left mouse button and drag a box from left to right to
modify the slenderness setting of all concrete columns and walls
within the box.

• Hold down the left mouse button and drag a box from right to left to
modify the slenderness setting of all concrete columns and walls
within the box or cut by the box.

Review and set camber
The Show/Alter State Camber attribute allows you to graphically set and
review the camber properties applied to steel beams.

Review camber

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Camber.

5. Set the [M]ode to Review 

The member color coding indicates where and how camber has been
applied to beams.

Set on

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Camber.

5. Set the [M]ode to Set On

6. Set Apply as to Value/Proportion of span/Proportion of deflection as
required.

a. Enter the value or proportion information required to definer the
camber.
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7. Enter any beam length, or web thickness limits that you want to use to
limit when the camber should be applied.

8. Select Entire member to apply the new setting to all spans, or leave it
unselected to update individual spans only.

9. Click or box around those beam(s) you want to set. 

The member color coding updates to reflect the details that have been
applied.

• Members color coded as 'On' have the camber that is shown in the
properties window.

• Members color coded as 'Other details' have other camber properties.
These are displayed in a tooltip when you hover the cursor over each
member.

Set off

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Camber.

5. Set the [M]ode to Set Off

6. Select Entire member to switch off camber for all spans, or leave it
unselected to update individual spans only.

7. Click or box around those beam(s) for which you want to switch off
camber. 

The member color coding updates to reflect the details that have been
applied.

Toggle camber settings

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Camber.

5. Set the [M]ode to Toggle

6. Click or box around those beam(s) you want to toggle. 

The camber setting toggles between on and off.

Copy camber settings

1. Open a view and change the view regime (page 89) to Review View.
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2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Camber.

5. Set the [M]ode to Copy

6. In the model, click the beam from which you want to copy the camber
properties.

7. Click the beam to which you want to copy the camber properties. The
camber properties are copied to the selected beam.

8. Continue copying the same camber properties by clicking the desired
beams; or press Esc to select a new beam to copy the camber properties
from; or press Esc twice to finish.

Apply cantilever ends
The Cantilever end command allows you to graphically apply cantilever ends
where required to beams and columns.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Fixed/Pinned.

3. Go to the Properties window.

4. In the Attribute list, select Cantilever end.

5. Set Mode to Set On, Set Off, or Toggle as required.

6. Do one of the following:

• Click an individual member end to set/unset a cantilever end as per
the Mode.

• Hold down the left mouse button and drag a box from left to right to
alter the cantilever end settings of all members entirely within the box.

• Hold down the left mouse button and drag a box from right to left to
alter the cantilever end settings of all members within the box or cut
by the box.

Review carbon factors
The Show/Alter State Carbon factors attribute allows you to graphically
review and override the carbon factors applied to the model.

Review carbon factors

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Carbon factors.
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5. Set Mode to Review.

6. Set the Carbon source category to be reviewed 

NOTE Any entity in the model can have multiple carbon sources that
relate to it.

Set override

NOTE In general, rather than applying a carbon factor override you should
consider adding it instead to the list of embodied carbon factors that
can be applied.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Carbon factors.

5. Set Mode to Set override.

6. Set the Carbon source category to be overridden.

7. Enter the required Carbon factor.

8. In the model, click the entities to which the override applies.

9. Continue applying overrides or press Esc to finish.

Remove override

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Carbon factors.

5. Set Mode to Remove override.

6. Set the Carbon source category override to be removed.

7. In the model, click the entities from which the override is to be removed.

8. Continue removing overrides or press Esc to finish.

Review and copy deflection limits
You can graphically review specified deflection limits and copy the limits from
one steel beam to others.

Review deflection limits

1. Open a view and change the view regime (page 89) to Review View.
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2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Deflection Limits.

5. Set Mode to Review.

6. Set Load type to the load type that you want to review.

Copy deflection limits

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Deflection Limits.

5. Set Mode to Copy.

6. In the model, click the beam from which you want to copy the deflection
limits.

7. Click the beam to which you want to copy the deflection limits. 

The deflection limits are copied to the selected beam.

8. Continue copying the limits by clicking the desired beams or press Esc to
finish.

Review and modify drift checks
You can graphically review drift check results and set the members to be
checked for columns and walls.

Review drift checks

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Drift check.

5. Set Mode to Review.

Set drift checks on or off

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Drift check.

5. Set Mode to Set On , or Set Off or Toggle.
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6. In the model, click the column or wall for which you want to set the check.

a. If Mode is Set On - the check is switched on

b. If Mode is Set Off - the check is switched off

c. If Mode is Toggle - the check toggles between on and off

7. Continue setting the checks by clicking the desired columns and walls or
press Esc to finish.

Apply fire proofing
The Show/Alter State Fire proofing attribute allows you to graphically set and
review the fire proofing applied to 1D member types.

See also

Fire proofing (page 950)

Review fire proofing

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Fire proofing.

5. Set the [M]ode to Review 

The member color coding indicates the fire proofing status. If working to
Eurocodes the beams that have been set to have a fire resistance check
are also indicated.

NOTE By hovering the cursor over an individual member or panel a
tooltip is displayed. This reports the cracked status, and also the
EImajor, EIminor values. For partially cracked members/panels the
percentage is also given.

Set as protected

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Fire proofing.

5. Set the [M]ode to Set On

6. Set Checks to Protected

7. Select which of the protection properties (exposure, shape, thickness &
density) you want to apply proofing of the
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8. Select Entire member to apply the new setting to all spans/stacks, or
leave it unselected to update individual spans/stacks only.

9. Click or box around those 1D member(s) you want to set. 

The member color coding updates to reflect the details that have been
applied.

• Members color coded as 'On' have the fire proofing that is shown in
the properties window.

• Members color coded as 'Other details' have other fire proofing
properties. These are displayed in a tooltip when you hover the cursor
over each member.

Set check for fire resistance (Eurocode only)

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Fire proofing.

5. Set the [M]ode to Set On

6. Set Checks to Check for fire resistance

7. Select Set exposure to specify whether the member is exposed on all
sides or 3 sides only.

8. Select Entire member to apply the new setting to all spans, or leave it
unselected to update individual spans only.

9. Click or box around those beam(s) you want to set. 

The member color coding updates to reflect the details that have been
applied.

• Members color coded as 'On' have the fire resistance that is shown in
the properties window.

• Members color coded as 'Other details' have other fire resistance
properties. These are displayed in a tooltip when you hover the cursor
over each member.

Toggle fire proofing settings

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Fire proofing.

5. Set the [M]ode to Toggle
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6. If working to Eurocodes, choose whether you want to toggle the
protection or fire check settings.

7. Click or box around those 1D member(s) you want to toggle. 

The member properties toggle between on and off.

Modify gravity only settings
If necessary, you can review and modify the gravity only setting of the beams
and columns in your model. For more information, see the following
paragraphs.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Gravity only. 

All members are color coded to indicate their gravity only setting.

5. Do one of the following:

• Click a steel beam or column to set its gravity only setting on or off.

• Hold down the left mouse button and drag a box from left to right to
set on or off the gravity only setting of all steel beams and columns
within the box.

• Hold down the left mouse button and drag a box from right to left to
set on or off the gravity only setting of all steel beams and columns
within the box or cut by the box.

Review and set imposed load reduction
By selecting the Imposed load reduction attribute in Show/Alter State you
can graphically review and set imposed load reduction parameters.

TIP Graphical editing will typically be more effective than the alternative of opening
the Properties dialog box for each member individually.

Review load reduction attributes

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Imposed load reduction

5. Set Mode to Review.

6. Set the Load reduction attribute as required:
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• Applied imposed load reduction factor

• Reduce imposed loads by

• Count the floor as being supported*

• Number of floors carried*

* Not applicable if working to the Australian headcode.

The view updates to display the selected load reduction attribute
information.

TIP Hover the cursor over a member to see all the above attributes in a
tooltip.

Set 'Reduce imposed loads by' percentage for beams/slabs

To graphically reduce imposed loads on beams and slabs by a percentage
proceed as follows:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Imposed load reduction

5. Set Mode to Set.

6. Set the Load reduction attribute to Reduce imposed loads by.

7. Enter the percentage.

8. Set the Entity type that you want to modify.

9. Click or box around entities in the Review view to apply the new
percentage. The view updates to display the revised reduction
percentages.

TIP Hover the cursor over entities that don't have the currently selected
percentage reduction to see their attributes in a tooltip.

Set 'Count floor as being supported' for columns/walls

NOTE Not applicable if working to the Australian headcode.

To graphically set the 'Count floor as being supported' property at specific
levels for columns and walls proceed as follows:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Imposed load reduction
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5. Set Mode to Set.

6. Set the Load reduction attribute to Count the floor as being
supported.

7. Check or uncheck the Count the floor as being supported checkbox as
required.

8. Click on a column or wall just above/below a specific floor to set/unset the
Count the floor as being supported property at that level for the
selected column or wall.

TIP Set the Entity type to Any, Column, or Wall to work on specific entities
only.

Set 'Assume extra floors supported' for columns/walls

NOTE Not applicable if working to the Australian headcode.

To graphically set the 'Assume extra floors supported' property for columns
and walls proceed as follows:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Imposed load reduction

5. Set Mode to Set.

6. Set the Load reduction attribute to Assume extra floors supported.

7. Enter the Assume extra floors supported number.

8. Click or box around columns and walls to apply the new value.

Review and set live load reduction
By selecting the Live load reduction attribute in Show/Alter State you can
graphically review and set live load reduction parameters.

TIP Graphical editing will typically be more effective than the alternative of opening
the Properties dialog box for each member individually.

Review load reduction attributes

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Live load reduction
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5. Set Mode to Review.

6. Set the Load reduction attribute as required:

• Applied live load reduction factor

• KLL

• Reduce live loads by

7. If reviewing the applied live load reduction factor, choose the loadcase
type to review:

• Live

• Roof Live

The view updates to display the selected load reduction attribute
information.

TIP Hover the cursor over a member to see all the above attributes in a
tooltip.

Set 'Reduce live loads by' percentage for slabs

To graphically reduce live loads on slabs by a percentage proceed as follows:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Live load reduction

5. Set Mode to Set.

6. Set the Load reduction attribute to Reduce live loads by.

7. Enter the percentage.

8. Click or box around slabs in the Review view to apply the new percentage.
The view updates to display the revised reduction percentages.

TIP Hover the cursor over slabs that don't have the currently selected
percentage reduction to see their attributes in a tooltip.

Set KLL factor

To graphically set the KLL property proceed as follows:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Live load reduction

5. Set Mode to Set.
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6. Set the Load reduction attribute to KLL.

7. Enter the KLL value.

8. Uncheck Entire member if you only want the value to apply to individual
stacks/spans.

9. Click or box around entities to apply the new value.

TIP Set the Entity type to Beam, Column, or Wall to work on specific
entities only.

Override effective width
The Show/Alter State Override Effective Width attribute allows you to
graphically set the composite beams to which an effective width override
applies.

NOTE For the width to be overridden the Update effective width prior to
design check setting must be selected in Design > Settings > Steel >
Composite beam.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, ensure that Override Effective Width is selected.

5. Set Mode to Set On , or Set Off or Toggle.

6. In the model, click the composite beams to which an effective width
override will apply.

a. If Mode is Set On - the setting is switched on

b. If Mode is Set Off - the setting is switched off

c. If Mode is Toggle - the setting toggles between on and off

7. Continue applying the setting or press Esc to finish.

Modify punching shear check position
If necessary, you can graphically modify the assumed punching shear check
position. This allows you to determine the loaded perimeter when the
perimeter is close to a free edge.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Punch check position.
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5. To change the punching shear check position, do one of the following:

To Do this
Switch the punching shear check position
between Edge Z and Internal

• Click the Z edge of a punching check item.

Switch the punching shear check position
between Edge Y and Internal

• Click the Y edge of a punching check item.

Switch the punching shear check position
between Corner, Edge Z, Edge Y and Internal

• Click a corner of a punching check item.

NOTE Clicking an internal punching check item does not change the
punching shear check position.

TIP You can also box around multiple punching check item to switch
their position. Do one of the following:

• Hold down the left mouse button and drag a box from left to
right to switch the position setting of all punch check items
within the box.

• Hold down the left mouse button and drag a box from right to
left to switch the position setting of all punch check items within
the box or cut by the box.

Copy quick connector layout
You can graphically copy the connector layout from one beam to another. For
more information, see the following paragraphs.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Quick Connector Layout.

5. Click on the beam with the layout that you want to copy (must be valid). 

The composite beams in the model are color coded to indicate the source
and valid targets.

6. To select the beams to apply the layout to, do one of the following:

• Click an individual valid target beam.

• Hold down the left mouse button and drag a box from left to right to
totally enclose the target beams.

• Hold down the left mouse button and drag a box from right to left to
select target beams within the box or cut by the box.

The connector layout is copied from the source to the target beam(s).
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Review and modify restraints
By selecting the Restraints attribute in Show/Alter State you can graphically
review and modify continuous and discrete restraints for beams, columns,
trusses and portal frames.

TIP Graphical editing of restraints will typically be more effective than the alternative
of opening the Properties dialog box for each member individually.

Review restraints

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Restraints.

5. Set Mode to Review. For details of the restraint type choices etc. that are
presented in Review mode, see the Options overview topics below.

6. Set the Continuous box as required:

• Checked: shows continuous restraints, each sub-member being colour
coded in accordance with the legend.

• Unchecked: shows discrete restraints, each internal node at which
other members connect being colour coded in accordance with the
legend.

7. Set the Restraint Type that you want to review.

8. Set the Entity type that you want to review.

Toggle restraints

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Restraints.

5. Set Mode to Toggle. For details of the restraint type choices etc. that are
presented in Toggle mode, see the Options overview topics below.

6. Set the Entity type that you want to modify.

7. Leave the Continuous box checked to set continuous restraints along
sub-members, or uncheck it to set discrete restraints at those points
where other members connect.

8. Set the Restraint Type as required.

9. In the model:

• click the member at the location where want to toggle the restraint.
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• drag a box around multiple members to toggle the restraint at all valid
locations within the box.

The type of restraint at the selected location(s) changes to the next
restraint type shown in the legend. (Simply click again as necessary until
the desired restraint type has been applied.)

10. Continue toggling the restraints by clicking the desired members or press
Esc to finish.

Set restraints

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Restraints.

5. Set Mode to Set. For details of the restraint type choices etc. that are
presented in Set mode, see the Options overview topics below.

6. Set the Entity type that you want to modify.

7. Leave the Continuous box checked to set continuous restraints along
sub-members, or uncheck it to set discrete restraints at those points
where other members connect.

8. Set the Restraint Type as required.

9. Set the Restraint as required.

10. In the model:

• click the member at the location where want to set the restraint.

• drag a box around multiple members to set the same restraint at all
valid locations within the box.

11. Continue setting the checks by clicking/boxing the desired members or
press Esc to finish.

Options overview (US headcode)

The restraint options displayed in the Properties window depend on the
Entity type filter. When this is set to either Beam, Column, or Truss Top/
Bottom Member, the options are:

Command or
option

Description

[M]ode • Review - sub-members/discrete points of restraint
are color coded to indicate their restraint settings

• Toggle - clicking sub-members/discrete points of
restraint toggles the applicable restraints.
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Command or
option

Description

• Set - clicking sub-members/discrete points of restraint
sets the selected restraint.

Continuous • Checked - enables the review/setting of sub-member
continuous restraints

• Unchecked - enables the review/setting of discrete
restraints at those points where other members
connect.

Restraint Type The restraint type determines which page(s) of properties
are being edited.

• LTB - enables the review/setting of the check-boxes
located on the Restraints (LTB) property page.

• Compression - enables the review/setting of the
check-boxes located on the Restraints (Comp)
property page.

• LTB & Compression Out of Plane - enables the
simultaneous review/setting of check-boxes on both
the the Restraints (LTB) and Restraints (Comp)
property pages.

Restraint When in Set Mode, this setting determines which check-
boxes on the selected restraint property page are
checked and un-checked.
For LTB restraint types (and Entity type Beam or Truss):

• Top - Top flange check-box is checked, Bottom flange
check-box is unchecked.

• Bottom - Top flange check-box is unchecked, Bottom
flange check-box is checked.

• Top and Bottom - both check-boxes are checked.

• Unrestrained - both check-boxes are unchecked.
For LTB restraint types (and Entity Type Column):

• Face A - Face A check-box is checked, Face C check-
box is unchecked.

• Face C - Face A check-box is unchecked, Face C check-
box is checked.

• Face A & C - both check-boxes are checked.

• Unrestrained - both check-boxes are unchecked.
For Compression restraint types:

• Out of Plane - Out of plane check-box is checked, In
plane check-box is unchecked.
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Command or
option

Description

• In Plane - In plane check-box is checked, Out of plane
check-box is unchecked.

• Out of Plane & In Plane - both check-boxes are
checked.

• Unrestrained - both check-boxes are unchecked.
 For LTB & Compression Out of Plane restraint type:

• Top & Bottom & Out of Plane - Top flange, Bottom
flange, and Out of Plane are checked.

• Top & Out of Plane - Top flange and Out of Plane are
checked, Bottom flange is unchecked.

• Bottom & Out of Plane - Bottom flange and Out of
Plane are checked, Top flange is unchecked.

• Unrestrained - Top flange, Bottom flange, and Out of
Plane are checked.

NOTE For each of the above, the In Plane check-box is
unaffected, retaining its existing setting.

Options overview (other head codes)

The restraint options displayed in the Properties window depend on the
Entity type filter. When this is set to either Beam, Column, or Truss Top/
Bottom Member, the options are:

Command or
option

Description

[M]ode • Review - sub-members/discrete points of restraint
are color coded to indicate their restraint settings

• Toggle - clicking sub-members/discrete points of
restraint toggles the applicable restraints.

• Set - clicking sub-members/discrete points of restraint
sets the selected restraint.

Continuous • Checked - enables the review/setting of sub-member
continuous restraints

• Unchecked - enables the review/setting of discrete
restraints at those points where other members
connect.

Restraint Type The restraint type determines which page(s) of properties
are being edited.
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Command or
option

Description

• Lateral - enables the review/setting of the check-
boxes located on the Lateral restraints property
page.

• Strut - enables the review/setting of the check-boxes
located on the Strut restraints property page

• Lateral & Strut Minor - enables the simultaneous
review/setting of check-boxes on both the the Lateral
restraints and Strut restraints property pages.

Restraint When in Set Mode, this setting determines which check-
boxes on the selected restraint property page are
checked and un-checked.
For Lateral restraint types (and Entity type Beam or
Truss):

• Top - Top flange check-box is checked, Bottom flange
check-box is unchecked.

• Bottom - Top flange check-box is unchecked, Bottom
flange check-box is checked.

• Top and Bottom - both check-boxes are checked.

• Unrestrained - both check-boxes are unchecked.
For Lateral restraint types (and Entity Type Column):

• Face A - Face A check-box is checked, Face C check-
box is unchecked.

• Face C - Face A check-box is unchecked, Face C check-
box is checked.

• Face A & C - both check-boxes are checked.

• Unrestrained - both check-boxes are unchecked.
For Strut restraint types:

• Major - Major check-box is checked, Minor check-box
is unchecked.

• Minor - Minor check-box is checked, Major check-box
is unchecked.

• Major and Minor - both check-boxes are checked.

• Unrestrained - both check-boxes are unchecked.
 For Lateral & Strut Minor restraint type:

• Top & Bottom & Minor - Top flange, Bottom flange,
and Minor are checked.

• Top & Minor - Top flange and Minor are checked,
Bottom flange is unchecked.
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Command or
option

Description

• Bottom & Minor - Bottom flange and Minor are
checked, Top flange is unchecked.

• Unrestrained - Top flange, Bottom flange, and Minor
are checked.

NOTE For each of the above, the Major check-box is
unaffected, retaining its existing setting.

Portal Frame options (US headcode)

The restraint options displayed in the Properties window when the Entity
type filter is set to Portal Frame are:

Command or
option

Description

[M]ode • Review - discrete points of restraint are color coded
to indicate their restraint settings

• Toggle - clicking discrete points of restraint toggles
the applicable restraints.

• Set - clicking discrete points of restraint sets the
selected restraint.

Restraint When in Set Mode, this setting determines which check-
boxes on the restraint property pages are checked and
un-checked.

Rafters:

• Torsional - Top flange, Bottom flange, and Out of
Plane are checked.

• Outer - Top flange is checked, Bottom flange is
unchecked.

• Inner - Top flange is unchecked, Bottom flange is
checked.

• Unrestrained - Top flange, Bottom flange, and Out of
Plane are unchecked.

Columns:

• Torsional - Face A, Face C, and Out of Plane are
checked.

• Outer - Face A is checked, Face C is unchecked.

• Inner - Face A is unchecked, Face C is checked.
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Command or
option

Description

• Unrestrained - Face A, Face C, and Out of Plane are
unchecked.

NOTE For each of the above, any checkbox not
specifically mentioned retains its existing setting.

Portal frames options (other head codes)

The restraint options displayed in the Properties window when the Entity
type filter is set to Portal Frame are:

Command or
option

Description

[M]ode • Review - discrete points of restraint are color coded
to indicate their restraint settings

• Toggle - clicking discrete points of restraint toggles
the applicable restraints.

• Set - clicking discrete points of restraint sets the
selected restraint.

Restraint When in Set Mode, this setting determines which check-
boxes on the restraint property pages are checked and
un-checked.

Rafters:

• Torsional - Top flange, Bottom flange, and Minor are
checked.

• Outer - Top flange is checked, Bottom flange is
unchecked.

• Inner - Top flange is unchecked, Bottom flange is
checked.

• Unrestrained - Top flange, Bottom flange, and Minor
are unchecked.

Columns:

• Torsional - Face A, Face C, and Minor are checked.

• Outer - Face A is checked, Face C is unchecked.

• Inner - Face A is unchecked, Face C is checked.
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Command or
option

Description

• Unrestrained - Face A, Face C, and Minor are
unchecked.

NOTE For each of the above, any checkbox not
specifically mentioned retains its existing setting.

Related video

Show/Alter State Restraints

Apply rotational stiffness to a beam end
The Rotational stiffness command allows you to graphically apply partially
fixity/linear springs to the ends of beams.

Related video

Automatic modelling of partial fixity

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Fixed/Pinned.

3. Go to the Properties window.

4. In the Attribute list, select Rotational stiffness.

5. Set Mode to Set On.

6. Set Direction to Major, or Minor as required.

7. Set Rotational stiffness to Partially fixed, or Spring linear as required.

8. If Partially fixed, set the percentage fixity value; or if Spring linear set
the spring stiffness value as required.

9. To apply the new setting do one of the following:

• Click an individual beam end.

• Hold down the left mouse button and drag a box from left to right to
apply to all beam ends entirely within the box.

• Hold down the left mouse button and drag a box from right to left to
apply to both ends of all beams within the box or cut by the box.

Review and modify seismic drift
You can graphically review seismic drift check results and set the members to
be checked for columns and walls.
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Review seismic drift

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Seismic drift.

5. Set Mode to Review.

Set seismic drift checks on or off

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Seismic drift.

5. Set Mode to Set On , or Set Off or Toggle.

6. In the model, click the column or wall for which you want to set the check.

a. If Mode is Set On - the check is switched on

b. If Mode is Set Off - the check is switched off

c. If Mode is Toggle - the check toggles between on and off

7. Continue setting the checks by clicking the desired columns and walls or
press Esc to finish.

Review and modify SFRS settings
If necessary, you can graphically review and modify the the types and
directions of seismic force resisting systems (SFRS) in the model. For more
information, see the following paragraphs.

Review SFRS type and direction settings

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select SFRS. 

Members and walls are color coded according to their SFRS type and
direction settings.

Modify SFRS type & direction settings

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.
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4. In the Attribute list, select SFRS. 

Members and walls are color coded according to their SFRS direction
setting.

5. Set Mode to one of the following:

• Update Type & Direction: includes a member in the selected SFRS
type & direction.

• Remove from SFRS: removes the member from SFRS.

6. Click the desired member. 

Depending on the set mode, Tekla Structural Designer includes the
member in the SFRS type & direction, or removes the member from SFRS.

Copy shear connectors
If necessary, you can copy the composite beam shear connector properties
from a source beam to other composite beams. Do the following:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Shear Connectors.

5. In the model, click the composite beam from which you want to copy the
shear connector properties.

6. Click the composite beams to which you want to copy the shear connect
properties. 

The properties are copied to the selected beams.

Modify SidePlates
The SidePlates command allows you to graphically review and modify the
SidePlate connection status.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click SidePlates.

3. Do one of the following:

• Click on the first half of a beam to reset end 1, the second half to reset
end 2 and the middle to reset both ends simultaneously.

• Hold down the left mouse button and drag a box from right to left to
reset all the beam ends within the box or cut by the box.

See also

Create and size SidePlate connections (page 645)
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Review and copy size constraints
If necessary, you can graphically review specified size constraints for steel
beams, columns, and braces, and copy the constraints from one steel member
to others. For more information, see the following paragraphs.

Review size constraints

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Size Constraints.

5. Set Mode to Review.

6. In Size constraint, select the size constraint that you want to review.

Copy size constraints

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Size Constraints.

5. Set Mode to Copy. 

TIP Select the By constraint type option if you want to only copy an
individual constraint type.

6. In the model, click the member from which you want to copy the size
constraints.

7. Click the member to which you want to copy the size constraints.

8. Continue copying the size constraints by clicking the desired members or
press Esc to finish.

Modify stud auto layout
If necessary, you can graphically modify the stud auto layout setting of
composite beams in the model. For more information, see the following
paragraphs.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.
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4. In the Attribute list, select Stud auto layout. 

The composite beams in the model are color coded according to their
auto layout setting.

5. Do one of the following:

• Click an individual composite beam to alter its auto layout setting.

• Hold down the left mouse button and drag a box from left to right to
alter the auto layout setting of all composite beams within the box.

• Hold down the left mouse button and drag a box from right to left to
alter the auto design setting of all composite beams within the box or
cut by the box.

Review and modify sway checks
You can graphically review sway check results and set the members to be
checked for columns and walls.

Review sway checks

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Sway check.

5. Set Mode to Review.

Set sway checks on or off

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Sway check.

5. Set Mode to Set On , or Set Off or Toggle.

6. In the model, click the column or wall for which you want to set the check.

a. If Mode is Set On - the check is switched on

b. If Mode is Set Off - the check is switched off

c. If Mode is Toggle - the check toggles between on and off

7. Continue setting the checks by clicking the desired columns and walls or
press Esc to finish.
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Copy transverse reinforcement
If necessary, you can copy beam transverse reinforcement from one
composite beam to others in your model. Do the following:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Transverse reinforcement. 

The composite beams in the model are color coded based on whether you
can copy transverse reinforcement properties from them.

5. Click the composite beam from which you want to copy transverse
reinforcement properties.

6. Click the composite beams to which you want to copy the transverse
reinforcement properties. 

The properties are copied to the selected beams.

Review and modify user defined U/R
From a Review View you can graphically review user defined utilization ratios,
set the members to which they are applied, and set whether they apply to
autodesign alone, or both autodesign and check.

Review user defined U/R

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select User defined U/R.

Apply a user defined U/R for autodesign only

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select User defined U/R.

5. Set Mode to Apply to Autodesign.

6. Select Set limit ratio.

7. Specify the required Ratio limit

8. If required, set Entity type and Material to make the command easier to
apply.
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9. In the model, click those column/wall stacks, beam spans, or objects for
which you want to apply the user defined U/R.

10. Continue setting the limit by clicking the desired columns and walls or
press Esc to finish.

Apply a user defined U/R for autodesign and check

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select User defined U/R.

5. Set Mode to Apply to Autodesign+Check.

6. Select Set limit ratio.

7. Specify the required Ratio limit

8. If required, set Entity type and Material to make the command easier to
apply.

9. In the model, click those column/wall stacks, beam spans, or objects for
which you want to apply the user defined U/R.

10. Continue setting the limit by clicking the desired columns and walls or
press Esc to finish.

Turn off user defined U/R

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select User defined U/R.

5. Set Mode to Set Off.

6. If required, set Entity type and Material to make the command easier to
apply.

7. In the model, click those column/wall stacks, beam spans, or objects for
which you want to turn off user defined U/R.

8. Continue by clicking the desired stacks/spans/objects or press Esc to
finish.

See also

Apply user defined utilization ratios (page 613)

Review models 758 Review model properties (show/alter state)



Review utilization and embodied carbon
The Show/Alter State Utilization and embodied carbon attribute allows you
to graphically focus in on high carbon usage and inefficiency.

Review utilization and embodied carbon

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Utilization and embodied carbon.

5. Set the Entity type and Variant to review.

6. Set the Carbon source category to be review. 

NOTE Any entity in the model can have multiple carbon sources that
relate to it, for example:

• A concrete beam has concrete and reinforcement

• A composite beam has steel, shear studs, and potentially
transverse shear reinforcement

For example

Set filters to focus on where the carbon impact might be reduced

1. Set the utilization filter as required. 

• Value below - only entities with utilization below the specified value are
displayed

• Value above - only entities with utilization above the specified value
are displayed

• Lowest X % - only the lowest specified percentage of utilizations are
displayed

• Highest X % - only the highest specified percentage of utilizations are
displayed

2. Set the embodied carbon filter as required. 

• Value below - only entities with a carbon usage below the specified
value are displayed

• Value above - only entities with a carbon usage above the specified
value are displayed

• Lowest X % - only the lowest specified percentage of carbon usages are
displayed

• Highest X % - only the highest specified percentage of carbon usages
are displayed
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Typically, filters would be applied to detect where high carbon usage occurs in combination with low utilization, as this
informs where the carbon impact could be reduced.

For example: Highest 50% embodied carbon combined with lowest 50%
utilization.

Copy web openings
If necessary, you can copy web opening properties from one member to
others. Do the following:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Web Openings. 

The members in the model are color coded based on whether you can
copy web opening properties from them.

5. In the model, click the member from which you want to copy web opening
properties.

6. Click the members to which you want to copy the web opening properties.

The properties are copied to the selected members.

Copy westok openings
If necessary, you can copy westok opening properties from one member in
your model to others. Do the following:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review tab, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Westok Openings. 

The members in the model are color coded based on whether you can
copy westok opening properties from them.

5. In the model, click the member from which you want to copy westok
opening properties.

6. Click the members to which you want to copy the westok opening
properties. 

The properties are copied to the selected members.
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Review and modify wind drift checks
You can graphically review wind drift check results, set the members to be
checked and set the check limits for columns and walls.

Review wind drift checks

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Wind drift.

5. Set Mode to Review.

Set wind drift checks on or off

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Wind drift.

5. Set Mode to Set On , or Set Off or Toggle.

6. In the model, click the column or wall for which you want to set the check.

a. If Mode is Set On - the check is switched on

b. If Mode is Set Off - the check is switched off

c. If Mode is Toggle - the check toggles between on and off

7. Continue setting the checks by clicking the desired columns and walls or
press Esc to finish.

Set wind drift checks on and set the ratio limit

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, select Wind drift.

5. Set Mode to Set On.

6. Select Set limit ratio.

7. Specify the required Wind drift ratio limit

8. In the model, click the column or wall for which you want to set the limit.

9. Continue setting the limit by clicking the desired columns and walls or
press Esc to finish.

Review models 761 Review model properties (show/alter state)



Modify wind loading
The Show/Alter State Wind Loading attribute allows you to graphically set the
members/ancillaries/equipment to which open structure wind loading applies.

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review toolbar, click Show/Alter State.

3. Go to the Properties window.

4. In the Attribute list, ensure that Wind Loading is selected.

5. If you want to apply the setting to individual stacks/spans within members
as opposed to the entire member, unselect Entire member.

6. Set Mode to Set On , or Set Off or Toggle.

7. In the model, click the members/ancillaries/equipment for which you want
to set the check.

a. If Mode is Set On - the setting is switched on

b. If Mode is Set Off - the setting is switched off

c. If Mode is Toggle - the setting toggles between on and off

8. Continue applying the setting or press Esc to finish.

9.3 Review tabular data
The Tabular Data command allows you to view design summaries, sway &
drift results, material lists, connection resistances, embodied carbon and more
in tabular views. Tabular data can be filtered, sorted and exported to Excel.

• Review design summary tabular results (page 763)

• Review inter-story shear tabular results (page 764)

• Review sway check tabular results (page 765)

• Review story shear tabular results (page 768)

• Review drift check tabular results (page 770)

• Review seismic drift check tabular results (page 773)

• Review wind drift check tabular results (page 777)

• Review connection resistance tabular results (page 643)

• Review material list tabular results (page 782)

• Review embodied carbon detail (page 808)

• Review embodied carbon overview (page 809)

• Review floored area tabular results (page 810)

• Filter tabular data (page 811)
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• Export tabular results to Excel (page 811)

Review design summary tabular results
To review a tabular Design Summary:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Design Summary

4. In the Result Type group, select the analysis type for which the design
summary is required.

5. In the Material Type group, select the material.

The available selections in the Characteristic group (and the other
groups) are reduced to those appropriate to the selected material.

6. In the Characteristic group, select the required characteristic.

The available selections in the Construction group are reduced to those
appropriate to the selected characteristic.

7. If applicable, in the Construction group, select the construction.
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The available selections in the Fabrication group are reduced to those
appropriate to the selected construction.

8. In the Fabrication group, select the fabrication.

The tabular design summary is displayed for every entity of the selected
material and type in the structure.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 811)

See also

Export tabular results to Excel (page 811)

Review member design (page 701)

Review inter-story shear tabular results
Inter-story shear can be reviewed by creating an Inter-story Shear tabular
data view.

Inter-story Shear tabular data views:

• are displayed for the loadcase/combination selected in the Loading list

• are by default displayed for all levels

• but can have level filters applied (page 811)

• can be exported to a spreadsheet (page 811)

Create inter-story shear tabular results
To display Inter-story Shear as tabular data:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Inter-story Shear
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4. Choose the required loadcase/combination in the Loading list. 

The results are displayed as specified.

If required you can configure a filter to limit the display to selected levels.
To do this, see: Filter tabular data (page 811)

Review sway check tabular results

NOTE The sway check is not applicable if using the ACI/AISC head code.

Sway check results can be reviewed by creating a Sway tabular data view.

Sway tabular data views:

• can either be displayed in summary or detail:

• Summary Only (default) - the column/wall with most critical result for
the selected combinations is reported for each direction at each level

• Detailed - the critical ratio in each direction at each level is reported for
all columns/walls for the selected combinations

• are displayed for all columns /walls (default), but you can also select by
material, characteristic and fabrication

• can have filters applied (page 811)

• can be examined in more detail by clicking the Details... button at the end
of each row

• are linked to the 3D view: double-clicking a row in the table locates the row
entity in the 3D view

• can be exported to a spreadsheet (page 811)

• are not suitable for direct printing, but the data can be included in a
Building Analysis Checks (page 841) report which can then be printed.

Review sway check tabular results from the Project Workspace Status
Tree
1. Go to the Project Workspace and in Status tree expand the Design

branch.

2. Right click on Sway and from the context menu select Review Data Table

3. On the Review Data ribbon, choose if you want results displayed for all
available material and member types, or a subset only:

• To display results for all available material and member types, in the 
View Type group, click Toggle Selection.

• To display results for a subset of materials/member types proceed as
follows:
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a. In the Material Type group, select the material(s).

b. In the Characteristic group, select the required characteristic(s).

c. In the Fabrication group, select the fabrication type(s).

4. Choose if you want critical results determined from All Combinations, or
a specific combination only:

• In the Loading list, select All Combinations.

• In the Loading list, select a specific combination.

5. Choose if you want to create a summary or a detailed report by selecting/
unselecting Summary Only in the View Type group.

The tabular drift checks are displayed as specified.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 811)

Review sway check tabular results from a Review View
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Sway

4. Choose if you want results displayed for all available material and
member types, or a subset only:

• To display results for all available material and member types, in the 
View Type group, click Toggle Selection.
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• To display results for a subset of materials/member types proceed as
follows:

a. In the Material Type group, select the material(s).

b. In the Characteristic group, select the required characteristic(s).

c. In the Fabrication group, select the fabrication type(s).

5. Choose if you want critical results determined from All Combinations, or
a specific combination only:

• In the Loading list, select All Combinations.

• In the Loading list, select a specific combination.

6. Choose if you want to create a summary or a detailed report by selecting/
unselecting Summary Only in the View Type group.

The tabular drift checks are displayed as specified.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 811)

Locate check in a 3D view
Double-clicking on a specific row in the tabular data view locates where the
row content is in the model by highlighting it in a 3D view.
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TIP Make use of the “ghost unselected” feature to make highlighted entities
clearer.

Review story shear tabular results
To create a tabular floored area summary:

1. Open a view and change the view regime (page 89) to Review View.
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2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Inter-story Shear or Cumulative Story Shear as required.

A table of story shears is displayed.

See also

Inter-story shear and cumulative story shear (page 769)

Inter-story shear and cumulative story shear
The Inter-story Shear (also known as Floor Forces) table displays the sum of
the lateral forces applied at each level in the structure.

Cumulative story shears are calculated by summing the floor forces from the
top to the bottom of the structure, consequently they should get bigger as you
move down.
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Review drift check tabular results

NOTE The drift check is only applicable if using the ACI/AISC head code.

Drift check results can be reviewed by creating a Drift tabular data view.

Drift tabular data views:

• can either be displayed in summary or detail:

• Summary Only (default) - the column/wall with most critical ratio for
the selected combinations is reported for each direction at each level

• Detailed - the critical ratio in each direction at each level is reported for
all columns/walls for the selected combinations

• are displayed for all columns /walls (default), but you can also select by
material, characteristic and fabrication

• can have filters applied (page 811)

• can be examined in more detail by clicking the Details... button at the end
of each row

• are linked to the 3D view: double-clicking a row in the table locates the row
entity in the 3D view

• can be exported to a spreadsheet (page 811)

• are not suitable for direct printing, but the data can be included in a
Building Analysis Checks (page 841) report which can then be printed.
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Review drift check tabular results from the Project Workspace Status
Tree
1. Go to the Project Workspace and in Status tree expand the Design

branch.

2. Right click on Drift and from the context menu select Review Data Table

3. On the Review Data ribbon, choose if you want results displayed for all
available material and member types, or a subset only:

• To display results for all available material and member types, in the 
View Type group, click Toggle Selection.

• To display results for a subset of materials/member types proceed as
follows:

a. In the Material Type group, select the material(s).

b. In the Characteristic group, select the required characteristic(s).

c. In the Fabrication group, select the fabrication type(s).

4. Choose if you want critical results determined from All Combinations, or
a specific combination only:

• In the Loading list, select All Combinations.

• In the Loading list, select a specific combination.

5. Choose if you want to create a summary or a detailed report by selecting/
unselecting Summary Only in the View Type group.

The tabular drift checks are displayed as specified.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 811)

Review drift check tabular results from a Review View
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Drift
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4. Choose if you want results displayed for all available material and
member types, or a subset only:

• To display results for all available material and member types, in the 
View Type group, click Toggle Selection.

• To display results for a subset of materials/member types proceed as
follows:

a. In the Material Type group, select the material(s).

b. In the Characteristic group, select the required characteristic(s).

c. In the Fabrication group, select the fabrication type(s).

5. Choose if you want critical results determined from All Combinations, or
a specific combination only:

• In the Loading list, select All Combinations.

• In the Loading list, select a specific combination.

6. Choose if you want to create a summary or a detailed report by selecting/
unselecting Summary Only in the View Type group.

The tabular drift checks are displayed as specified.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 811)

Locate check in a 3D view
Double-clicking on a specific row in the tabular data view locates where the
row content is in the model by highlighting it in a 3D view.
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TIP Make use of the “ghost unselected” feature to make highlighted entities
clearer.
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Review seismic drift check tabular results
Seismic drift check results can be reviewed by creating a Seismic drift tabular
data view.

Seismic drift tabular data views:

• can either be displayed in summary or detail:

• Summary Only (default) - the column/wall with most critical ratio for
the selected combinations is reported for each direction at each level

• Detailed - the critical ratio in each direction at each level is reported for
all columns/walls for the selected combinations

• are displayed for all columns /walls (default), but you can also select by
material, characteristic and fabrication

• can have filters applied (page 811)

• can be examined in more detail by clicking the Details... button at the end
of each row

• are linked to the 3D view: double-clicking a row in the table locates the row
entity in the 3D view

• can be exported to a spreadsheet (page 811)

• are not suitable for direct printing, but the data can be included in a
Building Analysis Checks (page 841) report which can then be printed.

Review seismic drift check tabular results from the Project Workspace
Status Tree
1. Go to the Project Workspace and in Status tree expand the Design

branch.

2. Right click on Seismic Drift and from the context menu select Review
Data Table

3. On the Review Data ribbon, choose if you want results displayed for all
available material and member types, or a subset only:

• To display results for all available material and member types, in the 
View Type group, click Toggle Selection.

• To display results for a subset of materials/member types proceed as
follows:

a. In the Material Type group, select the material(s).

b. In the Characteristic group, select the required characteristic(s).

c. In the Fabrication group, select the fabrication type(s).

4. Choose if you want critical results determined from All Combinations, or
a specific combination only:
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• In the Loading list, select All Combinations.

• In the Loading list, select a specific combination.

5. Choose if you want to create a summary or a detailed report by selecting/
unselecting Summary Only in the View Type group.

The tabular results are displayed as specified.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 811)

Review seismic drift check tabular results from a Review View
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Seismic drift

4. Choose if you want results displayed for all available material and
member types, or a subset only:

• To display results for all available material and member types, in the 
View Type group, click Toggle Selection.

• To display results for a subset of materials/member types proceed as
follows:

a. In the Material Type group, select the material(s).

b. In the Characteristic group, select the required characteristic(s).

c. In the Fabrication group, select the fabrication type(s).
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5. Choose if you want critical results determined from All Combinations, or
a specific combination only:

• In the Loading list, select All Combinations.

• In the Loading list, select a specific combination.

6. Choose if you want to create a summary or a detailed report by selecting/
unselecting Summary Only in the View Type group.

The tabular results are displayed as specified.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 811)

Locate check in a 3D view
Double-clicking on a specific row in the tabular data view locates where the
row content is in the model by highlighting it in a 3D view.

Review models 776 Review tabular data



TIP Make use of the “ghost unselected” feature to make highlighted entities
clearer.

Review wind drift check tabular results
Wind drift check results can be reviewed by creating a Wind drift tabular data
view.

Wind drift tabular data views:

• can either be displayed in summary or detail:
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• Summary Only (default) - the column/wall with most critical ratio for
the selected combinations is reported for each direction at each level

• Detailed - the critical ratio in each direction at each level is reported for
all columns/walls for the selected combinations

• are displayed for all columns /walls (default), but you can also select by
material, characteristic and fabrication

• can have filters applied (page 811)

• can be examined in more detail by clicking the Details... button at the end
of each row

• are linked to the 3D view: double-clicking a row in the table locates the row
entity in the 3D view

• can be exported to a spreadsheet (page 811)

• are not suitable for direct printing, but the data can be included in a
Building Analysis Checks (page 841) report which can then be printed.

Review wind drift check tabular results from the Project Workspace
Status Tree
1. Go to the Project Workspace and in Status tree expand the Design

branch.

2. Right click on Wind Drift and from the context menu select Review Data
Table

3. On the Review Data ribbon, choose if you want results displayed for all
available material and member types, or a subset only:

• To display results for all available material and member types, in the 
View Type group, click Toggle Selection.

• To display results for a subset of materials/member types proceed as
follows:

a. In the Material Type group, select the material(s).

b. In the Characteristic group, select the required characteristic(s).

c. In the Fabrication group, select the fabrication type(s).

4. Choose if you want critical results determined from All Combinations, or
a specific combination only:

• In the Loading list, select All Combinations.

• In the Loading list, select a specific combination.

5. Choose if you want to create a summary or a detailed report by selecting/
unselecting Summary Only in the View Type group.
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The tabular wind drift checks are displayed as specified.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 811)

Review wind drift check tabular results from a Review View
1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Wind drift

4. Choose if you want results displayed for all available material and
member types, or a subset only:

• To display results for all available material and member types, in the 
View Type group, click Toggle Selection.

• To display results for a subset of materials/member types proceed as
follows:

a. In the Material Type group, select the material(s).

b. In the Characteristic group, select the required characteristic(s).

c. In the Fabrication group, select the fabrication type(s).

5. Choose if you want critical results determined from All Combinations, or
a specific combination only:

• In the Loading list, select All Combinations.

• In the Loading list, select a specific combination.
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6. Choose if you want to create a summary or a detailed report by selecting/
unselecting Summary Only in the View Type group.

The tabular wind drift checks are displayed as specified.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 811)

Locate check in a 3D view
Double-clicking on a specific row in the tabular data view locates where the
row content is in the model by highlighting it in a 3D view.
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TIP Make use of the “ghost unselected” feature to make highlighted entities
clearer.
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Review material list tabular results
The material content of the model can be readily assessed in the form of a
Material List. This can be created and viewed either in a tabular data view or a
report, according to your needs.

• Material List tabular data view:

• created for a specific material and entity type

• displayed on screen (not suitable for direct printing)

• can be sorted in ascending/descending order of a column by clicking a
column heading

• row content can be located within a 3D view by double-clicking a row

• can be exported to a spreadsheet

• Material List report:

• created for multiple materials and entity types

• displayed in a format suitable for printing

• can be exported to a spreadsheet

Two levels of content can be generated:

• Summary Only - this is the default level and is very condensed, for
example:

• total quantities only for each beam/ column section size

• total quantities for each slab

• total weight of reinforcement (by mass, and by mass/unit volume)

• Detailed - this is a longer report, for example:

• quantities for each span/ stack/ panel for each concrete beam /
column / wall

• quantities for each section size of a given length for beams and
columns in other materials

• quantities for each slab item

• quantities for individual reinforcement bar/mesh types

The topics in the section all relate to the tabular data view. To find out how to
create a material list report, see: Material Listing report (page 844)

Create material list tabular results
To create a material list as tabular data:

1. Open a view and change the view regime (page 89) to Review View.
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2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Material List

4. In the Material Type group, select the material.

The available selections in the Characteristic group (and the other
groups) are reduced to those appropriate to the selected material.

NOTE To find out exactly what summary and detailed level output is
produced for each material type and characteristic, see:

• Steel material lists (page 786)

• Concrete material lists (page 792)

• Timber material lists (page 803)

• Cold formed material lists (page 805)

• General material lists (page 806)

5. In the Characteristic group, select the required characteristic.

The available selections in the Construction group are reduced to those
appropriate to the selected characteristic.

6. If applicable, in the Construction group, select the construction.
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The available selections in the Fabrication group are reduced to those
appropriate to the selected construction.

7. In the Fabrication group, select the fabrication.

The available selections in the Content group are reduced to those
appropriate to the selected fabrication.

8. In the Content group, select the content.

9. If you have selected Members in the Content group, you have the option
to create a summary or a detailed report by selecting/unselecting
Summary Only in the View Type group.

The tabular material list is displayed for every entity of the selected
material and type in the structure.

If required you can configure a filter to limit the display to sub-parts of the
structure only (selected levels, selected frames etc.) To do this, see: Filter
tabular data (page 811)

See also:

• Steel material lists (page 786)

Review models 784 Review tabular data



• Concrete material lists (page 792)

• Timber material lists (page 803)

• Cold formed material lists (page 805)

• General material lists (page 806)

Locate material list rows in a 3D view
Double-clicking on a specific row in the material list tabular data view locates
where the row content is in the model by highlighting it in a 3D view.

TIP Make use of the “ghost unselected” feature to make highlighted entities
clearer.
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Export material list to Excel
1. Create the material list and ensure that it contains the necessary

information.

2. On the Review Data ribbon tab, click Excel.

3. Click Yes to confirm exporting the report. 

The material list opens in Excel

Material lists for steel

TIP When viewing a Material List tabular data view, clicking a column header sorts
the table by that column.

Beams

NOTE • Summary reports provide quantities for each section size

• Detailed reports provide quantities for each section size of a given length

• Composite beam reports also include the number of connectors, the
transverse reinforcement associated with the beam (at detailed level only),
and the weight of reinforcement

Construction Fabrication Content View Type Description
Composite • Rolled

• Plated

• Westok
Plated

• Fabsec
Plated

• DELTABEA
M

Members Summary One row for
each size:

size, grade,
number (of
that size), no.
of connectors,
total length,
mass, surface
area,
reinforcement

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length), no. of
connectors,
length, mass,
surface area,
reinforcement
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Construction Fabrication Content View Type Description
Loose Bars Detailed One row for

each type:

type, unit
mass, total
length, total
mass

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass

Westok
Cellular

Members Summary One row for
each size:

size, grade,
number (of
that size), no.
of connectors,
total length,
gross mass,
net mass,
gross surface
area, net
surface area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length), no. of
connectors,
length, gross
mass, net
mass, gross
surface area,
net surface
area

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass
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Construction Fabrication Content View Type Description
Mesh Mesh One row for

each type:

type, unit
mass, total
area, total
mass

Non-
composite

• Rolled

• Plated

• Westok
Plated

• Fabsec
Plated

• DELTABEA
M

Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
mass, surface
area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length),
length, mass,
surface area

Westok
Cellular

Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
gross mass,
net mass,
gross surface
area, net
surface area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length),
length, gross
mass, net
mass, gross
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Construction Fabrication Content View Type Description
surface area,
net surface
area

Columns, Braces, Joists

NOTE • Summary reports provide quantities for each section size

• Detailed reports provide quantities for each section size of a given length

Characteristi
c

Fabrication Content View Type Description

Columns • Rolled

• Plated

Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
mass, surface
area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length),
length, mass,
surface area

• Concrete
Filled

• Concrete
Encased

Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
mass, surface
area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
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Characteristi
c

Fabrication Content View Type Description

length),
length, mass

Encase/Fill Detailed One row for
each size:

size, grade,
number (of
that size),
length, mass

Braces Rolled Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
mass, surface
area

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length),
length, mass,
surface area

Joists N/A Members Summary One row for
each size:

size, grade,
number (of
that size),
total length,
mass

Detailed One row for
each size &
length:

size, grade,
number (of
that size &
length),
length, mass
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Slabs/Mats

NOTE • Summary reports provide totals for the entire slab

• Detailed reports are given on a slab item basis

Characteristic Content View Type Description
Slabs/Mats Members Summary One row for each

slab:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume

Detailed One row for each
slab item:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume

Piles

Characteristic Content View Type Description
Piles Members Detailed One row for each

pile type:

reference,
dimension, shape,
installation type,
installation length,
number, total
length

Portal Frames

Characteristic Content View Type
Portal Frames Members Detailed

Trusses

Characteristic Content View Type
Trusses Members Detailed
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Material lists for concrete

TIP When viewing a Material List tabular data view, clicking a column header sorts
the table by that column. This can be useful for example when wanting to sort
members by how much reinforcement they contain.

Beams and Columns

NOTE • Summary reports provide total quantities for each section size

• Detailed reports provide quantities on a span/stack basis

• When group design is active this reduces to every detailing group
span/stack

• Reinforcement running between spans/stacks is shared

• No additional detailing allowance has been applied

• Reinforcement quantities are given in terms of weight and weight/unit
volume

Characteristi
c

Fabrication Content View Type Description

Beams Cast-in-place Members Summary One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
mass, surface
area, volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Detailed One row for
each span:

Group/
Member ref.,
section
geometry,
size, grade,
number (of
that ref),
length, mass,
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Characteristi
c

Fabrication Content View Type Description

surface area,
volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass

Precast Members Summary One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
mass, surface
area, volume

Detailed One row for
each span:

Member
reference,
section
geometry,
size, grade,
number,
length, mass,
surface area,
volume
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Characteristi
c

Fabrication Content View Type Description

Post-
tensioned

Members Summary One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
mass, surface
area, volume

Detailed One row for
each span:

Member
reference,
section
geometry,
size, grade,
number,
length, mass,
surface area,
volume

Columns Cast-in-place Members Summary One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
mass, surface
area, volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Detailed One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
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Characteristi
c

Fabrication Content View Type Description

mass, surface
area, volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass

Precast Members Summary One row for
each size:

section
geometry,
size, grade,
number (of
that size),
total length,
mass, surface
area, volume

Detailed One row for
each stack:

Member
reference,
section
geometry,
size, grade,
number,
length, mass,
surface area,
volume
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Walls

NOTE • Summary reports provide total quantities for each wall

• Detailed reports provide quantities on a wall panel basis

• Reinforcement running between panels is shared

• No additional detailing allowance has been applied

• Reinforcement quantities are given in terms of weight and weight/unit
volume

Characteristi
c

Fabrication Content View Type Description

Walls Cast-in-place Members Summary One row for
each wall:

reference,
gross mass,
mass, gross
surface area,
surface area,
volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Detailed One row for
each panel:

Member
reference,
gross mass,
mass, gross
surface area,
surface area,
volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass
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Characteristi
c

Fabrication Content View Type Description

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass

Precast Members Summary One row for
each wall:

reference,
gross mass,
mass, gross
surface area,
surface area,
volume

Detailed One row for
each panel:

Member
reference,
gross mass,
mass, gross
surface area,
surface area,
volume

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass

Slabs/Mats

NOTE • Summary reports provide totals for the entire slab

• Detailed reports are given on a slab item basis
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• Patch and punching reinforcement is approximately distributed by sharing
it equally between slab items it touches - it is not split based on covered
areas

• Reinforcement allows for laps at the slab item boundary

• An approximate user defined additional detailing allowance (specified in
Design Settings for cast-in-place slabs) is applied to all reinforcement
defined in any slab type.

• Punching reinforcement weight is approximated (based on ACI guidance)

• Precast and post-tensioned slabs are not designed, but the reinforcement
that is specified in the slab properties is reported. The post-tensioned
tendon information is not reported and must be allowed for in some
other way.

Construction Fabrication Content View Type Description
Composite N/A Members Summary One row for

each slab:

level, slab,
depth,
manufacturer,
reference,
gauge, grade,
mass, gross
surface area,
net surface
area, volume,
reinforcement

Detailed One row for
each slab
item:

level, slab,
depth,
manufacturer,
reference,
gauge, grade,
mass, gross
surface area,
net surface
area, volume,
reinforcement

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
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Construction Fabrication Content View Type Description
mass inc.
allowance

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass inc.
allowance

Non-
composite

Cast-in-place Members Summary One row for
each slab:

level, slab,
type, depth,
grade, mass,
gross surface
area, net
surface area,
volume,
reinforcement
, punching
reinforcement
, total
reinforcement
(mass), total
reinforcement
(mass/unit
area), total
reinforcement
(mass/ unit
volume)

Detailed One row for
each slab
item:

level, slab,
type, depth,
grade, mass,
gross surface
area, net
surface area,
volume,
reinforcement
, punching
reinforcement
, total
reinforcement
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Construction Fabrication Content View Type Description
(mass), total
reinforcement
(mass/unit
area), total
reinforcement
(mass/ unit
volume)

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass inc.
allowance

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass inc.
allowance

Precast Members Summary One row for
each slab:

level, slab,
depth,
manufacturer,
reference,
unit depth,
topping,
grade, mass,
gross surface
area, net
surface area,
volume,
reinforcement

Detailed One row for
each slab
item:

level, slab,
depth,
manufacturer,
reference,
unit depth,
topping,
grade, mass,
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Construction Fabrication Content View Type Description
gross surface
area, net
surface area,
volume,
reinforcement

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass inc.
allowance

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass inc.
allowance

Post
Tensioned

Members Summary One row for
each slab:

level, slab,
type, depth,
grade, mass,
gross surface
area, net
surface area,
volume,
reinforcement
, punching
reinforcement
, total
reinforcement
(mass), total
reinforcement
(mass/unit
area), total
reinforcement
(mass/ unit
volume)

Detailed One row for
each slab
item:

level, slab,
type, depth,
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Construction Fabrication Content View Type Description
grade, mass,
gross surface
area, net
surface area,
volume,
reinforcement
, punching
reinforcement
, total
reinforcement
(mass), total
reinforcement
(mass/unit
area), total
reinforcement
(mass/ unit
volume)

Loose Bars Detailed One row for
each type:

type, unit
mass, total
length, total
mass inc.
allowance

Mesh Detailed One row for
each type:

type, unit
mass, total
area, total
mass inc.
allowance

Punching checks

NOTE The weight of punching shear rails is approximated based on ACI guidance.

Content View Type Description
Stud Rails Detailed One row for each rail ref:

ref., diameter,stud
height, studs per rail,
stud spacing, rail length,
total no. of rails, approx.
mass
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Pad Bases, Pile Caps and Piles

NOTE • Reports provide quantities for each individual base

• Reinforcement quantities are given in terms of weight and weight/unit
volume

Characteristic Content View Type Description
• Pad Bases

• Pile Caps

Members Detailed One row for each
base:

member
reference, grade,
mass, surface
area, volume,
reinforcement
(mass),
reinforcement
(mass/unit
volume)

Loose Bars Detailed One row for each
type:

type, unit mass,
total length, total
mass

Mesh Detailed One row for each
type:

type, unit mass,
total area, total
mass

Piles Members Detailed One row for each
pile type:

reference,
dimension, shape,
installation type,
installation length,
number, total
length

Material lists for timber

TIP When viewing a Material List tabular data view, clicking a column header sorts
the table by that column.
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Beams, Columns, Braces

NOTE • Summary reports provide quantities for each section size

• Detailed reports provide quantities for each section size of a given length

Characteristic View Type Description
• Beams

• Columns

• Braces

Summary One row for each size:

size, grade, number (of
that size), total length,
mass

Detailed One row for each size &
length:

size, grade, number (of
that size & length),
length, mass

Slabs/Mats

NOTE • Summary reports provide totals for the entire slab

• Detailed reports are given on a slab item basis

Characteristic Content View Type Description
Slabs/Mats Members Summary One row for each

slab:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume

Detailed One row for each
slab item:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume
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Piles

Characteristic Content View Type Description
Piles Members Detailed One row for each

pile type:

reference,
dimension, shape,
installation type,
installation length,
number, total
length

Trusses

Characteristic Content View Type
Trusses Members Detailed

Material lists for cold formed

TIP When viewing a Material List tabular data view, clicking a column header sorts
the table by that column.

Beams, Columns, Braces

Characteristic Content View Type Description
• Beams

• Columns

• Braces

Members Summary One row for each
size:

size, grade,
number (of that
size), total length,
mass, surface
area

Detailed One row for each
size & length:

size, grade,
number (of that
size & length),
length, mass,
surface area
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Piles

Characteristic Content View Type Description
Piles Members Detailed One row for each

pile type:

reference,
dimension, shape,
installation type,
installation length,
number, total
length

Trusses

Characteristic Content View Type
Trusses Members Detailed

Material lists for general materials

TIP When viewing a Material List tabular data view, clicking a column header sorts
the table by that column.

Beams, Columns, Braces

NOTE • Summary reports provide quantities for each section size

• Detailed reports provide quantities for each section size of a given length

Characteristic Content View Type Description
• Beams

• Columns

• Braces

Members Summary One row for each
size:

size, grade,
number (of that
size), total length,
mass, surface
area

Detailed One row for each
size & length:

size, grade,
number (of that
size & length),
length, mass,
surface area
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Walls

Characteristic Content View Type Description
Walls Members Summary One row for each

wall:

reference, gross
mass, mass, gross
surface area,
surface area,
volume

Detailed One row for each
wall:

reference, gross
mass, mass, gross
surface area,
surface area,
volume

Slabs/Mats

NOTE • Summary reports provide totals for the entire slab

• Detailed reports are given on a slab item basis

Characteristic Content View Type  
Slabs/Mats Members Summary One row for each

slab:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume

Detailed One row for each
slab item:

level, slab, depth,
grade, mass,
gross surface
area, net surface
area, volume
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Piles

Characteristic Content View Type Description
Piles Members Detailed One row for each

pile type:

reference,
dimension, shape,
installation type,
installation length,
number, total
length

Review embodied carbon detail
Embodied carbon can be reviewed in depth by creating an Embodied Carbon
Detail tabular data view.

Embodied Carbon Detail tabular data views:

• are displayed for one construction type at a time according to the material,
characteristic, construction and fabrication type selected in the ribbon

• display a single row listing the total embodied carbon mass per member
reference when Summary Only is selected

• display separate rows listing the quantities, units, carbon factors, and
embodied carbon masses for each material that comprises the member
reference when Summary Only is unselected

• can have filters applied (page 811)

• are linked to the 3D view: double-clicking a row in the table locates the row
entities in the 3D view

• can be exported to a spreadsheet (page 811)

• are not suitable for direct printing, (but could be printed if exported to a
spreadsheet).

NOTE The embodied carbon mass totals are also included in the Review material list
tabular results (page 782).

Create embodied carbon detail tabular results
To display an embodied carbon detail as tabular data:

1. Open a view and change the view regime (page 89) to Review View.

2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.
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3. On the Review Data ribbon, in the list in the View Type group, select
Embodied Carbon Detail

4. Choose the construction type by selecting the required material,
characteristic, construction and fabrication type from the ribbon.

5. Choose if you want summary or detailed results:

• To display summary only, in the View Type group, select Summary
Only.

• To display more detailed results, unselect Summary Only.

The results are displayed as specified.

If required you can configure a filter to limit the display to selected levels,
frames etc. To do this, see: Filter tabular data (page 811)

Locate tabular data in a 3D view
Double-clicking on a specific row in the tabular data view locates where the
row content is in the model by highlighting it in a 3D view.

TIP Make use of the “ghost unselected” feature to make highlighted entities
clearer.

Review embodied carbon overview
Embodied carbon can be reviewed in summary form by creating an Embodied
Carbon Overview tabular data view.

Embodied Carbon Overview tabular data views:

• are reported for each plane when Group by Plane is selected, or each
construction type when unselected

• are either displayed for the whole model, or according to the materials,
characteristics, construction and fabrication types selected in the ribbon

• can have filters applied (page 811) ( selected UDAs, frames, or groups)

• are linked to the 3D view: double-clicking a row in the table locates the row
entities in the 3D view

• can be exported to a spreadsheet (page 811)

• are not suitable for direct printing, but the data can be included in an
Embodied Carbon report (page 842) which can then be printed.

Create embodied carbon overview tabular results
To display an embodied carbon overview as tabular data:

1. Open a view and change the view regime (page 89) to Review View.
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2. On the Review ribbon, click Tabular Data 

A Review Data tab is added to the ribbon and a Review Data View opens
in a new window.

3. On the Review Data ribbon, in the list in the View Type group, select
Embodied Carbon Overview

4. Choose if you want results displayed for all available material and
member types, or a subset only:

• To display results for all available material and member types, in the 
View Type group, click Toggle Selection so that all construction types
are selected.

• To display results for a subset of construction types proceed as
follows:

a. In the Material Type group, select the material(s).

b. In the Characteristic group, select the required characteristic(s).

c. In the Fabrication group, select the fabrication type(s).

5. Choose if you want results reported by plane, or by construction type:

• For the former, in the View Type group, select Group by Plane.

• For the latter, unselect Group by Plane.

The Embodied Carbon Overview is displayed as specified.

Locate tabular data in a 3D view
Double-clicking on a specific row in the tabular data view locates where the
row content is in the model by highlighting it in a 3D view.

TIP Make use of the “ghost unselected” feature to make highlighted entities
clearer.

Review floored area tabular results
To create a tabular floored area summary:

1. If necessary, change the view regime (page 89) to a Review View.

2. On the Review ribbon tab, click Tabular Data. 

A Review Data tab opens on the ribbon and a Review Data View is
displayed.

3. On the Review Data ribbon tab, in the list in the View Type group, select
Floored Area.

A table of floored areas is displayed.
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Filter tabular data
You can apply model filters to enable selective display of tabular data. The
filters available depend on the view type displayed.

Create and apply filters
1. In the Filters group of the Review Data tab, select the desired filter type. 

The Select filter items list opens.

2. In the Select filter items list, select the necessary options to define the
filter requirements.

3. Click OK. 

Tekla Structural Designer applies the filter.

Edit filters

NOTE If a filter type is not applicable for the current tabular data view type, it
will be unavailable.

1. On the Review Data tab, click either Filter Items... 

The Select filter items list opens.

2. In the Select filter items list, select the necessary options to define the
filter requirements.

3. Click OK. 

Tekla Structural Designer applies the filter.

Export tabular results to Excel
1. Create the tabular data view and ensure that it contains the necessary

information.

2. On the Review Data ribbon tab, click Excel.

3. Click Yes to confirm exporting the report. 

The tabular data opens in Excel
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10 Calculate slab deflections

In Tekla Structural Designer you can choose to adopt a rigorous approach to
slab deflection calculation using iterative cracked section analysis.

NOTE Tekla Structural Designer's iterative cracked section analysis for slab
deflections is only available for the Eurocode and ACI/AISC Head Code.

• To begin, see Get started with slab deflection analysis (page 812)

• To define event sequences in Tekla Structural Designer, see Work with
event sequences (page 813).

• To set up the deflection checks and place check lines, see Work with check
lines (page 815).

• To perform the analysis, see Run a slab deflection analysis (page 817)

• To investigate the results, see Slab deflection results and reports
(page 818).

Related video

Rigorous Slab Deflection Design (ACI)

Rigorous Slab Deflection (Eurocode)

10.1 Get started with slab deflection analysis
Two different ways of checking slab deflections in Tekla Structural Designer
are available. Either deemed-to-satisfy checks, or a rigorous theoretical
deflection estimation. These are introduced in the topic .

If you decide to adopt the latter approach the video links at the bottom of this
page are a good start point, and the topic also provides an overview of the
steps required.

Many topics are then discussed in more detail in the , which also provides
Tutorial worked examples for you to download and work through.
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Related video

Rigorous Slab Deflection Design (ACI)

Rigorous Slab Deflection (Eurocode)

10.2 Work with event sequences
Event sequences are edited in the (page 1194).

Add an event to the end of the event sequence
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page.

3. Click Add to Add the Event as the last event in the sequence.

4. Name the new event and specify the event parameters according to your
needs. If you want the same parameters to apply to custom events,
ensure the Update custom event sequences box is selected.

5. Click OK.

Insert an event within the event sequence
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page.

3. Select the event above which you want to insert the new event.

4. Click Insert to insert the event.

5. Name the new event and specify the event parameters according to your
needs. If you want the same parameters to apply to custom events,
ensure the Update custom event sequences box is selected.

6. Click OK.

Re-order events in the event sequence
You can Add, Insert, Remove and Re-Order Events from the Model Event
Sequence page.
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1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page.

3. In the Drawing Variant list, select the Event you want to move.

4. ClickMove Up or Move Down until the Event is in the required position.

5. Click OK.

Remove an event from the event sequence
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page.

3. Select the event which you want to remove.

4. Click Remove to remove the event.

5. Click OK.

Edit event parameters
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page, or specific custom event sub
page as required.

3. Edit the event parameters according to your needs. If editing the Model
Event Sequence and you want the same parameters to apply to custom
events, ensure the Update custom event sequences box is selected.

4. Click OK.

Edit event loadcases
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Model Event Sequence sub page, or specific custom event sub
page as required.

3. In the left hand pane, expand the Event Sequence if required so that you
can select the Event. 

The available and included loadcases are displayed.
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4. Move loadcases between the available and included lists as required. If
editing the Model Event Sequence and you want the same loadcases to
apply to custom events, ensure the Update custom event sequences
box is selected.

5. Click OK.

Create a custom event sequence
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Event Sequences sub page.

3. Click Add to add a new Custom Event.

4. In the right hand pane click on the event name to rename it.

5. In the left hand pane click on the event name in order to define the event
parameters in the sequence.

6. Click OK.

Apply a custom event sequence to a submodel
1. On the Slab Deflection tab, click Event Sequences 

The Load Event Sequences dialog box opens.

2. Go to the Submodels sub page. 

The table displays the event sequence assigned to each submodel.

3. Use the droplist to change the Event Sequence assigned to a specific
submodel as required.

4. Click OK.

10.3 Work with check lines
User defined Check Lines can be placed across 2D element meshes, They are
similar to 2D results strips, (but with zero width and different properties).

From these check lines, deflection results are determined from the shell/plate/
membrane nodal analysis results - these can then be checked against
specified limits for slab design purposes.

Engineering judgment is required when positioning the check lines to ensure
worst case deflections are obtained.
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Create the deflection checks to be applied to check lines
1. On the Slab Deflection tab, click Deflection Checks 

The Slab Deflection Check Catalogue (page 1211) is displayed, containing
any checks that have been defined.

2. Click Add 

A new check is created in the table.

3. Select the name in order to give it a more descriptive title.

4. Choose the check Type: (Total, Instantaneous, or Differential).

a. If the Type is Differential, select the Start Event from the droplist.

5. Select the Event to check from the droplist.

6. Enter the Deflection Limit to be checked.

7. Select Use in new Check Lines if you want this check to be performed in
each check line that is created.

Create a check line
Check lines can only be created while in the Slab Deflections View regime.

1. Open a 2D view of the FE mesh where the check line is to be placed.

2. On the Slab Deflection tab, click Create 

The Check Line properties are displayed in the Properties window.

3. Adjust the properties to specify:

a. The number of stations

b. The upper and lower Flat Zone Reductions

c. Up to 6 deflection checks to be performed (these can either be
selected from the predefined Deflection Checks Catalogue, or a new
check can be defined)

4. Click a point where the strip is to start.

5. Click a 2nd point where the strip is to end. (Neither start or end points
have to match nodes in the mesh.) 

A check line is created between the points that you identified.

6. Either continue to place further check lines, or if done, press Esc to exit.

Delete a check line
To be able to delete a check line you must first ensure that Slab Deflection
Check Lines are switched on in Scene Content.
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1. Open a view displaying the check lines to be deleted.

2. Click or press Delete

3. Click on the check lines to be deleted.

10.4 Run a slab deflection analysis
The same basic analysis process is followed irrespective of whether the
current level (sub-model), a selected level, or all slabs in the model are
analyzed.

In simple terms, events are considered in sequence.

For each event:

• An iterative cracked section analysis including long term effects determines
the deflection at the end of the event.

• An additional analysis using the determined state of cracking along with
short term cracked properties is undertaken to calculate the total
instantaneous deflection associated with the event.

• The state of cracking is carried forward to the next event as the starting
point.

To run the analysis for specific or all sub models see the following instructions.

Run a slab deflection analysis for the current sub model
To analyze a specific sub model:

1. Open a view of the required sub model from the Structure Tree in the
Project Workspace.

2. On the Slab Deflection tab, click Analyze Current At the end of the
analysis the active sub model view switches into a Slab Deflections View
regime and the Results group is available on the ribbon - ready for
reviewing the results graphically.

Run a slab deflection analysis for all sub models
To analyze all sub models:

1. On the Slab Deflection tab, click Analyze All At the end of the analysis
the active view switches into a Slab Deflections View regime and the
Results group is available on the ribbon - ready for reviewing the results
graphically.
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Run a slab deflection analysis for selected sub models
To analyze selected sub models:

1. On the Slab Deflection tab, click Analyze Selected At the end of the
analysis the active view switches into a Slab Deflections View regime and
the Results group is available on the ribbon - ready for reviewing the
results graphically.

10.5 Slab deflection results and reports
Click the links below to find out more:

• Display slab deflection analysis results (page 818)

• Display check line results (page 820)

• Display slab deflection status and utilization (page 821)

• Slab deflection optimization (page 823)

• Slab Deflection Reports

• Slab Reinforcement (page 720)

Display slab deflection analysis results
Once a slab deflection analysis has been performed analysis results can be
reviewed for the chosen level (sub-model), or the entire structure - dependent
upon your chosen analysis.

The following results are available for display in the Slab Deflections View
regime by making appropriate selections from the Results group of the Slab
Deflection ribbon.

• Deflections.

• Extent of Cracking at any load event.

• Relative Stiffness in a particular result direction for any specified event.

• Effective Reinforcement for a chosen result direction for each FE
element.

Display deflection contours
Three deflection types are available for review:

• Total deflection at the end of any event.
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• Differential deflection between any two events (Start of Event and End of
Event).

For further details, see:

• Instantaneous deflection (not actually needed for TR 58).

• This is the deflection when the entire event loading is applied to a
version of the model using the established extent of cracking along with
short term analysis properties.

• US codes require an assessment of the instantaneous deflection
associated with the imposed load only. This is achieved by adding extra
events at the same time as the final event where only the required
imposed load is applied.

To display deflection contours:

1. From the Slab Deflection ribbon Results group Result list select
Deflections

2. Then from the same group:

a. Make your selection from the Result Direction list

b. Make your selection (Instantaneous, Total, or Differential) from the 
Result Type list

3. From the Results group select the Event, and if viewing differential
deflections also select the Start Event. 

NOTE Hover the cursor over a specific solver node in order to see the
nodal displacement at that location displayed in a tooltip.

Display extent of cracking
1. From the Slab Deflection ribbon Results group Result list select Extent

of Cracking

2. Make your selection from the Result Direction list

3. From the Results group select the Event. 

NOTE Hover the cursor over a specific solver element in order to see the
detailed cracking calculation parameters for that element
displayed in a tooltip.

Display relative stiffness
1. From the Slab Deflection ribbon Results group Result list select Relative

Stiffness

2. Make your selection from the Result Direction list
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3. From the Results group select the Event. 

NOTE Hover the cursor over a specific solver element in order to see the
detailed relative stiffness calculation parameters for that element
displayed in a tooltip.

Display effective reinforcement
1. From the Slab Deflection ribbon Results group Result list select

Effective Reinforcement

2. Make your selection from the Result Direction list 

NOTE Hover the cursor over a specific solver element in order to see the
detailed effective reinforcement calculation parameters for that
element displayed in a tooltip.

Display check line results
Once a slab deflection analysis has been performed, the Check Line results are
available for display in the Slab Deflections View regime.

Display deflections along all check lines
1. From the Slab Deflection ribbon Check Lines group click Deflections 

The deflected shape of each check line and an accompanying legend is
displayed in the current view.

For clarity you may want to switch off other results to obtain a clearer
view.

Display detailed deflections and average slopes along an individual
check Line
1. Right click on the check line you want to view and select Open deflections

check view from the context menu that is displayed.

2. Select the Result Type and the Event from the Loading Analysis toolbar. 

The deflections and average slopes are displayed in a deflections view.
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Display check line status and utilization
Every check line can have up to six different deflection checks assigned to it for
different events. Every check line will therefore have a Pass/Fail status and a
critical Utilization ratio

Once check lines are set up and any re-analysis is undertaken i.e. due to
optimization of a slab design, adding reinforcement etc. then the check lines
are automatically re-checked so you will obtain instant feedback on status and
utilization.

To view check line status or utilization:

1. From the Slab Deflection ribbon Check Lines group

• Click Status

• Click Utilization

Color codes are used to graphically display the status or utilization of each
Check Line.

Display slab deflection status and utilization
Once a slab deflection analysis has been performed, the Slab deflection status
and utilization are available for display in the Slab Deflections View regime.

Display slab deflection status
1. From the Slab Deflection ribbon Slab Deflection group click Status 

Color codes are used to graphically display the status of each slab item.
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In the screenshot below;

• No check lines cross the slab items between C-D / 2-3 and C-E / 3-4 so the
slab reports Unknown as no checks have been performed

• One passing check line crosses the slabs between C-E / 4-5 so the slab
reports a Pass.

• A fail at any point in a check line causes the status of every slab item
crossed by the check line to report as a Fail. Hence, all other slab items Fail.

Display slab deflection utilization
1. From the Slab Deflection ribbon Slab Deflection group click Utilization 

Color codes are used to graphically display the utilization of each slab
item.
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The worst utilization from all associated check lines is displayed.

Slab deflection optimization
If you find that a slab either fails deflection checks (or passes with a low
utilization) then changes will need to be made. There are many areas where
adjustments can be made.

• Adjust slab/panel depths?

• Adjust reinforcement?

• Re-consider the Event timings and loadings?

• Adjust other settings?

Any or all changes are possible.

When changes are necessary we would recommend that it will be more
efficient to work on one level at a time. The automatic re-checking of check
lines will help considerably with this optimization.

View slab deflection reports
A Slab Deflection Check Lines report can be generated for multiple check lines
from the Reports toolbar. The same report can also be generated for
individual check lines from the right click menu.
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View an individual check line report
1. Right click on the check line you want the report for and select Report for

Member from the context menu that is displayed. 

A report is displayed consisting of a defection check summary table.

NOTE Optionally the report can be configured to include a picture
showing the Check Line location within the slab, (by clicking
Member Report on the Reports ribbon and choosing the Slab
Deflection Check Line as the Member Type.)

View all/multiple check line reports
1. From the Report tab click Model Report... 

A report is displayed consisting of a defection check summary table.

2. Create a report that includes the Slab Deflection Check Lines chapter
(located under Concrete>Slab/Mat Design per Plane).

3. Apply Model filters to the report as required.

View an effective modulus report
A slab Effective Modulus Report can be exported to Excel for an individual slab
panel, or all panels.

1. Right click on a slab panel and select Export Eff. Modulus Report to
Excel from the context menu that is displayed.

2. Choose whether to export for the current slab item, or all slab items from
the sub menu that is displayed. 

The report opens in Excel, (assuming Excel is installed).
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11 Create reports and drawings

Having designed your model in Tekla Structural Designer you can then output
the results in the form of reports and/or drawings.

11.1 Create and modify reports
You can tailor a wide range of different reports according to your needs by
using the Report toolbar.

NOTE Initially, only the Contents group and Filters group are displayed on
the Report toolbar. Only when a report is displayed and the Report
View is active, do the Appearance group, Navigation group, and
Export group become available.

Report terminology
The following terms are used to described specific aspects of the report
creation process in Tekla Structural Designer.

Model reports
Model reports are used to set up the printed output for either the entire
structure or a part of it. Model reports are configured by selecting specific
output categories (referred to as chapters) in a list of all the available output
categories. You can include entire chapters, or just the headings within the
chapter you require.

The combination of selected chapters is referred to as the report structure. If
necessary, you can apply filters to individual headings in the report structure
to limit the output that is produced.

Model report chapters include:
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• Structure:

Structure data (under headings such as Loadcases or Wind Data).

• Analysis:

Analysis model properties and results

• Concrete, Steel, Timber, Cold Formed, Cold Rolled, and General Material:

Member reports for each different member types. Each member report
can be configured to contain as much or as little output as needed. You can
also decide to include design summary tables for the members that Tekla
Structural Designer can design.

• Beam End Forces, Bracing Forces, and Foundation Reactions:

Chapters for specific sets of analysis results.

• Picture:

A 3D view of the entire structure. Applying model filters also allows you to
view a picture of selected sub structures, frames, or levels. If necessary,
you can also include applied loads in the picture by applying a load filter.

• View:

The current display in any 2D or 3D view can be saved as a view
configuration, and then, included in the model report as a View chapter.

• Analysis Diagram:

A 3D diagram of the entire structure. Applying model filters also allows you
to view a picture of selected sub structures, frames, or levels. If necessary,
you can also display the analysis results by applying an analysis method
filter.

• Material Listing:

Tabulated quantities of materials.

• Revision History:

The revision history that has been recorded in the Project Wiki.

Member reports
Member reports are only output as part of a created model report or by right-
clicking on an individual member and selecting Report for Member.

Member report chapters include:

• Picture:

The 3D view that you receive by right-clicking a member and selecting
Open [element name] view.

• Drawing:

The DXF file that you receive by right-clicking a member and selecting
Generate Detailing Drawing...
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• Loading:

The table that you receive by right-clicking a member and selecting Show
Member Loading.

• Different force diagrams and Deflected Shape Diagram:

The diagrams that you receive by right-clicking a member and selecting
Open Load Analysis View.

Active model report
The active model report is the default report displayed in the list on the left
corner of the Report toolbar, unless another report view is already active.

To specify the active model report, do the following:

1. On the Report tab, click Model Report...

The Report Contents dialog box opens.

2. In the Available Styles list, select the desired report.

3. Click >> Active.

Active member report
The active member report is the report that is generated when you right-click
a member in a 2D or 3D view and select Report for Member.

To specify the active model report, do the following:

1. On the Report tab, click Member Report...

The Report Contents dialog box opens.

2. In the Available Styles list, select the desired report.

3. Click >> Active.

Active and inactive chapters
In the Report Contents dialog box, each chapter in the report structure is
marked as either active or inactive. Only the chapters that are marked as active
are included in the report that you generate.

Report filters
You can use filters to limit the amount of output in the report.

Tekla Structural Designer offers the following filters for different data types:

• Model filters:

If necessary, you can filter the report for selected levels, frames, or planes.
You can also filter certain data types for selected beams, columns, or walls.
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If you have applied user-defined attributes to your model, you can also use
them to filter the report output.

• Loading filters:

If necessary, you can filter the report for selected loadcases and
combinations.

Available styles
A number of sample reports are available in the Available Styles list of the
Report Contents dialog box. The reports serve as templates and can be
modified to suit the model in question. If you cannot find a report that can be
customized to meet your needs, you can add further reports to the list by
clicking Add.

If you start a new project, the same default reports are available. However,
they are reset to the default report structures. It is not currently possible to
save customized reports from the Report Contents dialog box to apply them
to other projects.

Create reports
Tekla Structural Designer allows you to create two kinds of reports: you can
either create a report based on the entire model or an individual member in
the model.

Configure and display model reports
To create model reports and display them, see the following instructions.

Configure a model report

1. On the Report tab, click Model Report... 

The Report Contents dialog box opens.

2. Select the report:

• To select an existing report, click the report name in the Available
Styles list.

• To add a report, click Add and type the report name in the Active
Style field.

3. Review the report structure and modify it (page 831) according to your
needs.

4. To limit the output to selected levels, frames, planes, or sub structures,
apply a model filter (page 832). 
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TIP You can further limit the output of Loadcases and Combinations
sub chapters by applying a loading filter (page 832).

5. If you have created specific view configurations for the model and want to
include them in the report, include a separate View chapter for each view
configuration.

6. If the report structure includes any member chapters (such as beams,
columns, or walls), select an appropriate member report style for each
member chapter.

7. Click OK. 

NOTE If you have included a drawing in the report structure, specify
appropriate settings for the drawing as follows:

a. Right-click the drawing in the report structure.

b. Click Settings...

c. Define the drawing settings according to your needs.

d. Click OK.

Display a model report

1. In the list on the far left of the Report tab, select the report that you want
to view.

2. On the Report tab, click Show Report. 

Tekla Structural Designer displays the report in a new window. If the
report contains loading analysis views of individual members (such as
force diagrams or pictures), the views are displayed for each member type
according to the selected member report style.

See also

Export reports (page 838)

Print reports (page 838)

Format reports (page 833)

Configure and display member reports
To create member reports, see the following instructions.

Configure a member report

1. On the Report tab, click Member Report... 

The Report Contents dialog box opens.

2. In the Member Type list, select the desired member.
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3. Select the report:

• To select an existing report, click the report name in the Available
Styles list.

• To add a report, click Add and type the report name in the Active
Style field.

4. Review the report structure and modify it (page 831) according to your
needs.

5. To control the level of output, modify the report structure (page 834) or
loading filters according to your needs.

6. Click OK. 

NOTE If you have included a drawing in the report structure, specify
appropriate settings for the drawing as follows:

a. Right-click the drawing in the report structure.

b. Click Settings...

c. Define the drawing settings according to your needs.

d. Click OK.

Display a member report

1. Ensure that you have selected and activated the member report style
(page 830).

2. Hover the mouse pointer over the desired member.

3. Once the outline of the member is high-lighted, right-click the member.

4. In the context menu, select Report for Member. 

Tekla Structural Designer opens a report for the selected member in a
new window.

See also

Format reports (page 833)

Export reports (page 838)

Select the member report style
Different member report styles produce different levels and types of output
both in model reports and member reports. To select the member report
style, see the following instructions.
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Select the member report style used in a model report

1. On the Report tab, click Model Report... 

The Report Contents dialog box opens.

2. Select the desired report type.

3. Right-click the member chapter in the report structure.

4. In the context-menu, go to Style.

5. Click the desired member report style.

Select the member report style used in an individual member report

1. On the Report tab, click Member Report... 

The Report Contents dialog box opens.

2. In the Member Type list, select the desired member.

3. In the Available Styles list, select the desired member report style.

4. Click >> Active.

See also

Configure and display member reports (page 829)

Configure and display model reports (page 828)

Format reports (page 833)

Export reports (page 838)

Modify the report structure
Once you have selected the report type, you can modify the report structure
according to your needs. For more information, see the following instructions.

To aid the report structuring process, an option is provided to display the
structure as either a Flat, or a Hierarchical layout.

1. According to your needs, click either Model Report... or Member
Report... 

The Report Contents dialog box opens.

2. In the Report Contents dialog box, do one or more of the following:

• To include chapters and options in the report, drag them from the left
column to the right column.

• To remove unwanted chapters and options permanently from the
report, drag them from the right column to the left column.

• To exclude a specific chapter from the report but maintain the current
report structure, right-click the chapter and clear the Active option.
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• To re-arrange the report order, drag and drop chapters within the right
column.

• To apply a filter to a chapter, right-click the desired chapter. For more
information, see Filter reports (page 832).

TIP In View Mode, you can select if you want to display the structure as
flat or hierarchical.

3. Click OK.

See also

Configure and display member reports (page 829)

Filter reports
Tekla Structural Designer contains two main categories of filters that you can
apply to chapters in the report structure. The categories are model filters and
loading filters. For more information, see the following paragraphs.

You can apply model filters to enable selective output based on selected:

• Levels

• Frames

• Planes

• Groups

• Members

• Trusses

• Portal frames

• UDAs

Using loading filters enables selective output based on selected:

• Loadcases

• Combinations

• Envelopes

See also

Configure and display model reports (page 828)

Create filters
1. In the Filters group of the Report tab, select the desired filter type. 

The Edit filters dialog box opens.
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2. Click Add.

3. Type a name for the new filter.

4. In the Selected items list, select the necessary options to define the filter
requirements.

5. Click OK. 

Tekla Structural Designer creates the filter. You can now apply the filter to
a specific report.

TIP If you create a member filter, you can later review and modify it
graphically by clicking Report Filter on the Review tab.

Apply filters

NOTE If a filter type is not applicable for the selected chapter, it will be
unavailable.

1. On the Report tab, click either Model Report... or Member Report... 

The Report Contents dialog box opens.

2. Select the report that you want to filter. 

In the right column, any chapters that can be filtered are displayed in blue
text.

3. Right-click a chapter.

4. In the context menu, select the desired filter type and filter name. 

TIP If you cannot find an appropriate filter, do the following:

a. In the context menu, go to the filter type and click Edit\New...

b. In the Select filter dialog box, click Add.

c. Type the name of the filter in the Active filter field.

d. In the Selected items list, select the necessary options to define
the filter requirements.

e. Click OK.

5. Click OK. 

Tekla Structural Designer applies the filter to the selected report chapter.
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Format reports
Tekla Structural Designer allows you to customize the appearance of reports in
a number of ways. You can, for example, configure paragraphs styles and
tables, and adjust header and footer information.

Adjust and apply report settings
Report settings allow you to modify the appearance of reports. You can adjust,
for example, paragraph styles, page margins and numbering, tables, and
headers or footers.

1. On the Report tab, click Settings. 

The Settings dialog box opens.

2. In the Settings dialog box, do one or more of the following to adjust the
report settings:

To Do this
Customize the paragraph styles in the different
areas of the report

a. Go to the Styles page.

b. Adjust the settings according to your
needs.

Adjust the page margin width, page numbering,
and margin frame

• Go to the Page Options page.

• Adjust the settings according to your needs.

Adjust the appearance of tables • Go to the Table Options page.

• Adjust the settings according to your needs.

Define whether headers and footers are
displayed, adjust image width and paragraph
spacing, and control page breaks

• Go to the Document Options page.

• Adjust the settings according to your needs.

Adjust the appearance of fonts used in pictures
and force diagrams

• Go to the Picture Fonts page.

• Adjust the settings according to your needs.

3. Click OK. 

Provided that you adjusted the report settings of an active settings set,
the new report settings are applied to the report.

See also

Report settings (page 1168)

Adjust report headers and footers
Tekla Structural Designer provides you with default page header and footer
layouts for your reports. However, you can also create, use and save different
layouts according to your needs.

Enter company details in the header

1. On the Report tab, create the desired report and click Show Report. 

The report is displayed.
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2. On the Report tab, click Edit Header. 

The Document headers/footers dialog box opens.

3. Go to the Headers page.

4. In the Available layouts list, select an existing layout that contains an
Address cell.

5. Go to the Fields page.

6. In the Available fields list, select Address.

7. In the list on the right, select the necessary company details and click <<
to include them in the report.

8. To define the text displayed in each included field, select the field in the
left Available fields list and type the desired text in the Displayed value
field.

9. To insert the company logo in the header, select Company Logo in the
left Available fields list and click ... to browse to the desired image. 

TIP • Large logos are automatically resized to within the column width
in which they are placed. However, using smaller images in PNG
format saves memory and speeds up exporting reports.

• To include more images in the header, click Add Image Field,
type a name for the field and selected the desired image.

10. Click OK. 

The company details are displayed in the report header.

Enter project-specific details in the header

1. On the Home tab, click Project Wiki. 

The Project Wiki dialog box opens.

2. On the Project Summary page, type the project details in the available
fields.

3. Click OK. 

The project details are saved.

NOTE When you go back to the Report tab, remember to update the
report to display the project details in the header.

Create a new header or footer layout

1. On the Report tab, create the desired report and click Show Report. 

The report is displayed.
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2. On the Report tab, click Edit Header. 

The Document headers/footers dialog box opens.

3. According to your needs, go to the Headers or Footers page.

4. In the Available layouts section, click New.

5. Type a name for the new layout in the Name field.

6. According to your needs, do some of the following to adjust the header
layout:

To Do this
Remove an existing field and create an empty
shell

a. Hover the mouse pointer over the field in
the Current layout section until the field
name is highlighted.

b. Click the field that you want to remove it
and replace it with an empty cell.

Place a field into an empty cell or replace an
existing field

• Hold down the left mouse button and drag
the field from the Available fields list into
the desired cell.

Merge cells • Hold down the left mouse button and drag
over the cells that you want to merge.

NOTE To unjoin previously merged cells, right-
click the merged cell and in the context
menu, select Unjoin.

Modify the field alignment within a shell a. Right-click the required cell in the layout.

b. In the context menu, set the horizontal and
vertical alignment options as required.

Insert or remove rows or columns or change
their alignment

a. Right-click the layout.

b. In the context menu, select the desired
command.

Change column type, width and alignment in the
layout

a. Under the Current layout section, click
Edit...

b. Adjust the column properties according to
your needs.

c. Click OK.

7. Click OK. 

The new layout is created.

Navigate reports
Use the Report Index to quickly navigate to a specific section in a report.
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You can also use the buttons in the Navigation group of the Report toolbar to
move through the report pages.

Navigation using the Report Index
Open a report view then:

1. In the Navigation group of the Report toolbar, select Report Index 

The Report Index tab is displayed in the Project Workspace.

2. Click the Report Index tab in the Project Workspace.

3. Click on a specific heading or sub heading Report Index to move to that
section in the report.

Navigation buttons in the Report toolbar
Open a report view then:

• Click  to move to the first page

• Click  to move to the previous page

• Click  to move to the next page

• Click  to move to the last page

• Click  to open the Report Index in the Project Workspace
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Export reports
Tekla Structural Designer allows you to export your reports to PDF format,
Microsoft Word, Excel, and Tekla Tedds. For detailed instructions, see the
following paragraphs.

Export a report to PDF
1. Create the report and ensure that it contains the necessary information.

2. On the Report tab, click PDF.

3. Click Yes to confirm exporting the report. 

The report opens as a PDF file.

Export a report to Microsoft Word
1. Create the report and ensure that it contains the necessary information.

2. On the Report tab, click Word.

3. Click Yes to confirm exporting the report. 

The report opens in Microsoft Word.

Export a report to Excel
1. Create the report and ensure that it contains the necessary information.

2. On the Report tab, click Excel.

3. Click Yes to confirm exporting the report. 

The report opens in Excel

Export a report to Tekla Tedds
1. Create the report and ensure that it contains the necessary information.

2. On the Report tab, click Tedds.

3. Click Yes to confirm exporting the report. 

The report opens in Tekla Tedds

Print reports
To print any reports that you require, see the following instructions.

1. Create the report and click Show Report. 

Tekla Structural Designer displays the report.
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2. On the File menu, go to Print --> Print...

3. Adjust the printing settings according to your needs.

4. Click OK.

Example reports
Tekla Structural Designer provides a number of standard reports that are
installed by default. Even though the standard reports may not match your
exact requirements, they can often serve as templates that you can modify
according to your needs.

Beam End Forces report
The report is typically generated for steel or timber beams in order to provide
connection design forces in one of the following configurations:

• End 1/End 2:

6 forces are output in the support's local co-ordinate system for the
selected loadcases, combinations, or envelopes. For each end of each
beam span, a single row of data is output for loadcases, combinations, or
envelopes in the selected loading filter (Fx, Fy, Fz, Mx, My, Mz). Select this
option if you intend to design the connections at both ends of each beam
independently.

• End 1/End 2 + Coincident:

For each end of each beam span, a separate row is output for each
loadcase, combination, or envelope according to the applied loading filter
for the maximum and the minimum of each of the 6 forces that are output.
In addition, the report contains the coincident forces in the other
directions.

Up to 12 rows of data can be output for a loadcase, combination, or
envelope as follows:

• maximum: Fx (+ coincident Fy, Fz, Mx, My, Mz)

• minimum: Fx (+ coincident Fy, Fz, Mx, My, Mz)

• maximum: Fy (+ coincident Fx, Fz, Mx, My, Mz)

• minimum: Fy (+ coincident Fx, Fz, Mx, My, Mz)

• maximum: Fz (+ coincident Fx, Fy, Mx, My, Mz)

• minimum: Fz (+ coincident Fx, Fy, Mx, My, Mz)

• maximum: Mx (+ coincident Fx, Fy, Fz, My, Mz)

• minimum: Mx (+ coincident Fx, Fy, Fz, My, Mz)

• maximum: My (+ coincident Fx, Fy, Fz, Mx, Mz)
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• minimum: My (+ coincident Fx, Fy, Fz, Mx, Mz)

• maximum: Mz (+ coincident Fx, Fy, Fz, Mx, My)

• minimum: Mz (+ coincident Fx, Fy, Fz, Mx, My)

The loadcase, combination, or envelope names in which the maximum or
minimum values occur are also reported.

• Higher End Only:

For each beam span, two rows of data are output for the chosen loading
filter: maximum (end 1, end 2): Fx, Fy, Fz, Mx, My, Mz; minimum (end 1, end
2): Fx, Fy, Fz, Mx, My, Mz. This configuration does not contain loadcase,
combination, or envelope names because they could vary for each of the 6
values.

• Higher End Only + Coincident (initial default option):

A separate row is output for the maximum and the minimum of each of the
6 forces, along with the coincident forces in the other directions. For each
beam span, up to 12 rows of data can be output for the applied loading
filter as follows:

• maximum (end 1, end 2): Fx (+ coincident Fy, Fz, Mx, My, Mz)

• minimum (end 1, end 2): Fx (+ coincident Fy, Fz, Mx, My, Mz)

• maximum (end 1, end 2): Fy (+ coincident Fx, Fz, Mx, My, Mz)

• minimum (end 1, end 2): Fy (+ coincident Fx, Fz, Mx, My, Mz)

• maximum (end 1, end 2): Fz (+ coincident Fx, Fy, Mx, My, Mz)

• minimum (end 1, end 2): Fz (+ coincident Fx, Fy, Mx, My, Mz)

• maximum (end 1, end 2): Mx (+ coincident Fx, Fy, Fz, My, Mz)

• minimum (end 1, end 2): Mx (+ coincident Fx, Fy, Fz, My, Mz)

• maximum (end 1, end 2): My (+ coincident Fx, Fy, Fz, Mx, Mz)

• minimum (end 1, end 2): My (+ coincident Fx, Fy, Fz, Mx, Mz)

• maximum (end 1, end 2): Mz (+ coincident Fx, Fy, Fz, Mx, My)

• minimum (end 1, end 2): Mz (+ coincident Fx, Fy, Fz, Mx, My)

The loadcase, combination, or envelope names in which the maximum or
minimum values occur are also reported.

TIP To change the default Beam End Forces report configuration, do the
following:

1. On the Report tab, click Model Report...

The Report Contents dialog box opens.

2. In the Available Styles list, select Beam End Forces.

3. In the Chapters and Options list, expand the Member End Forces
group.
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4. Hold down the left mouse button and drag the desired
configurations into the report structure.

5. Click OK.

To display a Beam End Forces report, do the following:

1. In the list on the left side of the Report toolbar, select Beam End Forces.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Bracing Forces report
Tekla Structural Designer provides the bracing design force data for all
loadcases and combinations in steel buildings.

To display a Bracing Forces report:

1. In the list on the left side of the Report toolbar, select Bracing Forces.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Building Analysis & Drift Checks report
By default this report contains the following tables:

• Loadcase summary

• Drift check or sway check results (depending on head code)

• Wind drift check results

To display the Building Analysis & Drift Checks report, do the following:

1. In the list on the left side of the Report toolbar, select Building Analysis
& Drift Checks.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).
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Building Design report
By default, the report contains the design results for the building at a
summary level.

To display a Building Design report, do the following:

1. In the list on the left side of the Report toolbar, select Building Design.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Building Loading report
By default, the report contains a picture of the model and the following tables
of loading related input data:

• Action codes

• Resistance codes

• Combinations

• Wind data

To display a Building Loading report, do the following:

1. In the list on the left side of the Report toolbar, select Building Loading.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Connection Resistance report
Tekla Structural Designer provides the bracing design force data for all
loadcases and combinations in steel buildings.

To display a Connection Resistance report:

1. In the list on the left side of the Report toolbar, select Connection
Resistance.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).
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Embodied Carbon report
The report summarizes the embodied carbon in the structure in two tables:

• Embodied Carbon Overview by Plane

The plane reference, level, embodied carbon mass, floored area, and
embodied carbon mass per floored area are output for each plane.

• Embodied Carbon Overview by Construction Type

The embodied carbon mass is output each construction type.

To display an Embodied Carbon report, do the following:

1. In the list on the left side of the Report toolbar, select Embodied Carbon.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Foundation Reactions report
The report summarizes the foundation design forces and is available in two
different configurations:

• Foundation Reactions (initial default option):

6 forces are output in the support's local co-ordinate system for the
selected loadcases, combinations, or envelopes.

• Foundation Reactions + Coincident

The maximum and minimum value of each of the 6 forces in the support's
local co-ordinate system are output for the selected loading type. In
addition, the report contains the coincident forces that exist in the other
directions for the loading type in which the maximum or minimum value
occurs. The maximum values are highlighted in red, whereas the minimum
values are highlighted in blue.

NOTE The table for the Foundation Reactions + Coincident option never
contains more than 12 rows, irrespective of the number of
selected loadcases or combinations.

To display a Foundation Reactions report, do the following:

1. In the list on the left side of the Report toolbar, select Foundation
Reactions.

2. Click Show Report. 
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TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

In addition to model and loading filters, you can also reconfigure
settings for each of the two configurations. These settings provide
options for:

• choosing strength or service factors

• choosing to display all rows, or non-zero rows only

• excluding reactions from columns assigned to cores

• excluding reactions from walls assigned to cores

Industrial Structure Loading report
By default, this report contains tables for the following industrial structure
loading data:

• Line Ancillary

• Area Ancillary

• Equipment

To display an Industrial Structure Loading report, do the following:

1. In the list on the left side of the Report toolbar, select Industrial
Structure Loading.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Material Listing report
To configure and then display a Material Listing report, do the following:

1. On the Report ribbon, select Material Listing from the list in the
Contents group.

2. Click Model Report... 

The Report Contents dialog box opens.

3. The default report is created for all materials and entity types in the
model and includes all associated properties. If required you can
configure which materials/entity types are to be included in the report
and also choose to exclude properties that you don't require. This is done
as follows:
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a. Right-click on the Material Listing chapter in the Report Structure
and choose Options from the context menu.

b. Uncheck those materials/entity types and any properties that you
don't want to include in the report.

4. The default report is created for the whole structure. If required you can
configure a filter to limit the report to selected floor levels only, or other
criteria as follows:

a. right-click on the Material Listing chapter once again and choose
Model Filter > Edit/New

b. Click Add

c. Select the type of filter

d. Select the items to be included
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e. Click OK

5. To choose between a summary or detailed report, right-click on the
Material Listing chapter once again and choose Settings

• Uncheck Show summary only for a detailed report

• Leave it checked for a summary report

NOTE To find out exactly what summary and detailed level output is
produced for each material type and characteristic, see:

• Steel material lists (page 786)

• Concrete material lists (page 792)

• Timber material lists (page 803)

• Cold formed material lists (page 805)

• General material lists (page 806)

6. Click OK to close the settings dialog.

7. Click OK to close the Report Contents dialog. The report is displayed
according to the configuration choices that you have applied.

Member Design report
By default, the report contains the design results for each member at a
summary level.

To display a Member Design Calcs report, do the following:

1. In the list on the left side of the Report toolbar, select Member Design
Calcs.

2. Click Show Report. 
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TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Open Structure Wind Load report
By default, this report contains tables of the open structure wind loads applied
to the following entities:

• Member

• Line Ancillary

• Area Ancillary

• Equipment

To display an Open Structure Wind Load report, do the following:

1. In the list on the left side of the Report toolbar, select Open Structure
Wind Load.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Seismic Design report
By default, the report contain the following tables:

• Seismic loading summary

• Analysis seismic drift results

To display a Seismic Design report, do the following:

1. In the list on the left side of the Report toolbar, select Seismic Design.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

Solver Model Data report
By default, the report contains a picture of the model and the following tables
of analysis model input data:

• Nodes

• Node support details

• Elements
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• Element members

• Element properties

• Contains to PDF

To display a Solver Model Data report, do the following:

1. In the list on the left side of the Report toolbar, select Solver Model Data.

2. Click Show Report. 

TIP If the resulting report displays too little or too much information,
adjust the content by re-configuring the report (page 828).

See also

Configure and display member reports (page 829)

11.2 Create drawings
You can create drawings of individual levels and frames by using the
commands on the Draw toolbar. As for single-member drawings, they are
created by right-clicking the desired object and selecting the correct option in
the context menu that appears. In addition, you can create drawings in
batches using the Drawing Management... commands.

Drawing categories
In Tekla Structural Designer there are five main drawing categories. Each of
the categories contains different drawing variants, and each variant has a
number of specific options that allows you to configure their appearance. In
addition, each variant contains a set number of drawing layers that are
switched on and off according to the selected layer configuration. The
appearance of each layer is controlled by the layer style. Drawing options,
drawing layers, and layer styles can be managed in drawing settings.

See the different drawing categories and variants in the following table:

Category Drawing variant Description
Planar drawings General arrangement General arrangement

(GA) of 2D levels and
frames.

Foundation reactions GA that also contains
support reactions in
order to assist
foundation design.
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Category Drawing variant Description
Loading plan GA that also contains

applied loads for the
selected loadcase.

Beam end forces GA that also contains
forces at the ends of
steel beams in order to
assist steel connection
design.

Column splice loads Frame GA that also
contains the splice loads
at splice locations in
steel columns in order to
assist steel connection
design.

Member details Concrete beam detail Beam reinforcement in
elevation and section for
each span. If necessary,
you can also include a
reinforcement quantity
table.

Concrete column detail Column reinforcement
in elevation and section.
If necessary, you can
also include a
reinforcement quantity
table.

Concrete wall detail Wall reinforcement in
elevation and section. If
necessary, you can also
include a reinforcement
quantity table.

Non-concrete beam
detail

Individual details for
non-concrete beams.

Non-concrete column
detail

Individual details for
non-concrete columns.
When applicable, this
can include the
associated base plate
detail.

Base plate detail Individual details for
column base plates.
Applicable to EC & US
headcodes

Concrete member
schedules

Concrete beam schedule Tabular data created by
building, by floor, or by
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Category Drawing variant Description
selected beams. The
information shown in
the schedule is based on
the design groups.

Concrete column
schedule

A table containing cross
sections through each
stack for the selected
columns. If necessary,
you can also include a
reinforcement quantity
table.

Concrete wall schedule A table containing cross
sections through each
stack for the selected
walls. If necessary, you
can also include a
reinforcement quantity
table.

Slabs and mats Slab/mat layout Slab item, patch and
punching shear
reinforcement
requirements. If
necessary, you can also
include a reinforcement
quantity table for the
reinforcement displayed
with an added detailing
allowance.

Punching check detail Punching shear
reinforcement details for
individual punching
check locations.

Foundations Isolated foundation
detail

Individual foundation
details in plan. If
necessary, you can also
include the detail in
cross section and a
reinforcement quantity
table.

Foundation layout GA at foundation level
displaying isolated
bases, pile layouts, and
mats. If necessary, you
can also include isolated
foundation details, a
reinforcement quantity
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Category Drawing variant Description
table, and an isolated
foundation schedule.

Adjust and apply drawing settings
To adjust the drawing settings of the current project or set them as default
settings for future projects, see the following instructions.

Adjust drawing settings in the current project
1. On the Draw toolbar, click Settings 

The Model Settings dialog box opens.

2. Review and modify the drawing settings according to your needs.

3. Do one of the following:

• To apply the changes to the current project, click OK.

• To save the changes to the selected settings set, click Save...

• To revert to the drawing settings specified in the selected settings set,
click Load...

Adjust drawing settings in future projects
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to the Drawings page.

3. In the list at the top of the page, select the settings set that you want to
modify.

4. Review and modify the drawing settings according to your needs.

5. To save the settings as defaults for future projects that use the selected
settings set, click OK.

See also

Drawing settings (page 1126)

Create drawing scales
You can only create new drawing scales by accessing the Settings dialog box
via the Home tab. For more information on creating scales, see the following
instructions.

1. On the Home toolbar, click Settings.
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2. Go to the Drawings page.

3. In the list at the top of the page, select the settings set that you want to
modify.

4. In the Drawing Variant list, select the drawing category that you want to
configure.

5. Type the desired scale in the Scale field.

6. Click Add. 

The new scale is added to the Available Styles list.

7. Click OK. 

TIP If necessary, you can also adjust the distance between independent
drawing blocks by typing a value in the Minimum Text Block
Spacing field. However, note that if the value is too great, text labels
can end up far from the objects to which they refer.

Create, modify, or delete layer configurations
Layer configurations control which layers are displayed when the drawing is
created. Tekla Structural Designer contains several default layer configurations
that you can modify. If necessary, you can also create your own layer
configurations.

Create a new layer configuration

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Configurations sub page.

3. In the Drawing Variant list, select the drawing category whose layer
configurations you want to modify.

4. Click Add.

5. Name the new layer configuration.

6. Select or clear the layers according to your needs.

7. Click OK.

Modify a layer configuration

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Configurations sub page.

3. In the Available Configurations list, select the configuration that you
want to modify.
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4. Select or clear the layers according to your needs.

5. Click OK.

Copy a layer configuration

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Configurations sub page.

3. In the Drawing Variant list, select the drawing category whose properties
you want to copy.

4. In the Available Configurations list, select the configuration that you
want to copy properties from.

5. Click Add copy... 

The Copy Drawing Item dialog box opens.

6. Select the properties that you want to copy.

7. Name the copy.

8. Select or clear the layers according to your needs.

9. Click OK.

Delete a layer configuration

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Configurations sub page.

3. In the Drawing Variant list, select the drawing category whose layer
configurations you want to modify.

4. In the Available Configurations list, select the configuration that you
want to remove.

5. Click Remove. 

The selected layer configuration is deleted for the selected drawing
category.

6. Click OK.

Create, modify, or delete layer styles
Drawing styles control how a drawing is displayed, for example, what line
types, fonts, and colors are used. Tekla Structural Designer contains several
default layer styles that you can modify. If necessary, you can also create your
own layer styles.
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Create a new layer style

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Styles sub page.

3. In the Drawing Variant list, select the drawing category whose layer
styles you want to modify.

4. Click Add. 

A new layer style is added to the Available Styles list.

5. Name the new layer style.

6. Adjust the layer properties according to your needs.

7. Click OK.

Modify an existing layer style

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Styles sub page.

3. In the Available Styles list, select the layer style that you want to modify.

4. Adjust the layer properties according to your needs.

5. Click OK.

Copy an existing layer style

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Styles sub page.

3. In the Drawing Variant list, select the drawing category whose layer
styles you want to modify.

4. In the Available Styles list, select the layer style that you want to copy
properties from.

5. Click Add copy... 

The Copy Drawing Item dialog box opens.

6. Select the drawing item that you want to copy.

7. Click OK.

8. Name the copied layer style.

9. Adjust the layer properties according to your needs.

10. Click OK.
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Delete an existing layer style

1. On the Draw toolbar, click Edit... 

The Model Settings dialog box opens on the Drawings page.

2. Go to the Layer Styles sub page.

3. In the Drawing Variant list, select the drawing category whose layer
styles you want to modify.

4. In the Available Styles list, select the layer style that you want to delete.

5. Click Delete. 

The selected layer configuration is deleted for the selected drawing
category.

6. Click OK.

Create planar drawings
Planar drawings cover general arrangement drawings, beam end force
drawings, column splice load drawings, foundation reaction drawings and
loading plan drawings.

NOTE Before you create a drawing, ensure that the current drawing options meet
your needs by doing the following:

1. On the Draw toolbar, click Settings

The Model Settings dialog box opens on the Drawings page.

2. Go to Settings.

3. Click the drawing type whose options you want to review or adjust.

4. Adjust the drawing options according to your needs.

5. Click OK.

Create general arrangement drawings
General arrangement drawings display 2D levels and frames, and can only be
created in 2D views. To create general arrangement drawings, do the
following:

1. Open a 2D view displaying the part of the model that you want to include
in the drawing. 

The part can be, for example, a construction level, frame, or sloped plane.

2. On the Draw toolbar, click General Arrangement. 

The DXF Export Preferences dialog box opens.

3. Select the layer configuration and layer style for the drawing.
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4. Set the drawing scale.

5. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

6. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

7. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

See also

Create drawing scales (page 851)

Create beam end force drawings
Beam end force drawings are general arrangement drawings that also contain
support reactions. They are typically created to assist connection design in
steel structures and can only be created in 2D views. To create beam end force
drawings, do the following:

NOTE Beam end forces are not displayed for concrete beams.

1. Open a 2D results view displaying the part of the model that you want to
include in the drawing. 

The part can be, for example, a construction level, frame, or sloped plane.

2. In the Loading list, select the loadcase or combination that you want to
display.

3. On the Draw toolbar, click Beam End Forces. 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.
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8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

See also

Create drawing scales (page 851)

Create column splice load drawings
Column splice drawings are general arrangement drawings that also contain
applied loads for the selected loadcase. Column splice drawings are typically
created to assist connection design in steel structures. To create column splice
load drawings, do the following:

NOTE Column splice loads are not relevant in concrete structures, and
therefore, they are not displayed for concrete beams.

1. Open a frame view containing the steel frame for which you want to see
the column splice loads.

2. On the Status bar, click  Results View.

3. In the Loading list, select the loadcase or combination that you want to
display.

4. On the Draw toolbar, click Column Splice Loads. 

TIP If the Column Splice Loads command is not active, ensure that the
current view is displayed in 2D.

The DXF Export Preferences dialog box opens.

5. Select the layer configuration and layer style for the drawing.

6. Set the drawing scale.

7. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

8. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

9. Click OK. 
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The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

See also

Create drawing scales (page 851)

Create foundation reaction drawings
Foundation reaction drawings are general arrangement drawings that also
contain support reactions in order to assist foundation design. Foundation
reaction drawings can only be created in 2D results views. To create
foundation reaction drawings, do the following:

1. Open a 2D results view displaying the part of the model that you want to
include in the drawing. 

Typically, the part is be the base construction level.

2. In the Loading list, select the loadcase or combination that you want to
display.

3. On the Draw toolbar, click Foundation Reactions. 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

See also

Create drawing scales (page 851)
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Create loading plan drawings
Loading plan drawings are general arrangement drawings that also contain
applied loads for the selected loadcase. Loading plan drawings can only be
created in 2D scene views. To create loading plan drawings, do the following:

1. Open a 2D view displaying the part of the model that you want to include
in the drawing. 

The part can be, for example, a construction level, frame, or sloped plane.

2. In the Loading list, select the loadcase or combination that you want to
display.

3. On the Draw toolbar, click Loading Plan. 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

See also

Create drawing scales (page 851)

Create member detail drawings
Member detail drawings include concrete beam detail drawings, concrete
column detail drawings, concrete wall detail drawings, non-concrete beam
detail drawings and non-concrete column detail drawings. For instructions on
how to create different member detail drawings, see the following paragraphs.

NOTE Before you create a drawing, ensure that the current drawing options meet
your needs by doing the following:

1. On the Draw tab, click Settings

The Model Settings dialog box opens on the Drawings page.
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2. Go to Settings --> Member Details.

3. Click the drawing type whose options you want to review or adjust.

4. Adjust the drawing options according to your needs.

5. Click OK.

See also

Create drawing scales (page 851)

Create concrete beam detail drawing
Concrete beam drawings display the beam reinforcement in elevation and
section for each span. If necessary, you can also include a reinforcement
quantity table.

1. Hover the mouse pointer over the beam that you want to detail.

2. When the desired beam is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create concrete column detail drawing
Concrete column drawings display the column reinforcement in elevation and
section. If necessary, you can also include a reinforcement quantity table.

1. Hover the mouse pointer over the column that you want to detail.

2. When the desired column is highlighted, right-click it.
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3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create concrete wall detail drawing
Concrete wall details drawings display the wall reinforcement in elevation and
section. If necessary, you can also include a reinforcement quantity table.

1. Hover the mouse pointer over the wall that you want to detail.

2. When the desired wall is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).
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Create non-concrete beam detail drawing
Non-concrete beam detail drawings display individual steel beam details.

1. Hover the mouse pointer over the beam that you want to detail.

2. When the desired beam is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create non-concrete column detail drawing
Non-concrete column detail drawings display individual steel column details.

1. Hover the mouse pointer over the column that you want to detail.

2. When the desired column is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 
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The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create base plate detail drawing
Base plate detail drawings display individual column base plate details.

1. Hover the mouse pointer over the base plate that you want to detail.

2. When the desired base plate column is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create slab and mat drawings
Slab and mat drawings refer to slab and mat layout drawings and punching
shear check detail drawings. Slab and mat detail drawings are used to convey
slab reinforcement and patch reinforcement requirements, and contain a
quantity table for the reinforcement displayed with a detailing allowance
added. Punching check detail drawings display an individual check detail in,
and also contain the option to display the reinforcement quantities table.

See also

Create drawing scales (page 851)
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Create slab or mat layout drawings
1. Open a 2D scene view displaying the slabs or mats that you want to

include in the drawing.

2. On the Draw tab, click Slab/Mat Detailing. 

NOTE If the Slab/Mat Detailing command is not active, ensure that you
are in a 2D scene view.

The DXF Export Preferences dialog box opens.

3. Select the layer configuration and layer style for the drawing.

4. Set the drawing scale.

5. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

6. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

7. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create punching shear check detail drawings
1. Hover the mouse pointer over the punching shear check item that you

want to detail.

2. When the desired punching shear check item is highlighted, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 
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The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create foundation drawings
Foundation drawings refer to isolated foundation detail drawings and
foundation layout drawings. Isolated foundation detail drawings display an
individual foundation detail in plan. If necessary, you can also display the
detail in cross section and a reinforcement quantity table. As for foundation
layout drawings, they display the piling layout and the layout of isolated
foundations. If necessary, you can also display isolated foundation details, a
reinforcement quatity table, an isolated foundation schedule, and a pile
location table.

See also

Create drawing scales (page 851)

Create isolated foundation detail drawings

NOTE Before you create a base cap detail drawing, ensure that the current
drawing options meet your needs by doing the following:

1. On the Draw tab, click Settings

The Model Settings dialog box opens on the Drawings page.

2. Go to Settings --> Isolated Foundation Detail.

3. Adjust the drawing options on the Content and Isolated
Foundation Detail sub pages according to your needs.

4. Click OK.

1. Hover the mouse pointer over the base cap or pile cap that you want to
detail.

2. When the desired base cap or pile cap is highlighter, right-click it.

3. In the context menu, select Generate Detailing Drawing... 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.
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7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create foundation layout drawings
1. Open a 2D scene view displaying the piles, bases or pile caps that you

want to include in the drawing.

2. On the Draw tab, click Foundation Layout. 

NOTE If the command is not active, ensure that you are in a 2D scene
view displayed in 2D.

The DXF Export Preferences dialog box opens.

3. Select the layer configuration and layer style for the drawing.

4. Set the drawing scale.

5. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

6. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

7. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create concrete member schedule drawings
Concrete member schedule drawings include concrete beam schedules,
concrete column schedules and concrete wall schedules. In beam schedule
drawings, the reinforcement is listed on a span by span basis, and contractors
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or specialist detailing firms can use the information to produce the necessary
bar bending schedules. As for concrete column schedule drawings, they
display a cross section through each stack of the selected columns, and if
necessary, allow you to include a reinforcement quantity table. Concrete wall
schedule drawings display a cross section through each stack of the selected
walls, and if necessary, also allow you to include a reinforcement quantity
table

NOTE Before you create a schedule drawing, ensure that the current drawing
options meet your needs by doing the following:

1. On the Draw tab, click Settings

The Model Settings dialog box opens on the Drawings page.

2. Go to Settings.

3. Adjust the drawing options on the sub pages according to your needs.

4. Click OK.

See also

Create drawing scales (page 851)

Create concrete beam schedule drawings
You can create beam schedule drawings by building, by floor or by selected
beams. The information shown in the schedule is based on the different
design groups. Beam schedule drawings are created in dxf format even
though they do not include graphical information, so that you can add them to
beam detail drawings.

1. Open a 2D scene view of a part displaying the beams that you want to
include in a schedule. The part can be, for example, a construction level,
frame, or sub model.

2. On the Draw tab, click Beam Schedule. 

NOTE If the Beam Schedule command is not active, ensure that you are
in a 2D scene view that is displayed in 2D.

The DXF Export Preferences dialog box opens.

3. Select the layer configuration and layer style for the drawing.

4. Set the drawing scale.

5. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

6. Do one of the following:

• Accept the automatic file name.
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• Clear the Use automatic file name option and name the file yourself.

7. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create concrete column schedule drawings
1. Open a 3D view or a frame view displaying the columns that you want to

include in the schedule.

2. On the Draw tab, click Column Schedule. 

The Select column schedule content dialog box opens.

3. Select the columns to be included and click OK. 

The DXF Export Preferences dialog box opens.

4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Create concrete wall schedule drawings
1. Open a 3D view or a frame view displaying the walls that you want to

include in the schedule.

2. On the Draw tab, click Wall Schedule. 

The Select wall schedule content dialog box opens.

3. Select the walls to be included and click OK. 

The DXF Export Preferences dialog box opens.
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4. Select the layer configuration and layer style for the drawing.

5. Set the drawing scale.

6. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

7. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

8. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Manage drawings in batches
Although you can create individual drawings according to your needs, creating
a batch of drawings at once is often more efficient, especially when working
with larger models.

The Drawing Management... command on the Draw tab allows you to:

• Select the drawing variant that you want to manage.

• Either add a drawing sheet manually or generate a series of drawing
sheets.

• Select the frames, levels, or members for which you want to create
drawings.

• Arrange the drawings on the drawing sheet either in a linear or a grid
arrangement.

• Select the loadcases or combinations for load-dependent drawing variants.

• Create drawing revisions.

• View the revision history of drawings.

• Reset reinforcement marks on concrete detail drawings in order to remove
gaps in the bar mark numbering.
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Create or generate drawings in batches
To easily create multiple drawings of any particular variant , be they base plate
details, punching check details, concrete member details, see the following
instructions:

To place multiple drawings of a single variant, (base plate detail, punching
check detail, concrete member detail etc.) on to one or more drawing sheets,
see the following instructions:

See also

Specify the drawing layout (page 871)

Specify the loading for load-dependent drawings (page 871)

View drawings (page 872)

Review drawings (page 873)

Reset reinforcement marks in concrete detail drawings (page 872)

Create a new batch drawing manually

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. Click Add. 

A new drawing appears in the Available Drawings list.

4. Name the new drawing.

5. Click Content... 

The Drawing Content dialog box opens.

6. Drag the items that you want to include in the drawing from the left
column to the right column.

7. Click OK.

8. Click View Drawing...

Generate a new concrete beam or column detail drawing

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Drawing Variant list, select either Concrete Beam Detail or
Concrete Column Detail.

Create reports and drawings 870 Create drawings



3. Click Generate. 

New drawings are created with automatically generated content. One
drawing contains typical beams or columns, wheras additional drawings
can contain any ungrouped beams or columns.

4. If necessary, click the available drawings to rename them, and type a new
name.

5. Click View Drawing...

6. Select the drawing you want to create from the available drawings list.

7. Click View Drawing...

Specify the drawing layout
To specify the layout of the drawings that you have created, do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click Layout... 

The Drawing Layout dialog box opens.

5. Define the direction and arrangement of the layout.

6. Click OK.

See also

Specify the loading for load-dependent drawings (page 871)

Specify the loading for load-dependent drawings
To specify the loading for load-dependent drawings, do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click Loading... 

The Select loading dialog box opens.

5. Select the desired loadcases and combinations.

6. Click OK.
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See also

Create or generate drawings in batches (page 869)

Reset reinforcement marks in concrete detail drawings
Each bar geometry used in the model has an associated reinforcement mark.
However, if a model is designed and some of the bars fall out of use, the mark
assignment is still retained. As a result, there may be gaps in the marks and
marks starting at high numbers. To avoid this, you can reset all the
reinforcement marks in the model. Do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Drawing Variant list, select either Concrete Beam Detail or
Concrete Column Detail.

3. Click Reset ALL Marks. 

All reinforcement marks are reset.

See also

Create or generate drawings in batches (page 869)

View drawings
To view the drawings that you have created in the Drawing Management
dialog box, do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click View Drawing... 

The DXF Export Preferences dialog box opens.

5. Select the layer configuration and layer style for the drawing.

6. Set the drawing scale.

7. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

8. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

9. Click OK. 
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The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

See also

Create or generate drawings in batches (page 869)

Review drawings
To apply a revision to a drawing, do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click Create Revision... 

The Create Drawing Revision dialog box opens.

5. Name the revision and type a revision note.

6. Click OK. 

The drawings open in an available DXF tool.

See also

View the revision history of drawings (page 873)

View the revision history of drawings
To view the formerly applied revisions to a drawing, do the following:

1. On the Draw tab, click Drawing Management... 

The Drawing Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click History... 

The Drawing History dialog box opens and allows you to view the
revision history of the selected drawing.

See also

Review drawings (page 873)
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Manage schedule drawings in batches
Although you can create individual schedule drawings according to your
needs, creating a batch of schedule drawings at once is also possible. For
more information, see the following instructions.

The Schedule Management... command on the Draw tab allows you to:

• Select the drawing variant that you want to manage.

• Create new drawing sheets.

• Select the members that you want to include in the drawing.

• Arrange the drawing layout.

• Create drawing revisions.

• Reset reinforcement marks in order to remove gaps in the bar mark
numbering.

Create new schedule drawings
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. Click Add. 

A new drawing appears in the Available Drawings list.

4. Name the new drawing.

5. Click Content... 

The Drawing Content dialog box opens.

6. Drag the items that you want to include in the drawing from the left
column to the right column.

7. Click OK.

Specify the schedule drawing layout
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. Click Layout... 

The Drawing Layout dialog box opens.

3. Define the direction and arrangement of the layout.

4. Click OK.
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View schedule drawings
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click View Drawing... 

The DXF Export Preferences dialog box opens.

5. Select the layer configuration and layer style for the drawing.

6. Set the drawing scale.

7. If necessary, to adjust the distance between independent lines of text,
modify the minimum text block spacing.

8. Do one of the following:

• Accept the automatic file name.

• Clear the Use automatic file name option and name the file yourself.

9. Click OK. 

The drawing opens in an available DXF application.

NOTE If preferred this drawing variant can be created as a batch
(page 870), (allowing multiple drawings to be created on a single
drawing sheet).

Reset reinforcement marks in schedule drawings
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. In the Drawing Variant list, select Concrete Beam Schedule, Concrete
Column Schedule, or Concrete Wall Schedule.

3. Click Reset ALL Marks. 

All reinforcement marks are reset.

Review schedule drawings
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

Create reports and drawings 875 Create drawings



4. Click Create Revision... 

The Create Drawing Revision dialog box opens.

5. Name the revision and type a revision note.

6. Click OK. 

The drawings open in an available DXF tool.

View the revision history of schedule drawings
1. On the Draw tab, click Schedule Management... 

The Schedule Management dialog box opens.

2. In the Available Styles list, select the desired drawing category.

3. In the Available Drawings list, select the desired drawing.

4. Click History... 

The Drawing History dialog box opens and allows you to view the
revision history of the selected drawing.
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12Manage models

Click the links below to find out more various model management tasks:

• Define and modify head codes and design codes (page 878)

• Define and modify units (page 879)

• Manage object references (page 881)

• Create and manage user-defined attributes (page 916)

• Manage settings sets (page 886)

• Manage materials (page 890)

• Manage properties and property sets (page 912)

• Manage sub structures (page 921)

• Working with large models (page 927)

See also

Model Settings (page 1032)

12.1 Apply and manage model settings
To apply and manage the various defaults and settings that apply to the
current project, see the following instructions.

1. On the Home tab, click Model Settings.

2. Adjust the Model Settings (page 1032) according to your needs.

3. After adjusting the settings, do one of the following:

To Do this
Apply the changes to the current project • Click OK.

Save the changes back to the active settings set
for future use

• Click Save...

Cancel the changes • Click Cancel.
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Revert to the model settings specified in the
active settings set

• Click Load...

NOTE Clicking Load... loads all of the model
settings from the active settings set, not
only those specified on the current page
of the Model Settings dialog box.

Analysis options and design options are
not loaded.

See also

Define and modify head codes and design codes (page 878)

Define and modify units (page 879)

Manage object references (page 881)

Create and manage user-defined attributes (page 916)

Define and modify head codes and design codes
Tekla Structural Designer allows you to select from a range of international
design codes of practice. Each new project initially adopts the codes that have
been specified in the active settings set. However, you can also change the
codes in the middle of a project.

See also

Design code settings (page 1033)

Change design codes in an existing project

WARNING If you change the head code in an existing project, the following
will occur in the model:

• Some materials, steel sections, studs, decks and
reinforcement may require re-selecting in the model to make
them consistent with the new head code/unit system.

• Wind loading (if any) and wall/roof panel properties will be
deleted. The wind wizard will need rerunning, wall/roof panel
properties need resetting and the wind loadcases will need
recreating.

• Seismic loading (if any) will be deleted. The seismic wizard will
need re-running.

• All combinations will be deleted.
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1. On the Home tab, click Model Settings. 

The Settings dialog box opens.

2. Go to Design Codes.

3. Select the head code as required. 

The head code controls which action and resistance codes are available
for selection.

4. Set the action and resistance codes according to your needs.

5. Click OK.

Define default design codes for new projects

1. On the Home tab, click Settings. 

The Settings dialog box opens.

2. Select a suitable settings set, and click >> Active to make it active.

3. Go to Design Codes.

4. Check that the head code is set as required. 

The head code controls which action and resistance codes are available
for selection.

5. Set the action and resistance codes according to your needs.

6. Click OK. 

Tekla Structural Designer retains the selected codes to apply them for
each new project until you decide to modify them.

7. To use the set design codes in a new project, on the Home tab, click 
New. A new project opens with its design codes, (and all of its other
model settings) copied from the active settings set.

Define and modify units
Tekla Structural Designer allows you to switch between Metric and US
customary units. Furthermore, you can select the units which you want to use
in the selected unit system. For example, if you use US customary units, you
can input forces in either kip or lb, and lengths in feet, inches, or feet and
inches.
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Change units and unit precision in an existing project

1. On the Home tab, click Model Settings. 

The Model Settings dialog box opens.

2. Go to Units.

3. Select the unit system.

4. Set the units and unit precision that you want Tekla Structural Designer to
use.

5. Click OK. 

NOTE The length unit can be set appropriate for the type of dimension
being input:

• Fine Dimension units are used for defining stud spacings,
section size constraints, and other typically small distances.

• Dimension units are used for defining grid spacings,
positioning members, positioning load locations, and so on.
They are also used to control the accuracy of any measured
dimension lines that you apply to the model.

• Deflection units are used for reporting deflection results.

• Distance units are used for defining large dimensions.

Once you have set the units according to your needs, Tekla Structural Designer
will then expect input in the same format.

Example

If the Dimension units are set to ft, in fract.:

• To input a dimension of two feet, six and one quarter inches, you need to
type 2' 6 1/4"

• To input a series of irregular grid lines in the grid wizard at spacings of
fifteen feet, followed by three spacings of twenty feet, six and one half
inches, followed by one spacing of fifteen feet, you need to type
15',3*20' 6 1/2",15'

Define the default units and unit precision for new projects

1. On the Home tab, click Settings. 

The Settings dialog box opens.

2. Select a suitable settings set, and click >> Active to make the set active.

3. Go to Units.
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4. Select the unit system.

5. Set the units and unit precision that you want Tekla Structural Designer to
use. 

NOTE The length unit can be set appropriate for the type of dimension
being input:

• Fine Dimension units are used for defining stud spacings,
section size constraints, and other typically small distances.

• Dimension units are used for defining grid spacings,
positioning members, positioning load locations, and so on.
They are also used to control the accuracy of any measured
dimension lines that you apply to the model.

• Deflection units are used for reporting deflection results.

• Distance units are used for defining large dimensions.

6. Click OK.

7. To use the set units in a new project, on the Home tab, click New. A
new project opens with its units, (and all of its other model settings)
copied from the active settings set.

Once you have set the units according to your needs, Tekla Structural Designer
will then expect input in the same format.

Example

If the Dimension units are set to ft, in fract.:

• To input a dimension of two feet, six and one quarter inches, you need to
type 2' 6 1/4"

• To input a series of irregular grid lines in the grid wizard at spacings of
fifteen feet, followed by three spacings of twenty feet, six and one half
inches, followed by one spacing of fifteen feet, you need to type
15',3*20' 6 1/2",15'

Manage object references
Tekla Structural Designer contains a flexible object referencing system that is
specifically designed considering the use of multiple materials within the same
model.

You can define the object references to meet your needs on the References
page of the Settings dialog box.
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See also

Object reference settings (page 1035)

Basics of object reference formats

Object reference formats are user definable. Each object type has its own
reference format that has been built using individual components. You can
customize the reference format by adding or removing components as
required.

See some of the typical components in the following table:

Icon Item Further information
Material Fully user-definable text.

For example:

• S for Steel

• C for Concrete
Characteris
tic

Fully user-definable text.

For example:

• B for Beam

• C for Column
Start Level
Reference

Not applicable

End Level
Reference
Start Point
Reference

Grid or construction point reference.

The start and end reference points P1 and P2
work from the grids that you define, and from
the construction points that have been created
automatically when you place members that do
not lie between existing points.

NOTE When reference points are constructed
using two grid reference points, you
must always use a separator.

For example, type A/11 to avoid
confusion with A1 and 1.

End Point
Reference

Direction Applies for beams only.
Count Tekla Structural Designer keeps a separate

count for each level for each object type.
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Icon Item Further information

NOTE Tekla Structural Designer does not keep
a count by material. For example, steel
beams and concrete beams are
included in the same count on a level.

If the direction prefix is specified, Tekla
Structural Designer keeps separate
counts for each direction. Direction 1 is
defined as objects falling within ± 45
degrees of the horizontal, and Direction
2 ± 45 degrees of the vertical of the
global axis.

Not applicable Reinforcem
ent > Bar
Layer:

• T1

• T2

• B1

• B2

• T1 is the top surface reinforcement in the 1st
(outer) layer.

• T2 is the top surface reinforcement in the
2nd (inner) layer.

• B1 is the bottom surface reinforcement in
the 1st (outer) layer.

• B2 is the bottom surface reinforcement in
the 2nd (inner) layer.

Reinforcem
ent > Bar
Size

Not applicable

Reinforcem
ent >
Center
Spacing

The center spacing between bars.

Reinforcem
ent >
Detailing
prefix

An item that is typically added in front of the bar
size.

Custom
text

Fixed text that you can include at any position
within the reference.

For example:

• Block C
Separators

• backslas
h

• dash

• slash

Optional items that you can place between
items.
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Icon Item Further information
• space

• times

Note that:

• When you create objects of a certain type, the default references from the
active settings set are applied.

• You can modify the syntax of the reference format at any time. Objects
created after the changes will adopt the new format.

• Once objects have been created, you can edit their references on an object-
by-object basis, so that they can be further individualized.

• For members, the object reference does not include the group reference,
geometric shape, and section size as part of the reference descriptor.
Instead, options are provided in the Scene Content settings and the GA
drawing's control to show the information.

Modify reference formats and texts in an existing project
1. On the Home tab, click Model Settings. 

The Model Settings dialog box opens.

2. Go to References.

3. Adjust the way in which the references are applied.

4. Click OK.

Modify the reference format syntax of an object type
1. Go to References --> Formats .

2. Click the ... button on the right side of the desired reference format.

3. Do one of the following:

To Do this
Add an extra item to the reference format • Click Add... and select the desired item.

The selected item appears at the end of the
reference format.

Re-order the items in the reference format a. Select the item you want to move.

b. Drag the item to reposition it.

Add custom text to the reference format a. Click Add... and select Custom Text.

b. Drag the new component to the desired
position.

c. Click the Custom Text component to edit
it.

d. Type the desired text in the box.

e. Click Set.
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Remove an item from the reference format a. Select the item you want to remove.

b. Drag the item outside the Edit Reference
Format dialog box.

4. Click OK.

Change the text used for the materials and characteristics in the
reference format
1. Go to References --> Texts .

2. According to your needs, go to the Characteristics or Materials tab.

3. Modify the desired text according to your needs.

4. Click OK.

Renumber members
You can use the Renumber command to simultaneously renumber all
member types in the model whose reference format includes the count item.

Member types are initially numbered in the order in which they are created.
Renumbering makes the members easier to find in the model and on
drawings.

By default, the Renumber command works from the lowest plane or level
upwards. The count starts at 1 and continues sequentially.

NOTE To change the renumbering direction and the starting value, go to
Model Settings --> References --> General .

1. On the Structure tab of Project Workspace, right-click the Members
branch.

2. In the context menu, select Renumber. 

Tekla Structural Designer automatically renumbers all members in the
model that include a count in their reference format.

Renumber slabs
You can use the Renumber command to simultaneously renumber all slab
items in the model.

Slab items are initially numbered in the order in which they are created.
Renumbering makes them easier to find in the model and on drawings.

By default, the Renumber command works from the lowest plane or level
upwards. The count starts at 1 and continues sequentially.

NOTE To change the renumbering direction and the starting value, go to
Model Settings --> References --> General .
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1. On the Structure tab of Project Workspace, right-click the Slabs branch.

2. In the context menu, select Renumber. 

Tekla Structural Designer automatically renumbers all slab items in the
number.

Adjust the default references to be applied to new projects
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Select a suitable settings set in the list, and click >> Active to make it
active.

4. Go to References.

5. Adjust the way in which the references are applied to each of the object
types in your projects.

6. Click OK.

7. To start a new project using the new references, on the Home tab, click
New.

12.2 Manage settings sets
The first time Tekla Structural Designer is run after installation you are
required to select a country or region. Based on this selection, Tekla Structural
Designer creates an initial settings set (the 'active' set), containing defaults for
design codes, units, and sections, and settings for drawings, schedules, and
reports.

You can edit the settings in this set and also create new sets, but only one set
can be designated the 'active' settings set.

Each new project takes a copy of the 'active' settings set to form its own
independent model settings.

Model settings can then be edited as required without affecting the active
settings set.

Add a new settings set
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.
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3. Click Add Copy.

4. In the Settings dialog box, modify the settings for the new settings sets.

5. Click OK to save the settings to the new settings set.

Import a settings set for a different region
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Click Import...

4. Select the region for which you want to import the settings.

5. Click OK.

NOTE To use these settings in your new projects, you will need to make this
the active set.

Edit the content of a settings set
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Select the settings set you want to edit.

4. In the Settings dialog box, modify the settings according to your needs.
For example:

• Modify the font used to display results in the Results Viewer.

• Modify the appearance of reports.

• Set the units that you want to use, and set the desired precision for the
units.

• Set the design codes that you want.

• Set default section sizes for each of the member types.

• Set if confirmations are required for specific actions.

• Set element references.

• Modify the appearance of schedules.

• Modify drawing types and styles.

• Modify the colors used in 2D and 3D views.
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5. Click OK to save the settings to the selected settings set.

Change the active settings set
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Select the settings set required from the drop list.

4. To make the set a default set for new projects, click >> Active.

5. Click OK.

Delete a settings set
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Select the set you want to delete.

4. Click Remove.

Load settings from the active settings set to the current
project
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Ensure that the required settings set is active. If it is not, click >> Active.

4. Click OK.

5. Open the dialog that contains the settings to be updated, either:

• On the Home ribbon, click Model Settings

• On the Home ribbon, click Embodied Carbon Factors

• Or, on the Analyze ribbon, click Settings
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• Or, on the Design ribbon, click Settings

• Or, on the Draw ribbon, click Settings

6. Click Load... 

A confirmation dialog appears.

7. To update the model settings to match the active settings set, click Yes.

Save settings from the current project to the active settings
set
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Ensure that the settings set is active. If it is not, click >> Active.

4. Click OK.

5. Open the dialog that contains the settings to be saved.

• On the Home ribbon, click Model Settings

• Or, on the Home ribbon, click Embodied Carbon Factors

• Or, on the Analyze ribbon, click Settings

• Or, on the Design ribbon, click Settings

• Or, on the Draw ribbon, click Settings

6. Click Save... 

A confirmation dialog appears.

7. To update the active settings set to match the current settings, click Yes.

Copy a settings set from one computer to another
In order to apply consistent settings on a company wide basis, the xml file of
the appropriate settings set should be manually copied to other computers.
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1. On the computer containing the settings set, go to the Home ribbon and

click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Click Open Folder.

4. Select the xml file of the settings set, and manually transfer it to the
Settings folder on each destination computer.

5. To view and use the new settings set, restart Tekla Structural Designer on
the destination computers.

See also

Settings set settings (page 1160)

12.3 Manage materials
Material databases contain an extensive range of sections, materials,
reinforcement, decking, and connectors for each head code and country. The
initial data in the material databases is protected, so that standard items
cannot be accidentally edited or deleted. However, you can add user data
from other sources or suppliers, if needed. All user data is fully editable. You
can view the protected data and manage the user data from the Materials
dialog (page 1201).

Embodied carbon factors are saved separately and are fully editable. You can
add and manage these factors from the Embodied Carbon Factors dialog
(page 1185).

• Add, modify and delete user-defined sections (page 890)

• Manage design section orders (page 892)

• Add simple connection resistances to the database (page 895)

• Add material properties from the model to a material database (page 902)

• Add materials for a head code (page 902)

• Timber property assumptions (page 907)

• Upgrade material databases (page 906)

• Add and manage embodied carbon factors (page 907)

Manage models 890 Manage materials



Add, modify and delete user-defined sections
A user defined section can take the form of a custom, or a compound section,
a compound section being one that comprises of 2 chords or more connected
by battens or lattice or welded.

See also

The Sections dialog box (page 1208)

Add a user-defined custom or compound section to the material
database
1. On the Home ribbon, click Materials. 

The Materials dialog box opens.

2. Go to Sections, and click Manage Sections. 

The Sections dialog box opens.

3. In the country list, select the database country.

4. In the Page pane on the left, select the desired geometry. 

NOTE If you cannot find the desired shape, ensure that the Geometry
filter does not filter it out.

5. Click Add...

6. Enter values for each of the requested variables.

7. Click OK.

The new section size is now displayed in the Item pane.

Modify a user-defined custom or compound section in the material
database
1. On the Home ribbon, click Materials. 

The Materials dialog box opens.

2. Go to Sections, and click Manage Sections. 

The Sections dialog box opens.

3. In the country list, select the database country.

4. In the Page pane on the left, select the desired geometry. 

NOTE If you cannot find the desired shape, ensure that the Geometry
filter does not filter it out.

5. In the Item pane on the right, select the desired section size.
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6. Click Edit...

7. Modify the section properties according to your needs.

8. Click OK.

Delete a user-defined custom or compound section from the database

NOTE Only user-defined sections, marked with *, can be deleted.

1. On the Home ribbon, click Materials. 

The Materials dialog box opens.

2. Go to Sections, and click Manage Sections. 

The Sections dialog box opens.

3. In the country list, select the database country.

4. In the Page pane on the left, select the desired geometry. 

NOTE If you cannot find the desired shape, ensure that the Geometry
filter does not filter it out.

5. In the Item pane on the right, select the desired section size.

6. Click Delete. 

A confirmation dialog appears.

7. To delete the section, click Yes.

Manage design section orders
A design section order is a list of sections you wish to consider for design
when the Autodesign property is checked.

The design process commences by starting with the first section in the chosen
order file. Any section that fails any of the design conditions is rejected and the
design process is then repeated for the next available section in the list.

On completion of the design process, the first satisfactory section from the
section designation list is assigned to the member.

View the list of sections in a design section order
You can view the list of sections in a design section order, by following the
steps below.

1. Edit the properties of the member.

2. Click the Design section order drop list and select <New\Edit...>
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3. Choose a section order from the available list and then click Edit...

The sections contained within the chosen order file appear in the Sections in
use list on the right of the page.

Specify that a section in the list should not be considered for design
You can control which sections in a design order list are considered by
following the procedure below.

Only checked sections within the list are considered during the design process.
Uncheck a section and it will no longer be considered.

WARNING Limiting the choice of sections by unchecking a section within an
order file is a global change that affects ALL projects, (not just the
currently open one). It is typically used to eliminate unavailable or
non-preferred sections from the design process. If design
requirements for an individual member require section sizes to
be constrained, (due to, for example depth restrictions), then the
choice of sections should be limited instead by using Size
Constraints, (as these only affect the current member).

Sort the listed sections by a different property
You can sort a design section order list by following the steps below.

While viewing the list of sections:

1. Click Criteria... to open a dialog for selecting the sort critera.

2. Select a property from the Available Criteria list and click Add.

3. Choose the order for sorting (Ascending, or Descending).

4. Add further criteria as required.

5. Click OK to close the dialog.

6. Click Sort to re-order by the chosen criteria.

7. Having sorted, if you don't want to subsequently move individual sections
up or down the list, check Keep sorted to de-activate Move Up and Move
Down.

NOTE Changing the order of sections within an order file is a global change
that affects ALL projects, (not just the currently open one).

Specify that a section is non-preferred
Some sections might be more expensive or difficult to obtain; you might
therefore want other sections to be chosen in preference to them, (whilst still
keeping them available).
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You can achieve this by moving the "non-preferred" sections further down the
design order list.

To move a section up or down the list:

1. If Keep sorted is checked, you must uncheck it in order to activate Move
Up and Move Down.

2. Highlight the section in the Sections in use list and then click Move Down
or Move Down to promote or demote it.

NOTE Changing the order of sections within an order file is a global change
that affects ALL projects, (not just the currently open one).

Reset a design section order back to the original default
If you have made changes to a design order list, the following steps you
through resetting the order file to the original default values.

1. Edit the properties of the member.

2. Click the Design section order drop list and select <New\Edit...>

3. In the Select a Section Order dialog, highlight the section order that you
want to reset.

4. Click Reset

The highlighted design section order is reset to its default settings.

NOTE The Reset button is only displayed for the pre-installed section orders.
(User defined section orders can be deleted but not reset.)

Create a new Design section order
If you want to create a completely new design section order you can do so as
follows:

1. Edit the properties of a member.

2. Click the Design section order drop list and select <New\Edit...>

3. In the Select a Section Order dialog, click Add...

4. Enter a unique name for the new design section order.

5. Select the Country and the Section Group required.

6. Either click Add All to add all the available sections, or highlight just the
sections you require and click Add Selected. 

NOTE When adding selected sections you can use the Top, Bottom,
Above Selected, Below Selected options to specify where they
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appear in the list. However, these options are ineffective if you
have a sort criteria specified and the Keep sorted box is checked.

7. Sort individual sections in the Sections in use list, using Move Up or
Move Down, as required. 

8. When the list of sections in use is as you want it, click OK

The new design section order appears on the list of available section orders.

Add simple connection resistances to the database
The materials database contains pre-defined connection types with pre-
defined resistances for steel beams to Eurocode1 and US2 head codes.

In addition, you can specify user-defined connection types and user-defined
resistances for any head code and save them to the section database. Once
defined, these can then be used to Check simple connection resistance
(page 635) across all projects.
1The Eurocode resistances are derived from SCI publication P358 and make use of
UK NA values for partial safety factors, regardless of the Eurocode Country setting.
2 The US resistances are derived from AISC publication Steel Construction Manual
14th Ed and are only given when US Customary units are selected. Separate
resistances are given for LRFD and ASD.

Pre-defined connection types and resistances
For Eurocodes:

With the Member Type set to Simple Beam, three pre-defined connection types
are available for S355 and S275 grades:

• Fin Plates,

• Full Depth End Plates

• Partial Depth End Plates

These have connection resistance values defined for UB and UKB section
beams. The bolts considered are all size M20, of property class 8.8, and
ordinary or flowdrill type. The plates considered are all S275 grade. Fin Plates
and Partial Depth End Plates have resistances defined for beams with 0, 1 or 2
notches, while the resistances for Full Depth End Plates assume no notches.
Fin Plates have resistances for 1 or 2 vertical lines of bolts.

For US (ACI/AISC) and US Customary units:

With the Member Type set to Simple Beam, and the steel grade set to 'Any'
one pre-defined connection type is available:

• Single Plate
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Single Plates have connection resistance values defined for W section beams
of any Fy value. The bolts considered are sizes 3/4 in, 7/8 in and 1 in, from
Group A, with thread condition N, in standard holes. The plates considered are
all of Fy 36 ksi, with thickness ranging from 1/4 in to 9/16 in. Single Plates have
resistances defined for beams with no coping and top flange coping only. All
resistances assume 1 vertical line of bolts only.

In addition, two further Simple Beam connection types are available for the 50
ksi grade:

• All-Bolted Dbl Angle,

• Shear End-Plate

These have connection resistance values defined for W section beams, and for
Single Plates with W section beams of Fy 50 ksi. The bolts considered are sizes
3/4 in, 7/8 in and 1 in, from Group A, with thread condition N, in standard
holes. The plates and angles considered are all of Fy 36 ksi, with thickness
ranging from 1/4 in to 9/16 in. All-Bolted Double Angles have resistances
defined for beams with no coping and top flange coping only, while the
resistances for Shear End-Plates assume no coping. All resistances assume 1
vertical line of bolts only.

NOTE The pre-defined connection types and resistances can be reviewed in
the Connection Resistance dialog (page 1174).

Add user-defined connection types
1. Open the Connection Resistance dialog (page 1174)

2. Under Connection Types, click Add... 

An Add Connection Type dialog appropriate to the current headcode is
displayed.
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3. In the Name box enter a name for the Connection Type. 

If you want to create a Connection Type with a number of variations of
Grade, Notches or Bolt Lines then it is important to enter exactly the same
Name each time - e.g. the database will recognise “CT1” and “CT 1” as
separate Types simply because of the space in the second name. This has
an effect when viewing results in tabular data or reports, where Tekla
Structural Designer carries out an optimisation process to find the first
passing resistance based on the name of the Connection Type and the
number of Bolt Lines and Bolt Rows assigned to that name

NOTE It is possible to use the same Name as one of the pre-defined
Types and it will be recognised in the optimisation process as
essentially being the same Connection Type

4. In the Note box enter any descriptive text you would like to see displayed
in the dialog’s Info box.
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5. Select a Grade or, with US codes, an Fy value. 

Note that subgrades like S355 J0 are ignored e.g. a Connection Type with
S355 Grade assigned will have its resistances applied to beams or braces
of Grade S355 J0, S355 J2, etc.

6. Select # Notches and # Bolt Lines or, with US codes, select Coping, # Bolt
Lines, Bolt Diameter and Thickness (of plate or angle leg).

7. Select the section lists that you will want to define resistances for (this list
can be added to later on if required, in the Edit Connection Type dialog).

8. Click OK 

NOTE OK is not active until a Name has been defined. After clicking OK
‘Hide undefined values’ becomes automatically un-ticked and
resistance values can be entered against the required sections. If
no resistance values are assigned at this stage for at least one
section in a selected Section List, then that List will become de-
selected and have to be re-selected later on.

You are now able to add user-defined connection resistances to the
database against the required sections for this connection type.

Edit user-defined connection types
1. Open the Connection Resistance dialog (page 1174)

2. Under Connection Types, click Edit... 

An Edit Connection Type dialog appropriate to the current headcode is
displayed.

3. Edit the values as required.

4. Click OK

Add user-defined connection resistances
User-defined connection resistances can be added to the database for existing
connection types as follows:

1. If it is not already displayed, open the Connection Resistance dialog
(page 1174)

2. If necessary, use the filters at the top of the dialog until the required
connection is displayed in the Connection Types list.

3. Select the connection in the Connection Types list. The sections are listed
in the Resistances table, along with the bolt rows and resistance values for
the selected connection type.

NOTE If no sections are listed uncheck Hide undefined values.
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4. Select the section type in the Section List.
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5. Resistance values can be entered directly in the table. Alternatively, select
a particular section in the table and click Edit.... This displays the Edit
resistances dialog which allows you to adjust the bolt rows count or to
Add multiples of the same section size with more than one bolt row
count. The bolt row counts can be entered in any order and then use Sort
to number from lowest to highest. Use the Edit resistances dialog also to
Delete data rows if no longer required in your database.
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NOTE Connection resistances are made active as the values are entered.

Related video
Predefined connection resistance database for Eurocode and AISC

Add material properties from the model to a material
database
When you define a member, its material properties are initially read from the
appropriate material database. However, subsequently, the material
properties are held with the member itself. This means that you can open and
run the model on another computer, even if it does not have a matching
material in its database.

When a mismatch between the model's material data and the material
database arises, you are not required to add the missing properties to the
database. It may however be beneficial to do so if you anticipate that you will
need to re-use the property in question in new models.

1. On the Home ribbon, click Materials. 

The Materials dialog box opens.

2. Go to Model.

3. Select the desired objects in the Material data objects in model list.

4. Click Add to Database.

Add materials for a head code
Engineers may need to design using local sections, materials, and
reinforcement. These may not be listed in the materials databases for the
current head code. However, you can add materials to the material database
manually, if necessary.

WARNING If you add data to a material database, you are responsible for
both its accuracy and applicability to the selected design had
code.
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Add a material grade for a head code
1. On the Home ribbon, click Materials. 

The Materials dialog box opens.

2. Go to the Material page.

3. Select the required head code.

4. Select the required material type.

5. If the required grade is not listed for the selected head code, click Add... 

The Add Grade dialog opens.

6. Type in the grade properties.

7. Click OK to return the Materials dialog box 

The new grade is shown in the list of available grades.

8. To make the new grade the default grade for the material in the selected
head code, select the grade and click >> Default.

Add a reinforcement class for a head code
1. On the Home ribbon, click Materials. 

The Materials dialog box opens.

2. Go to the Reinforcement page.

3. Select the required head code.

4. Select the country to assign the reinforcement to.

5. Select the required type and rib type.

6. If the required class of reinforcement is not listed for the selected head
code, click Add... 

The New Reinforcement Class dialog opens.

7. Type in the reinforcement class properties.

8. Click OK to return the Materials dialog box 

The new class is shown in the list of available grades.

9. To make the new class the default class for the combination of the
selected head code and country, select the class and click >> Default.
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Add new reinforcement sizes
When you have created a new reinforcement class, the class does not contain
any specified bar sizes. Therefore, you must add the sizes you intend to use.

1. On the Reinforcement page, click Add... on the right side of the
Available sizes list. 

The New Reinforcement Bar Size dialog opens.

2. Type in the properties of the first bar size.

3. Repeat steps 1 and 2 for all bar sizes that you require.

4. When you are finished, click Close.

Specify the bar size range to be applied in auto design
After the new reinforcement has been added to the materials database, you
can specify the minimum and maximum bar sizes that should apply to the
different concrete members when they are auto-designed.

1. On the Design tab, click Settings.

2. Go to the Concrete page.

3. Locate the reinforcement of each of the following: 

• Beam

• Column

• Wall

• Slab --> Slab on Beams

• Slab --> Flat Slab

• Punching Shear

• Foundations --> Pad Base

• Foundations --> Pile Cap

• Foundations --> Mat Foundations

4. For each of the above, select the country to which the new reinforcement
is registered.

5. For each of the above, select the minimum and maximum bar sizes that
apply to auto design.

The new design options now apply to the current project. If you want them to
apply to new projects as well, save the changes back to the active set.
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Change default design sections for a different head code
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to the Section Defaults page.

3. Select the settings set that you want to modify.

4. In the table on the Section Defaults page, click the currently displayed
section for a member to change it. 

The Select Section dialog box opens.

5. Select the required country.

6. Select the shape in the Page pane on the left.

7. Select the section size in the Item pane on the right.

8. Click Select. 

The default section has now been updated.

9. Repeat steps 4–8 for all the sections that you want to update.

The new default sections will be applied to new models, provided that the
settings set that you modified is the active settings set.

Change default design section orders for a head code
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to the Section Order Defaults page.

3. Select the settings set that you want to modify.

4. In the table on the page, click the currently displayed section for a
member to change it. 

The Select a Section Order dialog box opens.

5. Select the required country. 

NOTE If there are no section orders listed for the selected country, they
do not yet exist for the current head code. However, you can still
create section orders can still be created by using the Import...
feature.

6. Highlight an available section order in the list and click Select. 

The section order has now been updated.

7. Repeat the steps 4–6 for other members that you want to change.

The new section order will be applied to new models, provided that the
settings set that you modified is the active settings set.
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Create new section orders for a head code
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to the Section Order Defaults page.

3. Select the settings set that you want to modify.

4. In the table on the page, click the currently displayed section for a
member to change it. 

The Select a Section Order dialog box opens.

5. Click Export... and save the section order as an XML file.

6. Close the Select a Section Order dialog box.

7. On the Section Order Defaults page, select the settings set that was
originally being modified.

8. In the table, click the section order that you want to change.

9. Select the required country.

10. Click Import... and select the XML file that you just created.

11. Select the imported file by clicking Select.

12. Repeat steps 4–11 for other member types as needed.

Upgrade material databases
The installed material databases each have their own database version. You
can see the version number separately on each page of the Materials dialog
box.

The original data in each of the material databases is system data, and it
cannot be edited. The version number relates specifically to this system data.

From time to time, new system data may become available through an update.
When this happens, an Upgrade button is displayed next to the current
database version on the relevant page of the Materials dialog box. You then
have the choice to either upgrade the database or retain the old version.

NOTE Updating the database version does not cause you to lose any user
data you may have added to the old version, because the user data is
automatically copied back in to the new database.

In certain circumstances, an inconsistency can arise between the user data in a
model and the installed databases. The inconsistencies can be identified and
resolved on the Model page of the Materials dialog box, either by updating
the model data, or by updating the material databases.
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1. On the Home ribbon, click Materials. 

The Materials dialog box opens.

2. Click the Upgrade button next to the current database version number.

Timber property assumptions
The engineer shall verify that the properties of the selected grades are those
that are characteristic of the material, are obtained from up-to-date
manufacturer’s data and are applicable to the analysis model. Analysis
Modification Factors must also be confirmed to be correct.

Head Code Eurocode

The following assumptions have been made:

• Loading will be perpendicular to the wide faces of the laminations (bending
about the major axis).

• Moisture content of the sections will be less than 15% - analysis
modification factors may need to be applied if this is not the case.

• The glulam grade being used complies with the characteristic properties
outlined in BS EN 14080:2013.

• The engineer has verified that the Eanalysis value of the member is suitable
for the particular application.

• The section and strength class are compatible.

Head Code ACI/AISC

The following assumptions have been made:

• The moisture content of the structural composite lumber or glulam section
is less than 16% and the temperature remains below 100°F - analysis
modification factors may need to be applied if this is not the case.

• The glulam section will be loaded perpendicular to the wide faces of the
laminations (bending about the x-x axis).

• The glulam grade being used complies with the characteristic properties
outlined in AWC NDS supplement 2018.

• The engineer has verified that the Eanalysis value of the member is suitable
for the particular application.

• The section and strength class are compatible.
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Add and manage embodied carbon factors
To enable embodied carbon to be calculated in Tekla Structural Designer
default embodied carbon factor (ECF) values have to be set up and saved. You
can set up a local set of factors which apply to the current model only and a
global set of factors which serve as the defaults for new models.

Set up a global set of factors
When setting up standard embodied carbon factors you should add them
directly to a global settings set so that they are available for all new models.

This can be done as follows:

1. On the Home toolbar, click
Settings

2. On the Embodied Carbon page
of the dialog, click Edit...

 The Embodied Carbon Factors dialog
(page 1185) is displayed from where
you can manage the global set of
factors for the active setting set.

When you have finished, click OK to close the dialog and OK to close Settings

Set up and edit the local set of factors
The local set of factors are initially inherited from the global set. Often you
might want to customize these by making specific factors inactive. You might
also want to add project specific factors, for example cladding for walls and
roofs.

These operations should be performed using the Embodied Carbon Factors
dialog (page 1185), which is accessed as follows:

On the Home toolbar, click Embodied
Carbon Factors

The Embodied Carbon Factors dialog
(page 1185) is displayed from where
you can manage the local set of
factors.

 
NOTE Changes to the local set do

not get applied to new
models unless they are saved
to a global settings set
(page 889).
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When you have finished, click OK to close the dialog.

Add factor
1. Open the Embodied Carbon Factors dialog (page 1185)

2. In the Category filter select the category appropriate to the factor you
are about to add. 

TIP If you intend to enter several factors with similar characteristics you
can specify additional Category/Entity filters in advance, before
clicking Add factor. This way you don't have to respecify the filters
for each factor.

3. Click Add factor 

The Add factor dialog is displayed with any Category/Entity filters that
you specified preselected.

4. If the factor being added is from manufacturers data and has an
Environmental Product Declaration (EPD), check the EPD box.

5. In the Name box enter a description for the factor that can be used to
identify it uniquely.

6. Enter the factor.

7. Confirm that the Category/Entity filters are set as you require.
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8. Click OK The factor is added to the list.

You can now continue to add further factors, or if finished, click OK to close
the dialog.

Edit factor
1. Open the Embodied Carbon Factors dialog (page 1185)

2. In the Category filter select the category appropriate to the factor you
want to edit.

3. Select the factor to be edited from the list.

4. Click Edit factor 

The Edit factor dialog is displayed.

5. Edit the values and filters as required.

6. Click OK
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Remove factor
1. Open the Embodied Carbon Factors dialog (page 1185)

2. In the Category filter select the category appropriate to the factor you
want to remove.

3. Select the factor to be removed from the list.

4. Click Remove factor 

The factor is removed from the list.

5. Click OK

Reorder the list of factors
1. Open the Embodied Carbon Factors dialog (page 1185)

2. In the Category filter select the category appropriate to the factors you
want to reorder.

3. Select a factor to be move and drag it to move it up or down the list.

4. Continue moving factors as required, or click OK when done.

Set a factor as active or inactive
1. Open the Embodied Carbon Factors dialog (page 1185)

2. In the Category filter select the category appropriate to the factors you
want to activate/deactivate.

3. Check the box to the left of a factor to make it active, or uncheck to make
inactive. 

4. Click OK when done.

Export factors to a spreadsheet
1. Open the Embodied Carbon Factors dialog (page 1185)

2. Click Export and choose to export either all factors, or active factors. 

A spreadsheet opens listing the factors.

Manage models 911 Manage materials



12.4 Manage properties and property sets
When you create a new entity, default properties for it are displayed in the
Properties window, these can be edited as required before the entity is
placed.

Provided the properties are saved to a property set, they can be applied to
similar entities elsewhere in the current model.

Property sets can also be transferred between models.

In this section we show you how to:

• Save properties to and recall properties from property sets (page 912)

• Apply property sets to existing entities (page 913)

• Review where property sets have been applied (page 914)

• Transfer property sets between models (page 915)

• Delete property sets (page 915)

Related information

See also

Modify the properties of entities or model objects (page 168)

Related video

Property Sets - tutorial

Save properties to and recall properties from property sets
Saving properties to property sets allows you to re-use them elsewhere.

Save properties from the Properties window to a new property set

NOTE You can only save properties in the Properties window to a property
set when there are no entities selected. This ensures that each
property in the property set has an unique entry.

1. From the Model, Design, or Foundations ribbon tab, click the entity type
whose properties you want to save as a property set. 

The list on the top of the Properties window now reads <unsaved set>.

2. Specify the properties according to your needs.

3. Click the Save... button on the top right corner of the Properties window. 

The Add property set dialog box opens.
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4. Name the property set.

5. Click OK.

Save the properties of an existing entity to a named property set
1. Hover the mouse pointer over the desired entity until it becomes

highlighted.

2. Right-click the entity.

3. In the context menu select Create property set... (and if the entity is a
beam or column or wall, select the span or stack required). 

The Add property set dialog box opens.

4. Name the property set.

5. Click OK.

Recall a previously saved property set to the Properties Window
Provided that you have previously saved a property set, you can recall it again
later in the Properties window, if it is applicable to the current command.

1. From the Model, Design, or Foundations ribbon tab, click the desired
entity type. 

The properties applicable to the selected entity type are displayed in the
Properties window.

2. Click the list on the top of the Properties window.

3. In the list, select the desired property set.

Apply property sets to existing entities
You can apply a property set to existing entities in a Structural View, but if
you want to make a lot of changes property sets can be applied more easily
from a Review View.

Apply a property set to an individual entity in a Structural View
1. Hover the mouse pointer over the entity until it becomes highlighted.

2. Right-click the entity.

3. In the context menu, select Apply Property Set... 

The Select property set to apply dialog box opens.

4. Select the desired property set.
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5. Click OK.

The property set is only applied to the individual entity that you right-click,
even if multiple entities were selected. To apply a property set to multiple
entities, see the following topic.

Apply a property set to multiple members in a Structural View
1. Select the entities that you want to update.

2. Ensure that the list on top of the Properties window shows the correct
entity type.

3. On the top right corner of the Properties window, click Apply...

4. Select the desired property set.

5. Click OK.

The property set is now applied to all of the selected entities, provided that
they are of the same type.

Apply a property set in a Review View
1. Open a Review View

2. On the Review tab, click Property Sets.

3. In the Properties window, do all of the following:

a. Set Review/Update to Apply property set.

b. Select the entity type. 

NOTE Only those entity types that already have property sets saved
will be listed.

c. If the Member entity type was selected, you will also need to select
the characteristic.

d. Select the property set that you want to apply.

4. In the Review View, click the entities to which you want to apply the
property set.

Review where property sets have been applied
To graphically review where property sets have been applied, see the following
instructions.

1. Open a Review View

2. On the Review tab, click Property Sets.

3. In the Properties window, set Review/Update as Review All.
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4. Still in the Properties window, select the entity type that you want to
review. 

NOTE Only those entity types that already have property sets saved will
be listed.

Entities of the selected type are color-coded to indicate where property
sets have been applied.

Transfer property sets between models
Once property sets have been saved, they can be exported from the current
model and then imported into another Tekla Structural Designer model.

Export property sets

1. On the Home tab, click Manage Property Sets. 

The Manage Property Sets dialog opens.

2. Select the property sets that you want to export.

3. Click Export...

4. Save the properties as a .tsps file.

Import property sets

1. On the Home tab, click Manage Property Sets. 

The Manage Property Sets dialog opens.

2. Select the property sets that you want to import.

3. Click Import...

4. Select the .tsps file that contains the required property sets.

5. Click Open. 

The imported property sets are now listed in the Manage Property Sets
dialog.
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Delete property sets

1. On the Home tab, click Manage Property Sets. 

The Manage Property Sets dialog opens.

2. Select the property sets that you want to delete.

3. Click Delete.

4. Click OK.

12.5 Create and manage user-defined attributes
You can define user-defined attributes (UDAs) to save miscellaneous data to
files, individual members and panels.

User-defined attributes are flexible, and you can use them for a variety of
purposes. For example, you can:

• Apply descriptive labels, such as construction phases.

• Record paint specifications.

• Attach office documents, pictures, or other associated files.

• Link to design files from other applications.

• Filter material lists and member design reports for specific attributes.

UDA definitions and values

Example UDA definitions are included in the default settings sets. You can
easily modify the definitions according to your needs.

(page 1045) allows you modify the definitions that apply to the current model.
From there you can also set UDAs to be linked so that the same UDA value
gets assigned to all duplicate levels.

You assign specific UDA values to an entity via the Properties window. Once a
UDA value exists, it can also be assigned to or removed from members
graphically by using the Review View. For further details, see: Attach UDA
values to members and panels (page 918)

Attaching files as attributes

When a file is attached as an attribute, you can embed it within the Tekla
Structural Designer file. When embedded, the attached file is included when
the model is transferred to another computer.
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NOTE The embedded file only gets attached to the Tekla Structural Designer
file when the model is saved using Save or Save As.

This means that the embedded files are not attached when you use
Save Model Only. Similarly, if you have to revert to an autosaved
version of the model, the embedded files will not be attached.

Transferring attributes

Attributes are transferred when models are exported to Tekla Structures and
Revit. In the current release, attributes are not yet included for Tekla Structural
Designer drawings.

See also

User-defined attribute settings (page 1045)

Create attribute definitions (page 917)

Attach UDA values to members and panels (page 918)

Apply attribute filters to material lists and reports (page 920)

Create attribute definitions
You can create and modify attribute definitions according to your needs. The
attributes are defined either in the Model Settings dialog box or in the 
Settings dialog box, depending on whether you want the to the attributes be
applied to the current model or new models.

Create attribute definitions in the current model

1. On the Home tab, click Model Settings. 

The Model Settings dialog opens.

2. Go to the User Defined Attributes page.

3. Click Add.

4. Define the following properties: 

• Name

• Type

• Source
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• Values (value choices that apply when the source is value list)

NOTE The order in which UDAs are listed in the replicates the order in
which the UDAs are listed in the Model Settings dialog.

Use the Move Up and Move Down buttons to reorder the UDAs.

Create attribute definitions for new models
1. On the Home ribbon, click Settings. 

The Settings dialog box opens.

2. Go to Settings Sets.

3. Select the settings set to which you want the attributes to apply.

4. Go to the User Defined Attributes page.

5. Define the following properties: 

• Name

• Type

• Source

• Values (value choices that apply when the source is value list)

NOTE The order in which UDAs are listed in the replicates the order in
which the UDAs are listed in the Model Settings dialog.

Use the Move Up and Move Down buttons to reorder the UDAs.

Attach UDA values to members and panels
You can attach office documents, pictures, or other files to the members and
panels of your model. When you attach files to members and panels, they are
embedded in the file. The embedded files will also be included in the model if
the model is transferred to another computer.

See also

Create attribute definitions (page 917)

Attach a UDA value using the Properties Window
1. Select the members or panels to which you want to attach attributes. 

NOTE If the selection contains different member types, select the first
member type in the list at the top of the Properties window.
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2. In the Properties window, under UDA, define the value for each attribute
that you want to attach.

3. If the attribute is a file, select the Embedded option to save the file inside
the model. 

Only embedded files are automatically transferred when the model is
copied to another computer.

TIP For multi-span beams and multi-stack columns or walls, you can
attach separate UDAs to individual spans or stacks.

4. Repeat steps 1-3 for additional member types.

Attach an existing UDA value in the Review View

1. On the Review tab, click UDA.

2. In the Properties window, set [M]ode as Set On or Toggle.

3. In the Properties window, select the attribute.

4. In the Properties window, select a value for the selected attribute. 

NOTE You can use some additional settings in the Properties window to
control which members and panels are displayed in the Review
View.

• Under Filter, you can use the Show and Entity type to select
which attribute values and entities are displayed.

• Select the Color for other values box to display members
that have an other value of the selected attribute.

5. Click the desired members to add the UDA value. 

TIP To remove the UDA value:

• If the [M]ode is set to Set On, change it to Set Off.

• If the [M]ode is set to Toggle, click the selected members again.

Graphically review the attached UDA values

1. On the Review tab, click UDA.

2. In the Properties window, set [M]ode as Review.

3. In the Properties window, select the attribute that you want to review. 

The members or panels are color-coded to represent the different values
of the selected attribute.
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Open a file that has been attached as a UDA

1. On the Review tab, click UDA.

2. In the Properties window, set [M]ode as Review.

3. In the Properties window, select the attribute that you want to review.

4. Click the member or panel to which the file is attached. 

Provided that the extension has been associated with an appropriate
application, the application opens and displays the file.

Apply attribute filters to material lists and reports
User-defined attributes (UDAs) allow you to filter material lists and member
design reports for specific attributes. For more detailed information, see the
following paragraphs.

See also

Create attribute definitions (page 917)

Attach UDA values to members and panels (page 918)

Material list settings (page 1039)

Apply an attribute filter to material list review data
1. On the Review tab, click Tabular Data.

2. In the View Type list, select Material List.

3. In the Filter list, select Selected UDAs. 

The Select filter items dialog box opens.

4. Select the required attribute values.

5. Click OK.

Apply an attribute filter to a report
1. On the Report tab, click Model Report... 

The Report Contents dialog box opens.

2. In the Available Styles list, select the report.

3. In the Report Structure list, right-click the chapter or sub-heading that
you want to filter.

4. In the context menu, select Model Filter --> Edit\New... 

The Select filter dialog box opens.
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5. Click Add.

6. In the Filter properties list, select Selected UDAS.

7. In the Selected items list, select the attribute values.

8. Click OK.

12.6 Manage sub structures
Sub structures are saved user-defined selection groups of any objects which
can be of any size and mix of object types, materials etc. They can be viewed in
isolation and used as filters for many areas of program operation. Using sub
structures has multiple productivity benefits throughout the Tekla Structural
Designer workflow, from model organization and editing through to results
review, design and output.

NOTE In Tekla Structural Designer the term sub structure is specifically used to refer
to a collection of elements, either above or below ground level. It is not being
used to refer to that part of the structure below ground level (e.g. basements
and foundations).

Sub structure characteristics
The basic characteristics of Tekla Structural Designer sub structures are:

• Elements can be a part of more than one sub structure.

• Not every element has to be in a sub structure.

• Deleting a sub structure does not delete the elements within it.

• Sub structures are distinct from, and should not be confused with sub
models (page 488).

• Sub structures themselves are never analyzed.

• Sub structure groups are simply collections of other sub structures.

Create a sub structure
1. To create a sub structure from a Structural View

1. In the scene view, click or box around the members that you wan to
include in the sub structure.

2. Right click and from the context menu select Add to Sub Structure...

3. In the left hand pane of the dialog, all the selected objects are listed with
on/off check boxes
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a. Uncheck any objects that you don't want to be included in the sub
structure.

4. In the left hand pane of the dialog, choose an existing or new
substructure, and if new, enter the sub structure name.

5. Click OK

2. To create a sub structure from the Project Workspace

6. In the Project Workspace open the Structure tree.

7. Expand the Sub Structures branch.

8. Right-click the Sub Structures sub branch, then in the context menu,
select Create Sub Structure.

9. Review the sub structure properties in the Properties window.

10. In the Name field, type the name of the sub structure.

11. Select the color of the sub structure.

12. In the 3D view, click or box around the members that you want to include
in the sub structure.

13. Press [Esc] when complete.

3. To create a sub structure from a Review View

14. On the status bar at the bottom of the window, click Review View.

15. On the Review tab, click Sub Structures.

16. Go to the Properties window.

17. Set Review/Update to Update Selected.

18. Set Update Sub Structure to - - New - -.

19. In the Name field, type the name of the sub structure.

20. Select the color of the sub structure.

21. In the review view, click or box around the members that you want to
include in the sub structure.

22. Press [Esc] when complete.

Edit a sub structure
1. To edit a sub structure from the Project Workspace

1. In the Project Workspace open the Structure tree.

2. Expand the Sub Structures branch, and then the Sub Structures sub
branch within it.
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3. Right-click the sub structure that you want to add to, or remove from.

4. in the context menu, select Edit.

5. Skip to step 7 below.

2. To edit a sub structure from a Review View

6. On the status bar at the bottom of the window, click Review View.

7. On the Review tab, click Sub Structures.

8. Go to the Properties window.

9. Set Review/Update to Update Selected.

10. In Update Sub Structure, select the sub structure that you want to
modify.

11. In Selection Mode, select how you want to modify the structure.

12. In the review view, click or box around the members that you want to
modify.

Delete a sub structure

NOTE Deleting a sub structure only removes the association between the
selected group of members - the members themselves are not
deleted.

1. In the Project Workspace open the Structure tree.

2. Expand the Sub Structures branch, and then the Sub Structures sub
branch within it.

3. Right-click the sub structure that you want to delete.

4. in the context menu, select Delete.

Rename a sub structure
1. In the Project Workspace open the Structure tree.

2. Expand the Sub Structures branch, and then the Sub Structures sub
branch within it.

3. Right-click the sub structure that you want to rename.

4. in the context menu, select Rename.

5. Enter the new name as required.
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Review sub structures

1. On the status bar at the bottom of the window, click Review View.

2. On the Review tab, click Sub Structures.

3. Go to the Properties window.

4. Set Review/Update to Review All. 

Tekla Structural Designer displays each sub structure in a different color.

Create a sub structure group
1. In the Project Workspace open the Structure tree.

2. Expand the Sub Structures branch.

3. Right-click the Sub Structure Groups sub branch.

4. In the context menu, select Create Sub Structure Group.

5. Select the sub structures to be included in the sub structure group.

6. In the Properties window.

a. In the User name field, type the name of the sub structure group.

b. Select the color of the sub structure group.

Open a 3D view of a sub structure
1. In the Project Workspace open the Structure tree.

2. Expand the Sub Structures branch.

3. Double-click the sub structure. 

Tekla Structural Designer opens a 3D view of the selected sub structure.

TIP To open a solver view of the sub structure, right-click the sub
structure, and select Open solver view.

4. Once the view has opened, a  (Ghosted) button is displayed in the
bottom right corner. Clicking this button toggles the display to either show
just the sub structure, or the sub structure with a 'Ghosted On' view of the
rest of the model.
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Use Ghosted to see the view in the context of the whole
model

You can toggle Ghosted on and off using the  button.

NOTE The  Ghosted button is displayed in in the bottom corner of Sub Structure
and Sub-model Views. It is also displayed in Level, Frame, and Slope Views
when they have been toggled into 3D (via the 2D/3D toggle button).

• Ghosted off: the view is displayed in isolation.

• Ghosted on: the view is displayed in the context of the whole structure.

Manage models 925 Manage sub structures



Related video

Ghosted Structure view

Related information

Related videos

How do I use Sub structures?

Sub Structure enhancements

See also

Check all members and walls in a sub structure (page 609)

Design all slab items in a sub structure (page 625)

Check all slab items in a sub structure (page 624)
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12.7 Working with large models
Although bigger models will typically need more RAM, you should note that it
is the volume of model data and results data created during analysis and
design that generates the demand for RAM, so by controlling the volume of
data you are able to influence the speed of solution.

Your modelling and design choices can affect the volume of data produced;
some of the more significant of these choices are discussed below:

Don't mesh concrete slabs in 3D Analysis

Meshing is not necessary in 3D Analysis for traditional Beam and Slab models
as these can use FE decomposition instead.

It is also not necessarily required for Flat Slab models, however, it does
become required if you have a transfer slab. It is not critical unless the slab is
part of the lateral resistance system.

By default the Mesh 2-way slabs in 3D analysis option that controls this is not
checked at any level; you should only check it at a given level when you have
good reason to do so.

Using coarser shell meshing in large models

You should review and consider adjusting the mesh parameters as the
defaults can often be conservative.

• Using coarser mesh parameters has no impact on sway or modal
frequencies.

• If you are not concentrating on slab design you can use very coarse
meshes.

Ultimately it is your responsibility to be comfortable with the level of mesh
refinement applied to the model. However we would definitely recommend
using a courser mesh during design development and then perhaps consider
refining a bit more at final design stage.

Using coarser semi-rigid diaphragm meshing in large models

If you have employed semi-rigid diaphragms and are experiencing
performance issues you should review and consider adjusting the semi-rigid
mesh parameters.

It has been observed that using refined semi-rigid meshes generally has
negligible impact on results and only has the effect of slowing down analysis
and increasing memory requirements. It is suggested that the default mesh
parameters may be more refined that is actually necessary.

Limit the number of loadcases and combinations

You can control the number of combinations created when running the
Combination Generator.
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In particular you should consider limiting the number of wind loadcases and
combinations.

Also:

• Don't add wind loading during the initial design development.

• Don't activate pattern loadcases and combinations until you need to,
probably only at the final design stage.

Alternative design approach for large models

For large models, rather than running Design All you may be able to save time
by running Analyse All instead and then run a selective design, such as:

• Design by level

• Design by frame

• Design by group

• Design by sub-structure

• Design by member

Effective use of Auto Design

Although for the first design run you might choose to use select bars starting
from Minima, on subsequent runs it is generally more efficient to use select
bars starting from Current; this will run a check on the current steel provision
and if inadequate, it will automatically re-select new steel bars to pass the
design.

Check Design can also be very effective - you can turn off the Autodesign and
then manually deal with any fails.

Design members for FE chasedown analysis results

This is set in the design options for concrete and by default it is checked on for
beams, columns and walls. However in a traditional Beam and Slab model it
may not actually be necessary; it is generally not critical unless you have some
unusual transfer level challenge. In large models you should therefore
consider unchecking it.

Re-design columns (or beams) using previous analysis results

If you change the size of a member you can try out its design without being
forced to re-analyse.

Basically you can make any edit you want that does not change the number of
stacks in a column, (or spans in a beam); although the analysis results will be
marked as out of date, you can still do a design for the changed member
based on the old analysis results.

So using the list below as examples design can still be done in all the cases
noted:

1. Changing column (or beam) size but retaining shape - designs ok (but see
3 and 4).
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2. Changing column (or beam) shape - designs ok (but see 3 and 4).

3. Making column (or beam) smaller so that previously attached members
no longer attach - this changes number of stacks - design beyond scope.

4. Making column (or beam) larger so that previously un-attached members
now attach - this changes number of stacks (spans) - design beyond
scope.

5. Adding / editing / deleting beams that attach to a column - design remains
possible up to the point that it affects number of stacks - OK

6. Adding / editing / deleting flat slabs that attach to a column - design
remains possible up to the point that it affects number of stacks - OK

7. Adding / deleting stacks or levels (or editing level properties) - Adjusting
Levels designs ok because number of stacks is the same. If you add or
remove stacks then design is beyond scope.

Model organisation

Tekla Structural Designer has a number of features for organising the model
than can each be used to increase efficiency:

• Grouping - one design is applied to all members in the group.

• Sub-structures - allow you to focus on specific areas of interest.

• Duplicate levels - generally save modelling time and reduce the volume of
data.

When using duplicate levels, you can achieve further efficiency by designing
slabs for a fine mesh at one level only, and then check the slabs at duplicates
of the level using a courser mesh result.

NOTE Because meshing parameters are "sub model", rather than "level" based, to
achieve this you would set coarse mesh parameters in the structure settings
but then override them for an individual sub model.

Our general advice for duplicate levels is:

• For preliminary design set a coarse mesh for entire structure

• For final design where there are a lot of duplicate levels

• possibly refine the mesh used for the entire structure a little

• but for each set of duplicate levels, select one and adjust the relevant
sub-model parameters to get a finer mesh.

Model complexity

Do not model every little architectural detail - especially not things like small
holes in slabs and walls.

Design Options

Take control (get it right at the beginning!)
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13 Tekla Structural Designer
reference

This section contains reference information mainly on settings, options, and
sign conventions, but with with various other miscellaneous reference topics
included also.

• Properties (page 930)

•

• Settings (page 1032)

• Dialogs (page 1172)

13.1 Properties
This section describes properties of the main object types.

Structure geometric/analytical properties:

• Structure Properties (page 931)

• Level Properties (page 933)

• Frame Properties (page 935)

• Slope Properties (page 936)

• Sub Model Properties (page 937)

Member properties:

• Beam properties (page 938)

• Brace properties (page 951)

• Column properties (page 956)

• Concrete meshed and mid-pier wall properties (page 965)

• Concrete core properties (page 973)
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• Slab item properties (page 982)

• Foundation mat properties (page 988)

• Pad base strip base and pile cap properties (page 993)

Industrial object properties:

• Line ancillary properties (page 1001)

• Area ancillary properties (page 1004)

• Equipment properties (page 1006)

Other object properties:

• Bearing wall properties (page 1008)

• Shear only wall properties (page 1011)

• Wall Panel Properties (page 1013)

• Roof Panel Properties (page 1015)

• Slab/Mat overhang properties (page 993)

• Support properties (page 1017)

• Analysis Element properties (page 1020)

• Base plate properties (page 1022)

• Patch properties (page 1024)

• Punching check properties (page 1027)

• Result strip properties (page 1031)

Structure Properties
Use the Structure properties to view or modify the basic properties of the
structure.

Property Description
Building
Direction
Rotation

Defines the building direction relative to the Global Axis System

The default (0 degrees) aligns the building direction 1 arrow with
the global X axis and the direction 2 arrow with the global Y axis.

Entering a positive value rotates the Building Direction arrows
clockwise about positive Global Z, a negative value rotates anti-
clockwise. The limiting values are +45 degrees and -45 degrees. (If
you enter larger values they will be capped at these limits).

The building direction arrows are always at 90 degs to each other.
Show
Building
Arrows

When shown, building direction arrows are displayed in all 2D
and 3D Views.
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Property Description
Building
Direction
Labels

The labels to be used for the building direction arrows.

The options are:

• Dir 1/2

• Dir H/V

• Dir X/Y
Conseque
nce class

Defines kFl used in strength combinations.

• CC3 - kFl = 1.1

• CC2 - kFl = 1.0

• CC1 - kFl = 0.9

NOTE Applies to Finland (Eurocode) head code only

Reliability
class

Defines γd used in strength combinations.

• RC3 - γFl = 1.0

• RC2 - γFl = 0.91

• RC1 - γFl = 0.83

NOTE Applies to Sweden (Eurocode) head code only

Shell
Mesh Size

Defines the shell mesh size for two way spanning slabs.

NOTE To optimize solution time consider using a coarser mesh
during design development before switching to a more
refined mesh at the final design stage.

Shell
Uniformit
y Factor

Defines the shell mesh uniformity for two way spanning slabs.
(100% = maximum uniformity).

Semi-Rigid
Mesh Size

Defines the mesh size for roof panels, and slabs when modeled
as semi-rigid diaphragms.

Semi-Rigid
Uniformit
y Factor

Defines the semi-rigid mesh uniformity for roof panels, and slabs
when modeled as semi-rigid diaphragms.

Semi-Rigid
Mesh
Type

Defines the semi-rigid mesh type for roof panels, and slabs when
modeled as semi-rigid diaphragms

The options are:

• QuadDominant

• QuadOnly
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Property Description
• Triangular

Wall Mesh
Horizontal
Size

Defines the horizontal mesh size for all meshed walls in the
model - but can be overridden in individual wall properties.

Wall Mesh
Vertical
Size

Defines the vertical mesh size for all meshed walls in the model -
but can be overridden in individual wall properties.

Wall Mesh
Type

Defines the mesh type for all meshed walls in the model, (but can
be overridden in individual wall properties):

The options are:

• Quad only

• Tri only

• Quad dominant

Level Properties
Use the Level properties to view or modify the basic properties of a level.

General
Level The height of the construction level above the base level
Floor By setting a construction level to be a Floor you are indicating

that it is a major level in the building. Floor levels are used to
determine items such as your inter story height and positions
from which column splices are laid out. If a level is not set to be a
floor then no live load reductions will be accounted for in the
beams at that level, or in the columns supporting that level.

There can certainly be a number of levels that are clearly floor
levels, but there could be many others that are not. For example
you create intermediate levels in order to define:

• half landing levels and stairs,

• K Bracing - you require a construction level for the
intermediate bracing connection points,

• steps in the building floor levels.

Where you define a level which is clearly not a floor, then you
should not check the floor box.
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General
Check for
drift

If this option is unselected, the sway/drift, seismic drift and wind
drift check results for all column stacks and wall panels at the
specific level are excluded from the tabular review data.

In addition, the height of structure considered in the Overall Wind
Drift check (page 679) is determined according to how this option
has been set - the height used being the distance between
highest level and the lowest level in the model that have Check
for drift selected.

NOTE This option is only displayed if the Floor option described
above is selected.

Type The level type can be:

• T.O.S = Top of Steel

• S.S.L = Structural Slab Level

• T.O.F = Top of Foundation

NOTE Slabs are modeled above the level when it is set to T.O.S
or T.O.F but below the level when it is set to S.S.L

Short
Name

Each construction level should be given a unique reference.
Typically this might be a storey number, 1, 2 , 3 etc.

Long
Name

Each construction level can also be given a name to further assist
identification. 'First Floor', or 'Mezzanine' etc.

Name Automatically generated from the short and long name. By
default this will be used as the name in the Structure tree

Mesh 2-
way Slabs
in 3D
Analysis

• On = 2-way slabs are meshed in the 3D building analysis and
grillage chasedown analysis in addition to the FE chasedown
analysis.

• Off = 2-way slabs are only meshed in the FE chasedown
analysis.

NOTE The Sub Model in which the Level is contained
determines the mesh parameters that are applied.

Include in
Export

Determine whether Level should be included in CXL or IFC export.

• Floor Only - include only if defined as a Floor.

• Yes - always include.

• No - never include.

NOTE The lowest Level will always be exported.
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General
Show
grids in
plane
view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in plane views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off

• Off = Grid & construction lines are always off, irrespective of
the Scene Content Grid & Construction Lines checkbox
setting

Show
grids in
3D view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in 3D views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off for the specified
level

• Off = Grid & construction lines are always off for the specified
level, irrespective of the Scene Content Grid & Construction
Lines checkbox setting

NOTE This setting does not control the display of Architectural
Grids which have a separate checkbox in Scene Content.

Decompo
sition>
Keep
solver
model

Controls whether you will be able to review the solver model
used for load decomposition between each analysis run:

• On = the solver model is retained, you might choose to use
this setting if you need to investigate any validation warnings
that relate to load decomposition.

• Off (default) = the solver model is discarded immediately after
analysis has been performed.

Decomposition
Keep
solver
model

Controls whether you will be able to review the solver model
used for load decomposition between each analysis run:

• On = the solver model is retained, you might choose to use
this setting if you need to investigate any validation warnings
that relate to load decomposition.

• Off (default) = the solver model is discarded immediately after
analysis has been performed.

Frame Properties
Use the Frame properties to view or modify the basic properties of a frame.
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Property Description
Name Automatically generated, but can be replaced by User name if

required.
Show
grids in
plane
view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in plane views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off

• Off = Grid & construction lines are always off, irrespective of
the Scene Content Grid & Construction Lines checkbox
setting

Show
grids in
3D view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in 3D views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off for the specified
frame

• Off = Grid & construction lines are always off for the specified
frame irrespective of the Scene Content Grid & Construction
Lines checkbox setting

NOTE This setting does not control the display of Architectural
Grids which have a separate checkbox in Scene Content.

Visible Controls whether the frame view can be opened or not.

Slope Properties
Use the Slope properties to view or modify the basic properties of a frame.

Property Description
Name Automatically generated, but can be replaced by User name if

required.
Show
grids in
plane
view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in plane views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off

• Off = Grid & construction lines are always off, irrespective of
the Scene Content Grid & Construction Lines checkbox
setting
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Property Description
Show
grids in
3D view

Controls whether the Grid & Construction Lines checkbox in
Scene Content has any effect in 3D views:

• On = The Scene Content Grid & Construction Lines checkbox
switches grid & construction lines on and off for the specified
slope

• Off = Grid & construction lines are always off for the specified
slope irrespective of the Scene Content Grid & Construction
Lines checkbox setting

NOTE This setting does not control the display of Architectural
Grids which have a separate checkbox in Scene Content.

Visible Controls whether the slope view can be opened or not.

Sub Model Properties
Use the Sub Models properties to view or modify the selected sub model.

Property Description
Override
model's

Select this check box in order to override the Structure meshing
properties in the current sub model.

Shell
Mesh Size

Defines the shell mesh size for two way spanning slabs in the sub
model.

Shell
Uniformit
y Factor

Defines the shell mesh uniformity factor for two way spanning
slabs in the sub model.

Slab Mesh
Type

Defines the shell mesh type used in the sub model.

These options are:

• Quad only

• Tri only

• Quad dominant
Semi-Rigid
Mesh Size

Defines the semi-rigid mesh size when slabs are modeled as
semi-rigid diaphragms in the sub model.

Semi-Rigid
Uniformit
y Factor

Defines the semi-rigid uniformity factor when slabs are modeled
as semi-rigid diaphragms in the sub model.
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Property Description
Semi-Rigid
Mesh
Type

Defines the semi-rigid mesh type when slabs are modeled as
semi-rigid diaphragms in the sub model.

The options are:

• Quad only

• Tri only

• Quad dominant

Beam properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Group The name of the group to which the member belongs.

See: ,
Plane Indicates the level or frame within which the member is

placed.
Characteristic Beam
Active Clearing this option makes single span beams inactive in

the analysis.

See: Inactive members (page 306)

NOTE Only displayed for single span members

Material type • Steel

• Concrete

• Timber

• General

• Cold formed

• Cold rolled
Construction,

Fabrication

The available construction and fabrication options depend
on the characteristic and material type selected, see
Member characteristic, construction and fabrication
properties (page 978)

Autodesign See: ,

Tekla Structural Designer reference 938 Properties



General
Design section
order

(steel only)

The design order file from which a section size will be
selected.

NOTE Only displayed for Autodesign

For details of managing order files, see: Manage design
section orders (page 892)

Select bars
starting from

(concrete only)

This option controls the starting point for auto-design
procedures and is therefore only displayed if Automatic
design is ‘on’. It applies to both longitudinal bars and links.

• Minima (default) - removes the current arrangement and
begins with the minimum allowed bar size.

• Current - the auto design commences from the current
bar arrangement.

See: ,
Gravity only Controls whether the member is defined for gravity

combinations only, or gravity plus lateral:

• On = designed for gravity combinations only

• Off = designed for gravity and lateral combinations

See:
Rotation Rotation of the member about its local x axis.

The default (Degrees0) aligns the major properties with the
global Z axis, (provided that the member has not been
specifically defined within an incline plane).

Global offset
end 1,

end 2

Can be used to model a physical offset with respect to the
global axes at one or both ends of the member, (exceptions
apply).

See: Member global offsets (page 231)
Major snap
level,

Minor snap
level

(not concrete)

Defines the major and minor alignment of the member
relative to the insertion point.

Major offset,

Minor offset

(not concrete)

Used to offset the member from the snap point in the
major and minor axis.

Allow automatic
join end 1,

When this check box is selected - the end in question will be
automatically joined to a suitable connecting concrete
beam end during design process or when the ‘Beam Lines’
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General
end 2

(concrete only)

command is run, (providing the Beam Lines limiting criteria
specified in Model Settings are met.)

All spans
Section The section size
Concrete type,

Grade/Class

While you can apply both normal and lightweight concrete,
wall design using lightweight concrete is currently beyond
scope.

Linearity • Straight

• Curved Major

• Curved Minor
Chord height This property is only displayed when ‘Linearity’ is curved

major or curved minor. It is the perpendicular distance
from the mid point of the chord baseline to the curve itself.

Maximum facet
error

This property is only displayed when ‘Linearity’ is curved
major or curved minor. It controls number of straight line
elements that replace the curved member in the solver
model.

See: Analysis Model settings (page 1040)
Top flange cont.
rest.

(steel and
composite
beams only)

Define if the top flange is continuously restrained.

Alignment (concrete only)
Major snap
level,

Minor snap
level,

Define the major and minor alignment of the member
relative to the insertion point.

Major offset,

Minor offset

Used to offset the member from the snap point in the
major and minor axis.

Releases
Free end 1,

end 2

When this check box is selected - defines a cantilever end.

Fixity end 1,

end 2

• Moment

• Pin

• Fully fixed

See: Beam releases (page 949)
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All spans
Axial load
release end 1,

end 2

Check one end only to define an axial release.

Torsional load
release end 1,

end 2

Check one end only to define a torsional release.

My stiffness
end 1, end 2

This property controls end fixity in the Major direction. It is
only displayed when ‘Fixity’ is Fully fixed, or Moment. The
choices are:

• Fixed (default)

• Spring linear

• Partially fixed
Stiffness y end
1, end 2

When ‘My stiffness’ is set to Spring linear, this property
allows you to specify the major direction stiffness in terms
of a linear spring value.

When ‘My stiffness’ is set to Partially fixed, this property
allows you to specify the major direction stiffness as a
percentage of a fully fixed connection. (% of 4EI/L).

Mz stiffness end
1, end 2

This property controls end fixity in the Minor direction. It is
only displayed when ‘Fixity’ is Fully fixed. The choices are:

• Fixed (default)

• Spring linear

• Partially fixed
Stiffness z end
1, end 2

When ‘Mz stiffness’ is set to Spring linear, this property
allows you to specify the minor direction stiffness in terms
of a linear spring value.

When ‘Mz stiffness’ is set to Partially fixed, this property
allows you to specify the minor direction stiffness as a
percentage of a fully fixed connection. (% of 4EI/L).

Wind loading
Apply open
structure wind
load

Select this flag if you want open structure wind loads to be
calculated.

See:
Shape factor, Cf The default shape factor varies according to the entity type

and is taken from Model Settings > Loading > Wind
Loading
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All spans

NOTE Default Cf factors are taken from the document
‘Wind Loads For Petrochemical And Other Industrial
Facilities’ published by ASCE.

Effective area XY
Formula The default effective area formula varies according to the

entity type and is taken from Model Settings > Loading >
Wind Loading

Factor The factor used in the above formula can be edited if
required.

Effective area XZ
Formula The default effective area formula varies according to the

entity type and is taken from Model Settings > Loading >
Wind Loading

Factor The factor used in the above formula can be edited if
required.

Load reductions
KLL

(Head Code
ACI/AISC)

Specify the KLL factor in accordance with Table 4-2 in
ASCE7-05/ASCE7-10.

See:
Reduce
imposed loads
by

(All other Head
Codes)

This property is particularly applicable to the design of
transfer beams.

Although the percentage of imposed load reduction is not
determined automatically for beams, this property allows
you to specify the percentage manually.

It can be applied to all, or individual spans.

• reducible loadcases are reduced

• combinations incorporating reducible loadcases are
reduced

The reduced results are used in concrete beam design.

See:
Deflection limits (steel only)
Apply span
\factor

With this option checked, the limit can be defined as a
Relative span/factor.

Apply abs. limit With this option checked, the limit can be defined as
absolut value.

Limit for
immediate live
load deflection,

These options control how the deflection is calculated.
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All spans
Limit for total
deflection
affecting
sensitive
finishes

Calculate total
deflection at
design time

Calculate
deflection after
installation of
finishes

(ACI only)
Torsion (steel only)
Check for
torsion,

Apply rotational
limit

Used to specify if the member should be checked for
torsion, and also to apply a rotational limit if required.

See:

Camber (steel only)
Apply camber Used to specify a camber to the beam if required.

See:
Natural frequency (non-composite and composite beams only)
Calculate
natural
frequency

For composite beams this is fixed to on (for EC and BS
headcodes only) and is utilized during autodesign. The
calculated natural frequency is displayed in the results
viewer.

Check natural
frequency
against
minimum

For composite beams this is fixed to on (for EC and BS
headcodes only). For non-composite beams it can be used
in conjunction with the 'Calculate natural frequency'
property to impose an optional 2-step control, ‘calculate’
and ‘check’, which allows for the natural frequency value to
be calculated (and displayed in Results Viewer) with or
without the check. While the US headcode has no
requirement for this check, it can still be requested if
required.

When performed, a simple (design model) approach is
taken based on uniform loading and pin supports. This
fairly simple calculation is provided to the designer for
information only. The calculation can be too coarse
particularly for long span beams and does not consider the
response side of the behavior i.e. the reaction of the
building occupants to any particular limiting value for the
floor system under consideration. In such cases the
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All spans
designer has the option to perform a 1st Order Modal
Analysis.

See:

•

•
Minimum
natural
frequency

The minimum value against which the natural frequency is
checked (default 4Hz).

Include self
weight (beam &
slab)

Include other
dead loads

Include live
loads (US)

Include
imposed loads
(other
headcodes)

The engineer can specify the percentages of each of these
loads to be included in the calculation of the maximum
static instantaneous deflection, δ

Factor for
increased
dynamic
stiffness of the
concrete flange

For composite beams this factor is applied to the beam's
short term modular ratio

Effective width

Calculate
effective width

For composite beams the effective width can either be
entered directly or calculated from the geometry.

See:

•

•

•
Size constraints (steel only)
Max depth,

Min depth,

Max width,

Min width

Size Constraints are only applicable when Autodesign is
checked. They allow you to ensure that the sections that
Tekla Structural Designer proposes match any particular
size constraints you may have. For instance for a composite
beam you may want to ensure a minimum flange width of
150mm (6in). If so you would simply enter this value as the
Minimum width, and Tekla Structural Designer would not
consider sections with flanges less than this width for the
design of this beam.

See:
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All spans
Apply max
span/depth
ratio

Max span/
depth ratio

After setting a max span/depth ratio you can check the
'Apply' button for it to be considered by auto-design. During
design, only sections which satisfy the maximum ratio limit
will be selected.

The setting can also be reviewed and/ or copied via Review
View > Show/Alter State.

See:
Instability factor (steel only)
Prevent out of
plane instability

Define if out of plane stability is prevented.

See:
  
Analysis & design control (concrete only)
Structure
supporting
sensitive
finishes (ACI
and Eurocode
only)

Any beam that supports or is attached to partitions or other
constructions likely be damaged by large deflections should
be identified as such by selecting this property.
ACI - The deflection method applied to the beam depends
on this setting as follows:

• beams not required to support sensitive finishes adopt
the simplified method.

• beams required to support sensitive finishes adopt the
rigorous method.

Eurocode - The f2 parameter used in the deflection check
depends on this parameter as follows:

• When selected: f2 is calculated as MIN[1,7/Leff]

• When unselected: f2 will be taken as 1.0.
Increase
reinforcement if
deflection check
fails (Eurocode
BS and IS only)

Select in order to increase the reinforcement during the
auto-design process if the deflection check fails.

Permissible
increase in
reinforcement

Specify the max percentage increase in reinforcement that
is allowed in order to satisfy the deflection check.

Consider
flanges

Select in order to consider flanges in the concrete beam
design calculations - once checked additional fields are
displayed for specifying an allowance for openings.

Flange dimensions can only be calculated by editing the
beam once it has been positioned and slabs have been
defined. (In this case a ‘Calculate flanges’ button is also
displayed, this can be clicked in order to automatically
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calculate the flange dimensions based on the adjoining
slabs.)

See:
Include flanges
in analysis NOTE This property is only displayed when the ‘Consider

flanges’ option has been selected.

Select this check box to use flanged beam properties when
the analysis is performed.

See:
Isolated beam
(ACI only) NOTE This property is only displayed when the ‘Consider

flanges’ option has been selected.

Select this check box in order to apply ACI 318 clause 8.12.4.

When the check is performed, if the flange geometry does
not meet the requirements the flanges are ignored.

See:
User defined
flange (left/
right)

NOTE This property is only displayed when ‘Include
flanges in analysis’ has been checked.

If you clear this check box the flange depth and the effective
flange width are determined automatically.

If you select the check box, two new properties are
displayed for defining ‘Flange width’ and ‘Flange depth’.

See:
Ignore lateral
instability
(Eurocode only)

This option allows you to ignore lateral instability for
slender spans to EC2 clause 5.9(1).

• When selected: the slender span check is excluded from
design

• When unselected (default): the slender span check is
included.

Assume cracked Assuming concrete sections are cracked has a direct affect
on the analysis; smaller Modification Factors are applied
to cracked sections causing an increase in deflection.
Indirectly the design can also be affected because the sway/
drift sensitivity calculations are also influenced by this
assumption.

See:
Design parameters (concrete only)
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Nominal cover
beam top edge,

bottom edge,

section side,

beam ends

The nominal concrete cover is the distance between the
surface of the reinforcement closest to the nearest concrete
surface (including links and surface reinforcement where
relevant) and the nearest concrete surface. Different values
of nominal cover can be specified to the beam edges, sides
and ends.

Seismic
In a seismic
force resisting
system

If this is the case, select the check box, and then specify the
SFRS direction and type.

NOTE Design of members in seismic force resisting
systems is only supported for the ACI/AISC Head
Code in the current release.

Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 613)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

Fire proofing
Check for fire
resistance NOTE This property is only displayed for non-composite,

simply supported rolled steel beams to Eurocodes.

On

• When the check is requested, the additional properties
shown below are required.
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Fire proofing
See:

Off

• no check is performed
Protected On

• When members are set as 'Protected', self-weight of the
members is increased by the weight of fireproofing.

See: Fire proofing (page 950)

• If 'Check for fire resistance' is also selected, the check is
performed using the 'protected' time interval for critical
temperature iteration, as specified in Design Settings

Off

• If 'Check for fire resistance' is also selected, the check is
performed using the 'unprotected' time interval for
critical temperature iteration, as specified in Design
Settings

Fire check (steel only, Eurocode only)
Load reduction
factor

0.65, or user input value.

Required time
of fire exposure

R15, R30, R60, R90, or R120

Exposure Exposed on three, or four sides

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)

Reinforcement (concrete beams only)
Rib type -
vertical, Class -
longitudinal

Specifies the longitudinal reinforcement properties

Rib type - link,
Class - link

Specifies the link properties.
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Reinforcement (concrete beams only)
Top longitudinal
bar pattern,

Bottom
longitudinal bar
pattern

Choose from standard patterns (which can be setup in
Design Options) to control the top and bottom bar
arrangement when the beam is auto-designed.

See:

Span 1, 2, 3 etc.
In a multi-span beam properties can be entered for a
specific span, over-riding those defined at the All spans
level.

Beam releases
Releases at the two ends of a beam span can be set as follows:

• Pin - Pinned to the support or supporting member. This means pinned
about the major and minor axes of the section but fixed torsionally.

• Fully fixed - with the following major (My), and minor (Mz) stiffness sub-
options to allow definition of partial fixity in each direction if required:

• Fixed - Encastré, all degrees of freedom fixed.

• Spring linear - allows you to specify a linear spring stiffness value.

• Partially fixed - allows you to specify partial fixity as a percentage of a
fully fixed connection (%4EI/L)

• Moment (pin Mz) - Major axis moment connection, and pinned about the
minor axis.

• Moment (pin My) - Minor axis moment connection, and pinned about the
major axis.

• Fully fixed (free end) - Denotes a cantilever end. It is achieved by selecting
Free end.

(In a single span beam this box can only be checked if the opposite end is
fully fixed.)

• Continuous - This setting is automatically applied when a continuous
beam is created and effectively creates a non-editable fully fixed
connection between the spans of the continuous member. The connection
can only be edited by splitting the beam.

In addition to the above release options you are also able to apply a torsional
release at either end by checking the appropriate box. Similarly an axial
release can be applied to beams of all materials apart from concrete.

NOTE Moment (pin My) this (unusual) release type is not available in the Properties
Window and can only be specified as follows:
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1. Right-click the beam to display the context menu.

2. Choose Edit

3. From the Beam Property Dialog open the Releases page.

4. Check the Mz and uncheck the My degree of freedom at the desired end as
required.

Fire proofing
Fire proofing is the application of fire resistance material on the surface of
structural members in the form of:

• protective paints

• thin/thick film coating

• sprays

• fire boards

In Tekla Structural Designer fire proofing can be applied as a surface coat to
members, defined by a thickness and density.

NOTE Fire proofing can be applied to all 1D member types apart from analysis
elements, DELTABEAM, and FABSEC beams.

The additional self weight of fire protection material is then added to the "Self-
weight - excluding slabs" loadcase.

NOTE If Calc Automatically is unselected for the "Self-weight - excluding
slabs" in the Loading dialog, neither the member self weight, or the
fire proofing self weight are calculated.

How to apply fire proofing

Fireproofing is applied to a member by selecting ‘Protected’ under the 'Fire
proofing' heading in the member properties. It can also be applied graphically
using the Fire proofing attribute (page 737) in Show/Alter state.

Fire protection material details

Property Description
Exposure • Exposed on three sides (Applicable for beams only)

• Exposed on all sides
Shape Contour encasement
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Property Description

Hollow encasement

Thickness Thickness of fire proofing material
Density Density of fire proofing material
Selfweight Calculated self weight of fire proofing material per unit

length.

Brace properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Group The name of the group to which the member belongs.

See:
Plane Indicates the level or frame within which the member is

placed.
Characteristic Brace
Active Clearing this option makes the brace inactive in the

analysis.

See: Inactive members (page 306)
Material type • Steel

• Timber

• General

• Cold formed
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General
Construction,

Fabrication

The available construction and fabrication options depend
on the characteristic and material type selected, see
Member characteristic, construction and fabrication
properties (page 978)

Autodesign See: ,
Design section
order

(steel only)

The design order file from which a section size will be
selected.

NOTE Only displayed for Autodesign

For details of managing order files, see: Manage design
section orders (page 892)

Rotation Rotation of the member about its local x axis.
Alignment
Global offset
end 1,

end 2

Can be used to model a physical offset with respect to the
global axes at one or both ends of the member, (exceptions
apply).

See: Member global offsets (page 231)
Major snap
level,

Minor snap
level

Defines the major and minor alignment of the member
relative to the insertion point.

Major offset,

Minor offset

Used to offset the member from the snap point in the
major and minor axis.

All spans
Section The section size
Grade The material grade
Connection • Bolted

• Welded
Compression only,

Tension only

Specify if the brace is compression
only, or tension only.

NOTE Tension only and
Compression only members
are non-linear elements and
therefore require non-linear
analysis. If linear analysis is
performed they will be
treated as linear elements
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Relaxation factor Only displayed if the brace is tension

only (default 0.0).

Any value entered is not used unless
you also check the ‘Use relaxation
factors for tension only elements’ box
in Analysis Options.

NOTE It is highly unlikely that you
would ever need to set a
specific release factor for an
individual brace.

See 1st order non-linear settings in:
Analysis Settings (page 1050)

Releases
Fixity end 1,

end 2

• Pinned

Torsional load release end 1,

end 2

Check one end only to define a
torsional release.

Vertical load release end 1,

end 2

A vertical load release can be applied
to the end of a V or A type brace pair
so that they don’t prop other
members against gravity loads, (you
are prevented from releasing single
braces, or other brace pairs in this
way).

Include force in eccentricity moment
end 1,

end 2

Eccentricity moments in steel and
precast columns as a result of beam
connection eccentricities do not also
consider the brace connection
eccentricities unless this property is
checked for the appropriate end of
the brace.

• When checked ON the brace axial
force is resolved into a vertical
force, multiplied by the connection
eccentricity, to obtain a
connection eccentricity moment.

• When checked OFF the brace axial
force does not contribute to the
total connection eccentricity
moment.

See:
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• Steel column connection

eccentricity moments - overview

• Precast column connection
eccentricity moments - overview

Wind loading
Apply open structure wind load Select this flag if you want open

structure wind loads to be calculated.

See:
Shape factor, Cf The default shape factor varies

according to the entity type and is
taken from Model Settings >
Loading > Wind Loading

NOTE Default Cf factors are taken
from the document ‘Wind
Loads For Petrochemical And
Other Industrial Facilities’
published by ASCE.

Effective area XY
Formula The default effective area formula

varies according to the entity type
and is taken from Model Settings >
Loading > Wind Loading

Factor The factor used in the above formula
can be edited if required.

Effective area XZ
Formula The default effective area formula

varies according to the entity type
and is taken from Model Settings >
Loading > Wind Loading

Factor The factor used in the above formula
can be edited if required.

Load reductions
KLL

(Head Code ACI/AISC)

Specify the KLL factor in accordance
with Table 4-2 in ASCE7-05/ASCE7-10.

See:
Reduce imposed loads by

(All other Head Codes)

Although the percentage of imposed
load reduction is not determined
automatically, this property allows
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you to specify the percentage
manually.

• reducible loadcases are reduced

• combinations incorporating
reducible loadcases are reduced

See:
Compression
Effectve length factor y-y,

z-z

 

Tension
Net area Specified as an effective net area or a

percentage value.
Size constraints (steel only)
Max depth,

Min depth,

Max width,

Min width

Size Constraints are only applicable
when Autodesign is checked. They
allow you to ensure that the sections
that Tekla Structural Designer
proposes match any particular size
constraints you may have.

Seismic
In a seismic force resisting system If this is the case, select the check

box, and then specify the SFRS
direction and type.

NOTE Design of members in
seismic force resisting
systems is only supported for
the ACI/AISC Head Code in
the current release.

Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 613)
Apply (to check) On
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Utilization ratio
• When a Check is performed, the check will pass

provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

Fireproofing
Protected When members are set as 'Protected', self-weight of the

members is increased by the weight of fireproofing.

See: Fire proofing (page 950)

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)

Column properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Group The name of the group to which the member belongs.

See: ,
Top Level Specifies the top level for the column.
Base Level Specifies the bottom level for the column.
Plane Indicates the Frame when the column has been placed in a

Frame View.
Characteristic Column
Material type • Steel

• Concrete
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General
• Timber

• General

• Cold formed

• Cold rolled
Construction,

Fabrication

The available construction and fabrication options depend
on the characteristic and material type selected, see
Member characteristic, construction and fabrication
properties (page 978)

Autodesign See: ,
Design section
order

(steel only)

The design order file from which a section size will be
selected.

NOTE Only displayed for Autodesign

For details of managing order files, see: Manage design
section orders (page 892)

Select bars
starting from

(concrete only)

This option controls the starting point for auto-design
procedures and is therefore only displayed if Automatic
design is ‘on’. It applies to both longitudinal bars and links.

• Minima (default) - removes the current arrangement and
begins with the minimum allowed bar size.

• Current - the auto design commences from the current
bar arrangement.

See: ,
Gravity only Controls whether the member is defined for gravity

combinations only, or gravity plus lateral:

• On = designed for gravity combinations only

• Off = designed for gravity and lateral combinations

See:
Rotation Rotation of the column about its local x axis.

NOTE For a vertical column:

• 0° - column local y aligns with global X

• 90° - column local y aligns with global Y

Assume extra
floors
supported

Enter the number of extra floors supported.

Simple column

(steel only)

See:
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Section The section size
Concrete type,

Grade/Class

(Concrete columns only)

While you can apply both normal and
lightweight concrete, wall design
using lightweight concrete is currently
beyond scope.

Alignment (concrete only)
Major snap level,

Minor snap level,

Define the major and minor
alignment of the member relative to
the insertion point.

Major offset,

Minor offset

Used to offset the member from the
snap point in the major and minor
axis.

Face A cont. rest.,

Face C cont. rest.

(steel only)

Indicates continuous restraint to Face
A and/or Face C.

See:

Releases
Fixity Top,

Fixity Bottom

• Pinned

• Fixed

• Moment (pin My)

• Moment (pin Mz)

See: Column releases (page 965)
Axial load release top An axial (Fx) release is only allowed at

the top of the column.
Torsional load release top,

Torsional load release bottom

Check one end only to define a
torsional release.

Wind loading
Apply open structure wind load Select this flag if you want open

structure wind loads to be calculated.

See:
Shape factor, Cf The default shape factor varies

according to the entity type and is
taken from Model Settings >
Loading > Wind Loading

NOTE Default Cf factors are taken
from the document ‘Wind
Loads For Petrochemical And
Other Industrial Facilities’
published by ASCE.
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Effective area XY
Formula The default effective area formula

varies according to the entity type
and is taken from Model Settings >
Loading > Wind Loading

Factor The factor used in the above formula
can be edited if required.

Effective area XZ
Formula The default effective area formula

varies according to the entity type
and is taken from Model Settings >
Loading > Wind Loading

Factor The factor used in the above formula
can be edited if required.

Size constraints (steel only)
Max depth,

Min depth,

Max width,

Min width

Size Constraints are only applicable
when Autodesign is checked. They
allow you to ensure that the sections
that Tekla Structural Designer
proposes match any particular size
constraints you may have.

Instability factor (steel only)
Prevent out of plane instability Define if out of plane stability is

prevented.

See:
Analysis & design control (concrete only)
Assume cracked Assuming concrete sections are

cracked has a direct affect on the
analysis; smaller Modification
Factors are applied to cracked
sections causing an increase in
deflection. Indirectly the design can
also be affected because the sway/
drift sensitivity calculations are also
influenced by this assumption.

See:
Apply rigid zones Unless cleared, rigid zones are

automatically created at the
connection between the column and
any connecting beams.

Design parameters (Eurocode only)
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Permanent load ratio option

Relative humidity (RH)

Age of loading

You are required to supply a value for
the permanent load ratio parameter.
A default of 0.65 has been assumed,
but you are advised to consider if this
is appropriate and adjust as
necessary.

Age of loading is the age at which
loading is applied.

See: Design parameters (Eurocode
only) (page 963)

Confinement reinforcement (concrete only)
Provide support regions • Checked - confinement

reinforcement is designed separately
in three regions.

• Cleared - the same confinement
reinforcement is designed for the
whole stack.

Slenderness (concrete only)
Direction 1,

Direction 2

• Braced

• Bracing
Direction 1 effective length factor,

Direction 2 effective length factor

• Calculated

• User input value
Stiffness (concrete only)
Use slab for calculation upper, lower For the unrestrained length

calculation:

• if a slab exists at a panel end, it can
be ignored by unchecking the
relevant box.

• If no slab exists at that end, the
setting is redundant - in which case
the program considers the setting at
the remote end of the next panel
instead.

See: Stiffness
Sway and drift checks
Merge with stack below Columns are divided into stacks and

walls are divided into panels at floor
levels where members or slabs
connect to the column/wall. For the
purposes of Sway/Drift, Wind Drift
and Seismic Drift checks only you can
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override the default stack/panel
divisions by merging a stack/panel
with a lower stack/panel. The length
of the combined stack/panel is then
used in the checks.

Sway/Seismic drift checks By default all stacks of all columns are
taken into account in the calculation
to determine the sway sensitivity of
the building. The results of this
calculation being accessed from the
Review toolbar.

This parameter provides a facility to
exclude particular column stacks from
these calculations to avoid spurious
results associated with very small
stack lengths. You can either clear the
check box located under ‘All Stacks’ to
exclude the entire column, or you can
exclude a particular stack by clearing
the check box located under that
stack only.

Wind drift check,

Wind drift ratio

Wind drift is automatically checked
against the specified limiting ratio,
(which can be set differently for
different columns). The results of this
calculation are accessed from the
Review toolbar.

If you don’t want this check to be
performed you can either clear the
check box located under ‘All Stacks’ to
exclude the entire column, or you can
exclude a particular stack by clearing
the check box located under that
stack only.

Nominal cover The nominal concrete cover is the
distance between the surface of the
reinforcement closest to the nearest
concrete surface (including links and
surface reinforcement where
relevant) and the nearest concrete
surface.

Seismic
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In a seismic force resisting system If this is the case, select the check

box, and then specify the SFRS
direction and type.

NOTE Design of members in
seismic force resisting
systems is only supported for
the ACI/AISC Head Code in
the current release.

Shear demand/shear capacity ratio in
Dir 1

Shear demand/shear capacity ratio in
Dir 2

(ASCE7 code only)

When working to the ASCE7, the
engineer can directly define the shear
demand / capacity ratio (beta) in each
direction. The default value of 1.0
could be over-conservative.

The setting is applicable to all years of
the ASCE7 code and has the following
default and limits: Default = 1; Min =
0.001; Max = 10.

Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 613)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

Fireproofing
Protected When members are set as 'Protected', self-weight of the

members is increased by the weight of fireproofing.

See: Fire proofing (page 950)
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UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)

Reinforcement
Rib type -
vertical, Class -
vertical

Specifies the vertical reinforcement properties

Rib type - link/
confinement,
Class - link/
confinement

Specifies the link/confinement properties.

Stack 1, 2, 3 etc.
In a multi-stack column properties can be entered for a
specific stack, over-riding those defined at the All stacks
level.

Splice,

Splice offset

Used to indicate a splice at the bottom of a stack, and the
offset above the floor level.

See:

Level 1, 2, 3 etc.
Load reductions
KLL

(Head Code
ACI/AISC)

Specify the KLL factor in accordance with Table 4-2 in
ASCE7-05/ASCE7-10.

See:
Count the floor
as being
supported

(Head Code
Eurocode, BS or
IS)

If checked, the floor will be treated as supported when
calculating the live/imposed load reductions.

Eccentricity (steel only)
Apply face A
eccentricity, etc.

See:
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Design parameters (Eurocode only)
Located under the Design parameters heading in the column properties, the
following parameters relating to shrinkage and creep can be specified for
individual members.

NOTE The Design Parameters described below are only applicable when the Head
Code is set to Eurocode.

Permanent Load Ratio

The permanent load ratio is used in the equation for determining the service
stress in the reinforcement, which is in turn used in table 7.3N to determine
the maximum allowable centre to centre bar spacing. It is also used to
calculate the effective creep ratio which appears in the column slenderness
ratio calculations.

It is defined as the ratio of quasi-permanent load to design ultimate load.

i.e. SLS/ULS = (1.0Gk + y 2Qk) / (factored Gk + factored Qk*IL reduction)

If Qk is taken as 0 then:

SLS/ULS = (1 / 1.25) = 0.8

Hence, setting the permanent load ratio to 0.8 should provide a conservative
upper bound for all cases.

When determining this ratio more precisely, consideration should be given to
the amount of IL reduction specified, for example (assuming Gk = Qk and y 2 =
0.3):

For 50%IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5*0.5) = 0.65

For no IL reduction,

SLS/ULS = (1 + 0.3) / (1.25 + 1.5) = 0.47

NOTE The program defaults to a permanent load ratio of 0.65 for all members - you
are advised to consider if this is appropriate and adjust as necessary.

Relative Humidity

Typical input range 20 to 100%

Age of Loading

This is the age at which load is first applied to the member.

The Age of Loading should include adjustments necessary to allow for cement
type and temperature as defined in EC2 Annex B.

NOTE The program defaults the Age of Loading to 14 days for all members -
you are advised to consider if this is appropriate and adjust as
necessary.
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Column releases
Releases in columns can be set as follows:

Moment Releases

• Pinned - Pinned to the adjacent stack and connecting members. This
means pinned about the major and minor axes of the section but fixed
torsionally.

• Fixed - fully fixed

• Moment (pin My) - Pinned about the y axis only

• Moment (pin Mz) - Pinned about the z axis only.

NOTE While Moment (pin My) and Moment (pin Mz) releases are less usual, for
continuous columns composed of two or more stacks, they have been
provided in response to customer feedback, to allow any/all column stacks to
be pinned in one direction whilst the other direction remains fixed.

When such a release is applied, a Warning status is issued in the Column
Property dialog. This is intentional and does not prevent analysis or design -
as the Warning tooltip states, it is to prompt the engineer to consider the
connection details at this location in the column.

Translational releases

• Fy and Fz releases are prevented in all stacks i.e. no ‘roller’ connections.

• Fx (axial) release allowed at the top of the topmost stack only.

• Mx (torsional release allowed in all stacks.

Concrete meshed and mid-pier wall properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Top Level Specifies the top level for the wall.
Base Level Specifies the bottom level for the wall.
Wall Type • Meshed Shear Wall

• Mid-pier Shear Wall

NOTE Mid-pier shear walls must be rectangular in a
vertical plane. Meshed shear walls can be vertical
or sloping.

Tekla Structural Designer reference 965 Properties



General
Fabrication Choice of:

• Cast-in-place

• Precast

NOTE Design of precast members is beyond scope in
the current release

Autodesign • Cleared - the specified reinforcement will be checked
during the design process.

• Checked - reinforcement will be designed during the
design process.

See:
Select bars
starting from

This option controls the starting point for auto-design
procedures and is therefore only displayed if Automatic
design is ‘on’. It applies to both longitudinal bars and links.

• Minima (default) - removes the current arrangement and
begins with the minimum allowed bar size.

• Current - the auto design commences from the current
bar arrangement.

See:
Assume extra
floors
supported

Enter the number of extra floors supported.

Rotation

(mid-pier only)

• 0° - wall spans horizontally

• 90° - wall spans vertically
AutomaticGene
rate Support

• Cleared - a support will only be created if the Generate
support property is checked.

• Checked - a support will only be created if no members/
slabs capable of providing support exist under the wall.

Generate
support

• Cleared - no support is created under the wall.

• Checked - a support is created under the wall.

NOTE When a support is created, a line support is formed
under a meshed wall, a point support under a mid-
pier wall, and a series of point supports under a
bearing wall.

NOTE When a support is created, its degrees of freedom
are as specified in the ‘Wall support’ area of the wall
properties.
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General
KLL

(Head Code
ACI/AISC)

Specify the KLL factor in accordance with Table 4-2 in
ASCE7-05/ASCE7-10.

See:
Plane Indicates the grid along which the wall is placed.

All panels
Concrete type While you can apply both normal and

lightweight concrete, wall design
using lightweight concrete is currently
beyond scope.

Grade The concrete grades that are available
here are set from the Materials
button on the Home ribbon.

Thickness The thickness of the wall.
Alignment Alignment of the wall:

• Front

• Back

• Middle

• User
Alignment offset When the alignment is set to User it

can be adjusted by specifying an
exact offset.

Assume cracked Assuming concrete sections are
cracked has a direct affect on the
analysis; smaller Modification
Factors are applied to cracked
sections causing an increase in
deflection. Indirectly the design can
also be affected because the sway/
drift sensitivity calculations are also
influenced by this assumption.

End 1 extension The amount the wall is extended or
trimmed back from end 1.

• A positive extension extends the
wall length beyond its insertion point.

• A negative extension trims the wall
back from the insertion point.

See: Specify extensions and releases
(page 239)
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End 2 extension The amount the wall is extended or

trimmed back from end 2.

• A positive extension extends the
wall length beyond its insertion point.

• A negative extension trims the wall
back from the insertion point.

See: Specify extensions and releases
(page 239)

Reinforcement Layers Number of layers of reinforcement to
be used in the wall:

• 1

• 2
Releases
Minor Top • Fixed

• Pinned

• Continuous (incoming members
pinned)

NOTE The ‘Continuous’ option is
only available for FE meshed
walls.

Minor Bottom • Fixed

• Pinned

• Continuous (incoming members
pinned)

NOTE The ‘Continuous’ option is
only available for FE meshed
walls.

Analysis & design control
Assume cracked Assuming concrete sections are

cracked has a direct affect on the
analysis; smaller Modification
Factors are applied to cracked
sections causing an increase in
deflection. Indirectly the design can
also be affected because the sway/
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drift sensitivity calculations are also
influenced by this assumption.

See:
Design parameters
Permanent load ratio option

Relative humidity (RH)

Age of loading

You are required to supply a value for
the permanent load ratio parameter.
A default of 0.65 has been assumed,
but you are advised to consider if this
is appropriate and adjust as
necessary.

Age of loading is the age at which
loading is applied.

See: Design parameters (Eurocode
only) (page 963)

Sway and drift checks
Merge with stack below Columns are divided into stacks and

walls are divided into panels at floor
levels where members or slabs
connect to the column/wall. For the
purposes of Sway/Drift, Wind Drift
and Seismic Drift checks only you can
override the default stack/panel
divisions by merging a stack/panel
with a lower stack/panel. The length
of the combined stack/panel is then
used in the checks.

Sway/Seismic drift checks By default all stacks of all walls are
taken into account in the calculation
to determine the sway sensitivity of
the building. The results of this
calculation being accessed from the
Review toolbar.

This parameter provides a facility to
exclude particular wall panels from
these calculations to avoid spurious
results associated with very small
panel lengths. You can either clear
the check box located under ‘All
Panels’ to exclude the entire wall, or
you can exclude a particular panel by
clearing the check box located under
that panel only.
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Wind drift check,

Wind drift ratio

Wind drift is automatically checked
against the specified limiting ratio,
(which can be set differently for
different columns). The results of this
calculation are accessed from the
Review toolbar.

If you don’t want this check to be
performed you can either clear the
check box located under ‘All Panels’ to
exclude the entire wall, or you can
exclude a particular stack by clearing
the check box located under that
panel only.

Confinement reinforcement
Provide support regions • Checked - confinement

reinforcement is designed separately
in three regions.

• Cleared - the same confinement
reinforcement is designed for the
whole stack.

Slenderness
Major

(Minor)

• Braced

• Bracing
Effective length factor direction Major

(Minor)

• Calculated

• User input value
Stiffness
Use slab for calculation (upper major/
minor, lower major/minor)

For the unrestrained length
calculation:

• if a slab exists at a panel end, it can
be ignored by unchecking the
relevant box.

• If no slab exists at that end, the
setting is redundant - in which case
the program considers the setting at
the remote end of the next panel
instead.

See:
Nominal cover The nominal concrete cover is the

distance between the surface of the
reinforcement closest to the nearest
concrete surface (including links and
surface reinforcement where
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relevant) and the nearest concrete
surface.

Seismic
In a seismic force resisting system If this is the case, select the check

box, and then specify the SFRS
direction and type.

NOTE Design of members in
seismic force resisting
systems is only supported for
the ACI/AISC Head Code in
the current release.

Shear demand/shear capacity ratio in
Dir 1

Shear demand/shear capacity ratio in
Dir 2

(ASCE7 code only)

When working to the ASCE7, the
engineer can directly define the shear
demand / capacity ratio (beta) in each
direction. The default value of 1.0
could be over-conservative.

The setting is applicable to all years of
the ASCE7 code and has the following
default and limits: Default = 1; Min =
0.001; Max = 10.

Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 613)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).
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Wall support
Angles

(Fx/Fy/Fz,
Mx/My/Mz)

Used to specify the translational and rotational degrees of
freedom in which the support acts:

• Fixed - indicates the support is fixed in the specified
direction.

• Free - indicates the support is free to move, or has a
stiffness applied in the specified direction.

Translational
stiffnesses
(x/y/z)

Used to specify the translational stiffness applied in a
direction that is not fixed:

• Release

• Spring Linear

• Spring Non-linear
Rotational
stiffnesses
(x/y/z)

Used to specify the rotational stiffness applied in a direction
that is not fixed:

• Release

• Spring Linear

• Spring Non-linear

Reinforcement
Include end
zones

• Cleared - the wall is designed without end zones of
reinforcement

• Checked - the wall is designed with end zones of
reinforcement

Wall zone
Form, type class Specifies the wall zone reinforcement properties
End zone
Form, type class Specifies the end zone reinforcement properties (if end

zones have been requested).

Panel 1, 2, 3 etc.
 In a multi-stack wall properties can be entered for a specific

panel, over-riding those defined at the All panels level.

Count the floor as being supported
Top level

(Interediate
levels)

If checked, the floor will be treated as supported when
calculating the live/imposed load reductions.
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Count the floor as being supported
Base level

(Head Code
Eurocode, BS or
IS)

Restrained
Used to indicate at which levels the wall is restrained.

NOTE Only levels with a connecting member are listed.

Meshing (meshed walls only)
Override
Model’s

Select this check box to override the default wall mesh size
that is specified in the Structure properties.

Wall Mesh
Horizontal Size

Used to override the default wall horizontal mesh size
(1.000m).

Wall Mesh
Vertical Size

Used to override the default wall vertical mesh size
(1.000m).

Wall Mesh Type Available mesh types:

• Quad only

• Tri only

• Quad dominant

See: How meshed walls are represented in solver models
(page 577)

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)

Concrete core properties

General
Name The automatically generated name for the core.
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General
User Name Can be used to override the automatically generated name

if required.
Rotation Defines the axis system for reporting the core results:

• Dir 1/2 - Main Building Directions

• Principal 1/2 - Major and minor local axis

• Angle - in Global Coordinate System

Level 1, Level 2 etc.
Centroid above,
Centroid below

Every core will have at least 2 core levels, with a core
section for each level. The centroids of the core sections are
reported above and below each level.

General wall properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Top Level Specifies the top level for the wall.
Base Level Specifies the bottom level for the wall.
Wall Type • Meshed Shear Wall
Material type • General
Assume extra
floors
supported

Enter the number of extra floors supported.

AutomaticGene
rate Support

• Cleared - a support will only be created if the Generate
support property is checked.

• Checked - a support will only be created if no members/
slabs capable of providing support exist under the wall.

Generate
support

• Cleared - no support is created under the wall.

• Checked - a support is created under the wall.

NOTE When a support is created, a line support is formed
under a meshed wall, a point support under a mid-
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General

pier wall, and a series of point supports under a
bearing wall.

NOTE When a support is created, its degrees of freedom
are as specified in the ‘Wall support’ area of the wall
properties.

Plane Indicates the grid along which the wall is placed.

All panels
Grade The grades that are available for

General materials are set from the
Materials button on the Home ribbon.

Thickness The thickness of the wall.
Alignment Alignment of the wall:

• Front

• Back

• Middle

• User
Alignment offset When the alignment is set to User it

can be adjusted by specifying an
exact offset.

Assume cracked Assuming concrete sections are
cracked has a direct affect on the
analysis; smaller Modification
Factors are applied to cracked
sections causing an increase in
deflection. Indirectly the design can
also be affected because the sway/
drift sensitivity calculations are also
influenced by this assumption.

End 1 extension The amount the wall is extended or
trimmed back from end 1.

• A positive extension extends the
wall length beyond its insertion point.

• A negative extension trims the wall
back from the insertion point.

See: Specify extensions and releases
(page 239)
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End 2 extension The amount the wall is extended or

trimmed back from end 2.

• A positive extension extends the
wall length beyond its insertion point.

• A negative extension trims the wall
back from the insertion point.

See: Specify extensions and releases
(page 239)

Releases
Minor Top • Fixed

• Pinned

• Continuous (incoming members
pinned)

Minor Bottom • Fixed

• Pinned

• Continuous (incoming members
pinned)

Sway and drift checks
Merge with stack below Columns are divided into stacks and

walls are divided into panels at floor
levels where members or slabs
connect to the column/wall. For the
purposes of Sway/Drift, Wind Drift
and Seismic Drift checks only you can
override the default stack/panel
divisions by merging a stack/panel
with a lower stack/panel. The length
of the combined stack/panel is then
used in the checks.

Sway/Seismic drift checks By default all stacks of all walls are
taken into account in the calculation
to determine the sway sensitivity of
the building. The results of this
calculation being accessed from the
Review toolbar.

This parameter provides a facility to
exclude particular wall panels from
these calculations to avoid spurious
results associated with very small
panel lengths. You can either clear
the check box located under ‘All
Panels’ to exclude the entire wall, or
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you can exclude a particular panel by
clearing the check box located under
that panel only.

Wind drift check,

Wind drift ratio

Wind drift is automatically checked
against the specified limiting ratio,
(which can be set differently for
different columns). The results of this
calculation are accessed from the
Review toolbar.

If you don’t want this check to be
performed you can either clear the
check box located under ‘All Panels’ to
exclude the entire wall, or you can
exclude a particular stack by clearing
the check box located under that
panel only.

Panel 1, 2, 3 etc.
 In a multi-stack wall properties can be entered for a specific

panel, over-riding those defined at the All panels level.

Count the floor as being supported
Top level

(Interediate
levels)

Base level

(Head Code
Eurocode, BS or
IS)

If checked, the floor will be treated as supported when
calculating the live/imposed load reductions.

Restrained
Used to indicate at which levels the wall is restrained.

NOTE Only levels with a connecting member are listed.

Meshing
Override
Model’s

Select this check box to override the default wall mesh size
that is specified in the Structure properties.

Wall Mesh
Horizontal Size

Used to override the default wall horizontal mesh size
(1.000m).

Wall Mesh
Vertical Size

Used to override the default wall vertical mesh size
(1.000m).
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Meshing
Wall Mesh Type Available mesh types:

• Quad only

• Tri only

• Quad dominant

See: How meshed walls are represented in solver models
(page 577)

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)

Member characteristic, construction and fabrication
properties
The following table lists the available permutations of characteristic,
construction and fabrication for each material type.

Mate
rial

Charac
teristic

Constructio
n

Fabrication Notes

Concr
ete

Beam Concrete
beam

Cast-in-place  
Post tensioned Not designed
Precast Not designed

Coupling
beam

Cast-in-place Coupling beams are the only
beams considered by the
Assisted core function.

If you set the Construction
as a Coupling beam when
part of a core, you have
made an engineering
decision that you are
satisfied the section is
sufficiently stiff to provide
rigid section behavior - Tekla
Structural Designer does not
check for this.
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Mate
rial

Charac
teristic

Constructio
n

Fabrication Notes

Column Concrete
column

Cast-in-place  
Precast Not designed

Analysis
Element

Not
applicable

Not applicable Not designed

Steel Beam Non-
composite
beam

Rolled  
Plated  
Westok cellular  
Westok plated  
Fabsec Not designed

Composite
beam

Rolled  
Plated  
Westok cellular Not designed
Westok plated Not designed
Fabsec Not designed

Column Non-
composite
column

Rolled  
Plated  
Concrete filled Not designed
Concrete
encased

Not designed

Composite
column

Rolled Not designed
Plated Not designed

Brace Steel brace Rolled  
Steel
joist

Steel joist Steel joist Standard, Special or Girder
types

Gable
post

Steel gable
post

Rolled  

Parapet
post

Steel
Parapet
post

Rolled  

Truss
membe
r top

Steel Truss
member top

Rolled  

Truss
membe
r
bottom

Steel Truss
member
bottom

Rolled  
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Mate
rial

Charac
teristic

Constructio
n

Fabrication Notes

Truss
membe
r side

Steel Truss
member
side

Rolled  

Truss
membe
r
internal

Steel Truss
member
internal

Rolled  

Analysis
Element

Not
applicable

Not applicable Not designed

Cold
forme
d

Beam Cold formed
beam
member

Cold formed  

Column Cold formed
column
member

Cold formed  

Brace Cold formed
brace
member

Cold formed  

Gable
post

Steel gable
post

Cold formed  

Parapet
post

Steel
Parapet
post

Cold formed  

Truss
membe
r top

Steel Truss
member top

Cold formed  

Truss
membe
r
bottom

Steel Truss
member
bottom

Cold formed  

Truss
membe
r side

Steel Truss
member
side

Cold formed  

Truss
membe
r
internal

Steel Truss
member
internal

Cold formed  

Analysis
Element

Not
applicable

Not applicable Not designed

Cold
rolled

Beam Cold rolled
beam
member

Cold rolled Not designed
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Mate
rial

Charac
teristic

Constructio
n

Fabrication Notes

Column Cold rolled
column
member

Cold rolled Not designed

Eaves
beam

Eaves beam Cold rolled Not designed

Purlin Purlin Cold rolled Not designed
Rail Rail Cold rolled Not designed
Analysis
Element

Not
applicable

Not applicable Not designed

Timbe
r

Beam Timber
beam

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Column Timber
column

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Brace Timber
brace

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Gable
post

Timber
gable post

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Truss
membe
r top

Timber
Truss
member top

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Truss
membe
r
bottom

Timber
Truss
member
bottom

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed
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Mate
rial

Charac
teristic

Constructio
n

Fabrication Notes

Truss
membe
r side

Timber
Truss
member
side

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Truss
membe
r
internal

Timber
Truss
member
internal

Timber Not designed
Glulam Not designed
Structural
composite
lumber

Not designed

Analysis
Element

Not
applicable

Not applicable Not designed

Gener
al

Beam General
material
beam

Not applicable Not designed

Column General
material
column

Not applicable Not designed

Brace General
material
brace

Not applicable Not designed

Analysis
Element

Not
applicable

Not applicable Not designed

Slab item properties

General
Name The automatically generated name for the slab item.
User Name Can be used to override the automatically generated name

if required.
Rotation angle

(one-way slabs)

or

X direction

(two way slabs)

This property is used for the following where appropriate:

• Span direction for 1-way load decomposition

• To determine the 2D solver element local axes in the
solver model

• Bar direction for Slab on Beam and Flat Slabs.

Different angles can be specified for different panels within
the slab.
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General

NOTE When SpanDirection is switched on in Scene
Content, the rotation angle/X direction is
represented by a blue arrow.

See: and Modify slab/panel span direction (page 274)
Include in
diaphragm

If this option is cleared, the slab item does not participate in
diaphragm action. All nodes linked to the mat item will be
able to displace independently of the diaphragm.

Override slab
depth

By default all panels in a slab adopt the same depth.
Checking this option allows the selected panel to have a
different depth and vertical offset.

Vertical offset Only available when ‘Override slab depth’ is checked.

A positive offset raises the slab panel surface, a negative
offset drops it.

NOTE Vertical offsets are not structurally significant

Auto-design For panels in Auto-design mode, As,prov is increased until
either a pass is achieved or the limiting reinforcement
parameter limits have been exceeded.

For panels not in Autodesign mode, the result will be a pass
or fail.

Select bars
starting from

This option controls the starting point for auto-design
procedures.

Plane Indicates the level at which the slab is placed.

Slab general
Name The automatically generated name for the mat item.
User Name Can be used to override the automatically generated name

if required.
Slab type • Precast

• Steel deck

• Timber deck

• Composite slab

• Foundation mat
Deck type The deck type depends on the slab type as follows:

• Precast concrete planks: Precast,

• Steel plate: Steel deck,

• Timber: Timber deck,
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Slab general
• Profiled metal decking: Composite slab,

• Reinforced concrete: Slab on beams, Flat slab,
Foundation mat

• Post tension: Slab on beams, Flat slab, Foundation mat
Decomposition Decomposition choices depend on the slab type as follows:

• One-way only: Precast, Timber deck, Composite slab

• One-way or two way: Steel deck, Slab on beams

• Two-way only: Flat slab, Foundation mat

Slab parameters
Slab properties(general)
Overall depth Specifies the slab thickness.
Diaphragm
option

Sets the default diaphragm action for all slab items within
the parent slab.

• Rigid

• Semi-rigid

• None
Slab properties (concrete slabs)
Concrete type • Normal

• Lightweight
Grade/Concrete
class

Specifies the concrete grade.

Concrete
aggregate type

Specifies the aggregate type.

Concrete
density class

For normal weight concrete only, specifies the density class.

Dry density Specifies the dry concrete density
Wet density Specifies the wet concrete density
Long term
elastic modulus
= Ecm divided
by...

composite slab
and precast
only)

Factor by which the short term elastic modulus is divided to
obtain the long term modulus .

Ponding
allowance

If required, choose either value or percentage and then
specify actual ponding allowance accordingly.
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Slab parameters
option, Ponding
allowance value

(composite slab
only)
Apply ponding
to construction
stage

(composite slab
only)

• On = ponding allowance applied at construction stage

Apply ponding
to composite
stage

(composite slab
only)

• On = ponding allowance applied at composite stage

Decking properties (where applicable)
Country,
Manufacturer,
Reference,
Gauge

Defines properties of decking (where applicable).

Reinforcement in slab for crack control or fire requirements

(composite slab, and precast with topping specified only)
Type, Rib type,
Mesh type
Class, Bar size

Defines reinforcement for crack control or fire
requirements

Topping details(precast only)
Topping • None

• Non-structural

• Structural
Depth Depth of topping when topping other than 'None' is

selected.
Design parameters (Head Code Eurocode)
Permanent load
ratio

You are required to supply a value for the permanent load
ratio parameter. A default of 0.65 has been assumed, but
you are advised to consider if this is appropriate and adjust
as necessary.

Maximum crack
width

• 0.2

• 0.3

• 0.4
Deflection parameters
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Slab parameters
Restraint
constant

(ACI only)

See:

Restraint type

(Eurocode only)

See:

Cement class

(Eurocode only)

See:

Material properties
Modulus of
elasticity,
Poisson's ratio,
Shear moduls,
Coefficient of
thermal
expansion

Properties specific to timber and steel decks.

Design parameters
Adjustment
ratio direction
X ,Adjustment
ratio direction Y

(slab on beam
only)

These factors are applied to the enclosing lengths in X and Y
in order to manually adjust the X and Y direction span in the
span-effective depth check.

See Slab on beam idealized panels

Enclosing
length X,
Enclosing
length Y

(slab on beam
only)

The automatically calculated span length in the X direction,
and Y direction.

See Slab on beam idealized panels

Adjusted length
X, Adjusted
length X

(slab on beam
only)

The adjusted span lengths in the X and Y directions.

See Slab on beam idealized panels

Edge category
start X, Edge
category start Y

(slab on beam
only)

The assumed support condition at the start of the span in
the X direction, and Y direction.

See Slab on beam idealized panels
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Design parameters
Edge category
end X, Edge
category end Y

(slab on beam
only)

The assumed support condition at the end of the span in
the X direction, and Y direction.

See Slab on beam idealized panels

Average
stiffness ratio

(Slab on beam
ACI/AISC only)

In the current release of Tekla Structural Designerr the
average stiffness ratio is a user defined value. (Default value
= 1.0). The way in which the minimum thickness is
calculated directly depends on this value.

Live/Imposed load reduction
Reduce live/
imposed loads
by

This property is applicable for the design of transfer slabs
and mats.

Although the percentage of live load reduction is not
determined automatically, this property allows you to
specify the percentage manually.

It can be applied to an individual slab item - you don't have
to apply a single value throughout a slab or mat (this can be
important if you have discrete transfer panels within a large
slab area).

• reducible loadcases are reduced

• combinations incorporating reducible loadcases are
reduced

• The reduced results are used in slab design.

NOTE For mats, the bearing pressures are reduced as
well.

Reinforcement
 Slabs panels can potentially have 4 layers of background

reinforcement, (however any of the layers/directions can be
set to “none” if required).

Select/clear Outside layer in X direction as appropriate to
indicate if the outside layer is in the X or Y direction. (The
outside layer can be set differently for the top and bottom
bars if required.)

Utilization ratio
Apply (to
autodesign)

On
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Utilization ratio
• When an Autodesign is performed, the design will be

incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 613)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

All edges, Edge 1, Edge 2 etc.
Linear Uncheck in order to specify curved edges.
Curvature Defines the amount of curvature to all edges.

Only displayed when Linear is cleared.

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)

See also

Foundation mat properties (page 988)

Foundation mat properties

General
Name The automatically generated name for the mat item.
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General
User Name Can be used to override the automatically generated name

if required.
Foundation
type

Mat

Rotation angle Specifies the orientation of reinforcement.

Different angles can be specified for different panels within
the mat.

See:
Include in
diaphragm

If this option is cleared, the mat item does not participate in
diaphragm action. All nodes linked to the mat item will be
able to displace independently of the diaphragm.

Override slab
depth

By default all panels in a slab adopt the same depth.
Checking this option allows the selected panel to have a
different depth and vertical offset.

Vertical offset Only available when ‘Override slab depth’ is checked.

A positive offset raises the slab panel surface, a negative
offset drops it.

NOTE Vertical offsets are not structurally significant

Auto-design For panels in Auto-design mode, As,prov is increased until
either a pass is achieved or the limiting reinforcement
parameter limits have been exceeded.

For panels not in Autodesign mode, the result will be a pass
or fail.

Plane Indicates the level at which the mat is placed.

Slab general
Name The parent foundation mat name.
User Name Can be used to override the automatically generated name

if required.
Slab type Foundation mat
Deck type • Reinforced concrete

• Post tension

NOTE Design of post tensioned slabs is beyond scope in
the current release.

Decomposition Two-way
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Slab parameters
Slab properties
Overall depth Specifies the slab thickness.
Concrete type • Normal

• Lightweight
Grade/Concrete
class

Specifies the concrete grade.

Concrete
aggregate type

Specifies the aggregate type.

Concrete
density class

For normal weight concrete only, specifies the density class.

Dry density Specifies the dry concrete density
Wet density Specifies the wet concrete density
Diaphragm
option

Sets the default diaphragm action for all slab items within
the parent slab.

• Rigid

• Semi-rigid

• None
Design parameters (Head Code Eurocode)
Permanent load
ratio

You are required to supply a value for the permanent load
ratio parameter. A default of 0.65 has been assumed, but
you are advised to consider if this is appropriate and adjust
as necessary.

Maximum crack
width

• 0.2

• 0.3

• 0.4
Deflection parameters
Restraint
constant

See:

Restraint type

(Eurocode only)

See:

Cement class

(Eurocode only)

See:

Soil parameters
Use Ground
Bearing Springs

Select to specify that the mat is ground bearing.

Allowable
Bearing
Pressure

The allowable bearing pressure is only required when the
‘Use Ground Bearing Springs’ option is selected.
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Slab parameters
Ground Stiffness The following properties are only displayed when the ‘Use
Ground Bearing Springs’ option is selected.
Type • Spring Linear

• Spring Non-Linear
Stiffness Only displayed when the Type is set to ‘Spring Linear’.
Stiffness -ve Only displayed when the Type is set to ‘Spring Non-Linear’.
Tension limit -
ve

Only displayed when the Type is set to ‘Spring Non-Linear’.

Stiffness +ve Only displayed when the Type is set to ‘Spring Non-Linear’.
Compression
limit +ve

Only displayed when the Type is set to ‘Spring Non-Linear’.

Horizontal
Support

• Fixed

• Free

• Spring
% of vertical
spring stiffness

This field is displayed when the Horizontal Support is set to
‘Spring’.

Live/Imposed load reduction
Reduce live/
imposed loads
by

This property is applicable for the design of transfer slabs
and mats.

Although the percentage of live load reduction is not
determined automatically, this property allows you to
specify the percentage manually.

It can be applied to an individual slab item - you don't have
to apply a single value throughout a slab or mat (this can be
important if you have discrete transfer panels within a large
slab area).

• reducible loadcases are reduced

• combinations incorporating reducible loadcases are
reduced

• The reduced results are used in slab design.

NOTE For mats, the bearing pressures are reduced as
well.
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Reinforcement
 Slabs panels can potentially have 4 layers of background

reinforcement, (however any of the layers/directions can be
set to “none” if required).

Select/clear Outside layer in X direction as appropriate to
indicate if the outside layer is in the X or Y direction. (The
outside layer can be set differently for the top and bottom
bars if required.)

Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 613)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

All edges, Edge 1, Edge 2 etc.
Linear Uncheck in order to specify curved edges.
Curvature Defines the amount of curvature to all edges.

Only displayed when Linear is cleared.

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)
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Slab/Mat overhang properties

General
LengthofBeam • When checked, the overhang is created by a single click

on a supporting beam along the the slab edge.

• When unchecked, the overhang is created by clicking
two points along the slab edge.

EdgeParallel • When checked, the overhang is created with a straight
edge.

• When unchecked, the overhang is created with a curved
edge.

Curvature Specifies the overhang curvature, (when EdgeParallel is
unchecked).

Tapered • When checked, the overhang varies in width. (Width1 to
Width2)

• When unchecked, the overhang is a constant width
(Width1).

Width1 The width at end 1 of the overhang.
Width2 The width at end 2 of the overhang, (when tapered).

Pad base strip base and pile cap properties

Property Description
General  
Foundation Type Isolated Pad Base (not editable).

Isolated Pile Cap (not editable).
Auto-design depth • When Autodesign is selected an

iterative procedure is used to
determine the depth. If the shear
design fails the depth is increased
until either the check passes, or the
maximum depth specified in Design
Options has been reached.

• When Autodesign is not selected (i.e.
check mode), the existing depth is
retained and Tekla Structural
Designer determines if it is sufficient.
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Property Description

NOTE In Design Options - if Isolated
Foundations have been set to
be designed using groups,
then if at least one base in
the group is set to have its
depth auto-designed the
whole group will have their
depth auto-designed.

NOTE When Design Member on the
right-click context menu is
used to design an individual
base, the depth will be
checked or designed
according to the auto-design
depth setting.

Auto-design size • When Autodesign is selected an
iterative procedure is used to
determine the base size. If the
bearing check fails the size is
increased until either the check
passes, or the maximum side length
specified in Design Options has been
reached.

• When Autodesign is not selected (i.e.
check mode), the existing size is
retained and Tekla Structural
Designer determines if it is sufficient.

NOTE In Design Options - if Isolated
Foundations have been set to
be designed using groups,
then if at least one base in
the group is set to have its
depth auto-designed the
whole group will have their
depth auto-designed.

NOTE When Design Member on the
right-click context menu is
used to design an individual
base, the size will be checked
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Property Description

or designed according to the
Auto-design size setting.

Auto-design piles

(Pile cap only)

Autodesign piles automatically
determines the quantity and size of
piles.

• Cleared - the specified number of
piles at their specified positions
will be checked during the design
process.

• Checked - the number of piles and
their positions under the pile cap
will automatically determined
during the design process.

When this check box is selected, the
actual procedure used will depend on
the Pile auto-design method that has
been specified in Design Options >
Concrete Foundations > Isolated
Foundations Piles

The Minimise number of piles
method commences by first selecting
the pile with the smallest load
capacity in the Pile Catalogue. Pile
positioning is attempted using the
user defined pile arrangements. If
one of the limitations is exceeded the
pile with the next smallest load
capacity in the catalogue is selected
and the process starts again. This is
repeated until the pile loading check
passes.

The Minimise pile capacity method
commences by first selecting the pile
with the smallest load capacity in the
Pile Catalogue. Pile positioning is
attempted using the user defined pile
arrangements. If one of the
limitations is exceeded one pile is
added to the pile group and the
process starts again. This is repeated
until the pile loading check passes.

Select size/depth starting from This option only appears when either
Autodesign depth or Autodesign size
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Property Description
is selected. It sets the autodesign
start point for the depth, or size, or
both.

The options are:

• Minima (default)

• Current

Selecting ‘Minima’ removes the
current depth/size and begins with
the minimum allowed depth/size
specified in Design Options.

For both options the auto-design
depth increment is that specified in
Design Options> Foundations Isolated
Foundations> Foundation Size

Autodesign reinforcement This setting applies to top and bottom
reinforcement, but reinforcement in
either location can still be set to none.

If enabled, auto-design of
reinforcement occurs after the base
size and depth have been established.

• When Autodesign reinforcement is
enabled an iterative procedure is
used to determine the
reinforcement. If the bending
design fails the reinforcement size
gets increased and spacing gets
decreased until these checks pass.
Iterations continue until either a
satisfactory bar configuration has
been achieved, or the maximum
bar size and minimum spacing
specified in Design Options has
been reached. At this point the
depth gets increased and the
above procedure is repeated.

NOTE If the smallest bar at
largest spacing is
insufficient then the next
bar size at max spacing is
used. If the largest bar is
reached the spacing gets
reduced and the smallest
bar is used. Then the bar
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Property Description
size gets increased until
the largest bar size
reached.

• When Autodesign reinforcement is
disabled (i.e. check mode), the
existing reinforcement provision is
retained and Tekla Structural
Designer determines if it is
sufficient.

NOTE In Design Options - if
Isolated Foundations have
been set to be designed
using groups, then if at
least one base in the
group is set to have its
depth auto-designed the
whole group will have
their reinforcement auto-
designed.

NOTE When Design Member on
the right-click context
menu is used to design an
individual base the
reinforcement is always
designed (irrespective of
the Autodesign
reinforcement setting).

Select bars starting from This option controls the starting point
for auto-design procedures and is
therefore only displayed if Autodesign
reinforcement is selected.

• Minima (default) - removes the
current arrangement and begins
with the minimum allowed bar
size specified in Design Options.

• Current - the auto design
commences from the current bar
arrangement.

Foundation Parameters  
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Property Description
Eccentricity in Y direction Specifies the eccentricity of the base

in the Y direction.

(For strip bases this is along the wall)
Eccentricity in X direction Specifies the eccentricity of the base

in the X direction.

(For strip bases this is across the wall)
Rotation angle Specifies the rotation of the base:

• Pad base: relative to that of the
support (which is controlled by the
rotation angle specified for
column).

• Strip base: the angle of the base
about global Z.

Shape

Pad base and pile cap only)

Specifies the base shape in plan:

• Square

• Rectangular
Length in Y direction (Pad base and
pile cap only)

Specifies the size of the pad in the Y
direction.

Length in X direction (Pad base and
pile cap only)

Specifies the size of the pad in the X
direction.

Width (Strip base only) Specifies the width of the base
Depth Specifies the depth of the base.
Concrete class The concrete grade.

The concrete grades that are available
are set from the Materials button on
the Home ribbon.

Use loaded area (Pad base only) Selecting this option allows you to
specify a user override of the
punching shear area - defined using
the Loaded Area Breadth and Loaded
Area Depth properties.

This feature can be used in both pad
bases and pile caps to, for example,
consider unmodeled base plates or
pedestals.

Sliding in Y prevented / Sliding in X
prevented (Pad base only)

If sliding is prevented by some other
means (e.g. if attached to a floor slab
in one or other direction) then this
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Property Description
can be indicated by selecting the
appropriate direction.

TIP If the direction is not clear make
the base non-rectangular so
that length in X and hence X-
direction is clearer.

Selecting this option sets the shear
force for the particular direction to
zero. This affects the sliding check,
but actually affects all checks because
there is no additional overturning
moment developed due to shear at
top of base.

Overturning about X prevented /
Overturning about Y prevented (Pad
base only)

This option only appears when the
Sliding in Y prevented / Sliding in X
preventedoption is selected. Selecting
this option indicates that overturning
is also prevented by some other
means for the selected direction,
which sets the support moment for
that direction to zero. This affects all
checks because there is no
overturning moment considered.

Permanent load ratio option
(Eurocode only)

You are required to supply a value for
the permanent load ratio parameter.
A default of 0.65 has been assumed,
but you are advised to consider if this
is appropriate and adjust as
necessary.

Maximum crack width • 0.2

• 0.3

• 0.4
Piles

(Pile cap only)

 

Pile type Pile types that have previously been
specified in the Pile Catalogue are
available for selection. You can
choose <New...> to add additional
types.

User defined arrangement Specifies the eccentricity of the pile
cap in the X direction.
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Property Description
Pile arrangement Opens the Pile arrangement dialog

for specifying the number of piles,
and spacing, pile type and principal
direction.

Number of piles Specifies the number of piles.
Principal direction Specifies the principal direction.
Pile spacing The dimension between pile centers.
Shape For three piles only, you can choose

to specify either a triangular. or
rectangular pile cap.

Reinforcement  
Type • Mesh

• Loose Bars

• None
Rib type (Head Code Eurocode, BS or
IS)

• Plain

• Type 1

• Type 2
Rib type (Head Code ACI) • Plain

• Deformed
Bar type The reinforcement grades that are

available here are set from the
Materials button on the Home ribbon.

Bar size, spacing, Mesh type etc. The actual reinforcement provided in
each of the layers is indicated here.

Top, Bottom, Side cover Nominal cover to reinforcement.
Soil Parameters  
Soil unit weight Soil unit weight
Characteristic friction angle Characteristic friction angle
Presumed bearing resistance (EC
Head Code)

The presumed bearing resistance is
only displayed and used when the
‘presumed bearing capacity method
(EN 1997 - 1 cl. 6.5.2.4)’ is selected in
Design Options.

Surcharge  
Soil

Surcharge depth

Other permanent

Permanent surcharge load

Drop-list controls allow each
surcharge load to be assigned to a
specific loadcase.

The partial safety factors defined in
the design combinations for these
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Property Description
Other variable

Variable surcharge load

cases are then used for these loads in
all design calculations.

The assigned loadcases are initially
set to “None” and must be user-
selected. Where no appropriate Dead
or Live loadcase exist in the model
and so no loadcase can be assigned,
zero partial factor values are used in
the calculations.

Design shear strength of soil angle
(ACI & BS Head Codes)

Design shear strength of soil angle

Allowable bearing capacity (ACI & BS
Head Codes)

Allowable bearing capacity

Bearing capacity A1 - STR (EC Head
Code)

Allowable bearing capacity A1.

Only displayed and used when the
‘presumed bearing capacity method
(EN 1997 - 1 cl. 6.5.2.4)’ is unselected
in Design Options.

Bearing capacity A2 - GEO (EC Head
Code)

Allowable bearing capacity A2.

Only displayed and used when the
‘presumed bearing capacity method
(EN 1997 - 1 cl. 6.5.2.4)’ is unselected
in Design Options.

UDA A customizable list of the attributes
that can be applied to individual
members and panels.

Line ancillary properties

General
Name The automatically generated name for the ancillary.
User Name Can be used to override the automatically generated name

if required.
Width, W Width of ancillary
Type The following types are available:

• Walkways/catwalks1

• Ladders with cage

• Ladders without cage

• Access platforms1
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General
• Operating platforms (storage laydown)1

• Operating platforms (standard)1

• Steel stair flight/landing2

• Concrete stair flight/landing3

• Timber stair flight/landing3

• Lines of pipework4

• Lines of cable tray5

• Other
1 These types expose the Guardrail flag below.
2 This type exposes the Measuring property and Guardrail
+ channel height, H1 value below.
3 These types expose the Guardrail height, H1 value
below.
4 This type exposes the Category and Diameter of largest
pipe values below.
5 This type exposes the Category and Height of Cable Tray
values below.

Default Load
Values

If this option is selected, load values for the selected type
(with or without guardrail) are obtained from Model
Settings > Loading, if unselected, load values can be
entered directly.

Dead Load Load to be created in the Ancillary Dead loadcase
Live (Imposed)
Load

Load to be created in the Ancillary Live (Imposed)
loadcase

Measuring
(Live/Imposed)

For stairs choose whether the live/imposed load is a
vertically projected load, or measured along the element.

Live (Imposed)
Load loadcase

If working to Eurocodes, some ancillaries may require
different Ψ and ɸ factors in which case a new loadcase
should be manually added with the desired factors.

To create the load in the new loadcase select it here.
Empty Load Load to be created in the Pipework Empty, or Cable Tray

Emptyloadcase
Operating
Content Load

Load to be created in the Pipework Empty, or Cable Tray
Emptyloadcase

Operating
Content Load
loadcase

If working to Eurocodes, some cable trays may require
different Ψ and ɸ factors in which case a new operating
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General
content loadcase should be manually added with the
desired factors.

To create the load in the new loadcase select it here.
Testing Content
Load

Load to be created in the Pipework Testing Content
loadcase

Category For cable trays and pipework, the default load values from
Model Settings > Loading are those for the selected
category.

Guardrail If this option is selected, the default load values from
Model Settings > Loading are those for the selected type
with guardrail.

Guardrail
height, H1

The value specified here is used in the calculation of wind
loads on open structures seen by the ancillary.

Guardrail +
channel height,
H1

The value specified here is used in the calculation of wind
loads on open structures seen by the ancillary.

Height of cable
tray, H

The value specified here is used in the calculation of wind
loads on open structures seen by the ancillary.

Diameter of
largest pipe

The value specified here is used in the calculation of wind
loads on open structures seen by the ancillary.

Height, H The value specified here is used in the calculation of wind
loads on open structures seen by the ancillary.

Wind loading
Apply open
structure wind
load

Select this flag if you want open structure wind loads to be
calculated.

For more information, see:
Shape factor, Cf The default shape factor varies according to the entity type

and is taken from Model Settings > Loading > Wind
Loading

NOTE Default Cf factors are taken from the document
‘Wind Loads For Petrochemical And Other Industrial
Facilities’ published by ASCE.

Effective area XY
Formula The default effective area formula varies according to the

entity type and is taken from Model Settings > Loading >
Wind Loading

Factor The factor used in the above formula can be edited if
required.

Effective area XZ
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General
Formula The default effective area formula varies according to the

entity type and is taken from Model Settings > Loading >
Wind Loading

Factor The factor used in the above formula can be edited if
required.

Reverse For lines of pipework/cable trays the height is displayed and
it can be visually reversed by checking this flag.

See also

Ancillaries (page 285)

Area ancillary properties

General
Name The automatically generated name for the ancillary.
User Name Can be used to override the automatically generated name

if required.
Rotation Defines the span direction.
Type The following types are available:

• Walkways/catwalks1

• Ladders with cage

• Ladders without cage

• Access platforms1

• Operating platforms (storage laydown)1

• Operating platforms (standard)1

• Steel stair flight/landing2

• Concrete stair flight/landing3

• Timber stair flight/landing3

• Lines of pipework4

• Lines of cable tray5

• Other
1 These types expose the Guardrail flag below.
2 This type exposes the Measuring property and Guardrail
+ channel height, H1 value below.

Tekla Structural Designer reference 1004 Properties



General
3 These types expose the Guardrail height, H1 value
below.
4 This type exposes the Category and Diameter of largest
pipe values below.
5 This type exposes the Category and Height of Cable Tray
values below.

Default Load
Values

If this option is selected, load values for the selected type
(with or without guardrail) are obtained from Model
Settings > Loading, if unselected, load values can be
entered directly.

Dead Load Load to be created in the Ancillary Dead loadcase
Live (Imposed)
Load

Load to be created in the Ancillary Live (Imposed)
loadcase

Measuring
(Live/Imposed)

For stairs choose whether the live/imposed load is a
vertically projected load, or measured along the element.

Live (Imposed)
Load loadcase

If working to Eurocodes, some ancillaries may require
different Ψ and ɸ factors in which case a new loadcase
should be manually added with the desired factors.

To create the load in the new loadcase select it here.
Empty Load Load to be created in the Pipework Empty, or Cable Tray

Emptyloadcase
Operating
Content Load

Load to be created in the Pipework Empty, or Cable Tray
Emptyloadcase

Operating
Content Load
loadcase

If working to Eurocodes, some cable trays may require
different Ψ and ɸ factors in which case a new operating
content loadcase should be manually added with the
desired factors.

To create the load in the new loadcase select it here.
Testing Content
Load

Load to be created in the Pipework Testing Content
loadcase

Category For cable trays and pipework, the default load values from
Model Settings > Loading are those for the selected
category.

Guardrail If this option is selected, the default load values from
Model Settings > Loading are those for the selected type
with guardrail.

Guardrail
height, H1

The value specified here is used in the calculation of wind
loads on open structures seen by the ancillary.

Guardrail +
channel height,
H1

The value specified here is used in the calculation of wind
loads on open structures seen by the ancillary.
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General
Height of cable
tray, H

The value specified here is used in the calculation of wind
loads on open structures seen by the ancillary.

Diameter of
largest pipe

The value specified here is used in the calculation of wind
loads on open structures seen by the ancillary.

Height, H The value specified here is used in the calculation of wind
loads on open structures seen by the ancillary.

Wind loading
Apply open
structure wind
load

Select this flag if you want open structure wind loads to be
calculated.

For more information, see:
Shape factor, Cf The default shape factor varies according to the entity type

and is taken from Model Settings > Loading > Wind
Loading

NOTE Default Cf factors are taken from the document
‘Wind Loads For Petrochemical And Other Industrial
Facilities’ published by ASCE.

Effective area XY
Formula The default effective area formula varies according to the

entity type and is taken from Model Settings > Loading >
Wind Loading

Factor The factor used in the above formula can be edited if
required.

Effective area XZ
Formula The default area per length used in this formula varies

according to the entity type and is taken from Model
Settings > Loading > Wind Loading

Area per length The area per length used in the above formula can be
edited if required.

Reverse For lines of pipework/cable trays the height is displayed and
it can be visually reversed by checking this flag.

See also

Ancillaries (page 285)

Equipment properties

Properties
Name The automatically generated name for the equipment.

Tekla Structural Designer reference 1006 Properties



Properties
User Name Can be used to override the automatically generated name if

required.
Type The following types are available:

• Sphere

• Vertical Cylinder

• Horizontal Cylinder

• Cuboid
Diameter, D Diameter of sphere or cylinder.

Used to determine the Cf value.

These values
are also
used in the
calculation
of wind
loads on
open
structures
seen by the
equipment.

For more
information,
see:

Length, L Length of cuboid or cylinder.

Used to determine the Cf value.

Breadth, B Breadth of cuboid.

Used to determine the Cf value.

Height, H Height of cuboid.

Used to determine the Cf value.

Base
position, z

Entering a non-zero value raises/lowers the
equipment above/below the loading area.

Angle to
Global X

Can be used to rotate the equipment relative to
global X

CoG offset Can be used to offset the equipment relative to
the global or local axes

Empty Load
Apply Load Load can either be applied at CoG or at Supports.

This load is created in the Equipment Empty loadcase.
Load Enter a single value if at CoG, or individual values at each

support.
Operating Content Load
Apply Load Load can either be applied at CoG or at Supports.

This load is created in the Equipment Operating Content
loadcase.

Load Enter a single value if at CoG, or individual values at each
support.

Testing Content Load
Apply Load Load can either be applied at CoG or at Supports.

This load is created in the Equipment Testing Content
loadcase.
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Properties
Load Enter a single value if at CoG, or individual values at each

support.
Wind loading
Apply open
structure
wind load

Select this flag if you want open structure wind loads to be
calculated.

For more information, see:
Surface For vertical and horizontal cylinders, specify the surface as

either, moderately rough, rough, or very rough.

For cylinders the surface and L/D ratio are used to determine
the Cf value

End For horizontal cylinders, specify the end as either flat, or
rounded.

This is used to determine the Cf value, see ASCE7 Fig 6-21

See also

Equipment (page 295)

Bearing wall properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Top Level Specifies the top level for the wall.
Base Level Specifies the bottom level for the wall.
Wall Type Bearing Wall

NOTE Bearing walls must be rectangular in a vertical
plane.

Material Type Choice of:

• Concrete

• Timber

• General
Assume extra
floors
supported

Enter the number of extra floors supported.
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General
AutomaticGene
rate Support

• Cleared - a support will only be created if the Generate
support property is checked.

• Checked - a support will only be created if no members/
slabs capable of providing support exist under the wall.

Generate
support

• Cleared - no support is created under the wall.

• Checked - a support is created under the wall.

NOTE When a support is created, a line support is formed
under a meshed wall, a point support under a mid-
pier wall, and a series of point supports under a
bearing wall.

NOTE When a support is created, its degrees of freedom
are as specified in the ‘Wall support’ area of the wall
properties.

Plane Indicates the grid along which the wall is placed.

All panels
Concrete type While you can apply both normal and

lightweight concrete, wall design
using lightweight concrete is currently
beyond scope.

Grade The grades available here are set
from the Materials button on the
Home ribbon.

NOTE The grade is only required to
specify the correct density to
be used in the wall self
weight calculation.

Thickness The thickness of the wall.

NOTE The thickness is only required
for the wall self weight
calculation.

Alignment Alignment of the wall:

• Front

• Back

• Middle

• User
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All panels
Alignment offset When the alignment is set to User it

can be adjusted by specifying an
exact offset.

Wall support
Angles

(Fx/Fy/Fz,
Mx/My/Mz)

Used to specify the translational and rotational degrees of
freedom in which the support acts:

• Fixed - indicates the support is fixed in the specified
direction.

• Free - indicates the support is free to move, or has a
stiffness applied in the specified direction.

Translational
stiffnesses
(x/y/z)

Used to specify the translational stiffness applied in a
direction that is not fixed:

• Release

• Spring Linear

• Spring Non-linear
Rotational
stiffnesses
(x/y/z)

Used to specify the rotational stiffness applied in a direction
that is not fixed:

• Release

• Spring Linear

• Spring Non-linear

Panel 1, 2, 3 etc.
 In a multi-stack wall properties can be entered for a specific

panel, over-riding those defined at the All panels level.

Count the floor as being supported
Top level

(Interediate
levels)

Base level

(Head Code
Eurocode, BS or
IS)

If checked, the floor will be treated as supported when
calculating the live/imposed load reductions.

Restrained
Used to indicate at which levels the wall is restrained.

NOTE Only levels with a connecting member are listed.
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UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)

Shear only wall properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Top Level Specifies the top level for the wall.
Base Level Specifies the bottom level for the wall.
Wall Type Shear Only Wall

NOTE Shear only walls must be rectangular in a vertical
plane.

Material Type Choice of:

• Concrete

• Timber

• General
AutomaticGene
rate Support

• Cleared - a support will only be created if the Generate
support property is checked.

• Checked - a support will only be created if no members/
slabs capable of providing support exist under the wall.

Generate
support

• Cleared - no support is created under the wall.

• Checked - a support is created under the wall.

NOTE When a support is created, a line support is formed
under a meshed wall, a point support under a mid-
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General

pier wall, and a series of point supports under a
bearing wall.

NOTE When a support is created, its degrees of freedom
are as specified in the ‘Wall support’ area of the wall
properties.

Plane Indicates the grid along which the wall is placed.

All panels
Grade The grades available here are set

from the Materials button on the
Home ribbon.

NOTE The grade is only required to
specify the correct density to
be used in the wall self
weight calculation.

Thickness The thickness of the wall.

NOTE The thickness is only required
for the wall self weight
calculation.

Alignment Alignment of the wall:

• Front

• Back

• Middle

• User
Alignment offset When the alignment is set to User it

can be adjusted by specifying an
exact offset.

Spring stiffness The stiffness to be used in the
analysis.

See: How shear only walls are
represented in solver models
(page 584)
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UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)

Wall Panel Properties
Use the Wall Panel properties to view or modify the properties of a wall panel.

The  Wall Panel command is used to create a wall panel. Once created, the
panel properties can then be viewed or modified in the Properties Window:

Property Description
General  
Plane Describes the plane in which the panel was placed.
Rotation
angle

Describes the panel span direction as an angle, 0° is horizontal
and 90° is vertical.

See: and Modify slab/panel span direction (page 274)
Is a parapet
wall

Check to indicate the panel is to be treated as a parapet in the
wind analysis.

See: Parapet wall panel load decomposition (page 1014)
Ignore local
moments
from lareral
loading

This option is omly available when the “Is a parapet wall” setting
is selected. When checked, only a lateral point load is applied to
the top of a supporting column.

See: Parapet wall panel load decomposition (page 1014)
Gap Where the funneling gap to the adjacent building is not

consistent due to the shapes of the buildings it is up to you to
decide whether to specify the average or worst-case gap. The
default gap is 1000 m which effectively give no funneling. A zero
gap value explicitly means ignore funneling, for example where
this building and the adjacent one are sheltered by upwind
buildings.

Solidity If you indicate that the wall panel is a parapet, then you also
need to indicate the Solidity of the parapet. (Walls that are not
parapets automatically adopt a solidarity of 1.0).

Status Indicates whether the panel is valid or not.
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Property Description
Decompose
to

Loads can be set to be decomposed to:

• Members

• Nodes (Default)

• Rigid Diaphragms

NOTE The decompose to nodes option only applies to those
loads generated by the wind wizard. It does not apply to
those loads applied directly to panels.

[+] UDA A customizable list of the attributes that can be applied to
individual members and panels.

Parapet wall panel load decomposition

For the special case of parapet wall panels spanning horizontally to parapet
posts supported by columns, the panel load is decomposed as a lateral point
load and point moment - which would be produced by a UDL on the post - to
the top of the supporting column.

In some circumstances the engineer may wish only the lateral load but not a
moment to be applied. This is catered for using the option “Ignore local
moments from lateral loading” which is available in the wind wall properties
only when the “Is a parapet wall” setting is checked on. When the “Ignore local
moments from lateral loading” setting is checked on, only a lateral point load
is applied to the top of a supporting column. No moment is applied.
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NOTE • The special decomposition of point loads - with or without a point
moment - to supporting columns only occurs when all the
following are true; the wind panel spans horizontally to parapet
posts, the “Is a parapet wall” setting is checked on for the wall
panel, the parapet post is supported by a column.

• In both the following cases a UDL will be decomposed to the
members onto which the parapet wind panel directly spans;

• The member supporting the parapet post is NOT a column.

• The member onto which the parapet wind panel spans is not a
parapet post (e.g. is an extended column or vertical beam).

Roof Panel Properties
Use the Roof Panel properties to view or modify the properties of a wall
panel.

The  Roof Panel command is used to create a roof panel. Once created, the
panel properties can then be viewed or modified in the Properties Window:

Property Description
General  
Plane Describes the level at which the panel was placed.
Rotation
angle

This value determines the following where appropriate:

• Span direction for 1-way load decomposition
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Property Description
• Orientation of semi-rigid 2D elements in the Solver Model

See: and Modify slab/panel span direction (page 274)
Include in
diaphragm

The options are:

• Checked

The roof panel is meshed to form a diaphragm of semi-rigid
2D elements.

• Unchecked (Default)

No diaphragm is defined on the roof panel.
Thickness Roof panel thickness

NOTE Only displayed if "Include in diaphragm" is checked

Youngs
Modulus

Youngs Modulus

NOTE Only displayed if "Include in diaphragm" is checked

Shear
Modulus

Shear Modulus

NOTE Only displayed if "Include in diaphragm" is checked

Temperatur
e coefficient

Temperature coefficient.

NOTE Only displayed if "Include in diaphragm" is checked

Divide
Stiffness by

Used to adjust the roof panel stiffness.

NOTE Only displayed if "Include in diaphragm" is checked

RoofType The options are:

• Default (Default)

• Flat

• Monopitch

• Duopitch

• Hip Gable

• Hip Main

• Mansard

NOTE The default option assigns the roof panel as flat (if the
slope < 5 deg) or Monopitch (if the slope is > 5 deg).
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Property Description

You can more accurately specify the roof panel by
choosing the appropriate option from the list.

NOTE If the RoofType is changed after the wind model has

already been established, you will need run 
Update Zones to reinstate the zoning.

[+] UDA Customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)

Support properties
Use the Support properties to view or modify the properties of a support.

When a support is first created, it's properties are taken as those displayed in
the Properties window at that time.

You can either set the properties prior to placing the support, or select a
support in the model afterwards to review or modify its properties.

Property Description
General  
Name Automatically created name based on the grid point

location.

NOTE This property is only displayed when editing
an existing support

User Name You can enter a user name to replace the
automatically created name if required.

NOTE This property is only displayed when editing
an existing support

Plane Describes the level at which the support was placed.

NOTE This property is only displayed when editing
an existing support
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Property Description
3 Grid Points The options are:

• Checked

A user defined coordinate system is applied to the
support. (After clicking where you want to create
the support, the second click defines the x direction
and the third click defines the y direction.)

• Unchecked (Default)

Support properties are defined in accordance with
the global coordinate system.

NOTE This property is only displayed when creating a
new support

Fx, Fy, Fz The translational degrees of freedom can be set as
either Free, or Fixed in each direction.

Mx, My, Mz The rotational degrees of freedom can be set as either
Free, or Fixed in each direction.

Angles  
Inclination, Azimuth
and Rotation

When creating new supports, the angles are calculated
automatically depending on the placement method (3
Grid Points Checked/Unchecked).

When editing existing supports, the angles can be
edited in order to redefine the direction in which the
support acts.

Translational
stiffness x, y, and z

 

Type In order to define a translational spring in a particular
direction, the translational degree of freedom in the
same direction must first be set to Free. The available
types are:

• Release - (i.e. zero translational stiffness)

• Spring Linear

• Spring Non-linear
Stiffness The options are:

• Spring Linear

A single stiffness value is entered, which acts in
both the positive and negative directions.
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Property Description
• Spring Non-linear

Two stiffness values are entered, one to act in the
positive direction and a second to act in the
negative direction.

Fmax -ve and Fmax
+ve

For non-linear springs you are also able to define the
spring capacity in each direction. (Note that this must
always be entered as a positive value, for both +ve and
-ve directions).

Rotational stiffness
x, y, z

 

Type In order to define a rotational spring in a particular
direction, the rotational degree of freedom in the same
direction must first be set to Free. The available
options are:

• Release - (i.e. zero rotational stiffness)

• Spring Linear

• Spring Non-linear

• Nominally Pinned

• Nominally Free
Stiffness The options are:

• Spring Linear

A single stiffness value is entered, which acts in
both the positive and negative directions.

• Spring Non-linear

Two stiffness values are entered, one to act in the
positive direction and a second to act in the
negative direction.

Stiffness Percentage The options are:

• Nominally Pinned - 10%

(i.e. 10% * 4 EI/L)

• Nominally Fixed - 100%

(i.e. 100% * 4 EI/L)

NOTE In the above equations, L is the length from
the base of the column to the level of the next
column stack that is denoted as a floor, or it is
the distance to the top of the column if
shorter.
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Property Description
Fmax -ve and Fmax
+ve

For non-linear springs you are also able to define the
spring capacity in each direction. (Note that this must
always be entered as a positive value, for both +ve and
-ve directions).

See also

Create supports (page 314)

Analysis Element properties

General
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Plane Indicates the level or frame within which the member is

placed.
Characteristic Analysis Element
Active Clearing this option makes the Analysis Element inactive in

the analysis.

See: Inactive members (page 306)
Element type • Beam (page 319)

• Truss (page 319)

• Tension only (page 319)

• Compression only (page 319)

• Linear axial spring (page 320)

• Linear torsional spring (page 320)

• Non-linear axial spring (page 320)

• Non-linear torsional spring (page 320)

• Link (page 320)

NOTE Tension only elements, Compression only
elements, and non-linear axil/torsional springs are
all non-linear elements and therefore require non-
linear analysis. If linear analysis is performed they
will be treated as linear elements.

Material type • Steel

• Concrete
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General
• Timber

• General

• Cold formed

• Cold rolled
Rotation Rotation of the member about its local x axis.

Span 1
Grade The material grade
Section
properties

For the Beam element type only, the area and inertia
properties about each axis are required.

For the Truss, Tension only, Compression only, and Link
element types, the area Ax is required.

For the spring Element types, spring properties are
required.

Spring
stiffnesses

For linear and non-linear axial and torsional springs, the
spring properties are defined here.

Releases
 For the Beam element type only, the six degrees of

freedom; 3 translational (Fx, Fy, Fz) and 3 rotational (Mx, My,
Mz); can be set at each end. See: Beam releases (page 949)

All other analysis element types are released in all degrees
of freedom at both ends apart from axial (Fx).

Load reductions
KLL

(Head Code
ACI/AISC)

Specify the KLL factor in accordance with Table 4-2 in
ASCE7-05/ASCE7-10.

See:
Reduce
imposed loads
by

(All other Head
Codes)

Although the percentage of imposed load reduction is not
determined automatically, this property allows you to
specify the percentage manually.

• reducible loadcases are reduced

• combinations incorporating reducible loadcases are
reduced

See:

UDA
Name

Finish

Class

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)
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UDA
Phase

Note

File

Base plate properties

Property Description
General  
Name The automatically generated name.
User Name Can be used to override the automatically generated name

if required.
Plane Indicates the level or frame within which the base plate is

placed.
Base Plate
Autosize Indicates whether base plate should be autosized when

column section changes
Length Length of base plate. User defined only when autosize is

off.
Width Width of base plate. User defined only when autosize is off.
Thickness Thickness of base plate. User defined only when autosize is

off.
Grade Grade of base plate.
Prepared for
direct contact in
bearing
(Eurocode only)

Indicates whether the base plate should be considered to
be prepared for direct contact in bearing.

Rod (AISC only)
Rod Grade Rod grade.
Rod Size Rod size.
Embedded
depth

Rod embedded depth.

Friction
Coefficient

Coefficient of friction between the base plate and the grout
layer

Horizontal
Shear Transfer

• Friction Alone

• Shear on Bolts Alone

• Friction and Shear on Bolts

• Bearing on Shear Lug
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Property Description
• Friction and Bearing on Shear Lug

Rod Layout
Type

• Symmetric 4 rods

• Symmetric
Edge Distance Distance of bolt from edge of plate
End Distance Distance of rod from end of plate
Bolts (Eurocode only)
Bolt Grade Bolt grade.
Bolt Size Bolt size.
Bolt Length Bolt length.
Projection
above base
plate

Length the bolt projects above the base plate.

Friction
Coefficient

Coefficient of friction between the base plate and the grout
layer

Horizontal
Shear Transfer

• Friction Alone

• Shear on Bolts Alone

• Friction and Shear on Bolts
Bolt Layout
Type

• Symmetric 4 Bolts

• Symmetric

• Asymmetric
Edge Distance Distance of bolt from edge of plate
End Distance Distance of bolt from end of plate
Anchor Plate (Eurocode only)
Type • Individual

• Combined
Width Anchor plate width.
Thickness Anchor plate thickness.
Length Anchor plate length.
Edge Distance Anchor plate edge distance, applicable when Type is

Combined.
Welds
Type • Fillet

• Butt
Leg Length Leg length of Fillet weld.
Full Profile Indicates whether weld is full or partial.
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Property Description
Partial Profile Length of partial weld, applicable when Full Profileis

turned off and is only applicable to weld associated with the
web.

Concrete base
Length Length of concrete foundation associated with base plate. If

no concrete base exists this value is user defined.
Width Width of concrete foundation associated with base plate. If

no concrete base exists this value is user defined.
Depth Depth of concrete foundation associated with base plate. If

no concrete base exists this value is user defined.
Concrete Material grade of concrete foundation associated with base

plate. If no concrete base exists this value is user defined.
Grout Space Grout space between base plate and concrete base.
Geometric
enhancement
parameter, α
(Eurocode only)

Geometric enhancement parameter (EN 1992-1-1 Cl. 6.7)
automatically calculated from base plate and concrete base
dimensions.

UDA
Name

Finish

Class

Phase

Note

File

A customizable list of the attributes that can be applied to
individual members and panels.

See: Create and manage user-defined attributes (page 916)

Patch properties

General
Name The automatically generated name for the patch.
User Name Can be used to override the automatically generated name

if required.
Type • Column

• Beam

• Wall
Lx Specifies the size of the patch in the X direction.
Ly Specifies the size of the patch in the Y direction.
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General
Associated Slab
Panel

Where a patch sits over more than one panel then an
automatic choice is made, but you are able to override this
if required by selecting one of the alternative panels from a
drop-down list.

Align to Panel
Reinforcement

When this check box is selected, the calculated strip
reinforcement is aligned with the background
reinforcement in the Associated Slab Panel.

Local X Angle The angle of the X axis reinforcement is only editable ifAlign
to Panel Reinforcement is cleared.

Surface Specifies the reinforcement to be associated with and
designed by the patch:

• Top or Bottom (cannot be both).
Autodesign This setting applies to all strips in both directions, but

reinforcement in either direction can still be set to none -
see below.

• Cleared - the specified reinforcement will be checked
during the design process.

• Checked - reinforcement will be designed during the
design process.

Select bars
starting from

This option controls the starting point for auto-design
procedures.

• Minima (default) - removes the current arrangement
and begins with the minimum allowed bar size.

• Current - the auto design commences from the current
bar arrangement.

Consider Strips This setting controls which strips are to be designed by the
patch.

• X

• Y

• X and Y
Consider patch
surface
moments only

Off (default)

• patch reinforcement is designed in the surface of the
slab at which the patch has been specified AND the slab
reinforcement is also checked in the opposite surface.

On

• patch reinforcement is designed in the surface of the
slab at which the patch has been specified, but the slab
reinforcement in the opposite surface is NOT checked.
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General

NOTE The only situation when you might need to
activate this option is if the check of slab
reinforcement in the opposite surface fails but
another patch exists in the same location at that
face.(When the other patch is designed
additional reinforcement will be provided at that
surface, so this check is not required for the
original patch).

Strips in X, Strips in Y
Center, Left
and Right Strip

 

Width The left and right strip widths can be specified
independently: the center strip width is recalculated
accordingly and cannot be edited.

(By default the center strip covers half the panel, so that the
left and right strips each cover a quarter of the panel.)

Design Force • Average (of all the FE nodal values within the strip).

• Maximum (of all the FE nodal values within the strip).
Reinforcement  
Combine with
Panel
Reinforcement

When this check box is selected, the calculated strip
reinforcement takes into account any existing panel
reinforcement in the Associated Slab Panel that is in the
same alignment as the strip.

Cover as Panel When this check box is selected, the cover is set to be the
same as that in the Associated Slab Panel.

Outer Bar
Direction as
Panel

When this check box is selected, the outer bar direction is
set to be the same as that in the Associated Slab Panel.

When cleared, the outer bar direction can be set in X or Y.

Reinforcement
Combine with
Panel
Reinforcement

When this check box is selected, the calculated strip
reinforcement takes into account any existing panel
reinforcement in the Associated Slab Panel that is in the
same alignment as the strip.

Cover as Panel When this check box is selected, the cover is set to be the
same as that in the Associated Slab Panel.

Outer Bar
Direction as
Panel

When this check box is selected, the outer bar direction is
set to be the same as that in the Associated Slab Panel.

When cleared, the outer bar direction can be set in X or Y.
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Reinforcement
Reinforcement This setting is used to specify whether bars or mesh are to

be used in each direction.

• Mesh

• Bars XY

• Bars X

• Bars Y

• None

(If Mesh is selected an extra setting then allows you to
specify if main bars are in X or Y.)

Reinforcement in X, Reinforcement in Y, or Mesh
Bar Size,
spacing, Mesh
type etc.

The actual reinforcement provided in each of the strips is
indicated here.

Punching check properties

General
Tension
Reinforcement

This setting identifies the slab reinforcement to be used in
the punching check calculation.

• Top

• Bottom
Center The check location (not editable).
Column Drop Indicates if the check considers a Column Drop (not

editable).
Beta - User limit

(Head Code
Eurocode)

When this check box is selected, a minimum value of Beta =
1.15 is applied to all internal columns.

User factor for
Vt

(Head Code BS)

When this check box is selected, the user factor for Vt is
applied.

u0 - user
reduction

Can be used to manually specify a reduction in the length of
the u0 perimeter to account for undefined openings.

u1 - user
reduction

Can be used to manually specify a reduction in the length of
the u1 perimeter to account for undefined openings.

Check Status
and Ratio

Indicates the status of the checks for each calculated
perimeter and the overall check ratio.
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Loaded Perimeter
Length Indicates the length of the u0 Loaded Perimeter (not

editable).
Reduced length The reduced length of u0 after accounting for openings.
BEquiv, DEquiv,
BBound,
BBound,
Bounding
Perimeter

Refer to the Concrete Design Reference Guide for the
current Head Code for the appropriate definition of these
terms.

d Effective
Depth

Indicates the average effective depth to the tension
reinforcement (not editable).

d = (dy + dz) / 2

where dy and dz are the effective depths in the two
orthogonal directions.

There is a value of d for top steel and a different value for
bottom steel. Note this definition changes in the presence
of a drop panel.

This information is only available if the reinforcement is
known in each direction.

Slab Override When an override is applied the slabs in each direction can
be de-activated in the check. In this way the Loaded
Perimeter Position can be edited.

NOTE In the typical case of punching checks around a
column, the slab ‘y’ & ‘z’, ‘positive’ & ‘negative’ are
defined by the local axis system of the column. This
can be displayed by displaying the Local Axes for
1D Elements in Scene Content.

Control Perimeter
Length Indicates the length of the u1 Control Perimeter (not

editable).
Reduced length The reduced length of u1 after accounting for openings.
[-] Design Input

(Head Code
Eurocode and
ACI)

 

Use
Reinforcement

Select this check box in order to apply a default punching
reinforcement arrangement that can then either be
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Control Perimeter
checked, or used as the starting reinforcement for an auto-
design.

You would only choose to clear the check box when
specifying a new check if you want to perform an auto-
design but starting from Minima.

Reinforcement
type

In the current release only Stud reinforcement is
considered.

Arrangement
type

The options are:

• Orthogonal (default)

• Circular
Auto-design When run in Auto-design mode, the reinforcement is

increased until either a pass is achieved or the limiting
reinforcement parameter limits have been exceeded.

Select
reinforcement
starting from

This option controls the starting point for auto-design
procedures and is therefore only displayed if Auto-design is
‘on’.

• Minima - removes the current arrangement and begins
with the minimum allowed bar size.

• Current - auto-design commences from the current bar
arrangement.

Rib type Specifies the reinforcement rib type.
Grade The reinforcement grades that are available here are set

from the Materials button on the Home ribbon.
Bar size The reinforcement bar sizes that are available here are set

from the Materials button on the Home ribbon.
Spacing Defines the spacing between bars along each rail.
Spacing from
column face

Defines the spacing of the first bar in each rail from the
column face.

Stud rails
spacing in Y
direction

Spacing between rails in the local Y direction.

Stud rails
spacing in Z
direction

Spacing between rails in the local Z direction.

Number of
diagonal stud
rails on one
corner

The number of stud rails adjacent to each corner of the
column.

(This property is only displayed when the ‘Arrangement
Type’ is Circular)

Number of
studs per

The number of stud rails adjacent to the column face in the
local Y direction.
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Control Perimeter
column face - Y
direction
Number of
studs per
column face - Z
direction

The number of stud rails adjacent to the column face in the
local Z direction.

Number of
studs per rail

Number of studs on each rail.

Utilization ratio
Apply (to
autodesign)

On

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than the
ratio limit.

Off

• When an Autodesign is performed, the design will be
incremented to achieve a utilization ratio less than 1.0.

See: Apply user defined utilization ratios (page 613)
Apply (to check) On

• When a Check is performed, the check will pass
provided the utilization ratio is less than the ratio limit.

Off

• When a Check is performed, the check will pass
provided the utilization ratio is less than 1.0.

Ratio limit The utilization ratio against which the autodesign or check
is performed (when applied above).

Design Input (Eurocode and ACI only)
Use
Reinforcement

Select this check box in order to apply a default punching
reinforcement arrangement that can then either be
checked, or used as the starting reinforcement for an auto-
design.

You would only choose to clear the check box when
specifying a new check if you want to perform an auto-
design but starting from Minima.

Reinforcement
type

In the current release only Stud reinforcement is
considered.

Arrangement
type

The options are:

• Orthogonal (default)

• Circular
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Design Input (Eurocode and ACI only)
Auto-design When run in Auto-design mode, the reinforcement is

increased until either a pass is achieved or the limiting
reinforcement parameter limits have been exceeded.

Select
reinforcement
starting from

This option controls the starting point for auto-design
procedures and is therefore only displayed if Auto-design is
‘on’.

• Minima - removes the current arrangement and begins
with the minimum allowed bar size.

• Current - auto-design commences from the current bar
arrangement.

Rib type Specifies the reinforcement rib type.
Grade The reinforcement grades that are available here are set

from the Materials button on the Home ribbon.
Bar size The reinforcement bar sizes that are available here are set

from the Materials button on the Home ribbon.
Spacing Defines the spacing between bars along each rail.
Spacing from
column face

Defines the spacing of the first bar in each rail from the
column face.

Stud rails
spacing in Y
direction

Spacing between rails in the local Y direction.

Stud rails
spacing in Z
direction

Spacing between rails in the local Z direction.

Number of
diagonal stud
rails on one
corner

The number of stud rails adjacent to each corner of the
column.

(This property is only displayed when the ‘Arrangement
Type’ is Circular)

Number of
studs per
column face - Y
direction

The number of stud rails adjacent to the column face in the
local Y direction.

Number of
studs per
column face - Z
direction

The number of stud rails adjacent to the column face in the
local Z direction.

Number of
studs per rail

Number of studs on each rail.

Result strip properties
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General
Name The automatically generated name for the strip.
User Name Can be used to override the automatically generated name

if required.
  
Start Width The total strip width at the first point picked when creating

the strip.
End Width The total strip width at the second point picked when

creating the strip.
Result Type Determines how the strip result is calculated:

• Average

• Centreline

• Maximum
Number of
Stations

The number of stations per metre along the strip.

Number of
Points

The number of points per metre across the strip at each
station.

13.2 Settings

Settings for the current project

Several dialogs are provided for controlling the various settings and options in
the current project:

• Model Settings dialog (page 1207)

• Analysis Settings dialog (page 1173)

• Design Settings dialog (page 1179)

• Slab Deflection Settings dialog (page 1225)

• Drawing Settings dialog (page 1180)

Settings for future projects

A single dialog is provided for defining all settings and options that are to be
applied to new projects:

• Settings dialog (page 1209)

Model Settings
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Many (but not all) of the settings for the current project are accessed from the
Model Settings dialog (page 1207) on the Home tab.

• Design code settings (page 1033)

• Unit settings (page 1034)

• Object reference settings (page 1035)

• Loading settings (page 1037)

• Grouping model settings (page 1038)

• Material list settings (page 1039)

• Beam lines settings (page 1039)

• Analysis Model settings (page 1040)

• Validation settings (page 1042)

• Live/imposed load reduction settings (page 1043)

• Global Imperfections settings (page 1044)

• User-defined attribute settings (page 1045)

• Graphics view settings (page 1047)

• Structural BIM settings (page 1047)

See also

Analysis Settings (page 1050)

Design Settings (page 1064)

Slab deflection settings (page 1122)

Drawing settings (page 1126)

Design code settings
The Design Codes page allows you to specify the head code and the
subsequent design codes that are applied:

• To the current project - when accessed from the  Model Settings
(page 1032)

• To new projects - when accessed from the  Settings dialog (page 1209)

Item Description
Select the head code list Allows you to select the head code

that you want to apply. When you
select a head code in the list, the
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Item Description
Design Codes table automatically
updates.

WARNING If you change the head
code in an existing
project, the following will
occur in the model:

• Some materials, steel
sections, studs, decks
and reinforcement
may require re-
selecting in the
model to make them
consistent with the
new head code/unit
system.

• Wind loading (if any)
and wall/roof panel
properties will be
deleted. The wind
wizard will need
rerunning, wall/roof
panel properties
need resetting and
the wind loadcases
will need recreating.

• Seismic loading (if
any) will be deleted.
The seismic wizard
will need re-running.

• All combinations will
be deleted.

Design Codes table Displays the available action codes
and resistance codes, which are
dependent on the selected head
code. The lists within the Design
Codes table can be used to select
between available alternatives.

See also

Define and modify head codes and design codes (page 878)
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Unit settings
The Units page allows you to specify the units, format and precision that are
applied

• To the current project - when accessed from the  Model Settings
(page 1032)

• To new projects - when accessed from the  Settings dialog (page 1209)

Item Description
System list Allows you to determine whether

metric or US customary units are
used.

Table of quantities Displays each quantity, its current
unit and its precision. You can modify
quantities by selecting them in the
table.

Settings list Displays and allows you to select the
units for the currently selected
quantity.

Precision list Displays and allows you to define the
precision of the currently selected
quantity.

Use for values lower than Allow you to define the values for
which Tekla Structural Designer
applies exponential formats.

or greater than or equal to

See also

Define and modify units (page 879)

Object reference settings
The References page and its subpages allow you to adjust different object
reference settings:

• To the current project - when accessed from the  Model Settings
(page 1032)

• To new projects - when accessed from the  Settings dialog (page 1209)

Item Description
General subpage
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Item Description
Initial value in levels Allows you to specify the start

number (such as 1, 100, 1000) at each
construction level for object
references that contain the Count
item.

Renumbering Direction Allows you to specify renumbering
directions that control how the
member numbering is applied when
you use the Renumber command.

Ignore letters I & O Allows you to ignore the letters I and
O in grid line names.

Initial number Allows you to specify the initial
number applied to the first grid lines.

Initial letter Allows you to specify the initial letter
applied to the first grid lines.

Naming style list Allows you to select a desired naming
style for grid lines.

Groups subpage

NOTE This subpage is only displayed in the Settings dialog box not in the
Model Settings dialog box.

Sub-group Name Allows you to specify the text used to
designate the group labelling.

This text forms the stem of the Design
Group and Detailing Group names
that are displayed on the Groups tab
of the Project Workspace. These
names are shown in the output
reports and drawings when grouped
design has been applied.

Formats subpage
Format table Lists each object type showing its

current reference format and allows
you to customize the formats.

NOTE To customize a object
reference format, click the
click the ... button in the Edit
column

Texts subpage
Characteristics table Allows you to specify the text used to

designate the characteristic for object
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Item Description
references that contain the
Characteristic item.

Materials table Allows you to specify the text used to
designate the material for object
references that contain the Material
item.

See also

Manage object references (page 881)

Loading settings
The Loading page and its subpages allow you to adjust certain loading
settings:

• In the current project - when accessed from the  Model Settings
(page 1032)

• In new projects - when accessed from the  Settings dialog (page 1209)

General

Item Description
Use load patterning for steel
beams

Allows you to select whether Tekla
Structural Designer applies load
patterns for steel beams.

Use patterning of eccentricity
moments for steel columns

Allows you to select whether Tekla
Structural Designer considers
patterned eccentricity moments in
the design of steel columns.

Pipework Operating & Testing
Content Loadcase Type

Allows you to select whether the
ancillary loadcases created for lines of
pipework are considered as Dead or
Live (Imposed).

Equipment Operating & Testing
Content Loadcase Type

Allows you to select whether the
equipment loadcases created for
operating and testing are considered
as Dead or Live (Imposed).
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Line/Area Ancillary Loading

Item Description
Ancillary Type Ancillary Type.
Dead/Empty Load The default Dead/Empty Load factors

applied for each type.
Live (Imposed)/Content Load The default Live (Imposed)/Content

Load factors applied for each type.
Testing Content Load The default Testing Content Load

factors applied for each type.

Wind Loading

Item Description
Entity Type The loadcase names that will be

created when specific ancillary types
have been specified.

Shape factor Cf The default Cf factors come from the
document ‘Wind Loads For
Petrochemical And Other Industrial
Facilities’ published by ASCE

Effective Areaxy , xz The effective area of entity in xy and
xz planes respectively.

Factorxy , xz Factor applied to the effective area of
entity in xy and xz planes respectively.

Area Per Lengthxz The area per length.

Grouping model settings
The Grouping page in the Model Settings dialog box allows you to control the
tolerance applied when members are grouped in the current project.

Item Description
Maximum edge length variation Allows for a tolerance to be applied to

the automatic grouping. A member
can only be included in an existing
group if its span length is within the
specified tolerance of the group's
(average) span length.

Maximum length variation Allows for a length tolerance to be
applied to the automatic grouping of
trusses. A truss can only be included
in an existing group if its span length
is within the specified tolerance of the
group's (average) span length.
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Item Description
Maximum height variation Allows for a height tolerance to be

applied to the automatic grouping of
trusses. A truss can only be included
in an existing group if its height is
within the specified tolerance of the
group's (average) height.

Material list settings
The Material List page allows you to specify settings affecting material lists:

• To the current project - when accessed from the  Model Settings
(page 1032)

• To new projects - when accessed from the  Settings dialog (page 1209)

Item Description
Ignore openings with area less
than

Allows you to specify the size of
opening that can be considered small
enough to be ignored when
determining the quantity of necessary
slab reinforcement.

See also

Apply attribute filters to material lists and reports (page 920)

Beam lines settings
The Beam Lines page allows you to control the parameters used for
continuous concrete beam formation:

• In the current project - when accessed from the  Model Settings
(page 1032)

• In new projects - when accessed from the  Settings dialog (page 1209)

NOTE The parameters are only used to control the automatic concrete beam
joining that occurs during the design process or when the Beam Lines
command is run. The parameters are not considered when members
are joined manually using the Join command.
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Item Description
Join pinned beam end Allows you to control whether joining

should occur or not if a pin is defined
at the end the last span of the first
beam or the start of the first span of
the second beam, the fixity at the end
in question changing from pinned to
continuous once joined. If the beam is
subsequently re-split at the same
location, the pin gets reinstated.

Limiting join angle in plan Specifies the limiting angle in plan to
be applied for joining beams. Only
beams meeting in plan at an angle
less than the specified value can be
joined. Where two beams start at the
end of the first, the one that has the
minimum angle is the one that gets
connected.

Limiting join angle in elevation Specifies the limiting angle in
elevation to be applied for joining
beams. Only beams meeting in
elevation at an angle less than the
specified value can be joined. Where
two beams start at the end of the
first, the one that has the minimum
angle is the one that gets connected.

Minimum section overlap Allows you to apply a tolerance when
joining beams if they do not fully
overlap in section. You can use it to
prevent joining if there is very little
physical overlap between the beam
cross sections.

See also

Automatically join all concrete beams (page 331)

Analysis Model settings
On the Analysis Model page you can adjust certain rigid zone, curved beam,
and concrete column centerline settings:

• In the current project - when accessed from the  Model Settings
(page 1032)

• In new projects - when accessed from the  Settings dialog (page 1209)
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Rigid Zones

Design codes allow engineers to assume parts of concrete beams or columns
are rigid, leading to more efficient designs.

NOTE Rigid zones should not be confused with rigid offsets, which are used
to ensure that the analysis model is properly connected. You can have
rigid offsets in the model even if rigid zones are turned off.

Item Description
Percentage of rigidity Allows you to specify the extent of the

rigid zone created. The option has an
effect only if rigid zones are applied
(see below).

Rigid zones not applied Allows you to switch rigid zones on or
off. The option affects where releases
are applied in the analysis model and
where members start and end for
design.

When rigid zones are not applied, the
design model corresponds to the
analysis model, whereas when they
are applied, the design model is
defined between the ends of the rigid
zones.

NOTE There is a significant difference between Rigid zones not applied and
rigid zones applied with 0% rigidity. The total elastic length of a
member will be the same in the two models, but the position of
releases and start or end of design members will be different.

Curved Beams

In the solver model, curved beams are replaced by a series of straight line
solver elements. The number of solver elements used being controlled by the
Maximum facet error that has been specified.

Item Description
Maximum facet error For any given chord height, reducing

this value increases the number of
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Item Description
solver elements used to represent the
curve.

Column Centerlines

For concrete columns connected to a two-way slab, the column perimeter
shape is cut out of the slab 2D element mesh. Stiff analysis ‘rigid link’ elements
then connect the column centerline (where the column 1D elements are
located) to the 2D mesh nodes. In some circumstances - for example for L-
section columns of certain proportions - very short link elements could result,
which could cause validation errors or warnings and analysis solution
problems.

The following settings are provided in order to move the column centerline a
small distance where needed to avoid these problems.

Item Description
Automatically move column
centerlines when the smallest rigid
link is less than the error limit for
1D element length

This option is initially on by default.

The error limit used in this check is
specified in Validation settings
(page 1042)

Automatically move column
centerlines when the smallest rigid
link is less than the warning limit
for 1D element length

This option is initially off by default.

The warning limit used in this check is
specified in Validation settings
(page 1042)

Validation settings
The Validation page of the Model Settings dialog box allows you to control
the checks that are applied when the current model is validated.

Item Description
Error limit for length Allows you to control when an error is

displayed when very short analysis
elements are detected.

Warning limit for length Allows you to control when a warning
is displayed when very short analysis
elements are detected.
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Item Description
Error limit for quality Allows you to control when an error is

displayed when poor quality 2D
elements are detected.

NOTE 2D element quality depends
on two things: skew and
aspect ratio. 0% is bad
quality: a squashed triangle
tends towards bad quality,
whereas 100% is perfect
quality, so an equilateral
triangle is perfect quality.

Warning limit for quality Allows you to control when a warning
is displayed when poor quality 2D
elements are detected.

Check for validation warnings Allows you to specify which model,
analysis, and design validation checks
are performed. If a box is cleared, the
validation check is not performed.

Live/imposed load reduction settings
The Live load reduction (US headcode) or Imposed load reduction (other
head codes) page in the Model Settings dialog box allows you to control the
live/imposed load reductions.

US headcode

Item Description
Limit on live load reductions Specify the limit on reductions

applied to beams.

Specify the limit on reductions
applied to column stacks and wall
panels for the number of floors
carried.

These apply to all loadcases of type
Live Load

Limit on live load reductions Specify the limit on reductions
applied to beams columns and walls.

These apply to all loadcases of type
Roof Live Load
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Other headcodes

Item Description
Number of floors carried The number of floors carried by the

column or wall.
Reduction percentage The reduction that is applied to the

column stack or wall panel for the
number of floors carried.

See also

Activate reductions in live or imposed loadcases (page 341)

Global Imperfections settings

This page in the Model Settings dialog box is used to control the percentages
of load used for the global imperfection calculations.

The percentages are material independent, which means that the same
percentages are used for concrete and steel. The percentages vary depending
on the height of the structure and the number of columns in each direction.

EHF Global Imperfections (Eurocode)

Item Description
Height of the structure Allows you to specify the effective

height of the structure to be used in
the EHF calculations.

Set Default Sets the height of the structure to the
highest construction level.

Number of columns in X direction In the Eurocode Cl 5.2(5) the
calculation of the reduction factor am
depends on the number of
contributing members, m.

Valid input for m in the X and Y
directions is any whole number from
1 to 1000. The default value is 1 which
results in am = 1.000. If a value of
1000 is entered then am would reduce
to 0.707.

Number of columns in Y direction

Global initial sway imperfections Displays the calculated alpha values
and phi percentages for the above
input.

The override checkboxes can be used
to enter your own percentages in
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Item Description
place of the calculated values if
required.

NL Global Imperfections (US head code)

Item Description
 
Global initial sway imperfections

Direction Dir 1, Dir 2

Displays the calculated percentage
imperfections to be applied in each
direction.

The override checkboxes can be used
to enter your own percentages in
place of the calculated values if
required.

NHF Global Imperfections (BS, IS & AS head codes)

Item Description
 
Global initial sway imperfections

Direction Dir 1, Dir 2

Displays the calculated percentage
imperfections to be applied in each
direction.

The override checkboxes can be used
to enter your own percentages in
place of the calculated values if
required.

See also

Display notional forces and seismic equivalent lateral forces (page 504)

User-defined attribute settings
The User Defined Attributes page allows you to control the attributes that
are available:

• In the current project - when accessed from the  Model Settings
(page 1032)

• In new projects - when accessed from the  Settings dialog (page 1209)

You can add new attribute definitions, delete them, set a type for each
attribute, and adjust the acceptable values.
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Item Description
Name Displays and allows you to modify the

name of the attribute that will be
displayed in the UDA section of the
Properties window.

Type list Allows you to specify a type for the
option. The options are text, number,
and file.

Source list Allows you to restrict the allowable
input of the attribute, if necessary.
The two options are:

• Custom Value: Does not restrict
the allowable input.

• Value List: Restricts the allowable
input for an attribute to a pre-set
list.

Values Allows you to specify the allowable
attribute values when the source is
set to Value List.

Linked This setting has no effect if all levels in
the model are unique.

If the model contains existing
duplicate levels it works as follows:

• for UDAs that are linked, a single
UDA value is assigned to the entity
on the source and the duplicate
level.

• for UDAs that are not linked, a
different UDA value can be
assigned to an entity on a
duplicate level.

NOTE In the Construction Levels
dialog, when a level is first set
to be duplicate of a source
level:

• initially UDA values from
the source level are
copied to the duplicate
regardless of the Linked
setting

• only from that point on
does the linked/not linked
functionality apply.
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Item Description

• i.e. when set to not
linked, the UDA at each
level becomes
independently
editable.

Add Creates a blank row that allows you to
define a new attribute.

Delete Deletes the currently selected
attribute from the table.

Move Up Move the currently selected attributes
up or down in the table and in the
Properties window.

Move Down

See also

Create and manage user-defined attributes (page 916)

Graphics view settings
The Graphics View Settings page in the Model Settings dialog box allows
you to control the display of miscellaneous items in 2D and 3D views in the
current project.

Item Description
Do not display values of story
shear below

Allows you to limit the values of story
shear for a new model. This way, you
can easily ignore the small values of
story shear that might otherwise
detract you from the more important
story shear values. The story shear
values that are less than the limiting
value are not displayed in the results
view.

Show full pile length Allows you to select whether Tekla
Structural Designer displays the full
length of piles or a shorter pile length
that you can specify.

2x scale for steel columns Allows you to double the scale of steel
columns in 2D views in order to
simplify viewing the columns and
their orientation.
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Structural BIM settings
The Structural BIM page and its subpages allow you to control the structural
BIM import and export processes:

• In the current project - when accessed from the  Model Settings
(page 1032)

• In new projects - when accessed from the  Settings dialog (page 1209)

Button, command, or option Description
Export --> Continuous Objects subpage
Separate objects for each stack Allows you to select which columns

are exported as separate objects.

NOTE Tekla Structural Designer
organizes rebar information
by stacks and spans. If you do
not export concrete columns
as separate objects, no rebar
information is exported.

Separate objects for each span Allows you to select which beams or
other members are exported as
separate objects.

NOTE Tekla Structural Designer
organizes rebar information
by stacks and spans. If you do
not export concrete beams as
separate objects, no rebar
information is exported.

Separate objects for each panel Allows you to select which wall types
are exported as separate objects.

NOTE Tekla Structural Designer
organizes rebar information
by stacks and spans. If you do
not export shear walls as
separate objects, no rebar
information is exported.

Export --> Reinforcement Information subpage
Concrete columns Allows you to select whether bar

marks are included in the exported
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Button, command, or option Description
concrete column reinforcement
information.

Concrete beams Allows you to select whether bar
marks, link leg count, and region
length percentage are included in the
exported concrete beam
reinforcement information.

Export --> Mappings subpage
Materials --> Reset mappings for
Structural BIM export

Resets the mappings for Structural
BIM export of materials to the default
settings.

Decking --> Reset mappings for
Structural BIM export

Resets the mappings for Structural
BIM export of decking to the default
settings.

Import --> Settings subpage
Concrete beams --> Default "Allow
automatic join"

Allows you to control whether new
imported concrete beams are
automatically joined or not at the end
of the import.

NOTE If the BIM model contains
continuous beams as one
piece, you might want to
clear the option. After the
import, you can change the
properties back, if necessary.

Steel columns --> Ignore splice
offsets in physical member
positions

Allows you to select whether splice
offsets are ignored when importing
physical member positions.

Import --> Mappings subpage
Materials --> Reset mappings for
'TEL' File import

Resets the mappings for TEL file
import of materials to the default
settings.

Materials --> Reset mappings for
Structural BIM import

Resets the mappings for Structural
BIM import of materials to the default
settings.

Decking --> Reset mappings for
Structural BIM import

Resets the mappings for Structural
BIM import of decking to the default
settings.

See also

Import a project from a Structural BIM Import file (page 109)
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Analysis Settings
The Analysis Settings page and its subpages allow you to adjust the options
applied to the different analyses:

• In the current project - when accessed from the Analysis Settings dialog
(page 1173) on the Analyze tab.

• In new projects - when accessed from the Settings dialog (page 1209) on
the Home tab.

1st order non-linear settings

Button, command, or option Description
Maximum number of iterations The number of iterations to perform.

Default = 100.
Tolerance At the end of each iteration, values

are checked against the previous
iteration results. If the difference is
less than the tolerance determined
here, the result is converged, and the
analysis is complete. Default = 0.0001.

Relative Default: ON.
Relaxation Factors Relaxation factors control an amount

of nominal compression tension-only
braces can undergo while remaining
active during analysis iteration. This
improves convergence for rare
problematic models/ loading
situations in which otherwise most or
all braces may experience
compression and become inactive,
causing instability and preventing
solution. When converged tension-
only braces will still have only either
zero or tension force. The process is
entirely automatic by default and it is
anticipated the factors will not require
manual editing for most
circumstances.

• Use relaxation factors for
tension only elements: Default =
cleared

• Minimum relaxation factor:
Default = 0.1
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Button, command, or option Description
• Maximum relaxation factor:

Default = 0.5

If the model still fails to converge
when using relaxation factors,
expanding the allowable range (by
changing the above minimum and
maximum values) may produce
convergence.

NOTE Relaxation factors are not
activated by default, as it is
anticipated they will not be
required for the majority of
models. In addition, since the
solution process is
necessarily more complex,
their use can increase the
analysis time to a degree.

2nd order non-linear settings

Button, command, or option Description
Maximum number of iterations The number of iterations to perform.

Default = 100.
Tolerance At the end of each iteration, values

are checked against the previous
iteration results. If the difference is
less than the tolerance determined
here, the result is converged, and the
analysis is complete. Default = 0.0001.

Relative Default: ON.
Relaxation Factors Relaxation factors control an amount

of nominal compression tension-only
braces can undergo while remaining
active during analysis iteration. This
improves convergence for rare
problematic models/ loading
situations in which otherwise most or
all braces may experience
compression and become inactive,
causing instability and preventing
solution. When converged tension-
only braces will still have only either
zero or tension force. The process is
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Button, command, or option Description
entirely automatic by default and it is
anticipated the factors will not require
manual editing for most
circumstances.

• Use relaxation factors for
tension only elements: Default =
cleared

• Minimum relaxation factor:
Default = 0.1

• Maximum relaxation factor:
Default = 0.5

If the model still fails to converge
when using relaxation factors,
expanding the allowable range (by
changing the above minimum and
maximum values) may produce
convergence.

NOTE Relaxation factors are not
activated by default, as it is
anticipated they will not be
required for the majority of
models. In addition, since the
solution process is
necessarily more complex,
their use can increase the
analysis time to a degree.

1st order modal settings

Button, command, or option Description
Extraction Method Allows you to select the appropriate

extraction method for your model.
The options are:

• Automatic (default option):
Initially uses the Subspace option
to find the lowest modes. If the
criteria (either mass or number of
modes) is not fulfilled, FEAST is
then automatically used to find
higher modes until the stopping
criteria is fulfilled.
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Button, command, or option Description
• Jacobi: An iterative transformation

method used to calculate all
eigenvalues and eigenvectors.
Suitable for small models, but not
for medium to large models.

• Subspace: An iterative
simultaneous vector method to
calculate the smallest eigenvalues
and the corresponding
eigenvectors. Suitable for quickly
finding the lowest frequencies in
medium to large models.

• FEAST: uses the FEAST algorithm
to effectively calculate all the
eigenvalues within a specific
range. Suitable for any size
structure. For more information,
see: http://www.ecs.umass.edu/
~polizzi/feast/.

Mass Model Allows you to select how the mass
model of the analysis is displayed.
The options are:

• Consistent

• Lumped
Mass reporting For users that wish to determine a

center of mass for each floor, the
Simple mass option is available to
simplify the calculation. A single value
of mass for each node is listed in the
Tabular Data for both the "Active
Masses by Node" & "Total Masses by
Node" view types.

The simple mass is calculated by
averaging the mass values in the
active directions.

NOTE It is recommended that the
simple mass option is used
only when the lumped mass
model is used.

Stopping Criteria Stopping criteria prevent analysis
continuing forever. If either of the
criteria (Maximum number of
modes or Stopping Frequency) are
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Button, command, or option Description
met, the analysis will not look for any
more modes.

Modes Allows you to select one of the
following options:

• Automatic number of modes: If
the option is selected, you must
specify the mass participation
required in each direction. You can
optionally specify an initial
number of modes that should be
close to the actual number
required in order to speed up the
analysis process.

• Total number of modes: If
Automatic number of modes is
cleared, you can specify the total
number of modes required. The
default value is 10.

Jacobi Allows you to adjust the following
settings:

• Maximum number of sweeps: A
sweep is a transformation of every
off-diagonal in the global matrices.
The option allows you to set the
maximum number of sweeps
allowed.

• Sweep tolerance: At the end of
each sweep, values are checked
against the previous sweep
results. If the difference is less
than the tolerance specified here,
the result is converged, and the
analysis is complete.

Subspace Allows you to adjust the following
settings:

• Maximum number of iterations:
The number of iterations to
perform.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance specified here,
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Button, command, or option Description
the result is converged, and the
analysis is complete.

FEAST Allows you to adjust the following
settings:

• Initial search range: Specifies the
initial range of values FEAST will
search for eigenvalues in.

• Overestimation multiplier:
Specifies the initial guess for the
subspace dimension within each
range; an overestimate of the
predicted number of modes in the
range.

• Maximum modes in range: The
maximum number of modes in
the range. If more modes are
found in a range, the range is split
into several smaller ranges.

• Minimum search range: When a
range is smaller than the value
specified here, it will no longer be
split, even if the maximum
number of modes is greater than
that allowed.

2nd order buckling settings

Button, command, or option Description
Maximum number of iterations The number of iterations to perform.

Default = 1000.
Tolerance At the end of each iteration, values

are checked against the previous
iteration results. If the difference is
less than the tolerance determined
here, the result is converged, and the
analysis is complete. Default =
0.00001.

Maximum number of sweeps A sweep is a transformation of every
off-diagonal in the global matrices.
The option allows you to set the
maximum number of sweeps
allowed. Default = 50.
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Button, command, or option Description
Sweep tolerance At the end of each sweep, values are

checked against the previous sweeps
results. If the difference is less than
the tolerance determined here the
result is converged, and the analysis
is complete. Default = 1.0E-12.

Total number of modes Allows you to specify the total
number of modes required. Default =
10.

Show negative buckling factors Default = OFF.
Extraction Method Allows you to select the appropriate

extraction method for your model.
The options are:

• Jacobi: An iterative transformation
method used to calculate all
eigenvalues and eigenvectors.
Suitable for small models, but not
for medium to large models.

• Subspace: An iterative
simultaneous vector method to
calculate the smallest eigenvalues
and the corresponding
eigenvectors. Suitable for quickly
finding the lowest frequencies in
medium to large models.

• Automatic (default option): Tekla
Structural Designer determines
the most appropriate extraction
method for the structure.

1st order seismic settings

Button, command, or option Description
Extraction Method Allows you to select the appropriate

extraction method for your model.
The options are:

• Automatic (default option):
Initially uses the Subspace option
to find the lowest modes. If the
criteria (either mass, or number of
modes) is fulfilled, FEAST is then
automatically used to find higher
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modes until the stopping criteria is
fulfilled.

• Jacobi: An iterative transformation
method used to calculate all
eigenvalues and eigenvectors.
Suitable for small models, but not
for medium to large models.

• Subspace: An iterative
simultaneous vector method to
calculate the smallest eigenvalues
and the corresponding
eigenvectors. Suitable for quickly
finding the lowest frequencies in
medium to large models.

• FEAST: uses the FEAST algorithm
to effectively calculate all the
eigenvalues within a specific
range. Suitable for any size
structure. For more information,
see: http://www.ecs.umass.edu/
~polizzi/feast/.

Mass Model Allows you to select how the mass
model of the analysis is displayed.
The options are:

• Consistent

• Lumped
Mass reporting For users that wish to determine a

center of mass for each floor, the
Simple mass option is available to
simplify the calculation. A single value
of mass for each node is listed in the
Tabular Data for both the "Active
Masses by Node" & "Total Masses by
Node" view types.

The simple mass is calculated by
averaging the mass values in the
active directions.

NOTE It is recommended that the
simple mass option is used
only when the lumped mass
model is used.
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Stopping Criteria Stopping criteria prevent analysis

continuing forever. If either of the
criteria (Maximum number of
modes or Stopping Frequency) are
met, the analysis will not look for any
more modes.

Modes Allows you to modify the following
options:

• Initial number of modes: In
order to speed up the analysis
process, you can specify an initial
number of modes you expect to
be required to achieve the
required participation. The value
specified here should be close to
the actual number required
because if you enter too few or
too many modes, the analysis may
take longer.

• Mass participation for RSA:
Allows you to specify the mass
participation required in each
direction. If this isn't achieved
before the stopping criteria apply,
the RSA analysis will still be
performed, but a warning will be
issued.

• Min. Mass participation for RSA:
If the minimum participation isn't
achieved before the stopping
criteria apply, the RSA analysis is
not performed.

NOTE The options in Stopping
Criteria overrule both the
number of modes and mass
percentage.

Jacobi Allows you to adjust the following
settings:

• Maximum number of sweeps: A
sweep is a transformation of every
off-diagonal in the global matrices.
The option allows you to set the
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maximum number of sweeps
allowed.

• Sweep tolerance: At the end of
each sweep, values are checked
against the previous sweeps
results. If the difference is less
than the tolerance determined
here the result is converged, and
the analysis is complete.

Subspace Allows you to adjust the following
settings:

• Maximum number of iterations:
The number of iterations to
perform.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance determined
here, the result is converged, and
the analysis is complete.

FEAST Allows you to adjust the following
settings:

• Initial search range: Specifies the
initial range of values FEAST will
search for eigenvalues in.

• Overestimation multiplier:
Specifies the initial guess for the
subspace dimension within each
range; an overestimate of the
predicted number of modes in the
range.

• Maximum modes in range: The
maximum number of modes in
the range. If more modes are
found in a range, the range is split
into several smaller ranges.

• Minimum search range: When a
range is smaller than the value
specified here, it will no longer be
split, even if the maximum
number of modes is greater than
that allowed.
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Modal Combination Method To determine the representative

maximum response of interest for a
loadcase, the relevant values for each
relevant mode are combined by using
the modal combination method
specified here. Note that once modes
have been combined, the relative
signs are lost. The options are:

• Complete Quadratic
Combination (CQC): Suitable for
models where modes are closely
spaced or well spaced.

• Square Root of Summation of
Squares (SRSS): Suitable only for
models where modes are well
spaced.

Iterative cracked section analysis settings

Button, command, or option Description
Global Convergence Criteria Allows you to modify the following

options:

• Maximum number of iterations:
The number of iterations to
perform. Default = 200.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance determined
here, the result is converged, and
the analysis is complete. Default =
0.00100.

• Relative: Default: ON.

TIP To resolve global convergence
failures:

• Increase the value in
Maximum number of
iterations.

• Decrease the value in
Tolerance.
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Local Convergence Criteria Allows you to modify the following

options:

• Maximum number of iterations:
The number of iterations to
perform. Default = 500.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance determined
here, the result is converged, and
the analysis is complete. Default =
0.000001.

• Smoothing Parameter: A
property only available for the
Eurocode head code. Default =
0.005.

TIP To resolve local convergence
failures:

• Increase the value in
Maximum number of
iterations.

• Decrease the value in
Tolerance.

• If you are using the
Eurocode head code,
increase the value in
Smoothing Parameter.

Modification factors

Different factors can be applied for each of the different materials in the
model in order to adjust the following properties:

• E: Young's modulus

• G: Shear modulus

• Itorsion: Section inertia about local X

• Imajor: Section inertia about local Y

• Iminor - Section inertia about local Z

• Area: Section area in compression or tension
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• Aparallel to minor: Section shear area in local Y

• Aparallel to major - Section shear area in local Z

• t: shell thickness (applicable to concrete only)

The factors also vary according to the member types, (and in the case of
concrete members whether they are cracked or not).

For concrete members in particular, design codes can require that analysis
stiffness adjustment factors are applied since the appropriate properties to
use in analysis are load and time dependent.

For various other investigations it is also possible that you will want to apply
an adjustment to material properties. One suggested example is the
assessment of structures subject to corrosion. Another classic requirement in
this regard relates to torsion, it is common engineering practice to assume
that if it will work without assuming any torsional strength, then torsion can be
ignored.

Although default modification factors for each material are provided in the
settings sets to reflect the design code being worked to, you should check that
these are appropriate for your particular analysis model.

NOTE If you make changes to any of the modification factors, analysis must
be repeated.

Meshing settings
The meshing options can be adjusted in order to fine-tune the meshes that
are produced in slabs and walls. The default settings are generally
appropriate, but they could potentially be adjusted if 2D element quality
errors are being created during validation.

Composite steel beams settings

Button, command, or option Description
Inertia used for loading analysis list Allows you to specify the inertia to be

used in the global analysis of the
model for a composite steel beam:

• Steel beam (default option)

• Long term composite

• Short term composite

NOTE • If the model still fails to
converge when using
relaxation factors,
expanding the allowable
range (by changing the
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above minimum and
maximum values) may
produce convergence.

• Relaxation factors are not
activated by default as it is
anticipated they will not
be required for the
majority of models. In
addition, since the
solution process is
necessarily more complex,
their use can increase the
analysis time to a degree.

The inertia has different
effects on different head
codes:

• US head code:

Long and short term
composite inertia only
apply to rolled symmetric
I sections without web
openings. For all other
sections, the standard
steel beam inertia is used
regardless of the analysis
option selected.

• EC head code:

Long and short term
composite inertia only
apply to:

• Symmetric I rolled
sections without web
openings

• I plated sections
without web openings

• Westok plated sections
without web openings

• Fabsec sections
without web openings

For all other sections, the
standard steel beam
inertia is used regardless
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of the analysis option
selected.

• BS head code:

Long and short term
composite inertia only
apply to:

• Symmetric I rolled
sections without web
openings

• Asymmetric I rolled
sections without web
openings

• I plated sections
without web openings

• Westok plated sections
without web openings

• Fabsec sections
without web openings

For all other sections, the
standard steel beam
inertia is used regardless
of the analysis option
selected.

• AUS and IS head codes:

Design of composite
beams is not currently
supported for the head
codes.

Design Settings
The Design Settings sub-pages allow you to control the design options
applied:

• to the current project - when accessed from the Design Settings dialog
(page 1179) on the Design tab.

• to new projects - when accessed from the Settings dialog (page 1209) on
the Home tab.

Design Settings contains the following sub-pages:

• Analysis (page 1066)
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• General (page 1065)

• Steel > General (Eurocode only) (page 1067)

• Steel > Composite Beams (page 1068)

• Steel > Steel Joists (page 1069)

• Concrete > Cast-in-place (page 1070)

• Concrete > Precast

• Design Forces (page 1096)

• Design Groups (page 1113)

• Autodesign (page 1114)

• Design Warnings (page 1115) (AISC/ASC only)

• Sway and Drift Checks (page 1119)

• Fire checks (page 1121)

Design Settings - General and Analysis

General design settings

Button, command, or option Description
Fix column nodes horizontally Allows you to automatically apply

lateral translational fixed supports to
column nodes for the 3D building
analysis performed during the gravity
design processes.

The option is useful at the early
design stage when lateral systems
have not been established. The
automatic lateral supports can
remove unwanted lateral
displacements that may prevent the
analysis from completing and
produce unrealistic forces.

NOTE The option does not apply to:

• The column nodes that
are in a rigid floor
diaphragm

• An analysis run as a
separate process

• The Analyze All (Static)
command
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• The 3D building analysis
performed during any
Design (Static) command

Analysis settings

Button, command, or option Description
Analysis Allows you to select if a first or second

order 3D building analysis is
performed.

TIP For steel structures in particular
you should consider running a
first-order analysis for the initial
gravity design before switching
to a second-order analysis for
the final design.

In addition, Solve lateral loadcases
in isolation if non-linear analysis is
required during design allows you to
try to solver lateral loadcases in
isolation if non-linear analysis is
required. However, in non-linear
analysis, lateral loadcases often fail to
solve or take a long time to converge
when considered in isolation,
especially for compression only
foundation mats. Therefore, we
recommend that you leave the option
cleared.

If you need to see the results for the
individual lateral loadcases, you can
either run the analysis directly on the
Analyze tab, or select the option if
you know that the analysis does not
fail.

Stability coefficient tolerance

United States head code (ACI/AISC)
head code only

Stack height / ratio allows you to
adjust the value of deflection that can
safely be ignored. Selecting the option
prevents any small deflections from
causing erroneously high stability
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coefficients in stability coefficient
calculations.

NOTE If the second order drift is
less than the tolerance
specified in Stack height /,
the stability coefficient value
is returned as N/A with a note
that states that the drift is
small enough to be ignored.

Reduced stiffness factor

United States head code (ACI/AISC)
head code only

This factor is only exposed once the
analysis is set to second-order.

It is applied to the stiffness (EI and EA)
of all steel members in addition to
any settings made on Analysis
Options, Modification Factors.

For correct design to the AISC
Specification using the DAM, it should
be set to 0.8.

NOTE As an alternative to setting
the analysis to first-order to
explore the reason for any
second order analysis failure,
it is possible to alter this
factor. If you set it to a value
of say 10, this will stiffen both
the Modulus of elasticity (E)
and the shear modulus of
elasticity (G) by a factor of 10
in the second order analysis.
Although the results will not
be able to be used for a valid
design, it should now be
possible to run the analysis to
see which member might fail
a design and hence be the
cause of the analysis
instability. This factor can
then be reduced towards 0.8
for further investigation.

Design Settings - Steel > General (Eurocode only)
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General

NOTE Partial safety factors are only applicable to EC3 and relevant National
Annexes.

Button, command, or option Description
Partial safety factors
Use user defined partial safety
factors

When Use user defined partial
safety factors is selected, the options
to define partial safety factors are
enabled.

Otherwise, the corresponding country
defaults will be used.

NOTE Default for this setting is
unselected.

Resistance of cross-sections, γM0 Specify a user-defined value for this
partial safety factor as required.

Resistance of members to
instability, γM1

Specify a user-defined value for this
partial safety factor as required.

Resistance of cross-sections to
tension, γM2(EC3 - Part 1-1)

Specify a user-defined value for this
partial safety factor as required.

Resistance of joints, γM2(EC3 - Part
1-8)

Specify a user-defined value for this
partial safety factor as required.

Design Settings - Steel > Composite Beams

Composite beams

Button, command, or option Description
Tolerance of rectilinearity The calculation of the effective width

of composite beams is only
performed if they lie within the
tolerance on rectilinearity adjusted
here.

The default tolerance is 15 degrees.
At greater angles, you will be
prompted to type the effective width
manually.
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Update effective width prior to
design check

Allows you to determine the effective
width each time auto or check design
is run.

NOTE Unless this box is selected,
you will be unable to
manually override the
effective width on the Floor
construction and Natural
frequency pages of the beam
properties.

Design Settings - Steel > Steel Joists

Steel joists

NOTE Steel joists are only applicable in the US.

Button, command, or option Description
Uniform load tolerance If the calculated percentage load

tolerance for steel joists is less than
this value, the load is classified as
Uniform.

Equivalent load tolerance If the calculated percentage load
tolerance for steel joists is greater
than this value, the load is classified
as Non-uniform.

NOTE If 0% equivalent load
tolerance is specified, only
pure uniform loading is
accepted.

Maximum sum of concentrated
loads

Allows you to specify a user-defined
maximum sum of concentrated loads
that limits K, LH and DLH joists. If any
concentrated loads exceed the
specified maximum sum, the relevant
load combination is classified as Non-
uniform.

Maximum eccentricity of zero
shear

In the equivalent uniform load
method, the position of the point of
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zero shear relative to the center span
point of the joist is determined.

The option allows you to specify the
maximum eccentricity of zero shear
value in the equivalent uniform load
method. If the position is located
outside the value, the load is
classified as Non-uniform.

Deflection increase to allow for
shear

Deflections due to live load are
calculated using the following
effective inertia value:

Ieffective = Igross / (1 + R),

where

R = the deflection increase to allow
for shear effects (defaulted to 15%)
and applied to KCS only.

The option allows you to adjust the
value of R, (the deflection increase to
allow for shear, percentage).

Design Settings - Concrete > Cast-in-place

General

Buttons, commands, or options Description
Limitation on concrete cylinder strength for shear/torsion design
(Eurocode only)
Normal weight concrete limit

Lightweight concrete limit

For shear/torsion design the cylinder
strength and its use in all derived
mechanical properties is limited (but
'overridable') for specific national
annexes.

Default national annex values of these
limits for normal weight/lightweight
respectively:

• UK, Eire, Singapore, Malaysia: 50/50

• Norway: 65/55
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• EU, Finland, Sweden: 90/90 (no limit

stated)

NOTE Changing the headcode/settings
set does NOT update these values
automatically.

Reinforcement anchorage length parameters

(used in the calculation of the ultimate bond stress, from which anchorage
lengths are determined)
Plain Bars Bond Quality
Modifier

Default value 0.5.

Deformed Bars Bond Quality
Modifier

Default value 0.8. Only applies to the
Eurocode head code.

Type-1 Bars Bond Quality
Modifier

Default value 1.0. Only applies to the
Eurocode head code.

Type-2 Bars Bond Quality
Modifier

Default value is 1.0. Only applies to the
ACI headcode.

Beam

. . . . Reinforcement Settings

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Longitudinal bars Allows you to adjust the following settings

applied to longitudinal bars:

• Minimum bar size: Sets the minimum
allowable bar size that can be used in
the longitudinal bar design process.

• Maximum bar size: Sets the
maximum allowable bar size that can
be used in the longitudinal bar design
process.

• Minimum side bar size: Sets the
minimum allowable side bar size that
can be used in the longitudinal bar
design process.

• Minimum top steel clear spacing:
Sets the minimum allowable top steel
clear spacing that can be used in the
longitudinal bar design process.
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• Minimum bottom steel clear

spacing: Sets the minimum allowable
bottom steel clear spacing that can be
used in the longitudinal bar design
process.

• Maximum tension steel spacing:
Sets the maximum allowable tension
steel spacing that can be used in the
longitudinal bar design process.

• Maximum compression steel
spacing: Sets the maximum allowable
compression steel spacing that can be
used in the longitudinal bar design
process.

• Use single bars when beam width
<=: Single bars are only permitted in
beams whose width is less than the
width specified.

• Steel overstrength factor: Sets the
value that accounts for the
reinforcement steel yielding
overstrength in seismic design. Only
applies to the ACI headcode.

Short span maximum length Spans smaller than the value set here are
treated as short spans. Support bars of
short spans are merged with the span
bars.

. . . . Detailing Settings

Buttons, commands, or options Description
Use same size bars in
multilayer arrangements

Allows you to use the same bar size in
each layer.

Use same number of bars in
each layer

Allows you to use the same number of
bars in each layer.

Cut length rounding increment Allows you to specify a value to which cut
lengths are rounded.

Merge identical longitudinal
bars if appropriate

Allows you to merge bars of the same
size, number, and position, provided that
the total length of the merged bar does
not exceed the max allowable bar length.

TIP The max bar length can be verified
on the Reinforcement page of the
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Materials dialog box. To do so, click
an available bar size and then, click
View...

NOTE Top bar patterns 1 and 2 do not
have any bars that you could
merge.

Extend top longitudinal
support bars symmetrically

Extends the support bars symmetrically to
both spans based on the larger effective
span length; but only if the spans vary by
less than the percentage specified.

Extend top longitudinal
support bars by anchorage
length

Adds anchorage lengths to the calculated
extension lengths.

Min anchorage length {value} x
dia

Allows you to control the minimum
anchorage length as a multiple of bar
diameter.

NOTE The option is only available for
the Eurocode headcode.

Min anchorage length of plain
bars {value} x dia

Allows you to control the minimum
anchorage length as a multiple of bar
diameter when the rib type is plain.

NOTE The option is only available for
the ACI headcode.

Extend top span bars to end
support

Extends the top span bars of the first and
last spans to the end supports.

Use 'U' bars at end support if
appropriate

Allows you to replace the top and bottom
bars at the end support region with 'U'
bars under certain conditions. The bars
that are joined or merged to create the 'U'
bars depend on the top and bottom
patterns selected for the beam.

The anchorage lengths for the resulting
'U' bars are taken as the lengths required
for the pair of bars that made the 'U' bar.

Select same bar size in support
region and in the span

Allows you to use the same bar size in the
support and span regions.
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Select symmetrical stirrup in
support region

Allows you to use the same stirrup
arrangement (bar size and spacing) in
both supports.

. . . . Top / Bottom Longitudinal Bar Pattern

Buttons, commands, or options Description
Longitudinal Bar Pattern Allows you to select a pattern to be

viewed and modified.
Longitudinal Default Pattern Allows you to select the pattern that is

applied to new beams when they are first
created.

NOTE The Longitudinal Default
Pattern option cannot be used to
change the pattern applied to
existing beams. Instead, you
should modify the beam
properties.

Continuous Span + Cantilever
(Backspan) tab

Allows you to define how the selected
longitudinal bar pattern is applied to
continuous spans and cantilever
backspans. An interactive diagram
updates to match the changes you make.

• Bars: Selected checkboxes that are
greyed out are mandatory for the
selected pattern. Other bars can
optionally be included in the pattern
according to your needs.

• Region fields: The regions in which
bars are applied are defined as a
percentage of the span length.

• Bar lapping: Select whether you want
to lap the bottom bars in the middle of
the support region (inside support) or
at the face of the support region
(outside support).

Single Span tab Allows you to define how the selected
longitudinal bar pattern is applied to
single spans. An interactive diagram is
also displayed and updates to match the
changes you make.

Cantilever Allows you to define how the selected
longitudinal bar pattern is applied to
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cantilevers. An interactive diagram
updates to match the changes you make.

. . . . Stirrup (Link) Settings

Buttons, commands, or options Description
Normal When considering shear, the design shear

checks are performed in each of 3 regions
S 1 , S 2, and S 3 as shown below. In each
region, the maximum vertical shear from
all load combinations is determined and
this maximum value used to determine
the shear reinforcement required in that
region.

• Region S1, Region S2, Region S3: The
regions are defined as fixed
proportions of the clear span of the
beam. By defining the extent of the S1
region, the other regions are
determined automatically.

• Stirrup Type: Select either open or
closed stirrups in the list.

Cantilever In cantilevers, the design shear checks are
performed in 2 regions S 1 and S 2 as
shown below.

Minimum bar size Sets the minimum allowable bar size that
can be used in the design process.

Maximum bar size Sets the maximum allowable bar size that
can be used in the design process.

Minimum spacing Sets the minimum allowable stirrup
spacing that can be used in the design
process.
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Maximum spacing Sets the maximum allowable stirrup

spacing that can be used in the design
process.

Spacing increment The designed stirrup spacings are
multiples of this value.

Maximum stirrup leg spacing
across beam

Allows you to determine if single stirrups,
double stirrups, or more are required,
depending on the width of the beam.

Use single outside stirrup Allows you to use a single outside link
with additional links added as required (as
per stirrup d shown dotted below).

Accept single leg internal
stirrup

Allows the use of single leg internal links
(as per stirrup c shown dotted below).

Optimize stirrup design regions
where possible

In this case in the central region S2, shear
reinforcement is provided to meet the
minimum of the code requirement or
user preference whilst in regions S1 and
S3, designed shear reinforcement is
required.

The position and length of region S2 is
determined from considerations of the
shear resistance of the concrete cross-
section and this then enables the lengths
of regions S1 and S3 to be determined.

. . . . General Parameters

Buttons, commands, or options Description
Partial fixity coefficient, β A coefficient applied to the maximum

positive moment in the beam span
(excluding support positions) to set a
user-defined minimum design moment
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for beam support regions. Allowable
range is 0.0 to 1.0. Default value is 0.25

NOTE The option is only available for
the ACI headcode.

Maximum Bond Quality
Coefficient

A value used in the calculation of the
ultimate bond stress from which the
anchorage lengths are determined. The
allowable range is 0.5 to 1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation A value is used in the calculation to
determine the limiting nominal concrete
cover cnom, lim. The full calculation is:

cnom, lim = cmin + Δcdev

NOTE The option is only available for
the Eurocode head code.

Long term deflection period Allowable range is 3 to 60 months. Default
value is 60 months.

NOTE The option is only available for
the ACI headcode.

Time at which brittle finishes
are introduced

Allowance range is 1 to 6 months. Default
value is 1 month.

NOTE The option is only available for
the ACI headcode.

Design Beams for FE
Chasedown analysis results

Allows you to specify that the beams are
designed for the forces obtained from a
previously performed FE chasedown
analysis in addition to the forces obtained
from the other analyses that have been
performed.
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Tolerance on rectilinearity The calculation of the effective width is

only carried out for concrete beams if
they lie within the tolerance on
rectilinearity set here. The default
tolerance is 15 degrees. At greater angles
you will be prompted to enter the
effective width manually.

Column

. . . . Reinforcement Layout

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Vertical bars Allows you to adjust the following settings

applied to vertical bars:

• Minimum bar size: Sets the minimum
allowable bar size that can be used in
the vertical bar design process.

• Maximum bar size: Sets the
maximum allowable bar size that can
be used in the vertical bar design
process.

• Minimum clear spacing: Sets the
minimum allowable clear bar spacing
that can be used in the vertical bar
design process.

• Maximum center spacing: Sets the
maximum value for bar spacing when
a column is set to auto design mode.
The exact spacing may be reduced to
meet the requirements of the design if
the design fails with the bars at the
maximum spacing.

• Spacing increment: Sets the value
whose multiples the designed bar
spacings are.

• Minimum reinforcement ratio: Sets
the minimum allowable area of
reinforcement as a ratio of the
concrete section area.

Tekla Structural Designer reference 1078 Settings



Buttons, commands, or options Description
• Maximum reinforcement ratio: Sets

the maximum allowable area of
reinforcement as a ratio of the
concrete section area.

• Steel overstrength factor: Sets the
value that accounts for the
reinforcement steel yielding
overstrength in seismic design.

Tie bars Allows you to adjust the following settings
applied to tie bars:

• Minimum bar size: Sets the minimum
allowable bar size that can be used in
the tie bar design process.

• Maximum bar size: Sets the
maximum allowable bar size that can
be used in the tie bar design process.

• Minimum clear spacing: Sets the
minimum allowable clear bar spacing
that can be used in the tie bar design
process.

• Maximum center spacing: Sets the
maximum value for bar spacing when
a column is set to auto design mode.
The exact spacing may be reduced to
meet the requirements of the design if
the design fails with the bars at the
maximum spacing.

• Spacing increment: Sets the value
whose multiples the designed bar
spacings are.

Multiple Layers For circular column sections only, if
autodesign requires a 2nd layer of
reinforcement you can control the layer
spacing. Autodesign will use a larger
spacing if needed - and it is checked in the
check results.

Aspect ratio change point Allows you to specify a value that
determines which rectangular sections
are considered to have a low aspect ratio
and which are considered to have a high
aspect ratio.
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Use double ties for low aspect
ratio

Allows you to use double ties where
applicable instead of single ties for
sections with a low aspect ratio.

Use double ties for high aspect
ratio

Allows you to use double ties where
applicable instead of single ties for
sections with a high aspect ratio.

Use triple ties for low aspect
ratio

Allows you to use triple ties where
applicable instead of double or single ties
for sections with a low aspect ratio.

Use cross ties for low aspect
ratio

Allows you to use cross ties where
applicable instead of triple, double or
single ties for sections with a low aspect
ratio.

. . . . Detailing Settings

Buttons, commands, or options Description
Cut length rounding increment Allows you to specify a value to which cut

lengths are rounded.
Kicker dimension Allows you to specify the height of column

kicker cast above the slab level.
Assumed foundation depth for
starter bars

Allows you to control the length of starter
bars at the base of the column in
drawings.

Join identical bars where
possible

Allows you to merge bars together only if
the bar size and layout in the current and
adjacent stack are identical and proving
that the max bar length is not exceeded.

Number of span region ties
required to use separate
regions

Allows you to specify the minimum
number of span region ties that are
necessary for a span region to be
indicated on the detail, and in
consequence, standardize the tie spacing
on the detail.

Provide ties through full
foundation depth

Allows you to draw ties through the full
depth of the foundation.

Foundation penetration depth
of ties

Allows you to specify the penetration
depth of ties into the foundation.

NOTE The option is only available in the
If the Provide ties through full
foundation depth option is
cleared.
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Buttons, commands, or options Description
Provide ties through floor
depth for internal walls

For walls restrained by flat slabs: ties are
always provided through the floor depth
irrespective of this setting.

For walls restrained by beam and slab:
ties are always provided through the
beam depth for edge walls but are only
provided for internal walls when the
option is selected. When the option is
cleared, ties are provided up to the soffit
of the shallowest beam depth.

Tie bar type Allows you to select the tie bar type that
you want to use.

. . . . General Parameters

Buttons, commands, or options Description
Bar sizes no smaller than stack
above

Allows you to ensure that bar sizes do not
reduce in lower stacks.

Match bar position to stack
above

Allows you to have the starting
arrangement for longitudinal bars match
the arrangement of the bars in the stack
above if the section geometry matches.

Increase main bar size
preferentially

Allows you to have the corner bars
increased in preference to the
intermediate bars.

All bars start off at the same size (unless
the initial bar size is driven by the current
arrangement or the stack above), but
when the check fails, the corner bars will
be increased in size if all bar sizes are the
same. Otherwise, the intermediate bars
will be increased in size. This means that
when the final design is produced, either
all bars will be the same size or the corner
bars will be one size larger than the
intermediate bars.

Alternatively, if you require all bar sizes to
be the same size, clear the option. This
way, all bar sizes are increased together.

Maximum Bond Quality
Coefficient

A value used in the calculation of the
ultimate bond stress from which the
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Buttons, commands, or options Description
anchorage lengths are determined. The
allowable range is 0.5 to 1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation A value is used in the calculation to
determine the limiting nominal concrete
cover cnom, lim. The full calculation is:

cnom, lim = cmin + Δcdev

NOTE The option is only available for
the Eurocode head code.

Design Columns for FE
Chasedown analysis results

Allows you to specify that the columns are
designed for the forces obtained from a
previously performed FE chasedown
analysis in addition to the forces obtained
from the other analyses that have been
performed.

Wall

. . . . Reinforcement Layout

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Vertical bars Allows you to adjust the following settings

applied to vertical bars:

• Minimum bar size: Sets the minimum
allowable bar size that can be used in
the vertical bar design process.

• Maximum bar size: Sets the
maximum allowable bar size that can
be used in the vertical bar design
process.

• Minimum clear spacing: Sets the
minimum allowable clear bar spacing
that can be used in the design process.

Tekla Structural Designer reference 1082 Settings



Buttons, commands, or options Description
• Maximum center spacing: Sets the

maximum value for bar spacing when
a wall is set to auto design mode. The
exact spacing may be reduced to meet
the requirements of the design if the
design fails with the bars at the
maximum spacing.

• Spacing increment: Sets the value
whose multiples the designed bar
spacings are.

• Minimum reinforcement ratio: Sets
the minimum allowable area of
reinforcement as a ratio of the
concrete section area.

• Maximum reinforcement ratio: Sets
the maximum allowable area of
reinforcement as a ratio of the
concrete section area.

Vertical bars in end zone Allows you to adjust the following settings
applied to vertical bars in the end zone
area:

• Minimum bar size: Sets the minimum
allowable bar size that can be used in
the vertical bar design process in the
end zone area.

• Maximum bar size: Sets the
maximum allowable bar size that can
be used in the vertical bar design
process in the end zone area.

• Minimum reinforcement ratio: Sets
the minimum allowable area of
reinforcement as a ratio of the end
zone area.

• Maximum reinforcement ratio: Sets
the maximum allowable area of
reinforcement as a ratio of the end
zone area.

Horizontal bars Allows you to set the minimum allowable
bar size that can be used in the design
process of horizontal bars and the
minimum allowable area of reinforcement
as a ratio of the end zone area.

Tie/horizontal bars Allows you to set the minimum and
maximum allowable bar sizes that can be
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Buttons, commands, or options Description
used in the tie/horizontal bar design
process and specify the value whose
multiples the designed bar spacings are.

Tie/confinement bars Allows you to set the minimum and
maximum allowable bar sizes that can be
used in the tie/confinement bar design
process.

Confinement bars in end zone Allows you to set the minimum and
maximum allowable bar sizes that can be
used in the confinement bar design
process.

Substitute loose bars if mesh
inadequate

Allows you to use additional loose bars in
the end zones when the mesh is
inadequate.

. . . . Detailing Settings

Buttons, commands, or options Description
Cut length rounding increment Allows you to specify a value to which cut

lengths are rounded.
Kicker dimension Allows you to specify the height of column

kicker cast above the slab level.
Assumed foundation depth for
starter bars

Allows you to control the length of starter
bars at the base of the wall in drawings.

Join identical bars where
possible

Allows you to merge bars together only if
the bar size and layout in the current and
adjacent stack are identical and proving
that the max bar length is not exceeded.

Number of span region ties
required to use separate
regions

Allows you to specify the minimum
number of span region ties that are
necessary for a span region to be
indicated on the detail, and in
consequence, standardize the tie spacing
on the detail.

Provide ties through full
foundation depth

Allows you to draw ties through the full
depth of the foundation.

Foundation penetration depth
of ties

Allows you to specify the penetration
depth of ties into the foundation.

NOTE The option is only available in the
If the Provide ties through full
foundation depth option is
cleared.
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Buttons, commands, or options Description
Provide ties through floor
depth for internal walls

For walls restrained by flat slabs: ties are
always provided through the floor depth
irrespective of this setting.

For walls restrained by beam and slab:
ties are always provided through the
beam depth for edge walls but are only
provided for internal walls when the
option is selected. When the option is
cleared, ties are provided up to the soffit
of the shallowest beam depth.

Tie bar type Allow you to select the tie bar type that
you want to use.Tie bar type in end zones

. . . . General Parameters

Buttons, commands, or options Description
Bar sizes no smaller than stack
above

Allows you to ensure that bar sizes do not
reduce in lower stacks.

Maximum Bond Quality
Coefficient

A value used in the calculation of the
ultimate bond stress from which the
anchorage lengths are determined. The
allowable range is 0.5 to 1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation A value is used in the calculation to
determine the limiting nominal concrete
cover cnom, lim. The full calculation is:

cnom, lim = cmin + Δcdev

NOTE The option is only available for
the Eurocode head code.

Design Walls for FE Chasedown
analysis results

Allows you to specify that the walls are
designed for the forces obtained from a
previously performed FE chasedown
analysis in addition to the forces obtained
from the other analyses that have been
performed.
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Slab

. . . . Reinforcement Layout

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Minimum loose bar size Allows you to set the minimum allowable

loose bar size that can be used in the
design process.

Maximum loose bar size Allows you to set the maximum allowable
loose bar size that can be used in the
design process.

Minimum clear spacing Allows you to set the minimum allowable
clear bar spacing that can be used in the
design process.

Minimum spacing ( slab auto-
design)

Allows you to set the minimum allowable
clear bar spacing used in the slab item
auto design process.

As the option only applies to slab items, it
allows panel design to more readily select
bars at a wider spacing, while allowing
patch design to more readily pass by
reducing minimum spacing check failures
in the patches.

Maximum principal bar spacing Allows you to set the maximum allowable
principal bar spacing both as a distance
and as a function of the slab depth.

Maximum secondary bar
spacing

Allows you to set the maximum allowable
secondary bar spacing that can be used in
the design process both as a distance and
as a function of the slab depth.

Bar spacing increment Allows you to set a value whose multiples
the bar spacings are.

Maximum bar length Allows you to set the maximum length of
a bar.

Bar length increment Allows you to set a value whose multiples
the bar lengths are.

Use mesh where possible Select to use mesh where possible in bars.
Make bob for top steel of
cantilevers

Allows you to apply a bob to the end of
the top steel in cantilevers.

Auto selection of outer bars Allows you to automatically select the
bars in the outer layer.
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. . . . Patches

Buttons, commands, or options Description
Use mesh where possible Select to use mesh where possible in

patches.
Patch Size Allows you to set the default patch size to

be used.
Center strip width Allows you to set the width of the center

strip in beam patches.
Edge strip width as proportion
of patch width

Allows you to control how the patch width
is split between edge and center strips in
column patches.

. . . . General Parameters

Buttons, commands, or options Description
Maximum Bond Quality
Coefficient

A value used in the calculation of the
ultimate bond stress from which the
anchorage lengths are determined. The
allowable range is 0.5 to 1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation A value is used in the calculation to
determine the limiting nominal concrete
cover cnom, lim. The full calculation is:

cnom, lim = cmin + Δcdev

NOTE The option is only available for
the Eurocode head code.

Allowance for additional
detailing bars

Allows you to specify a percentage by
which the total mass of bars for slabs or
mats shown in material listing reports and
in slab or mat detailing drawings is
increased.
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Punching Shear

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Reinforcement bars Allows you to set the minimum and

maximum allowable bar sizes that can be
welded to the rail in the design process
and set the maximum allowable diagonal
spacing for radial layouts.

Spacing along rail Allows you to set the minimum and
maximum allowable bar spacing along
each rail and specify a value whose
multiples the bar spacings are.

Spacing to first reinforcement
line

Allows you to set the minimum and
maximum spacing from the column face
to the first reinforcement line and define
a value whose multiples the spacings
from the column face are.

Auto-design Allows you to select whether the auto
design method is to minimize the bar size
or minimize the number of rails and
specify the minimum number of studs per
face that will be used when auto-
designing from minima.

Diagonal spacing between rails Allows you to set the maximum diagonal
spacing between the outermost studs in
the last critical perimeter for circular
arrangements.

Spacing between rails in Y
direction

Allows you to set the minimum and
maximum allowable rail spacing in the Y
direction and specify a value whose
multiples the bar spacings in the Y
direction are.

Spacing between rails in Z
direction

Allows you to set the minimum and
maximum allowable rail spacing in the Z
direction and specify a value whose
multiples the rail spacings in the Z
direction are.

Spacing from last line to outer
perimeter

Allows you to set the maximum spacing
from the last reinforcement line to the
outer perimeter.
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Foundations - General

Buttons, commands, or options Description
Minimum distance from
column/wall face to base/cap
edge

Allows you to specify the minimum
distance from the column or wall face to
the base edge or cap edge.

Use presumed bearing capacity
method for pad bases and mats
(EN 1997-1 cl.6.5.2.4)

If this option is selected the bearing
pressure is checked for serviceability
combinations using the presumed
bearing resistance specified in the pad
base properties (no ‘STR’ and ‘GEO’
capacities).

NOTE The option is only available for
the Eurocode head code.

Isolated Foundations

. . . . Reinforcement Layout

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Minimum loose bar size Allows you to set the minimum allowable

loose bar size that can be used in the
design process.

Maximum loose bar size Allows you to set the maximum allowable
loose bar size that can be used in the
design process.

Minimum clear spacing Allows you to set the minimum allowable
clear bar spacing that can be used in the
design process.

Maximum principal bar spacing Allows you to set the maximum allowable
principal bar spacing both as a distance
and as a function of the slab depth.

Maximum secondary bar
spacing

Allows you to set the maximum allowable
secondary bar spacing that can be used in
the design process both as a distance and
as a function of the slab depth.

Bar spacing increment Allows you to set a value whose multiples
the bar spacings are.

Use mesh where possible Select to use mesh where possible in bars.
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. . . . Foundation Size

Buttons, commands, or options Description
Minimum depth Allows you to set the minimum allowable

foundation depth.
Maximum depth Allows you to set the maximum allowable

foundation depth.
Auto-design depth increment Allows you to set the depth increment.
Minimum side length Allows you to set the minimum allowable

side length.
Maximum side length / strip
width

Allows you to set the maximum side
length under columns as a distance.

Maximum side length ratio
under columns

Allows you to set the maximum side
length ratio under columns.

Rounding increment for footing
dimensions

Allows you to specify a value to which the
overall footing size is rounded.

Default 3-pile cap shape Allows you to define whether the default
shape is triangular or rectangular when 3
piles are used.

. . . . General Parameters

Buttons, commands, or options Description
Maximum Bond Quality
Coefficient

A value used in the calculation of the
ultimate bond stress from which the
anchorage lengths are determined. The
allowable range is 0.5 to 1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation A value is used in the calculation to
determine the limiting nominal concrete
cover cnom, lim. The full calculation is:

cnom, lim = cmin + Δcdev

NOTE The option is only available for
the Eurocode head code.
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Buttons, commands, or options Description
(Pad Base tab)

Consider passive resistance of
soil for sliding check

Allows you to control whether the passive
resistance of the soil is included in the
check of Sliding Resistance.

(Pad Base tab)

Pad base shear reactions at
pinned bases

Ignorable percentage of passive
pressure

This allows you to ignore small shear
forces at pinned bases. The default of 1%
is typically a negligible load level which
would commonly be ignored. If you do
not want to ignore any shear forces, set
the value to zero.

(Pad Base tab)

FOS for sliding and uplift
checks

Allows you to edit the design safety factor
for these checks.

NOTE The option is only available for
the ACI/AISC head codes.

(Pile Cap tab)

Tolerance for pile position
variation

Allows you to specify the allowable
deviation value of the pile position from
its original plan position. The value is used
in the design moment calculations.

. . . . Piles

Buttons, commands, or options Description
Minimum number of piles for
pile caps under columns

Minimum and maximum numbers of piles
that apply when a pile cap under a
column has been set to auto design the
piles.

Maximum number of piles for
pile caps under columns
Minimum spacing option list Allows you to select whether the

minimum spacing check uses a set
minimum spacing value or a multiple of
the pile width or pile circumference.

Minimum spacing of piles Allows you to set the minimum spacing
value that you can select in the Minimum
spacing option list.

Minimum pile edge distance Allows you to set the minimum distance
from the pile face to edge of foundation.

Pile auto-design method list Allows you to select to use the smallest
number of high capacity piles or more
piles of lowest capacity when a pile cap
has been set to auto design.
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Buttons, commands, or options Description
Limit maximum critical section
size

When selected, allows you to specify a
maximum critical section size as a
multiple of the pile dimension.

Use pile capacity for pile
punching and shear checks

When selected, allows you to use pile
capacity for pile punching and punching
shear checks.

When unselected, the pile load is used.
Check piles for lateral load When selected, a pile lateral capacity

check is performed.

Mat Foundations

. . . . Reinforcement Layout

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Minimum loose bar size Allows you to set the minimum allowable

loose bar size that can be used in the
design process.

Maximum loose bar size Allows you to set the maximum allowable
loose bar size that can be used in the
design process.

Minimum clear spacing Allows you to set the minimum allowable
clear bar spacing that can be used in the
design process.

Minimum spacing ( slab auto-
design)

Allows you to set the minimum allowable
clear bar spacing used in the panel auto
design process.

As the option only applies to slab items, it
allows panel design to more readily select
bars at a wider spacing, while allowing
patch design to more readily pass by
reducing minimum spacing check failures
in the patches.

Maximum principal bar spacing Allows you to set the maximum allowable
principal bar spacing both as a distance
and as a function of the slab depth.

Maximum secondary bar
spacing

Allows you to set the maximum allowable
secondary bar spacing that can be used in
the design process both as a distance and
as a function of the slab depth.
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Buttons, commands, or options Description
Bar spacing increment Allows you to set a value whose multiples

the bar spacings are.
Maximum bar length Allows you to set the maximum length of

bar.
Bar length increment Allows you to set a value whose multiples

the bar lengths are.
Auto selection of outer bars Allows you to automatically select the

bars in the outer layer.
Use mesh where possible Select to use mesh where possible in bars.

. . . . Patches

Buttons, commands, or options Description
Use mesh where possible Select to use mesh where possible in

patches.
Patch Size Allows you to set the default patch size to

be used.
Center strip width Allows you to set the width of the center

strip in beam patches.
Edge strip width as proportion
of patch width

Allows you to control how the patch width
is split between edge and center strips in
column patches.

. . . . General Parameters

Buttons, commands, or options Description
Maximum Bond Quality
Coefficient

Allows you to specify a value used in the
calculation of the ultimate bond stress
from which the anchorage lengths are
determined. The allowable range is 0.5 to
1.0.

NOTE The option is only available for
the Eurocode headcode.

Maximum nominal aggregate
size

Allows you to specify a value for the
calculation to determine the minimum
clear horizontal distance between
individual parallel bars.

Allowance for deviation Allows you to specify a value is used in the
calculation to determine the limiting
nominal concrete cover cnom, lim. The full
calculation is:

cnom, lim = cmin + Δcdev
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Buttons, commands, or options Description

NOTE The option is only available for
the Eurocode headcode.

. . . . Piles

Buttons, commands, or options Description
Use pile capacity for punching
check

When selected, allows you to use pile
capacity for the pile punching check.

When unselected, the pile load is used.
Check piles for lateral load When selected, a pile lateral capacity

check is performed.

Design Settings - Concrete > Precast

Beam

. . . . Reinforcement Settings

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Reinforcement settings Allows you to adjust the Reinforcement

Class and nominal cover settings applied
to beam reinforcement:

. . . . Top / Bottom Longitudinal Bar Pattern

Buttons, commands, or options Description
Longitudinal Bar Pattern Allows you to select a pattern to be

viewed and modified.
Longitudinal Default Pattern Allows you to select the pattern that is

applied to new beams when they are first
created.

NOTE The Longitudinal Default
Pattern option cannot be used to
change the pattern applied to
existing beams. Instead, you
should modify the beam
properties.

Continuous Span tab Allows you to define how the selected
longitudinal bar pattern is applied to
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Buttons, commands, or options Description
continuous spans. An interactive diagram
updates to match the changes you make.

• Bars: Selected checkboxes that are
greyed out are mandatory for the
selected pattern. Other bars can
optionally be included in the pattern
according to your needs.

• Region fields: The regions in which
bars are applied are defined as a
percentage of the span length.

NOTE The Top and Bottom Region fields
dictate how many design
sections appear in the Tedds
Calculation - a different design
section is required at each
interface between regions.

Pinned Span tab Allows you to define how the selected
longitudinal bar pattern is applied to
single pinned spans. An interactive
diagram is also displayed and updates to
match the changes you make.

Cantilever Allows you to define how the selected
longitudinal bar pattern is applied to
cantilevers. An interactive diagram
updates to match the changes you make.

. . . . Stirrup (Link) Settings

Buttons, commands, or options Description
Normal When considering shear, the design shear

checks are performed in each of 3 regions
S 1 , S 2, and S 3. In each region, the
maximum vertical shear from all load
combinations is determined and this
maximum value used to determine the
shear reinforcement required in that
region.

• Region S1, Region S2, Region S3: The
regions are defined as fixed
proportions of the span of the beam.
By defining the extent of the S1 region,
the other regions are determined
automatically.
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Buttons, commands, or options Description
Cantilever In cantilevers, the design shear checks are

performed in 2 regions S 1 and S 2.

. . . . General Parameters

Buttons, commands, or options Description
Design Beams for FE
Chasedown analysis results

Allows you to specify that the beams are
designed for the forces obtained from a
previously performed FE chasedown
analysis in addition to the forces obtained
from the other analyses that have been
performed.

Design precast beams for
lifting forces

Allows you to specify that the beams are
also to be designed for lifting forces, (the
lifting check being optional in the Tedds
calculation).

Column

. . . . Reinforcement Settings

Buttons, commands, or options Description
Country list Allows you to specify the country used for

the reinforcement information.
Reinforcement settings Allows you to adjust the Reinforcement

Class and nominal cover settings applied
to column reinforcement:

. . . . General Parameters

Buttons, commands, or options Description
Design Columns for FE
Chasedown analysis results

Allows you to specify that the columns are
designed for the forces obtained from a
previously performed FE chasedown
analysis in addition to the forces obtained
from the other analyses that have been
performed.

Design precast column for
lifting forces

Allows you to specify that the columns are
also to be designed for a set of lifting
forces, (the lifting check being optional in
the Tedds calculation).
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Design Settings - Design Forces

NOTE Values entered in the Ignorable Forces Below section:

• are considered when designing steel and cast-in-place concrete
members in Tekla Structural Designer

• are not considered when designing timber or precast members via Tekla
Tedds

Values entered in the Minimum Design Forces section:

• are considered when creating member end force reports/drawings and
foundation reaction reports/drawings in Tekla Structural Designer

• are considered when performing connection resistance checks in Tekla
Structural Designer

• are considered when designing connections in Tekla Connection
Designer, or IDEA StatiCa

• are not considered when designing steel and cast-in-place concrete
members in Tekla Structural Designer

• are not considered when designing timber or precast members via Tekla
Tedds

Ignore forces below

NOTE Values entered in the Ignorable Forces Below section:

• are considered when designing steel and cast-in-place concrete
members in Tekla Structural Designer

• are not considered when designing timber or precast members
via Tekla Tedds

Design  
Ignore Forces Below Allow you to specify appropriate

negligible or nominal force levels to
prevent 3D analysis from exposing
small forces that are normally ignored
in design.

When the small forces in the 3D
analysis are below the specified
levels, they are ignored and the
design in Tekla Structural
Designerproceeds automatically.

Tekla Structural Designer reference 1097 Settings



Concrete beams (Eurocode only)

Button, command, or option Description
Torsion force % of concrete
resistance

Allows you to limit the maximum
torsion force to a % of the concrete
resistance.

Minimum design forces

NOTE Values entered in the Minimum Design Forces section:

• are not considered when designing steel and cast-in-place
concrete members in Tekla Structural Designer

• are not considered when designing timber or precast members
via Tekla Tedds

These settings provide flexibility to control minimum design values and
rounding increments used in the following:

• Member end force reports/drawings

• Foundation reaction reports/drawings

• Connection resistance checks

• Export of connection forces to another application for design (Tekla
Connection Designer or IDEA StatiCa)

Setting Description
Brace Force

Axial Force

Click the links to see examples of how
the minimum entered here is used in:

• Member end force reports/
drawings (page 1099)

• Connection resistance checks
(page 1108)

• Exported connection forces
(page 1110)

Beam End Forces

Axial Force

Minor Axis Shear Force

Minor Axis Moment

Major Axis Shear Force

Major Axis Moment

Click the links to see examples of how
the minimums and rounding
increments entered here are used in:

• Member end force reports/
drawings (page 1099)

• Connection resistance checks
(page 1108)

• Exported connection forces
(page 1110)

Rounding Increment for Force

Rounding Increment for Moment
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Setting Description
Foundation Reactions

Axial Force

Minor Axis Shear Force

Minor Axis Moment

Major Axis Shear Force

Major Axis Moment

Click the links to see examples of how
the minimums and rounding
increments entered here are used in:

• Foundation reaction reports/
drawings (page 1103)

• Exported connection forces
(page 1110)

Rounding Increment for Force

Rounding Increment for Moment

How Minimum Design Forces are used

The following topics illustrate how Minimum Design Forces are applied in
different areas of Tekla Structural Designer.

Member end force reports/drawings

Tekla Structural Designer reports member end forces (Beam end forces/
Bracing forces) based on analysis results.

The ‘Minimum Design Forces’ inputs under Brace Force/Beam End Forces
allow the user to specify minimum values for the reported forces, and also
apply rounding increments to them.

NOTE While minimum design values and rounding increments are applied to
the member end force reports/drawings, they have no impact on steel
and concrete member design in Tekla Structural Designer, or timber and
precast design using Tekla Tedds.

Consider a fixed beam with axial force + major/minor shear + torsion + major/
minor moment.

Forces/moments are reported in the Beam End Force report.
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The user wants the forces rounded to the nearest 5kN and moments to the
nearest 10kNm so inputs 5kN in the ‘Rounding Increment for Force’ and
10kNm in the ‘Rounding Increment for Moment’ under Beam End Forces.
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The Beam End Forces report displays rounded value of forces and moments.

NOTE The rounding increment for moment applies to major axis and minor
axis moments, but does not apply to torsional moments (Mx).

The user might want the forces reported to be not less than minimum values,
for example they might enter 200kN in the ‘Major Axis Shear Force’ under
‘Beam End Forces.
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This results in the report being updated as follows.

The changes to the rounding increments and mimimum force are also
reflected in the Beam End Forces drawing.
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Foundation reaction reports/drawings

Tekla Structural Designer reports foundation reactions based on analysis
results.

The ‘Minimum Design Forces’ inputs under Foundation Reactions allow the
user to specify minimum values for the reactions, and also apply rounding
increments to them.

NOTE Changed force/moment values are for reporting purposes only.

Consider a fixed end support.

Forces/moments are reported in the Foundation Reactions report.
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The user wants these reported values to be not less than certain minimum
values, so inputs the required minimums under Foundation Reactions.
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The Foundation Reactions report shows minimum design forces/moments
specified by the user.
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The user also wants the forces rounded to the nearest 5kN and moments to
the nearest 10kNm so inputs 5kN in the ‘Rounding Increment for Force’ and
10kNm in the ‘Rounding Increment for Moment’ under Foundation
Reactions.

When the report is updated, any values exceeding the minimums are rounded
up accordingly.
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The changes are also reflected in the Foundation Reactions drawing, which
now shows the same minimum values of design force and moment.
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Connection resistance checks

Tekla Structural Designer performs connection resistance checks for simple
beams and braces which use design forces from the analysis results.

The ‘Minimum Design Forces’ inputs under Brace Force/Beam End Forces
allow the user to specify minimum values for these forces, and also apply
rounding increments to them.

Consider a simple beam connection.

Review Data of Connection Resistance shows the following details.

The user wants the forces rounded to the nearest 5kN so inputs 5kN in the
‘Rounding Increment for Force’ under Beam End Forces.
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By closing and re-opening the Connection Resistance Review Data, the
connection resistance check is updated and now uses the rounded value.

The user also wants a minimum design force of 75 kN for connection
resistance check so inputs 75 kN in the ‘Major Axis Shear Force’ under Beam
End Forces.
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By closing and re-opening the Connection Resistance Review Data once again,
the connection resistance check is updated to use the specified minimum
design force.

Because the minimum design force is being used this is indicated in the table
under the 'Note' column.

Exported connection forces

Forces exported to Tekla Connection Designer or IDEA StatiCa from Tekla
Structural Designer are based on analysis results.

The ‘Minimum Design Forces’ inputs allow the user to specify minimum values
for the exported forces, and also apply rounding increments to them.
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Consider a base plate connection exported to Tekla Connection Designer and
designed for axial load and major shear.

The user wants to design the base plate connection for a minimum shear of 50
kN and for a minimum axial load of 500 kN, so inputs these values under
Foundation Reactions.
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NOTE For other connection types the values under Brace Forces/Beam End
Forces would be edited instead.

Rounding increments could also be applied if required. These would
only apply to forces and moments exceeding the above minimums.

To apply the new minimums to the existing connections, it is necessary to click
Update Connections from the Project Workspace.

The base plate connection is now designed for the minimum shear of 50 kN
and for the minimum axial load of 500 kN specified by the user.
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Design Settings - Design Groups and Autodesign

Design groups

Button, command, or option Description
Members to design using groups Allows you to select the member

types for which you want to apply
grouped design.

When the members are grouped, only
one member in the group is designed.
This design is then copied to the
remaining members in the group, so
that they can be checked. Any failing
member in the group is redesigned,
and the process is repeated until all
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Button, command, or option Description
members pass, or a design is not
possible.

Autodesign settings

  
Reset Autodesign to off... Allows you to control what happens

to individual steel and concrete
member auto design settings and
isolated foundation auto design
settings at the end of the design
process. The options are:

• Always: the auto design setting is
automatically cleared at the end of
the design process, so that each
member is put into check mode.

• Never: the autodesign settings is
always retained as it is at the end
of the design process.

• When check status is at worst:

• Pass: The auto design setting is
only automatically cleared at
the end of the design process
for members with design
status Pass.

• Warning: The auto design
setting is only automatically
cleared at the end of the
design process for members
with design status Pass or
Warning.

• Fail: The auto design setting is
only automatically cleared at
the end of the design process
for members with design
status Pass, Warning, or Fail.

• Invalid: The auto design
setting is only automatically
cleared at the end of the
design process for members
with design status Pass,
Warning, Fail or Invalid.
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• Beyond Scope: The auto

design setting is only
automatically cleared at the
end of the design process for
members with design status
Pass, Warning, Fail, Invalid, or
Beyond Scope.

TIP The most practical use of When
check status is at worst is to
set it to Pass and start with all
members in auto design mode.
At the end of the first design
run, passing members would be
set to check mode, allowing you
to focus on the remaining
members still in auto design
mode.

Design Settings - Design Warnings
Warnings used as guidance during the design of a structure to US seismic
provisions are in effect by default. These can be de-activated as found useful
from this page.

Design Warnings (AISC/ASC Head code only)

Button, command, or option Description
Concrete Seismic Warnings
Specified concrete grade is too low • Compliance with ACI 318-08 and

ACI 318-11 Section 21.1.4.2, “(..) f’c,
shall not be less than 3000 psi.“

• Applies to normal weight
reinforced concrete columns and
beams part of Special Moment
Frames

• Applies to normal weight
reinforced concrete walls assigned
as Special Reinforced Concrete
Structural Walls

• Prompts the designer to increase
the concrete grade of the member

Specified longitudinal
reinforcement grade too high

• Compliance with ACI 318-11
Section 21.1.5.2, “(..)
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Button, command, or option Description
reinforcement resisting earth-
quake induced flexure, axial force,
or both, shall comply with ASTM
A706, Grade 60.”

• Applies to normal weight
reinforced columns and beams
part of Special Moment Frames

• Applies to normal weight
reinforced concrete walls assigned
as Special Reinforced Concrete
Structural Walls

• Prompts the designer to use lower
longitudinal reinforcement grades

Column at the end of the beam is
not in the same seismic frame

• Used to validate if the frame of
which the beam is part of is
correctly set-up as a seismic frame

• Applies to normal weight
reinforced concrete beams part of
a seismic force resisting system

• Applies to both SRFS type and
direction

• Checks both ends of each beam
span

• Prompts the designer to set up a
consistent SFRS type and direction
between all members of the frame

Beam at the end of the column is
not in the same seismic frame

• Used to validate if the frame of
which the column is part off is
correctly set-up as a seismic frame

• Applies to normal weight
reinforced concrete columns part
of a seismic force resisting system

• Checks the top of each column
stack

• Prompts the designer to set up a
consistent SFRS type and direction
between all members of the frame

Beam support region size is too
small

• Compliance with ACI 318-08 and
ACI 318-11 Section 21.3.4.2, “(..)
hoops shall be provided over
lengths not less than 2h measured
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Button, command, or option Description
from the face of the supported
member toward the midspan”

• Applies to normal weight
reinforced concrete beams part of
Intermediate and Special Moment
Frames

• Comes into effect if the length of
the end shear design regions is
smaller than the requirement

• Prompts the designer to review
the shear design regions - Design
options

High seismic to conventional
demand on non-SFRS beams

High seismic to conventional
demand ratio of non-SFRS columns

High seismic to conventional
demand of non-SFRS walls

• Used to recognize when a
member has a significant
contribution to the building’s
lateral force resistance but has not
been assigned to the SFRS with
the required ductility properties

• Specifically apply to each member
type

• The highest non-seismic design
ratio from bending and shear
design is obtained

• The highest seismic design ratio
from bending and shear design is
obtained

• Comes into effect when the ratio
between seismic and non-seismic
values is higher than a given
threshold (default = 1.0)

• The maximum seismic/non-
seismic ratio threshold that
triggers the warning is set through
the Seismic to conventional
minimum demand ratio field
described below

• Prompts the designer to either
include the member in the SFRS or
review the structure layout to
reduce the contribution of the
member to the lateral force
resistance
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Button, command, or option Description
Non-SFRS design requirements
applicable in SDC D-F

• Compliance with ACI 318-08 and
ACI 318-11 Sections 21.13.1,
“Requirements of section 21.13
apply to members not designated
as part of the seismic-force-
resisting system in structures
assigned to SDC D, E and F”

• Applies to normal weight
reinforced concrete beams,
column and walls not included in
the SFRS

• Comes into effect in Seismic
Design Category, SDC D or above

• Prompts the designer to apply
code prescribed requirements on
top of current design

Steel Static Warnings
Additional notional loads required
when alpha Pr/Py > 0.5, C2.3

• Compliance with 7.3 (3) of AISC
360-05 and C2.3 of AISC 360-10
requires the stiffness of certain
members to be reduced. When
the ratio of the required axial
compressive force (Pr) and the
axial yield strength (Py = Fy Ag) is >
0.5 then this stiffness must be
reduced further

• As an alternative which is the
approach adopted in Tekla
Structural Designer, an additional
notional load of 0.001 Yi can be
applied instead

• When the program identifies that
the ratio of Pr/Py exceeds 0.5 a
warning is given to alert the
designer

• If this additional notional load has
been dealt with by the designer
then this warning is no longer
relevant and this option allows
you to switch off the warning

Concrete Seismic
Seismic to conventional minimum
demand ratio

• Sets the maximum seismic/non-
seismic ratio threshold, which is
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Button, command, or option Description
used to trigger the High seismic
to conventional
demandwarnings listed above

• Default: 1.000

Design Settings - Sway & Drift Checks

Sway & drift check settings

Button, command, or option Description
Merge short stacks With this setting off the Sway/Drift,

Wind Drift & Seismic Drift checks are
performed for all column stacks and
wall panels irrespective of their stack
lengths.

With this setting on you can specify a
minimum stack length.

NOTE The ‘Merge short stacks’
option does not apply to
columns/walls where you
have elected to merge stacks
manually (via the column/wall
properties).

The following logic is applied to
merging stacks when the setting is on:

1. Start at the topmost stack of the
column/wall.

2. If the stack length is less than the
merge limit then merge with the
stack below.

3. Check again to see if then new
length exceeds the merge limit, if
not then merge again with the
next stack below.

4. Repeat step 3 as required until
the stack length exceeds the
merge limit.

5. For subsequent stacks repeat
steps 2 and 3 as required until
the length exceeds the merge
limit.
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Button, command, or option Description
6. When the bottommost stack is

reached, if this needs to be
merged, merge with the stack
above.

NOTE If a single stack column or
single panel wall length is less
than the merge short stacks
limit it is not considered for
sway/drift, wind drift, seismic
drift checks.

Check wind cases only Allows you to set that the wind drift
check performed on all columns only
considers the effect of the wind
loadcases in each wind combination.

Clear the setting to consider the
effects of all loadcases in wind
combinations, such as drift induced
by gravity loads.

For more information, see: Consider
wind cases only for the wind drift
check (page 683)

Wind Drift Limit The limit applied to all columns and
walls.

NOTE This can be overridden for
specific members as required
in the member properties.

NOTE A re-analysis is required if the
limit is changed.

For more information, see: Set the
wind drift limit (page 682)

Check for Resultant Wind Drift The wind drift check can either be
performed in two directions (Dir 1 &
2), or for the resultant wind drift
direction only. For new models the
default is to check for the resultant
direction only.

For more information, see: Choose
resultant or directional wind drift
checks (page 682)
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Design Settings - Fire check

Fire check (Eurocode Head code only)

Button, command, or option Description
Time interval for critical
temperature iteration if
'Unprotected'

default 5 sec

Time interval for critical
temperature iteration if 'Protected'

default 30 sec

Design Settings - Timber
The settings allow you to apply your own set of timber design defaults that
broadly apply to all members. These are incorporated into Tedds calculations
as default variables, which can then be edited within the calculation if
required.

Timber (US Headcode)

Button, command, or option Description
Service condition NDS: Service condition

• Dry (default)

• Wet
Temperature range • up to 100 degF (default)

• 100 degF to 125 degF

• 125 degF to 150 degF
Is section incised • yes

• no (default)

The incisions made when applying a
preservative treatment result in a loss
of area and section modulus. When
you indicate that the section is
incised, appropriate incising factors
are applied in the Tedds calculation.

Timber (Eurocode)

Button, command, or option Description
Service class • 1 (default)
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Button, command, or option Description
• 2

• 3
Individual grade stamp • yes

• no (default)

Depending on the National Annex
being worked to, the partial factor for
material properties can be reduced
when timber has been individually
marked.

Slab deflection settings
The Slab Deflection page and its subpages allow you to control the slab
deflection defaults applied:

• In the current project - when accessed from the Slab Deflection Settings
dialog (page 1225) on the Slab Deflection tab.

• In new projects - when accessed from the Settings dialog (page 1209) on
the Home tab.

Slab deflection settings when accessed from the Slab Deflection Check
Catalogue

Button, command, or option Description
New Load Event Defaults subpage
Start time offset Allows you to define a default start

time offset value for new event load
start times. The value of a new event
load start time is always the previous
event start time + the default start
time offset.

Construction load Allows you to define a default value
for new construction loads.

NOTE The default construction load
value depends on the head
code that you are using.

New Check Defaults subpage
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Button, command, or option Description
Deflection limit, L / Allows you to define a default

deflection limit to new checks added
to the

When a new check is added to the
Slab Deflection Check Catalogue it
initially defaults to the deflection limit
set here.

Aging, Creep & Shrinkage subpage
Allowance for shrinkage effects in
total deflection

Allows you to define an amplification
base factor for shrinkage.

NOTE The value must be within the
range from 0.1 to 0.9.

Aging Coefficient Allows you to select between 2 creep/
aging methods: User defined and
Automatic.

NOTE The Aging Coefficient option
is only available for the US
head code.

Modification Factors subpage Allows you to adjust the properties
used for the different element types
in the iterative cracked section
analysis.

Iteractive Cracked Section Analysis subpage
Global Convergence Criteria Allows you to modify the following

options:

• Maximum number of iterations:
The number of iterations to
perform. Default = 200.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance determined
here, the result is converged, and
the analysis is complete. Default =
0.00100.

• Relative: Default: ON.

TIP To resolve global convergence
failures:
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Button, command, or option Description

• Increase the value in
Maximum number of
iterations.

• Decrease the value in
Tolerance.

Local Convergence Criteria Allows you to modify the following
options:

• Maximum number of iterations:
The number of iterations to
perform. Default = 500.

• Tolerance: At the end of each
iteration, values are checked
against the previous iteration
results. If the difference is less
than the tolerance determined
here, the result is converged, and
the analysis is complete. Default =
0.000001.

• Smoothing Parameter: A
property only available for the
Eurocode head code. Default =
0.005.

TIP To resolve local convergence
failures:

• Increase the value in
Maximum number of
iterations.

• Decrease the value in
Tolerance.

• If you are using the
Eurocode head code,
increase the value in
Smoothing Parameter.

Slab deflection settings in the Settings dialog

Button, command, or option Description
New Load Event Defaults subpage
Start time offset Allows you to define a default start

time offset value for new event load
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Button, command, or option Description
start times. The value of a new event
load start time is always the previous
event start time + the default start
time offset.

Construction load Allows you to define a default value
for new construction loads.

NOTE The default construction load
value depends on the head
code that you are using.

New Check Defaults subpage
Deflection limit, L / Allows you to define a default

deflection limit to new checks added
to the

When a new check is added to the
Slab Deflection Check Catalogue it
initially defaults to the deflection limit
set here.

Aging, Creep & Shrinkage subpage
Allowance for shrinkage effects in
total deflection

Allows you to define an amplification
base factor for shrinkage.

NOTE The value must be within the
range from 0.1 to 0.9.

Aging Coefficient Allows you to select between 2 creep/
aging methods: User defined and
Automatic.

NOTE The Aging Coefficient option
is only available for the US
head code.

Load Event Sequence subpage Allows you to modify the global event
sequence according to your needs.

TIP The global event sequence
provides the basis for the model
event sequence that you can
modify, whereas the model
event sequence provides the
basis for a submodel event
sequence that you can modify.
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Drawing settings
The Drawings page and its subpages allow you to adjust different drawing
settings:

• In the current project - when accessed from the Drawing Settings dialog
(page 1180) on the Draw tab.

• In new projects - when accessed from the Settings dialog (page 1209) on
the Home tab.

Export preferences

NOTE The Export Preferences subpage is only available when drawing
settings are accessed from the Settings dialog (page 1209)

Setting Description
Drawing Variant list Allows you to select the drawing

category whose export preferences
you want to modify.

Minimum Text Block Spacing Allows you to define a minimum value
between independent drawing blocks.

NOTE If the value is too great, text
labels can end up far from
the objects to which they
refer.

Available Scales list Displays the existing drawing scales.

NOTE You can add user-defined
scales in the list by typing the
scale in the Scale field and
clicking the Add button, or
delete them by selecting the
scale and clicking the
Remove button.

Scale Allows you to create a user-defined
drawing scale by typing it in the field.

Name Allows you to specify a name for a
user-defined drawing scale.
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Layer configurations

Setting Description
Drawing Variant list Allows you to select the drawing

category whose layer configurations
you want to modify.

NOTE Use the subpages of the 
Layer Configurations
subpage to modify the
required drawing type.

Available Configurations list Displays the available layer
configurations and allows you to
select or modify them. You can use
the following buttons to modify the
available layer configurations:

• Add: creates an empty layer
configuration that you can modify
in the Active Configuration
section.

• Add copy...: allows you to copy a
drawing item to create a new layer
configuration.

• Remove: deletes the selected
layer configuration.

Active Configuration Displays the name and layers in the
selected layer configuration.

Name Displays and allows you to modify the
name of the selected layer
configuration.

Layers list Displays and allows you to select or
clear the layers that are included in
the selected layer configuration.

TIP If you access the drawing
settings from the Draw tab and
modify them, consider saving
the changes to a settings set, so
that you can use them in later
projects as well.

Tekla Structural Designer reference 1127 Settings



Layer styles

Setting Description
Drawing Variant list Allows you to select the drawing

category whose layer styles you want
to modify.

NOTE Use the subpages of the 
Layer Styles subpage to
modify the required drawing
type.

Available Styles list Displays the available layer styles and
allows you to select or modify them.
You can use the following buttons to
modify the available layer styles:

• Add: creates an empty layer style
that you can modify in the Active
Style section.

• Add copy...: allows you to copy a
drawing item to create a new layer
style.

• Remove: deletes the selected
layer style.

Active Style Displays the name and layers in the
selected layer style.

Name Displays and allows you to modify the
name of the selected layer style.

Apply to All... This button opens a dialog for rapidly
applying a single color, report color,
line type, font, or font size to all layers
in the active layer style.

Layers list Displays and allows you modify the
appearance of layers that are
included in the active layer style.

Description The layer description is fixed and
can't be changed.

Name The layer name as it will appear in the
drawing can be edited if required.

Is Merged,

Merged with

By checking the box you are able to
merge two or more layers together.
All objects in the merged layer are
drawn in the Merged with layer,
adopting its line type, font and font
size.
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Setting Description
Color The colors specified here are used for

the different layers in the dxf drawing
output

Report Color Member Reports have the facility to
include a member drawing along with
the calculations and diagrams etc.
When a member report is printed the
drawings adopt the report colors that
have been specified here.

Line Type Different line types can be specified
for the different drawing layers as
required.

Font Different fonts can be specified for
the different drawing layers as
required.

Font Size Different font sizes can be specified
for the different drawing layers as
required.

Planar drawing options

. . . . General (all drawing variants)

Setting Description
Hatching Allows you to select how columns and

walls are hatched in planar drawings.
You can select or clear the following
options:

• Show columns and walls above
the level as hatched: The
columns and walls that continue
above the current level are
hatched.

• Show transfer columns and
walls as cross hatched: Transfer
columns and walls are cross
hatched.

Force and Moment Values
NOTE Applies to the following

drawing variants:

• Foundation Reactions

• Beam End Forces
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Setting Description

• Column Splice Loads

Allows you to select which force and
moment values are displayed in
planar drawings. The options are:

• Strength factors: Displays the
strength factors in planar
drawings.

• Service factors: Displays the
service factors in planar drawings.

Additionally factor by allows you to
specify a value by which the strength
or service factors are factored in the
selected drawing category.

Moment Values
NOTE Applies to the following

drawing variants:

• Foundation Reactions

• Beam End Forces

• Column Splice Loads

Allows you to select which moment
values are displayed in planar
drawings. The options are:

• None: Does not display any
moment values.

• Only greater than: Moment
values are only displayed if their
value is greater than the value
specified here.

• All: Displays all moment values,
even if zero.

Shear Force Values
NOTE Foundation Reactions

drawing variant only.

Allows you to select which shear
values are displayed in Foundation
Reactions drawings. The options are:

• None: Does not display any shear
values.
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Setting Description
• Only greater than: Shear values

are only displayed if their value is
greater than the value specified
here.

• All: Displays all shear values, even
if zero.

Axial Force Values
NOTE Beam End Forces drawing

variant only.

Allows you to select which axial force
values are displayed in planar
drawings. The options are:

• None: Does not display any axial
force values.

• Only greater than: Axial force
values are only displayed if their
value is greater than the value
specified here.

• All: Displays all axial force values,
even if zero.

Display End Forces for
NOTE Beam End Forces drawing

variant only.

Allows you to select the members for
which end forces are displayed.

Enveloped Reaction Values
NOTE Beam End Forces drawing

variant only.

Include coincident forces: when this
option is selected, further options are
presented allowing you to choose the
max/min values and coincident forces
to display when the beam end forces
drawing is created for a loading
envelope.

. . . . Beams (all drawing variants)

Setting Description
Grouped Beam Labelling Allow you to modify the labeling of

beams when the beams have been
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Setting Description
designed using groups. You can select
or clear the following options:

• Use detail group name: Select
the option to use the detail group
name in the beam label, or clear
the option to use the design group
name in the beam label.

• Include the beam name: Select
the option to include the beam
name in the beam label for
grouped beams.

Concrete Beam Labelling Position Allows you to set the position of the
beam label in relation to the beam in
planar drawings. The options are:

• Above

• Inside

• Below
Beam Mark Position Allows you to adjust the appearance

and position of the beam mark in
relation to the brace in planar
drawings. To display beam marks,
select Show beam mark. The
position options are:

• Above

• Below
Beam Attributes Position Allows you to adjust the appearance

and position of beam attributes in
relation to the beam in planar
drawings. To display beam attributes,
select Show beam attributes. The
position options are:

• Above

• Below
Beam Attributes Allows you to select which beam

attributes are displayed in planar
drawings and how they are displayed.
You can select or clear the following
options:

• Show beam size in parentheses:
Places brackets around the beam
size in the beam label.
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Setting Description
• Grade: Displays the beam grade in

planar drawings.

• Camber: Displays the camber in
steel beams. To modify the
camber prefix, type the desired
value in the Camber prefix field.

• Composite properties: Displays
composite beam properties. To
change the separators inside
which the number of studs is
displayed, select the desired the
Stud separator list.

• Transverse reinforcement:
Displays transverse reinforcement
in planar drawings.

. . . . Braces (all drawing variants)

Setting Description
Brace Mark Position Allows you to adjust the appearance

and position of the brace mark in
relation to the brace in planar
drawings. To display brace marks,
select Show brace mark. The
position options are:

• Above

• Below
Brace Attributes Position Allows you to adjust the appearance

and position of brace attributes in
relation to the brace in planar
drawings. To display brace attributes,
select Show brace attributes. The
position options are:

• Above

• Below
Brace Attributes Allows you to select whether brace

grades are displayed in planar
drawings.
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. . . . Columns (all drawing variants)

Setting Description
Grouped Column Labelling Allow you to modify the labeling of

columns when the columns have
been designed using groups. You can
select or clear the following options:

• Use detail group name: Select
the option to use the detail group
name in the column label, or clear
the option to use the design group
name in the label.

• Include the column name: Select
the option to include the column
name in the column label for
grouped columns.

Column Mark Position Allows you to adjust the appearance
and position of the column mark in
relation to the brace in planar
drawings. To display column marks,
select Show column mark. The
position options are:

• Above

• Below
Column Attributes Position Allows you to adjust the appearance

and position of the column attribute
in relation to the brace in planar
drawings. To display column
attributes, select Show column
attributes. The position options are:

• For position in elevation:

• Above

• Below

• For position in cross-section:

• To the right of the mark

• Below the mark
Column Attributes Allows you to select which column

attributes are displayed in planar
drawings and how they are displayed.
You can select or clear the following
options:

• Show column size in
parentheses: Places brackets
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Setting Description
around the column size in the
column label.

• Grade: Displays the column grade
in planar drawings.

2x scale for steel columns Allows you to double the scale of steel
columns to simplify viewing the
columns and their orientation.

. . . . Walls (all drawing variants)

Setting Description
Wall Labelling position Allows you to set the position of the

wall label in relation to the wall in
planar drawings. The options are:

• Above

• Inside

• Below
Show wall size in parentheses Allows you to select whether brackets

are placed around the wall size in the
wall label.

Wall Reactions Allows you to select whether or not to
include distributed vertical reaction
values of walls in the foundation
reactions planar drawing. These are
available in two different formats:

• Show distributed wall reactions
table: a table with the distributed
wall reaction end values is
included in the drawing,

• Show vertical reaction values:
values are added for each wall in
the planar drawing,

• Distributed (Maximum):
Maximum absolute values of
the vertical distributed reaction
retaining sign,

• Distributed (Average):
Average value of the vertical
distributed reaction along the
length of the bottom analytical
chord of the wall,
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• Distributed (Extremes):

Extreme values at each end of
the wall bottom analytical
chord,

• Total: Single integrated total
vertical reaction of the wall.

. . . . Slabs/Mats (all drawing variants)

Setting Description
Panel Labelling Allows you to select which panel

properties are included in panel
labels and how panel labels are
displayed in planar drawings.

You can select or clear the following
options:

• Include panel reference: Allows
you to include the panel reference
in the panel label.

• Include panel thickness: Allows
you to include the panel thickness
in the panel label.

• Include surface offset (if non-
zero): Allows you to include any
surface offset that has been
applied to the panel in the panel
label.

• Include border around label:
Allows you to add a border around
the label.

• Align label to panel
reinforcement: Allows you to
select how the panel label is
aligned to the panel span
direction. Select the option to
achieve the result displayed on the
left, and clear the option to
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achieve the result displayed on the
right.

Include panel span direction
symbol

Allows you to select whether a
direction symbol is displayed in the
slab or mat geometry.

. . . . Loads (Loading Plan drawing variant only)

Setting Description
Display size Allows you to adjust the width and

height of line, udl, and vdl loads and
the size of point loads in planar
drawings. The different options that
you can adjust are:

• Width of line/UDL/VDL loads on
plan: Line, UDL, and VDL loads are
drawn as hatched rectangles of
fixed width when drawn in plan.
The option allows you to adjust
the width of the hatched
rectangle.

• Height of line/UDL/VDL loads on
plan: Line, UDL, and VDL loads are
drawn as hatched rectangles of
fixed width when drawn in plan.
The option allows you to adjust
the height of the hatched
rectangle.

• Point load marker size: Allows
you to adjust the size of point
loads in planar drawings.
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Setting Description
Show dimensions for panel loads Allows you to include the dimensions

of panel loads in planar drawings.
Include dimensions to reference
points

Allows you to include the dimensions
from panel loads to their reference
points in planar drawings.

Show dimensions for member
loads

Allows you to include the dimensions
of member loads in planar drawings.

Member detail options

. . . . Beam Detail

Setting Description
Content subpage
Grouped Beams tab
Show number of beams in group If the beams in the model have been

arranged into detailing groups,
selecting the option causes the
detailing number to be used as the
member label instead of the beam
reference.

If detailing groups have not been
used, the beam reference is always
used as the member label.

Levels tab
Show span levels Allows you to display the span levels

on the elevation.
Cross-sections tab
Spans list Allows you to select which cross-

sections to display. You can decide to
display no cross-sections, only the
cross-sections for first spans of multi-
span beams, or all spans.

Positions list If cross-sections are displayed, the list
allows you to select where they are
positioned. You can decide to only
position cross-sections for spans, for
supports, or for supports and spans.

Bar annotation list Allows you to select the cross-section
annotation. The options are:

• None

• Standard
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• IStructE

Display bar marks If the cross-section annotation is set
to Standard or IStructE, you can
select the option to display bar marks
in cross-section labels.

Show slab lines in section Select the option to display slab lines
in sections, as shown in the first
image:

Clear the option to not display slab
lines in sections, as shown in the
second image:

Bar Labels tab
Show bar marks in elevation Select the option to include bar marks

in the bar labels on the elevation. Bar
marks will also be displayed on the
cross-sections, provided that the
Display bar marks option is also
checked.

Clear the option to not display bar
marks on cross-sections irrespective
of the Display bar marks option.

Show steel bar layer information Allows you to display steel bar layer
information (B1, B2, T1, T2, and so
on).

Dimensions tab
Laps list Allows you to select whether existing

laps are dimensioned, not
dimensioned, or the dimension is
replaced by a standard label (TL).

Anchorage lengths list Allows you to select whether any
required anchorage lengths are
dimensioned, not dimensioned, or the
dimension is replaced by a standard
label (AL).
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Setting Description
Axes list Allows you to select whether axes are

not displayed, are displayed above
the beam with dimensions, or are
displayed below the beam with
dimensions.

Additional bottom span bar
positioning dimensions

Allows you to dimension any existing
optional second span bars from the
face of the support.

Support region length If different stirrup regions have been
used along a beam span, the option
allows you to dimension the length of
the support regions on the elevation.

First and last stirrups Allows you to add dimensions from
the face of the supports to the first
and last stirrups.

Support columns and clear spans Allows you to add dimensions
showing the width of each supporting
column and the clear beam span
between supports.

Beam section Allows you to dimension the beam
depth and width on the cross-section.

Slabs in beam sections Allows you to dimension the slab
depth on the cross-section.

Quantities tab
Show reinforcement quantities
table

Allows you to include reinforcement
quantity tables in beam detail
drawings.

Style subpage
Beam Labels tab
Print beam labels below the detail Allows you to display the beam label

centrally below each span. Clear the
option to position the label
immediately above each span.

Underline beam labels Allows you to to underline the beam
label on the elevation.

Label every span of multi-span
beams

Allows you to display a label for each
span in multi-span beams.

Cross-sections tab
Section label style list Allows you to select the label naming

style that is applied to cross-sections.
Restart section labels in each beam
line

Allows you to restart the section
labels for each line when multiple

Tekla Structural Designer reference 1140 Settings



Setting Description
beam lines are displayed on the same
drawing sheet.

Add beam name label as prefix to
section labels

Allows you to prefix each section label
with the beam name.

Place cross-sections underneath
the elevation

Allows you to to position cross-
sections under the elevation.

Longitudinal Bars tab
Draw bobs as shifted Allows you to apply a slight offset to

bobbed bars in drawings, so that the
bobbed bars do not overlap each
other in drawings an therefore, the
drawings are easier to read.

Display only a single side bar in
detail

Allows you to draw only a single side
bar is drawn full length when multiple
side bars are required in each face.
Clear the option to draw all side bars
full length.

Stirrups tab
Draw stirrup labels in line Allows you to display stirrup labels in

line on the elevation, as shown in the
first image:

Clear the option to display stirrup
labels above the line, as shown in the
second image:

Print stirrup labels inside beam Allows you to display the stirrup
labels inside the beam. Clear the
option to display the stirrup labels
below the beam.

Stirrup label distance from bottom
edge [n] % of the beam depth

Allows you to control the vertical
position of stirrup labels that are
positioned inside the beam.

Dimensions tab
Lap and anchorage rounding
increment

Allows you to control the rounding
increment of lap and anchorage
dimensions.
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. . . . Column Detail

Setting Description
Content subpage
Grouped Columns tab
Show number of columns in group Allows you to display the number of

columns in a column group.
Levels tab
Show levels Allows you to label the construction

levels.
Cross-sections tab
Show cross-sections Allows you to display cross-sections

through each stack.
Bar annotation list Allows you to select the cross-section

annotation. The options are:

• None

• Standard

• IStructE
Display bar marks If the cross-section annotation is set

to Standard or IStructE, you can
select the option to display bar marks
in cross-section labels.

Bar Labels tab
Show bar marks in elevation Select the option to include bar marks

in the bar labels on the elevation. Bar
marks will also be displayed on the
cross-sections, provided that the
Display bar marks option is also
checked.

Clear the option to not display bar
marks on cross-sections irrespective
of the Display bar marks option.

Dimensions tab
Laps list Allows you to select whether existing

laps are dimensioned, not
dimensioned, or the dimension is
replaced by a standard label (TL or
CL).

Support region length Allows you to dimension the support
regions on the elevation.

Levels Allows you to add dimensions
between levels.
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Setting Description
Grid line offsets Allows you to add dimensions from

the grid to the column face on the
elevation.

Connecting elements and clear
heights

Allows you to add dimensions
connecting elements and clear
heights.

Column section Allows you to add column dimensions
to the column section.

Quantities tab
Show reinforcement quantities
table

Allows you to include reinforcement
quantity tables in column detail
drawings.

Style subpage
Column Labels tab
Underline column labels Allows you to to underline the column

label on the elevation.
Cross-sections tab
Section label style list Allows you to select the label naming

style that is applied to cross-sections.
Restart section labels in each
column line

Allows you to restart the section
labels for each line when multiple
column lines are displayed on the
same drawing sheet.

Add column name label as prefix to
section labels

Allows you to prefix each section label
with the column name.

Ties tab
Draw tie labels in line Allows you to display tie labels in line

on the elevation, as shown in the
image on the left. Clear the option to
display tie labels above the line, as
shown in the image on the right.

Dimensions tab
Lap dimension rounding increment Allows you to control the rounding

increment of lap dimensions.
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. . . . Wall Detail

Setting Description
Content subpage
Levels tab
Show levels Allows you to label the construction

levels.
Cross-sections tab
Show cross-sections Allows you to display cross-sections

through each stack.
Bar annotation list Allows you to select the cross-section

annotation. The options are:

• None

• Standard

• IStructE
Display bar marks If the cross-section annotation is set

to Standard or IStructE, you can
select the option to display bar marks
in cross-section labels.

Bar Labels tab
Show bar marks in elevation Select the option to include bar marks

in the bar labels on the elevation. Bar
marks will also be displayed on the
cross-sections, provided that the
Display bar marks option is also
checked.

Clear the option to not display bar
marks on cross-sections irrespective
of the Display bar marks option.

Dimensions tab
Laps list Allows you to select whether existing

laps are dimensioned, not
dimensioned, or the dimension is
replaced by a standard label (TL or
CL).

Support region length Allows you to dimension the support
regions on the elevation.

Levels Allows you to add dimensions
between levels.

Grid line offsets Allows you to add dimensions from
the grid to the column face on the
elevation.
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Setting Description
Wall section Allows you to add wall dimensions to

the wall section.
Quantities tab
Show reinforcement quantities
table

Allows you to include reinforcement
quantity tables in wall detail
drawings.

Style subpage
Wall Labels tab
Underline wall labels Allows you to underline the wall label

on the elevation.
Cross-sections tab
Section label style list Allows you to select the label naming

style that is applied to cross-sections.
Add wall name label as prefix to
section labels

Allows you to prefix each section label
with the wall name.

Don't label typical panel bars Allows you to not label typical bars in
cross-sections. Clear the option to
label every bar in cross-sections.

Horizontal Bars and Ties tab
Draw labels in line Allows you to display tie labels in line

on the elevation, as shown in the
image on the left. Clear the option to
display tie labels above the line, as
shown in the image on the right.

Label bars inside panel Allows you to label bars inside the
wall panel.

Dimensions tab
Lap dimension rounding increment Allows you to control the rounding

increment of lap dimensions.
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Member schedule options

. . . . General

Setting Description

NOTE The settings that you see on the General tab depend on which
drawing category subpage you have selected in the left side pane.

Item list Allows you to select an item to view
the text label that will applied to it in
the concrete beam schedule drawing.

Text Allows you to modify the text
displayed in the beam schedule for
the item selected in the Item list.

Size Column Format Allows you to select whether to
display the width of the beam or its
height first in the size column.

Use single column for size Allows you to display both the width
and height in a single column.

Use single column for bottom bars Allows you to display the bottom bars
in a single column

Omit top middle bars column Allows you to omit the top middle
bars from the schedule drawing.

Use single column for stirrups Allows you to display the stirrups in a
single column.

Show design group name Allows you to display only the design
group name in the mark column.

Show grouped column number Allows you to display column groups.
Include starter bars Allows you to include starter bars in

member schedule drawings.
Show reinforcement quantities
table

Allows you to include reinforcement
quantity tables in member schedule
drawings.

Bar annotation list Allows you to select the cross-section
annotation. The options are:

• Standard

• IStructE
Display bar marks Allows you to display bar marks in

cross-section labels.
Show outline of stack below Allows you to display the outline of

the column stack below.
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Dimension column section Allows you to add column dimensions

to the column section.
Dimension levels Allows you to add dimensions

between levels.
Show outline of panel below Allows you to display the outline of

the wall panel below.
Dimension wall section Allows you to add wall dimensions to

the wall section.

. . . . Bar Key

Setting Description
Reference column Lists every reference that can

potentially appear in the bar bending
details table in concrete beam
schedule drawings.

TIP Hover the mouse pointer over a
reference to see the bar and its
associated note.

Allows you to use a custom name for
the selected reference.
Allows you to specify the custom
name that replaces the original
reference in the bar bending details
table if the

Slab and mat layout options

. . . . General

Setting Description
Layout subpage
General tab
Show columns and walls above the
level as hatched

Allows you to hatch columns and
walls that continue above the current
level.

Show transfer columns and walls
as cross hatched

Allows you to cross-hatch transfer
columns and walls.
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. . . . Beams

Setting Description
Use detail group name Allows you to use the detail group

name in the beam label.

Clear the option to use the design
group name in the beam label
instead.

Include the beam name Allows you to include the beam name
in the label for grouped beams.

Beam Labelling position Allows you to set the position of the
beam label in relation to the beam in
slab and mat layout drawings. The
options are:

• Above

• Inside

• Below
Show beam mark Allows you to display beam marks in

slab and mat layout drawings. The
position options for beam marks are:

• Above

• Below
Show beam attributes Allows you to display beam attributes

in slab and mat layout drawings. The
position options for beam attributes
are:

• Above

• Below
Show beam size in parentheses Allows you to place brackets around

the beam size in the beam label.
Grade Allows you to display the beam grade

in slab and mat layout drawings.

. . . . Braces

Setting Description
Show brace mark Allows you to display brace marks in

slab and mat layout drawings. The
position options for brace marks are:

• Above

• Below
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Setting Description
Show brace attributes Allows you to display brace attributes

in slab and mat layout drawings. The
position options for brace attributes
are:

• Above

• Below
Brace Attributes Allows you to select whether brace

grades are displayed in slab and mat
layout drawings.

. . . . Columns

Setting Description
Use detail group name Allows you to use the detail group

name in the column label.

Clear the option to use the design
group name in the column label
instead.

Include the column name Allows you to include the column
name in the label for grouped
columns.

Show column mark Allows you to display column marks in
slab and mat layout drawings. The
position options for column marks
are:

• Above

• Below
Show column attributes Allows you to display column

attributes in slab and mat layout
drawings. The position options for
column attributes are:

• For position in elevation:

• Above

• Below

• For position in cross-section:

• To the right of the mark

• Below the mark
Show column size in parentheses Allows you to place brackets around

the column size in the column label.
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Setting Description
Grade Allows you to display the column

grade in foundation layout drawings.
2x scale for steel columns Allows you to double the scale of steel

columns to simplify viewing the
columns and their orientation.

. . . . Walls

Setting Description
Wall Labelling position Allows you to set the position of the

wall label in relation to the wall in slab
and mat layout drawings. The options
are:

• Above

• Inside

• Below
Wall Attributes Allows you to select whether brackets

are placed around the wall size in the
wall label.

. . . . Slabs/Mats

Setting Description
Include panel reference Allows you to include the panel

reference in the panel label.
Include panel thickness Allows you to include the panel

thickness in the panel label.
Include surface offset (if non-zero) Allows you to include any surface

offset that has been applied to the
panel in the panel label.

Include border around label Allows you to add a border around
the label.

Align label to panel reinforcement Allows you to select how the panel
label is aligned to the panel span
direction. Select the option to achieve
the result displayed on the left, and
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clear the option to achieve the result
displayed on the right.

Include panel span direction
symbol

Allows you to select whether a
direction symbol is displayed in the
slab or mat geometry.

Extend loose bar panel
reinforcement lines across full
panel

Allows you to draw bar panel
reinforcement across the entire
panel.

Clear the option to display the loose
bar reinforcement as shown in the
following image:

Always show main bar layer for
rectangular mesh

If the mesh is not a square mesh, the
main bars are normally put on the
outer layer of the drawing, and no
text is required in the drawing.
However, if the bars are not on the
outer layer of the drawing, they are
indicated by adding B2 (if bottom
mesh) or T2 (if top mesh) aligned to
the main bar direction.

NOTE If a square mesh (has the
same size and spacing of bars
in both directions) is applied,
a square mesh symbol is
used, and bars are shown
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equally spaced in both
directions.

If the mesh is not a square
mesh (does not have the
same size and spacing of bars
in both directions), a
rectangular mesh symbol is
used. Bars are shown in both
directions, but with closer
spacing for the more closely
spaced bars in the mesh.

Anchorage rounding increment Allows you to specify the rounding
value applied to the anchorage
length.

. . . . Patches

Setting Description
Show patches with no
reinforcement

Allows you to display patches that
have no reinforcement specified in
drawings.

Draw full anchorage lengths Allows you to display bars with full
anchorage lengths.

Draw curtailed (indicative)
anchorage lengths = max()

Allows you to draw curtailed
(indicative) anchorage lengths instead
of full anchorage lengths and specify
their size.

. . . . Punching Shear

Setting Description
Show punching reinforcement
details

Allows you to include a detail to the
side of the layout showing the
punching shear reinforcement
provided.

Don't show area of steel
requirement where rails have been
designed

Allows you to only display the area of
steel requirement for punching shear
check items where rails are not
provided (such as walls or column
drops).

Clear the option to display the area of
steel requirement for all punching
check items.
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Setting Description
Hide punching reinforcement on
the main layout

Allows you to hide the punching
reinforcement on the main layout.
The reinforcement is still displayed in
the punching check detail drawing,
provided that Show punching
reinforcement details is selected.

Slab and mat punching check detail options

Button, command, or option Description
Content subpage
Dimensions tab
Show column to first stud spacing Allows you to add a dimension from

the column face to the first stud.
Show stud spacing Allows you to add dimensions

displaying the stud spacings along the
rail.

Show rail spacing Allows you to add dimensions
displaying the rail spacings.

Include schematic showing stud
dimensions

Allows you to add a schematic
displaying the stud width and height
above the rail.

Quantities tab
Show reinforcement quantities
table

Allows you to include reinforcement
quantity tables in punching check
detail drawings.

Style subpage
Show column as hatched Allows you to hatch the column.
Underline punching check label Allows you to underline the punching

check label in punching check detail
drawings.

Foundation layout options

. . . . General

Setting Description
Show columns and walls
above the level as hatched

Allows you to hatch the columns and walls
that continue above the current level.

Show transfer columns and
walls as cross hatched

Allows you to cross-hatch transfer columns
and walls.
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Setting Description
Show pile location and
loading table

Click Columns to choose which columns of
tabular data are to be included in the table on
the drawing.

NOTE Only the single most critical load
condition is reported in the table for
each pile.

- could be tension or compression

- could be a gravity, wind, or seismic
combination

. . . . Beams

Setting Description
Use detail group name Allows you to use the detail group name in

the beam label.

Clear the option to use the design group
name in the beam label instead.

Include the beam name Allows you to include the beam name in the
label for grouped beams.

Concrete Beam Labelling
Position

Allow you to modify the labeling of beams
when the beams have been designed using
groups. You can select or clear the following
options:

• Use detail group name: Select the option
to use the detail group name in the label,
or clear the option to use the design group
name in the label.

• Include the beam name: Select the
option to include the beam name in the
label for grouped beams.

Show beam mark Allows you to display beam marks in
foundation layout drawings. The position
options for beam marks are:

• Above

• Below
Show beam attributes Allows you to display beam attributes in

foundation layout drawings. The position
options for beam attributes are:

• Above

• Below
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Setting Description
Beam Attributes Allows you to select which beam attributes

are displayed in foundation layout drawings
and how they are displayed. You can select or
clear the following options:

• Show beam size in parentheses: Places
brackets around the beam size in the
beam label.

• Grade: Displays the beam grade in planar
drawings.

• Camber: Displays the camber in steel
beams. To modify the camber prefix, type
the desired value in the Camber prefix
field.

• Composite properties: Displays
composite beam properties. To change the
separators inside which the number of
studs is displayed, select the desired the
Stud separator list.

• Transverse reinforcement: Displays
transverse reinforcement in foundation
layout drawings.

. . . . Braces

Setting Description
Show brace mark Allows you to display brace marks in

foundation layout drawings. The position
options for brace marks are:

• Above

• Below
Show brace attributes Allows you to display brace attributes in

foundation layout drawings. The position
options for brace attributes are:

• Above

• Below
Brace Attributes Allows you to select whether brace grades are

displayed in foundation layout drawings.
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. . . . Columns

Setting Description
Use detail group name Allows you to use the detail group name in

the column label.

Clear the option to use the design group
name in the column label instead.

Include the column name Allows you to include the column name in the
label for grouped columns.

Show column mark Allows you to display column marks in
foundation layout drawings. The position
options for column marks are:

• Above

• Below
Show column attributes Allows you to display column attributes in

foundation layout drawings. The position
options for column attributes are:

• For position in elevation:

• Above

• Below

• For position in cross-section:

• To the right of the mark

• Below the mark
Show column size in
parentheses

Allows you to place brackets around the
column size in the column label.

Grade Allows you to display the column grade in
foundation layout drawings.

2x scale for steel columns Allows you to double the scale of steel
columns to simplify viewing the columns and
their orientation.

. . . . Walls

Setting Description
Wall Labelling position Allows you to set the position of the wall label

in relation to the wall in foundation layout
drawings. The options are:

• Above

• Inside

• Below
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Setting Description
Wall Attributes Allows you to select whether brackets are

placed around the wall size in the wall label.

. . . . Slabs/Mats

Setting Description
Include panel reference Allows you to include the panel reference in

the panel label.
Include panel thickness Allows you to include the panel thickness in

the panel label.
Include surface offset (if
non-zero)

Allows you to include any surface offset that
has been applied to the panel in the panel
label.

Include border around label Allows you to add a border around the panel
label.

Align label to panel
reinforcement

Allows you to select how the panel label is
aligned to the panel span direction. Select the
option to achieve the result displayed on the
left, and clear the option to achieve the result
displayed on the right.

Include panel span
direction symbol

Allows you to select whether a direction
symbol is displayed in the slab or mat
geometry.

Show pile location table Allows you to include a table showing the pile
locations in foundation layout drawings.

Show pile reference Allows you to display the pile references in
foundation layout drawings.
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. . . . Isolated Foundations

Setting Description
Show pile type name Allows you to include the pile type names in

the footing attributes displayed for each pile
cap in foundation layout drawings.

Show foundation details Allows you to include pad base or strip base
and pile cap details, displaying the designed
reinforcement, on the side of the foundation
layout drawing.

Show reinforcement
quantities table

Allows you to include the reinforcement
quantity table for the pad bases and strip
bases and pile caps displayed in foundation
layout drawings.

Show pad/strip base
schedule

Allows you to include the reinforcement
schedule for the pad bases or strip bases in
foundation layout drawings.

Show pile cap schedule Allows you to include the reinforcement
schedule for the pile caps in foundation layout
drawings.

Show allowable pile
capacity

Allows you to include the allowable pile
capacity table for the piles under pile caps in
foundation layout drawings.

Show overall dimensions Allows you to include the overall dimensions
of the pad bases or strip bases and pile caps
in foundation layout drawings.

Show pile spacings Allows you to include the pile cap pile spacing
dimensions in foundation layout drawings.

Include the foundation
name

Allows you to include the pad base or strip
base or pile cap name in the footing mark for
grouped footings in foundation layout
drawings.

Labelling Position Allows you to control where the footing mark
and attributes are displayed for isolated
foundations. The position options are:

• Above

• Below

Isolated Foundation detail options

. . . . Content

Setting Description
Content subpage
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Setting Description
Grouped Foundations tab
Show number of
foundations in group

Allows you to display the number of bases or
pile caps in the group.

Cross-sections tab
Positions list Allows you to select how cross-section

positions are displayed. You can select to not
display cross-section positions at all, display a
length-wise section or display cross-sections
in both directions.

Pile Labels tab
Show pile type name Allows you to include the pile type name in

the pile label.
Dimensions tab
Show overall dimensions Allows you to include the overall dimensions

of the base/pile cap.
Show supported member
dimensions

Allows you to include dimensions of the
column or wall being supported.

Show pile spacings Allows you to include dimensions from center
to center of each pile for pile caps.

Quantities tab
Show reinforcement
quantities table

Allows you to include reinforcement quantity
tables in isolated foundation detail drawings.

. . . . Style

Setting Description
General tab
Show supported member
as hatched

Allows you to hatch columns and walls that
are supported on the base pile cap in isolated
foundation detail drawings.

Underline foundation label Allows you to underline the foundation label
on the detail in isolated foundation detail
drawings.

Cross-sections tab
Section label style list Allows you to select the label style to be

applied to cross-sections in isolated
foundation detail drawings.

Restart labels in each
foundation

Allows you to restart labeling from the
beginning of each section when multiple
foundations are included in the same
drawing.
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See also

Adjust and apply drawing settings (page 851)

Settings set settings
The Settings Sets page in the Settings dialog box controls the settings sets
which are used to create the model/analysis/design settings in new projects,
and which can also be used to replace the model/analysis/design settings in
existing projects.

Button, command, or option Description
Available settings sets list Allows you to select a settings set

whose content you can view and
modify on the other pages of the 
Settings dialog box.

Add Copy Creates a new settings set based on
the one selected in the Available
settings sets list. You can then
customize the new settings set on the
other pages of the Settings dialog
box.

>> Active Makes the settings set that is selected
in the Settings dialog box the active
settings set.

Import... Allows you to import a settings set
from another region. The selected
settings set appears in the Settings
dialog box.

Rename Allows you to rename the settings set
that is selected in the Available
settings sets list.

Remove Deletes the settings set that is
selected in the Available settings
sets list.

Open Folder Opens the folder in which the existing
settings sets are located.

See also

Manage settings sets (page 886)
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General settings
The General page and its subpages in the Settings dialog box allow you to
configure the language, captions, autosave settings, confirmation messages,
and updates in Tekla Structural Designer.

Button, command, or option Description
Language subpage
Select the preferred language list Allows you to select whether the

terms in the interface and the output
are in US English or UK English.

NOTE The language cannot be
configured differently in
different settings sets.

Appearance page
Show captions on top Allows you to select whether you

want to show captions on the top or
the bottom of the Project
Workspace.

Autorecover subpage
Autosave
Enabled Allows you to select whether Tekla

Structural Designer creates an
automatic saves of models. Autosave
may be useful, for example, when
restarting Tekla Structural Designer
after a crash.

For more information, see: Work with
autosave and backups (page 51)

Interval Allows you to determine the interval
at which Tekla Structural Designer
creates automatic saves of models.

Backups
Enabled Allows you to select whether Tekla

Structural Designer creates automatic
backups of models. Backup may be
useful, for example, if you want to
revert to a previous version of the
model.

For more information, see: Work with
autosave and backups (page 51)
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Button, command, or option Description
Interval Allows you to determine the interval

at which Tekla Structural Designer
creates automatic backups of models.

Location Defines the backup Location
directory - the default is your
Windows user profile Documents
directory. Click the link to browse to
your preferred location (both local
and network locations are allowed).

Maximum number of backups per
project

default = 10 (when the limit is reached
the older backups start to be
automatically deleted).

Confirmation subpage
Confirm on list Allows you to select the operations

that you want to confirm each time.
Update Service subpage
Enable Update Service Allows you to select whether you

want Tekla Structural Designer to
notify you when new product updates
or service packs can be installed, so
that you can keep Tekla Structural
Designer up to date.

Check for updates when starting
Tekla Structural Designer

Allows you to select whether Tekla
Structural Designer check if new
updates are available each time it
starts.

Check for non critical updates
every [n] days

Allows you to determine the interval
at which Tekla Structural Designer
checks if new non-critical updates are
available.

Yes, I am willing to participate
anonymously

Allows you to select whether the
Tekla Customer Experience
Improvement Program can collect
anonymous information on your
hardware configuration and your use
of Tekla products to improve the
customer experience of Tekla
products.
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Results Viewer settings
The Results Viewer page and its subpages in the Settings dialog box allow
you to configure the appearance of the on-screen results viewer for the
settings set selected in the Select the settings set to edit list.

NOTE Unlike other settings, changes made to the active settings set on the
Results Viewer page are instantly applied to the current session
when you click OK to close the Settings dialog box.

Button, command, or option Description
General subpage
Viewer font --> Change... Allows you to modify the font that is

displayed on the left side pane of the
results viewer.

Styles subpage
Report Styles list Allows you to select the style whose

font, color, or other properties you
want to modify. The options are:

• Calc Normal: not used in the
current version.

• Table: controls all the text
displayed on the right side pane of
the results viewer except for the
first row in any table.

• Table Heading: controls the
heading row, or first row, in any
table.

Font --> Change... Allows you to change the font used
for the currently selected style.

Colors --> Foreground --> Change... Allows you to change the foreground
color of the selected style.

Colors --> Background --> Clear Allows you to use a clear background
for the selected style.

Colors --> Foreground --> Change... Allows you to change the background
color of the selected style.

Vertical alignment Allows you to modify the vertical
alignment of the selected style.

Indentation Allows you to determine the
indentation of the selected style.

Line spacing Allows you to determine the line
spacing of the selected style.
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Structure default settings
The Structure Defaults page in the Settings dialog box allows you to
configure miscellaneous structure default settings that are applied to the
settings set selected in the Select the settings set to edit list.

Button, command, or option Description
Construction Levels --> Default
Type

Allows you to define the default type
for the new constructions levels you
create in the Construction Levels
dialog box.

Grid & Construction Lines -->
Extension length

Allows you to define the default
extension length of grid and
construction lines.

Pattern loadcases Allows you to define whether load
patterns are applied to loadcases.

Nominal Cover Allows you to modify the nominal
cover of different members.

NOTE Unlike other settings,
changes made to the nominal
cover settings are instantly
applied to new members.

Section default settings
The Section Defaults page in the Settings dialog box allows you to specify the
default section size for each member type when a new member is create. The
default section sizes are applied to the settings set selected in the Select the
settings set to edit list.

To change the default section size for a member type, click the section size in
the Section column.

Section order default settings
The Section Order Defaults page in the Settings dialog box allows you to
modify the default section orders for different countries by clicking the desired
order in the Section Order column.
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Solver settings
The Solver page in the Settings dialog box allows you to specify the solver
method that is applied to the settings set selected in the Select the settings
set to edit list.

Button, command, or option Description
Global Matrix Storage Allows you to specify the global

matrix storage method. The options
are Compressed Sparse Row and
Skyline.

NOTE We recommend that you
select the Compressed
Sparse Row option because
it generally reduces the
analysis time, particularly in
the case of finite element
analysis.

Scene settings
The Scene page and its subpages in the Settings dialog box allow you to
control the color and opacity of each object type in scene views when using
the settings set selected in the Select the settings set to edit list.

NOTE Unlike other settings, changes made to the active settings set on the
Scene page are instantly applied to the current session when you click
OK to close the Settings dialog box.

Button, command, or option Description
Graphics subpage
Driver

NOTE The default settings on the
Graphics subpage are the
recommended settings. Do
not adjust them unless the
Tekla Support Team instructs
you to do so.

Antialiasing
Transparency

Colors subpage
Background color list Allows you to select whether the table

below displays and allows you to
adjust the colors for a light or dark
background.
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Button, command, or option Description
Gradient Background Unselect this option to apply a

uniform white or black background to
each window, with no gradient
applied.

Reset Colors Resets all the colors to the default
settings.

Color Name Displays the interface item to which
the color applies.

TIP An arrow is displayed to the left
of some of the items, this can be
clicked on in order to set the
colors for sub-items.

NOTE The Gradient Legend colors
are those used when
reviewing embodied carbon.

Opacity Allows you to set the opacity of each
color.

Color Allows you to set the color for each
interface item according to your
needs.

Fonts subpage
Reset Fonts Resets all the fonts to the default

settings.
Font Name Displays the interface item to which

the font applies.
Font Allows you to change the font used

for the interface item.
Size Allows you to adjust the size of the

font.
Bold Allow you to further format the font.
Italic
Contours subpage
Lower bound [%] Displays the lower bound of each FE

contour in the results view.

TIP To adjust the size of the lower
bound, modify Size [%].
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Button, command, or option Description
Upper bound [%] Displays the upper bound of each FE

contour in the results view.

TIP To adjust the size of the upper
bound, modify Size [%].

Size [%] Allows you to adjust the size of
individual contours according to your
needs. Note that the sum of the sizes
must equate to 100 %.

Color Allows you to change the color of a
contour.

Split Divides the contour that is currently
selected in the table into two
contours that are each half the size of
the original contour.

Delete Deletes the contour that is currently
selected in the table.

Reset Resets the contours to the default
configuration that consists of 10
evenly sized contours.

Utilization Ratios subpage
Minimum value Allows you to adjust the minimum

value of a ratio band.

NOTE The value of the highest ratio
band can be increased above
1.0, if necessary.

Color Allows you to change the color of a
ratio band.

Add Creates a new ratio band that you can
modify to the bottom of the table.

Delete Deletes the ratio band that is
currently selected in the table.

Reset Resets the ratio bands to the default
configuration that consists of 5 evenly
sized ratio bands.

Sort Rearranges the ratio bands in order
of the values (from highest to lowest).

View Settings subpage
Do not display values of story
shear below

Allows you to limit the values of story
shear for a new model. This way, you
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Button, command, or option Description
can easily ignore the small values of
story shear that might otherwise
detract you from the more important
story shear values. The story shear
values that are less than the limiting
value are not displayed in the results
view.

Show full pile length Allows you to select whether Tekla
Structural Designer displays the full
length of piles or a shorter pile length
that you can specify.

2 x scale for steel columns Allows you to double the scale of steel
columns in 2D views in order to
simplify viewing the columns and
their orientation.

Report settings
The Report page and its subpages in the Settings dialog box allow you to
modify the appearance of reports.

NOTE Unlike other settings, changes made to the active settings set on the
Report page are instantly applied to the current session when you
click OK to close the Settings dialog box.

Button, command, or option Description
Styles subpage
Report Styles list Allows you to select a style used in

reports whose font, color, or other
properties you want to modify.

Font --> Change... Allows you to change the font used
for the currently selected style.

Colors --> Foreground --> Change... Allows you to change the foreground
color of the selected style.

Colors --> Background --> Clear Allows you to use a clear background
for the selected style.

Colors --> Background --> Change... Allows you to change the background
color of the selected style.

Vertical alignment Allows you to modify the vertical
alignment of the selected style.

Indentation Allows you to determine the
indentation of the selected style.
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Button, command, or option Description
Line spacing Allows you to determine the line

spacing of the selected style.
Page Options subpage
Page margins Allows you to adjust the margins on

report pages.
Margin frame --> Draw page margin
frame

Allows you to select whether Tekla
Structural Designer creates a margin
frame to separate the report text
from the margins.

Margin frame --> Color --> Change... Allows you to change the color of the
margin frame.

First page number Allows you to determine the number
from which the page numbers start.

Page number prefix Allows you to specify a prefix to the
page number.

Table Options subpage
Border Style Allows you to specify the table border

style. You can select to have no table
borders, a single line border, or a
double line border.

Border Properties --> Color -->
Change...

Allows you to change the table border
color.

Border Properties --> Width Allows you to adjust the table border
width.

Table width --> [] percent of page
width

Allows you to specify the width of all
tables included in reports.

Use landscape orientation for wide
tables

When enabled (default) the report
page orientation will automatically
change to landscape mode when the
table header will not fit in portrait
orientation.

NOTE You can reduce the need for
landscape orientation and
number of pages by;
reducing page margins
(default values may be quite
wide); increasing the
allowable table width from 90
to 95% of the available width

Document Options subpage
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Button, command, or option Description
Show document header Allows you to include the header at

the top of each report page.
Show border in document header Draws a border around each field cell

in the header.
Show document footer Allows you to include the header at

the top of each report page.
Show border in document footer Draws a border around each field cell

in the footer.
Show document field description in
line with the value

Allows you to display the field
descriptions in line with the field
values in each cell.

If you do not select the Show
document field description in line
with the value option, the field
values are displayed on a new line.

Underline document field cell Underlines the cell value of each field.
Image width --> [] percent of page
width

Allows you to specify the width of all
images included in reports.

Paragraphs --> Spacing Allows you to specify the paragraph
spacing in reports.

Start each item on new page Allows you to start each report
chapter on a new page.

Start each member report on new
page

Allows you to start each member
report on a new page.

Picture Fonts subpage
Reset Fonts Resets all the fonts to the default

settings.
Font Name Displays the report item to which the

font applies.
Font Allows you to change the font used

for a report item.
Size Allows you to adjust the size of the

font.
Bold Allow you to further format the font.
Italic

See also

Adjust and apply report settings (page 834)
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Embodied carbon settings

The Embodied Carbon page allows you to control the carbon factors applied:

• In the current project - when accessed from the  Model Settings
(page 1032)

• In new projects - when accessed from the  Settings dialog (page 1209)

Embodied carbon settings when accessed from Model Settings

Button, command, or option Description
Steel Connections
Pin-ended allowance Allows you to define the allowance for

pin-ended connections in steel
members as a percentage of the
mass of the member.

Fixed-ended allowance Allows you to define the allowance for
fixed-ended connections in steel
members as a percentage of the
mass of the member.

Embodied carbon settings in the Settings dialog

Button, command, or option Description
Carbon factors
Edit Opens the Embodied Carbon Factors

dialog (page 1185) to allow you to
define the embodied carbon factors
that will be used in new models.

Steel Connections
Fixed-ended allowance Allows you to define the allowance for

fixed-ended connections in steel
members as a percentage of the
mass of the member.

Pin-ended allowance Allows you to define the allowance for
pin-ended connections in steel
members as a percentage of the
mass of the member.
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Performance settings
The Performance page in the Settings dialog box allow you to optimise
analysis and design performance according to your preference and your PC’s
capabilities.

Button, command, or option Description
General To optimise performance choose one

of the following:

• Conserve memory (default)

• Favour speed

NOTE We recommend the 'Favour
speed' option is used only on
higher specification PC’s with
multi-core processors and
the recommended amount of
RAM.

Design Options are provided to allow you to
take advantage of multi-core
processing in the design and chase-
down phases.

• Use multi-core processors for
design

• Run chase-downs concurrently

13.3 Dialogs
This section covers some of the important dialogs in Tekla Structural Designer
and their different options.

Click the links below to find out more:

• Analysis Settings dialog (page 1173)

• Connection Resistance dialog (page 1174)

• Construction Levels dialog (page 1177)

• Design Settings dialog (page 1179)

• Drawing Settings dialog (page 1180)

• Edit Reinforcement dialog (page 1180)

• Embodied Carbon Factors dialog (page 1185)

•
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•

•

• Load Event Sequences dialog (page 1194)

• Loading dialog (page 357)

• Materials dialog (page 1201)

• Model Settings dialog (page 1207)

• Sections dialog (page 1208)

• Settings dialog (page 1209)

• Slab Deflection Check Catalogue (page 1211)

• Slab Deflection Settings dialog (page 1225)

• Snow wizard (ASCE7) (page 1220)

• Snow wizard (Eurocode) (page 1211)

• Sub Models dialog (page 1223)

Analysis Settings dialog

Summary

The Analysis Settings dialog and its subpages allow you to adjust the settings
applied to the different analyses.

Location

On the Analyze tab, click Settings.

Content

Button, command or
option

Description

1st Order Non-Linear See 1st order non-linear
settings (page 1050)

2nd Order Non-Linear See 2nd order non-linear
settings (page 1051)

1st Order Modal See 1st order modal settings
(page 1052)

2nd Order Buckling See 2nd order buckling
settings (page 1055)

1st Order Seismic See 1st order seismic settings
(page 1056)
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Button, command or
option

Description

Iterative Cracked
Section Analysis

See Iterative cracked section
analysis settings (page 1060)

Modification Factors See Modification factors
(page 1061)

Meshing See Meshing settings
(page 1062)

Composite Steel
Beams

See Composite steel beams
settings (page 1062)

OK button Apply the changes to the
current project.

Cancel button Cancel the changes.
Save button Save the changes back to the

active settings set for future
use.

Load button Revert to the model settings
specified in the active settings
set.

Connection Resistance dialog
The Connection Resistance dialog displays the pre-defined connection
resistances for steel beams to Eurocode and US head codes. It can also be
used to add or edit user-defined connection resistances.

To open the dialog:

1. Click the Home tab.

2. Click  Materials.

The Materials dialog is displayed.

3. On the Sections page, check that the required head code and material are
displayed.

NOTE Both steel and cold formed materials can have resistances
defined, unless the head code is US, in which case resistances can
be defined for steel only.

4. Click Connection Resistance

The dialog content is described below.
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1. Title Bar

The title bar displays:

• The currently selected head code.

• For India this also displays LS or WS, and for US displays LRFD or ASD,
according to the setting of the currently open model.

2. Filters

The filter settings determine what is displayed elsewhere in the viewer.

The Member Type filter has options for:
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• Simple Beam

• Brace

3. Connection Types

Pre-defined and user-defined Connection Types are listed here according to
the Filter settings.

• Click the Add... button to add a user-defined Connection Type (page 896).

• Click the Edit... button to edit a user-defined Connection Type.

• Click the Delete button to delete a user-defined Connection Type.

NOTE The Edit... and Delete buttons are only active when a user-defined
Type is selected.

4. Info box

Displays information related to the currently selected Connection Type. For
user-defined Connection Types the information displayed here can be added
or edited via the Add… and Edit… buttons in the Connection Types area of the
viewer.

5. Resistances

• Resistance values are listed in the window according to the Filter settings
and the currently selected Connection Type. The resistance values (for
user-defined Connection Types) can be edited directly.

• The ‘Active’ setting means that, when ticked, the particular resistance will
be considered in the check. The Active status can be edited directly in this
window for individual resistances but is more quickly edited using Activate/
Deactivate. All pre-defined resistances start out Active.

• If ‘Hide undefined values’ is un-ticked those resistances which have zero
value currently assigned will be displayed along with the other sections.
This box is ticked by default when opening the viewer.

• If ‘Hide inactive values’ is ticked those resistances which have ‘Active’ un-
ticked will be hidden in this window. This box is un-ticked by default when
opening the viewer.

• Use the Edit... button to edit the bolt row count or resistance or Active
status of a user-defined Connection Type. Note that multiples of the same
section size can be added through the Edit Resistances dialog, so that the
same size with different bolt row counts and resistances can be defined.

Click here for an example (page 898) showing the use of Edit... as described
above.
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• Use the Activate/Deactivate... button to change the Active setting for
multiple sections. Set the filters in the Activate/Deactivate dialog, then set
either Activate or Deactivate, and then Apply if you want to change further
Active settings or Apply & Close to finish.

Click here for a Eurocode example (page 636) or here for a US example
(page 638) showing the use of Activate/Deactivate as described above.

6. OK and Cancel

Button Description
OK Commit all changes made in the

viewer to the database.
Cancel Closes the dialog box without saving

changes.

See also:

Check simple connection resistance (page 635)

Construction Levels dialog
The Construction Levels dialog allows you to define the levels required in
order to construct your model.

Choose from:

• On the Model tab, click Construction Levels.

• In the Structure tree, double-click Levels.

Content

Button,
command or

option

Description

Options  
Ref Allows you to assign a unique reference to a construction

level.
Name Allows you to assign an optional name to further assist

identification. For example, "First floor" or "Mezzanine".
Type Allows you to select the Type from the drop down menu:

• T.O.S. = Top of steel

• S.S.L. = Structural slab level
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Button,
command or

option

Description

• T.O.F. = Top of foundation

WARNING Slabs are modeled above the level when they
are set to T.O.S or T.O.F but below the level
when they are set to S.S.L

Level Allows you to assign the height of the construction level
above the base level.

Spacing Allows you to assign the distance of this construction level to
the one immediately below.

Source Allows you to assign the level as Unique or the same as
another level. Unique levels can be edited independently,
whereas edits to indentical levels are applied at both levels
simultaneously.

Slab Th. Allows you to set the default thickness for any slab created
on the level.

Floor Allows you to assign the construction level as a major level in
the building. Floor levels determine the number of sub
models that are created for the chasedown analysis. Floor
levels are also used to determine items such as your inter
story height.

There will certainly be a number of levels that are clearly
floor levels, but there could be many others that are not. For
example you create intermediate levels in order to define:

• half landing levels and stairs

• K bracing. You require a construction level for the
intermediate bracing connection points

• Steps in the building floor levels

When you define a level that is clearly not a floor, then you
should not check the option. If a floor exists only at some
locations in the level (e.g. in a building with stepped floor
levels), then you should check the option where applicable.

Buttons  
OK Allows you to save any changes made.
Cancel Allows you to discard any changes made.
Insert Above Allows you to insert a new construction level above the

currently highlighted level with the same spacing.
Insert Below Allows you to insert a new construction level below the

currently highlighted level with the same spacing.
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Button,
command or

option

Description

New on Top Allows you to insert multiple construction levels above the
uppermost level with variable spacings

NOTE 3*5 inserts three levels, each at 5m spacing

3,4,5 inserts three levels at spacings of 3,4 and 5m
respectively.

New at the
Bottom

Allows you to insert multiple construction levels below the
lowest level with variable spacings

Delete Allows you to delete the selected level.

Design Settings dialog
The Design Settings dialog applies design settings to the current project.

Location

On the Design tab, click Settings.

Content

Button, command or option Description
Analysis See Analysis (page 1066)
General See General (page 1065)
Steel > General Steel > General (Eurocode only) (page 1067)
Steel > Composite Beams See Steel > Composite Beams (page 1068)
Steel > Steel Joists See Steel > Steel Joists (page 1069)
Concrete > Cast-in-place See Concrete > Cast-in-place (page 1070)
Concrete > Precast See Concrete > Precast
Design Forces See Design Forces (page 1096)
Design Groups See Design Groups (page 1113)
Autodesign See Autodesign (page 1114)
Design Warnings (AISC/ASC
only)

See Design Warnings (page 1115)

Sway & Drift Checks See Sway and Drift Checks (page 1119)
Fire check See Fire check (page 1121)
OK button Apply the changes to the current project.
Cancel button Cancel the changes.
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Button, command or option Description
Save button Save the changes back to the active settings

set for future use.
Load button Revert to the model settings specified in

the active settings set.

Drawing Settings dialog

Location

On the Draw tab, click Settings.

Content

Button, command or option Description
General > Default export
directory

Specifies the default folder for creation of
dxf files

Layer Configuration See Layer configurations (page 1126)
Layer Styles See Layer styles (page 1127)
Options > Planar Drawings See Planar drawing options (page 1129)
Options > Member Details See Member detail options (page 1138)
Options > Member Schedules See Member schedule options (page 1145)
Options > Slabs and Mats See Slab and mat layout options

(page 1147)
Options > Foundations See Foundation layout options (page 1153)
OK button Apply the changes to the current project.
Cancel button Cancel the changes.
Save button Save the changes back to the active settings

set for future use.
Load button Revert to the model settings specified in

the active settings set.

Edit Reinforcement dialog

Summary

The Edit Reinforcement dialog box allows you to modify the reinforcement
used in a punching shear check. The graphic in the dialog box previews the
reinforcement and updates to match the changes that you make. The graphic
also indicates other items that are specific to the check location.
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Location

To display the dialog:

1. Right click on an existing punching check item.

2. In the context menu, select Edit Reinforcement.

Content

1. Use reinforcement

Selecting the Use reinforcement option allows you to apply a default
punching reinforcement arrangement that can either be checked or used as
the starting reinforcement for an auto design.

2. Preview graphic

The components of the preview graphic are as follows:

Stud rail reinforcement

Stud rail reinforcement is only shown if you have selected the Use
reinforcement option.
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The red design rails signify rails considered in design.

The blue detailing rails are only considered for detailing purposes.

Perimeters

Perimeters are displayed as dashed lines around the column section and will
have different shapes and positioning depending upon the head code being
worked to.

Control Perimeter (EC)

The control perimeter is the perimeter of the dark grey area as shown above.
This will vary depending on existing slab edges and openings.
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Critical Perimeter (ACI)

The critical perimeter is the perimeter of the dark grey area as shown above.
This will vary depending on existing slab edges and openings.

Slab opening dead zones

Slab opening dead zones are displayed as interruptions in perimeters and
reinforcement.

Punching shear check local axis

Using the YZ system orients the X axis upwards following the right-hand rule.
This is also the local axis system for the column elements, so it is easier to
relate.

Additional Perimeters

If reinforcement is found to be required, additional perimeters will be
displayed representing positions beyond the critical/control perimeter where
the reinforcement requirement is checked.
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3. Auto-design

If you select the Auto-design option, the reinforcement is increased until
either a pass is achieved or the limiting reinforcement parameter limits have
been exceeded. You can then select the starting point in the Select
reinforcement starting from list.

The Select reinforcement starting from list allows you to select the staring
point for auto-design procedures. The options are:

• Minima: removes the current arrangement and starts the reinforcement
with the minimum allowed bar size.

• Current: auto design starts from the current bar arrangement. The
Current option is only available if you have selected Use reinforcement in
the Properties window.

4. Select reinforcement parameters

Reinforcement type

In the current release, only stud reinforcement is available.

Arrangement type

Allows you to define whether the reinforcement arrangement is orthogonal or
circular.

Rib type

Allows you to specify the reinforcement rib type.

Grade

The reinforcement grades that are available here are set in the Materials
dialog box.

Bar size

The reinforcement bar sizes that are available here are in the Materials dialog
box.

Spacing from column face

Defines the spacing of the first bar in each rail from the column face.

NOTE The option is only available if the Use reinforcement option has been
selected.
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Spacing

Defines the spacing between bars along each rail.

NOTE The option is only available if the Use reinforcement option has been
selected.

5. Studs parameters

Number of studs per rail

Allows you to define the number of studs on each rail.

Number of diagonal stud rails on one corner

Allows you to define the number of stud rails adjacent to each corner of the
column.

NOTE The option is only displayed when Arrangement type is set to
Circular.

Number of studs per column face

Allows you to define the number of stud rails adjacent to the column face in
the local y and z directions.

Rails spacing

Allows you to define the spacing between rails in the local y and z directions.

6. Buttons

Button Description
OK Saves the current reinforcement and

closes the dialog box.
Cancel Closes the dialog box without saving

changes.
Check... Opens the Results dialog box that

displays the detailed results for the
current design.

See also

Create punching shear checks (page 627)

Design and check punching shear (page 629)
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Embodied Carbon Factors dialog
The Embodied Carbon Factors dialog on the Home ribbon is used to add and
to manage embodied carbon factors (ECFs). The order in which factors are
arranged in the dialog determines the priority in which they are assigned to
models.

Filters can be applied to make it easier to interrogate the list, these do not
affect how the factors are subsequently applied to the model.

NOTE Any changes made in the dialog will only apply to the current model
until the factors are saved to the active global settings set.

The dialog is shown below.
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1. Category filter

The category filter contains a list of all item categories that it is possible to
apply embodied carbon factors to.

Select a category in order to see the factors that have been previously defined
in that category.

Some of these such as 'Cladding' are optional items and might not have any
factors defined.

You cannot add new categories.

Additional filters are also provided which vary depending on the category
selected. For example, when the Steel category is selected the filters are Grade
and Section.

NOTE For the UK Settings Set, some initial defaults have been provided for
the Concrete, Metal Deck, Reinforcement, Steel, and Timber
categories.

2. Entity filter

Each factor is associated with one or more variants within a specified category.

As there are potentially hundreds of factors that could be defined in any one
category, the Entity filter provides a means of filtering the list to make it
easier to interrogate a specific variant.

The Entity filter defaults to displaying all factors applicable to any variant. If
this results in a long list that requires a lot of scrolling, you might choose to
filter the list as follows:

1. Unselect All in order to see a choice of variants that apply to the current
category.

• Click Show only used variants if you want to have the choice of
variants reduced further to just those that exist in the currently open
model.

2. Select one or more variants in order to filter the main list accordingly.

• Click Clear if you want to clear the selected variants and return to the
default All setting.
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3. Active flag

If the Active flag is unselected, the factor will not be applied to model.

4. Filtered list of embodied carbon factors

The list is displayed in accordance with the Category filter and Entity filter
criteria. It also takes account of the specified View options.

The list can be reordered by selecting individual items and dragging them up
or down. The order is very important because each entity in the model will
adopt the first applicable factor it finds in the list.

The number of entities to which the factor currently applies is shown to the
right of the item. When the list is reordered these numbers are instantly
updated.

5. Embodied carbon factor item

When a factor is added its name and value appear in the list as shown.

Beneath the item to the left are its category and entity criteria, and on the next
line, the entities to which it applies.

Beneath the item to the right the number of entities to which the factor
currently applies is shown.
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6. Number of entities the factor currently applies to

The number of entities to which a factor currently applies is shown to the right
of the item. When the list is reordered this number is instantly updated.

7. Defined factors applied to possible entities message

Located underneath the list of factors, this message indicates for the current
filtering criteria, the number of entities that have a factor applied, and the total
number of entities in the model meeting the criteria.

NOTE If the numbers don't match this indicates that the total embodied
carbon will be under-reported.

8. Add factor

Add factor is used to add new factors within the category currently shown in
the Category filter. Initially these would be available for the current model
only.
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Item Description
Active • selected - the factor will initially be active when added

• unselected - the factor will initially be inactive when added
EPD This flag is used to indicate that the factor has come from an EPD. To

make this clear it is suggested that you include 'EPD' in the name.

NOTE Flagging a factor as from an EPD in this way does not make
it uneditable. (Users might wish to update factors when
EPDs get updated due to new manufacturing practices, and
they might wish to change the name, or the filter
determining which entities the factor applies to.)

Name The name that you assign to a factor should be an exclusive
identifier, so that it can be clearly differentiated from other factors
that exist in the same category.

Factor • defined in kgCO2/kg (metric units)

• defined in lb av CO2 e/ib av (US customary units)
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Item Description
Catego
ry
filter

The filters shown here will vary depending on the category. You can
apply a filter in order to limit the range of applicability of the factor.

NOTE The main category cannot be set from here. It has to be
preselected in the Category filter on the Embodied Carbon
Factors dialog before clicking Add factor.

Entity
filter

You can apply an entity filter in order to further limit the range of
applicability of the factor.

The variants available in the entity filter depend on the applied
category filter. Accepting the default setting All would allow the
factor to be applied to all variants within the current category filter.

Alternatively, unselect All in order to see a list of all variants to which
the factor could potentially be applied. From this list you can then
select one or more variants to which the factor will be exclusively
applied.

• Click Clear if you want to clear the selected variants and reselect.

• Click Show only used variants to have the list only show those
variants that have been used in the currently open model.

OK /
Cancel

Click OK to add the factor to the list.

NOTE Once factors have been added, the updated list should be saved to
the currently active global settings in order to make it available to new
models also.

9. Edit factor
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Edit factor is used to edit existing factors within the category currently shown
in the Category filter

Item Description
Active • selected - the factor will initially be active after editing

• unselected - the factor will initially be inactive after editing
EPD This flag is used to indicate that the factor has come from an EPD.

NOTE Flagging a factor as from an EPD in this way does not make
it uneditable. (Users might wish to update factors when
EPDs get updated due to new manufacturing practices, and
they might wish to change the name, or the filter
determining which entities the factor applies to.)

Name The name that you assign to a factor should be an exclusive
identifier, so that it can be clearly differentiated from other factors
that exist in the same category.

Factor • defined in kgCO2/kg (metric units), or
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Item Description
• lb av CO2 e/ib av (US customary units)

Catego
ry
filter

The filters shown here will vary depending on the category. You can
apply a filter in order to limit the range of applicability of the factor.

Entity
filter

You can apply an entity filter in order to further limit the range of
applicability of the factor.

The variants available in the entity filter depend on the applied
category filter. Accepting the default setting All would allow the
factor to be applied to all variants within the current category filter.

Alternatively, unselect All in order to see a list of all variants to which
the factor could potentially be applied. From this list you can then
select one or more variants to which the factor will be exclusively
applied.

• Click Clear if you want to clear the selected variants and reselect.

• Click Show only used variants to have the list only show those
variants that have been used in the currently open model.

OK /
Cancel

Click OK to add the factor to the list.

NOTE Initially any edits would apply to the current model only, but they can
be saved to the currently active global settings in order to make them
applicable to new models also.

10. Remove factor

If you select a factor in the main list and then click Remove factor it is deleted.

11. Export

Exports factors to a spreadsheet. You are given the choice to export:

• All factors

• Active factors

• Used factors

12. Load and Save

Button Description
Load Load carbon factors from the

currently active global settings.
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Button Description

WARNING Any existing factors will
be discarded.

Save Save carbon factors to the currently
active global settings.

WARNING Any existing factors in
the currently active
global settings will be
discarded.

13. View options

View options apply to the display of the main list. When selected these apply
as follows:

• Active only - only those factors with the Active flag selected are displayed in
the main list.

• Entity details - the multiple entities text is expanded to list the entity details
instead.

14. OK and Cancel

Button Description
OK Commit all changes made in the

viewer to the database.
Cancel Closes the dialog box without saving

changes.

Load Event Sequences dialog
The Load Event Sequences dialog is used to define all the construction stage
events that slabs in a sub model will go through starting from the day the
slabs are cast.

To display the dialog:

• On the Slab Deflection toolbar, click Event Sequences

The dialog content is described below.
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1. Event sequences and submodels pane

Event Sequences

Select Event Sequences to show a summary of the model event sequence and
any custom event sequences that have been defined.

When this page is active you can:

• Add a Custom Load Event Sequence.

• Remove a selected Custom Load Event Sequence.

• Review which Event Sequences are used in submodels

Model Event Sequence

Select Model Event Sequence to display the various event sequence
parameters for editing.
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When this page is active you can:

• Review the existing Load Events and edit all the quantities (except included
loadcases)

• Add an event to the end of the sequence

• Insert an event above the selected event in the sequence

• Remove events

• Move Up or Move Down events to re-order the sequence

• Reset the Model Event Sequence to the default Event Sequence in the
active Settings Set

Custom Event Sequences

Pages for custom event sequences are only displayed if they have been added
from the Event Sequences page.
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When a custom event sequence page is active you can:

• Review the existing Load Events and edit all the quantities (except included
loadcases)

• Add an event to the end of the sequence

• Insert an event above the selected event in the sequence

• Remove events

• Move Up or Move Down events to re-order the sequence

• Reset the custom event sequence to be the same as the Model Event
Sequence

NOTE Model Event Sequences and Custom Event Sequences do not behave
differently - they are both just Event Sequences.

Load Event sub-pages

Load Event sub-pages are displayed under the Model Event Sequence, and any
custom Event Sequences pages. Each Load Event has a separate sub-page
which is used to define the loadcases included in the Load Event.

The [>>] and [<<] buttons are used to add or remove loadcases from the
Included Loadcases list.

On submodel specifies the percentage of each included loadcase on the
submodel.

From chasedown specifies the percentage of each included loadcase from
the chasedown.
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NOTE For propping loadcases - “From Chasedown” should be 0%.

Submodels

Select Submodels to assign a custom event sequence to a submodel if
required.

• With this row selected you can edit the section size and grade for all stacks
simultaneously.

2a. Event sequence parameters table (Eurocode)

The input parameters required for each event are:

• Event Number - Automatic

• Event Name - A user defined name to help explain the event

• Load Start time - The time at which the event takes place
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• Beta - a coefficient to take account of the influence of the duration of
loading. (See: EC2 Clause 7.4.3) This coefficient is used to account for the
fact that tension stiffening effects reduce over time.

Tension stiffening is the phenomenon that when the concrete is not fully
cracked, there is still concrete in the tension zone that transfers some
tensile forces, so the stiffness is greater than that of the fully cracked
stiffness (and less than the uncracked stiffness). Since this effect reduces
over time, to model loads with a longer duration, you want to model a
lower stiffness, which means setting beta = 0.5.

In Tekla Structural Designer, Beta defaults to 1.0 where the start event time
is ≤ 30 days and 0.5 if >30 days, but may be changed for any event.

Tension stiffening reduces over time because of increased cracking and
bond failure between the steel reinforcement and concrete.

These phenomena cannot be reversed, so reduced tension stiffening
cannot be recovered.

For this reason, if Beta is set to 0.5, and then in a later event set to 1.0, a
warning flag is shown.

• Temperature - Used in the calculation of the Composite Modulus. The
effective age of concrete is adjusted to account for the defined
temperature.

• Relative Humidity - Used in the calculation of creep.

• Number of Exposed Faces - Used for the calculation of creep.

• Construction load - The construction load you wish to allow for at the
chosen load event.

• Loadcase - You select the loadcases you wish to be included in the event.

• On submodel - The % of load to apply to the slab, applied directly to the
sub-model.

• From chasedown - The % of load to apply to the slab, from the reactions
established in analysis of the sub-models above.
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2b. Event sequence parameters table (ACI)

The input parameters required for each event are:

• Event Number - Automatic

• Event Name - A user defined name to help explain the event

• Load Start time - The time at which the event takes place

• Ultimate Creep Coefficient

• Aging Coefficient

• Number of Exposed Faces - Used for the calculation of creep.

• Construction load - The construction load you wish to allow for at the
chosen load event.

• Loadcase - You select the loadcases you wish to be included in the event.

• On submodel - The % of load to apply to the slab, applied directly to the
sub-model.

• From chasedown - The % of load to apply to the slab, from the reactions
established in analysis of the sub-models above.

3. Update custom event sequences

If you select the Update custom event sequences option, changes made to
the Event in the Model Event Sequence are also replicated in custom event
sequences.
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4. Buttons

Button Description
OK Saves the current reinforcement and

closes the dialog box.
Cancel Closes the dialog box without saving

changes.
Add Depends on the page selected in the

Event sequences and submodels
pane.

Insert Depends on the page selected in the
Event sequences and submodels
pane.

Remove Depends on the page selected in the
Event sequences and submodels
pane.

Move Up Depends on the page selected in the
Event sequences and submodels
pane.

Move Down Depends on the page selected in the
Event sequences and submodels
pane.

Reset Depends on the page selected in the
Event sequences and submodels
pane.

Materials dialog
The Materials dialog box allows you to view material database properties and
manage material databases. The databases contain an extensive range of
sections, materials, reinforcement, decking and connectors for each head code
and country.

NOTE Although the Materials dialog can be used to view the properties for
any of the head codes, only the properties for the currently selected
head code in Model Settings can be applied to the model.

To display the dialog:

1. Click the Home tab.

2. Click  Materials.

The dialog content is described below.
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Sections settings

The Sections page of the Materials dialog box allows you to view the available
steel, cold formed, cold rolled, and timber sections for each head code. You
can also add new user-defined sections.

Field or button Description
Upgrade If the button is visible, you can click it to upgrade

the material database to a newer version.
Unit System Allows you to select which units are used for

sections.
Head Code Allows you to select the head code whose material

database properties you want to view.
Material Allows you to select the material whose sections

you want to view.
Manage Sections Allows you to add, modify, and delete user-defined

sections.
Manage Section Orders Allows you to adjust section orders according to

your needs.
Connection Resistance Allows you to add connection resistance

information for a section.
Steel Joists Allows you to add steel joist information for a

section.
Plate Dimensions Allows you to adjust plate widths and thicknesses.

Material settings

The Material page of the Materials dialog box allows you to view properties
of each grade of each material for each head code. You can also add new user-
defined sections.

Button or field Description
Upgrade If the button is visible, you can click it

to upgrade the material database to a
newer version.

Head Code Allows you to select the head code
whose material database properties
you want to view.

Material Type Allows you to select the material type
whose material database properties
you want to view.
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Button or field Description
Add... If necessary, allows you to add user-

defined material grades to the
Available Grades list.

View... Allows you to view the properties of
pre-defined material grades.

Delete Allows you to permanently delete
user-defined material grades.

>> Default Allows you to make the currently
highlighted material grade a default
material grade, so that it appears in
the Default Grade field.

Reinforcement settings

The Reinforcement page of the Materials dialog box allows you to view the
properties of reinforcement classes and bar sizes.

Button or field Description
Upgrade If the button is visible, you can click it

to upgrade the material database to a
newer version.

Head Code Allows you to select the head code
whose material database properties
you want to view.

Country Allows you to select the country
whose material database properties
you want to view.

Type Allows you to select the type whose
material database properties you
want to view.

Rib Type Allows you to select the rib type
whose material database properties
you want to view.

Add... If necessary, allows you to add user-
defined reinforcement classes or bar
sizes to the appropriate list.

View... Allows you to view the properties of
pre-defined reinforcement classes or
bar sizes.

Delete Allows you to permanently delete
user-defined reinforcement classes or
bar sizes.
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Button or field Description
>> Default Allows you to make the currently

highlighted reinforcement class a
default class, so that it appears in the
Default Class field.

Decking settings

The Decking page of the Materials dialog box contains different sub pages:
Metal Decking and Precast Concrete Decking. The Metal Decking page
allows you to view the properties of different profiles and gauges, and the
Precast Concrete Decking page allows you to view the properties of different
precast concrete planks and depths. The sub pages contain the same
commands.

Button or field Description
Upgrade If the button is visible, you can click it

to upgrade the material database to a
newer version.

Country Allows you to select the country
whose material database properties
you want to view.

Add... If necessary, allows you to add user-
defined profiles, gauges, planks, or
depths to the appropriate list.

View... Allows you to view the properties of
pre-defined profiles, gauges, planks,
or depths.

Delete Allows you to permanently delete
user-defined profiles, gauges, planks,
or depths.

>> Default Allows you to make the currently
highlighted profile, gauge, plank, or
depth a default option, so that it
appears in the appropriate Default
field.
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Shear Connectors settings

The Shear Connectors page of the Materials dialog box allows you to view
the properties of different connectors.

Button or field Description
Upgrade If the button is visible, you can click it

to upgrade the material database to a
newer version.

Head Code Allows you to select the head code
whose material database properties
you want to view.

Country Allows you to select the country
whose material database properties
you want to view.

Add... If necessary, allows you to add user-
defined sources or connectors to the
appropriate list.

View... Allows you to view the properties of
pre-defined sources or connectors.

Delete Allows you to permanently delete
user-defined sources or connectors.

>> Def. Metal Allows you to make the currently
highlighted option the default option
for metal, so that it appears in the
Default for Metal field.

>> Def. Concrete Allows you to make the currently
highlighted option the default option
for concrete, so that it appears in the
Default for Concrete field.

Bolts (Rods in US) settings

The Bolts/Rods page of the Materials dialog box allows you to view the
properties of bolt/rod classes and sizes.

Button or field Description
Upgrade If the button is visible, you can click it

to upgrade the bolts/rods database to
a newer version.

Unit System Allows you to select which units are
used for bolts/rods.

Head Code Allows you to select the head code
whose material database properties
you want to view.
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Button or field Description
Add... If necessary, allows you to add user-

defined bolts/rods.
Copy... Allows you to copy an existing bolt/

rod.
View... Allows you to view the properties of

the selected bolt/rod.
Delete Allows you to permanently delete

user-defined bolts/rods.
>> Default Allows you to make the currently

highlighted bolt a default, so that it
appears in the Default Bolt/Rod field.

Welds settings

The Welds page of the Materials dialog box allows you to view the properties
of welds leg lengths and electrodes.

NOTE Electrodes are US only

Button or field Description
Upgrade If the button is visible, you can click it

to upgrade the welds database to a
newer version.

Unit System Allows you to select which units are
used for welds.

Head Code Allows you to select the head code
whose material database properties
you want to view.

Leg Lengths Allows you to view the Leg Lengths
currently in the welds database.

Defaults... Allows you to set and view the default
weld leg lengths

Reset Allows you to reset the default weld
leg lengths and delete all user defined
welds.

Add If necessary, allows you to add user-
defined leg lengths to the database.

Electrodes
Electrodes Allows you to view the list of

electrodes in the welds database.
Add If necessary, allows you to add user-

defined electrodes to the database.
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Button or field Description
View Allows you to view the properties of

pre-defined electrodes.
Delete Allows you to permanently delete

user-defined electrodes.
>> Default Allows you to make the currently

highlighted option the default
electrode, so that it appears in the
Default Electrode field.

Model settings

The Model page of the Materials dialog box allows you to both update the
material databases with new properties from the model and update material
properties in the model with new values from the material databases.

Button, field, or column Description
In Database Uses ? to display if there are

inconsistencies between the material
data in the model and the material
databases.

Add to Database Allows you to update the material
databases with values from the
model.

Update from Database Allows you to update the material
properties in the model with values
from the material databases.

Show only objects not saved in the
database

Hides the model properties that are
consistent with the material
databases.

Model Settings dialog
The majority of settings for the current project are accessed from the Model
Settings dialog.

Location

On the Home tab, click  Model Settings.
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Content

Button, Command
or Option

Description

Design Codes See Design code settings (page 1033)
Units See Unit settings (page 1034)
References See Object reference settings (page 1035)
Loading See Loading settings (page 1037)
Grouping See Grouping model settings (page 1038)
Material List See Material list settings (page 1039)
Beam Lines See Beam lines settings (page 1039)
Analysis Model See Analysis Model settings (page 1040)
Validation See Validation settings (page 1042)
Live, or Imposed
Load reductions

See Live/imposed load reduction settings (page 1043)

EHF, NL, or NHF
(Global
Imperfections)

See Global Imperfections settings (page 1044)

User Defined
Attributes

See User-defined attribute settings (page 1045)

Graphics View
Settings

See Graphics view settings (page 1047)

Structural BIM See Structural BIM settings (page 1047)
OK button Apply the changes to the current project.
Cancel button Cancel the changes.
Save button Save the changes back to the active settings set for

future use.
Load button Revert to the model settings specified in the active

settings set.

Sections dialog
The Sections dialog box is used to select sections to apply to the model and
also to manage the sections stored in the material database.
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The dialog content is described below.

1. Page pane: views the different section geometries.

2. Item pane: views the different sizes of the selected section when you
select a section geometry Page pane. Any user-defined sections are
marked with *.

3. Details pane: views the details of the selected section when you click the
Details button.

4. Country droplist: allows you to display the sections of each country.

5. Geometry filter: allows you to filter sections according to their geometry.

6. Selected section: displays the details of the currently selected section.

7. Section filter: allows you to filter sections according to their details.

You can also use the following buttons to manage the sections:

• Add...: allows you to add a user-defined section to the material database.

• Delete: allows you to delete a user-defined section.

• Edit...: allows you to modify the properties of a user-defined section.

• Details: opens the Details pane and displays the properties of the
currently selected section.

Settings dialog
The Settings dialog allows you to manage defaults, collectively referred to as a
settings set, that are used in future projects. In addition, you can manage
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general and display settings that are applied instantly to the current work
session.

Location

On the Home tab, click  Settings.

Content

List, Page, or
Button

Description

Select the settings
set to edit list,
Available settings
sets list

Allows you to select the settings set to view or modify.

Settings Sets See Settings set settings (page 1160)
General See General settings (page 1160)
Results Viewer See Results Viewer settings (page 1162)
Report See Report settings (page 1168)
Units See Unit settings (page 1034)
Design Codes See Design code settings (page 1033)
Design Settings See Design Settings (page 1064)
Analysis Settings See Analysis Settings (page 1050)
Loading See Loading settings (page 1037)
Structure Defaults See Structure default settings (page 1164)
Section Order
Defaults

See Section order default settings (page 1164)

References See Object reference settings (page 1035)
Drawings See Drawing settings (page 1126)
Material List See Material list settings (page 1039)
Beam Lines See Beam lines settings (page 1039)
Analysis Model See Analysis Model settings (page 1040)
Solver See Solver settings (page 1164)
User Defined
Attributes

See User-defined attribute settings (page 1045)

Scene See Scene settings (page 1165)
Structural BIM See Structural BIM settings (page 1047)
Slab Deflection See Slab deflection settings (page 1122)
Embodied Carbon See Embodied carbon settings (page 1170)
Performance See Performance settings (page 1171)
OK button Apply the changes.
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List, Page, or
Button

Description

Cancel button Cancel the changes.

Slab Deflection Check Catalogue
The Slab Deflection Check Catalogue is used to define the deflection checks
that are applied to check lines.

Location

On the Slab Deflection tab, click Deflection Checks.

Content

Each deflection check has a unique name and can either be defined as a total
or instantaneous check for a specific event, or a differential check between
load events. A deflection limit is set and you can specify if the check is to be
applied to each new check line as it is defined.

Field or button Description
Name Allows you to modify the check name.
Type Allows you to select the deflection check type, see

Display slab deflection analysis results (page 818) .
Start Event Allows you to select the start event for a

differential check.
Event Allows you to select the event to which the check

applies.
Deflection Limit Allows you to specify the deflection check limit.
Use in new Check Lines Check the box only to be automatically apply the

check to new check lines as they are created.
Add Allows you to add a new row in the table for

defining a new check.
Remove Removes the selected check from the table.

Snow wizard (Eurocode)

Summary

You can use the Snow wizard... to define sufficient site information to
calculate the snow loadcases.
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Location

1. Ensure the head code is set as Eurocode with the required National
Annex.

2. On the Load tab, click Snow Load --> Snow wizard...

Plain Eurocode, Ireland and Sweden National Annex

Button,
command or

option

Description

Page 1 - Basic
data (Plain
Eurocode,
Ireland and
Sweden
National
Annex)

The following basic data is required:

Exposure
Coefficient

User defined value. (Default 1.0)

Thermal
Coefficient

User defined value. (Default 1.0)

Coefficient for
Exceptional
Snow Loads

User defined value. (Default 1.0)

Snow Density Define the density of snow. (Default 2.0
kN/m2)

Snow Load User defined value. (No default value)
Next Click to proceed to the next page of the

Snow wizard...
Page 2 - Snow
loadcases (Plain
Eurocode,
Ireland and
Sweden
National
Annex)

On this page you specify the design
situations to be considered.

Loadcase Automatically generated wind loadcase
title. The loadcase title can be manually
renamed if required.

Apply Options are:

• Checked

If checked the loadcase will be
created.
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Button,
command or

option

Description

• Unchecked

If unchecked the loadcase will not be
created.

NOTE Undrifted (Cases A-1, B1-1, B1-3,
B2-1, B3-1, B3-3)

• Loads in these cases are
generated automatically

Drifted Snow Load (Cases A-2,
B1-2, B1-4, B2-2, B2-3, B3-2,
B3-4)

• You must create the loads in
these cases manually

NOTE The EC/NA recommends which
loadcases to apply.

Loadcase Type
(Plain Eurocode
and Ireland
National Annex)

Each loadcase has a loadcase type which
can be:

• Snow

• Snow > 1000m

• Snow Drift

Refer to EC 1991-1-3 Annex A, Table A1
Loadcase Type
(Sweden
National Annex)

Each loadcase has a loadcase type which
can be:

• Snow

• Snow Sk > 2 kN/m2

• Snow Sk > 3 kN/m2

• Snow Drift

Refer to EC 1991-1-3 Annex A, Table A1.
Number of wind
directions to be
considered for
drifted snow

You can select between 1 and 4
separate loadcases to be generated for
each 'Drifted' loadcase (identified
by....1, ...2, etc. appended to the drifted
loadcase name).

For example if you have checked the
box to apply loadcase "Snow Load - Case
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Button,
command or

option

Description

A - 2) Drifted" and selected 2 wind
directions, the following loadcases will
be created:

• Snow Load - Case A - 2) Drifted 1

• Snow Load - Case A - 2) Drifted 2
Finish Completes the Snow wizard... and sets

up the loadcases based upon the input.

UK National Annex

Button,
command or

option

Description

Page 1 - Basic
data (UK
National
Annex)

The following basic data is required:

Exposure
Coefficient

User defined value. (Default 1.0)

Thermal
Coefficient

User defined value. (Default 1.0)

Coefficient for
Exceptional
Snow Loads

User defined value. (Default 1.0)

Snow Density Define the density of snow. (Default 2.0
kN/m2)

Snow Load  
Zone Number, Z Zone Number. (Default 2.0 kN/m2)
Altitude, A Altitude. (Default 1.0)
Characteristic
Ground Snow
Load, sk

Characteristic ground snow load
calculated as

sk = (0.15 + (0.1 * Z + 0.05)) + ((A - 100)/
525)

Next Click to proceed to the next page of the
Snow wizard...

Page 2 - Snow
loadcases (UK
National
Annex)

On this page you specify the design
situations to be considered.
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Button,
command or

option

Description

Loadcase Automatically generated wind loadcase
title. The loadcase title can be manually
renamed if required.

Apply Options are:

• Checked

If checked the loadcase will be
created.

• Unchecked

If unchecked the loadcase will not be
created.

NOTE Undrifted (Cases A-1, B1-1, B1-3,
B2-1, B3-1, B3-3)

• Loads in these cases are
generated automatically

Drifted Snow Load (Cases A-2,
B1-2, B1-4, B2-2, B2-3, B3-2,
B3-4)

• You must create the loads in
these cases manually

NOTE The EC/NA recommends which
loadcases to apply.

Loadcase Type Each loadcase has a loadcase type which
can be:

• Snow

• Snow > 1000m

• Snow Drift

Refer to EC 1991-1-3 Annex A, Table A1.
Number of wind
directions to be
considered for
drifted snow

You can select between 1 and 4
separate loadcases to be generated for
each 'Drifted' loadcase (identified
by....1, ...2, etc. appended to the drifted
loadcase name).

For example if you have checked the
box to apply loadcase "Snow Load - Case
A - 2) Drifted" and selected 2 wind
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Button,
command or

option

Description

directions, the following loadcases will
be created:

• Snow Load - Case A - 2) Drifted 1

• Snow Load - Case A - 2) Drifted 2
Finish Completes the Snow wizard... and sets

up the loadcases based upon the input.

Finland National Annex

Button,
command or

option

Description

Page 1 - Basic
data (Finland
National
Annex)

The following basic data is required:

Topography Options are:

• Windswept

• Normal (Default)

• Sheltered
Exposure
Coefficient

Value determined from Topography.

Thermal
Coefficient

User defined value. (Default 1.0)

Coefficient for
Exceptional
Snow Loads

User defined value. (Default 1.0)

Snow Weight
Density

Define the density of snow. (Default 2.0
kN/m2)

Characteristic
Ground Snow
Load

User defined value. (No default value)

Next Click to proceed to the next page of the
Snow wizard...

Page 2 - Snow
loadcases
(Finland
National
Annex)

On this page you specify the design
situations to be considered.
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Button,
command or

option

Description

Loadcase Automatically generated wind loadcase
title. The loadcase title can be manually
renamed if required.

Apply Options are:

• Checked

If checked the loadcase will be
created.

• Unchecked

If unchecked the loadcase will not be
created.

NOTE Undrifted (Cases A-1, B1-1, B1-3,
B2-1, B3-1, B3-3)

• Loads in these cases are
generated automatically

Drifted Snow Load (Cases A-2,
B1-2, B1-4, B2-2, B2-3, B3-2,
B3-4)

• You must create the loads in
these cases manually

NOTE The EC/NA recommends which
loadcases to apply.

Loadcase Type Each loadcase has a loadcase type which
can be:

• Snow

• Snow, Sk > 2.75 kN/m2

• Snow Drift

• Ice

Refer to EC 1992-1-3 Annex A, Table A1.
Number of wind
directions to be
considered for
drifted snow

You can select between 1 and 4
separate loadcases to be generated for
each 'Drifted' loadcase (identified
by....1, ...2, etc. appended to the drifted
loadcase name).

For example if you have checked the
box to apply loadcase "Snow Load - Case
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Button,
command or

option

Description

A - 2) Drifted" and selected 2 wind
directions, the following loadcases will
be created:

• Snow Load - Case A - 2) Drifted 1

• Snow Load - Case A - 2) Drifted 2
Finish Completes the Snow wizard... and sets

up the loadcases based upon the input.

Norway National Annex

Button,
command or

option

Description

Page 1 - Basic
data (Norway
National
Annex)

The following basic data is required:

Topography Options are:

• Windswept

• Normal (Default)

• Sheltered
Exposure
Coefficient

Value determined from Topography.

Thermal
Coefficient

User defined value. (Default 1.0)

Coefficient for
Exceptional
Snow Loads

User defined value. (Default 1.0)

Snow Weight
Density

Define the density of snow. (Default 2.0
kN/m2)

Altitude, H User defined value.
Basic Reference
Altitude

User defined value.

Basic Snow Load User defined value.
???? User defined value.
???? User defined value.
Characteristic
Ground Snow
Load

Automatically determined from the
above values.
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Button,
command or

option

Description

Next Click to proceed to the next page of the
Snow wizard...

Page 2 - Snow
loadcases
(Norway
National
Annex)

On this page you specify the design
situations to be considered.

Loadcase Automatically generated wind loadcase
title. The loadcase title can be manually
renamed if required.

Apply Options are:

• Checked

If checked the loadcase will be
created.

• Unchecked

If unchecked the loadcase will not be
created.

NOTE Undrifted (Cases A-1, B1-1, B1-3,
B2-1, B3-1, B3-3)

• Loads in these cases are
generated automatically

Drifted Snow Load (Cases A-2,
B1-2, B1-4, B2-2, B2-3, B3-2,
B3-4)

• You must create the loads in
these cases manually

NOTE The EC/NA recommends which
loadcases to apply.

Loadcase Type Each loadcase has a loadcase type which
can be:

• Snow

• Snow > 1000m

• Snow Drift

Refer to EC 1992-1-3 Annex A, Table A1.
Number of wind
directions to be

You can select between 1 and 4
separate loadcases to be generated for

Tekla Structural Designer reference 1219 Dialogs



Button,
command or

option

Description

considered for
drifted snow

each 'Drifted' loadcase (identified
by....1, ...2, etc. appended to the drifted
loadcase name).

For example if you have checked the
box to apply loadcase "Snow Load - Case
A - 2) Drifted" and selected 2 wind
directions, the following loadcases will
be created:

• Snow Load - Case A - 2) Drifted 1

• Snow Load - Case A - 2) Drifted 2
Finish Completes the Snow wizard... and sets

up the loadcases based upon the input.

Snow wizard (ASCE7)

Summary

You can use the Snow wizard... to define sufficient site information to
calculate the snow loadcases.

Location

1. Ensure the snow loading code is set as ASCE7.

2. On the Load tab, click Snow Load --> Snow wizard...

Content

Button,
command or

option

Description

Page 1 - Basic
data (ASCE7
Snow wizard)

The following basic data is required:

Ground snow
load

(No default)

Terrain Category Options are:

• B (urban, suburban, wooded) -
Default

• C (open terrain scattered
obstructions),
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Button,
command or

option

Description

• D (flat unobstructed areas), Above
treeline, Alaska no trees

Exposure Options are:

• Fully exposed

• Partially exposed
Exposure factor,
Ce

Ce is determined from the following
table:

 Ful
ly

Exp
ose

d

Full
y

Exp
ose

d

Shel
tere

d

B 0.9 1 1.2
C 0.9 1 1.1
D 0.8 0.9 1
Abov
e
treeli
ne

0.7 0.8 0

Alask
a

0.7 0.8 0

Thermal
Condition

Option are:

• All except below

• Structures kept just above freezing

• Unheated open air structures

• Structures kept below freezing

• Continuously heated greenhouses
Thermal factor,
Ct

Ct is determined from the following
table:

A 1
B 1.1
C 1.2
D 1.3
E 0.85
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Button,
command or

option

Description

Risk Category Option are:

• I

• II

• III

• IV
Snow
Importance
factor, Is

Is is determined from the following
table:

I 0.8
II 1
III 1.1
IV 1.2

Flat Roof Snow
load, , pf

pf is determined from the following:

pf = 0.7 * Ce * Ct * Is * pg

Next Takes you to the next page.
Page 2 - Snow
loadcases (AISC
Snow wizard)

This page is used to specify the
loadcases as follows:

Minimum Snow
Load

Option are:

• Yes

• No
Balanced Snow
Load

Option are:

• Yes

• No
Unbalanced
Snow Load

Option are:

• No

• 1

• 2

• 3

• 4

You can select between 1 and 4 cases to
generate (1 Unbalanced..., 2
Unbalanced, etc.)
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Button,
command or

option

Description

Draft Snow Load Option are:

• No

• 1

• 2

• 3

• 4

You can select between 1 and 4 cases to
generate (1 Unbalanced..., 2
Unbalanced, etc.)

Rain on Snow
Surcharge

Option are:

• Yes

• No
Finish Completes the Snow wizard... and sets

up the loadcases based upon the input.

Sub Models dialog
The Sub Models dialog box allows you to split the structure into a continuous
series of sub models, working from the top of the building down to, and
including the foundations.

Location

In the Structure tree, double-click Sub Models.

Content

Button,
Command or

Option

Description

Options  
Level Before any analysis has been performed,

only two levels are displayed, one at a
distance (2m) above the highest
construction level and a second at the
same distance below the lowest level.
These cannot be changed. Hence, at this
point, there is a single sub-model
comprising the whole structure.
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Button,
Command or

Option

Description

Active Only active levels act to divide the
structure into sub-models. The top and
bottom levels must always remain active,
as there must always be at least one sub
model.

Once intermediate levels have been
inserted, you can choose to inactivate
them if required. When this occurs the
sub-models immediately above and below
the level in question are merged into a
single sub-model.

Auto Generate If any adjustments to the cutting planes or
cutting plane levels, or any of them are set
as inactive you must also clear Auto-
Generate. Otherwise the changes you
have made will be lost the next time the
sub models are generated.

Buttons  
OK Allows you to save any changes made.
Cancel Allows you to discard any changes made.
Insert Above Allows you to insert a new sub model

between the selected level and the one
above. It defaults to being located half way
between the two, however this can be
edited manually, provided it remains
between the two reference levels.

Insert Below Allows you to insert a new sub model
between the selected level and the one
below. It defaults to being located half way
between the two, however this can be
edited manually, provided it remains
between the two reference levels.

Delete  
Generate Allows you to auto generate default sub

models or not

• Checked

Auto Generate creates default sub
models for every level specified as a
floor in the Construction Levels dialog.
It is optional as default sub models are
automatically generated for you when
you run the analysis, provided the Auto
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Button,
Command or

Option

Description

Generate box on the dialog is checked.
You may choose to do this if you want
to review the sub models prior to the
first run of the analysis.

• Unchecked

Does not Auto Generate sub models
prior to the first run of the analysis.

NOTE The Generate button can also be
used to revert back to the default
sub models at any time.

See also

Manage sub models (page 488)

Create sub models (page 489)

Slab Deflection Settings dialog
The Slab Deflection Settings dialog and its subpages allow you to adjust the
settings applied to the different analyses.

Location

On the Slab Deflection tab, click Settings.

Content

Button, command or option Description
• New Load Event Defaults

• New Check Defaults

• Aging, Creep & Shrinkage

• Modification Factors

• Iterative Cracked Section
Analysis

See: Slab deflection settings

OK button Apply the changes to the current project.
Cancel button Cancel the changes.
Save button Save the changes back to the active settings

set for future use.
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Button, command or option Description
Load button Revert to the model settings specified in

the active settings set.
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Index

.......................................................................681

............................................................. 407,1013

.......................................................................858
Activate reductions in live or imposed
loadcases .................................................... 341
Activate rigid diaphragm option within a
slab .............................................................. 485
Activate semi-rigid diaphragm action within
a slab ........................................................... 485
Add haunches to steel beams...................226
Add material properties from the model to
a material database ...................................902
Add or remove elements in sub structures
.......................................................................922
Adjust and apply analysis settings ...........460
Adjust and apply drawing settings ...........851
Adjust global slab mesh properties .........465
Adjust global wall mesh properties ......... 480
Adjust report headers and footers .......... 834
Align a column to a specific angle or an
angled grid line ...........................................203
Analysis Model settings ...........................1040
Analysis options ....................................... 1050
Analysis Settings dialog ...........................1173
Analyze All (Static)....................................... 496
Analyze models .......................................... 450
Apply an architectural grid to a specific level
.......................................................................185
Apply and manage model settings .......... 877
Apply and modify design options ............ 599
Apply cantilever ends ................................ 734
Apply curved edges to existing slab items ....
269
Apply different mesh properties at different
levels ............................................................466
Apply different mesh properties to an
individual wall .............................................481

Apply drift loads to loadcases on
completion of the snow wizard.................403
Apply loading...............................................340
Apply member loads ................................. 370
Apply panel, member, and structure loads
.......................................................................364
Apply patterning to live/imposed loadcases
.......................................................................356
Apply patterning to load combinations .. 356
Apply rotational stiffness .......................... 752
Apply snow loading manually .................. 406
Apply snow loads ....................................... 396
Apply structure loads ................................ 372
Apply wind loads ........................................387
Apply wind, snow, and seismic loads ...... 387
Automatically join all beams .....................331
Basic model creation methods................. 155
Beam line settings ................................... 1039
Beam Properties - SidePlate......................654
Beam releases ............................................ 949
BIM Integration .......................................... 108
Calculate slab deflections ......................... 812
Change the name of an single grid line or
grid arc ........................................................ 185
Change the name or color of an
architectural grid ........................................185
Change the view regime ..............................89
Check selected members and walls......... 606
Column releases ........................................ 965
Combined analysis and member design. 601
Configure and display member reports ..829
Configure and display model reports ..... 828
Connection Resistance dialog ................ 1174
Construction levels dialog ...................... 1177
Copy and rotate objects ............................321
Copy material grades ................................ 722
Copy or modify slab and foundation
reinforcement ............................................ 720
Copy or modify user-defined attributes . 725
Copy properties ..........................................723
Copy quick connector layout.....................744
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Copy section sizes ......................................722
Copy shear connectors ............................. 754
Copy transverse reinforcement ............... 756
Copy web openings ................................... 760
Copy westok openings .............................. 760
Create a new project based on a template
.........................................................................48
Create a new template ................................ 47
Create a pile type catalogue ..................... 690
Create a sub structure ...............................921
Create a sub structure group ................... 924
Create a truss ............................................. 275
Create and manage user-defined attributes
.......................................................................916
Create and modify patches ...................... 617
Create and modify reports ....................... 825
Create beam end force drawings ............ 856
Create column drops .................................270
Create column splice load drawings ........857
Create concrete cores................................ 245
Create concrete member schedule drawings
.......................................................................866
Create continuous beams .........................214
Create curved beams ................................ 215
Create DELTABEAMS .......................... 220,222
Create diaphragm loads ............................373
Create door or window openings ............ 241
Create drawing scales ............................... 851
Create drawings ......................................... 848
Create drawings in batches ...................... 869
Create foundation drawings .....................865
Create free form trusses ...........................276
Create full UDLs ......................................... 370
Create gable posts or parapet posts ....... 202
Create general arrangement drawings ... 855
Create isolated foundations ..................... 688
Create load combinations manually ........346
Create load groups .................................... 343
Create loadcases ........................................341
Create loading plan drawings ...................858
Create mat foundations ............................693
Create member detail drawings .............. 859
Create modal mass combinations ...........347
Create models ............................................ 155
Create nodal loads .....................................382
Create pad base columns ......................... 688
Create partial-length torsional UDLs and
VDLS .............................................................372

Create partial-length UDLs or VDLs .........370
Create planar drawings .............................855
Create point loads and moment loads ... 371
Create punching shear checks ................. 627
Create reports ............................................ 828
Create reports sand drawings ..................825
Create settlement loads ............................382
Create slab and mat drawings ................. 863
Create slab or mat openings .................... 265
Create space trusses ................................. 275
Create strip base walls .............................. 689
Create sub models .....................................489
Create temperature loads ........................ 382
Create torsion full UDLs ............................371
Create trapezoidal loads ........................... 371
Create Westok Cellular, Westok Plated or
FABSEC beams ............................................219
Create, modify, or delete layer
configurations ............................................ 852
Create, modify, or delete layer styles ......853
Cross-check the sum of reactions against
the load input ............................................. 497
Delete construction levels ........................ 177
Delete panel, member, and structure loads
.......................................................................383
Delete sub models .....................................490
Delete sub structure ..................................923
Delete the snow model ............................. 406
Design settings..........................................1067
Design code settings ............................... 1033
Design connections ................................... 655
Design isolated foundations .....................692
Design mat foundations ............................698
Design review filters .................................. 705
Design selected members and walls........609
Design settings....
1065,1069,1096,1113,1119,1121
Design settings ............ 1068,1070,1094,1115
Design Settings - Minimum Design Forces
Examples....................................................1099
Design Settings dialog .............................1179
Design slabs, create and design patches,
create and run punching shear checks....616
Desing options ......................................... 1064
Dialog boxes .............................................1172
Diaphragm loads and diaphragm load
tables ........................................................... 372
Display analysis results.............................. 498
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Display reactions ........................................500
Display solver models ............................... 551
Display sway drift and story shear ...........503
Drawing categories ....................................848
Drawing settings ...................................... 1126
Drawing Settings dialog .......................... 1180
Edit Event Sequences................................. 813
Edit Reinforcement dialog....................... 1180
Embodied Carbon Factors dialog .......... 1185
Embodied carbon settings ......................1170
Example reports .........................................839
Exclude individual nodes from a rigid
diaphragm .................................................. 487
Exclude slab items from a diaphragm .....488
Export a model to Autodesk Revit............ 135
Export a model to Autodesk Robot
Structural Analysis ..................................... 148
Export a model to IFC ................................ 136
Export a model to STAAD ..........................147
Export a model to Tekla Structures ......... 126
Export a model to the cloud ..................... 149
Export reports ............................................ 838
Export tabular results to Excel.................. 811
Export to and import from other
applications ................................................ 135
Export to Trimble applications.................. 125
FE meshing, sub models and diaphragms ....
463
Filter reports ...............................................832
Filter tabular data ...................................... 811
Fire proofing ........................................737,950
Format reports ........................................... 833
Further help and update information........ 37
General settings .......................................1160
Generate load combinations automatically
.......................................................................345
Get familiar with the user interface ...........54
Get started with analysis ...........................450
Get started with slab deflection analysis 812
Global Imperfections settings ................ 1044
Graphics view settings ............................ 1047
Grouping model settings ........................ 1038
How bearing walls are represented in solver
models..........................................................588
How can I centrally deploy Tekla software?
.........................................................................38
How meshed walls are represented in
solver models ............................................. 577

How mid-pier walls are represented in
solver models.............................................. 582
How to use the Project Workspace to
manage connections ................................... 83
How to use the Project Workspace ............70
Identify the nodes constrained by rigid
diaphragms .................................................487
Import a project from a Structural BIM
Import file ................................................... 109
Import grids from DXF files .......................186
Import loadcases and combinations from a
spreadsheet.................................................347
Import model data .....................................108
Install a Tekla Structural Designer service
pack ................................................................39
Install and license Tekla Structural Designer
.........................................................................33
Install Tekla Structural Designer service
packs...............................................................39
Installation and licensing workflow............ 27
Inter-story shear and cumulative story
shear.............................................................769
Live/imposed load reduction settings ...1043
Load combination classes .........................344
Load Event Sequences dialog .................1194
Loading dialog............................................. 357
Loading settings .......................................1037
Make a level an identical copy of another
level ..............................................................176
Make a level an independent copy of
another level ...............................................177
Manage and view result strips ................. 512
Manage architectural grids and grid lines ....
178
Manage display and design result lines...515
Manage drawings in batches ....................869
Manage FE meshed slabs.......................... 464
Manage FE meshed walls ..........................480
Manage load combinations ...................... 344
Manage load groups ..................................342
Manage load patterns ............................... 353
Manage loadcases ..................................... 340
Manage loadcases, groups, combinations,
envelopes and patterns............................. 340
Manage material databases ..................... 890
Manage models ..........................................877
Manage properties and property sets .... 912
Manage scene views ....................................85
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Manage schedule drawings in batches ... 874
Manage sub models .................................. 488
Material list settings ................................ 1039
Material lists for cold formed.................... 805
Material lists for concrete.......................... 792
Material lists for general materials...........806
Material lists for steel................................. 786
Material lists for timber..............................803
Merge planes ..............................................337
Mirror objects to new locations ............... 322
Model Settings.......................................... 1032
Model Settings dialog...............................1207
Model SidePlate connections.................... 653
Model steel beams and cold formed beams
.......................................................................216
Modify assumed cracked settings ........... 728
Modify auto design settings .............. 717,727
Modify BIM status ...................................... 720
Modify column splice positions ................725
Modify concrete column alignment or
specify offsets .............................................209
Modify end fixity ........................................ 719
Modify gravity only settings ......................739
Modify panel, member, and structure loads
.......................................................................383
Modify punching shear check position ... 743
Modify SidePlates .......................................754
Modify slenderness settings .....................731
Modify stud auto layout ............................ 755
Modify the geometry of steel trusses ......276
Modify the position of beams .................. 216
Modify the properties of a construction
level ..............................................................177
Modify the properties of existing trusses ....
277
Modify the report structure ......................831
Modify wind loading .................................. 761
Move a brace .............................................. 230
Move an rotate objects ............................. 322
Navigate reports ........................................ 836
Object properties .......................................930
Object reference settings ........................1035
Open a 3D view of a sub structure .......... 924
Open a 3D view of a sub model ............... 490
Override effective width ............................743
Overview of load groups ...........................342
Overview of load patterns ........................ 354

Overview of one-way and two-way load
decomposition............................................ 385
Performance settings .............................. 1171
Print reports ............................................... 838
Reference ....................................................930
Rename sub structure ...............................923
Renumber all load combinations .............352
Renumber all loadcases ............................342
Report settings .........................................1168
Report terminology ....................................825
Reset reinforcement marks in concrete
detail drawings ...........................................872
Results Viewer settings ........................... 1162
Review and apply property sets ...............725
Review and copy deflection limits ............735
Review and copy size constraints ............ 755
Review and modify diaphragm settings ..718
Review and modify drift checks ............... 736
Review and modify member filters ......... 723
Review and modify restraints ...................744
Review and modify seismic drift checks . 752
Review and modify SFRS type and direction
settings ........................................................753
Review and modify sway checks .............. 756
Review and modify user defined utilization
ratios ............................................................757
Review and modify wind drift checks ......760
Review and set imposed load reduction .741
Review and set camber ............................. 732
Review and set live load reduction .......... 739
Review carbon factors ...............................734
Review concrete beam flanges .................724
Review design summary tabular results..763
Review drawings ........................................ 873
Review drift check tabular results ............770
Review embodied carbon detail .............. 808
Review embodied carbon overview .........809
Review floored area tabular results......... 810
Review foundation and pile design ......... 702
Review inter-story shear tabular results .764
Review material list tabular results ......... 782
Review member design .............................701
Review models ........................................... 700
Review seismic drift check tabular results ....
773
Review slab and mat design ..................... 703
Review story shear tabular results........... 768
Review sub structures ............................... 924
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Review sub structures ............................... 724
Review sway check tabular results .......... 765
Review tabular data ...................................762
Review the slab mesh before the analysis ....
466
Review the wall mesh before the analysis ....
481
Review utilization and embodied carbon ....
758
Review where property sets have been
applied .........................................................914
Review wind drift check tabular results .. 777
Roof Panel Properties ............................. 1015
RoofType ..................................................... 397
RSA seismic results .................................... 518
Run a 1st order linear or non-linear analysis
.......................................................................491
Run a 1st order modal analysis ................492
Run a 2nd order buckling analysis ...........493
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